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9.2.2. Das Untermenü ”Holen“ . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 216
9.2.3. Einstellungen . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 216
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9.3. Das Menü ”Xtns“ im Werkzeugfenster . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 216
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9.5.11. Zurücksetzen . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 230
9.5.12. Drucken . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 231
9.5.13. Schließen . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 231
9.5.14. Beenden . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 231
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1. Einführung

1.1. Willkommen bei GIMP

GIMP ist ein freies, sehr leistungsfähiges Photo- und Bildbearbeitungsprogramm. Der Name GIMP ist
zusammengesetzt aus den englischen Worten ”GNU Image Manipulation Program“, was im Deutschen
soviel bedeutet wie ”GNU Bildbearbeitungsprogramm“. Sie können GIMP für eine Vielzahl an Aufga-
ben einschließlich Photonachbearbeitung, Bildkomposition und -malerei einsetzen.

Eine große Stärke von GIMP ist seine Erweiterbarkeit. Es wurde von Grund auf so entworfen, dass
es durch verschiedenste Erweiterungen fast beliebige neue Funktionen erhalten kann. Sogar eine eigene
kleine Programmiersprache, genannt Skript-Fu, wurde ihm mit auf den Weg gegeben, um einfache wie
komplexe Probleme durch kleine Programme lösen zu können.

Eine weitere Stärke von GIMP besteht in der freien Verfügbarkeit des Programmcodes. Hierdurch
ist es auf sehr vielen verschiedenen Plattformen verfügbar. Die meisten GNU/Linux Distributionen
beinhalten GIMP als Standard Anwendung für Bildbearbeitung. Weitere Beispiele hierfür sind Microsoft
Windows oder Apple Mac OS X (Darwin). GIMP ist keine Freeware, sondern wird unter einer freien
Software Lizenz, der GPL <http://www.gnu.org/license/gpl/> weitergegeben. Die GPL gibt
Benutzern die Freiheit auf den Programmcode zuzugreifen, diesen zu modifizieren und weiterzugeben.

1.1.1. Das Team hinter GIMP

Die erste Version von GIMP entstand durch Peter Mattis und Spencer Kimball. Bis heute haben vie-
le weitere Entwickler zu diesem Produkt beigetragen und Tausende haben durch Support und Tests
mitgewirkt. Neue GIMP Versionen werden im Augenblick von Sven Neumann verwaltet.

1.1.2. Das GIMP-Hilfe System

Das Dokumentationsteam und die Anwender von GIMP stellen Ihnen vielfältige Informationen bereit,
um Sie bei der Arbeit mit GIMPzu unterstützen. Dieses Handbuch ist ein wichtiger Bestandteil dieser
Hilfe. Die aktuellste Version finden Sie auf der Internetseite <http://docs.gimp.org> des Doku-
mentationsteams im HTML und PDF Format. Die HTML Version wird zusätzlich als Onlinehilfe bereit-
gestellt, auf die Sie von GIMP aus jederzeit durch drücken der F1 Taste zugreifen können. Lesen Sie
weiter und freuen Sie sich auf viel digitale Farbe und eine bunte Welt mit GIMP.

1.1.3. Funktionen und Möglichkeiten

In der folgenden Liste finden Sie eine kurze Übersicht über eine Auswahl der Funktionen und Möglichkeiten
die GIMP Ihnen bietet:

• Eine große Auswahl an Malwerkzeugen, inklusive Pinsel, Stifte, einer Sprühpistole (Airbrush),
einem Klonwerkzeug und vielem mehr,

• Ein cleveres Speichermanagement, welches Ihnen die Arbeit mit sehr großen Bildern ermöglicht
und nur durch den verfügbaren Speicherplatz auf der Festplatte Ihres Computers beschränkt ist,

• Qualitativ hochwertige Werkzeuge, welche auf Subpixelebene arbeiten und ”Treppenstufen“ durch
Anti-Aliasing vermeiden,

• die Unterstützung von Alphakanälen für die Arbeit mit Transparenz,

• Ebenen und Kanäle,

• eine eigene Programmiersprache ”Skript-Fu“ mit der Sie auf viele Funktionen von GIMP in eige-
nen Skripten zugreifen können,
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• die Möglichkeit eigenen Skripte zu entwickeln, um spezielle Aufgaben effizient zu lösen,

• wiederholbare Funktionen zum rückgängig machen und wiederholen von Arbeitsschritten,

• Transformationswerkzeuge wie Rotieren, Skalieren, Scheren und Spiegeln,

• lesen und schreiben verschiedenster Dateiformate wie beispielsweise GIF, JPEG, PNG, XPM, TIFF,
TGA, MPEG, PS, PDF, PCX, BMP und viele anderen

• Auswahlwerkzeuge inklusive rechteckiger-, elliptischer-, freier- unscharfer Auswahl (Zauberstab),
sowie ein Pfadwerkzeug und eine magnetische Schere,

• und zu guter letzt: die Möglichkeit GIMP durch verschiedenste Erweiterungen um neue Dateifor-
mate, Filter und Funktionen zu bereichern.

1.2. Was gibt es Neues in GIMP?

GIMP 1.0 wurde schrittweise in die sehr stabile und weit verbreitete Version 1.2 weiterentwickelt. Drei
Jahre später, als sich die Entwicklung dem nächsten stabilen Stand näherte, wurde entschieden, dass
die Menge der teilweise grundlegenden Änderungen an GIMP eine Veröffentlichung unter der Versi-
onsnummer 2.0 rechtfertigte. GIMP 2.0.0 wurde am 23. März 2004 freigegeben. Für die darauf folgende
Version 2.2 strebten die Entwickler einen kurzen Entwicklungszeitraum an, da die Einführung einiger
neuer, wichtiger Funktionen keine tiefgreifenden Änderungen an den Programmstrukturen erforder-
lich machte. GIMP 2.2 wurde bereits am 19. Dezember 2004 freigegeben. In den folgenden Abschnitten
werden die wichtigsten Änderungen der GIMP Versionen 2.0 und 2.2 beschrieben.

Hier folgt eine kurze Beschreibung der Änderungen in GIMP 2.2 im Vergleich zu GIMP 2.0. Neben
den hier beschriebenen neuen Funktionen gab es noch eine Menge weiterer, kleinerer Änderungen,
welche erfahrene GIMP Anwender bemerken und lieben (oder auch nicht) werden, die wegen der hohen
Anzahl hier jedoch nicht im Einzelnen aufgeführt sind. Weiterhin gab es einige Änderungen bei der
Programmierung von Erweiterungen und Skripten, welche an dieser Stelle aber auch nicht beschrieben
werden.

1.2.1. Programmübergreifende Zusammenarbeit und Unterstützung von
Standards

• Sie können Bilder per ”Drag and Drop“ und ”Cut, Copy, Paste“ mit allen Programmen austau-
schen, welche den Datentyp ”image/png“ unterstützen. Momentan sind dies beispielsweise Abiword
und Kword . Gleiches gilt für den Datentyp ”image/xml+svg“ , der beispielsweise von Inkscape
unterstützt wird. Mit letzterem lassen sich sehr einfach Pfade austauschen.

• Muster können jetzt jedes in GtkPixbuf unterstützte Format haben, inklusive png, jpeg, xbm und
Anderen.

• Sie können mit GIMP Farbverläufe aus SVG Dateien und Paletten von ACT und RIFF Dateien
laden.

• Die Unterstützung für ”Drag and Drop“ in GIMP wurde erweitert. Sie können nun Dateien und
URI’s in ein Bildfenster ziehen und diese werden dann automatisch im entsprechenden Bild in
eine neue Ebene geladen.

1.2.2. Editor für die Tastenkürzel

Sie können jetzt ein einem eigens dafür vorgesehenen Dialog selbst Tastenkürzel für die verschiedens-
ten GIMP Funktionen vergeben. Diese Möglichkeit steht Ihnen zusätzlich zu den seit der Version 1.2
vorhandenen Dynamischen Tastenkürzeln zur Verfügung.
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1.2.3. Vorschau in Filtern

Für die Entwickler von Erweiterungen (wie zum Beispiel Filtern) steht jetzt ein ”Widget“ zur Verfügung,
welches den Aufwand für die Erzeugung einer Vorschau erheblich reduziert. David Odin hat dieses
Element in alle derzeit vorhandenen Filter eingebaut, so dass jetzt sehr viele Filter über eine stets aktua-
lisierte Vorschau verfügen. Außerdem wird dadurch das Verhalten der Vorschau in den verschiedenen
Filtern sehr viel einheitlicher.

1.2.4. Echtzeitvorschau in den Transformationswerkzeugen

Die Transformationswerkzeuge (Scheren, Skalieren, Perspektive und Drehen) verfügen jetzt über eine
Vorschau auf das Ergebnis, sofern das Werkzeug im traditionellen Modus ausgeführt wird. Zuvor konn-
te die Vorschau lediglich als Gitter angezeigt werden.

1.2.5. Konformität zu den GNOME Richtlinien für Benutzeroberflächen (GNOME
HIG)

In dieser Version wurde viel Arbeit darauf verwendet die Oberfläche von GIMP einfacher und für neue
Anwender verständlicher zu gestalten. Viele Dialoge halten sich nun an die GNOME Richtlinien zur
Gestaltung von Benutzeroberflächen. Zusätzlich wurden viele Dialoge herausgetrennt und ”erweiterte“
Einstellungen durch sinnvolle Standardeinstellungen ersetzt oder zumindest ausgeblendet.

1.2.6. Migration zu GTK+ 2.4

• Menüs werden jetzt unter Verwendung der Klasse GtkUIManager dynamisch aus XML Beschrei-
bungsdateien aufgebaut.

• Überall in GIMP wird nun ein überarbeiteter Dateiauswahldialog zum Laden und Speichern von
Dateien verwendet. Dieser hat zum Beispiel den großen Vorteil, dass Sie darin Favoriten anlegen
können, welche einen schnellen Zugriff auf häufig benutzte Verzeichnisse erlauben.

• GIMP unterstützt seit dieser Version ARGB Symbole für den Mauszeiger, sofern diese Symbole
auf Ihrem System verfügbar sind.

1.2.7. Grundlegende Unterstützung von Vektoren

Durch Verwendung der GIMP Erweiterung GFig bietet sich jetzt eine grundlegende Möglichkeit Vekto-
ren zu verwenden. Die GFig Erweiterung unterstützt eine Reihe von vektorbasierten Grafikfunktionen
wie Füllen mit einem Verlauf oder Bezierkurven. Es bietet außerdem die Möglichkeit sehr einfach Poly-
gone in GIMP zu zeichnen. In GIMP 2.2 können Sie mit GFig Ebenen erstellen und diese Ebenen dann
auch mit GFig weiterbearbeiten. Obgleich die Möglichkeiten der Arbeit mit Vektoren im Vergleich zu
speziellen Programmen wie Inkscape sehr primitiv wirkt, so sind sie doch ein erster Schritt.

1.2.8. Ausserdem ...

Es gibt viele weitere kleine Verbesserungen, darunter auch solche die für den Anwender direkt sichtbar
sind. Eine verkürzte Zusammenstellung enthält die folgende Liste.

• Es ist jetzt möglich GIMP im ”Batchmodus“ auszuführen, ohne einen X Server zu starten.

• Es gibt ein GIMP Programm (GIMP Konsole), welches völlig unabhängig von GTK+ ist.

• Der Dialog für erweiterte Eingabegeräte (wie Zeichenstifte) wurde verbessert.

• Das Werkzeugfenster ist jetzt konfigurierbar. Sie können bestimmen welche Werkzeuge angezeigt
werden sollen und welche nicht.

• Ein Histogramm ist für die R, G und B Histogramme im Dialogfenster ”Werte“ hinterlegt und
wird speziell für eine im Bild befindliche Auswahl berechnet.

• Tastenkürzel werden jetzt in allen GIMP Fenstern gemeinsam genutzt.
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1.3. Starthilfen

Alle aktuellen Betriebssysteme stellen Ihnen eine Oberfläche zur Verfügung, wo Sie zum Starten von
Programmen lediglich auf das zugehörige Symbol doppelklicken müssen. Dies ist auch für GIMP der
Fall. Alternativ können Sie es jedoch auch durch Eingabe von gimp auf der Kommandozeile starten.
Sollten Sie mehrere GIMP Versionen installiert haben, wird es nötig sein GIMP explizit mit dem Kom-
mando gimp-2.2 zu starten. Zusätzlich zu diesem Kommando können Sie verschiedene Parameter und
Dateinamen angeben, um zum Beispiel mehrere Bilder gleichzeitig zu öffnen.

Außerdem können Sie bei den meisten Betriebssystemen Bilddateien mit GIMP assoziieren, so dass
das Programm automatisch gestartet wird, wenn Sie eine Bilddatei ”doppelklicken“.

TIPP

Wenn Sie möchten, dass GIMP automatisch beim Bearbeiten ihrer Bilder
geöffnet wird, sollten Sie statt gimp lieber das Programm gimp-remote mit den
Bildern assoziieren. Sollte GIMP schon im Hintergrund laufen, werden mit Hilfe
von gimp-remote die Bilder im laufenden Programm gestartet, anstatt fuer jedes
Bild eine neue GIMP Instanz zu starten.

1.3.1. Kommandozeilenparameter

Kommandozeilenparameter können sehr nützlich sein, sind aber optional. Die folgende Liste der Para-
meter ist abhängig vom verwendeten Betriebssystem und der verwendeten GIMP Version. Unter Unix
ähnlichen Betriebssystemen können Sie eine komplette Liste in der Manpage ( man gimp ) erfragen.

-h, –help Zeigt eine Liste aller verfügbaren Parameter.

-v, –version Zeigt die GIMP Version.

–verbose Zeigt detailierte Startmeldungen.

-d, –no-data Öffne keine Muster, Gradienten, Farbpaletten oder Pinsel. Dies ist sinnvoll in nicht-interaktiven
Umgebungen, um die Startzeit zu minimieren.

–display display Benutze die angegebene X Anzeige (nicht verfügbar unter Microsoft Windows)

-s, –no-splash Zeige keinen Startbildschirm.

–session name Verwendet ein anderes Sitzungsprofil.

-g, –gimprc gimprc Ein alternatives gimprc-Profil verwenden.

-c, –console-messages Warnungen im Terminal statt in einem Dialog ausgeben.

-b, –batch commands Befehle im Stapelmodus ausführen. Die Befehle werden normalerweise in Form
eines Scriptes angegeben. Sollte - angegeben sein, werden die Kommandos von der Standardein-
gabe gelesen.
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1.3.2. Plattformverfügbarkeit

GIMP ist heutzutage das mit am meisten unterstützte Bildbearbeitungsprogramm und erhältlich auf
folgenden Plattformen: GNU/Linux, Apple Mac OS X (Darwin), Microsoft Windows 95, 98, Me, NT4,
2000 und XP, OpenBSD, NetBSD, FreeBSD, Solaris, SunOS, AIX, HP-UX, Tru64, Digital UNIX, OSF/1,
IRIX, OS/2 und BeOS.

Durch den offengelegten Programmcode, kann GIMP leicht auf andere Plattformen portiert werden.
Besuchen Sie für weitere Informationen die Entwickler Seite <http://developer.GIMP.org>.

1.3.3. GIMP auf Deutsch

GIMP bietet eine komplett deutsche Oberfläche. Die Sprache, in der Sie GIMP betreiben möchten, ist
abhängig von den Systemeinstellungen. Sollte eine automatische Erkennung Ihrer gewünschten Sprache
fehlschlagen, ist es möglich, manuell GIMP in Ihrer bevorzugten Sprache zu starten: Linux

1. GNU/Linux: Öffnen Sie eine Konsole und geben Sie folgendes ein:

2. LANGUAGE=de DE GIMP oder LANG=de GIMP um GIMP in Deutsch zu starten. Möchten Sie den
GIMP auf z.B. Französisch starten, ersetzen Sie die Landesbezeichnung de mit fr.

Windows XP

1. Linksklick auf das Symbol Start, anschließend Rechtsklick auf den Eintrag Arbeitsplatz.

2. Im erscheinenden Kontextmenü den Eintrag Eigenschaften wählen.

3. Im jetzt erscheinenden Dialogfeld Systemeigenschaften die Registerkarte Erweitert auswählen,
dann auf die Schaltfläche Umgebungsvariable klicken.

4. Sie sehen zwei Schaltflächen mit der Aufschrift Neu. Klicken Sie auf die untere und tragen folgen-
des ein: Name der Variablen: LANG und Wert der Variablen de, fr, en, ...

Apple Mac OS X

1. Öffnen Sie die Systemeinstellungen, klicken auf das Symbol Landeseinstellungen.

2. Wählen den Reiter Sprache aus. Die Sprache die Sie für GIMP bevorzugen, sollte in der Liste an
erster Stelle stehen.

1.4. GIMP das erste Mal starten

Durch den ersten Start von GIMP, wird ein neuer Ordner in ihrem Benutzerverzeichnis eingerichtet.
Dieser Ordner, .gimp-2.2 genannt 1 , enthält zukünftigen alle Ihre persönlichen Einstellungen, Pinsel-
formen, Muster, Farbpaletten und andere Dinge die Sie für Ihre Arbeit mit GIMP benötigen. Sollten Sie
diesen Ordner verschieben oder löschen, wird GIMP beim nächsten Start diesen Ordner wieder anlegen.
Nützlich kann dies sein, wenn Sie verschiedene Einstellungen ausprobieren und das Programm wieder
auf Vorgabewerte zurücksetzen möchten. Bedenken Sie dabei, dass alle ihre eigenen Pinselformen, Mus-
ter oder Paletten ebenso gelöscht werden.

Größtenteils ist das Einrichten von GIMP wirklich einfach, da für die meisten Benutzer die Vorga-
bewerte ausreichend sind. Änderungen an den Einstellungen können Sie später im Einstellungsdialog
vornehmen. Empfehlenswert ist, die Größe des Arbeitsspeichers den sie GIMP zur Verfügung stellen
möchten anzupassen.

Folgend begleiten wir Sie beim Einrichtungsprozess und geben Ihnen einige Hintergrundinformatio-
nen:

1. Als erstes wird Ihnen die Lizenz unter die GIMP vertrieben wird angezeigt. Sie sehen die GNU
General Public License, die Sie mit einem Mausklick auf die Weiter Schaltfläche akzeptieren.

2. Falls Sie auf Ihrem Computer bereits eine ältere Version von GIMP installiert hatten, könnnen
Sie Ihre alten Einstellungen übernehmen. In diesem Fall werden die folgenden Dialoge nicht mehr
angezeigt und Sie können sofort damit beginnen in der neuen Version auf Entdeckertour zu gehen.

1 Die Endung des Ordners ist Versions abhängig. Analog zur GIMP Version 2.2, wird der Ordner auch automatisch .gimp-2.2
genannt.
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Abbildung 1.1. Willkommen. Die ”Willkommen“ Ansicht des Einrichtungsassistenten.

3. Sie sehen alle Dateien die in ihrem GIMP Ordner angelegt werden. Wenn Sie wissen möchten
welche Bedeutung jede Datei im Ordner hat, klicken Sie einfach mit der Maus darauf.

4. Dieses Fenster zeigt die Dateien die GIMP bei der Installation im GIMP Ordner angelegt hat. Ne-
ben jeder erstellen Datein ist zu sehen, ob die Erstellung erfolgreich oder mit Fehler verbunden
war. Sollte letzteres der Fall sein, überprüfen sie bitte, ob sie Schreibzugriff auf diesen Bereich der
Festplatte haben und ausreichend Speicherplatz zur Verfügung steht.

5. Sie können in dieser Ansicht die Größe des Datenspeichers, sowie den Auslagerungsordner anpas-
sen. Das Finden einer optimalen Größe für den Datenspeicher ist leider nicht einfach. Faustformel
für einen guten Wert sind ¾ des zur Verfügung stehenden Arbeitsspeichers. Für Hintergrundin-
formationen schauen Sie bitte unter Größe des Datenspeichers nach. Das Anpassen des Datenspei-
chers kann ebenfalls bei Resourcenproblemen nötig sein.

Ein empfehlenswerter Auslagerungsordner ist unter Unix /tmp. Ansonsten wird der Auslage-
rungsordner in ihrem Benutzerverzeichnis angelegt.

Es kann los gehen... Nachdem Sie nun GIMP personalisiert haben, dürfen Sie in die Welt der Gra-
fikbearbeitung eintauchen. Bevor Sie sich in Ihr Vergnügen stürzen, kurz noch zwei Hinweise:
Nach jedem Start des Programms werden Ihnen Tipps über Funktionen und Vorgehensweisen an-
gezeigt, die Ihnen bei der täglichen Arbeit nützlich sein könnten. Sollten Sie gerade erst in das
Thema Bildbearbeitung oder in GIMP einsteigen, schauen Sie sich die Tipps an, bevor Sie sie in
den Einstellungen abstellen. Die Tipps können Sie auch manuell unter Help → Tipps anschau-
en. Sollten Ihnen während der Arbeit GIMP ”einfrieren“, geben wir Ihnen unter Problemlösungen
Hilfe um in diesem Fall genau das Richtige zu tun.

Aber jetzt ersteinmal: Happy GIMPing!

24
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Abbildung 1.2. Profil aktualisieren. GIMP bietet Ihnen an die Einstellungen einer alten Version zu
übernehmen

Abbildung 1.3. Persönlicher GIMP Ordner. Die Ansicht zur Erstellung des persönlichen GIMP Ordners.

25



1.4. GIMP DAS ERSTE MAL STARTEN KAPITEL 1. EINFÜHRUNG

Abbildung 1.4. Benutzerinstallation Logbuch. Das Logbuch zur Installation des GIMP Ordners.

Abbildung 1.5. Die Leistungsfähigkeit von GIMP. Der Dialog zur Verbesserung der Arbeitsgeschwin-
digkeit von GIMP
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2. Konzepte

2.1. Die GIMP Benutzeroberfläche

Abbildung 2.1. GIMP Fensteranordnung in der Standardeinstellung

1
2
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Die Fensteraufteilung von GIMP umfasst in der Standardeinstellung die folgenden drei Fenster:

1. Werkzeugfenster/Werkzeugkasten: Das Werkzeugfenster ist das ”Herz“ von GIMP . Es beinhaltet spe-
zielle Menüeinträge, sowie eine ganze Reihe von Werkzeugen die für die Bildbearbeitung un-
erlässlich sind. Wenn Sie das Werkzeugfenster schließen, wird GIMP beendet, zur Sicherheit be-
kommen Sie jedoch zuvor eine Warnung angezeigt.

2. Werkzeugeinstellungen: Unter dem Werkzeugfenster befindet sich der Dialog für die Werkzeugein-
stellungen, welcher die Eigenschaften des jeweils aktiven Werkzeuges anzeigt.

3. Bildfenster: Jedes in GIMP geladene Bild wird in einem eigenen Bildfenster geöffnet. Daher können
Sie nahezu beliebig viele Bilder gleichzeitig öffnen. Deren Anzahl hängt letztlich nur von den
verfügbaren Systemresourcen ab.
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4. Ebenendialog: Der Ebenendialog ist für die Ebenenverwaltung zuständig. Es ist möglich Bildbear-
beitung auch ohne Ebenen zu betreiben, jedoch werden halbwegs fortgeschrittene Benutzer ohne
Ebenendialog kaum auskommen.

5. Pinselformen/Muster/Farbverläufe: Unter dem Ebendialog befinden sich die Dialoge für die Verwal-
tung von Pinselformen, Mustern und Farbverläufen.

Das Bildschirmfoto zeigt die Fensteranordnung der Standardeinstellung. Es gibt noch weitere Dialo-
ge für jeden möglichen Zweck, jedoch werden diese größtenteils zweckgebunden aufgerufen und ge-
schlossen. Das Werkzeugfenster ist in den allermeisten Fällen der Ausgangspunkt der Bildbearbeitung
mit GIMP. Es bietet neben den Werkzeugen den schnellen Zugriff auf wichtige Dialoge.

ANMERKUNG

Möchten Sie zum voreingestellten Fensterlayout zurückkehren, geht das schnell
und einfach, indem Sie ein neues Dock erstellen: Datei → Dialoge → Dock
hinzufügen → Ebenen, Kanäle und Pfade erstellt den Ebenendialog wie oben
gezeigt. Im selben Menü erstellen Sie den Dialog für die Werkzeugeinstellungen:
Datei → Dialoge → Werkzeugeinstellungen Diesen Dialog können Sie wieder
unter das Werkzeugfenster docken.

Im Gegensatz zu anderen Programmen, ist es unter GIMP nicht möglich alle Elemente der Benut-
zeroberfläche wie Dialoge und Bildfenster in einem Fenster zusammenzufassen. Die Entwickler sind
der Meinung, das dies bei der Arbeit mit GIMP eher hinderlich ist. Außerdem müsste das Programm
zusätzliche Funktionen zur Fensterverwaltung mitbringen, eine Aufgabe die ein geeigneter Fensterma-
nager um einiges besser bewältigen kann; vor allem auch über mehrere Monitore hinweg.

Frühere Versionen von GIMP gingen, wenn es um das Öffnen von neuen Dialogen ging, sehr ver-
schwenderisch mit dem Platz auf Ihrem Bildschirm um. Fortgeschrittene Benutzer hatten viel zu vie-
le Dialoge geöffnet, was nicht nur sehr viel Platz benötigte, sondern es auch schwerer machte den
Überblick zu behalten. Seit GIMP 2.0 gibt es eine neue Art, um Dialoge zu verwalten: Docks. Docks
wirken mehr als Container, die die vielen Dialoge zu einem Fenster zusammenfassen. Das System sebst
ist leicht zu handhaben; es braucht jedoch etwas Zeit, um es als Anfänger zu erlernen.

Folgende Abschnitte gehen ausführlicher in die Verwendung verschiedener Dialoge ein. Sobald Sie
dieses Kapitel gelesen haben, sollten Sie mit dem Handwerkszeug vertraut sein, um GIMP in einer
ganzen Reihe von Dingen im Alltag einsetzen zu können. Sie können einen weiteren Streifzug durch
den Rest des Handbuchs unternehmen und viel Neues erlernen.

2.1.1. Das Werkzeugfenster

Abbildung 2.2. Das GIMP Werkzeugfenster
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Das Werkzeugfenster ist das Herzstück von GIMP. Es ist das einzige Fenster von dem alle anderen
Dialogfenster der Applikation abhängig sind. Folgend eine kurze Beschreibung der Bereiche des Werk-
zeugfensters.
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TIPP

Im Werkzeugfenster, wie auch in Dialogen oder Menüs, können Sie sich von
GIMP kurze Erklärungen geben lassen. Bewegen Sie hierzu den Mauszeiger
über eine Schaltfläche und verharren Sie dort mit der Maus einige Sekunden. Die
Minihilfe wird automatisch eingeblendet. Ausserdem können Sie F1 drücken, um
den Hilfebrowser zu öffnen, der Ihnen eine ausführlichere Seite der Onlinehilfe
mit einer Beschreibung der aktuellen Schaltfläche oder Funktion anzeigt.

1. Werkzeugfenstermenü: Das Spezielle an diesem Menü ist, dass es Funktionen enthält die Ihnen aus-
schließlich im Werkzeugfenster und nicht im Bildfenster zur Verfügung stehen. Insbesondere fin-
den Sie in diesem Menü eine große Menge von Funktionen, um Bilder zu öffnen, zu laden oder
neu zu erzeugen. Weitere Informationen finden Sie im Abschnitt 9.2 auf Seite 215.

2. Werkzeugsymbole: Durch einen Mausklick auf eines dieser Symbole aktivieren Sie das symbolisier-
te Werkzeug. GIMP stellt Ihnen verschiedenste Werkzeuge aus den Kategorien ”Auswahlwerk-
zeug“, ”Malwerkzeug“, ”Transformationswerkzeug“ und ”Sonstiges“ zur Verfügung. Weitere In-
formationen über die GIMP Werkzeuge und wie Sie mit diesen Arbeiten können finden Sie im
Abschnitt 7.1 auf Seite 75.

3. Vordergrund-/Hintergrundfarbe: Der Farbbereich des Werkzeugfensters zeigt die aktuelle Vor- und
Hintergrundfarbe, die von verschiedenen Dialogen benutzt wird. Durch klicken auf eines der bei-
den Schaltflächen öffnet sich der Farbdialog. Mit dem Pfeil lassen sich die Farben jeweils vertau-
schen. Um die Farben auf die Voreinstellungswerte Schwarz und Weiss zurückzusetzen, benutzen
Sie das kleine Symbol rechts unten.

4. Pinsel/Muster/Verlauf Diese Miniaturbilder zeigen GIMPs aktuell ausgewählten Pinsel, Muster und
Farbverlauf. Der Pinsel kann sowohl zum Zeichnen im herkömmlichen Sinn benutzt werden, als
auch zum Radieren und Verschmieren. So benutzen nicht nur die Malwerkzeuge Pinseleinstellun-
gen. Muster beispielsweise werden vom Fülleimer benutzt, um Flächen mit dem ausgewählten
Muster zu füllen. Der Verlauf kommt ins Spiel, wenn man viele Farben braucht um eine bestimm-
ten Bildbereich zu füllen. Durch klicken auf eines dieser Miniaturbilder erreichen Sie den jeweili-
gen Dialog, um entweder einen neuen Pinsel, Verlauf oder ein neues Muster auszuwählen.

5. Aktives Bild: Wenn Sie in GIMP mit vielen Bildern arbeiten, gibt es immer genau eines, auf welchem
Sie Operationen ausführen können. Das aktive oder aktuelle Bild zeigt ihnen GIMP in diesem
Bereich als Miniaturbild an. Klicken Sie auf dieses Miniaturbild öffnet GIMP einen Dialog, der
Ihnen alle derzeit geöffneten Bilder anzeigt.

ANMERKUNG

Diese Funktion ist in den GIMP Standardeinstellungen deaktiviert. Sie
können diese im Dialog Einstellungen Werkzeugfenster einschalten.
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ANMERKUNG

Bei jedem Start von GIMP wird das Standardwerkzeug mit der Standardfarbe,
der Standardpinselspitze und dem Standardmuster aktiviert. Wenn Sie es bevor-
zugen, dass GIMP mit der zuletzt verwendeten Einstellung startet, können Sie
dies im Dialog Einstellungen im Punkt Gerätestatus beim Beenden speichern.

2.1.2. Das Bildfenster

Abbildung 2.3. Das Bildfenster mit seinen wichtigsten Komponenten
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In GIMP wird jedes Bild in einem eigenen Fenster geöffnet. Die folgenden Abschnitte beschreiben die
wichtigsten Elemente des Bildfensters, welche in den Standardeinstellungen sichtbar sind. Einige dieser
Elemente können über Kommandos im Menü Ansicht ausgeblendet werden.

1. Titelzeile: Im oberen Bereich des Fensters befindet sich die Titelzeile in welcher verschiedene Infor-
mationen angezeigt werden. Da dieser Bereich des Fensters nicht von GIMP selbst, sondern vom
Betriebssystem Ihres Computers verwaltet wird, kann sich das Aussehen von dem hier gezeigten
unterscheiden. Die dargestellten Informationen bleiben jedoch gleich. Sie können in den Einstel-
lungen unter Bildfenster die angezeigten Informationen beeinflussen.

2. Bildmenü: Genau unter der Titelzeile befindet sich die Menüzeile des Bildfensters. Dieses Menü er-
laub Ihnen einen Zugriff auf fast alle Operationen und Werkzeuge, welche in GIMP zur Verfügung
steht. Das Bildmenü ist ausserdem mit einem rechten Mausklick 1 auf das Bild zu erreichen.

3. Menüschaltfläche: Durch klicken auf die Menüschaltfläche erreichen Sie das Bildmenü als Kontext-
menü. Um dieses per Tastatur aufzurufen, können Sie Shift–F10 verwenden.

4. Lineal: In einer voreingestellten Anzeige des Bildfensters erscheinen Lineale an der oberen und lin-
ken Kante. Diese Lineale beschreiben die aktuellen Koordinaten des Bildes. In der Standardeinstel-
lung wird als Maßeinheit für die Lineale ”Pixel“ verwendet. Dies können Sie jedoch ganz einfach
über eine Schaltfläche am unteren Bildrand ändern.

Eine der wichtigsten Eigenschaften der Lineale ist, dass Sie aus ihnen die Hilfslinien ”herauszie-
hen“ können. Probieren Sie es einfach einmal aus: Klicken Sie auf ein Lineal und ziehen Sie bei
gedrückter Maustaste eine Hilfslinie in das Bild. Sehr einfach - sehr hilfreich!

1 Benutzer eines Apple Macintosh mit einer Eintastenmaus können das Kontextmenü durch drücken von Ctrl–Maustaste errei-
chen.
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5. QuickMask Schaltfläche: Mit der QuickMask Schaltfläche können Sie die QuickMask aktivieren und
deaktivieren. Die Maske selber ist eine alternative Ansicht um Auswahlen zu bearbeiten. Detail-
lierte Informationen hierzu finden Sie im Abschnitt 8.2.2.5 auf Seite 164

6. Mauszeigerkoordinaten: Die Koordinaten des Mauszeigers im aktuellen Bild werden in diesem Bereich
eingeblendet. Die Einheiten der Koordinaten (x, y im Koordinatensystem des Bildes) können mit
der angrenzenden Schaltfläche verändert werden.

7. Einheitenmenü: Die voreingestellte Maßeinheit in GIMP ist Pixel. Diese Maßeinheit wird von Werk-
zeugen, Linealen und vielen anderen Dingen in GIMP benutzt. Durch klicken auf die Schaltfläche
können Sie die Maßeinheit auf cm, inch oder andere, verändern

8. Zoom Schaltfläche: Sie können die Zoom-Stufe durch Klicken auf diese Schaltfläche beliebig verändern.

9. Statuszeile: Die Statuszeile zeigt die aktuelle Ebene auf der gezeichnet wird, sowie die Größe des der-
zeit vom Bild benutzten Speichers. Bei Zeitintensiven Operationen verändert sich die Statuszeile
zu einer Fortschrittsanzeige.

10. Abbrechen Schaltfläche: Mit der Abbrechen Schaltfläche können zeitintensive Operationen abgebro-
chen werden.

ANMERKUNG

Einige GIMP Erweiterungen reagieren sehr langsam auf die Abbrechen
Schaltfläche, welches zu unerwünschten Resultaten führt.

11. Navigationsschaltfläche: Diese kleine Schaltfläche blendet durch Klicken eine Miniaturansicht des
aktuellen Bildes ein, in der navigiert werden kann. So können Sie die aktuelle Ansicht des Bildab-
schnitts beliebig verschieben. Für sehr große Bilder kann auch der Navigationsdialog hilfreich
sein.

12. inaktiver Bildrahmen: Der inaktive Bildrahmen grenzt das eigentlich aktive Bild vom inaktiven Rah-
men ab. Der Rahmen selber kann nur in seiner Farbe verändert werden, wird aber von Operatio-
nen oder Werkzeugen die auf das Bild angewandt werden nicht beeinflusst. Wenn Ebenen größer
als das eigentliche Bild sind, sieht man den Ebenenrahmen im inaktiven Bildrahmen.

13. Bildanzeige: Der wohl wichtigste Teil des Bildfensters ist die Anzeige des Bildes. Um das Bild herum
befindet sich eine gelb - schwarz gestrichelte Linie, welche die Grenzen einer Ebene kennzeichnet.

14. Schaltfläche zur Vergrößerung des Bildfensters: Wenn Sie diese Schaltfläche aktiviert haben, wird bei
Vergrößerung oder Verkleinerung des Bildfensters die Darstellung des Bildes ebenfalls vergrößert
oder verkleinert.

2.1.3. Docks und Dialoge

2.1.3.1. Andockleiste

Seit der GIMP Version 2.0 gibt es für Sie eine höhere Flexibilität, um Dialoge und Fenster anzuordnen.
Anstatt jeden Dialog in seinem eigenen Fenster anzuzeigen, wie es in älteren GIMP Versionen der Fall
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war, können Sie nun Dialoge gruppieren. Dafür stellt Ihnen GIMP Containerfenster – sogenannte Docks
– zur Verfügung, in welchen Dialoge platzier werden können. Einige Ausnahmen gibt es jedoch: Dialog-
fenster die direkt zu bestimmten Aktionen gehören, wie beispielsweise das Dialogfenster, um ein neues
Bild anzulegen oder der GIMP Einstellungsdialog können nicht in einem Dock platziert werden.

Abbildung 2.4. Ein Dock mit hervorgehobenen Andockleisten. An den weiß hervorgehobenen Leisten
können Sie weitere Dialoge andocken

Jedes Dock hat zwei Andockleisten. Im Beispielbild wurden diese weiß eingefärbt, um besser erkenn-
bar zu sein. In der Regel sind diese Leisten eher unscheinbar und die meisten Anwender nehmen diese
gar nicht wahr, bis sie darauf hingewiesen werden. Dies ist sehr schade, denn die Möglichkeit Dialoge
in Docks zusammenzufassen ist sehr mächtig und ermöglicht es Ihnen die GIMP Arbeitsoberfläche so
zusammenzustellen, das Sie optimal arbeiten können.

2.1.3.2. Sensibler Bereich (Dockgriffe)

Jeder dockbare Dialog hat einen sensiblen Bereich an dem Sie ihn greifen und in ein Dock hinein- oder
aus einem Dock herausziehen können. Sie werden beim überfahren des Bereiches merken, dass der
Mauszeiger sich zu einer Hand verändert. Wenn Sie nun auf diesen Bereich klicken, die Maustaste ge-
drückt halten, und den Dialog auf eine Andockleiste eines anderen Docks schieben, können Sie den
Dialog von einem Dock in ein anderes verschieben. Genau so können Sie Dialoge auch aus einem Dock
hinausziehen und erhalten eine neues Dock, welches genau diesen einen Dialog beinhaltet.

Abbildung 2.5. Ein Dialog in einem Dock. Das Bildschirmfoto illustriert den sensiblen Bereich zum
Greifen eines Dialogs aus dem Dock.

Wie Sie auch in dem Beispielbild sehen können, ist es durchaus möglich mehr als einen Dialog in
einem Dock abzulegen. Die einzelnen Dialoge werden dann durch Reiter dargestellt. Durch einen Klick
auf einen solchen Reiter holen Sie den zugehörigen Dialog nach vorn und er wird sichtbar. Die Reiter
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selbst gehören übrigens auch zum sensiblen Bereich eines Dialoges, Sie können Dialoge einfach am
Reiter ziehen und an anderer Stelle auf einem Reiter wieder fallenlassen. Damit können Sie die Reiter
sehr einfach in die von Ihnen gewünschte Reihenfolge bringen.

2.1.3.3. Menü zur Bildauswahl

Manche Docks haben im oberen Bereich ein Menü zur Bildauswahl. Dieses können Sie verwenden, um
auf die aktuell in GIMP geöffneten Bilder zuzugreifen. Ist die Auto Schaltfläche gedrückt, wird GIMP
automatisch das aktuelle Bild an dem Sie zur Zeit arbeiten, in der Liste auswählen.

Abbildung 2.6. Ein Dock mit hervorgehobener Bildauswahl

Standardmäßig zeigt das Ëbenen, Kanäle und Pfad”Dock als einziges dieses Menü zur Bildauswahl.
Sie können es manuell ein- oder ausblenden, indem Sie das Kontrollkästchen Bildauswahl anzeigen
im Reitermenü des Docks aktivieren bzw. deaktiveren.

2.1.3.4. Reitermenü

Abbildung 2.7. Schaltfläche zum Aufruf des Reitermenüs. Ein Dialog mit hervorgehobener Schaltfläche
zum Aufruf des Reitermenüs

In jedem Dialog ist es möglich, dockspezifische Funktionen aus einem Reitermenü auszuwählen. Die
Funktionalität die im Reitermenü eines Docks zur Auswahl erscheint ist von Dock zu Dock unterschied-
lich. Funktionen zum Erstellen von neuen Dialogen, schließen oder lösen von Dialogen sind jedoch bei
jedem Dock gleich.

Das Reitermenü gibt ihnen Zugriff zu folgenden Funktionen:
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Abbildung 2.8. Das Reitermenü des Ebenendialogs

Kontextmenü des aktiven Dialoges Der erste Eintrag des Reitermenüs enthält immer Kopmmandos,
welche vom speziell zum dem aktuell angezeigten Dialog gehören. Dieses Menü ist auch als Kon-
testmenü des Dialoges aufrufbar. 2

Reiter hinzufügen Dieser Menüeintrag splittet sich in ein Untermenü auf, mit dem Sie die Auswahl
aus allen Dialogen haben, die Sie dem Dock hinzufügen können.

Reiter schließen Mit diesem Kommando können Sie den Dialog schließen. Wenn Sie den letzten Dia-
log in einem Dock schließen, wird das Dock ebenfalls geschlossen.

Reiter lösen Dieser Eintrag löst den Dialog aus dem Dock, und erstellt ein neues Dock inklusive Dia-
log. Sie erzielen den gleichen Effekt, wenn Sie den Dialog aus dem Dock ziehen und irgendwo auf
dem Desktop ”fallen“ lassen.

Abbildung 2.9. Die Vorschaugröße im Untermenü des Reitermenüs.

Vorschaugröße

Die meisten Dialoge haben einen Eintrag Vorschaugröße im Reitermenü (siehe Abbildung 2.9
). Dieser Eintrag öffnet ein Untermenü mit einer Liste von Größen für Miniaturbilder im Dialog.
Beispielsweise regelt die Vorschaugröße im Pinseldialog die Größe der angezeigten Pinsel. Vorein-
gestellt ist Medium als Vorschaugröße.

Abbildung 2.10. Reiterstil des Untermenüs im Reitermenü.

Reiterstil

Dieser Eintrag ist nur bei mehreren Dialogen in einem Dock verfügbar (siehe Abbildung 2.10 ). Es
öffnet ein Untermenü mit der Möglichkeit das Aussehen der Reiter zu beeinflussen. Es gibt fünf
Möglichkeiten:

2 Apple Macintosh Benutzer, die mit einer Eintastenmaus arbeiten, können das Kontextmenü durch Drücken von Strg–Maustaste
erreichen.
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Symbol Spezifische Dialogicons werden im Reitermenü angezeigt.

Aktueller Status Dieser Menüeintrag ist nur bei Dialogen verfügbar, die eine Auswahl, z.B. bei
Pinseln, Mustern oder Farbverlauf, darstellen. Es zeigt das aktuell ausgewählte Objekt, wie
z.B. den Pinsel, das Muster oder den Farbverlauf.

Text Bei Auswahl zeigen die Reiter im Dock den Namen des Dialoges.

Symbol und Text Dieser Menüeintrag zeigt die Reiter als Icon in Verbindung mit den Namen der
Dialoge an.

Status und Text Dieser Menüeintrag das aktuell ausgewählte Objekt im Dialog in Verbindung
mit dem Namen des Dialoges an.

Als Liste anzeigen; Als Raster anzeigen Dieser Menüeintrag ist nur bei Dialogen verfügbar, die ei-
ne Auswahl, z.B. bei Pinseln, Mustern oder Farbverlauf, darstellen. Sie können die Anordnung der
Miniaturbilder beeinflussen indem Sie die Einträge im Dialog entweder als Liste oder übersichtlicher,
als Raster anzeigen lassen.

Bildliste anzeigen Ist das Kontrollkästchen aktiviert, wird im oberen Bereich des Docks ein Menü an-
gezeigt, welches die aktuell geöffneten Bilder beinhaltet. Es ist nicht für Dialoge verfügbar, die
sich unter dem Werkzeugfenster befinden.

Automatisch dem aktiven Bild folgen Sobald die Bildauswahl angezeigt wird und das Kontrollkästchen
aktiviert ist, wird das Bild an dem Sie arbeiten in der Bildauswahl automatisch aktiviert.

2.2. Grundlegende GIMP Konzepte

In diesem Abschnitt des Handbuches finden Sie eine kurze Einführung in die wichtigsten Konzepte
und Begriffe. Diese zu verstehen wird Ihnen sehr bei Ihrer Arbeit mit GIMP und beim Lesen des Hand-
buches helfen. Alle Themen, die hier kurz angerissen werden können, sind an einer anderen Stelle des
Handbuches jeweils mit großer Ausführlichkeit dargestellt. An geeigneter Stelle sind Querverweise im
Text enthalten. Falls nicht, empfhelen wir Ihnen einen Blick in den Index, dort finden Sie ganz sicher
noch Anregungen zum weiterlesen.

Übersicht GIMP ist ein Bildbearbeitungsprogramm. Auf der abstraktesten Ebene beinhaltet dies drei
Schritte: (1) Bild laden oder neu anlegen; (2) Bild verändern; (3) Ergebnis speichern.

Bilder laden Je nach dem wie Sie GIMP gestartet haben, wurden möglicherweise ein oder mehre-
re Bilder bereits beim starten geladen. Dies geschieht zum Beispiel, wenn Sie Bilddateien mit
GIMP assoziiert haben und diese dann per Doppelklick öffnen. Ein anderer Weg Bilddateien
in GIMP zu öffnen, ist das Kommando Datei → Öffnen (Abschnitt 9.5.3 auf Seite 225). Dabei
ist GIMP in der Lage Bilder in den verschiedensten Dateiformate zu lesen. Eine, vermutlich
unvollständige Liste finden Sie im Abschnitt 4.1 auf Seite 59. Auf einigen Betriebssystemen
unterstützt GIMP darüber hinaus auch ”Drag’n’Drop“, also das Laden von Dateien in GIMP,
indem Sie die entsprechende Datei einfach auf dem GIMP Werkzeugfenster fallen lassen.
Wenn Sie nicht sicher sind, ob das bei Ihnen funktioniert, probieren Sie es einfach aus. Das
Schlimmste was dabei passieren kann ist, dass Ihr Computer explodiert :) .
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Bilder verändern Gimp verfügt über unendlich viele Wege, um ein Bild zu verändern: Malwerk-
zeuge, Werkzeuge zur Farbkorrektur, Transformationswerkzeuge, Filter und so weiter. Der
größte Teil dieses Handbuches beschäftigt sich damit Ihnen diese Werkzeuge zu erklären
und zu zeigen, was Sie damit anstellen können.

Bilder speichern Wenn Sie mit der Arbeit an einem Bild fertig sein, werden Sie Ihre Änderungen
in der Regel speichern wollen. (Genaugenommen ist es eine gute Idee auch während der Ar-
beit an dem Bild gelegentlich die Zwischenergebnisse zu speichern.) Die meisten der Datei-
formate, welche Gimp lesen kann, können Sie auch zum Speichern Ihrer Bilder verwenden.
Allerdings sollten Sie auf jeden Fall beachten welche speziellen Eigenschaften und Effekte
das von Ihnen gewählte Dateiformat speichern kann. Es gibt nur genau ein Formati in Gimp,
welches alle Funktionen und Effekte die Gimp Ihnen zur Verfügung stellt auch in einer Da-
tei abspeichern kann: XCF. Allerdings hat auch XCF einen Nachteil: Es gibt nich allzuviele
Programme, die XCF Dateien lesen können. Es ist also eine gute Idee Dateien, welche Sie wei-
tergeben möchten zusätzlich in einem anderen Dateiformat wie JPEG oder TIFF zu speichern.

Bilder Bilder sind sozusagen der Dreh- und Angelpunkt von Gimp. Zu beschreiben, was genau ein Bild
ist, ist gar nich so leicht. Auf der einen Seite sind Bilder das, was in einem bestimmten Format wie
JPEG oder TIFF in eine Datei gespeichert wird. Auf der anderen Seite sind es die Inhalte die mit
Gimp in einem Bildfenster bearbeitet werden können. Dabei kann es pro Bild durchaus mehrere
Bildfenster in Gimp geben. Pro Bildfenster kann jedoch immer nur genau ein Bild dargestellt und
bearbeitet werden.

Bilder bestehen, wenn Sie in Gimp geöffnet sind, aus einer ganzen Anzahl von Elementen. Da
sind Auswahlen, Ebenen, Kanäle, Masken und so weiter. Wenn Sie sich ein Bild in Gimp als ein
bemaltes Blatt Papier vorstellen werden Sie nur einen kleinen Bruchteil der Funktionene von Gimp
verstehen und nutzen können. Besser ist schon der Vergleich mit einem dicken Stapel von Folien.
Einige sind farbig, einige durchsichtig und alle übereinander gelegt ergeben das Bild. Diese ein-
zelnen Folien können Kanäle oder Masken sein und zu Ebenen zusammengefasst werden. Das
klingt jetzt möglicherweise alles furchtbar kompliziert, aber es ist eines der wichtigsten Konzepte
in Gimp. Daher sei Ihnen die detailliertere Beschreibung im Abschnitt 2.3 auf der nächsten Seite
sehr zur lektüre empfohlen.

In Gimp ist es durchaus möglich mehrere, ja sogar viele, Bilder gleichzeitig geöffnet zu haben.
Jedes davon kann quasi beliebig groß sein. Um mit diesen riesigen Datenmengen zurechtzukom-
men, verfügt Gimp über ein sehr ausgefeiltes System zur Ressourcenverwaltung.

Ebenen Ebenen sind die Zeichenflächen in Gimp, die Ihre Bildinhalte aufnehmen. Wenn Sie sich also
ein Bild in Gimp als einen großen Stapel von Folien vorstellen, so sind die einzelnen Ebenen jeweils
kleine Stapel von ein bis drei Folien. Ein Bild besteht in Gimp aus mindestens einer Ebene, gerade
bei fortgeschrittenen Anwendern kann es jedoch durchaus vorkommen, dass ein Bild ein dutzend
Ebenen umfasst. Die Ebenen können untereinander nach bestimmten Regeln verknüpft sein und
müssen nicht gleiche Größe haben wie das Bild.

Kanäle Kanäle sind die kleinste Einheit in dem Stapel von Folien aus dem ein Bild in Gimp bildlich ge-
sprochen besteht. Ein Kanal ist genau eine Folie! Ein Kanal besteht aus Pixeln, die jeweil einen von
256 Werten annehmen. Beachten Sie, dass von Werten und nicht von Farben die Rede war. Das ge-
nau ist nämlich der Trick von Kanälen. Um Farben darzustellen werden sogenannte Farbmodelle
verwendet. Jedes Bild in Gimp hat genau ein zugeordnetes Farbmodell. Das gebräuchlichste ist si-
cherlich RGB. Die Primärfarben dieses Modells sind Rot, Grün und Blau. Eine Ebene in einem Bild
im RGB Modus besteht daher aus drei Kanälen, von denen jeder eine der Primärfarben beschreibt.

Auswahlen Es wird, wenn Sie mit einem Bild in Gimp arbeiten, oft der Fall sein, dass Sie eine bestimm-
te Aktion nur auf einem bestimmten Teil des Bildes ausführen wollen. An dieser Stelle kommen
die sogenannten Auswahlen ins Spiel. Eine Auswahl beschreibt eine bestimmte Region im Bild. Im
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Bild werden Auswahlen durch eine animierte, gestrichelte Linie dargestellt. Dabei ist zu beachten,
dass eine Auswahl nicht unbedingt eine ”harte“ Auswahlkante haben muss, es also durchaus Pi-
xel gibt die ”nur ein bisschen“ zur Auswahl gehören. Damit lassen sich Effekte erzeugen, die nicht
hart an der Auswahlkante enden, sondern weich in den nicht zur Auswahl gehörenden Bildbe-
reich übgergehen. Die im Bild angezeigte Kontur der Auswahl kennzeichnet dann den Bereich,
indem die Pixel zu 50% zur Auswahl gehören. Sie können aber den Bereich und die Stärke der
Auswahl jederzeit in der songenannten QuickMask ansehen, die sich über eine Schaltfläche in der
linken unteren Ecke des Bildfensters ein- und ausschalten lässt.

Ein großer Teil des Lernens wie Sie mit Gimp effektiv arbeiten entfällt auf das Problem wie Sie gute
Auswahlen erstellen. Auswahlen, die genau den Bereich des Bildes beinhalten, den Sie verändern
möchten - nicht mehr, aber auch nicht weniger. Weil die Erstellung von Auswahlen eine so zentra-
le Bedeutung in Gimp hat, gibt es eine ganze Reihe von Werkzeugen dafür, ein eigenens Menü mit
verschiedenen Kommandos und die schon angesprochene Schaltfläche, um schnell in den Quick-
Mask Modus umschalten zu können.

Rückgängig machen Nahezu jeden Bearbeitungsschritt in Gimp können Sie rückgängig machen. Mehr
als das - Sie können sogar eine ganze Reihe von Aktionen gleichzeitig rückgängig machen. Dies
ist ausßerordentlich hilfreich, denn es erlaubt Ihnen auch einfach einmal neue Dinge auszupro-
bieren. Wenn eine Aktion oder ein Filter nicht den gewünschten Effekt erzielen, können Sie die
Änderung einfach ungeschehen machen. Allerdings kostet die Aufbewahrung der Arbeitsschritte
die Sie rückgängig machen können Speicher. Daher ist die Anzahl beschränkt. Eine der wenigen
Aktionen, welche Sie nicht rückgängig machen können ist das Schließen eines Bildes in Gimp. Da-
her werden Sie auch in einem Dialogfenster gefragt, ob Sie das Bild wirklich schließen möchten.

Erweiterungen Viele der Dinge, welche Sie in Gimp mit Bildern tun, werden durch die Anwendung
Gimp selbst ausgeführt. Darüber hinaus macht Gimp aber ausgiebig Gebrauch von sogenannten
Erweiterungen. Erweiterungen sind Programmen, die sehr eng mit Gimp zusammenarbeiten und
wie die internen Gimp Kommandos über Menüs oder in Dialogen zur Verfügung stehen. Promi-
nentes Beispiel für Erweiterungen sind die Filter. Einig Gimp Erweiterungen werden mit jedem
Gimp mitgeliefert, es gibt aber noch viele weitere, teils sehr spezielle Erweiterungen, die Sie bei-
spielsweise im Internet finden können. Eine spezielle Art von Erweiterungen sind die Skripte.

Skripte Neben den Erweiterungen, die in der Regel in der Programmiersprache C entwickelt werden,
gibt es noch eine weitere Art von Gimp Erweiterungen - die Gimp Skripte. Die weitaus meis-
ten heute verfügbaren Skripte sind in ”Skript-Fu“ programmiert. Dabei handelt es sich um eine
speziell auf die Bedürfnisse von Gimp angepasste Version der Lisp ähnlichen Programmierspra-
che ”Scheme“. Darüber hinaus ist es auch möglich Skripte in den Sprachen Perl oder Python zu
schreiben, welche mächtiger und flexibler sind als Skript-Fu.

2.3. Mit Bildern arbeiten

2.3.1. Aufbau von Bildern in GIMP

Es mag verlockend sein, sich ein Bild in GIMP einfach als eine Fläche vorzustellen auf der man Zeich-
nen, die man mit Filtern verändern und dann in einem Dateiformat wie JPEG speichern kann. Prinzi-
piell könnten Sie es in der Tat bei dieser Vorstellung belassen, allerdings wird sich Ihnen die Welt von
GIMP dann nur in einem klitzekleinen Ausschnitt präsentieren. Um Ihnen das ganze GIMP Universum
zugänglich zu machen, werden wir Ihnen in diesem Kapitel Begriffe wie Farbmodell, Ebene, Kanal,
Maske und Pfad näher bringen.

Zunächsteinmal ist es wichtig zu wissen, dass sich Bilder grundsätzlich in zwei Klassen einteilen
lassen. Zum einen gibt es Vektorgrafiken. Diese zeichnen sich dadurch aus, dass alle Bildinhalte als
mathematische Formen beschrieben werden 3. Dies hat den großen Vorteil, dass solche Bilder völlig

3 Ein frei verfügbares Programm, um Vektorgrafiken zu bearbeiten ist Inkscape. <http://www.inkscape.org/?lang=de>
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problemlos beliebig vergrößert werden können, ohne dass Stufen oder ähnliches sichtbar werden. Al-
lerdings ist es für viele Bildinhalte wie beispielsweise Digitalfotos sehr kompliziert bis unmöglich diese
in mathematischen Formen wie Linien, Kreisen oder Bögen zu beschreiben.

Hierfür ist die zweite Gruppe von Bildern, als Rastergrafik bezeichnet, sehr viel besser geeignet. Bei
Rastergrafiken werden die Bilder in kleine Punkte, sogenannte Pixel, zerlegt, die in einem Raster aus
Zeilen und Spalten angeordnet die Bildinhalte abbilden. Bilder, welche Sie in GIMP bearbeiten sind im-
mer Rastergrafiken. Bilder haben in GIMP einige sehr wichtige Eigenschaften. Zunächsteinmal ist da die
Anzahl der Zeilen und Spalten in denen Pixel angeordnet sind. Diese bestimmen die Bildgröße (nicht
zu verwechseln mit der Dateigröße, die eine Eigenschaft der Datei ist, in die Sie ein Bild speichern).
Die zweite wichtige Eigenschaft von Bildern neben der Bildgröße ist das Farbmodell. Dieses beschreibt,
welche Farben die Pixel annehmen können und wie diese Farben zusammengesetzt werden. Zu den be-
kanntesten Farbmodellen gehören RGB, CMY(K), HSV und YUV. Alle diese Farbmodelle dienen dazu,
Farben zu beschreiben. Hierzu werden verschiedene Komponenten zur Verfügung gestellt. Das RGB
Modell verwendet beispielsweise als Komponenten die Primärfarben Rot, Grün und Blau, welche in
verschiedenen Verhältnissen addiert werden. Daher ist RGB ein sogenanntes additives Farbmodell. Bei
CMY(K) werden als Komponenten Cyan, Magenta, Yello und Key verwendet, die beim Mischen vonein-
ander subtrahiert werden. CMYK ist daher ein subtraktives Farbmodell. Bei HSV dienen Hue (Farbton),
Saturation (Sättigung) und Value (Intensität) als Komponenten.

Abbildung 2.11. Komponenten der Farbmodelle RGB und CMY

(a) Im RGB Farbmodell ergeben
die Grundfarben Rot, Grün und
Blau zusammengemischt Weiss.
Ein Anwendungsbeispiel ist die
Darstellung von Farben auf ei-
nem Bildschirm

(b) Im CMY(K) Farbmodell er-
geben die Grundfarben Cyan,
Magenta und Yellow zusammen-
gemischt Schwarz. Ein Anwen-
dungsbeispiel ist der Farbdruck,
bei dem oftmals zusätzlich echtes
Schwarz (K) verwendet wird.

Das Farbmodell eines Bildes wird in GIMP als Modus bezeichnet. Neben RGB können sich Bilder
in GIMP auch in den Modi Graustufen oder Indiziert befinden. Die beiden letzteren stellen keine Farb-
modelle im engeren Sinn dar. Ein Graustufenbild ist sozusagen ein Bild mit genau einer Komponente,
nämlich der Helligkeit im Bereich zwischen Schwarz und Weiss. Im Modus indiziert wird eine Palette
vordefinierter Farben verwendet und jedem Pixel eines der 256 Fächer der Palette zugewiesen. Indi-
zierte Bilder haben den Vorteil, dass Sie im Rechner mit wenig Ressourcen dargestellt und gespeichert
werden können. Dieser Vorteil war vor allem in Zeiten der Vernetzung mit langsamen Verbindungen
ein entscheidender Punkt. So waren indizierte Bilder in den Anfängen des World Wide Webs sehr stark
verbreitet. Die anderen oben erwähnten Farbmodelle können in GIMP nicht als Eigenschaft des Bildes
eingestellt werden. Jedoch stehen sie als Farbwähler zur Verfügung und sind, insbesondere im Fall von
HSV, Grundlage verschiedener Filter.

Jede einzelne Komponente eines Farbmodells wird in GIMP als Kanal abgebildet. Bei einem Bild im
RGB Modus werden folglich drei Kanäle, je einer für Rot, Grün und Blau verwendet. Befindet sich das
Bild hingegen im Modus Graustufen, wird lediglich ein Kanal für die Helligkeit verwendet. In jedem
Kanal werden die Werte in 256 Stufen abgebildet. Mit einem Bild im RGB Modus lassen sich daher
256 Rottöne * 256 Grüntöne * 256 Blautöne = 16,8 Millionen verschiedene Farben darstellen, während
ein Bild im Modus Graustufen lediglich über 256 Helligkeitsstufen = Grautöne verfügt. Sie können die
Kanäle eines Bildes in GIMP im Kanaldialog sehen und sogar einzeln bearbeiten.

Neben den Kanälen zur Abbildung des Farbmodells kann ein Bild in GIMP zusätzlich über einen
sogenannten Alphakanal verfügen. Mit diesem können Sie in 256 Stufen einstellen, wie durchsichtig ein
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Abbildung 2.12. Ein Bild im RGB Modus und im Graustufenmodus

(a) Ein Farbbild im RGB Modus mit den
zugehörigen Kanälen für Rot, Grün und
Blau.

(b) Ein Bild im Modus Graustufen mit dem
zugehörigen Kanal für die Helligkeit.

Pixel des Bildes sein soll. Dies ist insbesondere im Zusammenhang mit Ebenen wichtig.

Abbildung 2.13. Ein Bild mit Alphakanal. Ein Farbbild im RGB Modus mit Alphakanal. Der Alphakanal
beschreibt, welche Bildbereiche durchsichtig sein sollen.

Im vorigen Absatz wurde bereits ein Begriff aus der GIMP Welt verwendet, der noch nicht erklärt
wurde: die Ebene. Grob gesagt können Sie sich eine Ebene als eine Art Klarsichtfolie vorstellen, auf
der Sie malen, oder die Sie mit Filtern und all den anderen tollen Werkzeugen von GIMP bearbeiten
können. Was Ebenen in GIMP so nützlich macht, ist dass es davon beliebig viele geben kann. Alle Ebe-
nen liegen in einem Stapel übereinander. Das Gesamtbild ergibt sich, wenn Sie von oben durch den
gesamten Ebenenstapel hindurchschauen. Jede Ebene verfügt über einen eigenen Satz an Kanälen, in-
klusive Alphakanal. Um mit Ebenen arbeiten zu können, sollten Sie sich intensiv mit dem Ebenendialog
(siehe Abschnitt 8.2.1 auf Seite 155) vertraut machen. Dort können Sie unter anderem einstellen welche
Ebenen sichtbar sein sollen und wie die einzelnen Ebenen miteinander verknüpft werden. Außerdem
erhalten Sie im Abschnitt 2.3.3 auf Seite 33 einige nützliche Hinweise zur Arbeit mit Ebenen.

Verschiedene Dateiformate werden als indizierte Bilder in GIMP geöffnet (z.B. GIF, PNG). Viele der
GIMP Werkzeuge und Filter funktionieren durch die begrenzte Anzahl von Farben unter Umständen
nicht auf indizierten Bildern. Daher empfehlen wir Ihnen die geöffneten Bilder nach RGB zu konver-
tieren, bevor das Bild manipuliert wird. Falls nötig kann das bearbeitete Bild wieder zurückkonvertiert
werden.

Mit GIMP ist es sehr einfach ein Bild von einem Modus in einen anderen umzuwandeln. Hierzu steht
Ihnen das Menü Farbe → Modus im Bildfenster zur Verfügung. Bitte beachten Sie jedoch, dass bei der
Umwandlung zum Beispiel von RGB nach Graustufen Informationen verloren gehen können (nämlich
in diesem Fall alle Farbinformationen) und Sie diesen Schritt nicht rückgängig machen können.

ANMERKUNG

Sollten Sie einen Filter benutzen wollen, der ausgegraut im Menü erscheint, liegt
es am falschen Farbmodus der Ebene oder des Bildes. Manche Filter funktionie-
ren nur auf Bilder mit RGB Farbmodus. Manche davon benötigen noch einen
zusätzlichen Alphakanal. Meistens reicht es jedoch aus, den Farbmodus auf
RGB zu ändern.
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2.3.2. Schnelle Maske (QuickMask)

Abbildung 2.14. Bild mit eingeschalteter ”Schneller Maske“

Die Schnelle Maske ist ein sehr hilfreiches Mittel, wenn Sie bei der Erstellung von Auswahlen mit
den normalen Auswahlwerkzeugen nicht weiterkommen. Mit Hilfe der Schnellen Maske können Sie
Auswahlen mit den Malwerkzeugen bearbeiten. Hierzu wird eine halbdurchsichtige, standardmäßig
rot gefärbte, Maske über das Bild gelegt. An allen Stellen, an denen Sie die Maske entfernen, wird eine
Auswahl erstellt.

2.3.2.1. Überblick

Wenn Sie in GIMP eine Auswahl erstellen, wird diese normalerweise durch die ”marschierenden Amei-
sen“ markiert, die an der Auswahlkante ”entlang laufen“. In Wirklichkeit ist eine Auswahl in GIMP
wesentlich mehr, als das was diese Linie entlang der Auswahlkante zeigt. In GIMP ist eine Auswahl ein
vollständiger Kanal, der 256 verschiedene Werte abbilden kann. Pixel dieses Kanals, welche den Wert 0
(Schwarz) haben, sind vollständig unausgewählt, Pixel mit dem Wert 255 (Weiss) hingegen vollständig
ausgewählt. Dazwischen liegen eine ganze Reihe von Werten die als Graustufen im Kanal abgebildet
werden und mit denen Sie eine weiche Auswahlkante erzeugen können. Die in der normalen Ansicht
sichtbaren marschierenden Ameisen markieren dabei lediglich die Linie der Pixel, welche genau zur
Hälfte ausgewählt sind. In Wirklichkeit sind Pixel nicht wirklich drin, oder draussen, sondern es kann
eine unscharfe Übergangszone geben.

Mit der Schnellen Maske haben Sie nicht nur die Möglichkeit diesen unscharfen Übergangsbereich
zu sehen, sondern Sie können diesen damit auch sehr einfach bearbeiten. Um die Schnelle Maske zu
aktivieren gibt es eine Schaltfläche in der linken unteren Ecke des Bildfensters. Mit dieser können Sie
die Schnelle Maske sehr einfach ein- und ausschalten. Alternativ können Sie auch den Menüeintrag
Auswahl → Schnelle Maske aktivieren/deaktivieren, oder das Tastenkürzel Shift–Q verwenden.

In den Standardeinstellungen wird die Schnelle Maske als halbtransparente, rote Maske über das Bild
gelegt. Sollten Sie die Farbe oder Transparenz der Maske ändern wollen, so können Sie dies über das
Kommando Farbe und Deckkraft festlegen im Kontextmenü der Schaltfläche zur Aktivierung der
Schnellen Maske tun.

Wenn Sie die Schnelle Maske aktiviert haben, können Sie alle Malwerkzeuge und viele weitere Kom-
mandos genau so verwenden, als würden Sie das Bild selbst bearbeiten wollen. Um Bereiche zur Aus-
wahl hinzuzufügen müssen Sie einfach nur die Maske an der gewünschten Stelle teilweise oder vollständig
entfernen. Dies geschieht entweder durch Einsatz des Radierers, oder durch malen mit der Farbe weiss.
Um die Maske an einer Stelle wieder herzustellen, übermalen Sie den entsprechenden Bereich einfach
mit Schwarz. Für erfahrende GIMP Anwender ist das ”Malen“ einer Auswahl der einfachste und effek-
tivste Weg zur Erstellung komplizierterer Auswahlen.

TIPP

Sie können eine Auswahl, egal ob Sie diese mit oder ohne die Schnelle Maske
erstellt haben, in einen neuen Kanal speichern. Hierzu darf die Schnelle Maske
nicht aktiviert sein und es muss natürlich eine Auswahl existieren. Dann führen
Sie einfach das Kommando Auswahl → In Kanal speichern aus. Die Auswahl
wird dann in einen neuen Kanal mit dem Namen ”Auswahlmaske-Kopie“ gespei-
chert.
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TIPP

Wenn Sie die Schnelle Maske aktiviert haben, wirken die Kommandos Aus-
schneiden und Einfügen auf der Maske und nicht auf dem Bild selbst. Dies
ist sehr hilfreich, um Auswahlen als Maske von einem Bild in ein anderes zu
übertragen.

Weitere Informationen finden Sie in Abschnitt 8.2.2.5 auf Seite 164 und Abschnitt 8.2.2.4 auf Seite 163.

2.3.2.2. Eigenschaften

Es gibt zwei Eigenschaften, welche Sie über Kommandos im Kontextmenü der Schaltfläche zum Akti-
vieren der Schnellen Maske einstellen können.

• Normalerweise werden die Bereiche aus denen die Auswahl erzeugt wird in der Schnellen Mas-
ke als unmaskierte Bereiche angezeigt und die Bereiche in denen keine Auswahl entsteht durch
einen roten Schleier gekennzeichnet. Sie können diese Darstellung umkehren, indem Sie im Kon-
textmenü das Kommando Maske aus Auswahl, statt des in den Standardeinstellungen aktiven
Maske aus invertierter Auswahl ausführen.

• Durch ausführen des Kommandos Farbe und Deckkraft festlegen, gelangen Sie in einen Dialog,
in dem Sie die Farbe der Maske und die Stärke der Transparenz der Maske einstellen können. Dies
kann hilfreich sein, wenn der Bildbereich in dem Sie arbeiten die gleiche Farbe hat wie die Maske.

2.3.3. Ebenen

Aufgabe dieses Kapitels ist es, Ihnen das Konzept der Ebenen in GIMP näher zu bringen. Nun was sind
also diese ”Ebenen“? Am leichtesten können Sie sich eine Ebene als eine Folie vorstellen, die Sie mit all
den verschiedenen Werkzeugen und Filtern, welche GIMP zur Verfügung stellt, bearbeiten können. Das
schöne an Ebenen in GIMP ist, dass ein Bild beliebig viele davon haben kann. Stellen Sie sich ein Bild in
GIMP einfach als einen Stapel von Folien vor. Was auf dem Bild erscheint, ist das, was sie sehen, wenn
Sie von oben durch den Folienstapel hindurchsehen.

Wie die einzelnen Ebenen angeordnet sind, können Sie im Ebenendialog sehen. Dieser Dialog ist einer
der wichtigsten in GIMP, jedenfalls wenn Sie sich entscheiden mit mehreren Ebenen zu arbeiten. Wie
Sie am besten mit diesem Dialog arbeiten erfahren Sie detailliert in Abschnitt 8.2.1 auf Seite 155. Einige
wichtige Informationen haben wir aber auch in diesem Kapitel für Sie zusammengestellt.

Jedes in GIMP geöffnete Bild hat zu jeder Zeit genau eine aktive Zeichenfläche. Eine Zeichenfläche
ist in GIMP eine Fläche, auf der Sie mindestens mit den Malwerkzeugen arbeiten können. Beispiele für
konkrete Zeichenflächen in GIMP sind Ebenen, aber auch Kanäle, Ebenenmasken und Auswahlmasken.
Wenn eine Ebene in GIMP aktiv ist, erkennen Sie dies daran, dass der zugehörige Eintrag im Ebenendia-
log farbig hervorgehoben wird. Zusätzlich wird der Name der Ebene im Statusbereich, im unteren Rand
des Bildfensters angezeigt. Sollte keine der Ebenen im Ebenendialog aktiviert sein, ist eine andere Zei-
chenfläche aktiv. Sie können eine Ebene aktivieren, indem Sie den zugehörigen Eintrag im Ebenendialog
anklicken.

In der Menüleiste des Bildfensters finden Sie einen Eintrag Ebene. In diesem Menü finden Sie ein
ganze Reihe von Funktionen, die speziell für das Arbeiten mit Ebenen vorgesehen sind. In der Regel
beeinflussen diese Kommandos die aktive Ebene. Die meisten der Kommandos finden Sie auch im Kon-
textmenü des Ebenendialoges.

2.3.3.1. Eigenschaften von Ebenen

Jede Ebene verfügt über eine Reihe von Eigenschaften, welche Ihnen im Folgenden kurz vorgestellt
werden sollen:
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Ebenenname Jede Ebene in GIMP hat einen eindeutigen Namen. Dieser wird automatisch vergeben,
sobald eine Ebene erzeugt wird. Sie können den Namen der Ebene jedoch in einen beliebigen Na-
men ändern, solange der Name noch nicht für eine andere Ebene verwendet wird. Um den Namen
zu ändern, können Sie entweder mit einem Doppelklick auf den Eintrag der Ebene im Ebenendia-
log ein Texteingabefeld aktivieren, oder das Kommando Ebeneneigenschaften im Kontextmenü
des Ebenendialoges aufrufen.

Vorhandensein eines Alphakanals Wie bereits beschrieben, erlauben Alphakanäle es für jedes Pixel
eine Transparenz festzulegen. Ein Alphakanal kann, muss aber nicht, an jeder Ebene eines Bil-
des in GIMP vorhanden sein. Sofern einer vorhanden ist, wird ein Vorschaubild des Kanals im
Kanaldialog angezeigt. Schwarze Bereiche des Alphakanals sind vollständig transparent, an den
weissen Stellen hat die Ebene die volle Deckkraft. Die Grautöne symbolisieren halbtransparente
Bildbereiche.

Jede Ebene, ausser der Hintergrundebene eines Bildes, muss über einen Alphakanal verfügen. Für
die Hintergrundebene kann, muss aber kein Alphakanal vorhanden sein. Sollte eine Ebene noch
nicht über einen Alphakanal verfügen, so können diesen über das entsprechende Kommando im
Kontextmenüs des Ebenendialoges hinzufügen. Altnativ können Sie das Kommando Ebene →
Transparenz → Alphakanal hinzufügen verwenden.

Ebenentyp Der Typ der Ebene wird durch das Farbmodell des GIMP Bildes und das Vorhandensein
des Alphakanals bestimmt. Folgende Typen sind möglich:

• RGB
• RGBA
• Graustufen
• GraustufenA
• Indiziert
• IndiziertA

Der Hauptgrund, dass diese Eigenschaft eine Rolle spielt ist, dass viele Filter in GIMP nicht auf
Ebenen aller Typen angewendet werden können. Sollte ein Filter nicht mit dem aktuellen Ebenen-
typ funktionieren, so wird der entsprechende Menüeintrag deaktiviert. Sollten Sie einen gewünschten
Filter nicht ausführen können, so hilft es zumeist das Bild in den RGB Modus zu wandeln und ge-
gebenenfalls einen Alphakanal hinzuzufügen.

Sichtbarkeit Die Sichtbarkeit ist eine der wichtigsten Eigenschaften von Ebenen. Sie ermöglicht es
Ihnen, Ebenen vorübergehend auszublenden, ohne sie zu löschen. Die meisten Kommandos in
GIMP behandeln ausgeblendete Ebene so, als wären diese gar nicht vorhanden. Die Sichtbarkeit

von Ebenen können Sie mit Hilfe die Schaltfläche sowohl prüfen, als auch steuern. Wird das
Symbol im Ebenendialog vor der fraglichen Ebene angezeigt, so ist die Ebene eingeblendet und
kann mit einem Klick auf das Symbol ausgeblendet werden. Umgekehrt sind Ebenen, für die das
Symbol nicht angezeigt wird ausgeblendet und können mit einem Klick auf das Symbol wieder
eingeblendet werden.

TIPP

Wenn Sie auf die Schaltfläche zum ein- und ausblenden von Ebenen kli-
cken, während Sie die Shift Taste gedrückt halten, können Sie die Sichtbar-
keit aller Ebenen, außer der auf deren Symbol Sie geklickt haben, gleich-
zeitig ändern. Dies ist ist insbesondere dann sehr hilfreich, wenn Sie alle
Ebenen außer einer ausblenden möchten.
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Ebenen gruppieren Zwischen dem Augensymbol und der Vorschau einer Ebene im Ebenendialog be-

findet sich das Symbol . Dieses ermöglicht es Ihnen verschiedene Ebenen zu einer Gruppe zu-
sammenzufassen. Dies ist sehr hilfreich, wenn Sie eine bestimmte Aktion, wie das Verschieben,
nicht nur auf eine Ebene, sondern auf eine bestimmte Menge von Ebenen anwenden möchten. Die
Bedienung erfolgt analog zur Sichtbarkeit von Ebenen, das heißt durch einfaches Anklicken des
Symbols können Sie beliebige Ebenen zur Gruppe hinzufügen oder aus der Gruppe ausschließen.

Ebenengröße In GIMP entspricht die Größe einer Ebene nicht unbedingt der Größe des Bildes zu dem
sie gehört. Wenn Sie beispielsweise das Textwerkzeug anwenden, wird für jeden der Texte eine
eigene Ebene angelegt, deren Größe jeweils exakt der Textgröße entspricht. Im Bildfenster ist die
aktive Ebene von einer gelb-schwarz gestrichelten Linie umrandet, so dass Sie die Größe erkennen
können.

Der Grund weshalb die Ebenengröße wichtig ist, liegt darin, dass Sie in GIMP keinerlei Aktionen
außerhalb der Ebene vornehmen können. Sie können ja nichts bearbeiten, was nicht vorhanden
ist. Was Sie aber tun können, ist eine Ebene zu vergrößern. Hierzu stehen Ihnen verschiedene
Kommandos im untern Teil des Menüs Ebene zur Verfügung.

ANMERKUNG

Die Menge an Hauptspeicher Ihres Computers, den eine Ebene bean-
sprucht, hängt von der Ebenengröße und nicht vom Inhalt der Ebene ab.
Wenn Sie also mit sehr großen Bildern arbeiten, welche noch dazu viele
Ebenen enthalten, ist es empfehlenswert die Größe der Ebenen auf ein
Mindestmaß zu beschränken.

Deckkraft Die Deckkraft einer Ebene bestimmt, wie stark die im Ebenenstapel darunter befindlichen
Ebenen überdeckt werden. Die Deckkraft können Sie für jede Ebene im Bereich von 0 (volle Trans-
parenz) bis 100 (volle Deckkraft) einstellen.

Modus Der Modus einer Ebene bestimmt, wie die Farben oder Helligkeitswerte der Ebene mit den Far-
ben oder Helligkeitswerten der darunter befindlichen Ebenen verknüpft wird. Da es sich hierbei
um eine sehr komplexe und mächtige Eigenschaft handelt, ist der Arbeit mit den Ebenenmodi ein
eigenes Kapitel gewidmet. Weitere Informationen finden Sie daher in Ebenen Modi.

Ebenenmaske Neben dem Alphakanal gibt es noch eine weitere Methode, um die Transparenz einer
Ebene zu kontrollieren: die Ebenenmaske. Dabei handelt es sich um eine Zeichenfläche, die mit der
Ebene verknüpft ist. Sie können die Ebenenmaske über ein Kommando im Kontextmenü des Ebe-
nendialoges zu einer Ebene hinzufügen. Wie die Ebenenmaske wirkt und was Sie damit anstellen
können, wird in einem späteren Kapitel ausführlicher erläutert.

Transparenz erhalten Diese Ebeneneigenschaft finden Sie ebenfalls im Ebenendialog und zwar in des-
sen rechter oberer Ecke in Form eines Kontrollkästchens. Wenn diese Eigenschaft aktiviert ist, wird
der Alphakanal der Ebene geschützt und kann durch nichts verändert werden.

2.3.4. Die Auswahl

Wenn Sie mit GIMP Bilder bearbeiten, werden Sie sehr schnell nach einer Möglichkeit suchen eine Ak-
tion oder einen Filter von GIMP nicht auch das gesamte Bild, sondern lediglich auf einen bestimmten
Bereich des Bildes anzuwenden. Genau zu diesem Zweck gibt es in GIMP das Konzept der Auswahl.
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Abbildung 2.15. Wie würden Sie den Baum aus dem Bild isolieren?

In den verschiedensten Situationen ist das Erstellen der richtigen Auswahl in GIMP der Schlüssel
zum gewünschten Ergebnis. Allerdings kann es recht schwierig sein, die richtige Auswahl zu erhalten.
Nehmen wie einmal an, Sie würden den Baum gern aus dem obigen Bild herauslösen und in einem
anderen Bild vor einen neuen Hintergrund verwenden. Hierzu müssen Sie in einem ersten Schritt eine
Auswahl erstellen, welche ausschließlich den Baum beinhaltet. Dies ist nicht gerade einfach, denn der
Baum hat eine komplexe Form und an manchen Stellen ist es schwer zu entscheiden wo der Baum
aufhört und der Hintergrund beginnt.

Abbildung 2.16. Bild mit Auswahl. Der ausgewählte Bereich wird durch eine gestrichelte Linie gekenn-
zeichnet.

Der nächste Punkt ist sehr wichtig, ja grundlegend für das Verständnis von Auswahlen. Wenn Sie
eine Auswahl erzeugen, sehen Sie normaler Weise eine gestrichelte Linie, welche einen Teil des Bildes
umschließt. Dies könnte leicht zu der Annahme führen, dass die Bildbereiche innerhalb der Linie die
Auswahl darstellen und die Bildteile außerhalb nicht ausgewählt sind. Diese Annahme ist in vielen
Fällen auch zulässig, aber eben nicht immer korrekt.

Eine Auswahl ist in GIMP als Kanal hinterlegt. Ihre technische Struktur ist in der Tat identisch zu
einem Farbkanal für Rot, Grün, Blau oder einem Alphakanal. Daher kann die Auswahl für jeden Pixel
des Bildes einen Wert zwischen 0 (komplett unausgewählt) und 255 (komplett ausgewählt) annehmen.
Der große Vorteil dieses Ansatzes ist, dass er 245 Stufen für teilweise ausgewählte Pixel erlaubt. Sie
werden es schon bald zu schätzen wissen, dass Sie einen weichen Übergang zwischen ausgewählten
und nicht ausgewählten Bildbereichen schaffen können.

Und was stellt dann die gestrichelte Linie dar, welche erscheint, sobald Sie eine Auswahl erzeugen?
Die Antwort darauf ist gar nicht so schwierig: Die Linie zeigt die Kontur, an der Bereiche mit mehr

als halb ausgewählten Pixeln und Bereiche mit weniger als halb ausgewählten Pixeln zusammentreffen.

Abbildung 2.17. Die gleiche Auswahl als Schnelle Maske

Sie sollten, wann immer Ihr Blick auf eine Armee ”laufender Ameisen”, also eine gestrichelte Linie
zur Markierung einer Auswahl, sehen daran denken, dass diese Linie nicht die ganze Wahrheit über die
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Auswahl ist. Einen viel besseren Eindruck über die Beschaffenheit der Auswahl vermittelt die Schnelle
Maske. Das Sie diese über die kleine Schaltfläche in der linken unteren Ecke eines jeden GIMP Bild-
fensters ein- und ausschalten können haben wir ja nun schon häufig genug erwähnt - oder? Wenn die
Auswahl im Modus Schnelle Maske angezeigt wird, werden alle nicht ausgewählten Bildbereiche durch
eine halbtransparente rötliche Maske geschützt. Je weniger rötlich eine Stelle im Bild gefärbt ist, um so

”ausgewählter“ ist sie.
Eine ausführliche Beschreibung der Schnellen Maske finden Sie im Abschnitt 2.3.2 auf Seite 32. Da sich

die Arbeit mit Auswahlen bei aktivierter Schneller Maske doch ein bisschen anders gestaltet, sollten sie
diese nun wieder ausschalten. Dies erreichen Sie durch erneutes Klicken auf, na Sie wissen schon wo ...
.

Abbildung 2.18. Die Auswahl mit weicher Auswahlkante im Modus Schnelle Maske

2.3.4.1. Ausblendung (Weiche Auswahlkante)

Die von GIMP bei der Installation vorgegebenen Werkzeugeinstellungen der Auswahlwerkzeuge er-
zeugen scharfe Auswahlkanten. Die Pixel innerhalb der gestrichelten Linie sind also vollständig, die-
jenigen außerhalb gar ausgewählt. Dies können Sie leicht überprüfen, indem Sie einen Blick auf die
Schnelle Maske werfen. Die Auswahlkante wird durch eine scharfe Kante der Maske ohne rote Zwi-
schentöne dargestellt. Durch Verändern der Werkzeugeinstellungen können Sie jedoch die Eigenschaf-
ten der Auswahlwerkzeuge so verändern, dass diese automatisch eine weiche Auswahlkante erstellen.
Um dieses zu erreichen aktivieren Sie im Dialog Werkzeugeinstellungen die Eigenschaft Kanten aus-
blenden. Mit dem daraufhin erscheinenden Schieberegler Radius können Sie die Breite der weichen
Auswahlkante festlegen. Weitere Informationen zu den Eigenschaften der Auswahlwerkzeuge finden
Sie in Abschnitt 7.2 auf Seite 76.

Um dies auszuprobieren wählen Sie am einfachsten das Werkzeug ”Rechteckige Auswahl“, stellen in
den Eigenschaften eine weiche Auswahlkante von etwas 10 Pixeln ein und erzeugen eine Auswahl in
einem Bild. Wenn Sie sich daraufhin die Schnelle Maske dieser Auswahl ansehen, werden Sie die Breite
Auswahlkante sehr deutlich erkennen.

Das Ausblenden einer Auswahl (also die Erstellung einer Auswahl mit einer weichen Auswahlkante)
ist insbesondere dann sehr hilfreich, wenn Sie Bildobjekte durch Kopieren und Einfügen zu Bildern
hinzufügen und den neuen Bildbestandteil ”weich“ in das vorhandene Bild einfügen wollen.

Neben der Möglichkeit eine Auswahl direkt bei der Erstellung mit einer weichen Auswahlkante zu
versehen, haben Sie jederzeit die Möglichkeit eine bestehenden Auswahl mit einer weichen Auswahl-
kante zu versehen. Hierzu steht Ihnen das Kommando Auswahl → Ausblenden im Menü des Bild-
fensters zur Verfügung. Wenn Sie das Kommando ausführen, erscheint ein Dialogfenster, in welchem
Sie die Breite des Überganges einstellen können. Sollten Sie den Effekt des Ausblendens einer Auswahl
umkehren, also die Auswahlkante schärfen wollen, so steht Ihnen hierzu das Kommando Auswahl →
Schärfen zur Verfügung.

ANMERKUNG

Falls es Sie interessiert, wie das Ausblenden einer Auswahl technisch funktio-
niert: es wird auf den Kanal der die Auswahl repräsentiert ein Gaußscher Weich-
zeichner mit dem eingestellten Radius ausgeführt.
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2.3.4.2. Eine Auswahl teilweise transparent machen

Zwar können Sie die Deckkraft einer Ebene einstellen, aber Sie können dies nicht direkt für eine Aus-
wahl tun. Andererseits ist es sehr sinnvoll das Bild eines Glases transparent zu machen. Der folgende
Abschnitt zeigt Ihnen einige Möglichkeiten auf, dies zu erreichen:

• Für einfache Auswahlen können sie das ”Radierer“ Werkzeug mit der gewünschten Deckkraft
verwenden.

• Für komplexere Auswahlen erzeugen Sie am besten mit dem Kommando Auswahl → Schwe-
bend eine ”Schwebende Auswahl“. Wählen Sie diese im Ebenendialog aus und stellen Sie dort
die Deckkraft auf den gewünschten Wert. Verankern Sie die Auswahl danach wieder. Dies errei-
chen Sie am einfachsten, indem Sie im Kontextmenü der schwebenden Auswahl im Ebenendialog
das Kommando Ebene verankern ausführen.

Falls Sie diese Arbeitsschritte sehr häufig vornehmen müssen, können Sie alternativ: Strg–C ver-
wenden, um die Auswahl in die Zwischenablage zu kopieren, diese dann mittels Ctrl–V als schwe-
bende Auswahl in das Bild einfügen, die gewünschte Deckkraft im Ebenendialog einstellen und
die schwebende Auswahl über das Kommando Ebene→Neue Ebene in eine neue Ebene überführen.

• Eine weitere Möglichkeit den gewünschten Effekt zu erreichen, besteht darin, Eine Ebenenmaske
mit der Auswahl zu erzeugen. Dies können Sie über das Kommando Ebene → Maske → Ebe-
nenmaske hinzufügen erreichen. Hiernach können Sie mit einem Malwerkzeug die gewünschte
Deckkraft (schwarz) auftragen. Weitere Informationen hierzu finden Sie in Abschnitt 8.2.1.3 auf
Seite 158.

2.3.5. Rückgängig (Undo)

Fast jede Aktion welche Sie in GIMP ausführen können Sie rückgängig machen. Um die zuletzt aus-
geführte Aktion zurückzunehmen können Sie das Kommando Bearbeiten → Rückgängig im Menü
des Bildfensters verwenden. Alternativ steht Ihnen das Kommando unter dem Tastaturkürzel Strg–Z
zur Verfügung.

Das Kommando Rückgängig selbst können Sie auch rückgängig machen. Wenn Sie eine Aktion mit
Rückgängig zurückgenommen haben, können Sie diese mit dem Kommando Bearbeiten → Wieder-
holen im Menü des Bildfensters wieder herstellen. Alternativ steht Ihnen dieses Kommando unter dem
Tastaturkürzel Strg–Y zur Verfügung. Um die Auswirkungen eines Kommandos, beispielsweise eines
Filters, gut einschätzen zu können, ist es oft hilfreich schnell zwischen dem Bild vor und nach der
Ausführung des Kommandos umschalten zu können. Mit den beiden hier vorgestellten Kommandos
ist das sehr leicht.

ACHTUNG

Wenn Sie eine oder mehrere Aktionen rückgängig machen, und dann irgend-
ein anderes Kommando als Rückgängig oder Wiederholen verwenden, wird es
nicht mehr möglich sein mittels des Wiederholen Kommandos die rückgängig
gemachten Aktionen zu wiederholen. Diese sind für immer verloren. Die Lösung
hierfür ist, das Bild zu duplizieren und dann auf der Kopie weiterzuarbeiten. Da-
bei müssen Sie wirklich auf der Kopie weiterarbeiten, denn die Rückgängig /
Wiederholen Historie wird nicht mit dupliziert.

Wenn Sie die Kommandos Rückgängig und Wiederholen regelmäßig verwenden, könnten Sie gefal-
len an Dialog Journal finden. Dieser zeigt Ihnen in einer Liste alle Kommandos für das aktuellen Bild
an, die Sie zurücknehmen oder wiederholen können.

Das rückgängig machen von Aktion in GIMP erfolgt auf einer pro Bild geführten Aktionshistorie.
GIMP reserviert für jedes Bild eine bestimmte Speichermenge, um die Aktionshistorie zu führen. Sie
können die Menge an Speicher der für die Historie vorgesehen wird und maßgeblich bestimmt wie
viele Aktionen im Bild rückgängig gemacht werden können selbst in GIMP einstellen. Hierzu steht
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im Bereich Umgebung der GIMP Einstellungen zwei wichtige Eigenschaften. Mit Minimale Anzahl an
Journalschritten können Sie einstellen, wie viele Aktionen GIMP in der Historie eines Bildes verwaltet,
egal wie viel Speicher diese benötigen. Die Eigenschaft Maximaler Speicher für das Journal lässt Sie
hingegeben einstellen, wie viel Speicher GIMP für die Historie jedes Bildes maximal belegt. Wenn diese
Menge verbraucht ist, werden die ältesten Einträge der Historie verworfen.

ANMERKUNG

Bitte beachten Sie, dass das Journal, also die zurücknehmbaren Aktionen eines
Bildes verloren gehen, wenn Sie das Bild speichern. Nichteinmal in GIMPs eige-
nem Dateiformat XCF, welches alle sonstigen Bildeigenschaften speichern kann,
bleibt die Historie erhalten. Wenn Sie ein Bild in GIMP öffnen, wird das Journal
immer neu angelegt.

Die Art und Weise wie die Entwickler von GIMP das Rückgängig machen von Aktionen umgesetzt
haben ist sehr fortschrittlich. Viele der Aktionen erfordern nur sehr wenig Speicher um rückgängig ge-
macht zu werden. Dies führt dazu, dass sehr viele Aktionen im Journal verfügbar sind und rückgängig
gemacht werden können. Das ein- und ausblenden von Ebenen ist so eine Aktion, die Auswirkungen
auf das Bild sind sehr weitreichend, trotzdem wird nur sehr wenig Speicher benötigt, um die Aktion
wieder rückgängig zu machen. Einige Aktionen, auch hier ist das ein- und ausblenden von Ebenen ein
gutes Beispiel, werden darüber hinaus im Journal zusammengefasst. Das bedeutet, dass wenn Sie diese
Aktion mehrfach hintereinander ausführen, wird trotzdem nur ein Eintrag im Journal vorgenommen
und dieser verbraucht dann auch wieder entsprechend wenig Speicher. Auf der anderen Seite gibt es
auch eine ganze Reihe von Aktionen deren Rücknahme eine Menge Speicher benötigt. In diese Katego-
rie gehören auch die Filter. Der Grund hierfür ist, dass Filter in GIMP als Erweiterung eingebunden sind
und es daher für GIMP leider keinen einfachen Weg gibt herauszufinden, was genau das Filter im Bild
verändert hat. Daher muss sich GIMP den kompletten Inhalt der betroffenen Ebene vor der Ausführung
des Filters merken und dies verbraucht je nach Bildgröße eine ganze Menge Speicher.

2.3.5.1. Aktionen die Sie nicht rückgängig machen können

Die Aktionen in GIMP, welche das Bild nicht verändern können Sie grundsätzlich nicht rückgängig ma-
chen. Von den Aktionen die das Bild verändern können bis auf wenige Ausnahmen alle rückgängig
gemacht werden. Zu den Ausnahmen gehören das Speichern eines Bildes in eine Datei, das Duplizieren
eines Bildes, das Kopieren eines Bildbereiches in die Zwischenablage und noch einige mehr. Außerdem
gehören in diese Kategorie auch die Aktionen, welche zwar die Darstellung des Bildes, nicht aber das
Bild selbst verändern. Beispiele hierfür sind das Vergrößern oder Verschieben des angezeigten Bildaus-
schnittes.

Es gibt einige wenige wichtige Aktionen, welche das Bild verändern aber nicht rückgängig gemacht
werden können:

Das Schließen eines Bildes Die Historie, also die Liste der gemerkten letzten Aktionen ist eine Ei-
genschaft jedes Bildes in GIMP. Wenn Sie das Bildfenster schließen wird damit auch das Bild aus
GIMP entfernt und alle Komponenten des Bildes, also insbesondere auch seinen Historie wer-
den aus gelöscht (Keine Sorge, die Bilddateien in denen Sie das Bild gespeichert haben sind da-
von natürlich nicht betroffen). Sofern Sie das Bild seit dem letzten Speichern geändert haben,
fragt GIMP vor dem Schließen des Bildfensters nach, ob Sie die vorgenommenen Änderungen
tatsächlich verwerfen wollen. Dieses Verhalten können Sie auch in den GIMP Einstellungen ( Ab-
schnitt 8.5.1.14 auf Seite 210 ) ändern.

Das Zurücksetzen eines Bildes Das ”Zurücksetzen“ eines Bildes in GIMP ist nichts anderes, als ein
Schließen und neu laden des Bildes. Daher gilt auch für diese Aktion das bereits im letzen Ab-
schnitt geschriebene.
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”Teile“ von Aktionen Einige Aktionen bestehen aus einer komplexen Abfolge verschiedener Teilaktio-
nen welche aber nur zusammen zum gewünschten Effekt führen. Solche Aktionen werden auch
im Journal des Bildes als nur eine Aktion dargestellt und können daher auch nur gemeinsam
rückgängig gemacht werden. Ein rückgängig machen der Teilaktionen ist nicht möglich. Ein Bei-
spiel ist das die Arbeit mit dem ”Schere“ Werkzeug. Dabei müssen Sie zunächst einen geschlosse-
nen Pfad durch mehrfaches klicken erzeugen und die Erzeugung der Auswahl durch einen Klick
innerhalb des Pfades auslösen. In der Historie des Bildes können Sie dann die Erstellung der Aus-
wahl als ganzes, nicht aber jeden einzelnen Mausklick zurück nehmen.

Filter und andere Aktionen die in Form von GIMP Erweiterungen erstellt wurden können grundsätzlich
auch rückgängig gemacht werden. Allerdings setzt dies eine Unterstützung durch die Erweiterung vor-
aus. Manche der verfügbaren Erweiterungen sind leider nicht perfekt programmiert, so dass hier Proble-
me in der Bildhistorie auftreten können. Die direkt mit GIMP ausgelieferten Erweiterungen sind jedoch
diesbezüglich getestet und fehlerfrei.

2.3.6. Gitter und Hilfslinien

Es wird Ihnen vermutlich häufiger passieren, dass Sie Bildobjekte sehr exakt positionieren müssen. Da
dies mit der Maus sehr schwierig sein kann, unterstützt Sie GIMP hierbei auf verschiedene Weisen.
Zum einen könnnen Sie die Positionierung mit den Cursortasten vornehmen, die das Objekt jeweils um
einen, oder wenn Sie die Shift Taste gedrückt halten, um je 25 Pixel verschiebt. Zum anderen stellt Ihnen
GIMP ein Gitter und Hilfslinien zur Verfügung, um Objekte exakt auszurichten.

Abbildung 2.19. Ausgangsbild ohne Gitter und Hilfslinien

2.3.6.1. Das Bildgitter

Abbildung 2.20. Beispielbild mit Gitter

GIMP stellt Ihnen in jedem Bildfenster ein Gitter zur Verfügung. Dieses können Sie über das Kom-
mando Ansicht→Gitter anzeigen ein- und ausschalten. Falls Sie das Gitter standardmäßig eingeschal-
tet haben möchten, können Sie dies in den Voreinstellungen von GIMP einstellen. Dieser Dialog ist in
Abschnitt 8.5.1.10 auf Seite 205 beschrieben.
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In den Standardeinstellungen von GIMP besteht das Gitter aus kleinen Kreuzchen, welche im Ab-
stand von 30 Pixeln angeordnet sind. Sie können das Aussehen des Gitters in einem Dialog selbst be-
stimmen. Detail hierzu finden Sie im Abschnitt 8.5.1.3 auf Seite 198 Falls Sie das Aussehen des Gitters
nur für das aktuelle Bild ändern möchten, so können Sie dies über das Kommando Bild → Gitter kon-
figurieren erreichen. Dieses Kommando ist im ?gimp-configure-grid-dialog? ausführlich beschrieben.

Abbildung 2.21. Beispiel für ein alternatives Bildgitter

Das Gitter kann Ihnen nicht nur helfen Abstände und räumliche Ausrichtungen zu beurteilen, es
erlaubt Ihnen auch die exakte Ausrichtung von Bildobjekten am Gitter. Hierzu sollten Sie mit dem
Kommando Ansicht → Magnetisches Gitter das Gitter ”magnetisch“ machen. Hierdurch wird der
Mauszeiger beim Verschieben eines Bildobjektes wie magnetsich an die Gitterlinien herangezogen. In
welchem Radius dieser Magnetismus wirkt lässt sich ebenfalls einstellen. Beachten Sie hierzu bitte Ab-
schnitt 8.5.1.7 auf Seite 201. Die meisten Anwender kommen jedoch mit der Standardeinstellung von
acht Pixeln sehr gut zurecht. Beachten Sie bitte, dass Sie auch die Wirkung des magnetischen Gitters
aktivieren können, ohne das Sie das Gitter selbst einblenden. Lassen Sie sich also nicht verwirren, wenn
der Mauszeiger an einem Gitter ausgerichtet wird, welches Sie nicht sehen.

2.3.6.2. Hilfslinien

Abbildung 2.22. Beispielbild mit vier Hilfslinien

Zusätzlich zum Gitter bietet Ihnen GIMP noch eine weitere, flexiblere Möglichkeit Objekte exakt aus-
zurichten: Hilfslinien. Dabei handelt es sich um vertikale oder horizontale Linien, die über das Bild gelegt
werden und welche Sie frei positionieren können. Erzeugen können Sie Hilfslinien ganz einfach, indem
Sie diese aus den Linealen am Rand des Bildfensters ziehen. Sie können so viele Hilfslinien erzeugen
wie Sie möchten. Um die Position der Hilfslinien zu korrigieren aktivieren Sie das Werkzeug ”Verschie-
ben“ über das Werkzeugfenster oder durch drücken der Taste M. Sie können dann die Hilfslinie durch

”klicken und ziehen“ verschieben, sobald sich der Mauszeiger über einer Hilfslinie befindet. Zur exak-
ten Positionierung empfiehlt es sich die Postionsanzeige in der linken unteren Ecke des Bildfensters im
Blick zu behalten. Um eine Hilfslinie zu löschen, ziehen Sie diese einfach mit der oben beschriebenen
Methode aus dem Bild heraus.

Ähnlich wie das Gitter können Sie auch Hilfslinien magnetisch machen. Hierzu verwenden Sie ein-
fach das Kommando Ansicht→Magnetische Hilfslinien Um die Hilfslinien auszublenden steht Ihnen
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das Kommando Ansicht → Hilfslinien anzeigen zur Verfügung, welches Sie alternativ auch über das
Tastenkürzel Shift–Strg–T aufrufen können. Sie sollten beachten, dass Sie bei ausgeblendeten Hilfslini-
en auch neu angelegte Hilflinien nicht sehen. Dies kann verwirrend sein.

Auch wenn es möglicherweise aus oben genanntem Grund keine gute Idee ist, können Sie Hilfslinen
standardmäßig ausblenden. Die zugehörige Einstellung ist in Abschnitt 8.5.1.10 auf Seite 205 beschrie-
ben.

ANMERKUNG

Noch ein weiterer Tipp zum Thema Hilfslinien: mit dem Kommando ”Guillotine“
(Abschnitt 9.9.12 auf Seite 259) können Sie sehr einfach ein Bild entlang der
Hilfslinien zerschneiden und GIMP aus den einzelnen Teilen neue Bilder erzeu-
gen lassen.

2.3.7. Pfade

Abbildung 2.23. Beispielhafte Darstellungen von Pfaden in Gimp. Vier beispielhafte Darstellungen von
Pfaden in Gimp: geschlossen und polygonal, offen und polygonal, geschlossen und kurvig, Mix aus
geraden und kurvigen Segmenten.

Ein Pfad ist eine eindimensionale Kurve. Pfade werden vor allem für zwei Anwendungsfälle benutzt:

• Ein geschlossener Pfad4 kann in eine Auswahl konvertiert werden.

• Ein offener oder geschlossener Pfad kann benutzt werden, um ihn nach zu zeichnen. Er bildet
dabei ein unterstützendes Element zum Malen von kurvigen Linien.

Pfade können mit dem Pfadwerkzeug erstellt und bearbeitet werden. Sofern Sie ihr Bild im XCF Format
speichern, bleiben auch die Pfade erhalten. Eine Liste der in einem Bild existierenden Pfade wird im
Pfaddialog angezeigt. Wenn Sie Pfade in Gimp von ein Bild in ein Anderes übertragen möchten, stehen
dafür die Kommandos Kopieren und Einfügen im Kontextmenü des Pfaddialoges zur Verfügung.

Pfade in GIMP sind mathematisch betrachtet sogenannte ”Bézierkurven“. Praktisch bedeutet dies,
dass die Form der Pfade durch Ankerpunkte und die Ausrichtung von Griffpunkten bestimmt wird.
Ankerpunkte sind Punkte die sich auf dem Pfad befinden und an denen die Form der Kurve beeinflusst
werden kann. Griffpunkte sind den Ankerpunkten zugeordnet und werden verwendet, um festzulegen
wie sich die Kurve verhält, wenn sie aus dem Ankerpunkt ”herauskommt“. Zu jedem Ankerpunkt der
sich nicht am Ende der Kurve befindet, gehören daher genau zwei Griffpunkte.

Pfade können sehr komplexe Objekte sein. Sie können, unter Verwendung des Pfadwerkzeuges, von
Hand erstellt werden. Falls Sie jedoch nicht zu den ausgesprochen besessenen Zeitgenossen gehören,
werden Sie vermutlich eine andere Möglichkeit bevorzugen: Pfade können von GIMP automatisch aus

4 Zur Vollständigkeit: Auch können Auswahlen aus offenen Pfaden in Gimp erstellt werden. Der Pfad wird automatisch ge-
schlossen um die Auswahl zu erstellen.
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Abbildung 2.24. Ein Pfad in Bearbeitung. Ein Pfad mit zwei Komponenten. Die schwarzen Rechtecke
sind Ankerpunkte, der offene Kreis ist ein aktivierter Ankerpunkt. Beide offene Quadrate am aktivierten
Ankerpunkt werden Griffpunkte genannt.

Auswahlen erzeugt werden. Eine dritte Möglichkeit zur Erzeugung von Pfaden besteht in der Umwand-
lung von Text in einen Pfad. Das Ergebnis einer solchen automatischen Erzeugung kann leicht duzende
von Ankerpunkten umfassen.

Ein Pfad kann aus einer oder mehreren Komponenten bestehen. Als Komponente wird ein Teil eines
Pfades bezeichnet, dessen Ankerpunkte alle miteinander verbunden sind.

Jede Komponente eines Pfades kann für sich offen oder geschlossen sein. Bei geschlossenen Komponen-
ten sind die beiden Ankerpunkte, die Endpunkte der Komponente sind, identisch. Bei offenen Kompo-
nenten hingegen sind die beiden Endpunkte verschiedene Punkte. Wenn Sie einen Pfad in eine Auswahl
umwandeln, werden alle offenen Komponenten des Pfades automatisch in geschlossene umgewandelt.
Dies erfolgt durch Einfügen eines geraden Segmentes zwischen den beiden Endpunkten der entspre-
chenden Komponente.

Als Segment wird der Abschnitt eines Pfades bezeichnet, welcher zwei Ankerpunkte miteinander
verbindet. Pfadsegmente können entweder gerade oder kurvig sein. Ein Pfad, der ausschließlich aus
geraden Segmenten besteht, wird als ”polygonal“ bezeichnet. Wenn Sie ein neues Segment mit dem
Pfadwerkzeug anlegen, ist dieses zunächst gerade. Dies lässt sich dadurch erklären, dass die Griffpunk-
te, welche die Form des Segmentes bestimmen, sich nach dem Anlegen eines Segmentes direkt über
den Ankerpunkten befinden. Sie können ein gerades Segment in ein kurviges umformen, inde Sie die
Griffpunkte aus dem Ankerpunkt herausziehen.

Eine weitere Eigenschaft von Pfaden ist, dass sie sehr schonend mit den Ressourcen des Computers
umgehen. Um einen Pfad zu repräsentieren ”merkt“ sich GIMP jeweils im Wesentlichen die Position der
verschiedenen Anker- und Griffpunkte. Daher reicht 1KByte Hauptspeicher aus einen recht komplexen
Pfad mit duzenden Ankerpunkten aufzunehmen. In der gleichen Menge Speicher ließe sich dagegen
nichteinmal ein 20x20 Pixel großer Bildausschnitt ablegen. Sie können daher nach herzens Lust Pfade
anlegen und mit diesen arbeiten, ohne sich über den Ressourcenverbrauch Sorgen machen zu müssen.
Sogar ein Pfad mit tausenden von Segmenten verbraucht sehr viel weniger Speicher als ein typischer
Kanal oder gar eine Ebene.

2.3.7.1. Pfade und Auswahlen

Sie können mit Gimp eine Auswahlen und Pfade ineinander umwandeln. Wenn Sie einen Pfad aus
einer Auswahl erstellen, wird der Pfad eine ähnliche Form wie die Auswahl annehmen. Beachten Sie
hierbei jedoch, dass der Pfad nicht exakt die Form der Auswahl haben muss. Weitere Informationen
über Auswahlen finden Sin in Abschnitt 2.3.4 auf Seite 35.

Wird eine Auswahl in einen Pfad umgewandelt, so entspricht die Form des Pfades sehr genau der
durch die laufenden Ameisen angezeigten Kante. Jedoch handelt es sich bei Auswahlkanten nicht um
Linien, sondern um Ränder einer bestimmten Breite, also Flächen. Pfade dagegen haben keine Breite.
Daher wird die Information über eine weiche Auswahlkante verworfen, sobald aus der Auswahl ein
Pfad erstellt wird. Wird später aus diesem Pfad wieder eine Auswahl erstellt, so wird diese eine harte
Auswahlkante ohne weichen (ausgeblendeten) Rand haben.
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Abbildung 2.25. Text, konvertiert in einen Pfad

(a) In diesem Beispiel wurde Text in
einen Pfad konvertiert und perspekti-
visch transformiert.

(b) Der Pfad wurde mittels einem wei-
chem Pinsel nachgezeichnet. Darauf
wurde ein Gradient abgebildet und mit
dem ”Gelben Kontrast“ Filter verändert.

2.3.7.2. Pfade und Text

Ein Text kann mittels Textwerkzeug in ein Pfad konvertiert werden. Benutzen Sie dafür die Pfad aus
Text erzeugen Schaltfläche nach Erstellen des Textes. Dies eröffnet Ihnen unter anderem folgende
Möglichkeiten:

• Nachziehen des Pfades, wodurch sich Ihnen unzählige Möglichkeiten eröffnen Text mit überraschenden
Effekten zu versehen.

• Wichtiger noch ist der die Möglichkeit, Text zu transformieren. Text in einen Pfad zu konvertieren,
diesen zu transformieren und dann letztendlich nachzuziehen oder in eine Auswahl umzuwan-
deln und zu füllen führt zu sehr hochwertigen Ergebnissen. Die Ergebnisse sind in aller Regel
besser, als den Text auf eine Ebene aufzubringen und die Ebene auf Pixelebene zu transformieren.

2.3.7.3. Pfade und SVG Dateien

Das Kürzel SVG steht für ”Scalable Vector Graphics“ und ist ein Dateiformat zur Speicherung skalier-
barer Vektorgrafiken. Ein Dateiformat übrigens, welches zunehmend an Bedeutung gewinnt. Grafiken
werden dabei nicht als Raster von Pixeln, sondern als Anordnung mathematisch beschriebener Formen
gespeichert. GIMP selbst ist ein Programm zur Bearbeitung von Rastergrafiken, aber die Pfade sind
ebensolche mathematisch beschriebenen Formen.

Glücklicher Weise werden Pfade in SVG Dateien fast genauso dargestellt wie in GIMP. Genau ge-
nommen ist dies kein Zufall, denn wie GIMP mit Pfaden umgeht wurde für die GIMP Version 2.0 neu
entschieden und dabei hatten die Entwickler auch einen scharfen Blick auf SVG. Diese Kompatibilität
ermöglicht es Ihnen Pfade als SVG Dateien zu speichern. Dabei können alle Informationen die GIMP
über die Pfade hat in der Datei gespeichert werden. Es geht also nichts verloren. Eine Beschreibung
dieser Funktionalität finden Sie im Abschnitt 8.2.3 auf Seite 165.

Im Umkehrschluss bedeutet dies, dass Sie mit GIMP Pfade aus SVG Dateien erstellen können, welche
Sie in anderen, auf die Bearbeitung von skalierbaren Grafiken spezialisierten, Programmen 5 erzeugt
haben. Wie Sie SVG Grafik in GIMP als Pfad laden erfahren Sie ebenfalls im Abschnitt 8.2.3 auf Seite 165.

Im SVG Format können ausser Pfaden auch jede Menge anderer Formen wie Quadrate, Rechtecke,
Kreise, Ellipsen, Polygone und viele andere mehr gespeichert werden. Seit der GIMP Version 2.2 können
Sie auch diese Formen in GIMP als Pfade laden. Frühere Versionen von GIMP ignorieren diese SVG
Elemente.

ANMERKUNG

GIMP kann SVG Dateien nicht nur als Pfade importieren, sondern diese Dateien
auch ganz normal als Rastergrafik öffnen. Wie Sie dies erreichen, erfahren Sie
im Abschnitt 9.5.3 auf Seite 225.

5 Ein bekanntes Beispiel für ein freies Vektorgrafikprogramm ist Inkscape <http://www.inkscape.org>.
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2.3.8. Pinselspitzen

Abbildung 2.26. Verschiedene Pinselstriche. Eine Reihe von Beispielen von Pinselstrichen verschiedener
Pinsel in GIMP verfügbarer Pinselformen. Alle wurden mit dem Pinselwerkzeug gemalt.

Eine Pinselspitze ist die Stelle eines Malwerkzeuges, welche die Malfläche ”berührt“ und besteht aus
einer oder mehreren kleinen Pixelflächen. Diese bestimmen wie die Farbe aufgetragen wird. GIMP stellt
Ihnen ein Dutzend verschiedener Malwerkzeuge zur Verfügung, welche Sie anwenden können, um die
verschiedensten Arbeiten wie malen, radieren, kopieren, verschmieren, aufhellen und noch viele wei-
tere durchzuführen. Alle diese Werkzeuge ( den Stift mal ausgenommen) verwenden die selbe Palette
von Pinselspitzen. Wenn sie mit einem der Werkzeuge einen Strich ziehen, wird die Pixelfläche der Pin-
selspitze wieder und wieder entlang des gezogenen Striches angewendet. Die Art und Weise wie dies
geschieht hängt dabei sowohl von der Pinselspitze, als auch vom Malwerkzeug und dessen Eigenschaf-
ten ab.

Sie können eine Pinselspitze auswählen, indem Sie die Gewünschte im Dialog ”Pinsel“ anklicken
(siehe auch Abschnitt 8.3.2 auf Seite 177 ). Die aktuell ausgewählte Spitze wird im unteren Bereich des
GIMP Werkzeugfensters angezeigt.

Bei der Installation von GIMP wird eine Grundausstattung an Pinselspitzen mitgeliefert. Darunter
befinden sich einig sehr gebräuchliche, aber auch einige sehr ausgefallene Spitzen, welche eher dazu
dienen Ihnen zu zeigen was in GIMP alles möglich ist. Sie können selbstverständlich eigene Pinselspit-
zen kreieren, oder neue Sammlungen aus dem Internet herunterladen und diese in GIMP verfügbar
machen.

GIMP verfügt über verschiedene Typen von Pinselspitzen. Dabei dienen alle dem gleichen Zweck
und in den allermeisten Fällen müssen Sie gar nicht auf den Typ der gerade verwendeten Spitze achten.
Andererseits verfügen einige über spezielle Funktionen die Sie kennen sollten. Die folgenden Typen von
Pinselspitzen sind in GIMP verfügbar:

Gewöhnliche Pinselspitzen Die meisten der von GIMP mitgelieferten Pinselspitzen fallen in diese Ka-
tegorie. Sie werden im Pinsel Dialog durch ein graues Symbol dargestellt. Die Form in diesem
Symbol spiegelt die Pixelfläche wieder, welche die Form der Pinselspitze bestimmt. Wenn Sie eine
der Spitzen diese Types verwenden, werden die Graustufen des Pinselsymboles in die Farbtöne
der aktuell ausgewählten Vordergrundfarbe übersetzt. Die im Symbol abgebildete Form entspricht
der Form mit der Sie im Bild malen.

Um eine solche Pinselspitze anzulegen erzeugen Sie ein kleines Bild im Graustufenmodus, wel-
ches die gewünschte Form in der gewünschten Größe hat. Speichern Sie dieses Bild mit der En-
dung .gbr. Nach einem Klick auf die Schaltfläche Pinsel neu laden im Pinsel Dialog wird die neue
Pinselspitze automatisch ohne einen Neustart von GIMP verfügbar.

Farbige Pinselspitzen Pinselspitzen dieses Types werden durch ein farbiges Symbol im Pinsel Dialog
gekennzeichnet. Diese Pinselspitzen können auch Text beinhalten. Wenn Sie damit malen, werden
die Farben so angewendet, wie sie im Symbol dargestellt werden. Die aktuelle Vordergrundfarbe
spielt keine Rolle. Ansonsten wirken die Spitzen dieser Kategorie wie gewöhnliche Pinselspitzen.

Um eine Spitze dieses Types anzulegen, erzeugen Sie in GIMP ein RGBA Bild der entsprechenden
Größe mit dem gewünschten Inhalt. Ein RGBA Bild ist ein normales Bild im RGB Farbmodus mit
Alphakanal. Speichern Sie das Bild mit der Endung .gbr, um es als Pinsel zu verwenden. Nach
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einem Klick auf die Schaltfläche Pinsel neu laden im Pinsel Dialog wird die neue Pinselspitze
automatisch ohne einen Neustart von GIMP verfügbar. Falls Sie das Bild für eine spätere Weiter-
bearbeitung aufbewahren möchten, speichern Sie es zusätzlich im XCF Format.

TIPP

Sie können eine Auswahl sehr einfach in eine Pinselspitze verwandeln,
indem Sie das Kommando Skript-Fu → Auswahl → Zu Pinsel im Menü
des Bildfensters auswählen.

Animierte Pinselspitzen (Bilderschlauch) Pinselspitzen dieses Types zeichnen sich durch die Art und
Weise aus, wie sie beim Malen aufgetragen werden. Sie werden im Dialog Pinsel dadurch gekenn-
zeichnet, dass sich in der rechten unteren Ecke des Symbols ein kleines rotes Dreieck befindet. Das
Besondere an diesem Typ ist, dass beim malen nicht die Form einer Pixelfläche aufgetragen wird,
sondern dass sich verschiedene Pixelflächen abwechseln. Diese Pinselspitzen sind unglaublich
vielfältig. Die Animation kann zum Beispiel mit der Stärke des Aufdrucks des Stiftes auf ein Zei-
chentablett gesteuert werden. Die mit GIMP ausgelieferten Spitzen dieses Types sind verglichen
mit den Möglichkeiten sehr einfach, aber trotzdem nützlich und zur Verdeutlichung des Prinzips
geeignet. Probieren Sie sie aus!

Die Erstellung einer animierten Pinselspitze ist eine recht komplizierte Angelegenheit. Grob ge-
sagt wird ein Bild in GIMP gemalt, welches in mehreren Ebenen die verschiedenen Einzelbilder
der Animation enthält. Dieses wird dann als .gih Datei gespeichert. Hierbei öffnet sich ein Dialog-
fenster, in dem zusätzlich verschiedene Parameter eingestellt werden müssen.

Parametrisierte Pinselspitzen Pinselspitzen dieses Types werden mit Hilfe des Pinseleditors erstellt.
Dieser erlaubt es Ihnen eine große Bandbreite an Pinselspitzen durch einfache Einstellungen im
Dialogfenster zu erzeugen. Eine ausserordentlich nützliche Eigenschaft parametrisierter Pinsel-
spitzen ist, dass sie sehr einfach in der Größe angepasst werden können. Seit GIMP Version 2.2
können Sie GIMP sogar so einstellen, dass Sie die Größe parametrisierter Pinselspitzen durch Tas-
tenkürzel oder das Mausrad verändern können.

Eine Kategorie von Pinselspitzen die in GIMP (noch) nicht komplett ausgeprägt zur Verfügung steht
sind prozedurale Pinselspitzen. Das sind Spitzen, deren Signatur nicht auf Pixelflächen, sondern einer
Beschreibung der Form (ähnlich einem Pfad) besteht. Es gibt im Moment in GIMP lediglich ein Werk-
zeug, welches mit derartigen Spitzen arbeitet - der Stift.

Neben der Pixelfläche verfügt jede Pinselspitze in GIMP über eine weitere wichtige Eigenschaft, den
Abstand. Diese repräsentiert den Abstand zwischen zwei hintereinander aufgetragenen Abdrücken der
Pinselspitze beim Malen. Diese Eigenschaft können Sie im Dialog Pinsel einstellen.

2.3.9. Farbverläufe

Abbildung 2.27. Beispiele für Farbverläufe. Die Verläufe von oben nach unten: VG nach HG (RGB); Full
saturation spectrum CCW; Nauseating headache; Browns; Four bars

54



KAPITEL 2. KONZEPTE 2.3. MIT BILDERN ARBEITEN

Ein Farbverlauf ordnet eine Menge von Farben linear an. Die einfachste und wahrscheinlich am
häufigsten benutzte Anwendung von Farbverläufen ist das Werkzeug ”Mit Farbverlauf füllen“. Damit
können Sie Auswahlen mit Farben aus einem Verlauf füllen. Dabei haben Sie verschiedenste Möglichkeiten
das Füllen zu beeinflussen. Weitere wichtige Anwendungen in denen Farbverläufe eine zentrale Rolle
spielen umfassen:

Malen mit Verläufen Alle Malwerkzeuge in GIMP bieten Ihnen die Möglichkeit statt mit einer Farbe
mit einem Farbverlauf zu malen. Dabei wechselt der Pinselstrich beim Malen die Farbe entspre-
chend des ausgewählten Verlaufes.

Das Filter ”Abbilden auf Farbverlauf“ Mit diesem Filter können Sie ein Bild mit den Farben eines von
Ihnen ausgewählten Farbverlaufes ein- oder umfärben. Eine detaillierte Beschreibung finden Sie
im Abschnitt 10.3.8 auf Seite 314.

Bei der Installation von GIMP wird ein Standardset von Farbverläufen mitgeliefert. Dieses können Sie
sehr leicht durch eigenen oder aus dem Internet heruntergeladene Verläufe ergänzen. Eine Liste der
aktuell verfügbaren Verläufe finden Sie im Dialog Farbverläufe. Der aktuell ausgewählte Verlauf wird
im unteren Teil des Werkzeugfensters angezeigt. Wenn Sie auf diesen Bereich des Fensters klicken, wird
der Dialog ”Farbverläufe“ angezeigt.

Abbildung 2.28. Anwendung von Farbverläufen. Vier Möglichkeiten den Verlauf anzuwenden: füllen
mit einem linearen Verlauf; füllen mit einem geforment Verlauf; ein Pinselstrich gefüllt mit einem Farb-
verlauf; ein Pinselstrich mit einer weichen Pinselspitze, eingefärbt mit dem ”Abbilden auf Farbverlauf“
Filter

Einige nützliche Dinge, die Sie über Farbverläufe wissen sollten:

• Die ersten vier Einträge der Liste der verfügbaren Farbverläufe sind spezielle Verläufe. Diese
Farbverläufe verwenden anstelle fest eingestellter, die aktuelle Vorder- und Hintergrundfarbe. VG
nach Transparent ist ein Verlauf bei dem die aktuell eingestellte Vordergrundfarbe in die Trans-
parenz verläuft. VG nach HG (SHV-Farbton im Uhrzeigersinn) ist ein Verlauf dessen Anfang die
aktuelle Vordergrund- und dessen Ende die aktuelle Hintergrundfarbe ist. Der Verlauf wird dabei
über die auf dem Farbkreis im Uhrzeigersinn liegenden Farbtöne geführt. VG nach HG (HSV ge-
gen Uhrzeigersinn) entspricht vorherigen Verlauf, ausser dass der Verlauf über die auf dem Farb-
kreis entgegen dem Uhrzeigersinn befindlichen Farben geführt wird. Beim Verlauf VG nach HG
(RGB) wird schließlich ein Farbverlauf beschrieben, der entsprechend dem RGB Modell von der
aktuellen Vordergrund- zur aktuellen Hintergrundfarbe verläuft. Sie können diese Farbverläufe
sehr leicht duch eine Änderung an den aktuell eingestellten Vorder- oder Hintergrundfarben an-
passen.

• Verläufe können nicht nur zwischen Farben überblenden, sondern sich auch auf die Deckkraft be-
ziehen. Einige Verläufe sind komplett deckend, andere haben mehr oder weniger große transpa-
rente Bereiche. Wenn Sie mit einem Verlauf füllen der an einer oder mehreren Stellen transpartent
ist, so wird an diesen Stellen nach dem Auftragen die ursprüngliche Farbe durchscheinen.
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• Sie könnrn mit dem Farbverlaufseditor selbst neue Farbverläufe erstellen. Die mit GIMP ausge-
lieferten Farbverläufe sollen und können nicht verändert werden. Sie können jedoch eigene Farb-
verläufe erstellen, welche auf den mitgelieferten basieren, indem Sie diesen duplizieren. Die Kopie
können Sie dann nach Belieben verändern.

Das mit GIMP ausgelieferte Set an Farbverläufen wird in einem Systemverzeichnis gespeichert. Die
von Ihnen angelegten Verläufe werden in den Standardeinstellungen im Verzeichnis gradients Ih-
res persönlichen GIMP Benutzerprofiles gespeichert. Alle dort befindlichen Farbverläufe (gespeichert
in Dateien mit der Endung .ggr) werden beim starten von GIMP automatisch geladen. Wenn Sie das
Verzeichnis, in dem GIMP Ihre persönlichen Farbverläufe speichert ändern möchten, lesen sie Ab-
schnitt 8.5.1.16 auf Seite 212.

Seit der GIMP Version 2.2 ist es möglich, Farbverläufe aus dem SVG Dateiformat, welches von vie-
len Vektorgrafikprogrammen benutzt wird, zu laden. Hierzu legen Sie die entsprechenden SVG Datei
einfach in dem Verzeichnis ab, in dem GIMP Ihre persönlichen Farbverläufe speichert.

TIPP

Sie finden eine ganze Reihe von interessanten Farbverläufen in SVG Dateien
im Internet auf der Seite OpenClipArt Farbverläufe <http://openclipart.
org/cgi-bin/navigate/Gradients>.

2.3.10. Muster

Ein Muster ist ein, oft kleines, Bild, welches zum Füllen von Bereichen in Bildern verwendet wird. Hierzu
wird das Muster wiederholt aneinandergesetzt. Wenn die Kanten, an denen das Muster zusammenge-
setzt wird nicht sichtbar sind, wird das Muster als nahtlos bezeichnet.

Abbildung 2.29. Beispiele für die Anwendung von Mustern. Drei Möglichkeiten ein Muster aufzutra-
gen: Füllen mit dem gleichnamigen Werkzeug; Malen mit dem Werkzeug Klonen; Nachziehen einer
elliptischen Auswahl mit Muster

Es gibt drei typische Anwendungsbereiche für Muster:

• Sie können mit dem Werkzeug Füllen einen Bildbereich mit einem Muster statt einer Farbe füllen.

• Sie können mit dem Werkzeug Klonen unter der Verwendung von Mustern und verschiedenster
Pinselspitzen malen.

• Sie können, wenn Sie eine Auswahl oder einen Pfad nachziehen, ein Muster an Stelle einer einfa-
chen Farbe verwenden.
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TIPP

Muster müssen nicht immer und an allen Stellen vollständig deckend sein. Sie
können durch aus auch mit teiltransparenten Mustern arbeiten. An den Stellen,
an denen das Muster nicht vollständig deckend ist, scheint dann bei Anwendung
der vorherige Inhalt durch.

GIMP wird mit einem Set von Mustern ausgeliefert. Da diese sicher nicht in jedem Fall alle Ihre Anfor-
derungen abdecken, haben Sie die Möglichkeit eigene Muster in GIMP anzulagen oder Muster, welche
im Internet verfügbar sind in GIMP zu verwenden.

Das aktuell ausgewählte Muster wird im unteren Bereich des Werkzeugfensters angezeigt. Wenn Sie
auf dieses klicken, wird der Dialog Muster angezeigt, der es Ihnen gestattet ein anderes Muster aus-
zuwählen oder eigene Muster hinzuzufügen.

Um ein neues Muster in die Auswahl des Dialoges aufzunehmen, speichern Sie es als Bild in einem
Dateiformat welches von GIMP unterstütz wird in einem der Verzeichnisse in welchen GIMP nach Mus-
tern sucht ab. Die Dateiformate in denen Sie Muster ablegen können umfassen:

PAT Dateien mit der Endung .pat im Dateinamen werden ausschließlich von GIMP verwendet. Sie
werden also keine Datein mit dieser Endung finden, die nicht speziell für GIMP erstellt wurden.
Sie können jedoch jedes Bild in GIMP öffnen und im Dateiformat .pat speichern.

PNG, JPEG, BMP, GIF, TIFF Seit der Version 2.2 von GIMP können Sie auch diese Dateiformate benut-
zen, um Bilder zu speichern, welche Sie in GIMP als Muster verwenden möchten.

Um ein Muster in GIMP verfügbar zu machen, müssen Sie es in einem Verzeichnis ablegen, welches sich
im GIMP Suchpfad für Musterdateien befindet. In den Standardeinstellungen ist dies das Verzeichnis
patterns in Ihrem persönlichen GIMP Profil. Dieses findet sich für gewöhnlich unter dem Namen .
gimp-x.y in Ihrem Benutzerverzeichnis. X und Y bezeichnen dabei die Versionsnummer der GIMP
Version mit der Sie aktuell arbeiten. Sie können weitere Verzeichnisse angeben, in denen GIMP nach
Mustern sucht. Hierzu ergänzen Sie die GIMP Einstellungen wie im Abschnitt 8.5.1.16 auf Seite 212
beschrieben. Bitte beachten Sie, dass GIMP die neuen Suchpfade gegebenenfalls erst beim nächsten
Start des Programms berücksichtigt.

Es gibt unzählige Wege mit GIMP interessante Muster zu erzeugen und eine Menge von Werkzeugen
und Filtern kann Sie bei dieser Aufgabe unterstützen. Speziell hervorgehoben seien an dieser Stelle die
Renderfilter (Abschnitt 10.12 auf Seite 418). Einige der Filter haben die Eigenschaft das Ergebnis naht-
los machen zu können. Falls nicht, steht das Filter Kachelbarer Weichzeichner zur Verfügung, welcher
die Ränder von Bildausschnittel nahtlos kachelbar macht. Ausserdem finden Sie Unterstützung in den
unzähligen Tutorials auf der GIMP Seite <www.gimp.org> im Internet.

Abbildung 2.30. Beispiele für Muster aus Renderfiltern. Filter von links nach rects: 3D Truchet; Ca-
mouflage; Flatland; Land; Render Map; Swirly. Alle Filter wurden mit den Standardeinstellungen aus-
geführt.
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2.3.11. Farbpaletten

Als (Farb-)Palette wird in GIMP ein Menge von ausgewählten Farben genannt. Paletten werden hauptsächlich
für zwei Anwendungsfälle benötigt:

• Sie ermöglichen es Ihnen mit einer vordefinierten Auswahl an Farben zu malen. Damit haben
Sie die gleichen Möglichkeiten wie ein Maler der mit einer beschränkten Auswahl an Farbtuben
arbeitet.

• Die Paletten bilden die Farbkarten von Bildern im Farbmodus ”indiziert“. Ein solches Bild verfügt
nur über maximal 256 verschiedene Farben, die aus den Millionen verfügbaren Farben ausgewählt
werden. Die oben erwähnte Farbtabelle wird in GIMP ”Indizierte Palette“ genannt.

Sie haben natürlich Recht, wenn Sie feststellen, dass keine dieser beiden Anwendungen wirklich zu den
Basisfunktionen eines Malprogrammes wie GIMP gehört. Es ist durchaus möglich sehr anspruchsvol-
le Dinge in GIMP zu tun, ohne je dabei mit Paletten in Berührung gekommen zu sein. Trotzdem wird
sollten gerade fortgeschrittene GIMP Anwender sich mit dem Thema auskennen und auch für unerfah-
rene Benutzer müssen möglicherweise darüber nachdenken, wenn sie beispielsweise ein Bild im GIF
Dateiformat speichern.

Abbildung 2.31. Der Dialog ”Farbpaletten“

Wenn Sie GIMP installieren, wird es mit einem Set von einigen duzend vordefinierten Farbpaletten
ausgeliefert. Dieses können Sie zusätzlich noch um eigene Paletten erweitern. Einige der vordefinier-
ten Farbpaletten sind allgemein sehr nützlich, da sie standardisierte Farbpaletten wie die ”Webfarben“
beinhalten. Dabei handelt es sich um eine Auswahl von Farben, die auf den allermeisten Browsern im
Internet in der gleichen Weise dargestellt werden.

Abbildung 2.32. Der Farbpaletteneditor

Durch doppelklicken auf eine der Paletten im Dialog Farbpaletten, öffnet sich der Farbpaletteneditor
. Hier finden Sie alle Farben der Palette in kleinen Kästchen dargestellt. Sie können diesen Editor direkt
zur Farbauswahl verwenden - indem Sie auf eine der Farben klicken, wird die aktuelle Vordergrund-
farbe in GIMP geändert. Durch gedrückt halten der Taste Strg während des Klicks auf die gewünschte
Farbe können Sie die aktuelle Hintergrundfarbe in GIMP ändern.

Wie der Name des Farbpaletteneditors schon nahe legt, können Sie diesen auch dazu verwenden die
Farben in selbst zusammengestellten Paletten zu verändern. Die von GIMP zur Verfügung gestellten Palet-
ten können nicht geändert werden. Sie haben jedoch die Möglichkeit jede dieser Paletten zu duplizieren
und die Kopie zu verändern.
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Wenn Sie mit dem Farbpaletteneditor eine Palette erzeugen, wird diese automatisch im Verzeichnis
palettes Ihres GIMP Profiles gespeichert, sobald Sie GIMP beenden. Jede Datei, welche sich in diesem
oder einem anderen, für Farbpaletten in GIMP registrierten Verzeichnis befindet, wird automatisch in
den Farbpalettendialog geladen, sobald GIMP gestartet wird. Wie Sie weitere Verzeichnisse registrieren
können, in denen GIMP nach Dateien mit Farbpaletten sucht, erfahren Sie im Abschnitt 8.5.1.16 auf
Seite 212.

Um Farbpaletten in einer Datei zu speichern, verwendet GIMP ein spezielles Dateiformat. Sie können
diese Dateien am Suffix .gpl des Dateinamens erkennen. Es handelt sich bei dem verwendeten Dateifor-
mat übrigens um eine sehr einfache Variante, bei der die Daten im sogenannten ASCII Format, also in
Textform, gespeichert werden. Wenn es Sie interessiert, oder Sie je in die Verlegenheit kommen eine sol-
che Datei von Hand zu schreiben oder zu konvertieren, schauen Sie sich einfach eine der vorhandenen
Dateien als Beispiel an.

2.3.11.1. Farbkarten

Um die Dinge nicht zu einfach zu gestalten, verwendet GIMP zwei verschiedene Arten von Paletten.
Die leichter erkennbaren werden im Dialog Farbpaletten angezeigt und existieren unabhängig von Bil-
dern in GIMP. Die zweite Art, die sogenannten indizierten Paletten bilden die Farbkarten von Bildern im
Farbmodus ”indiziert“. Jedes Bild in diesem Farbmodus hat seine eigene Farbtabelle, in der die Farben
beschrieben werden, die für dieses spezielle Bild verfügbar sind. Die größtmögliche Anzahl verschiede-
ner Farben in einem Bild beträgt dabei 256. Diese Paletten werden als ”indiziert“ bezeichnet, weil jede
Farbe eine Nummer (einen Index) bekommt. In den zugehörigen Bildern wird dann für jedes Pixel nicht
mehr die Farbe selbst, sondern nur noch die Nummer der zugeordneten Farbe gespeichert.

Abbildung 2.33. Der Dialog ”Farbtabelle“

Die Farbtabelle eines Bildes im Farbmodus ”indiziert“, wird im Dialog Farbtabelle, den Sie jedoch
nicht mit dem Dialog ”Farbpaletten“ verwechseln sollten. Der Dialog ”Farbpaletten“ zeigt Ihnen eine
Liste aller in GIMP verfügbaren Farbpaletten an, während der Dialog ”Farbtabelle“ die im aktuellen
Bild verfügbaren Farben anzeigt - sofern sich dieses im Farbmodus ”indiziert“ befindet - ansonsten ist
dieser Dialog leer.

In diesem Zusammenhang ist es noch interessant zu erwähnen, dass Sie aus den Farben eines Bildes
im Farbmodus ”indiziert“ eine neue normale Farbpalette erzeugen können. Hierzu wählen Sie einfach
das Kommando Farbpalette importieren aus dem Kontextmenü des Dialoges Farbpaletten. In dem
sich daraufhin öffnendem Dialogfenster wählen Sie als Quelle dasjenige Bild aus, dessen Farbtabelle Sie
importieren möchten. Alternativ können Sie hier auch aus einem Verlauf eine neue Farbpalette impor-
tieren.

Wenn Sie den Farbmodus eines Bildes auf die Einstellung ”indiziert“ umstellen, besteht ein wesentli-
cher Teil des Vorganges darin eine indizierte Palette für das Bild zu generieren. Hierzu stehen verschie-
dene Algorithmen zur Verfügung. Einer davon basiert darauf, dass Sie eine bereits existierende Farb-
palette aus dem Dialog ”Farbpaletten“ vorgeben, welche dann unverändert für das Bild übernommen
wird. Weitere Informationen hierzu finden Sie im Abschnitt 9.9.6 auf Seite 256.

Zusammenfassend lässt sich also sagen, dass normale Farbpaletten in Farbtabellen umgewandelt wer-
den können, wenn Sie ein Bild auf Basis der Farbpalette in den Farbmodus ”indiziert“ überführen. An-
dersherum können Sie mittels eines Kommandos im Dialog Farbpaletten die Farbtabelle eines Bildes im
Farbmodus ”indiziert“ in eine normale Farbtabelle importen.
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2.3.12. Text und Schriftarten

Abbildung 2.34. Beispiel eines Textelementes. Ein Beispieltext mit gut sichtbarer Textebene (die Schrift-
art ist Utopia fett)

Eine der wichtigsten Weiterentwicklungen von GIMP Version 1.2 zu GIMP2 ist die Arbeit mit Text.
Jedes Textelement in GIMP wird in einer Ebene abgelegt und Sie können den Text einer solchen Ebene
auch später noch ändern. Sie können den Text im Bild herumschieben, die Schriftart und die Schriftgröße
ändern. Sie können jede auf Ihrem Computer vorhandene Schriftart verwenden und darüber hinaus
sowohl die Textausrichtung, als auch den Zeilenabstand einstellen.

Sie können Textebenen auch in ganz normale Ebenen überführen, dann ist es jedoch nicht mehr
möglich den Text als solches zu verändern. Sie müssten dann alle Veränderungen auf Pixelebene vor-
nehmen.

Abbildung 2.35. Der GIMP Texteditor

Um die Eigenheiten des Umganges mit Text in GIMP besser zu verstehen, hilft es möglicherweise sich
vor Augen zu halten, dass Textebenen ganz andere Informationen beinhalten als normale Ebenen, wel-
che ausschließlich aus Pixeln zusammengesetzt sind. In Textebenen muss zusätzlich der Text in Textfor-
mat, zusammen mit all den Informationen über Schriftart, Größe, Ausrichtung und so weiter verwaltet
werden. Sie können dies im Texteditor sehen, welcher sich öffnet, wenn Sie das Textwerkzeug benut-
zen. Jedes Mal, wenn Sie dien Text verändern, wird die Bildebene neu gezeichnet, um Ihre Änderungen
widerzuspiegeln. Weitere Informationen zum Textwerkzeug finden Sie im Abschnitt 7.6.5 auf Seite 150.

Nehmen wir einmal an, Sie erzeugen eine Textebene und bearbeiten die Ebene dann auf eine Weise,
die nichts mit dem Text zu tun hat. Beispielsweise könnten Sie die Ebene drehen. Wenn Sie nun wieder-
um den Text der Ebene bearbeiten, so wird dieser neu in die Ebene gezeichnet, und zerstört das Ergebnis
der in der Zwischenzeit durchgeführten Bearbeitungsschritte.

Da diese Gefahr nicht offensichtlich ist, versucht das Textwerkzeug Sie davor zur beschützen. Wenn
Sie auf einer Textebene arbeiten und später versuchen den Text weiter zu bearbeiten, wird ein Dialog-
fenster angezeigt, welches Sie warnt und Ihnen anbietet entweder den Text trotzdem zu bearbeiten, die
Aktion abzubrechen oder eine neue Textebene mit dem Text der bereits vorhandenen Textebene anzule-
gen und diese unverändert zu belassen.
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3. Problemlösungen

3.1. Hängen geblieben!

Okey, sie sind bei Ihrer ganzen Arbeit vollkommen verwirrt und hängen fest; wissen ein noch aus wie
Sie weiterkommen könnten. Am liebsten würden Sie GIMP schließen, jedoch hängt die Arbeit einiger
Minuten wenn nicht schon Stunden an Ihrer Geduld und an diesem Programm.

Bevor Sie jedoch das Programm ”killen“, geben wir Ihnen eine kleine Checkliste mit auf dem Weg,
um aus Sie aus dieser misslichen Lage zu befreien.

3.2. Die Hauptgründe, weshalb GIMP scheinbar ”einfriert“

Abbildung 3.1. Der Ebenendialog mit einer schwebenden Auswahl.

Es existiert eine schwebende Auswahl

Falls eine schwebende Auswahl existiert, sind nur die Funktionen aktiviert, mit der sich schwe-
bende Auswahlen manipulieren lassen. Entweder die schwebende Auswahl wird aufgelößt oder
verankert. Schauen Sie in den Ebenendialog (vergewissern Sie sich, dass er Ihnen die Ebenen des
aktuellen Bildes anzeigt) und prüfen Sie, ob die oberste Ebene schwebende Auswahl heißt.

Sollten Sie keine Auswahl sehen, überprüfen Sie die Auswahl anzeigen Option im Ansicht Menü.
Manchmal ist es nützlich die ”laufenden Ameisen“, die eine Auswahl markieren nicht anzuzeigen,
vor allem wenn diese wichtige Bestandteile des Bildes verdecken.

Probleme mit Auswahlen können vielseitiger Natur sein. Wenn Sie nicht sicher sind, was mit der
Auswahl passiert ist, oder wie groß die Auswahl ist entfernen Sie sie und fangen nochmal neu an.

Wie im Ebenendialog beschrieben, müssen Sie in den Bereich der Sichtbarkeit klicken um die Ebe-
ne wieder sichtbar zu machen.
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Abbildung 3.2. Problem mit der Sichtbarkeit der Auswahl. Vergewissern Sie sich, dass im Ansicht
Menü Auswahl anzeigen aktiviert ist.

Die Auswahl ist nicht sichtbar

Abbildung 3.3. Problem mit ”Alles ausgewählt“. Klicken Sie auf Auswahl → Alles im Bildmenü um
sicherzugehen, dass Sie in der Auswahl arbeiten.

Sie arbeiten außerhalb einer Auswahl

Die Deckkraft der Ebene wurde auf 0 gestellt. Damit ist die Ebene vollkommen transparent und
nicht mehr sichtbar. Wie im Ebenendialog beschrieben, können Sie den Schieberegler nach rechts
bewegen um die Deckkraft zu erhöhen.

Sie können nicht außerhalb der Ebene zeichnen Ebenen im GIMP müssen haben nicht die gleichen
Dimensionen wie das eigentliche Bild haben. Sie können kleiner oder auch größer sein. Gekenn-
zeichnet werden Ebenen mit einer Gelb/Schwarzen Umrandung. Daher können Sie auch nicht
außerhalb der Ebene zeichnen oder Filter anwenden.

Wenn die Ebene zu klein ist, muss sie vergrößert werden. Die Funktionen dafür befinden sich am
unteren Ende des Ebenenmenüs: Ebenengröße, Ebene auf Bildgröße, Ebene skalieren.

Das Bild befindet sich im indizierten Farbmodus. GIMP kann drei verschiedene Farbmodis verwal-
ten: RGB(A), Indiziert und Graustufen. Der indizierte Farbmodus benutzt eine Farbtabelle um
die verwendeten Farben im Bild zu speichern. Die Farbpipette jedoch, setzt Farben aus dem RGB
Farbraum. Versuchen sie nun mit einer Farbe die nicht in der Farbtabelle verzeichnet ist auf dem
Bild zu malen, werden sie unerwünschte Effekte erhalten. Entweder sie zeichnen mit einer nicht
gewünschten Farbe oder sie sehen keine Veränderungen.

Benutzen sie um das Bild zu verändern immer den RGB Modus. Sie können den Farbmodus mit-
tels des Modus Dialoges wechseln.

62
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Abbildung 3.4. Unsichtbarkeit von Ebenen beheben. Der Ebenendialog mit ausgeschalteter Sichtbarkeit
der aktiven Ebene.

Die Zeichfläche ist nicht sichtbar

Abbildung 3.5. Problem mit der Ebenentransparenz. Der Ebenendialog, die eine Ebene ohne Deckkraft
zeigt.

Die Zeichfläche ist transparent
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4. Anleitungen für Einsteiger

4.1. Bilddateien

GIMP ist imstande, viele Grafikformate schreiben und lesen zu können. Die meisten Formate werden
von Plug-ins gelesen und geschrieben; die einzige Ausnahme bildet hier das GIMP eigene XCF. Nachfol-
gend soll kurz auf Vor- und Nachteilen beim Anlegen, Öffnen und Speichern von Dateien eingegangen
werden.

4.1.1. Erstellen von Bildateien

Sie können neue Dateien in GIMP über das Bildmenü anlegen: Datei → Neu. Dadurch wird der Dialog
mit dem Titel Ein neues Bild erstellen aufgerufen, indem Sie entweder neue Werte für Höhe und
Breite des neuen Bildes eingeben oder die Standardwerte belassen. Mehr informationen über diesen
Dialog gibt es in Abschnitt 9.5.2 auf Seite 223.

4.1.2. Öffnen von Bildateien

Es gibt verschiedene Möglichkeiten Bilder im GIMP zu öffnen:

• Bild öffnen. Der nahe liegenste Weg eine Bilddatei zu öffnen, ist den Bild öffnen Dialog zu ver-
wenden. Das setzt natürlich vorraus, dass Sie wissen wo sich das Bild befindet und wie es heißt.
Sie erreichen ihn entweder über das Bild- oder Werkzeugfenstermenü: Datei → Öffnen.

Abbildung 4.1. Der Bild öffnen Dialog.
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ANMERKUNG

Das Öffnen von Bildern geschiet in den meisten Fällen durch die Auswahl
des Bildes und den Mausklick auf die Öffnen Schaltfläche. GIMP bestimmt
den Dateityp beim Öffnen automatisch. In wenigen Fällen jedoch, kann
der Dateityp nicht automatisch bestimmt werden. Wenn dieser Fall eintritt,
können Sie den Dateityp mit einem Mausklick auf Dateityp: Automatisch
bestimmt und eine zusätzliche Auswahl explizit angeben. Sollten sich auch
dann die Bilddatei nicht öffnen lassen, kann die Datei kaputt sein.

• Von Ort öffnen. Wenn Sie Bilder aus dem Internet (z.B. von Internetseiten) öffnen möchten, können
Sie das über den Bild von Ort öffnen Dialog tun. Der Dialog besteht aus einer Eingabezeile in der
Sie die Adresse (URL) zum Bild angeben können. Wenn GIMP das Bild nicht öffnen kann (durch
eine fehlerhafte Adresse z.B.), bricht der Dialog mit einer entsprechenden Fehlermeldung ab.

Abbildung 4.2. Der Dialog um ein Bild aus dem Internet (URL) zu öffnen.. Der Dialog um ein Bild aus
dem Internet (URL) zu öffnen.

• Zuletzt geöffnet. Gehört das Bild welches sie öffnen wollen zu einem früher mit GIMP erstellten
Bild, ist der einfachste Weg es über den Menüpunkt Zuletzt geöffnet zu öffnen. Sie finden ihn über
das Bild- oder Werkzeugfenstermenü: Datei→ Zuletzt geöffnet. Die Liste die Sie beim Aufruf des
Menüpunktes erhalten, besteht aus Bildern die Sie zuletzt mit GIMP erstellt oder bearbeitet haben.

• Dateimanager. Sobald Bildformate mit GIMP im Betriebssystem verknüpft sind, bieten Dateima-
nager immer eine Möglichkeit mit einem Mausklick das gewünschte Bild zu öffnen.

• Drag and Drop. Mittels Drag and Drop können Sie gewünschte Bilder von vielen Orten (z.B.
Dateimanager, Bildverwaltungs-Software) auf das Werkzeugfenster oder Bildfenster des GIMP
ziehen. Ziehen Sie das Bild auf das Bildfenster, wird es als neue Ebene eingefügt. Ziehen Sie das
Bild hingegen auf das Werkzeugfenster, wird es als neues Bild im GIMP geöffnet.

• Kopieren und Einfügen. In verschiedenen Programmen und abhängig vom verwendeten Be-
triebssystem ist es möglich, Bilddaten in die Zwischenablage zu kopieren. Sie können diese Bild-
daten dann als neues Bild aus der Zwischenablage einfügen mittels Datei → Holen → Als neues
Bild einfügen.

Wenn Sie mit GIMP Bilddateien öffnen, versucht das Programm automatisch das Bildformat heraus-
zufinden. Das geschieht nicht über die Dateinamenserweiterung im ersten Schritt, sondern über den
Dateiinhalt. In den meisten Bildformaten sind Zusatzinformationen versteckt, die helfen den Dateityp
zu bestimmen. Mißlingt die Erkennung des Dateityps mittels der Zusatzinformation, wird versucht die
Bilddatei anhand der Dateinamenserweiterung zu erkennen und zu öffnen.

4.1.3. Speichern von Bilddateien

GIMP bietet eine ganze Reihe von Bildformaten, in der Sie je nach Verwendung Ihre Bilder abspeichern
können. Wichtig ist zu wissen, dass nur das GIMP eigene Bildformat XCF im Stande ist, alle Informatio-
nen wie Ebenen, Pfade, Transparenz, ohne Verluste abzuspeichern. Das heißt, dass nach dem nächsten
Öffnen der Bilddatei, alle Ihre angelegten Ebenen, Pfade, etc. noch vorhanden sind.

Wie bereits beschrieben, kann nur das XCF Bildformat alle GIMP eigenen Informationen speichern.
Wenn Sie ein anderes Bildformat benutzen, werden Sie darauf hingewiesen, welche Informationen nicht
gespeichert werden können. Da es sich meist um Zusatzinformationen handelt, die das Bild in seinem
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KAPITEL 4. ANLEITUNGEN FÜR EINSTEIGER 4.2. AUSWAHLEN ERSTELLEN UND BENUTZEN

Abbildung 4.3. Ansicht des Exportieren Dialogs.

”Aussehen“ nicht verändern, verlieren Sie keine wichtigen Bildbestandteile beim Abspeichern in ein
anderes Dateiformat.

4.2. Auswahlen erstellen und benutzen

4.2.1. Auswahl verschieben

Abbildung 4.4. Durch verschieben der Auswahl erscheint die Hintergrundebene

Nachdem Sie eine rechteckige, elliptische oder freie Auswahl erstellt, oder den Zauberstab benutzt
haben, nimmt der Mauszeiger die Form des Verschiebesymbols an. Mit klicken und verschieben können
Sie dann die Auswahl und ihren Inhalt verschieben. An der Stelle von welcher die Auswahl wegbewegt
wird, erscheint der Hintergrund.

Falls Sie nur den Rahmen der Auswahl, nicht aber deren Inhalt verschieben möchten, halten Sie die
Alt Taste gedrückt beim klicken und verschieben.
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ANMERKUNG

Es besteht die Möglichkeit, dass die Alt Taste vom Fenster-Manager benutzt
wird. Sollte das der Fall sein, benutzen Sie das Verschiebewerkzeug und
verändern sie die ”Wirkt auf“ Option.

Eine Auswahl zu verschieben, ohne das an deren ursprünglicher Position der Hintergrund erscheint
ist ein bisschen schwieriger: drücken Sie die Strg Taste, bewegen Sie den Mauszeiger ein kleines Stück
und drücken Sie dann zusätzlich die Alt Taste. Nun klicken und verschieben Sie die Auswahl. Einfacher
funktioniert es, wenn Sie das Verschieben Werkzeug im Auswahlmodus hierfür verwenden.

Durch das Verschieben einer Auswahl wird automaisch eine Schwebende Ebene (Schwebende Aus-
wahl) erzeugt. Beachten Sie hierzu das Kapitel Schwebende Auswahl im Glossar. Der Mauszeiger stellt
in einem solchen Fall einen Anker dar, sofern er ausserhalb der Auswahl positioniert ist. Dies bedeutet,
dass die Auswahl endgültig am gewählten Platz verankert wird, sobald die Maustaste gedrückt wird.

4.3. Docken von Dialogen

4.3.1. Dialoge hinzufügen

Die meisten dockbaren Dialoge können über das Dialogmenü im Werkzeugfenster erstellt werden: Datei
→ Dialoge. Zur Bequemlichkeit, is es möglich voreingestellte Dialoge in einem Dock hinzu zu fügen.
Über Datei→ Dialoge→ Neues Dock erstellen aus dem Werkzeugfenster können Sie folgende Docks
erstellen:

Ebenen, Kanäle und Pfade Erstellt ein Dock inklusive:

• den Kanaldialog,

• den Ebenendialog,

• den Pfaddialog,

• und den Rückgängig Dialog.

Pinsel, Muster und Farbverläufe Erstellt ein Dock inklusive:

• den Pinseldialog,

• den Musterdialog,

• den Farbverlaufsdialog,

• den Farbpalettendialog,

• und die Schriftartenauswahl.

Verschiedenes Erstellt ein Dock inklusive:

• den Ablagendialog,

• den Bilderdialog,

• den Dokumentenindex,

• und den Vorlagendialog.
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TIPP

Eine große Auswahl bedeutet nicht gleichfalls, daß jede Auswahl gut ist. Nach-
folgend zwei Tips auf denen man achten sollte:

1. Docken Sie die Werkzeugeinstellungen unter dem Werkzeugfenster um zu
jeder Zeit Zugriff darauf zu haben.

2. Lassen Sie den Ebenendialog jederzeit in einem seperaten Dock geöffnet.
Ebenfalls empfehlen wir, die Bildliste angezeigt zu lassen.

4.3.2. Reiter entfernen

Abbildung 4.5. Ein Dialog im Dock mit hervorgehobenen SSchließenSSchaltfläche.

Um ein Dialog aus dem Dock zu entfernen, klicken Sie einfach die SSchließenSSchaltfläche, welche
im anliegenden Schnapschuß hervorgehoben ist.

4.4. Einstellen des Datenspeichers

Bei der Bearbeitung und Manipulation von Bildern wird viel Arbeitsspeicher benötigt. Je mehr zur
Verfügung steht, desto besser. Gimp benutzt die durch das Betriebssystem bereitgestellten Resourcen
und diese so effektiv wie möglich, damit Sie schnell und bequem ihre Bilder bearbeiten können. Der
Datenspeicher wird benutzt, um Bilddaten die aktuell in Bearbeitung sind, zwischenzuspeichern. Dabei
besteht der Unterschied, welche Form des Datenspeichers benutzt wird: die langsame Festplatte oder
der schnelle Arbeitsspeicher.

Je kleiner der Wert des Datenspeichers wird, desto mehr wird die Festplatte zum Zwischenspeichern
ihrer Daten benutzt. Der Vorteil hier ist, dass Sie weniger Arbeitsspeicher benötigen um auch große
Bilder zu Bearbeiten. Nachteil ist jedoch, dass die Bearbeitung am Bild merklich langsamer von statten
geht. Ein höherer Wert führt dazu, das Gimp mehr Arbeitsspeicher zum Zwischenspeichern der Bildda-
ten benutzt. Dabei wird das Bearbeiten der Bilder um einiges schneller werden, jedoch werden andere
Programme die zeitgleich ausgeführt werden, weniger Arbeitsspeicher zur Verfügung haben.

Folgend ein paar Tips um die Entscheidung für eine gute Größe des Datenspeichers einzustellen:

• Vergessen Sie die Entscheidungsfindung und benutzen die Vorgabeeinstellungen von 64 Mega-
Byte. Für viele Benutzer ist die Einstellung ausreichend, da keine Bilder bearbeitet werden, die so
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groß sind, dass sich die Größe negativ auf den Arbeitsprozess am Computer auswirkt.

• Sie haben eine ausreichende Menge von Arbeitsspeicher im Computer – sagen wir beispielsweise
512 MegaByte. Setzen Sie den Wert des Datenspeichers auf ca. ¾ des zur Verfügung stehenden
Arbeispeichers; also auf 384 MegaByte.
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5. Anleitungen für Fortgeschrittene

5.1. Pfade

5.1.1. Pfade nachziehen

Abbildung 5.1. Vier Pfade mit unterschiedlichen Mustern und Strichkombinationen nachgezogen.

Stellen Sie sich vor, sie könnten Ihre Handbewegungen aufzeichnen lassen. Hilfslinien entstehen, um
nicht den Überblick über das gezeichneten Objekt zu verlieren. Ähnlich sind Pfade zu verstehen. Mit
Pfade können Sie geschwungene Formen, mit verschiedenen Mustern auf das ”virtuelle Papier“ brin-
gen. Mittels folgender Funktion: Bearbeiten → Pfad nachziehen erhalten Sie einen Dialog (siehe Ab-
bildung 5.2 um den Pfad ein Aussehen zu geben.

Abbildung 5.2. Der Dialog um Pfade nachzuziehen.

Mit dem Pfad nachziehen Dialog können Sie das Aussehen des nachgezogenen Pfades bestimmen.
Er bietet eine breite Auswahl an Stilen, Mustern sowie Werkzeugen um jegliche Art von Linieneffekten
abzubilden.
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Die nachgezogene Linie läßt sich verstärken, wenn Sie verschiedene Pinselgrößen benutzen oder den
Pfad mehrmals nachziehen. Ihren Möglichkeiten um jedwede Art von Effekt zu erziehlen sind keine
Grenzen gesetzt. Probieren Sie es selber aus.

5.1.2. Pfade transformieren

Mit den Transformationswerkzeugen lassen sich nicht nur Ebenen oder Auswahlen transformieren, son-
dern auch Pfade. Gehen Sie in die Werkzeugeinstellungen einer der Transformationswerkzeuge und
klicken Sie auf die Pfad transformieren Schaltfläche rechts neben Wirkt auf:.

Transformationswerkzeuge wirken standardmäßig nur auf einem Pfad, nämlich den aktiven. Transfor-
mationseffekte lassen sich aber nicht nur auf einen Pfad erziehlen. Um eine Transformation auf mehrere
Pfade anzuwenden, verketten Sie mehrere Pfade miteinander (symbolisiert durch eine Kette).

5.2. Bilder für das Internet optimieren

Der häufigste Grund, warum Gimp benutzt wird ist, um Bilder für das Internet (z.B. für die eigene Ho-
mepage) zu erstellen. Das heisst also, dass die Bilder so gut wie möglich aussehen sollen, aber dennoch
eine kleine Dateigröße aufweisen um Bandbreite zu sparen. Dieser Abschnitt soll Sie darüber informie-
ren, wie Sie Ihre Bilder optimal mit Gimp für das Internet vorbereiten.

5.2.1. Bilder mit einem optimalen Größe/Qualitäts Verhältnis

Eine optimale Lösung für das Internet hängt vom Bildtyp und dem Dateiformat ab. Wenn Sie ein Foto,
welches meist viele Farben aufweist, veröffentlichen wollen, benutzen Sie besser JPEG als Format zum
Speichern. Wenn es sich jedoch um eine Zeichnung oder selbsterstellte Graphik handelt, benutzen Sie
besser das PNG Format.

1. Als Erstes öffnen Sie wie immer Ihr Bild. Als Beispielbild benutze ich unseren Wilber.

Abbildung 5.3. Das Bild mit Wilber im RGBA Modus geöffnet.

2. Das Bild befindet sich jetzt im RGB Modus mit einem zusätzlichen Alpha Kanal (RGBA). Meistens
benötigen Sie keinen Alpha Kanal, wenn sie Bilder für das Web erstellen möchten. Daher können
Sie ihn entfernen. Das geschieht durch einen Klick auf Bild zusammenfügen. Fotos haben meist
keinen Alpha Kanal, so dass Sie dieses wahrscheinlich im RGB Modus geöffnet haben und es nicht
zusammenfügen brauchen.

ANMERKUNG

Enthält, die Grafik einen weichen Übergang zu transparenten Bereichen,
können Sie den Alpha Kanal nicht entfernen, da hier die Informationen für
die Überblendung gespeichert werden. Wollen Sie eine Grafik mit transpa-
renten Bereichen ohne weiche Übergänge ( ähnlich dem GIF ) speichern,
können Sie den Alpha Kanal entfernen.

3. Nachdem Sie den Alpha Kanal entfernt haben, können Sie das Bild als PNG Abspeichern.
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ANMERKUNG

Sie können das PNG mit den Vorgabeeinstellungen speichern. Benutzen Sie je-
doch die maximale Kompression. Das wird keine negativen qualitativen Auswir-
kungen wie beim JPEG Format auf das Bild haben. Haben Sie ein Foto geöffnet,
kommt es auf den besten Kompromiss zwischen Dateigrösse und Qualität des
Bildes an. Mehr Informationen um ein Bild als JPEG zu speichern finden Sie im
Glossar unter JPEG.

5.2.2. Die Dateigrösse mehr verkleinern

Wenn Sie die Dateigrösse noch etwas mehr verkleinern wollen, können Sie das Bild in den Indizier-
ten Farbmodus konvertieren. Das heisst, dass die vielen Farben auf nur 256 reduziert werden. Um
schlecht aussehende Bilder zu vermeiden, ist diese Methode jedoch nicht für Fotos oder Bilder mit
Farbübergängen zu empfehlen.

Abbildung 5.4. Das indizierte Bild kann etwas körnig aussehen. Das linke Bild ist der Wilber in Origi-
nalgrösse. Das rechte Bild zeigt das Bild in 3-facher Vergrößerung

1. Benutzen Sie den Konvertieren Dialog um das Bild von RGB in den Indizierten Farbmodus zu
konvertieren.

2. Nachdem das Bild konvertiert wurde, können Sie das Bild nochmals als PNG Abspeichern.

5.2.3. Bilder mit Transparenz speichern

Die unterschiedlichen Grafikformate bieten 2 grundsätzliche Möglichkeiten um transparente Bereiche
in Bildern zu ermöglichen: einfache binäre Transparenz und Alpha-Transparenz. Die erste erwähnte
Möglichkeit, binäre Transparenz, wird vom GIF Grafikformat unterstützt. Es kann eine Farbe aus der
indexierten Farbpalette als transparente Farbe markieren. Alpha-Transparenz wird vom PNG Format
unterstützt, welches seine Informationen zur Transparenz in einem seperaten Farbkanal hällt: den Alpha
Kanal.
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Es gibt in den meisten Fällen keinen Grund mehr, Bilder im GIF Format zu spei-
chern, da PNG alle Features von GIF unterstützt und dazu zusätzliche Features
wie z.B. Alpha-Transparenz.

Ein Bild mit transparenten Bereichen erstellen (Alpha Transparenz)

1. Als Erstes, wir benutzen das gleiche Bild wie in den vergangenen Tutorials: Wilber das Gimp
Maskotchen.

Abbildung 5.5. Das Bild von Wilber im RGBA Modus geöffnet.

2. Eine Bedingung um Bilder mit Alpha Transparenz zu speichern ist der Alpha Kanal. Um zu
überprüfen ob ein Bild einen Alpha-Kanal besitzt öffne den Kanal Dialog und überprüfe ob neben
Rot, Grün und Blau ebenfalls ein Eintrag mit ”Alpha“ existiert. Sollte dies nicht der Fall sein füge
einen neuen Alpha Kanal aus den Ebenen Menü hinzu.

3. Es ist nun möglich die Hintergrund Ebene zu entfernen um einen transparenten Hintergrund zu
erhalten, oder erzeuge einen Farbverlauf von einer Farbe nach Transparenz. Deiner Phantasie sind
hier keine Grenzen gesetzt. Um die Möglichkeiten von Alpha Transparenz zu demonstrieren wer-
den wir ein leichtes glühen um Wilber herum erzeugen.

4. Wenn sie mit dem Bild fertig sind, können sie das Bild im PNG Format abspeichern

Abbildung 5.6. Die kleinen grauen Kästchen in der Hintergrund Ebene stellen die transparente Region
auf den gesicherten Bild dar, während sie das Bild im Gimp bearbeiten.

5.3. Hinzufügen neuer Pinsel

Pinselformen können Sie für Gimp erstellen oder im Internet als Dateien herunterladen. Um die Dateien
im Pinseldialog auch auswählbar zu haben, muss die Datei mit den Pinselformen in einen Ordner im
Suchpfad von Gimp platziert werden. Sie können Dateien mit Pinselformen im laufenden Betrieb in die
Ordner platzieren. Drücken sie die Pinsel neu laden Schaltfläche, um die neue Pinselform auswählen
zu können. Gimp kann drei Dateiformate für Pinsel lesen:

GBR Das Gimp brush Format (kurz gbr) wird für gewöhnliche Graustufen und Farbpinsel verwendet.
Es ist möglich, Pinsel anderer Programme oder Bilder in das Gimp eigene Pinselformat zu kon-
vertieren. Durch Öffnen und Speichern mit der Endung .gbr wird das Bild als Pinsel gespeichert.
Mehr Informationen finden Sie im devel-docs Verzeichnis unter gbr.txt der Gimp Quellcode
Distribution.
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Abbildung 5.7. Der Dialog um eine animierte Pinselform zu beschreiben.

GIH Das ”Gimp image hose“ Format (kurz gih) wird benutzt, um animierte Pinsel zu speichern. Diese
Pinsel werden mittels mehreren Ebenen konstruiert, wobei jede Ebene eine verschiedene Pinsel-
form wiederspiegelt. Wenn Sie eine animierte Pinselform als .gih abspeichern, erscheint ein Dia-
log um das Format zu beschreiben (siehe Abbildung 5.7. Das Format selber ist etwas kompliziert,
wird aber in gih.txt in den devel-docs der Gimp Quellcode Distribution beschrieben.

VBR Das .vbr Format wird benutzt um parametrische Pinselinformationen zu behalten, welche durch
den Pinseleditor abgespeichert werden.

Wie in der Einführung beschrieben, können Sie eine Pinseldatei in einen der Pinselordner von Gimp le-
gen. Standardmäßig werden zwei Ordner nach neuen Pinseln durchsucht: den systemweiten brushes
Ordner, den Sie besser nicht verändern und den brushes Ordner in ihrem persöhnlichen Gimp Ver-
zeichnis. Sie können neue Ordner zu diesen beiden in den Einstellungen hinzufügen. Jede Datei die auf
gbr, gih oder vbr endet wird von Gimp indiziert und im Pinseldialog angezeigt. Voreinstellung

ANMERKUNG

Wenn Sie Pinsel über den Pinseleditor erstellen, werden diese automatisch im
brushes Verzeichnis abgespeichert.

Es gibt eine Reihe von Webseiten die eine ganze Kollektion von Pinseln zum Herunterladen anbieten.
Anstatt Ihnen eine Liste von Verweisen anzubieten, möchten wir Sie ermutigen mit einer Suchmaschine
Ihrer Wahl nach ”GIMP brushes“ zu suchen. Es gibt zudem eine Menge von Pinseln die Sie konvertieren
können. Manche davon lassen sich leicht, schwer oder gar nicht konvertieren. Leider gehören die wohl
schönsten immer zur letzten Gruppe.
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6. Anleitungen für Profis

6.1. Erstellen eines Gitters

Sie möchten also ein Gitter auf das virtuelle Papier bringen. Jedoch hilft Ihnen das Bildgitter nicht weiter,
da es nur als Hilfestellung gedacht ist. Ein Plugin kann Ihnen aber bei der Erstellung eines Gitters die
Arbeit abnehmen. Das Plugin nennt sich Gitter.
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Teil III.

Die GIMP Funktionsreferenz
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7. Werkzeuge

7.1. Das Werkzeugfenster

GIMP verfügt über eine umfangreiche Sammlung von Werkzeugen. Diese können Sie verwenden, um
sehr schnell grundlegende Aufgaben wie das Erstellen einer Auswahl oder das Zeichnen von Pfaden zu
erledigen. Das Werkzeugfenster enthält alle diese Werkzeuge, welche wir Ihnen nachfolgend detailliert
vorstellen werden.

Die vielfältigen Werkzeuge von GIMP lassen sich in fünf Kategorien einteilen: Auswahlwerkzeuge, wel-
che den Bereich des Bildes festlegen oder anpassen, auf den die anschließenden Aktionen angewendet
werden; Malwerkzeuge, mit welchen sich die Farben in einzelnen Bildteilen verändern lassen; Transfor-
mationswerkzeuge zur Bearbeitung der Bildgeometrie; Farbwerkzeuge, um Farben über das ganze Bild zu
verteilen und Sonstige Werkzeuge, die in keine der vier genannten Kategorien fallen.

(Falls es Sie interessiert: in der GIMP Fachsprache ist ein ”Werkzeug“ die Art und Weise auf ein Bild
einzuwirken, welche einen Zugriff auf dessen Darstellung erfordert. Dies funktioniert entweder derart,
dass Sie festlegen was verändert werden soll, oder indem Sie interaktiv eine Veränderung der Darstel-
lung aufgezeigt bekommen. Wenn Sie sich jedoch unter einem Werkzeug lieber eine Säge und unter
einem Bild ein Stück Holz vorstellen möchten, so wird sich das auch nicht nachteilig auswirken.)

Die meisten Werkzeuge lassen sich durch einen Klick auf das entsprechende Symbol im Werkzeug-
fenster aktivieren. Einige jedoch (insbesondere die Farbwerkzeuge), sind nur über die Menüs Werkzeu-
ge → Farben oder Ebene → Farben. Jedes Werkzeug kann letztendlich über das Menü Werkzeuge
bzw. mit Hilfe eines Tastenkürzels aufgerufen werden.

In den Vorgabe-Einstellungen, die bei der ersten Installation von GIMP angelegt werden, sind nicht
alle Werkzeuge im Werkzeugfenster verfügbar: die Farbwerkzeuge wurden weggelassen. Sie können
die Auswahl an Werkzeugen, die im Werkzeugfenster angezeigt werden sollen im Dialog Werkzeuge
anpassen. Es gibt zwei Gründe, weshalb Sie dies möglicherweise tun möchten: Entweder Sie benutzen
ein Werkzeug sehr selten und möchten die Übersichtlichkeit des Werkzeugfensters erhöhen, oder Sie
verwenden die Farbwerkzeuge sehr häufig und möchten diese bequem über das Werkzeugfenster im
Zugriff haben. In jedem Fall finden Sie unbhängig vom aktuellen Inhalt des Werkzeugfensters jedes
Werkzeug jederzeit im Menü Werkzeuge in der Menüleiste des Bildfensters.

Welches Werkzeug momentan aktiv ist, erkennen Sie, sobald sich dieser innerhalb einem Bildfenster
befindet, auch an der Form des Mauszeigers.

7.1.1. Werkzeugeinstellungen

Abbildung 7.1. Einstellungen für das Werkzeug Rechteckige Auswahl.
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Jedes Werkzeug in GIMP verfügt über eine Reihe von Einstellungen, welche für das jeweils akti-
ve Werkzeug im Dialog Werkzeugeinstellungen angezeigt werden. In den Vorgabe-Einstellungen wird
diesr Dialog unterhalb des Werkzeugfensters angezeigt. Falls dies bei Ihnen nicht der Fall ist, sollten Sie
den Dialog an einer anderen Stelle eingeblendet haben, denn es erleichtert Ihnen die Arbeit mit einem
Werkzeug sehr, wenn sie seine Einstellungen leicht überprüfen und ändern können.

TIPP

Die Werkzeugeinstellungen werden in den GIMP Vorgabe-Einstellungen unter-
halb des Werkzeugfensters eingeblendet. Sollte der Dialog nicht sichtbar sein,
können Sie ihn über das Menü Datei → Dialoge → Werkzeugeinstellungen
neu erstellen und an der gewünschten Stelle andocken. Schauen Sie unter Do-
cken von Dialogen nach, falls Sie hierbei Hilfe benötigen.

Jedes Werkzeug hat seine eigenen, speziellen Eigenschaften. Die von Ihnen vorgenommenen Einstel-
lungen bleiben erhalten, bis Sie GIMP beenden, oder Sie die Einstellungen erneut ändern. Genaugenom-
men bleiben die Einstellungen an den Werkzeugen sogar erhalten wenn Sie GIMP beenden und später
neu starten. Diese Verhalten kann gelegentlich irritierend sein. Stellen Sie sich vor, ein Werkzeug verhält
sich nach einem Neustart von GIMP plötzlich sehr merkwürdig und Sie finden den Grund dafür nicht -
bis Sie sich erinnern, dass sie, als sie vor Tagen oder Wochen das letzte Mal mit GIMP gearbeitet haben,
genau diese ungewöhnlichen Werkzeugeinstellungen benötigten.

Am unteren Rand des Dialogs Werkzeugeinstellungen befinden sich vier Schaltflächen:

• Einstellungen speichern als. Diese Schaltfläche erlaubt es Ihnen die Eigenschaften des aktiven
Werkzeuges zu speichern, um sie später wiederzuverwenden. Beim Anklicken erscheint ein klei-
ner Dialog, in dem Sie den zu speichernden Einstellungen einen Namen geben können. Beim
Wiederherstellen der Eigenschaften bekommen Sie nur die für dieses Werkzeug gespeicherten
Einstellungen zur Auswahl angeboten, die Bezeichnung des Werkzeuges müssen Sie daher beim
Vergeben des Namens nicht berücksichtigen.

• Einstellungen laden. Diese Schaltfläche erlaubt es Ihnen zuvor gespeicherte Einstellungen zum
aktiven Werkzeug wiederherzustellen. Wurden die Eigenschaften des aktiven Werkzeuges noch
nie gespeichert, ist die Schaltfläche ausgegraut. Andernfalls öffnet sich nach einem Klick auf die
Schaltfläche ein Menü mit den Namen aller gespeicherten Einstellungen. Durch die Auswahl eines
Eintrages aus diesem Menü werden die gespeicherten Einstellungen wiederhergestellt.

• Einstellungen löschen. Diese Schaltfläche erlaubt es Ihnen zuvor gespeicherte Einstellungen zum
aktiven Werkzeug zu löschen. Wurden die Eigenschaften des aktiven Werkzeuges noch nie ge-
speichert, ist die Schaltfläche ausgegraut. Anderenfalls öffnet sich nach einem Klick auf die Schalt-
fläche ein Menü mit den Namen aller gespeicherten Einstellungen. Durch die Auswahl eines Ein-
trages aus diesem Menü werden die gespeicherten Einstellungen gelöscht.

• Auf Vorgabewerte zurücksetzen. Diese Schaltfläche setzt alle Eigenschaften des aktiven Werk-
zeuges auf die Vorgabe-Einstellungen zurück.

7.2. Auswahlwerkzeuge

7.2.1. Allgemeine Eigenschaften

Als Auswahl wird in in GIMP ein definierter, beliebig geformter Bereich eines Bildes bezeichnet. Wei-
tere Informationen hierzu finden Sie im Kapitel Auswahl. Die Arbeit mit einer Auswahl ermöglicht es
Ihnen Werkzeuge und Filter nur auf den ausgewählten Bereichen des Bildes wirken zu lassen. GIMP
stellt Ihnen verschiedene Auswahlwerkzeuge zur Verfügung, mit deren Hilfe Sie leicht solche Bereiche
festlegen können. Dabei verfügt jedes Auswahlwerkzeug einerseits über spezielle Eigenschaften, an-
dererseits haben aber auch alle Auswahlwerkzeuge bestimmte allgemeine Eingenschaften. In diesem
Abschnitt werden zunächst diese allgemeinen Eigenschaften beschrieben.

Es gibt sechs Auswahlwerkzeuge:
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• Rechteckige Auswahl

• Elliptische Auswahl

• Freie Auswahl

• Zauberstab

• Auswahl nach Farbe

• Magnetische Auswahl

Auch das Pfadwerkzeug kann als ein Auswahlwerkzeug betrachtet werden, da jeder geschlossene Pfad
in eine Auswahl konvertiert werden kann. Da das Pfadwerkzeug neben der Erstellung einer auswahl
aber noch viele weitere Anwendungsmöglichkeiten bietet, zählt es nicht zu den primären Auswahl-
werkzeugen und wird in einem eigenen Kapitel beschrieben.

7.2.1.1. Tastenkombinationen (Vorgabe-Einstellungen)

Das Verhalten der Auswahlwerkzeuge verändert sich, wenn Sie eine der drei Tasten Strg, Shift, und/oder
Alt während der Arbeit mit dem Werkzeug gedrückt halten.

ANMERKUNG

Tastenkürzel ermöglichen einen schnellen Zugriff auf verschiedene Eigenschaf-
ten der Auswahlwerkzeuge. Sie werden gern und häufig von fortgeschrittenen
Benutzern verwendet, Einsteiger finden Tastenkürzel hingegen gelegentlich ver-
wirrend. Glücklicherweise können sie die meisten Eigenschaften der Werkzeuge
auch per Mausklick verändern.

Strg Wenn Sie während der Verwendung eines Auswahlwerkzeuges die Taste Strg gedrückt halten,
wird dies zwei Auswirkungen haben. Zum Einen wird der Startpixel als Mittelpunkt der Auswahl
benutzt, dass heisst um diesen Mittelpunkt wird die Auswahl erstellt. Alternativ wird der Start-
pixel als rechte, untere Ecke benutzt, um die Auswahl zu erstellen. Zum Anderen wird der Aus-
wahlmodus auf Subtrahieren gesetzt. Sollte nur eine der Funktionen gewünscht sein, so können
Sie die Strg Taste vor der Maustaste loslassen. Dies wird dazu führen, dass die Auswahl im
Subtraktionsmodus durchgeführt wird, die werkzeugabhängige Funktion aber nicht zum Einsatz
kommt.

Alt Wenn Sie während der Verwendung eines Auswahlwerkzeuges die Taste Alt gedrückt halten, können
Sie die aktuelle Auswahl (nur den Rahmen, nicht den Inhalt) verschieben. Wird wider Erwarten
das gesamte Bild verschoben, versuchen Sie es nocheinmal während Sie Schift–Alt gedrückt hal-
ten.

ANMERKUNG

Leider wird die Alt Taste von einigen Fenstermanagern (einem Teil des Be-
triebssystems Ihres Computers) nicht korrekt weitergeleitet, so das GIMP
niemals erfährt das die Taste überhaupt gedrückt wurde. Dies kann dazu
führen, dass die Funktion bei Ihnen gar nicht funktioniert. Falls Sie einen
Apple Computer mit OS X benutzen, könne Sie versuchen das Problem
zu beheben, indem Sie in den Einstellungen des Programms X 11 unter
Eingabe die Funktion Drei Maustasten nachbilden ausschalten.
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Shift Wenn Sie während der Verwendung eines Auswahlwerkzeuges die Shift Taste gedrückt halten,
wird dies, wie bei der Strg Taste, zwei Auswirkungen haben, Die Erste ist wiederum vom kon-
kreten Auswahlwerkzeug abhängig, hat aber immer damit zu tun, dass das Seitenverhältnis der-
Auswahl konstant gehalten wird. Beispielsweise führt das Drücken der Shift Taste bei der Recht-
eckigen Auswahl zu einem quadratischen Bereich. Die zweite Auswirkung besteht darin, dass
der Auswahlmodus auf Hinzufügen geändert wird. Dies bedeutet, dass die neue Auswahl zu ei-
ner bereits vorhandenen Auswahl hinzugefügt wird. Sollten Sie nur eine der beiden Funktionen
wünschen, so können Sie die Shift Taste vor der Maustaste loslassen. Dies führt dazu, dass die
Auswahl im Modus Hinzufügen ausgeführt wird, allerdings ohne Auswirkungen auf das Seiten-
verhältnis der Auswahl zu haben.

Strg–Shift Durch Benutzung von Strg–Shift ergeben sich, in Abhängigkeit vom verwendeten Aus-
wahlwerkzeug, viele verschiedene Anwendungsmöglichkeiten. Für alle Auswahlwerkzeuge gilt,
dass wenn beide Tasten gleichzeitig gedrückt werden, der Auswahlmodus auf den Schnittmodus
umgeschaltet wird. Ausserdem wird die Auswahl um den Mittelpunkt erstellt, sowie das Seiten-
verhältnis der Auswahl konstant gehalten. Experimentieren Sie etwas mit den Tastenkombinatio-
nen, um ein Gefühl dafür zu bekommen.

7.2.1.2. Eigenschaften

Nachfolgend werden diejenigen Werkzeugeinstellungen beschrieben, die für alle Auswahlwerkzeuge
verfügbar sind. Werkzeugspezifische Einstellungen sind jeweils in dem Abschnitt dokumentiert, der
speziell diesem Werkzeug gewidmet ist. Die aktuellen Einstellungen eines Werkzeuges können im Dia-
log Werkzeugeinstellungen eingesehen werden, welchen Sie bei Ihrer Arbeit mit GIMP immer einge-
blendet haben sollten.

Auswahlmodus Diese Eigenschaft legt fest, in welcher Weise eine neu erstellte Auswahl mit einer be-
reits existierenden Auswahl verküpft wird. Bitte beachten Sie in diesem Zusammenhang auch die
für die Auswahlmodi verfügbaren Tastenkürzel, welche im vorigen Abschnitt des Handbuches
ausführlich erklärt wurden.

Der Modus Ersetzen, ersetzt die vorhandene Auswahl durch die neu erstellte Auswahl

Der Modus Hinzufügen, fügt die neue Auswahl zur bereits bestehenden Auswahl hinzu.

Im Modus Subtrahieren wird der sich überlappende Bereich zwischen einer neu erzeugten Aus-
wahl und der vorhandenen Auswahl von der vorhandenen Auswahl abgezogen. Überlappen
sich die neu erzeugte Auswahl und die bereits Bestehende nicht, bleibt die bestehende Auswahl
vollständig erhalten.

Im Schnittmodus bildet der sich überlappende Bereich zwischen der erzeugten und der bestehen-
den Auswahl die neue Auswahl.

Kantenglättung Diese Option hat nur auf einige der Auswahlwerkzeuge eine Auswirkung: Sie sorgt
für eine Weichzeichnung der Auswahlkanten.

Kanten ausblenden Der Radius Schieber legt die Länge des Übergangs der ausgeblendeten Kanten
fest. Ein veränderter Wert wird für die nächste Auswahl wirksam. Der Radius kann einen Wert
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zwischen 0 (keine Überblendung der Kanten) und 100 (starke Überblendung) annehmen. Eine
ausführliche Beschreibung der Eigenschaft Kanten ausblenden finden Sie im Glossar.

7.2.1.3. Ergänzende Informationen

ANMERKUNG

Wenn die Auswahl über die Bildgrenze hinausgeht, wird diese an den Bild-
grenzen beschnitten. Eine Auswahl kann nur auf der sichtbaren Ebene er-
stellt werden. Verschiebungen oder Veränderungen an der Auswahl lassen sich
rückgängig machen.

7.2.2. Rechteckige Auswahl

Abbildung 7.2. Die Rechteckige Auswahl im Werkzeugfenster.

Die Rechteckige Auswahl ist das einfachste und gleizeitig wohl das am häufigsten verwendete Aus-
wahlwerkzeug. Es ermöglicht Ihnen die Erstellung einer Auswahl aus einer rechteckigen Region eines
Bildes oder der aktuellen Ebene. Um weitere Informationen zu erhalten, lesen Sie das Kapitel über das
GIMP Konzept der Auswahl, oder das über die Allgemeinen Eigenschaften von Auswahlwerkzeugen.

Dieses Werkzeug wird auch für das Zeichnen von rechteckigen Flächen verwendet. Hierzu erstellen
Sie zunächst eine rechteckige Auswahl und füllen diese dann mit Hilfe des Fülleimer Werkzeuges. Um
einen rechteckigen Rahmen zu erzeugen, ist die einfachste und flexibelste Vorgehensweise die Erstel-
lung einer rechteckigen Auswahl, welche dann umrandet wird.

Falls Sie eine rechteckige Auswahl mit abgerundeten Ecken benötigen, so gibt es einen einfachen Weg
dies zu erreichen. Führen Sie einfach die Funktion, Auswahl → Abgerundetes Rechteck, welche sich
im Menü des Bildfensters findet, mit dem gewünschten Radius aus.

7.2.2.1. Werkzeugaufruf

Sie haben verschiedene Möglichkeiten das Werkzeug Rechteckige Auswahl zu aktivieren:

• Über das Menü Werkzeuge → Auswahlwerkzeuge → Rechteckige Auswahl im Bildfenster,

• Mit einen Mausklick auf das Symbol im Werkzeugfenster, sowie

• Über das Tastenkürzel R.
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7.2.2.2. Tastenkombinationen (Vorgabe-Einstellungen)

• Strg: Das Drücken der Taste Strg nach dem Beginn der Erstellung einer Auszahl bewirkt, dass
der Startpixel als Mittelpunkt der neuen Auswahl benutzt wird und nicht als Ecke. Bitte beach-
ten Sie, dass wenn Sie die Taste Strg drücken bevor Sie beginnen die Auswahl zu erstellen, der
Auswahlmodus auf Subtrahieren gestellt wird.

• Shift: Das Drücken der Taste Shift nach dem Beginn der Erstellung einer Auszahl bewirkt, dass
die neue Auswahl quadratisch sein wird. Bitte beachten Sie, dass wenn Sie die Taste Shift vor dem
Beginn der Erstellung der neuen Auswahl drücken, der Auswahlmodus auf Hinzufügen gestellt
wird.

• Strg–Shift: Das Drücken von Strg–Shift führt zu einer quadratischen Auswahl, wobei der Start-
pixel als Mittelpunkt der neuen Auswahl verwendet wird.

7.2.2.3. Eigenschaften

Abbildung 7.3. Die Werkzeugeinstellungen für die Rechteckige Auswahl.

ANMERKUNG

In diesem Abschnitt werden nur die speziellen Eigenschaften des Werkzeuges
beschrieben. Schauen sie bitte unter Auswahlwerkzeuge nach, falls Sie Hilfe zu
den Allgemeinen Einstellungen der Auswahlwerkzeuge benötigen.

Die aktuellen Einstellungen für die rechteckige Auswahl lassen sich durch ein Doppelklick auf das

Icon anzeigen.

Kantenglättung Diese Eigenschaft hat zur Zeit für das Werkzeug Rechteckige Auswahl keine Funktion
und wird nur aus Konsistenzgründen angezeigt. Sie ist daher ausgegraut.

Automatisch verkleinern Wenn das Kontrollkästchen Automatisch verkleinern aktiviert ist, wird die
nächste erstellte Auswahl automatisch auf die räumlich nächste in der Bildebene befindliche recht-
eckige Form verkleinert. Der Algorithmus, welcher diese Form erkennt ist ”intelligent“, was in
diesem Fall bedeutet, dass gelegentlich erstaunlich raffinierte Ergebnisse erzeugt werden. Manch-
mal jedoch auch überraschend sonderbare. Sofern jedoch die rechteckige Form die Sie auswählen
wollen von einer gleichmäßigen Farbe umgeben ist, wird das Ergebnis Ihren Erwartungen ent-
sprechen.
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Wenn zusätzlich die Eigenschaft Vereinigung überprüfen eingeschaltet ist, wird die Funktion
nicht auf Basis der Pixel in der aktiven Ebene berechnet, sondern vielmehr auf der Basis der aktu-
ellen Darstellung des Bildes, also aller momentan sichbaren Ebenen. Für weiterführende Informa-
tionen lesen Sie den Glossareintrag Vereinigung überprüfen.

Abbildung 7.4. Auswahlmenü für die Typen von Größenbeschränkungen

Größenbeschränkung

Diese Menü erlaubt es Ihnen eine Größenbeschränkung der Auswahl auf drei verschiedene Arten
vorzunehmen.

• Freie Auswahl. Diese Einstellung nimmt keine Beschränkung der Auswahl hinsichtlich der
Größe oder des Seitenverhältnisses vor.

• Feste Größe. Durch benutzen der Einstellung Feste Größe, lässt sich eine fixe Grösse für die
Auswahl einstellen. Parameter wie Breite und Höhe beeinflussen die Auswahl.

• Festes Seitenverhältnis. Die Einstellung Festes Seitenverhältniss sorgt dafür, dass bei der
Erstellung einer neuen Auswahl, das Verhältnis von Höhe und Breite konstant bleibt.

7.2.3. Elliptische Auswahl

Abbildung 7.5. Die Elliptische Auswahl im Werkzeugfenster.

Das Werkzeug Elliptische Auswahl ermöglicht es Ihnen eine Auswahl aus kreisförmigen und ellip-
tischen Bereichen des Bildes oder der aktuellen Ebene zu erstellen. Diese Auswahl kann dann benutzt
werden, um Bildmanipulationen nur auf den ausgewählten Bereich anzuwenden.

Dieses Werkzeug wird auch für das Zeichnen von kreisrunden oder elliptischen Flächen verwendet.
Hierzu erstellen Sie zunächst eine entsprechende Auswahl und füllen diese dann mit Hilfe des Fülleimer
Werkzeuges. Um einen runden oder elliptischen Rahmen zu erzeugen, ist die einfachste und flexibelste
Vorgehensweise die Erstellung einer passenden Auswahl, welche dann umrandet wird. Allerdings ist
die Qualität bei diesem Ansatz eher bescheiden. Eine qualitativ hochwertigerer Rahmen kann erzeugt
werden, indem Sie zwei Auswahlen verschiedener Größe erstellen und dann die innere Auswahl von
der äußeren Subtrahieren. Allerdings ist es nicht immer leicht die passenden Auswahlen zu erstellen.

7.2.3.1. Werkzeugaufruf

Sie haben verschiedene Möglichkeiten das Werkzeug Elliptische Auswahl zu aktivieren:

• Über das Menü Werkzeuge → Auswahlwerkzeuge → Elliptische Auswahl im Bildfenster,

• Mit einen Mausklick auf das Symbol im Werkzeugfenster, sowie

• Über das Tastenkürzel E.
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7.2.3.2. Tastenkombinationen (Vorgabe-Einstellungen)

• Strg: Das Drücken der Taste Strg nach dem Beginn der Erstellung einer Auszahl bewirkt, dass der
Startpixel als Mittelpunkt der neuen Auswahl benutzt wird und nicht als Ecke eines gedachten,
die Auswahl umgebenden, Rechtecks. Bitte beachten Sie, dass wenn Sie die Taste Strg drücken
bevor Sie beginnen die Auswahl zu erstellen, der Auswahlmodus auf Subtrahieren gestellt wird.

• Shift: Das Drücken der Taste Shift nach dem Beginn der Erstellung einer Auszahl bewirkt, dass
die neue Auswahl kreisrund sein wird. Bitte beachten Sie, dass wenn Sie die Taste Shift vor dem
Beginn der Erstellung der neuen Auswahl drücken, der Auswahlmodus auf Hinzufügen gestellt
wird.

• Strg–Shift: Das Drücken von Strg–Shift führt zu einer kreisrunden Auswahl, wobei der Startpixel
als Mittelpunkt der neuen Auswahl verwendet wird.

7.2.3.3. Eigenschaften

Abbildung 7.6. Eigenschaften des Werkzeuges Elliptische Auswahl

ANMERKUNG

In diesem Abschnitt werden nur die speziellen Eigenschaften des Werkzeuges
beschrieben. Schauen sie bitte unter Auswahlwerkzeuge nach, falls Sie Hilfe zu
den Allgemeinen Einstellungen der Auswahlwerkzeuge benötigen.

Die aktuellen Einstellungen für die Elliptische Auswahl lassen sich durch einen Doppelklick auf das

Symbol anzeigen.

Kantenglättung Diese Eigenschaft lässt die Kanten der Auswahl weicher erscheinen, indem auf die
Pixel am Rand der Auswahl ein Antialiasing Algorithmus angewendet wird. Sie werden meist
feststellen, dass Ihnen die Ergebnisse besser gefallen, wenn das Antialiasing eingeschaltet ist. Der
Hauptgrund der gegen die Verwendung dieser Eigenschaft spricht ist, dass bei Ausschneide- und
Einfügeoperationen Farbverschiebungen an den Rändern der Auswahl auftreten können.

Automatisch verkleinern Wenn das Kontrollkästchen Automatisch verkleinern aktiviert ist, wird die
nächste erstellte Auswahl automatisch auf die räumlich nächste in der Bildebene befindliche el-
liptische Form verkleinert. Der Algorithmus, welcher diese Form erkennt ist ”intelligent“, was in
diesem Fall bedeutet, dass gelegentlich erstaunlich raffinierte Ergebnisse erzeugt werden. Manch-
mal jedoch auch überraschend sonderbare. Sofern jedoch die rechteckige Form die Sie auswählen
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wollen von einer gleichmäßigen Farbe umgeben ist, wird das Ergebnis Ihren Erwartungen ent-
sprechen. Zu beachten ist noch, dass die verkleinerte Auswahl in iherer Form nicht in allen Fällen
exakt der von Ihnen vorgegebenen Form entsprechen wird.
Wenn zusätzlich die Eigenschaft Vereinigung überprüfen eingeschaltet ist, wird die Funktion
nicht auf Basis der Pixel in der aktiven Ebene berechnet, sondern vielmehr auf der Basis der aktu-
ellen Darstellung des Bildes, also aller momentan sichbaren Ebenen. Für weiterführende Informa-
tionen lesen Sie den Glossareintrag Vereinigung überprüfen.

Abbildung 7.7. Auswahlmenü für die Typen von Größenbeschränkungen

Größenbeschränkung

Diese Menü erlaubt es Ihnen eine Größenbeschränkung der Auswahl auf drei verschiedene Arten
vorzunehmen.

• Freie Auswahl. Diese Einstellung nimmt keine Beschränkung der Auswahl hinsichtlich der
Größe oder des Seitenverhältnisses vor.

• Feste Größe. Durch benutzen der Einstellung Feste Größe, lässt sich eine fixe Grösse für die
Auswahl einstellen. Parameter wie Breite und Höhe beeinflussen die Auswahl.

• Festes Seitenverhältnis. Die Einstellung Festes Seitenverhältniss sorgt dafür, dass bei der
Erstellung einer neuen Auswahl, das Verhältnis von Höhe und Breite konstant bleibt.

7.2.4. Freie Auswahl (Lassowerkzeug)

Abbildung 7.8. Das Lassowerkzeug im Werkzeugfenster.

Das Werkzeug Freie Auswahl (im folgenden Lassowerkzeug genannt) ermöglicht es Ihnen einen Be-
reich des Bildes oder der aktuellen Ebene, frei Hand auszuwählen. Hierzu führen Sie einfach den Maus-
zeiger um den auszuwählenden Bereich herum, während Sie die Maustaste gedrückt halten. Sobald Sie
die Maustaste loslassen, wird die Auswahl automatisch geschlossen, indem zwischen dem Startpunkt
und der aktuellen Position des Mauszeigers eine gerade Linie eingefügt wird. Das Lassowerkzeug ist
sehr gut, um einen Bereich grob auszuwählen. Es ist weniger für präzise Arbeiten geeignet. Erfahrene
GIMP Anwender werden feststellen, dass es sehr bequem ist mit dem Lassowerkzeug zu beginnen und
dann in den Modus Schnelle Maske zu wechseln, um dort die Detailarbeiten vorzunehmen.

ANMERKUNG

Das Lassowerkzeug lässt sich wesentlich einfacher benutzen, wenn Sie statt mit
einer Maus mit einem Zeichentablett arbeiten.
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7.2.4.1. Werkzeugaufruf

Sie haben verschiedene Möglichkeiten das Lassowerkzeug zu aktivieren:

• Über das Menü Werkzeuge → Auswahlwerkzeuge → Freie Auswahl im Bildfenster,

• Mit einen Mausklick auf das Symbol im Werkzeugfenster, sowie

• Über das Tastenkürzel F.

7.2.4.2. Tastenkombinationen (Vorgabe-Einstellungen)

Die Lassowerkzeug hat keine speziellen Tastenkombinationen. Die allgemeinen Tastenkombinationen
für Auswahlen stehen Ihnen aber, wie in dem Abschnitt Auswahlwerkzeuge beschrieben zur Verfügung.

7.2.4.3. Eigenschaften

Abbildung 7.9. Eigenschaften für das Lassowerkzeug

Das Lassowerkzeug hat keine Eigenschaften, ausser denen, die für alle Auswahlwerkzeuge verfügbar
sind. Schauen Sie bitte unter Auswahlwerkzeuge nach, um Hilfe zu den allgemeinen Eigenschaften
erhalten.

Die aktuellen Einstellungen für das Lassowerkzeug lassen sich durch einen Doppelklick auf das Sym-

bol anzeigen.

7.2.5. Zauberstab

Abbildung 7.10. Der Zauberstab im Werkzeugfenster.

Das Werkzeug Zauberstab ermöglicht es Ihnen eine Auswahl auf der Basis von Bereichen eines Bildes
oder der aktuellen Ebene mit ähnlichen Farbwerten zu erstellen. Es beginnt eine Auswahl zu erstellen,
sobald Sie einen Bereich des Bildes anklicken. Die Auswahl vergrößert sich ausgehend von dem von
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Ihnen gewählten Punkt, als würden Sie Wasser ausschütten, welches über alle Bereich mit gleicher oder
ähnlicher Farbe läuft.

Der Zauberstab ist sehr gut geeignet, um eine Auswahl aus Bildteilen zu erstellen, welche durch star-
ke Kanten von ihrer Umgebung abgegrenzt sind. Es macht Spaß den Zauberstab zu benutzen, daher
arbeiten gerade GIMP-Einsteiger sehr viel mit ihm. Wenn Sie eine Weile den Zauberstab verwendet ha-
ben, kann es allerdings passieren, dass Sie es als eher schwierig empfinden damit exakt den Bereich
auszuwählen, den Sie wollen - weder mehr, noch weniger. Das möglicherweise Frustrierendste bei der
Benutzung des Zauberstabes ist, dass wenn Sie ersteinmal die Maustaste losgelassen haben, Sie keine
Möglichkeit mehr haben kleine Änderungen an der Eigenschaft Schwelle vorzunehmen. Sie müssen
zuerst die Einstellung anpassen und dann die Auswahl neu erstellen. Erfahrenere Anwender empfin-
den daher die Arbeit mit den Werkzeugen Pfad oder Nach Farbe auswählen als wesentlich effizienter
und verwenden den Zauberstab deutlich seltener. Trotzdem, der Zauberstab ist sehr nützlich, wenn es
darum geht, einen Bereich des Bildes auszuwählen, der von einer Kontur begrenzt wird. Er funktioniert
auch sehr gut, um ein (nahezu) einfarbigen Hintergrund auszuwählen.

Bitte beachten Sie, dass der ausgewählte Bereich nicht nur Pixel umfasst, die direkt mit dem Start-
punkt verbunden sind. Der Zauberstab ist auch in der Lage kleine Lücken zu überspringen. Die Größe
dieser Lücken lässt sich im Bereich Werkzeugeinstellungen des Dialogs Einstellungen verändern. Hier-
zu passen Sie bitte die Eigenschaft Voreingestellter Schwellwert Ihren Bedürfnissen an. Durch ein
vergrößern oder verkleinern dieser Einstellung machen Sie den Zauberstab mehr oder weniger aggres-
siv.

TIPP

Sie können die Schwelle bis zu der sich die Auswahl ausbreitet verändern, indem
Sie den Mauszeiger nach unten oder nach rechts bewegen. Je weiter Sie den
Mauszeiger vom Startpunkt entfernen, um so größer wird die Auswahl. Beim ver-
schieben nach oben oder nach linke, wird die Auswahl entsprechend verkleinert.

ANMERKUNG

Wenn Sie den Zauberstab benutzen ist es sehr wichtig den richtigen Startpunkt
zu wählen. Wenn Sie dies nicht sorgfältig tun, werden Sie sehr wahrscheinlich
eine Auswahl erstellen, die nicht der entspricht, die Sie sich vorgestellt haben.

7.2.5.1. Werkzeugaufruf

Sie haben verschiedene Möglichkeiten den Zauberstab zu aktivieren:

• Über das Menü Werkzeuge → Auswahlwerkzeuge → Zauberstab im Bildfenster,

• Mit einen Mausklick auf das Symbol im Werkzeugfenster, sowie

• Über das Tastenkürzel Z.

7.2.5.2. Tastenkombinationen (Vorgabe-Einstellungen)

Der Zauberstab hat keine speziellen Tastenkombinationen. Die allgemeinen Tastenkombinationen für
Auswahlwerkzeuge stehen Ihnen aber zur Verfügung.
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Abbildung 7.11. Eigenschaften des Zauberstabes

7.2.5.3. Eigenschaften

ANMERKUNG

In diesem Abschnitt werden nur die speziellen Eigenschaften des Zauberstabes
beschrieben. Schauen Sie bitte unter Auswahlwerkzeuge nach, falls Sie Hilfe zu
den allgemeinen Eigenschaften der Auswahlwerkzeuge benötigen.

Die aktuellen Einstellungen für den Zauberstab lassen sich durch einen Doppelklick auf das Symbol

anzeigen.

Ähnliche Farben finden Diese Eigenschaften beeinflussen die Art und Weise wie der Zauberstab aus-
gehend vom Startpunkt die Auswahl erzeugt.

Transparente Bereiche auswählen Wenn Sie diese Eigenschaft aktivieren, lassen sich mit dem
Zauberstab auch transparente Bereiche auswählen. Andernfalls lassen sich transparente Be-
reiche mit dem Zauberstab nicht auswählen.

Vereinigung überprüfen Diese Eigenschaft wird wichtig, wenn das Bild mehrere Ebenen hat und
die aktiven Ebene entweder halb durchsichtig ist, oder einen anderen Modus hat als ”Nor-
mal“. In einem solchen Fall unterscheiden sich die Farben in der aktiven Eben von denen
des Gesamtbildes. Wenn die Eigenschaft Vereinigung überprüfen ausgeschaltet ist, reagiert
der Zauberstab ausschliesslich auf die Farben in der aktiven Ebene. Wenn Sie eingeschaltet
ist, werden in die Erstellung der Auswahl die Farben aller sichtbaren Ebenen einbezogen.
Weitere Informationen finden Sie unter Vereinigung überprüfen.

Schwelle Mit dem Schieberegler für die Eigenschaft Schwelle lässt sich die Empfindlichkeit des
Zauberstabes steuern. Die einstellbaren Werte reichen von 0 (minimale Farbdifferenz) bis 255
(maximale Farbdifferenz). Es ist auch möglich die Eigenschaft bei der Erstellung einer neuen
Auswahl zu verändern. Halten Sie hierzu die Maustaste nach dem Klick auf den Startpunkt
gedrückt und verschieben Sie den Mauszeiger nach oben oder unten. Der Schwellwert wird
sofort angepasst, so dass Sie das Ergebnis prüfen können. Das Einstellen des Schwellwertes
mit der Maus erfordert allerdings etwas Übung.

7.2.6. Nach Farbe auswählen

Das Werkzeug Nach Farbe auswählen ermöglicht es Ihnen eine Auswahl auf der Basis von Bereichen
eines Bildes oder der aktuellen Ebene zu erstellen, die eine ähnliche Farbe haben. Es funktioniert sehr
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Abbildung 7.12. Das Werkzeug ”Nach Farbe auswählen“ im Werkzeugfenster.

ähnlich wie der Zauberstab. Der Hauptunterschied zwischen den beiden Werkzeugen ist, dass Nach
Farbe auswählen Bereiche auswählt deren Farbe ähnlich zu der des Startpunktes ist, egal wo sich diese
im Bild befinden. Im Gegensatz dazu wählt der Zauberstab, beginnend mit dem Startpunkt, jeweils alle
Nachbarpixel aus, deren Farbe sehr ähnlich ist.

7.2.6.1. Werkzeugaufruf

Sie haben verschiedene Möglichkeiten das Werkzeug Nach Farbe auswählen zu aktivieren:

• Über das Menü Werkzeuge → Auswahlwerkzeuge → Nach Farbe auswählen im Bildfenster,

• Mit einen Mausklick auf das Symbol im Werkzeugfenster, sowie

• Über das Tastenkürzel Shift–O.

7.2.6.2. Tastenkombinationen (Vorgabe-Einstellungen)

Das Werkzeug Nach Farbe auswählen hat keine speziellen Tastenkombinationen Die allgemeinen Tas-
tenkombinationen für Auswahlwerkzeuge stehen Ihnen jedoch zur Verfügung.

7.2.6.3. Eigenschaften

Abbildung 7.13. Werkzeugeinstellungen für ”Nach Farbe auswählen“
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ANMERKUNG

In diesem Abschnitt werden nur die speziellen Eigenschaften des Werkzeuges
Nach Farbe auswählen beschrieben. Schauen Sie bitte unter Auswahlwerkzeuge
nach, falls Sie Hilfe zu den allgemeinen Eigenschaften der Auswahlwerkzeuge
benötigen.

Die Werkzeugeinstellungen für ”Nach Farbe auswählen“ lassen sich durch ein Doppelklick auf das

Symbol anzeigen.

Ähnliche Farben finden Diese Eigenschaften beeinflussen die Art und Weise wie der ”Nach Farbe
auswählen“ ausgehend vom Startpunkt die Auswahl erzeugt.

• Transparente Bereiche auswählen. Wenn Sie diese Eigenschaft aktivieren, lassen sich mit
dem Werkzeug auch transparente Bereiche auswählen. Andernfalls lassen sich transparente
Bereiche mit dem nicht auswählen.

• Vereinigung überprüfen. Diese Eigenschaft wird wichtig, wenn das Bild mehrere Ebenen
hat und die aktiven Ebene entweder halb durchsichtig ist, oder einen anderen Modus hat als

”Normal“. In einem solchen Fall unterscheiden sich die Farben in der aktiven Eben von denen
des Gesamtbildes. Wenn die Eigenschaft Vereinigung überprüfen ausgeschaltet ist, reagiert
das Werkzeug ausschliesslich auf die Farben in der aktiven Ebene. Wenn Sie eingeschaltet
ist, werden in die Erstellung der Auswahl die Farben aller sichtbaren Ebenen einbezogen.
Weitere Informationen finden Sie unter Vereinigung überprüfen.

• Schwelle. Mit dem Schieberegler für die Eigenschaft Schwelle lässt sich die Empfindlichkeit
des Werkzeuges steuern. Die einstellbaren Werte reichen von 0 (minimale Farbdifferenz) bis
255 (maximale Farbdifferenz).

7.2.7. Intelligente Schere (Magnetische Auswahl)

Abbildung 7.14. Die Intelligente Schere im Werkzeugfenster.

Das Werkzeug ”Intelligente Schere“ ist ein sehr interessantes Element der GIMP Werkzeugkiste. Ei-
nige seiner Eigenschaften hat es mit dem Lassowerkzeug gemein, einige mit dem Pfadwerkzeug und
die restlichen machen es einzigartig. Die Intelligente Schere ist sehr nützlich, wenn Sie eine Auswahl
aus enem Bildbereich erstellen wollen, der farblich deutlich abgegrenzt ist. Um die Intelligente Schere
zu verwenden, erzeugen Sie mit einzelnen Mausklicks Kontrollpunkte um die auszuwählende Region
herum. Das Werkzeug erstellt aus diesen eine Kurve, welche die Kontrollpunkte verbindet und an der
Farbkante entlangführt. Mit ein bisschen Glück stimmt diese Kurve mit der Kontur überein, die Sie
auswählen wollten.

Jedesmal wenn Sie mit der Maus klicken, erzeugt die Intelligente Schere einen neuen Kontrollpunkt.
Dieser wird automatisch mit dem vorherigen Kontrollpunkt verbunden. Um die Auswahl abzuschlies-
sen, klicken Sie auf den allerersten Kontrollpunkt. Beobachten Sie den Mauszeiger, er ändert seine Form,
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wenn er sich über dem entsprechenden Kontrollpunkt befindet. Sie können die Kurve korrigieren, in-
dem Sie die Kontrollpunkte verschieben und neue Kontrollpunkte durch Mausklicks einfügen. Sobald
Sie mit dem Ergebnis zufrieden sind, klicken Sie mit der Maus in die umrandete Region hinein, um die
Kurve in eine Auswahl umzuwandeln.

WARNUNG

Achten Sie darauf nicht in die durch die Kurve umrandete Region hineinzukli-
cken, bevor Sie alle Kontrollpunkte erzeugt und korrigiert haben. Wenn die Kur-
ve ersteinmal in eine Auswahl umgewandelt ist, können Sie die Kurve nicht mehr
korrigieren und müssten von vorn beginnen. Ausserdem sollten Sie darauf ach-
ten, dass Sie während der Erstellung einer Kurve mit der Intelligenten Schere
nicht das Werkzeug wechseln, denn auch dabei wird die Kurve in eine Auswahl
umgewandelt und Sie verlieren alle Kontrollpunkte.

Unglücklicherweise scheint es einige Problem mit der Logik zu geben, die benutzt wird, um die Farb-
kanten zu bestimmen, an denen die Kurve entlanggeführt wird. Das Ergebnis ist gelegentlich eine Aus-
wahl, die sehr unsauber an der gewünschten Kante entlangführt. Ein guter Weg dies dann zu korrigie-
ren ist in den Modus Schnelle Maske zu wechseln und mit Hilfe der Malwerkzeuge die problematischen
Stellen auszubessern. Alles in Allem sollte man bei Problemen mit der Intelligenten Schere einen Blick
auf das Pfadwerkzeug werfen. Dieses ist zwar nicht in der Lage die Kurve automatisch an Farbkanten
entlangzuführen, dafür bleiben aber die Kontrollpunkte der Kurve erhalten und können beliebig lange
korrigiert werden.

7.2.7.1. Werkzeugaufruf

Sie haben verschiedene Möglichkeiten das Werkzeug ”Intelligente Schere“ zu aktivieren:

• Über das Menü Werkzeuge → Auswahlwerkzeuge → Intelligente Schere im Bildfenster,

• Mit einen Mausklick auf das Symbol im Werkzeugfenster, sowie

• Über das Tastenkürzel I.

7.2.7.2. Tastenkombinationen (Vorgabe-Einstellungen)

Das Werkzeug ”Intelligente Schere“ hat keine speziellen Tastenkombinationen. Die allgemeinen Tasten-
kombinationen für Auswahlwerkzeuge stehen Ihnen jedoch zur Verfügung.

7.2.7.3. Eigenschaften

Abbildung 7.15. Die Werkzeugeinstellungen der Intelligenten Schere.
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ANMERKUNG

In diesem Abschnitt werden nur die speziellen Eigenschaften der Intelligenten
Schere beschrieben. Schauen Sie bitte unter Auswahlwerkzeuge nach, falls Sie
Hilfe zu den allgemeinen Eigenschaften der Auswahlwerkzeuge benötigen.

Die Werkzeugeinstellungen für die Intelligente Schere lassen sich durch ein Doppelklick auf das Sym-

bol anzeigen.

Interaktive Begrenzung anzeigen Wenn diese Eigenschaft aktiviert ist, wird bei der Erstellung ei-
nes Kontrollpunktes bereits die Kurve zum vorherigen Kontrollpunkt an der Farbkante entlang-
geführt. Ist die Eigenschaft ausgeschaltet wird hingegen die Verbindung zum vorherigen Kontroll-
punkt durch eine gerade Linie symbolisiert. Wenn Ihr Computer nicht zu den leistungsstärksten
gehört oder die Kontrollpunkte sehr weit auseinander liegen kann dies die Arbeitsgeschwindig-
keit erhöhen.

7.3. Malwerkzeuge

7.3.1. Allgemeine Eigenschaften

Abbildung 7.16. Eine Übersicht aller Malwerkzeuge von GIMP

Im unteren Bereich des Werkzeugfensters finden Sie die neun Malwerkzeuge, die GIMP Ihnen zur
Verfügung stellt. Malwerkzeuge sind Werkzeuge, die wenn sie bei gedrückter Maustaste den Mauszei-
ger in einem Bild bewegen, Pinselstriche hinterlassen. Vier der Malwerkzeuge - Stift, Pinsel, Sprühpistole
(Airbrush) und Tinte – verhalten sich ähnlichen wie ihren realen Vorbilder: Sie können sie benutzen, um
zu zeichnen. Die restlichen benutzen einen Pinsel für etwas andere Arbeiten: der Radierer entfernt Bild-
teile, das Klonen Werkzeug kopiert Muster, das Verknüpfen Werkzeug dient zum Weichzeichnen oder
Schärfen, das Verschmieren Werkzeug ermöglicht ein gezieltes verschmieren in Bildern und das Abwe-
deln/Nachbelichten Werkzeug tut genau was sein Name schon andeutet, nämlich einzelne Stellen im
Bild gezielt abdunkeln oder aufhellen.

Wenn Sie GIMP mit einem Grafiktablett anstelle der Maus bedienen, wird die Arbeit mit den Mal-
werkzeugen noch realistischer. Das Zeichnen wird viel intuitiver und sensibler als mit der Maus. Zusätzlich
verfügen die Malwerkzeuge über spezielle Eigenschaften zur Einstellung der Druckempfindlichkeit,
welche aber nur zusammen mit einem Grafiktablett eingesetzt werden können.

Zusätzlich zu der sehr gebräuchlichen Arbeitsweise von Hand, können die Malwerkzeuge auch au-
tomatisch angewendet werden, indem Sie einen Pfad erstellen und diesen dann anstreichen. Sie können
jedes der Malwerkzeuge, inklusive Radierer, Weichzeichner etc. benutzen, um GIMP anstreichen zu
lassen. Lesen Sie im Kapitel Anstreichen, um mehr über diese Funktion zu erfahren.
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Mit den Malwerkzeugen können Sie nicht nur auf Bildebenen, sondern auch auf Ebenenmasken,
Kanälen und Auswahlen arbeiten. Um ein Malwerkzeug auf eine Ebenenmaske oder einen Kanal an-
zuwenden aktivieren Sie die entsprechende Zeichenfläche einfach im Ebenen- oder Kanaldialog. Um
mit einem Malwerkzeug eine Auswahl zu bearbeiten, wechseln Sie in den Modus Schnelle Maske. Eine
Auswahl zu malen ist eine einfache und sehr mächtige Möglichkeit schnell sehr genaue Auswahlen zu
erstellen.

7.3.1.1. Tastenkombinationen (Vorgabe-Einstellungen)

• Durch gedrückt halten der Strg Taste, rufen Sie bei den meisten Malwerkzeugen die Pipette auf.
Eine Ausnahme stellt lediglich das Füllhalterwerkzeug dar. Der Farbauswahlmodus (die Pipette)
bewirkt, dass beim klicken auf einen Pixel dessen Farbe automatisch von GIMP als Vordergrund-
farbe aufgenommen wird (für den Radierer wird die Hintergrundfarbe gesetzt). Beim Werkzeug
Klonen dient die Strg Taste zum aufnehmen eines Referenzpunktes. Wenn Sie das Verknüpfen
Werkzeug aktiviert haben, schaltet die Strg Taste zwischen den Modi Weichzeichnen und Schärfen
um. Ensprechend wird beim Werkzeubg Abwedeln/Nahcbelichten eben zwischen abwedeln und
nachbelichten gewechselt.

• Shift: Diese Taste wirkt bei allen Malwerkzeugen gleich. Sie schaltet das Werkzeug in den Modus

”Linien zeichnen“. Um eine gerade Linie mit einem der Malwerkzeuge zu zeichnen, klicken Sie
den Startpunkt an und drücken dannach die Shift. Solange Sie die Shift Taste gedrückt halten,
wird Ihnen GIMP eine dünne Hilfslinie zwischen dem Startpunkt und der aktuellen Position des
Mauszeigers anzeigen. Sobald Sie erneut klicke, wird die gerade Linie eingezeichnet. Sie können
die Shift gedrückt halten und weitere Punkte anklicken, um auf diese Weise eine Reihe verbun-
dener, gerader Liniensegmente zu zeichnen.

• Strg–Shift: Durch gedrückt halten von beiden Tasten wird das Malwerkzeug in den Modus ”Be-
schränkte gerade Linie“ geschaltet. Dieser Modus ist ähnlich dem wenn Sie nur die Shift gedrückt
halten. Zusätzlich wird GIMP jedoch dafür Sorgen, dass die Orientierung der Linie einem vielfa-
chen von 15 Grad entspricht. Dies ist sehr hilfreich, wenn Sie exakt waagerechte oder senkrechte
Linien zeichnen möchten.

7.3.1.2. Eigenschaften

Abbildung 7.17. Allgemeine Werkzeugeigenschaften der Malwerkzeuge

Viele Eigenschaften sind in mehreren Malwerkzeugen vorhanden. Diese allgemeinen Werkzeugei-
genschaften werden hier beschrieben. Eigenschaften die nur für ein spezielles Werkzeug verfügbar sind,
werden in dem Kaptitel beschrieben, in welchem das Werkzeug detailliert vorgestellt wird.

Deckkraft Diese Eigenschaft legt fest, mit welcher Deckkraft ein Werkzeug auf dem Bild angewendet
wird. Bei den ”echten“ Malwerkzeugen, wie Pinsel oder Stift legt die Deckkraft fest wieviel Farbe
aufgetragen wird. Bei anderen Malwerkzeugen wie Radierer oder Weichzeichnen/Schärfen be-
stimmt die Deckkraft wie stark das Werkzeug auf das Bild einwirkt. Mittels eines Schiebereglers
lassen sich Werte zwischen 0 (keine Deckkraft) und 100 (volle Deckkraft) einstellen.
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Modus Durch die Einstellung des Modus bestimmen Sie, wie das Werkzeug auf den behandelten Bild-
bereich wirkt. Wenn Sie sich die Liste der verfügbaren Modi anschauen wird Ihnen sicher der Eine
oder Andere davon aus dem Ebenendialog bekanntvorkommen. In der Tat sind die Modi nicht nur
vom Namen, sondern auch von der Wirkungsweise her identisch. Weitere Informationen über die
Modi, welche GIMP zur Verfügung stellt, können Sie im Glossar nachlesen. Die Eigenschaft ”Mo-
dus“ ist nur für diejenigen Malwerkzeuge verfügbar die (virtuell) Farbe auf das Bild auftragen,
also Stift, Pinsel, Sprüpistole, Tinte und das Klonewerkzeug. Bei den anderen ist die Modusaus-
wahl ausgegraut und kann nicht verändert werden.

Pinsel Pinsel bezeichnet in GIMP nicht nur ein Malwerkzeug, sondern auch eine allgemeine Eigen-
schaft aller Malwerkzeuge. Diese Eigenschaft legt fest, wie die Werkzeugspitze beschaffen ist, die
auf das Bild einwirkt. GIMP erlaubt verschiedene Typen von Pinseln, eine detaillierte Beschrei-
bung dazu findet sich im Kapitel Pinsel. Es steht für alle Malwerkzeuge dieselbe Auswahl an
Pinseln zur Verfügung, einzige Ausnahme ist das Werkzeug ”Tinte“, welches eigene Typen von
Pinseln mitbringt. Die Farbe des Pinsels ist nur für die Werkzeuge Stift, Pinsel und Sprühpistole
interessant, für die anderen Werkzeuge ist lediglich die Intensitätsverteilung der Pinsel von Be-
deutung.

Druckempfindlichkeit Die Druckempfindlichkeit eines Malwerkzeuges spielt nur dann eine Rolle, wenn
Sie ein Zeichentablett benutzen. Sie erlaubt es dann einzustellen, welche Eigenschaft des Werkzeu-
ges durch die Druckstärke des Stiftes auf dem Tablett beeinflusst werden soll. Die Auswahlmöglichkeiten
hierfür sind Deckkraft, Härte, Rate, Größe und Farbe. Diese lassen sich auch beliebig kombinie-
ren.

Deckkraft Diese Eigenschaft wurde im vorigen Abschnitt beschrieben.

Härte Diese Eigenschaft betrifft Pinsel mit weichen Kanten. Wenn sie eingeschaltet ist, werden die
Kanten um so härter gemalt, je stärker Sie aufdrücken.

Rate Diese Eigenschaft betrifft die Sprühpistole sowie die Werkzeuge ”Verknüpfen“ und ”Ver-
schmieren“. Sie bewirkt einen zeitbezogenen Effekt. Je härter Sie aufdrücken, umso schneller
handelt das Werkzeug.

Größe Diese Eigenschaften wirkt bei allen druckempfindlichen Werkzeugen. aber nur dann wenn
Sie einen parameterbasierten Pinsel (das sind die Pinsel, die mit dem Pinseleditor erstellt
werden) benutzen. Wenn diese Eigenschaft eingeschaltet ist, und der Pinsel parameterbasiert
ist, wird sich die Größe des Pinsels erhöhen, sobald Sie stärker mit dem Stift aufdrücken.

Farbe Diese Eigenschft betrifft nur die echten Malwerkzeuge, also Stift, Pinsel sowie Sprühpistole
und auch dann nur, wenn Sie Farben aus einem Verlauf verwenden. Sind die Bedingungen
erfüllt, bewirkt ein stärkerer Druch mit dem Stift, dass die Farben von weiter oben aus dem
Verlauf verwendet werden.

Verblassen Die Eigenschaft Verblassen bietet die Möglichkeit, den Pinselstrich nach der vorgegebe-
nen Länge ausblenden zu lassen. Das lässt sich am einfachsten an den echten Malwerkzeugen
erkennen, funktioniert aber in der Tat für alle Malwerkzeuge. Die Eigenschaft wirkt wie eine ver-
ringerung der Deckkraft entlang des gemalten Striches. Bitte beachten Sie, dass diese Eigenschaft,
wenn Sie ein Zeichentablett verwenden, die Effekte die unter Druckempfindlichkeit eingestellt
sind nicht beeinflussen.
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Steigernd Die Eigenschaft Steigernd bewirkt, wenn sie eingeschaltet ist, dass die Deckkraft mit je-
dem Pinselstrich über die selbe Stelle des Bildes gesteigert wird. Dabei kann aber auch bei viel-
fachem Überstreichen der selben Stelle die Deckkraft nicht den in der entsprechenden Werkzeu-
geigenschaft eingestellten Wert überschreiten. Ist die Eigenschaft Steigernd nicht aktiviert, hat
bereits der erste Pinselstrich die maximale Deckkraft. Diese Eigenschaft ist für alle Malwerkzeuge
verfügbar, die nicht über die Eigenschaft Rate verfügen. Die Einstellungen für Rate erzeugen au-
tomatisch einen Steigerungseffekt. Weitere Informationen finden Sie im Glossar unter dem Punkt
Schrittweiser Zeichenmodus.

Harte Kanten Durch aktivieren des Harte Kanten Modus, werden die Kanten des Pinsels nicht mehr
geglättet (antialiased). Sie zeichnen dann mit einem reinen Schwarz/Weiss Pinsel. Dies hat zur
Folge, dass der Pinselstrich an den Kanten sehr rauh wirkt. Das kann sehr hilfreich sein, wenn
Sie zum Beispiel mit einer sehr hohen Vergrößerung arbeiten und exakte Kontrolle über jeden
einzelnen Pixel benötigen.

Harte Kanten ist für alle Malwerkzeuge, ausser Stift, Pinsel und Sprühpistole verfügbar. Bei den
letztgenannten wäre die Eigenschaft redundant, da ein Pinsel oder eine Sprühpistole mit harten
Kanten exakt wie ein Stift arbeiten würde.

7.3.1.3. Weitere Informationen

Erfahrende GIMP Anwender wird es möglicherweise interessieren zu erfahren, dass alle Malwerkzeuge
auf Subpixelebene arbeiten. Auf diese Weise wird verhindert, dass die Kanten der gezeichneten Striche
allzu zackig aussehen. Eine Konsequenz aus diesem Vorgehen ist, dass selbst Sie mit einem Pinsel mit
harter Kante arbeiten, die Pixel am Rand eines gezeichneten Striches nicht vollständig gefärbt werden.
Wenn Sie einen solchen ”Alles oder Nichts“ Effekt benötigen, weil Sie beispielsweise pixelgenau arbei-
ten müssen oder eine sehr exakte Auswahl benötigen, haben Sie zwei Möglichkeiten: (1) Sie können
zum Zeichnen den Stift benutzen, dieser sorgt bei allen Pinseln für absolut harte Kanten und schaltet
das Subpixel Antialiasing ab, oder (2) Sie aktivieren für die anderen Malwerkzeuge die Werkzeugeigen-
schaft ”Harte Kanten“.

7.3.2. Füllen (Fülleimer)

Abbildung 7.18. Das Dialogfenster des Werkzeuges”Füllen“

Das Werkzeug ”Füllen“ oder Fülleimer wird benutzt, um Bildbereiche mit der Vordergrundfarbe zu
füllen. Wenn Sie bei der Anwendung des Werkzeuges die Taste Shift gedrückt halten, wird zum Füllen
die aktuelle Hintergrundfarbe verwendet. Für die Füllart stehen Vorder-, und Hintergrundfarbe, so-
wie Muster zur Auswahl. Gerade beim Füllen von grösseren Bildbereichen, kann es sehr hilfreich sein,
ähnliche Farben mit zu füllen. Das Werkzeug kann darüberhinaus auch die Transparenz von Bildteilen
beeinflussen.

Die Grösse der gefüllten Bildteile hängt wesentlich vom eingestellten Schwellwert ab. Mit diesem
können Sie beeinflussen, wie weit sich die eingefüllte Farbe verteilt. Dies funktioniert ähnlich wie beim
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Werkzeug Zauberstab. Das Füllen beginnt an dem Pixel auf den Sie das Werkzeug durch Klicken an-
wenden und breitet sich von dort aus, bis die Bildfarbe oder der Wert des Alphakanals ”zu verschieden“
werden.

Wenn Sie Objekte auf einer transparenten Ebene (Beispielsweise Buchstaben auf einer Textebene) mit
einer neuen Farbe füllen, kann es passieren, dass die alte Farbe immernoch am Rand des Objektes er-
scheint. Die Ursache dafür ist ein niedriger Schwellwert des Werkzeuges. Mit einem geringen Schwell-
wert füllt das Werkzeug halbtransparente Pixel nicht und diese behalten daher ihre alte Farbe. Wenn
Sie Bereiche füllen wollen, welche komplett transparent sind, wählen Sie den Menüeintrag Auswahl
→ Alles und stellen Sie sicher, dass die Eigenschaft Transparenz erhalten (zu finden im Ebenendia-
log) angeschaltet ist. Ist diese Eigenschaft ausgeschaltet, werden nur die nichttransparenten Bereiche
der Ebene gefüllt, und wenn Sie vergessen den Befehl ”Alles auswählen“ auszuführen, wird nur die
bedeckte ”Insel“ auf die Sie geklickt haben, gefüllt.

7.3.2.1. Werkzeugaufruf

Sie haben verschiedene Möglichkeiten das Werkzeug ”Füllen“ zu aktivieren:

• Über das Menü Werkzeuge → Malwerkzeuge → Füllen im Bildfenster,

• Mit einen Mausklick auf das Symbol im Werkzeugfenster, sowie

• Über das Tastenkürzel Shift–B.

7.3.2.2. Tastenkombinationen (Vorgabe-Einstellungen)

Tastenkürzel Die Tastenkombination Shift–B aktiviert das Werkzeug ”Füllen“.

Strg Mit der Strg Taste lässt sich leicht zwischen der Vordergrund- oder Hintergrundfarbe, als Füllart
wechseln.

Shift Schaltet die Eigenschaft ”Beeinflusster Bereich“ zwischen Ähnliche Farben und Ganze Auswahl
füllen um.

7.3.2.3. Eigenschaften

Abbildung 7.19. Eigenschaften für das Werkzeug ”Füllen“
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Übersicht Die Werkzeugeinstellungen für das Werkzeug lassen sich durch einen Doppelklick auf das

Symbol anzeigen.

Deckkraft Mit dem Schieberegler können Sie die Deckkraft des Werkzeuges einstellen. Der Regler kann
Werte zwischen 100 (voller) und 0 (keiner) Deckkraft annehmen.

Modus Die verfügbaren Modi verändern die Art und Weise, wie die Pixel auf die Ebene gezeichnet
werden. Ähnlich den Modi der Ebenen, repräsentieren die Füllmodi eine Überblendung mit der
ausgewählten Füllfarbe (-muster) und der zu füllenden Ebene. Mehr über die Modi, die GIMP zur
Verfügung stellt, finden Sie im Glossar.

Füllart GIMP stellt drei verschiedene Füllarten zur Verfügung: Füllen mit der Vordergrundfarbe (VG),
Hintergrundfarbe (HG) und einem Muster.

Bei aktivierter Einstellung VG-Farbe, wird die nächste Füllung mit der aktuellen Vordergrundfar-
be ausgeführt.

Ähnlich verhalten sich die zwei weiteren Einstellungen. So lässt sich bei aktivierter Einstellung
HG-Farbe mit der Hintergrundfarbe und bei aktivem Muster, mit dem ausgewählten Muster
füllen.

Beeinflusster Bereich

Ähnliche Farben füllen Das Füllwerkzeug kann nicht nur eine Farbe ersetzen (füllen), sondern
auch Farben die sich nur wenig in der Helligkeit unterscheiden und somit ähnlich sind. Die
Ähnlichkeit der Farben lässt sich mit dem Schwellwert einstellen.

Ganze Auswahl füllen Füllt eine bestehende Auswahl oder das ganze Bild.

Ähnliche Farben finden Unter Ähnliche Farben finden sind drei Einstellungen untergebracht: Trans-
parente Bereiche füllen, Vereinigung abtasten und der Schwellwert.

Transparente Bereiche füllen Diese Einstellung bietet die Möglichkeit auch transparente Berei-
che, die keine oder nur eine geringe Deckkraft besitzen zu füllen.

Vereinigung abtasten Durch diese Einstellung ist es möglich, den Auswahlbereich zu beeinflus-
sen, den das Füllwerkzeug selektiert. Wenn dieses Kontrollkästchen aktiviert ist, wird die
Auswahl von allen sichtbaren Ebenen beeinflusst. Weitere Informationen zu Vereinigung ab-
tasten bietet das Glossar.

Schwelle Der Schieberegler Schwelle bietet Ihnen die Möglichkeit, den Schwellwert einzustellen.
Es werden bei niedrigem Schwellwert (0) keine ähnlichen Farben mit in die Füllung einbe-
zogen. Je höher der Schwellwert, desto mehr umliegende Farben werden mit in die Füllung
einbezogen. Bei ausgewähltem Maximalwert von 255, wird die gesamte Ebene gefüllt.

7.3.3. Farbverlauf

Das Werkzeug ”Farbverlauf“ ermöglicht es Ihnen, einen Bereich des Bildes mit einem Farbverlauf zu
füllen. Der Farbverlauf beginnt im Standardfall mit der Vordergrundfarbe und endet mit der Hinter-
grundfarbe. Um den Verlauf aufzutragen, ziehen Sie bei gedrückter Maustaste einen Strich in die Rich-
tung, in die der Verlauf aufgetragen werden soll. Die Weichheit des Überganges hängt von der Länge
des von Ihnen gezogenen Striches ab. Je länger der Strich, desto weicher der Verlauf.
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Abbildung 7.20. Das Werkzeug ”Farbverlauf“ im Werkzeugfenster

Es gibt eine erstaunliche Anzahl von Dingen, die Sie mit dem Werkzeug tun können. Die zwei wich-
tigsten Eigenschaften sind der Farbverlauf und die Form. Durch Klicken auf die Schaltfläche Farbver-
lauf öffnet sich ein Klappmenü, aus dem Sie aus einem grossen Angebot von Verläufen auswählen
können, welche mit GIMP mitgeliefert werden. Darüber hinaus können sie auch eigene Verläufe desi-
gnen und abspeichern.

Für die Eigenschaft Form stehen 11 Einstellungen zur Auswahl: Linear; Bi-Linear; Kreisförmig; Qua-
dratisch; Konisch (symmetrisch, asymetrisch); Formangepasst (winkelig, sphärisch, dimpled) sowie Spi-
rale (links- und rechtsdrehend). ”Formangepasst“ ist von diesen die interessanteste. Sie bewirkt, dass
der Verlauf den Grenzen der aktuellen Auswahl folgt, egal wie kompliziert diese auch sein mögen. Im
Gegensatz zu den anderen Forment spielte bei der Einstellung ”Formangepasst“ die Länge oder Rich-
tung der bei der Anwendung des Werkzeuges gezogenen Linie keine Rolle.

TIPP

Probieren sie die verschiedenen Einstellungen des Klappmenüs Modus aus,
selbst wenn Sie den gleichen Verlauf in der gleichen Form anwenden, führt ein
verschiedener Modus zu sehr interessanten Ergebnissen.

7.3.3.1. Werkzeugaufruf

Sie haben verschiedene Möglichkeiten das Werkzeug ”Farbverlauf“ zu aktivieren:

• Über das Menü Werkzeuge → Malwerkzeuge → Farbverlauf im Bildfenster,

• Mit einen Mausklick auf das Symbol im Werkzeugfenster, sowie

• Über das Tastenkürzel L.

7.3.3.2. Tastenkombinationen (Vorgabe-Einstellungen)

Tastenkürzel Die Tasten L aktiviert das Werkzeug ”Farbverlauf“.

Strg Mit der Taste Strg wird das Rotieren um den Anfangspunkt des Farbverlaufes auf 15 Grad Schritte
beschränkt.
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Abbildung 7.21. Eigenschaften für das Werkzeug ”Farbverlauf“

7.3.3.3. Eigenschaften

Übersicht Die Eigenschaften des Werkzeuges lassen sich durch einen Doppelklick auf das Symbol
anzeigen.

Deckkraft Mit dem Schieberregler lässt sich die Deckkraft des Farbverlaufes einstellen. So kann der
Schieber zwischen 100 (volle) und 0 (keine) eingestellt werden. Der voreingestellte Standardwert
ist 100.

Modus Die verfügbaren Modi verändern die Art und Weise, wie die Pixel auf die Ebene gezeichnet wer-
den. Ähnlich den Ebenenmodi, bestimmen die Füllmodi wie eine Überblendung mit ausgewählten
Füllfarbe bzw. des Musters und der zu füllenden Ebene geschieht. Ausführliche Informationen
und Beispiele zu den Modi, die GIMP zur Verfügung stellt, finden Sie im Glossar.

Farbverlauf Durch Klicken auf den aktuellen Farbverlauf öffnet sich der Farbverlaufsbrowser. Über
diesen können Sie sich zwischen eigens erstellten Farbverläufen und den Standardfarbverläufen
entscheiden. Mit der Einstellung Umkehren können Sie die Richtung des Verlaufes verändern. Im
Standard voreingestellt ist ein linearer Farbverlauf zwischen Vorder- und Hintergrundfarbe.

Versatz Durch den für die Eigenschaft Versatz eingestellten Wert, lässt sich die Grösse des Überganges
zwischen den Farben festlegen. Standardmässig ist der Versatz auf 0 eingestellt, welches einen sehr
weichen Übergang zwischen den Farben ergiebt. Bei einem hohem Versatzwert wird der gesamte
Farbverlauf auf zwei Farben beschränkt.

Form Diese Eigenschaft legt fest, welche Form der aufzutragende Verlauf haben wird. GIMP bietet die
Möglichkeit zwischen 11 verschiedenen Farbverlaufsformen auszuwählen. Die einzelnen Formen
werden im Folgenden detailliert vorgestellt.

Linear
Der lineare Farbverlauf zeichnet den Übergang zwischen den Farben ohne Transformation.
So entsteht ein linearer oder gerader Übergang zwischen den ausgewählten Farben.
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Bi-Linear
Bei dem Bi-Linearen Farbverlauf, wird der Verlauf vom Startpunkt aus in beiden Richtungen
aufgetragen. Somit entsteht ein gespiegelter Eindruck von der Mitte des Verlaufs.

Kreisförmig
Die radiale Form zeichnet den Farbübergang kreisförmig, also mit einem Zentrum in Vorder-
grundfarbe und einem äusseren Kreis in Hintergrundfarbe. Es entsteht der plastische Ein-
druck, einer runden Oberfläche.

Quadratisch
Diese vier Formen sind Varianten auf einem Quadrat: Quadratisch, Formangepasst (win-
kelig), Formangepasst (sphärisch), und Formangepasst (dimpled). Bei allen befindet sich
im Zentrum des Quadrates ein Bereich mit Vordergrundfarbe. Dies ist der Punkt, an dem die
Linie zum Auftragen des Verlaufes startete.

Konisch (symmetrisch)
Wie der Name es schon verrät, zeichnet sich dieser Farbverlauf durch seine konische Form
aus. Hier werden alle vorgegebenen Farbbereiche standardmässig, weich überblendet.

Konisch (asymmetrisch)
Im Vergleich zum symmetrisch, konischen Farbverlauf, wird bei der asymmetrischen Varian-
te nicht das Ende des Farbverlaufes mit dem Anfang weiche überblendet.

Spirale
Diese Form zeichnet den ausgewählten Farbverlauf als Spirale. Das linke Bild zeigt die Spi-
rale (rechtsdrehend) und das rechte Bild zeigt Spirale (linksdrehend).

Wiederholung Für die Formmodi Linear, Bi-Linear, Kreisförmig und Quadratisch stehen verschie-
dene Wiederholungsarten des Verlaufes zur Verfügung. Sie können wählen zwischen: Sägezahn
Welle und Dreieckswelle. Die Sägezahnwelle beginnt mit der Vordergrundfarbe, verändert sich
bis zur Hintergrundfarbe und beginnt dann erneut mit der Vordergrundfarbe. Demgegenüber
startet die Dreieckswelle mit der Vordergrundfarbe, verändert sich in die Hintergrundfarbe und
verändert sich dann wieder in die Vordergrundfarbe. Es gibt daher keinen ”Sprung“ im Farbver-
lauf.

Dithering Für die Farbverläufe steht eine Ditheringmethode zur Verfügung. Mehr über das Dithering
Verfahren im Glossar.

Anpassende Hochrechnung An scharfen Farbübergängen wird ein Antialiasing durchgeführt. Je grösser
die Maximale Tiefe ist (max. 10), desto mehr Rechenzeit wird benötigt, um die umliegendenden
Farbwerte zu berechnen.
Kaum Auswirkung hat die Anpassende Hochrechnung auf sehr bunten Farbverläufen mit ent-
sprechend vielen Farben, da hier meist schon ein weicher Übergang zwischen den Farben besteht.
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7.3.4. Farbauftragende Malwerkzeuge (Stift Pinsel, Airbrush)

Abbildung 7.22. Beispiele für Pinselstriche. Die drei Striche wurden mit der gleichen weichen Pinsel-
form, aber mit unterschiedlichen Werkzeugen gezeichnet. Von links nach rechts kamen zum Einsatz:
Stift, Pinsel und die Sprühpistole (Airbrush).

Die Werkzeuge in dieser Gruppe sind die ”einfachen“ Malwerkzeuge in GIMP und diese haben eine
ganze Menge gemeinsamer Eigenschaften, die in diesem Kapitel erläutert werden. Die Funktionen und
Eigenschaften, die alle Malwerkzeuge gemeinsam haben, sind im Kapitel Allgemeine Eigenschaften
beschrieben. Die werkzeugspezifischen Merkmale wiederum, werden in den Kapiteln erläutert, die den
einzelnen Werkzeugen gewidmet sind.

Der Stift ist das ”roheste“ Werkzeug in dieser Gruppe. Er erzeugt einfach harte, ungeglättete Striche.
Der Pinsel ist in der Mitte. Er ist wahrscheinlich das am häufigsten benutzte Werkzeug der Gruppe.
Die Sprühpistole (Airbrush) ist das flexibelste und kontrollierbarste Werkzeug. Es ist das Einzige, bei
dem die Menge der aufgetragenen (virtuellen) Farbe von der Geschwindigkeit abhängt, mit der Sie
zeichnen. Allerdings ist es eben durch diese grosse Anzahl an Möglichkeiten ein bisschen komplizierter
in der Benutzung.

7.3.4.1. Tastenkombinationen (Vorgabe-Einstellungen)

Strg Mit der Strg Taste wird die Pipette aufgerufen. Wenn Sie die Taste gedrückt halten und klicken,
wird die Farbe des angeklickten Pixels zur aktuellen Vordergrundfarbe, mit der Sie dann weiter-
malen können.

7.3.4.2. Eigenschaften

Modus Durch die Einstellung des Modus bestimmen Sie, wie das Werkzeug auf den behandelten Bild-
bereich wirkt. Wenn Sie sich die Liste der verfügbaren Modi anschauen wird Ihnen sicher der Eine
oder Andere davon aus dem Ebenendialog bekanntvorkommen. In der Tat sind die Modi nicht
nur vom Namen, sondern auch von der Wirkungsweise her identisch. Weitere Informationen über
die Modi, welche GIMP zur Verfügung stellt, können Sie im Glossar nachlesen. Zusätzlich zu den
Standardmodi verfügen die Malwerkzeuge über drei zusätzliche:

Vernichtend. Dieser Modus entfernt die Vordergrundfarbe und ersetzt sie durch eine teilweise
Transparenz. Der Modus verhält sich ähnlich wie das Filter Farbe zu Transparenz, nur eben auf
den Bildbereich unter dem gezeichneten Strich beschränkt. Bitte beachten Sie, dass der Modus nur
auf Ebenen mit Alphakanal arbeiten kann. Andernfalls ist der Modus identisch mit dem Modus

”Normal“.

Hinter. Dieser Modus trägt Farbe nur in den transparenten Teilen einer Ebene auf. Je geringer die
Deckkraft der Ebene, um so mehr Farbe wird aufgetragen. Daher hat zeichnen auf undurchsich-
tigen Bildteilen keine sichtbaren Auswirkungen, während das Zeichnen auf (teil-) transparenten
Flächen die gleiche Wirkung hat, wie ein Zeichnen im Modus ”Normal“. Natürlich funktioniert
das Beschriebene nur dann sinnvoll, wenn es für die Ebene einen Alphakanal gibt.

Farbe entfernen. Dies ist ein sehr nützlicher Modus - für unscharfe Pinsel bestimmt die Graustufe
nicht die Farbdichte, sondern die Wahrscheinlichkeit mit der überhaupt Farbe aufgetragen wrid.
Dies ergibt einen interessanten Weg sehr rauh und unfertig wirkende Pinselstriche zu zeichnen.
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Abbildung 7.23. Beispiele für das Überblenden. Zwei Pinselstriche, beide gezeichnet mit der
Sprühpistole und dem gleichen unscharfen, runden Pinsel. Einmal im Modus ”Normal“ (links) und
einmal im Modus ”Farbe entfernen“ (rechts).

Abbildung 7.24. Farbverlaufseinstellungen der Malwerkzeuge.

Farbverlauf

Bei aktiviertem Kontrollkästchen Farbverlauf, wird nicht die Vordergrundfarbe zum Zeichnen
verwendet, sondern der ausgewählte Farbverlauf. Für einführende Informationen lesen Sie das
Kapitel über das GIMP Konzept der Farbverläufe.

Sie haben verschiedene Möglichkeiten einzustellen welche Farben für den Farbverlauf verwendet
werden und wie diese angeordnet sind:

Farbverlauf. Hier wird der aktuelle Farbverlauf dargestellt. Wenn Sie auf den Verlauf klicken,
erscheint ein Klappmenü aus welchem Sie einen beliebigen anderen Verlauf auswählen können.

Umkehren. Normalerweise beginnt eine Pinselstrich mit der Farbe am linken Ende des Farbver-
laufs und ändert sich dann dem Farbverlauf nach rechts folgend. Wenn die Eigenschaft ”Umkeh-
ren“ aktiv ist, beginnt jeder Pinselstrich am rechten Ende des Farbverlaufs und entwickelt sich
nach links.

Länge. Mit dieser Eigenschaft können Sie einstellen, nach welcher Länge des Pinselstriches sich
der Farbverlauf wiederholt. Die Standardmasseinheit hierfür sind Pixel, aber Sie können aus dem
nebenstehenden Menü auch andere Einheiten auswählen.

Tabelle 7.1. Darstellung der drei verschiedenen Möglichkeiten zur Wiederholung von Farbverläufen.

Farbverlauf

”Abstract 2“

Keine Sägezahnwelle Dreieckswelle

Ist die Option Farbe aus Farbverlauf ohne Wiederholung aktiviert, wird bei längeren Strichen
mit der Endfarbe des Farbverlaufes weitergezeichnet.

Sägezahnwelle: Der Farbverlauf wird hintereinander auf den Pinselstrich gezeichnet. In Abhängigkeit
von der eingestellten Länge des Farbverlaufs, wird dieser wiederholend vom Beginn an, darge-
stellt.

Dreieckswelle: Ebenso wie bei der Sägezahnwelle, wird der Farbverlauf hintereinander auf den
Pinselstrich gezeichnet. Der Unterschied besteht hier, dass der Farbverlauf in Abhängigkeit von
der eingestellten Länge, seine Richtung beim Zeichnen wechselt.
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7.3.5. Stift

Abbildung 7.25. Der Bleistift im Werkzeugfenster

Das Stiftwerkzeug ist vor allem für Freihandzeichnungen vorgesehen. Jeder Strich wird mit der aktu-
ell ausgewählten Pinselform gezeichnet. Die Werkzeuge Stift und Pinsel sind sehr ähnlich. Der Haupt-
unterschied besteht darin, dass obwohl beide die gleichen Pinselformen verwenden, der Stift keine wei-
chen Kanten produziert, selbst mit einer sehr weichen Pinselform nicht.

Vielleicht fragen Sie sich jetz weshalb man ein derartig rohes, ja grobes, Werkzeug überhaupt benut-
zen sollte. Die möglicherweise wichtigste Anwendung dafür ist, die Arbeit an sehr kleinen Bildern, wie
beispielsweise Icons oder Symbolen, wo Sie mit einer hohen Vergrößerung arbeiten müssen und eine
exakte Kontrolle über jeden einzelnen Pixel benötigen.

TIPP

Wenn Sie mit dem Stift, oder mit einem anderen Malwerkzeug, gerade Linien
zeichnen möchten, halten Sie die Shift Taste gedrückt wenn Sie die Linie erstel-
len.

7.3.5.1. Werkzeugaufruf

Sie haben verschiedene Möglichkeiten den Stift zu aktivieren:

• Über das Menü Werkzeuge → Malwerkzeuge → Stift im Bildfenster,

• Mit einen Mausklick auf das Symbol im Werkzeugfenster, sowie

• Über das Tastenkürzel N.

7.3.5.2. Tastenkombinationen (Vorgabe-Einstellungen)

Strg Die Taste Strg verwandelt den Stift in eine Pipette, mit der Sie eine neue Farbe aufnehmen können.

Shift Die Shift Taste schaltet den Stift in den Linienzeichnenmodus. Durch gedrückt Halten von Shift,
wird das Werkzeug gezwungen, eine gerade Linie zu zeichnen. Diese Linie entsteht zwischen dem
Startpunkt und einem Mausklick an der aktuellen Mauszeigerposition.
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Abbildung 7.26. Werkzeugeinstellungen für den Stift

7.3.5.3. Eigenschaften

Übersicht Die aktuellen Werkzeugeinstellungen für den Stift lassen sich durch einen Doppelklick auf

das Symbol anzeigen.

Deckkraft; Pinsel(-form); Druckempfindlichkeit; Verblassen; Steigernd

ANMERKUNG

Diese Eigenschaften sind bei allen Malwerkzeugen von GIMP vorhanden
und daher in einem separaten Abschnitt Allgemeine Eigenschaften be-
schrieben.

Modus; Farbverlauf

ANMERKUNG

Diese Eigenschaften sind bei allen farbauftragenden Malwerkzeugen von
GIMP vorhanden und daher in einem separaten Abschnitt Farbauftragende
Malwerkzeuge beschrieben.

7.3.6. Pinsel

Mit Hilfe des Pinsels, können weiche Striche mit der aktuell ausgewählten Pinselform gezeichnet wer-
den.

7.3.6.1. Werkzeugaufruf

Sie haben verschiedene Möglichkeiten den Pinsel zu aktivieren:

• Über das Menü Werkzeuge → Malwerkzeuge → Pinsel im Bildfenster,
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Abbildung 7.27. Der Pinsel im Werkzeugfenster

• Mit einen Mausklick auf das Symbol im Werkzeugfenster, sowie

• Über das Tastenkürzel P.

7.3.6.2. Tastenkombinationen (Vorgabe-Einstellungen)

Strg Die Taste Strg verwandelt den Stift in eine Pipette, mit der Sie eine neue Farbe aufnehmen können.

Shift Die Shift Taste schaltet das Pinselwerkzeug in den Linienzeichnenmodus. Durch gedrückt Halten
derShift Taste, wird das Werkzeug gezwungen, eine gerade Linie zu zeichnen. Diese Linie entsteht
zwischen dem Startpunkt und einem Mausklick an der aktuellen Mauszeigerposition.

7.3.6.3. Eigenschaften

Abbildung 7.28. Werkzeugeinstellungen für den Stift

Übersicht Die Werkzeugeinstellungen für das Pinselwerkzeug lassen sich durch einen Doppelklick auf

das Symbol anzeigen.
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Deckkraft; Pinsel(-form); Druckempfindlichkeit; Verblassen; Steigernd

ANMERKUNG

Diese Eigenschaften sind bei allen Malwerkzeugen von GIMP vorhanden
und daher in einem separaten Abschnitt Allgemeine Eigenschaften be-
schrieben.

Modus; Farbverlauf

ANMERKUNG

Diese Eigenschaften sind bei allen farbauftragenden Malwerkzeugen von
GIMP vorhanden und daher in einem separaten Abschnitt Farbauftragende
Malwerkzeuge beschrieben.

7.3.7. Radierer

Abbildung 7.29. Der Radier im Werkzeugfenster

Der Radierer wird benutzt, um Bereiche der aktuellen Ebene, einer Auswahl oder des Bildes zu
löschen. Wird des Radierer auf einer Fläche benutzt, die keine Alphakanäle unterstützt (bsp. Kanäle
oder Ebenenmasken), so erscheint als radierte Fläche die Hintergrundfarbe. Unterstützt die Fläche einen
Alphakanal, dann erscheint die radierte Fläche als transparenter Bereich. Wie diese konkret dargestellt
wird hängt davon ab, wie die Darstellung der Transparenz eingestellt wurde.

Wenn Sie eine Menge von Pixeln komplett löschen möchten, so dass alle Spuren des vorherigen In-
haltes wirklich gründlich entfernt sind, sollten Sie die Eigenschaft Harte Kante einschalten. Nur so ist
sichergestellt, dass auch die Pixel an der Kante des Radierer vollständig gelöscht werden.

TIPP

Sollten Sie GIMP mit einem Grafiktablett benutzen, bevorzugen Sie es sicher,
das Radieren auf das hintere Ende des Stiftes zu legen. Aktivieren Sie hier-
zu das Werkzeug Radierer durch klicken mit dem hinteren Ende des Stiftes im
Werkzeugfenster. Jedes Ende des Stiftes wird im GIMP als unterschiedliches
Eingabegerät betrachtet und ermöglicht es Ihnen jedes Ende mit einem anderen
Werkzeug zu belegen.
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Der Radierer im GIMP funktioniert auf dem virtuellem sehr ähnlich wie einem Radiergummi auf
realen Papier. Neben dem Benutzen der verschiedenen Standardpinselforment, bietet das Werkzeug
zusätzliche Optionen um das Radieren exakter und einfacher zu gestalten.

7.3.7.1. Werkzeugaufruf

Sie haben verschiedene Möglichkeiten den Radierer zu aktivieren:

• Über das Menü Werkzeuge → Malwerkzeuge → Radierer im Bildfenster,

• Mit einen Mausklick auf das Symbol im Werkzeugfenster, sowie

• Über das Tastenkürzel Shift–E

7.3.7.2. Tastenkombinationen (Vorgabe-Einstellungen)

bitte Beachten Sie das Kapitel Allgemeine Eigenschaften. Dort werden die Tastenkombinationen be-
schrieben, die für alle Malwerkzeuge, also auch den Radierer, gelten.

• Strg: Wenn Sie die Taste Strg drücken, wird der Radierer in den Modus ”Pipette“ versetzt. Sie
können dann mit einem Mausklick die Farbe des Pixels unter der Pipette aufnehmen. Allerdings
wird, im Gegensatz zu den anderen Malwerkzeugen, die Farbe als Hintergrundfarbe und nicht als
Vordergrundfarbe aufgenommen.

• Alt: Mit der Taste Alt wird der Radierer in den Modus ”Un-Radieren“ versetzt. Wie Sie diesen
Modus anwenden können wird im Abschnitt Eigenschaften beschrieben.

7.3.7.3. Eigenschaften

Abbildung 7.30. Eigenschaften des Radierers

Deckkraft Der Deckkraft Schieberegler bestimmt die Stärke mit der ein Werkzeug angewendet wird.
Konsequenterweise bewirkt die Eigenschaft also beim Radierer wie stark gelöscht wird. Je höher
also die Deckkraft ist, um so mehr Durchsichtigkeit erzeugt der Radierer.

Pinsel(-form); Druckempfindlichkeit; Verblassen; Steigernd; Harte Kanten

ANMERKUNG

Diese Eigenschaften sind bei allen Malwerkzeugen von GIMP vorhanden
und daher in einem separaten Abschnitt Allgemeine Eigenschaften be-
schrieben.

113



7.3. MALWERKZEUGE KAPITEL 7. WERKZEUGE

Un-Radieren Bei aktivierter Eigenschaft Un-Radieren, werden Bildbereiche, auch wenn sie komplett
transparent sind, unradiert. Das funktioniert nur, wenn die Ebenen einen Alphakanal besitzen.

ANMERKUNG

Um zu verstehen was bei dem Un-Radieren passiert, müssen Sie sich vor
Augen halten, dass das Werkzeug nur den Alphakanal betrifft, nicht je-
doch die Farbkanäle welche die eigentlichen Bilddaten beinhalten. Sogar
wenn das Ergebnis komplett transparent bzw. durchscheinend ist, und Sie
die Farbdaten nicht sehen, hilft Ihnen das Un-Radieren beim anheben der
Werte des Alphakanals, um die Farbdaten wieder zu sehen.

7.3.8. Sprühpistole (Airbrush)

Abbildung 7.31. Die Sprühpistole im Werkzeugfenster. Die Sprühpistole ist das digitale Pedant zum
realen Airbrush. Sie ist hervorragend geeignet, um weiche, farbige Flächen zu malen.

7.3.8.1. Werkzeugaufruf

Sie haben verschiedene Möglichkeiten die Sprühpistole zu aktivieren:

• Über das Menü Werkzeuge → Malwerkzeuge → Sprühpistole im Bildfenster,

• Mit einen Mausklick auf das Symbol im Werkzeugfenster, sowie

• Über das Tastenkürzel A

7.3.8.2. Tastenkombinationen (Vorgabe-Einstellungen)

Tastenkürzel Die Taste A ruft die Sprühpistole auf.

Strg Mit Strg wird die Pipette aufgerufen.

Shift Die Shift Taste schaltet die Sprühpistole in den Linienzeichnenmodus. Durch gedrückt Halten
von Shift, wird das Werkzeug gezwungen, eine gerade Linie zu zeichnen. Diese Linie entsteht
zwischen dem Startpunkt und der aktuellen Mauszeigerposition.
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7.3.8.3. Eigenschaften

Abbildung 7.32. Werkzeugeinstellungen für die Sprühpistole

Übersicht Die aktuellen Werkzeugeinstellungen für die Sprühpistole lassen sich durch einen Dop-

pelklick auf das Symbol anzeigen.

Deckkraft; Pinsel(-form); Druckempfindlichkeit; Verblassen

ANMERKUNG

Diese Eigenschaften sind bei allen Malwerkzeugen von GIMP vorhanden
und daher in einem separaten Abschnitt Allgemeine Eigenschaften be-
schrieben.

Modus; Farbe aus Farbverlauf

ANMERKUNG

Diese Eigenschaften sind bei allen farbauftragenden Malwerkzeugen von
GIMP vorhanden und daher in einem separaten Abschnitt Farbauftragende
Malwerkzeuge beschrieben.

Rate Der Rate Schieberegler beeinflusst, wie schnell die Farbe auf das Bild gebracht wird. Je höher die
Rate desto schneller werden dunklere Striche gezeichnet. Die Rate kann einen Wert zwischen 0
und 100 annehmen.

Druck Durch verändern des Druckes, wird beeinflusst, wieviel Farbe gezeichnet wird. Je höher der
Druck, desto dunkler werden die Striche. Der Wert lässt sich zwischen 0 und 100 einstellen.

7.3.9. Tinte

Mit dem Werkeug ”Tinte“ lassen sich Striche ähnlich wie mit einem Füllhalter zeichnen. Die Werk-
zeugspitze verhält sich wie eine digitale Feder. Durch Einstellung der Eigenschaften Größe, Form und
Winkel, lässt sich der Strich beliebigen Bedürfnissen anpassen.
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Abbildung 7.33. Das Werkzeug ”Füllhalter“ im Werkzeugfenster

7.3.9.1. Werkzeugaufruf

Sie haben verschiedene Möglichkeiten das Werkzeug ”Tinte“ zu aktivieren:

• Über das Menü Werkzeuge → Malwerkzeuge → Tinte im Bildfenster,

• Mit einen Mausklick auf das Symbol im Werkzeugfenster, sowie

• Über das Tastenkürzel K

7.3.9.2. Tastenkombinationen Vorgabe-Einstellungen)

Tastenkürzel Die Taste K ruft das Werkzeug ”Tinte“ auf.

7.3.9.3. Eigenschaften

Abbildung 7.34. Eigenschaften des Werkzeuges ”Tinte“

Übersicht Die Werkzeugeinstellungen für das Werkzeug lassen sich durch einen Doppelklick auf das

Symbol anzeigen.

116



KAPITEL 7. WERKZEUGE 7.3. MALWERKZEUGE

Deckkraft

ANMERKUNG

Diese Eigenschaften sind bei allen Malwerkzeugen von GIMP vorhanden
und daher in einem separaten Abschnitt Allgemeine Eigenschaften be-
schrieben.

Modus

ANMERKUNG

Diese Eigenschaften sind bei allen farbauftragenden Malwerkzeugen von
GIMP vorhanden und daher in einem separaten Abschnitt Farbauftragende
Malwerkzeuge beschrieben.

Justierung

Größe Die Größe der Feder lässt sich zwischen 0 (sehr klein) bis 20 (sehr groß), einstellen.

Winkel Der Winkel mit der die virtuelle Feder des Werkzeuges auf die Zeichenfläche trifft. Dieser
kann zwischen -90° und +90° eingestellt werden. Dabei entspricht ein Winkel von 90° einer
senkrechten Haltung, es wird dann mit der eingestellten Federform gezeichnet.

Empfindlichkeit

Größe Mit dieser Eigenschaft kontrollieren Sie die Grösse der Feder. Je höher der eingestellte Wert
ist, desto mehr Tinte wird auf das Bild gegeben. Gerade bei der Benutzung eines Grafikta-
bletts kann diese Eigenschaft nützlich sein, da mit einem Stift wesentlich mehr verschiedene
Aufdruckstärken abgefragt werden können, als mit einer Maus.

Neigung Der Wert für die Neigung bewegt sich zwischen 0 und 1,0. Je kleiner die Neigung desto
mehr nähert sich der Strich der Form des ausgewählten Typs an. Ist zum Beispiel ein Kreistyp
mit einer sehr geringen Neigung (0,1) ausgewählt, wird mit einem runden Strich gezeichnet.

Geschwindigkeit Je höher der Wert für die Geschwindigkeit (max. 1,0), desto dünner wird der
Strich gezeichnet.

Typ und Form

Typ Für den Typ der Feder stehen dem Benutzer drei verschiedene Formen zur Auswahl: Kreis,
Quadrat und die Raute. Jede Spitze hat seine Eigenheiten, die Sie am besten einfach einmal
ausprobieren sollten.

Form Über die Form kann die Feder nochmals beliebig modifiziert werden. Durch verschieben
des Mittelpunktes lässt sich die Ausgangsform verzerren und drehen.
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7.3.10. Klonen

Abbildung 7.35. Das Werkzeug ”Klonen“ im Werkzeugfenster.

Das Klonwerkzeug benutzt die aktuelle Pinselform, um mit kopierten Bildbereiche zu zeichnen. Des-
halb kann es vielfältig eingesetzt werden. Meistens wird es benutzt um digitale Fotos zu retuschieren.
Also bestimmte Bereiche eines Fotos mit Inhalten von einer anderen Stelle auszubessern. Das funk-
tioniert ganz hervorragend. Um das perfekt umzusetzen, werden Sie etwas Zeit und Übung benötigen.
Ein anderer wichtiger Anwendungsfall für das Werkzeug ist das Zeichnen von gemusterten Linien oder
Kurven.

Wenn Sie Inhalte aus einem Bild anstelle von Mustern klonen wollen, müssen Sie zunächst GIMP
anweisen woher die geklonten Inhalte kommen sollen. Sie können dies tun, indem Sie an der Stelle von
der geklont werden soll, die Taste Strg gedrückt halten und mit der Maustaste klicken. Solange Sie nicht
auf diese Weise eine Quelle festgelegt haben, können Sie nicht mit dem Werkzeug ”Klonen“ zeichnen.
Der Mauszeiger zeigt dann ein entsprechendes Symbol an, um Sie zu warnen.

Wenn Sie ein Muster zum klonen verwenden, wird das Muster gekachelt, das heisst es wird immer
wieder gespiegelt aneinanderkopiert, so dass die Kanten aneinanderpassen. Wenn Sie von einem Bild
klonen ist das Verhalten anders. Wenn Sie über eine Kante des Quellbereiches hinausgeraten, hört das
Werkzeug auf weiterzuzeichnen.

Sie können auf jeder bemalbaren Unterlage (Ebenen, Ebenenmasken, Kanäle) klonen. Sie können so-
gar in eine Auswahlmaske hinein- und herausklonen, wenn Sie den Modus ”Schnelle Maske“ einge-
schaltet haben. Falls hierbei Farben kopiert werden sollen, welche die Zielunterlage nicht unterstützt
(bsp. klonen von einer RGB Ebene in eine Indizierte Ebene), werden die Farben bestmöglich angenähert.

7.3.10.1. Werkzeugaufruf

Sie haben verschiedene Möglichkeiten das Werkzeug ”Klonen“ zu aktivieren:

• Über das Menü Werkzeuge → Malwerkzeuge → Klonen im Bildfenster,

• Mit einen Mausklick auf das Symbol im Werkzeugfenster, sowie

• Über das Tastenkürzel C

7.3.10.2. Tastenkombinationen (Vorgabe-Einstellungen)

Strg Die Taste Strg wird verwendet, um eine Stelle im Bild zu definieren, die vom Werkzeug als Quelle
zum klonen verwendet wird. Sie hat keine Auswirkungen, wenn Sie von einem Muster klonen.
Wenn die Eigenschaft Ausrichtung auf den Wert Ausgerichtet oder Nicht ausgerichtet einge-
stellt ist, wird der Bildpunkt auf den Sie bei gedrückter Strg klicken als Quelle für das klonen
definiert. Der Bildinhalt an dieser Stelle ist das, was Sie beim zeichnen einfügen. Wenn Sie im
Modus Quellpunkt auswählen sind, erkennen Sie das auch am Mauszeiger, der sich in eine ent-
sprechendes Symbol verwandelt.
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7.3.10.3. Eigenschaften

Abbildung 7.36. Eigenschaften des Werkzeuges ”Klonen“

Deckkraft; Modus; Pinsel(-form); Druckempfindlichkeit; Verblassen; Harte Kante

ANMERKUNG

Diese Eigenschaften sind bei allen Malwerkzeugen von GIMP vorhanden
und daher in einem separaten Abschnitt Allgemeine Eigenschaften be-
schrieben.

Muster Das ausgewählte Muster welches für den nächsten Strich benutzt wird. Um das ausgewählte
Muster benutzen zu können, muss bei der Quelleneinstellung ebenfalls Muster ausgewählt sein.

Quelle Die ausgewählte Quelle gibt an, welcher Bereich des Bildobjekts geklont werden soll. In den
Vorgabe-Einstellungen ist Bildquelle ausgewählt. Damit werden Bildbestandteile klont. Ebenso
ist es möglich mit einem ausgewählten Muster das Werkzeug zum zeichnen zu benutzen.

Ausrichtung Die Ausrichtung bestimmt, wie die Position der Quelle für jeden Strich neu ausgerich-
tet wird. Nachfolgend zur Verdeutlichung eine schematisch Darstellung der verschiedenen Ein-
stellungen. Dabei ist die Mauszeigerposition mit einem roten Quadrat gekennzeichnet und der
Quellpunkt wird durch ein schwarzes Fadenkreuz dargestellt.

•
Im Modus Nicht ausgerichtet wird jeder Zeichenstrich mit dem Werkzeug unabhängig von-
einander behandelt. Dies bedeutet, dass bei jedem Zeichenstrich der gewählte Quellpunkt als
Quelle für den zu klonenden Inhalt verwendet wird. In diesem Modus werden typischerwei-
se die geklonten Inhalte nicht zueinander passen, wenn Sie mit zwei Zeichenstrichen über
den gleichen Zielbereich streichen.

•
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Im Modus Ausgerichtet wird der Abstand zwischen dem definierten Quellpunkt und dem
ersten Zeichenstrich konstant gehalten. Wenn Sie mehrere Striche zeichnen, werden daher
verschiedene Quellpunkte verwendet, die zueinander den gleichen Abstand haben, wie die
Punkte an denen Sie die Zeichenstriche gestartet haben.

•
Im Modus Registriertist der Quellpunkt gleich dem Zielpunkt. Dieser Modus wird meist
benutzt, wenn Bildbereiche von einer Ebene auf eine andere kopiert werden sollen.

7.3.10.4. Weitere Informationen

Transparenz Die Wirkungsweise des Klonwerkzeugs auf transparente Bereiche sind etwas komplizier-
ter. Sie können transparente Bereiche nicht klonen, indem Sie einen Quellpunkt setzen und hoffen
mit der transparenten Quelle zeichnen zu können. Klonen Sie jedoch von einer halbtransparen-
ten Fläche, wird die Wirkung anhand der Deckkraft der Quelle berechnet und sie können damit
malen. Angenommen Sie benutzen eine 100% gedeckte Fläche und eine harte Pinselform:

• Das Klonen eines transparenten Schwarz auf eine weiße Fläche erzeugt einen Grauton.

• Das Klonen eines transparenten Schwarz auf eine schwarze Fläche erzeugt einen Schwarzton.

• Das Klonen eines transparenten Weiß auf eine weiße Fläche erzeugt einen Weißton.

• Das Klonen eines transparenten Weiß auf eine schwarze Fläche erzeugt einen Grauton.

Das Klonwerkzeug kann niemals die Transparenz von Bereichen erhöhen, jedoch kann es die
Deckkraft der Ebene erhöhen (vorausgesetzt Transparenz behalten ist aktiviert). Das Klonen ei-
ner transparenten Fläche auf eine transparente Fläche wird dabei die Transparenz verringern und
die Deckkraft erhöhen.

”Filter”Pinsel Es gibt einige, nicht offensichtliche, Wege mit dem Werkzeug ”Klonen“ sehr beeindru-
ckende Effekte zu erzielen. Eine Sache, die Sie einmal ausprobieren sollten, ist einen ”Filterpinsel”,
also einen Filter mit einem Pinsel aufzutragen. Hierzu duplizieren Sie zunächst die Ebene an wel-
cher Sie arbeiten möchten und wenden den entsprechenden Filter auf die Kopie der Ebene an.
Dann aktivieren Sie das Werkzeug ”Klonen“ un stellen die Eigenschaften auf Quelle: Bild und
Ausrichtung: Registriert. Klicken Sie mit gedrückter Strg Taste in die Kopie der Ebene, um sie als
Quelle für das Klonen festzulegen. Sie können nun auf der Originalebene den Filter durch einfa-
ches zeichnen auftragen. Toll - nicht?

Undo/Redo Pinsel Sie können einen ähnlichen Ansatz verwenden, um den ”History Brush“ aus Photo-
shop nachzubilden, der ein ausgewähltes rückgängig machen oder wiederholen mit einem Pinsel
erlmöglicht. Es funktioniert sehr ähnlich wie in dem obigen Beispiel! Herauszufinden wie genau
es funktioniert sei Ihnen zur Übung überlassen :)

7.3.11. Verknüpfen (Weichzeichnen/Schärfen)

Das Werkzeug ”Verknüpfen“ ist geeignet, um kleine Bildbereiche gezielt zu weichzuzeichnen oder zu
schärfen. Wollen Sie jedoch große Bereiche oder gar das ganze Bild weichzeichnen oder schärfen, ist
die Verwendung der Filter zum Weichzeichnen oder Schärfen komfortabler. Die Richtung, in die der
Pinselstrich ausgeführt wird, hat keinen Einfluss auf das Ergebnis. Wenn Sie gerichtet weichzeichnen
möchten, verwenden Sie besser das Verschmieren Werkzeug.

Im ”Schärfen“ Modus bewirkt das Werkzeug eine Kontrasterhöhung in dem Bereich in dem es ange-
wendet wird. Ein bisschen davon kann ganz hilfreich sein, aber wenn Sie es zu stark anwenden, wird
ein meist unerwünschtes Rauschen auftreten. Hier leisten die Verbessern Filter, speziell Unscharf Mas-
kieren, wesentlich bessere Arbeit und führen zu saubereren Ergebnissen.
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Abbildung 7.37. Das Werkzeug ”Verknüpfen“ im Werkzeugfenster.

TIPP

Sie erhalten ein wesentlich raffinierteres Malwerkzeug zum Schärfen, indem Sie
das Werkzeug ”Klonen“ verwenden. Hierzu duplizieren Sie zunächst die Ebene
auf der Sie arbeiten wollen, führen dann einen Schärfefilter auf der Kopie aus.
Im nächsten Schritt aktivieren Sie das Werkzeug ”Klonen“ mit den Eigenschaf-
ten Quelle: Bild; Ausrichtung: Registriert; Deckkraft: niedrig, etwa 10. Mit einem
Strg-Mausklick auf die Kopie der Ebene legen Sie die Quelle fest. Wenn Sie nun
auf der Originalebene zeichnen, klonen Sie die geschärften Bildbereiche in das
Original.

Beide Modi, sowohl ”Weichzeichnen“ als auch ”Schärfen“, arbeiten verstärkend. Wenn Sie einen Bild-
bereich mehrfach überstreichen wird jedesmal die Wirkung des Werkzeuges neu angewendet und damit
verstärkt. Mit der Deckkraft können Sie diese Verstärkung beschränken. Die Eigenschaft Rate bestimmt
die maximale Stärke, mit der das Werkzeug auf einen einzelnen Bereich wirken kann.

7.3.11.1. Werkzeugaufruf

Sie haben verschiedene Möglichkeiten das Werkzeug ”Verknüpfen“ zu aktivieren:

• Über das Menü Werkzeuge → Malwerkzeuge → Verknüpfen im Bildfenster,

• Mit einen Mausklick auf das Symbol im Werkzeugfenster, sowie

• Über das Tastenkürzel V

7.3.11.2. Tastenkombinationen (Vorgabe-Einstellungen)

• Strg: Mit der Strg Taste, lässt sich zwischen den Modi ”Weichzeichnen“ und ”Schärfen“ umschal-
ten. Der jeweilige Modus bleibt erhalten, solange Sie die Taste Strg gedrückt halten.

7.3.11.3. Einstellungen

Deckkraft; Pinsel(-form); Druckempfindlichkeit; Verblassen; Harte Kanten
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Abbildung 7.38. Die Eigenschaften des Werkzeuges ”Verknüpfen“

ANMERKUNG

Diese Eigenschaften sind bei allen Malwerkzeugen von GIMP vorhanden
und daher in einem separaten Abschnitt Allgemeine Eigenschaften be-
schrieben.

Verknüpfungsart Die Verknüpfungsart gibt den Standardmodus des Werkzeuges an. So erlaubt das
Werkzeug, zwischen Weichzeichnen und Schärfen zu wählen. Der jeweils andere Modus lässt
sich durch gedrückt halten der Strg Taste einschalten.

Im Weichzeichnen Modus, werden die Farben ineinander verwischt. So entsteht von der weich-
gezeichneten Region ein verschwommener Eindruck. Damit lässt sich ein weicher Übergang zwi-
schen Farben erreichen, der aber auch etwas dunkler ausfallen kann.

Bei ausgewähltem Schärfen Modus, werden ähnliche Farben vereint. So entsteht ein Eindruck der
Schärfe. Bei übermässiger Anwendung kann der Werkzeugmodus zu ungewünschten Ergebnissen
führen, da Pixel zerstreut werden und scharfgezeichnete Kanten zerfranst wirken.

Rate Der Schieberegler zur Einstellung der Rate gibt an, mit welcher Stärke das Werkzeug angewendet
wird. So findet bei einer geringen Rate (0) keine Weichzeichnung/Schärfe statt. Bei einer hohen
Rate (100) verschwimmen die Farben im Weichzeichnen Modus ineinander umso mehr. Ebenso
verhält es sich im Schärfen-Modus, nur dass entsprechend mehr ähnliche Farben zusammenge-
fasst werden.

7.3.12. Abwedeln/Nachbelichten

Das Werkzeug zum Abwedeln oder Nachbelichten wird benutzt um Farben in Bildbereichen nachzu-
bessern. Diese können mit einer beliebigen Pinselform, abgedunkelt oder aufgehellt werden.

7.3.12.1. Werkzeugaufruf

Sie haben verschiedene Möglichkeiten das Werkzeug ”Abwedeln/Nachbelichten“ zu aktivieren:

• Über das Menü Werkzeuge → Malwerkzeuge → Abwedeln bzw. Nachbelichten im Bildfenster,

• Mit einen Mausklick auf das Symbol im Werkzeugfenster, sowie

• Über das Tastenkürzel Shift–D
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Abbildung 7.39. Das Werkzeug ”Abwedeln/Nachbelichten“ im Werkzeugfenster

7.3.12.2. Tastenkombinationen (Vorgabe-Einstellungen)

Tastenkürzel Die Tastekombination Strg–D ruft das Werkzeug Abwedeln/Nachbelichten auf.

Strg Mit der Strg Taste, lässt sich zwischen den Modi ”Abwedeln“ und ”Nachbelichten“ umschalten.
Der jeweilige Modus bleibt erhalten, solange Sie die Taste Strg gedrückt halten.

Shift Die Shift Taste schaltet das Werkzeug in den Linienzeichnenmodus. Durch gedrückthalten von
Shift wird das Werkzeug gezwungen, eine gerade Linie zu zeichnen. Diese Linie entsteht zwi-
schen dem Startpunkt und einem Mausklick an der aktuellen Mauszeigerposition.

7.3.12.3. Eigenschaften

Abbildung 7.40. Eigenschaften des Werkzeuges ”Abwedeln/Nachbelichten“

à[U+009C]bersicht Die Werkzeugeinstellungen für das Werkzeug ”Abwedeln/Nachbelichten“ lassen

sich durch einen Doppelklick auf das Symbol anzeigen.
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Deckkraft; Pinsel(-form); Druckempfindlichkeit; Verblassen; Harte Kanten

ANMERKUNG

Diese Eigenschaften sind bei allen Malwerkzeugen von GIMP vorhanden
und daher in einem separaten Abschnitt Allgemeine Eigenschaften be-
schrieben.

Typ Die Eigenschaft Typ gibt den Standardmodus des Werkzeuges an. So erlaubt das Werkzeug, zwi-
schen Abwedeln und Naachbelichten zu wählen. Der jeweils andere Modus lässt sich durch ge-
drückt halten der Strg Taste einschalten.
Im Modus Abwedeln werden die Farben der überstrichenen Bereiche, aufgehellt. Im Modus Nach-
belichten dagegen abgedunkelt.

Modus Diese Eigenschaft stellt drei Modi zur Verfügung, dem Wirkungsbereich des Werkzeuges be-
einflussen:

• Schatten beschränkt die Anwendung des Werkzeuges auf dunkle BeBildbereiche.
• Mitten beschränkt die Anwendung des Werkzeuges auf Bildbereiche mittlerer Helligkeit.
• Glanzlichter beschränkt die Anwendung des Werkzeuges auf helle Bildbereiche.

Belichtung Die Stärke der Belichtung, des ausgewählten Typs lässt sich mit dem Schieberegler einstel-
len. Standardmässig ist ein Wert von 50 eingestellt, diser kann aber zwischen 0 und 100 gewählt
werden Je höher der Wert, desto stärker ist die Wirkung des Werkzeuges.

7.3.13. Verschmieren

Abbildung 7.41. Das Werkzeug ”Verschmieren“ im Werkzeugfenster

Mit dem Werkzeug ”Verschmieren“ lassen sich Farben auf der aktuellen Ebene verschmieren. Es be-
nutzt die Farben unter der Werkezeugspitze um daraus die Zeichenfarbe zu bestimmen.

7.3.13.1. Werkzeugaufruf

Sie haben verschiedene Möglichkeiten das Werkzeug ”Verschmieren“ zu aktivieren:

• Über das Menü Werkzeuge → Malwerkzeuge → Verschmieren im Bildfenster,

• Mit einen Mausklick auf das Symbol im Werkzeugfenster, sowie

• Über das Tastenkürzel S
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7.3.13.2. Tastenkombinationen (Vorgabe-Einstellungen)

Shift Die Shift Taste schaltet das Werkzeug in den Linienzeichnenmodus. Durch gedrückthalten von
Shift wird das Werkzeug gezwungen, eine gerade Linie zu zeichnen. Diese Linie entsteht zwi-
schen dem Startpunkt und der aktuellen Mauszeigerposition.

7.3.13.3. Eigenschaften

Abbildung 7.42. Eigenschaften des Werkzeuges ”Verschmieren“

Übersicht Die Werkzeugeinstellungen für das Werkzeug ”Verschmieren“ lassen sich durch einen Dop-

pelklick auf das Symbol anzeigen.

Deckkraft; Pinsel(-form); Druckempfindlichkeit; Verblassen; Harte Kanten

ANMERKUNG

Diese Eigenschaften sind bei allen Malwerkzeugen von GIMP vorhanden
und daher in einem separaten Abschnitt Allgemeine Eigenschaften be-
schrieben.

Rate Der Rate Schieberegler beeinflusst die Stärke des Verschmierens. Je höher der eingestellte Wert,
desto stärker ist der Effekt. Je kleiner, desto weniger wird verschmiert. Die Eigenschaft kann Werte
zwischen 0 und 100 annehmen.

7.4. Transformationswerkzeuge

7.4.1. Allgemeine Eigenschaften

Im mittleren Bereich des Werkzeugfensters finden Sie die sieben Transformationswerkzeuge, welche
GIMP Ihnen zur Verfügung stellt. Während die Malwerkzeuge die Eigenschaften von Pixeln verändern,
werden durch die Transformationswerkzeuge die Pixel selbst verändert. Es werden also Pixel hinzu-
gefügt, gelöscht oder verschoben, ohne das dabei deren Eigenschaften wie Farbe oder Transparenz be-
einflusst werden. Bei der Arbeit mit den Transformationswerkzeugen wird, sobald Sie das Bildelement
auswählen auf das die Transformation angewendet werden soll, ein Informationsdialog eingeblendet.
In diesem Dialog können Sie alle Parameter exakt einstellen, bevor das Werkzeug angewendet wird.
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Abbildung 7.43. Eine Übersicht aller Transformationswerkzeuge von GIMP

7.4.1.1. Eigenschaften

Abbildung 7.44. Allgemeine Werkzeugeigenschaften der Transformationswerkzeuge

Viele Eigenschaften sind in mehreren Transformationswerkzeugen vorhanden. Diese werden hier be-
schrieben. Eigenschaften die nur für ein spezielles Werkzeug verfügbar sind, werden in dem Kaptitel
beschrieben, in welchem das Werkzeug detailliert vorgestellt wird.

Wirkt auf GIMP bietet drei Schaltflächen, um einstellen zu können, auf welches Bildelement die folgen-
de Tranformation angewendet wird.

Durch aktivieren der ersten Schaltfläche wird das Werkzeug auf die aktuelle Ebene an-
gewendet. Sie sollten darauf achten, dass keine Auswahlen auf dem Bild existieren, da GIMP die
Auswahlen bevorzugt.

Durch aktivieren der zweiten Schaltfläche wird dafür gesorgt, dass das Werkzeug nur
auf die Auswahl angewendet wird.

Mit aktivierter dritter Schaltfläche könne nur Pfade transformiert werden.

Transformationsrichtung Diese Eigenschaft gibt an, in welche Richtung die transformiert wird. GIMP
bietet zwei Transformationsrichtungen an: die Transformationen Vorwärts (traditionell) und Rückwärts
(korrigierend). Die traditionelle Transformationsrichtung führt die Tranformation im Uhrzeiger-
sinn aus. Die Korrigierende entsprechen in entgegengesetzter Richtung.

Interpolation Die Eigenschaft Interpolation erlaubt es die Qualität der Transformation auszuwählen.
Hierzu können Sie in einem Menü die verschiedenen Methoden einstellen. Um mehr über die
Algorithmen zur Interpolation zu erfahren, sei auf den Eintrag im Glossar verwiesen.

Hochrechnung Der Begriff ist im Glossar näher erklärt.
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Ergebnis beschneiden Bei aktivierter Option, wird die Größe des transformierten Elementes auf die
Größe des Originals zugeschnitten.

Vorschau GIMP bietet die Möglichkeit zwischen vier verschiedenen Arten der Vorschau zu wählen:

1 Umriss: Legt einen Rahmen um das Bild. Dieser Umriss hat an jeder Ecke einen aktiven
Punkt, mit dem Sie die Transformation beeinflussen können. Diese wird zunächst nur am
Rahmen sichtbar.

2 Gitter: Legt ein Gitter auf das Bild. Dieses Gitter hat an jeder Ecke einen aktiven Punkt, mit
dem Sie die Transformation beeinflussen können. Diese wird zunächst nur am Gitter sichtbar.

3 Bild: In diesem Fall wird eine Kopie des Bildes mit einem Rahmen über das eigentliche Bild
gelegt. Die Transformation wird für dieses Vorschaubild angezeigt, so dass Sie genau sehen,
wie das Ergebnis aussehen würde.

4 Bild + Gitter: Sowohl das Gitter, als auch das Vorschaubild werden angezeigt.

Das Vorschaubild dient lediglich der besseren Bedienbarkeit. Es hat keinen Einfluss auf das endgültige
Ergebnis, welches bei allen Arten der Vorschau identisch ist.

Wenn die gewählte Art der Vorschau ein Gitter verwendet, stehen Ihnen in einem Menü zwei
weitere Eigenschaften zur Verfügung: Anzahl der Gitterlinien erlaubt es Ihnen einzustellen wie-
viele Gitterlinien angezeigt werden. Verwenden Sie den Schieberegler, um die Anzahl festzulegen.
Abstand der Gitterlinien erlaubt es Ihnen einzustellen, in welchem Abstand die Gitterlinien an-
gezeigt werden. Verwenden Sie den Schieberegler, um den Abstand festzulegen.

ANMERKUNG

Wenn sie einen Pfad transformieren, stehen Ihnen die Vorschaueinstellun-
gen mit Vorschaubild nicht zur Verfügung. Nur der Umriss ist aktiv.

7.4.2. Verschieben

Abbildung 7.45. Das Werkzeug ”Verschieben“ im Werkzeugfenster

Das Verschieben Werkzeug wird benutzt um Ebenen oder Auswahlen zu verschieben.
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TIPP

Das Werkzeug ”Verschieben“ kann auch benutzt werden, um Hilfslinien zu ver-
schieben. Beachten Sie hierzu bitte den Eintrag Hilfslinien im Glossar.

Wenn Hilfslinien präzise platziert werden sollen, ist die Verwendung des Werk-
zeuges ”Messen“ empfehlenswert.

7.4.2.1. Werkzeugaufruf

Sie haben verschiedene Möglichkeiten das Werkzeug ”Verschieben“ zu aktivieren:

• Über das Menü Werkzeuge → Transformationswerkzeuge → Verschieben im Bildfenster,

• Mit einen Mausklick auf das Symbol im Werkzeugfenster, sowie

• Über das Tastenkürzel M

7.4.2.2. Tastenkombinationen (Vorgabe-Einstellungen)

Alt Wenn Sie die Taste Alt beim verschieben gedrückt halten, wird eine vorhandene Auswahl verscho-
ben und nicht das Bild selbst. Sollte die Taste Alt nicht wie gewünscht funktionieren versuchen
Sie bitte die Tastenkombination Shift–Alt.

Verwendung der Pfeiltasten Statt der Maus, können Sie zum Verschieben auch die Cursor- oder Pfeil-
tasten benutzen. Wenn Sie zusätzlich Shift gedrückt halten, wird nicht um einen, sondern um 25
Pixel verschoben.

7.4.2.3. Eigenschaften

Abbildung 7.46. Eigenschaften des Werkzeuges ”Verschieben“

Übersicht Die Werkzeugeinstellungen für das Werkzeug ”Verschieben“ lassen sich durch einen Dop-

pelklick auf das Symbol anzeigen.
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Wirkt auf

ANMERKUNG

Diese Eigenschaft ist bei allen Transformationswerkzeugen von GIMP vor-
handen und daher in einem separaten Abschnitt Allgemeine Eigenschaften
beschrieben.

Werkzeug-Modus Im Bereich Werkzeug-Modus können Sie festlegen, welcher Werkzeugmodus der
Standardmodus, und welcher nach drücken der Shift Taste aktiv sein soll.

7.4.3. Zuschneiden / Größe ändern

Abbildung 7.47. Das Werkzeug ”Zuschneiden / Größe ändern“ im Werkzeugfenster

Das Werkzeug ”Zuschneiden / Größe ändern“ können sie verwenden, um einen Rahmen oder sons-
tige nicht benötigte Bildbereiche zu entfernen. Auch um das Bild auf eine spezifische Bildgrössen zu
trimmen, kann das Werkzeug sehr hilfreich sein.

Zur Anwendung des Werkzeuges klicken Sie innerhalb des Bildes und ziehen Sie mit dem Mauszei-
ger einen rechteckigen Bereich auf. Danach lassen Sie die Maustaste los. Während der Aktion wird ein
Dialogfenster eingeblendet, das Ihnen die Gräße des ausgewählten Bereiches anzeigt und verschiede-
ne weitere Aktionen anbietet. Wenn Sie Form und Größe des ausgewählten Bereiches ändern möchten,
können Sie dies, indem Sie die Punkte an den Ecken des Bereiches anklicken und verschieben. Alternativ
können Sie auch direkt die Werte im angezeigten Dialogfenster ändern.

Sobald Sie den Bereich endgültig festgelegt haben, können Sie die Aktion ausführen, indem Sie entwe-
der in den ausgewählten Bereich hineinklicken, oder die Zuschneiden bzw. Größe ändern Schaltfläche
des Dialoges anklicken.

TIPP

Wenn Sie das Dialogfenster als eher störend denn hilfreich empfinden, können
Sie es unterdrücken, indem Sie beim ersten Klick zur Erstellung des zu bear-
beitenden Bereiches die Shift Taste gedrückt halten. Wenn das Dialogfenster
nicht angezeigt wird, können Sie den Bereich durch verschieben der Eckpunkte
korrigieren und mit einem Klick innerhalb des Bereiches die Aktion auslösen.

7.4.3.1. Werkzeugaufruf

Sie haben verschiedene Möglichkeiten das Werkzeug ”Zuschneiden / Größe ändern“ zu aktivieren:
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• Über das Menü Werkzeuge→ Transformationswerkzeuge→ Zuschneiden / Größe ändern im
Bildfenster,

• Mit einen Mausklick auf das Symbol im Werkzeugfenster, sowie

• Über das Tastenkürzel Shift–C.

TIPP

Um ein Bild auf eine bestehende Auswahl zuzuschneiden gibt es einen schnelle-
ren Weg: wählen Sie im Bildfenster den Menüeintrag Bild → Bild zuschneiden

7.4.3.2. Tastenkombinationen (Vorgabe-Einstellungen)

Tastenkürzel Die Tastenkombination Shift–C ruft das Werkzeug auf.

Strg Durch gedrückt Halten der Taste Strg wird zwischen den zwei Werkzeugmodi, Zuschneiden und
Größe ändern, umgeschaltet.

Shift Durch gedrückt Halten der Taste Shift können Sie ein fixes Seitenverhältnis einschalten.

Alt Durch gedrückt Halten der Alt Taste wird die Eigenschaft Vergrößern zulassen aktiviert.

7.4.3.3. Eigenschaften

Abbildung 7.48. Eigenschaften des Werkzeuges ”Zuschneiden / Größe ändern“

Übersicht Die Werkzeugeinstellungen für das Werkzeug lassen sich durch ein Doppelklick auf das

Symbol anzeigen.

Werkzeug-Modus Der Werkzeug-Modus für das Zuschneiden Werkzeug kann entweder auf Zuschnei-
den oder Größe ändern eingestellt werden.

Standardmässig ist das Werkzeug auf den Modus Zuschneiden eingestellt. Der Bereich, auf den
zugeschnitten werden soll, kann entweder durch Ziehen einer rechteckigen (Zuschneide-) Aus-
wahl oder durch manuelles Eingeben der Höhen- und Breitenangaben erfolgen. Bei der Benutzung
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des Werkzeuges wird automatisch ein Dialogfenster eingeblendet. Diese bietet Ihnen zusätzliche
Einstellungsmöglichkeiten, die die Benutzung des Werkzeuges erleichtern.

Der Werkzeugmodus Größe ändern funktioniert ähnlich dem Modus Zuschneiden mit dem Un-
terschied, dass die Grösse der betroffenen Ebenen nicht verändert wird. So bleibt die Grösse der
Ebene erhalten und nur die Pixel um den Zuschneide Bereich werden entfernt.

Zuschneidebereiche können auch aus einer vorhandenen rechteckigen Auswahl erstellt werden.
Ist der ausgewählte Bereich zu ungenau oder zu gross, können Sie die Funktion Automatisch
schrumpfen benutzen, um den Zuschneidebereich automatisch verkleinern zu lassen. Dies funk-
tioniert insbesondere dann sehr gut, wenn Sie einen einfarbigen Rahmen entfernen wollen.

Nur die aktive Ebene Das Zuschneiden findet nur auf der aktiven Ebene Anwendung. Andere Ebenen
werden nicht durch das Werkzeug verändert.

Vergrößern zulassen Diese Eigenschaft erlaubt es, Grössenänderungen ausserhalb des Bildes oder der
Ebenengrenzen durchzuführen.

Seitenverhältnis von Shift beibehalten Wenn diese Eigenschaft eingeschaltet ist, wird ein festes Sei-
tenverhältnis verwendet.

ZUSCHNEIDEINFORMATIONEN

Abbildung 7.49. Dialogfenster des Werkzeuges ”Zuschneiden / Größe ändern“

Ursprung X/Y Die Eingabefelder für den Ursprung dienen der manuellen Festlegung des Ursprungs-
punktes für den zuzuschneidenen Bereich. Der Ursprung ist immer die linke, obere Ecke des Zu-
schneidebereiches. Zusätzlich können noch Einheiten für die Bereichsangaben ausgewählt wer-
den.

Breite/Höhe Höhen- und Breitenangaben des Zuschneidebereiches können hier manuell eingegeben
werden. Zusätzlich stehen noch verschiedene Einheiten für die Werte zu Auswahl.

Seitenverhältnis Hier können Sie ein festes Seitenverhältnis für den Zuschneidebereich eingeben.

Aus Auswahl Diese Schaltfläche passt die Grösse des Zuschneidebereiches an die Grösse der bestehen-
den Auswahl an.
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Automatisch schrumpfen Die Schaltfläche Automatisch schrumpfen versucht automatisch den Zu-
schneidebereich an ein bestehendes Bildobjekt anzupassen.

Größe ändern / zuschneiden Mit diesen zwei Schalflächen können Sie die gewünschte Funktion ausführen.
Dies geschieht unabhängig vom eingestellten Werkzeugmodus.

7.4.4. Drehen

Abbildung 7.50. Das Werkzeug ”Drehen“ im Werkzeugfenster

7.4.4.1. Übersicht

Das Werkzeug ”Drehen“ wird benutzt, um Ebenen, Auswahlen und Pfade zu drehen. Wenn Sie das
Werkzeug aktiviert haben und in eine Ebene oder eine Auswahl klicken, wird ein Gitter bzw. eine Um-
randung eingeblendet und der Dialog Drehinformationen geöffnet. In diesem können Sie einen Winkel
und das Zentrum, um das gedreht werden soll, eingeben. Ebenso können diese Werte eingestellt wer-
den, indem Sie mit dem Mauszeiger direkt am Bild oder am Rotationszentrum im Bild ziehen.

7.4.4.2. Werkzeugaufruf

Sie haben verschiedene Möglichkeiten das Werkzeug ”Drehen“ zu aktivieren:

• Über das Menü Werkzeuge → Transformationswerkzeuge → Drehen im Bildfenster,

• Mit einen Mausklick auf das Symbol im Werkzeugfenster, sowie

• Über die Tastenkombination Shift–R

7.4.4.3. Tastenkombinationen (Vorgabe-Einstellungen)

Strg Durch gedrückt Halten der Taste Strg, wird die Drehung auf 15 Grad Schritte beschränkt.

EIGENSCHAFTEN

Übersicht Die Werkzeugeinstellungen für das Werkzeug ”Drehen“ lassen sich durch ein Doppelklick

auf das Symbol anzeigen.
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Abbildung 7.51. Eigenschaften des Werkzeuges ”Drehen“

Wirkt auf; Transformationsrichtung; Interpolation; Hochrechnung; Ergebnis beschneiden; Vorschau

ANMERKUNG

Diese Eigenschaften sind bei allen Transformationswerkzeugen von GIMP
vorhanden und daher in einem separaten Abschnitt Allgemeine Eigen-
schaften beschrieben.

Einschränkungen Durch Aktivierung der 15 Grad Option, wird die Rotation auf 15 Grad Schritte
beschränkt. Damit wird das Verhalten der Strg Taste umgekehrt.

DIALOGFENSTER DREHINFORMATIONEN

Abbildung 7.52. Dialogfenster des Werkzeuges ”Drehen“

Winkel Hier können Sie einstellen, um welchen Winkel das Bild gedreht werden Soll. Die Eingaben
können im Bereich 0 bis 360 und -180 bis 180 direkt eingegeben, oder über den Schieberegler
festgelegt werden.
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Zentrum X/Y Über diese Eigenschaft stellen Sie ein, wo sich der Punkt befindet, um den gedreht wird.
Die Werte können in verschiedenen Längeneinheiten angegeben werden, die über ein Menü aus-
gewählt werden. Sie können diese Einstellung auch direkt im Bild vornehmen, indem Sie den
hervorgehobenen Punkt in der Mitte des Rotationsbereiches anfassen und verschieben.

7.4.5. Skalieren

Abbildung 7.53. Das Werkzeug ”Skalieren“ im Werkzeugfenster

7.4.5.1. Übersicht

Das Werkzeug ”Skalieren“ wird benutzt, um die Grösse von Ebenen, Auswahlen und Pfaden zu verändern.
Sobald Sie das Werkzeug aktiviert haben und in ein Bild klicken, öffnet sich der Dialog ”Skalierin-

formationen“. Dieser ermöglicht es Ihnen Einstellungen für Höhe und Breite vorzugeben. Gleichzeitig
wird eine Vorschau mit einem Gitter oder einem Umriss dargestellt. Mit Hilfe der Vorschau können Sie
interaktiv alle Parameter einstellen, um das gewünschte Ergebnis zu erhalten.

7.4.5.2. Werkzeugaufruf

Sie haben verschiedene Möglichkeiten das Werkzeug ”Skalieren“ zu aktivieren:

• Über das Menü Werkzeuge → Transformationswerkzeuge → Skalieren im Bildfenster,

• Mit einen Mausklick auf das Symbol im Werkzeugfenster, sowie

• Über die Tastenkombination Shift–T

7.4.5.3. Tastenkombinationen (Vorgabe-Einstellungen)

Strg Durch gedrückt Halten der Strg Taste, bleibt die Höhe beim skalieren konstant.

Alt Durch gedrückt Halten der Alt Taste, bleibt die Breite beim Skalieren konstant.
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Abbildung 7.54. Eigenschaften des Werkzeuges ”Drehen“

7.4.5.4. Eigenschaften

Übersicht Die Werkzeugeinstellungen für das Werkzeug ”Skalieren“ lassen sich durch ein Doppelklick

auf das Symbol anzeigen.

Wirkt auf; Transformationsrichtung; Interpolation; Hochrechnung; Ergebnis beschneiden; Vorschau

ANMERKUNG

Diese Eigenschaften sind bei allen Transformationswerkzeugen von GIMP
vorhanden und daher im Abschnitt 7.4.1 auf Seite 117 beschrieben.

Einschränkungen Keine: Es werden keine Beschränkungen bei der Skalierung wirksam.

Höhe beibehalten: Ist diese Eigenschaft aktiv, bleibt die Höhe während der Skalierung konstant.

Breite beibehalten: Ist diese Eigenschaft aktiv, bleibt die Breite während der Skalierung konstant.

Verhältnis beibehalten: Ist diese Eigenschaft aktiv, bleibt das Verhältnis von Höhe und Breite
(Seitenverhältnis) bei der Skalierung konstant.

DIALOGFENSTER SKALIERINFORMATIONEN

Ursprüngliche Breite/Höhe Hier sind die ursprünglichen Werte für die Breite und Höhe des Bildob-
jektes angegeben, dass skaliert werden soll. Diese Werte werden auch benutzt, um die Skalierungs-
faktoren zu berechnen.

Aktuelle Breite/Höhe Über diese Eigenschaft stellen Sie ein, auf welche Grösse das Bildobjekt skaliert
werden soll. Die Eingaben können Sie in verschiedenen Einheiten vornehmen, die über ein Menü
ausgewählt werden. Eine Änderung der Werte wird sich auf den Wert des Seitenverhältnisses
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Abbildung 7.55. Dialogfenster des Werkzeuges ”Skalieren“

auswirken, welcher entsprechend angepasst wird. Die Werte werden auch benutzt, um die Skalie-
rungsfaktoren zu berechnen.

Skalierungfaktor X/Y Hier sind die Skalierungsfaktoren für Breite und Höhe angegeben, die sich aus
den ursprünglichen und den aktuellen Werten ergeben.

Seitenverhältnis Über diese Eigenschaft stellen Sie das gewünschte Seitenverhältnis der Skalierung
ein. Wenn Sie diesen Wert ändern, wird die aktuelle Höhe entsprechen angepasst.

7.4.6. Scheren

Abbildung 7.56. Das Werkzeug ”Scheren“ im Werkzeugfenster

Das ”Scheren“ Werkzeug wird benutzt, um Elemente wie Bilder, Ebenen, Auswahlen oder Pfade zu
scheren. Dabei wird eine Seite verschoben; aus einem Recheck wird also ein Trapez. Um das Werkzeug
zu verwenden, wählen Sie es aus und klicken Sie in ein Bild oder eine Auswahl. Das Dialogfenster
Schereninformationen wird eingebledet. Durch verschieben des Bildes oder der Auswahl können Sie
einstellen wie das Bild oder die Auswahl transformiert wird. Über den Dialog können Sie die Werte
auch numerisch vorgeben und mit einem Klick auf die Schaltfläche Scheren das Werkzeug anwenden.

7.4.6.1. Werkzeugaufruf

Sie haben verschiedene Möglichkeiten das Werkzeug ”Scheren“ zu aktivieren:

• Über das Menü Werkzeuge → Transformation → Scheren im Bildfenster,

• Mit einen Mausklick auf das Symbol im Werkzeugfenster, sowie
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• Über das Tastenkürzel Shift–S.

7.4.6.2. Eigenschaften

Abbildung 7.57. Eigenschaften des Werkzeuges ”Scheren“

Aufruf Die Werkzeugeinstellungen für das Werkzeug ”Scheren“ lassen sich durch einen Doppelklick

auf das Symbol anzeigen.

Wirkt auf; Transformationsrichtung; Interpolation; Hochrechnung; Ergebnis beschneiden; Vorschau

ANMERKUNG

Diese Eigenschaften sind bei allen Transformationswerkzeugen von GIMP
vorhanden und daher im Abschnitt 7.4.1 auf Seite 117 beschrieben.

DIALOGFENSTER SCHERINFORMATIONEN

Abbildung 7.58. Dialogfenster des Werkzeuges ”Scheren“

Scherneigung X Hier können Sie die horizontale Verschiebung, also die Verschiebung der oberen ge-
gen die untere Kante einstellen. Ein positiver Wert entspricht einer Verschiebung im Uhrzeiger-
sinn, ein negativer Wert einer ebensolchen in entgegengesetzter Richtung.
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Scherneigung Y Hier können Sie die vertikale Verschiebung, also die Verschiebung der linken gegen
die rechte Kante einstellen. Ein positiver Wert entspricht einer Verschiebung im Uhrzeigersinn, ein
negativer Wert einer ebensolchen in entgegengesetzter Richtung.

7.4.7. Perspektive

Abbildung 7.59. Das Werkzeug ”Perspektive“ im Werkzeugfenster

Das Werkzeug ”Perspektive“ wird benutzt, um Ebenen perspektivisch zu verzerren.

7.4.7.1. Werkzeugaufruf

Sie haben verschiedene Möglichkeiten das Werkzeug ”Perspektive“ zu aktivieren:

• Über das Menü Werkzeuge → Transformation → Perspektive im Bildfenster,

• Mit einen Mausklick auf das Symbol im Werkzeugfenster, sowie

• Über das Tastenkürzel Shift–P.

7.4.7.2. Tastenkombinationen (Vorgabe-Einstellungen)

Tastenkürzel Die Tastenkombination Shift–P ruft das Werkzeug für die perspektivische Verzerrung
auf.

7.4.7.3. Eigenschaften

Aufruf Die Werkzeugeinstellungen für das Werkzeug zur Perspektivkorrektur lassen sich durch ein

Doppelklick auf das Symbol anzeigen.

Wirkt auf; Transformationsrichtung; Interpolation; Hochrechnung; Ergebnis beschneiden; Vorschau

ANMERKUNG

Diese Eigenschaften sind bei allen Transformationswerkzeugen von GIMP
vorhanden und daher in einem separaten Abschnitt Allgemeine Eigen-
schaften beschrieben.
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Abbildung 7.60. Eigenschaften des Werkzeuges ”Perspektive“

DIALOGFENSTER INFORMATIONEN ZUR PERSPEKTIVTRANSFORMATION

Abbildung 7.61. Dialogfenster des Werkzeuges ”Perspektive“

Matrix In dieser aus drei Zeilen und drei Spalten bestehenden Matrix werden die aktuellen Transfor-
mationsparameter zur Kontrolle angezeigt.

7.4.8. Spiegeln

Abbildung 7.62. Das Werkzeug ”Spiegeln“ im Werkzeugfenster
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Das Werkzeug ”Spiegeln“ wird benutzt, um eine Ebene oder Auswahl horizontal oder vertikal zu
spiegeln.

7.4.8.1. Werkzeugaufruf

Sie haben verschiedene Möglichkeiten das Werkzeug ”Spiegeln“ zu aktivieren:

• Über das Menü Werkzeuge → Transformation → Spiegeln im Bildfenster,

• Mit einen Mausklick auf das Symbol im Werkzeugfenster, sowie

• Über das Tastenkürzel Shift–F (für den englischen Begriff ”flip“).

7.4.8.2. Tastenkombinationen (Vorgabe-Einstellungen)

Tastenkürzel Die Tastenkombination Shift–F aktiviert das Werkzeug ”Spiegeln“.

Strg Die Taste Strg erlaubt es, zwischen dem Horizontalen und dem Vertikalen Spiegelungsmodus
umzuschalten.

7.4.8.3. Eigenschaften

Abbildung 7.63. Eigenschaften des Werkzeuges ”Spiegeln“

Aufruf Die Werkzeugeinstellungen für das Werkzeug ”Spiegeln“ lassen sich durch ein Doppelklick auf

das Symbol anzeigen.

Wirkt auf

ANMERKUNG

Diese Eigenschaft ist bei allen Transformationswerkzeugen von GIMP vor-
handen und daher in einem separaten Abschnitt Allgemeine Eigenschaften
beschrieben.

Spiegeltyp Die Eigenschaft Spiegeltyp bestimmt, in welche Richtung gespiegelt wird.
Ist die Einstellung Horizontal aktiviert, wird die Ebene an der waagerechten Achse gespiegelt.
Bei aktivierter Vertikal Einstellung wird die Ebene an der senkrechten Achse gespiegelt.
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7.5. Farbwerkzeuge

7.5.1. Farbabgleich

Das Werkzeug ”Farbabgleich“ beeinflusst die Farbbalance der aktuellen Ebene oder Auswahl. Es ist
damit hervorragend geeignet, um beispielsweise einen Farbstich aus einem Digitalfoto zu entfernen.

7.5.1.1. Werkzeugaufruf

Sie haben verschiedene Möglichkeiten das Werkzeug ”Farbabgleich“ zu aktivieren:

• Über das Menü Werkzeuge → Farben → Farbabgleich im Bildfenster, sowie

• Mit einen Mausklick auf das Symbol im Werkzeugfenster, sofern die Farbwerkzeuge im
Werkzeugfenster eingeblendet sind. Dies können Sie im Dialog ”Werkzeuge“ einstellen.

7.5.1.2. Dialogfenster Farbabgleich anpassen

Abbildung 7.64. Das Dialogfenster des Werkzeuges ”Farbabgleich“

Den zu bearbeitenden Bereich auswählen Durch Auswahl eines der Werte Schatten, Mitten oder
Glanzlichter wird der Helligkeitsbereich festgelegt, auf den das Werkzeug angewendet wird. Bei-
spielsweise verändern Sie bei ausgewählten Schatten nur sehr dunkle Bereiche des Bildes.

Die Farbwerte des gewählten Bereichs bearbeiten Verschieben Sie mit der Maus die Schieberegler,
um den gewünschten Farbwert anzupassen. Die Farbe auf der linken Seite des Reglers ist jeweils
die Komplementärfarbe der rechten Seite. Durch Verschieben der einzelnen Regler werden die
Farbwerte des Bereiches auf den das Werkzeug wirkt neu gewichtet.

Bereich zurücksetzen Diese Schaltfläche setzt die Farbwerte auf ihre Standardwerte zurück.

Helligkeit erhalten Wenn dieses Kontrollkästchen aktiviert ist, wird die Helligkeit des Bildes durch das
Werkzeug konstant gehalten.

Vorschau Die Vorschau ermöglicht es Veränderung im Bild sofort sichtbar zu machen, um die Einstel-
lungen des Werkzeuges vor der Ausführung kontrollieren zu können.
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7.5.2. Farbton-Sättigung

Das Farbton-Sättigung Werkzeug können Sie benutzen, um den Farbton, Sättigung und Helligkeit in
der aktuellen Ebene oder Auswahl zu regulieren.

7.5.2.1. Werkzeugaufruf

Sie haben verschiedene Möglichkeiten das Werkzeug ”Farbton-Sättigung“ zu aktivieren:

• Über das Menü Werkzeuge → Farben → Farbton-Sättigung im Bildfenster, sowie

• Mit einen Mausklick auf das Symbol im Werkzeugfenster, sofern die Farbwerkzeuge im
Werkzeugfenster eingeblendet sind. Dies können Sie im Dialog ”Werkzeuge“ einstellen.

7.5.2.2. Dialogfenster Farbton / Helligkeit / Sättigung einstellen

Abbildung 7.65. Das Dialogfenster des Werkzeuges ”Farbton-Sättigung“

Zu bearbeitende Primärfarbe auswählen Der Dialog ordnet die zu änderndende Primärfarbe nach
dem HSV Farbkreis an. Die Primärfarbe, die in diesem Teil des Dialoges ausgewählt wird, lässt
sich im unteren Bereich mit Hilfe der Schieberegler verändern. Bei standardmässig ausgewählter
Schaltfläche Alle, werden alle Farben im Farbkreis in die Bearbeitung durch das Werkzeug einbe-
zogen.

Gewählte Farbe bearbeiten Durch Auswählen einer Primärfarbe, kann dieser Bereich des Farbspek-
trums verändert werden. Zu beachten ist dabei, dass es möglich ist, dass sich nicht die ausgewählte
Primärfarbe im Bild verändert muss.

• Farbton: Der Schieberegler erlaubt den Farbton von seinem Ausgangswert (0) im Bereich
-180 bis 180 zu verschieben.

• Helligkeit: Der Schieberegler erlaubt es, die Helligkeit von seinem Ausgangswert (0) im Be-
reich -100 bis 100 zu verschieben.
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• Sättigung: Der Schieberegler erlaubt es, die Sättigung von seinem Ausgangswert (0) im Be-
reich -100 bis 100 zu verschieben.

Mit Hilfe der Schaltfläche Farbe zurücksetzen lassen sich die Primärfarben wieder in ihren Aus-
gangszustand zurücksetzen.

Vorschau Die Vorschau ermöglicht es Veränderung im Bild sofort sichtbar zu machen, um die Einstel-
lungen des Werkzeuges vor der Ausführung kontrollieren zu können.

7.5.3. Einfärben

Das Werkzeug ”Einfärben“ konvertiert die aktuelle Ebene in ein Graustufenbild, um danach die einge-
stellte Farbe aufzubringen. Damit können Sie den beliebten ”Sephia-Effekt“ mit beliebigen Farbtönen
auf das Bild anwenden. Dieser Vorgang ähnelt einem eingefärbten Glass, durch welches Sie hindurch-
schauen. Die Einstellung der Veränderung an Farbton, Sättigung und Helligkeit erfolgen nach dem HSV
Farbmodell.

7.5.3.1. Werkzeugaufruf

Sie haben verschiedene Möglichkeiten das Werkzeug ”Einfärben“ zu aktivieren:

• Über das Menü Werkzeuge → Farben → Einfärben im Bildfenster, sowie

• Mit einen Mausklick auf das Symbol im Werkzeugfenster, sofern die Farbwerkzeuge im Werk-
zeugfenster eingeblendet sind. Dies können Sie im Dialog ”Werkzeuge“ einstellen.

7.5.3.2. Dialogfenster Bild einfärben

Abbildung 7.66. Das Dialogfenster des Werkzeuges ”Einfärben“

Farbe auswählen

• Farbton: Bewegen Sie den Schieberegler nach links oder rechts, um den Wert für den Farbton
zu verändern. Eine genaue Angabe der Werte von mindestens 0 oder maximal 360 können
sie über das Eingabefeld vornehmen. Standardmässig ist der Farbton auf einen Wert von 180
eingestellt.

• Sättigung: Bewegen Sie den Schieberegler nach links oder rechts, um den Wert für die Sättigung
zu verändern. Eine genaue Angabe der Werte von mindestens 0 oder maximal 100 können
Sie über das Eingabefeld vornehmen. Standardmässig ist die Sättigung auf einen Wert von 50
eingestellt.

• Helligkeit: Bewegen Sie den Schieberegler nach links oder rechts, um den Wert für die Hellig-
keit zu verändern. Eine genaue Angabe der Werte von mindestens -100 (dunkel) oder maxi-
mal 100 (hell), können Sie über das Eingabefeld vornehmen. Standardmässig ist die Helligkeit
auf einen Wert von 0 eingestellt.
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Vorschau Die Vorschau ermöglicht es Veränderung im Bild sofort sichtbar zu machen, um die Einstel-
lungen des Werkzeuges vor der Ausführung kontrollieren zu können.

7.5.4. Helligkeit-Kontrast

Das Werkzeug ”Helligkeit-Kontrast“ ermöglicht die Veränderung der Helligkeit und des Kontrastes der
aktuellen Ebene oder Auswahl. Das Werkzeug ist leicht zu benutzen, aber nicht sehr fortschrittlich. Die
Werkzeuge ”Werte“ und ”Kurven“ erlauben den gleichen Typ von Veränderungen, ermöglichen da-
bei aber helle Bildteile anders zu behandeln als dunkle. Kurz gesagt ermöglicht Ihnen das Werkzeug

”Helligkeit-Kontrast“ eine ”quick and dirty“ Einstellung der Werte, wenn aber exaktes Arbeiten und
zuverlässige Ergebnisse gefragt sind, sei Ihnen die Verwendung eines der anderen Werkzeuge empfoh-
len.

TIPP

Sie können mit dem Werkzeug sehr komfortabel arbeiten. Klicken Sie mit dem
Mauszeiger innerhalb des Bildes und bewegen Sie die Maus, während Sie die
Maustaste gedrückt halten. Ein Verschieben nach oben und unten erhöht, bezie-
hungsweise reduziert die Helligkeit. Wenn Sie die Maus nach links und rechts
bewegen, verringern beziehungsweise erhöhen Sie den Kontrast im Bild. Sobald
Sie die gewünschten Einstellungen gefunden haben, können Sie diese entwe-
der durch betätigen der OK Schaltfläche im Dialogfenster, oder durch drücken
der Enter Taste übernehmen.

7.5.4.1. Werkzeugaufruf

Sie haben verschiedene Möglichkeiten das Werkzeug ”Helligkeit-Kontrast“ zu aktivieren:

• Über das Menü Werkzeuge → Farben → Helligkeit-Kontrast im Bildfenster, sowie

• Mit einen Mausklick auf das Symbol im Werkzeugfenster, sofern die Farbwerkzeuge im Werk-
zeugfenster eingeblendet sind. Dies können Sie im Dialog ”Werkzeuge“ einstellen.

7.5.4.2. Dialogfenster Helligkeit und Kontrast anpassen

Abbildung 7.67. Das Dialogfenster des Werkzeuges ”Helligkeit-Kontrast“

Helligkeit Verschieben Sie den Schieberegler nach links, um das Bild abzudunkeln, oder nach rechts,
um das Bild aufzuhellen. Das Eingabefeld dient der Werteingabe im Bereich -127 bis 127.
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Kontrast Verschieben Sie den Schieberegler nach links, um den Kontrast des Bildes zu verringern oder
nach rechts, um ihn zu erhöhen. Das Eingabefeld dient der Werteingabe im Bereich -127 bis 127.

Vorschau Die Vorschau ermöglicht es Veränderung im Bild sofort sichtbar zu machen, um die Einstel-
lungen des Werkzeuges vor der Ausführung kontrollieren zu können.

7.5.5. Schwellwert

Das Werkzeug ”Schwellwert“ wandelt die aktive Ebene in ein Schwarz/Weiss Bild um, indem es den
eingestellten Schwellwert als Mass für die Trennung der schwarzen von den weissen Bildanteilen nutzt.
Anwendung findet das Werkzeug vor allem, um Auswahlen in Abhängigkeit von der Helligkeit des
Bildes zu erstellen.

7.5.5.1. Werkzeugaufruf

Sie haben verschiedene Möglichkeiten das Werkzeug ”Schwellwert“ zu aktivieren:

• Über das Menü Werkzeuge → Farben → Schwellwert im Bildfenster, sowie

• Mit einen Mausklick auf das Symbol im Werkzeugfenster, sofern die Farbwerkzeuge im Werk-
zeugfenster eingeblendet sind. Dies können Sie im Dialog ”Werkzeuge“ einstellen.

7.5.5.2. Dialogfenster Schwellwert anwenden

Abbildung 7.68. Das Dialogfenster des Werkzeuges ”Schwellwert“

Schwellwerteinstellung Im Bereich Schwellwerteinstellung des Dialogs werden die Helligkeitswerte
der aktuellen Ebene in einem Histogramm dargestellt. Durch Klicken mit der Maustaste können
Sie einen Helligkeitsbereich auswählen. Ausgewählte Histogrammbestandteile erscheinen im Bild
weiss, der Rest wird schwarz.

Vorschau Die Vorschau ermöglicht es Veränderung im Bild sofort sichtbar zu machen, um die Einstel-
lungen des Werkzeuges vor der Ausführung kontrollieren zu können.
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7.5.6. Werte

Das Werkzeug ”Werte“ bietet Ihnen Funktionalitäten, um das Histogramm der aktiven Ebene oder Aus-
wahl zu bearbeiten. Damit können Sie die Helligkeits- und Farbverteilung beeinflussen. Dies ermöglicht
es Ihnen zum Beispiel über- oder unterbelichtete Digitalfotos zu korrigieren, oder eine Gammawertkor-
rektur vorzunehmen.

7.5.6.1. Werkzeugaufruf

Sie haben verschiedene Möglichkeiten das Werkzeug ”Werte“ zu aktivieren:

• Über das Menü Werkzeuge → Farben → Werte im Bildfenster, sowie

• Mit einen Mausklick auf das Symbol im Werkzeugfenster, sofern die Farbwerkzeuge im Werk-
zeugfenster eingeblendet sind. Dies können Sie im Dialog ”Werkzeuge“ einstellen.

7.5.6.2. Dialogfenster Farbwerte anpassen

Abbildung 7.69. Das Dialogfenster des Werkzeuges ”Werte“

Kanal Diese Eigenschaft bestimmt auf welchem Kanal das Werkzeug ausgeführt wird. Es stehen fol-
gende Werte zur Auswahl: Wert beeinflusst die Helligkeit; Rot, Grün und Blau die jeweiligen
Farbkanäle; sowie Alpha, sofern vorhanden.

Quellwerte Dieser Bereich zeigt das aktuelle Histogramm des Bildes an. In diesem werden die Hel-
ligkeitswerte von dunkel bis hell darstellt. Unterhalb des Histogrammes befinden sich ein Farb-
verlauf, sowie drei dreieckige Regler Diese repräsentieren, korrespondierend mit den darunter
liegenden Pipetten, die dunklen, mittleren und hellen Bereiche des aktuellen Bildes.
Die Werte können auf drei Wegen verändert werden:

• Wie schon beschrieben, repräsentieren die drei Dreiecke dunkle, mittlere und helle Bildbe-
reiche. Der mittlere Regler repräsentiert dabei den Gammawert. Sie können diese Dreiecke
jeweils nach links oder rechts verschieben, um eine Veränderung der Helligkeit für diesen
Bildbereich sichtbar zu machen. Verschieben Sie zum Beispiel das mittleren Dreieck nach
rechts, wird das Bild zunehmend dunkler.
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• Alternativ zur Benutzung der Dreiecke, können Sie die Pipetten verwenden, um auf dunkle,
mittlere und helle Pixel im Bild zu klicken. Damit können die Pipetten Helligkeitswerte der
Pixel aufnehmen.

• Die Eingabefelder neben den Pipetten lassen eine direkte Werteingaben zu.

Zielwerte Die Zielwerte legen den Bereich fest, inden die Änderungen an den Quellwerten abgebildet
werden. Standardmässig bilden die Zielwerte den ganzen Helligkeitsbereich (0-255) ab. Indem
Sie die Dreiecke (Regler) nach links oder rechts schieben, können Sie den Abbildungsbereich ein-
schränken. Alternativ können Sie die beiden Eingabefelder verwenden, um direkt Werte einzutra-
gen.

Alle Kanäle Sie können Ihre vorgenommenen Änderungen in eine Datei abspeichern, um diese zu ei-
nem späteren Zeitpunkt wieder aufzurufen. Um die vorgenommenen Änderungen zu speichern,
benutzen Sie die Schaltfläche Speichern. Abgespeicherte Einstellungen lassen sich mit Hilfe der
Schaltfläche Öffnen wieder aufrufen. Bei Betätigung einer der Schaltflächen wird eine Dateiaus-
wahldialog angezeigt, mit welchem Sie die Datei speichern oder öffnen können.

Mit den im Bereich Alle Kanäle dargestellten drei Pipetten haben Sie schnellen Zugriff, um Hel-
ligkeitswerte aus dem Bild aufzunehmen. Diese Pipetten unterscheiden sich nicht von den bereits
für den Bereich Quellwerte Beschriebenen. Mit der Schaltfläche Auto, können Sie GIMP die Be-
lichtung des Bildes überlassen.

Vorschau Die Vorschau ermöglicht es Veränderung im Bild sofort sichtbar zu machen, um die Einstel-
lungen des Werkzeuges vor der Ausführung kontrollieren zu können.

EIGENSCHAFTEN

Abbildung 7.70. Eigenschaften des Werkzeuges ”Werte“

Obgleich das Werkzeug ”Werte“ in den Vorgabe-Einstellungen nicht im Werkzueugfenster enthalten
ist, verfügt es über Werkzeugeinstllungen. Diese Eigenschaften werden im Folgenden beschrieben:

Histogrammskala Diese zwei Eigenschaften haben die gleiche Funktion wie dei beiden Symbole ”Lo-
garithmisch“ und ”Linear“ im Dialogfenster.

Abtastgröße Mit diesem Schieberegler können Sie den Radius einstellen, welcher benutzt wird wenn
ein Farbwert aufgenommen wird.
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7.5.7. Kurven

Das Farbkurven Werkzeug ist das leistungsfähigste, aber auch das komplexeste Werkzeug, das GIMP
zur Bearbeitung der Tonwerte von Bildern zur Verfügung stellt. Es bedarf einiger Übung, um damit gute
Ergebnisse zu erhalten, aber wenn Sie es ersteinmal beherrschen, werden Sie begeistert sein. Das Werk-
zeug ermöglicht es Ihnen zum Beispiel gezielt die Schatten und Glanzlichter eines Bildes aufzuhellen
oder abzudunkeln. Dabei bestimmen Sie selbst, welche Tonwerte verstärkt oder abgeschwächt werden
sollen.

7.5.7.1. Werkzeugaufruf

Sie haben verschiedene Möglichkeiten das Werkzeug ”Kurven“ zu aktivieren:

• Über das Menü Werkzeuge → Farben → Kurven im Bildfenster, sowie

• Mit einen Mausklick auf das Symbol im Werkzeugfenster, sofern die Farbwerkzeuge im Werk-
zeugfenster eingeblendet sind. Dies können Sie im Dialog ”Werkzeuge“ einstellen.

7.5.7.2. Dialogfenster Farbkurven anpassen

Abbildung 7.71. Das Dialogfenster des Werkzeuges ”Kurven“

Kanal Sie können mit dieser Eigenschaft festlegen auf welchem Kanal das Werkzeug angewendet wer-
den soll. Es stehen fünf Möglichkeiten zur Auswahl: Wert (Helligkeit und Kontrast); die Farb-
kanäle Rot; Grün; und Blau (Farbsättigung); sowie, sofern vorhanden, der Alphakanal.

Kanal zurücksetzen Mit dieser Schaltfläche können Sie das Werkzeug in den Standardzustand zurücksetzen.

Symbole Linear and Logarithmisch Diese Schaltflächen erlauben es Ihnen festzulegen, ob das in der
Arbeitsfläche eingeblendete Histogramm linear oder logarithmischen dargestellt wird. Diese Wahlmöglichkeit
kann auch in den Werkzeugeigenschaften eingestellt werden.
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Bearbeitungsbereich Der Bearbeitungsbereich besteht aus einer weissen Fläche mit einem Raster von
Hilfslinien auf der in grauer Farbe das Histogramm des ausgewählten Kanales dargestellt ist.
Zusätzlich sehen Sie die aktuelle Kurve, welche Sie über Kontrollpunkte bearbeiten können. An
beiden Achsen der Fläche befinden sich Farbverläufe. Die x-Achse (horizontal) stellt die Einga-
bewerte dar, die y-Achse (vertikal) die Ausgabewerte. Der Farbverlauf auf der x-Achse unterteilt
sich in zwei Farbverläufe, sobald einer der Kontrollpunkte verschoben wird. Klicken Sie an einen
Punkt auf der Kurve, oder innerhalb der Fläche, so wird ein neuer Kontrollpunkt erzeugt und die
Kurve dem Kontrollpunkt angepasst.

Als Beispiel soll der Kontrollpunkt links unten dienen. Verschieben Sie diesen Kontrollpunkt in
einen helleren Bereich der y-Achse (nach oben), so werden die Ausgabewerte heller und letzten
Endes auch das Bild. Ähnlich verhalten sich die Werte, wenn die Kontrollpunkte in die x-Richtung
verschoben werden: dem Bild wird zunehmend die Sättigung entzogen und das Bild erscheint
zunehmend grauer.

TIPP

Sie werden einige Versuche und etwas Übung benötigen, um das Bild mit
Hilfe des Werkzeuges gezielt so zu bearbeiten wie es Ihren Vorstellun-
gen entspricht. Lassen Sie sich nicht entmutigen, Sie werden am Ende
durch sehr hochwertige Ergebnisse belohnt. Bis dahin können Sie jeder-
zeit alle hinzugefügten Kontrollpunkte wieder entfernen, indem Sie die Ka-
nal zurücksetzen Schaltfläche betätigen. Danach befindet sich der Dialog
wieder in der Vorgabe-Einstellung.

Alle Kanäle Sie können die vorgenommenen Kurveneinstellungen der Kanäle abspeichern, um Sie zu
einem späteren Zeitpunkt wieder aufrufen zu können. Um die Einstellunen zu speichern betätigen
Sie Speichern Schaltfläche und eine entsprechende Aufforderung zur Eingabe des Dateinamens
wird erscheinen. Mit der Öffnen Schaltfläche können Sie alte Kurveneinstellungen wieder aufru-
fen, indem Sie die Datei mit den gewünschten Kurveneinstellungen auswählen.

Kurventyp Der Kurventyp bestimmt zum Einen wie die Kurve in der Bearbeitungsfläche gezeichnet
wird, und zum Anderen, wie die Kurvenwerte auf das Bild übernommen werden. Es stehen ihnen
zwei Kurventypen zur Auswahl:

Weich: ist die Vorgabe-Einstellung. Bei Veränderungen zwischen Kontrollpunkten entsteht eine
weiche, geschwungene Kurvenform.

Freihand: ist ein Kurventyp, der die Möglichkeit bietet, mit dem Eingabegerät direkt in das Bear-
beitungsfenster zu zeichnen, wodurch eine exakte Kurvenform entsteht, die aber vielleicht grosse
Unterschiede im Bild sichtbar werden lässt.

Vorschau Die Vorschau ermöglicht es Veränderung im Bild sofort sichtbar zu machen, um die Einstel-
lungen des Werkzeuges vor der Ausführung kontrollieren zu können.

EIGENSCHAFTEN
Obgleich das Werkzeug ”Kurven“ in den Vorgabe-Einstellungen nicht im Werkzueugfenster enthalten

ist, verfügt es über Werkzeugeinstllungen. Diese Eigenschaften werden im Folgenden beschrieben:

Histogrammskala Diese beiden Einstellungen haben die gleiche Funktion, wie die Schaltflächen ”Li-
near“ und ”Logarithmisch“.
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Abbildung 7.72. Eigenschaften des Werkzeuges ”Kurven“

Abtastgröße Mit diesem Schieberegler können Sie den Radius einstellen, welcher benutzt wird wenn
ein Farbwert aufgenommen wird.

7.5.8. Posterisieren

Durch das Posterisieren Werkzeug können Sie die Farbanzahl einer Ebene oder Auswahl reduzieren.
Das bedeutet, dass die Farben in einem gewichteten Mass verringert, die Ähnlichkeit mit dem Aus-
gangsbild aber weitgehend beibehalten wird.

7.5.8.1. Werkzeugaufruf

Sie haben verschiedene Möglichkeiten das Werkzeug ”Posterisieren“ zu aktivieren:

• Über das Menü Werkzeuge → Farben → Posterisieren im Bildfenster, sowie

• Mit einen Mausklick auf das Symbol im Werkzeugfenster, sofern die Farbwerkzeuge im Werk-
zeugfenster eingeblendet sind. Dies können Sie im Dialog ”Werkzeuge“ einstellen.

7.5.8.2. Dialogfenster Posterisieren

Abbildung 7.73. Eigenschaften des Werkzeuges ”Posterisieren“

Farbanzahl Mit Hilfe des Schiebereglers kann die Stärke der Farbreduktion eingestellt werden. Die Far-
breduktion bezieht sich auf Intensitätswerte der einzelnen Farbkanäle. Aus weichen Farbübergängen
werden so gleichfarbige, zusammenhängende Flächen. Mit dem niedrigsten Wert 3 erhällt man 23

= 8 Farben.

Vorschau Die Vorschau ermöglicht es Veränderung im Bild sofort sichtbar zu machen, um die Einstel-
lungen des Werkzeuges vor der Ausführung kontrollieren zu können.
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7.6. Sonstige

7.6.1. Pfade

Abbildung 7.74. Das Werkzeug ”Pfade“ im Werkzeugfenster

Das Werkzeug ”Pfade“ ermöglicht es Ihnen, komplexe Auswahlen, sogenannte Bezier Kurven zu er-
stellen. Diese sind dem Lassowerkzeug ähnlich, haben aber zusätzlich alle Vorteile von Vektorkurven.
Diese Kurven werden mindestens durch einen Anfangs- und einen Endknoten begrenzt. Ursprünglich
kommt diese Technik aus dem Schiffbau, wo elastische Latten mit Gewichten beschwert werden, um
diese zu biegen. Hier stellen die Kontrollpunkte an den Knoten die Gewichte dar, um die Pfadlinien
zu modifizieren. Sie können mit diesem Werkzeug Pfade bearbeiten, mit den Pfaden malen, ja sie sogar
speichern und wiederherstellen. Spziell für die Pfade existiert in GIMP ein eigener Dialog.

7.6.1.1. Werkzeugaufruf

Sie haben verschiedene Möglichkeiten das Werkzeug ”Pfade“ zu aktivieren:

• Über das Menü Werkzeuge → Pfade im Bildfenster,

• Mit einen Mausklick auf das Symbol im Werkzeugfenster, sowie

• Über das Tastenkürzel B.

7.6.1.2. Tastenkombinationen (Vorgabe-Einstellungen)

Shift Die Taste Shift erfüllt verschiedene Funktionen, welche vom jeweiligen Kontext abhängen. Diese
sind im Abschnitt Eigenschaften ausführlich erklärt.

Strg Das Werkzeug ”Pfade“ stellt Ihnen drei verschiedene Modi zur Verfügung: Design, Bearbeiten
sowie Verschieben. Durch drücken der Taste Strg können Sie jederzeit zwischen den Modi De-
sign und Bearbeiten umschalten.

7.6.1.3. Eigenschaften

Übersicht Die aktuellen Einstellungen für das Werkzeug ”Pfade“ lassen sich durch einen Doppelklick

auf das Symbol anzeigen.
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Abbildung 7.75. Eigenschaften für das Werkzeug ”Pfade“

Werkzeugmodus Design Standardmässig befindet sich das Werkzeug immer im Modus Design. Pfad-
segmente lassen sich durch wiederholtes Klicken mit der Maustaste hinzufügen. Sie können die
Knotenpunkte in diesem Modus leicht durch anklicken und ziehen mit der Maus verschieben. Der
Abschnitt des Pfades zwischen den Knoten wird als Segment oder Pfadsegment bezeichnet.

TIPP

Um schnell einen Pfad zu schließen, halten Sie einfach die Taste Strg
gedrückt und klicken dann auf den ersten Kontrollpunkt des Pfades. In
früheren Versionen von GIMP wurde beim Klick in einen geschlossenen
Pfad dieser automatisch in eine Auswahl umgewandelt. Jetzt können Sie
hierzu die Schaltfläche Pfad aus Auswahl verwenden. Alternativ können
Sie auch die Schaltfläche Auswahl aus Pfad im Dialog Pfade verwenden.

In diesem Modus stehen Ihnen verschiedene Funktion zur Verfügung:

Neuen Knoten hinzufügen: Wenn sich der aktive Knoten (gekennzeichnet durch einen kleinen, leeren
Kreis), am Ende des Pfades befindet, erhält der Mauszeiger ein ’+’ Zeichen. Jedesmal wenn Sie jetzt
klicken, wird ein neuer Knoten erzeugt und durch ein neues Pfadsegment mit dem zuletzt aktiven
Knoten verbunden. Wenn sich der aktive Knoten nicht am Ende des Pfades befindet, ändert sich
der Mauszeiger zu einem Rechteck und Sie können durch Klicken eine neue Komponente zum
Pfad hinzufügen. Diese neue Komponente ist unabhängig vom bisherigen Pfad, jedoch gehört die
Komponente logisch zum Pfad, wie ein Blick auf den Dialog Pfade schnell zeigt. Durch gedrückt
halten der Taste Shift können Sie das Erzeugen einer neuen Komponente erzwingen.

Verschieben eines oder mehrer Knoten: Über einem Knoten positioniert, ändert sich der Mauszeiger
in ein Kreuz aus vier Pfeilen. Sie können dann durch klicken und ziehen den Knoten verschieben.
Sie können ausserdem mehrere Knoten auswählen, indem Sie die Taste Shift gedrückt halten,
mehrere Knoten anklicken und diese dann ziehen. Durch gleichzeitiges drücken von Strg–Alt,
können Sie den gesamten Pfad verschieben.

Pfadsegment bearbeiten: Wenn Sie ein Pfadsegment anklicken, ändert sich der Mauszeiger in ein
Kreuz aus vier Pfeilen. Sie können das Segment dann durck klicken und ziehen verbiegen. Sobald
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Sie dies tun, erscheinen an beiden Enden des Segmentes Kontrollpunkte. Durch verschieben dieser
Kontrollpunkte können Sie die Biegung des Segmentes steuern. Durch drücken der Taste Shift
können Sie die Kontrollpunkte in symmetrische Kontrollpunkte verwandeln.

Werkzeugmodus Bearbeiten Der Modus Bearbeiten stellt Ihnen Funktionen zur Verfügung, welche
im Modus Design nicht verfügbar sind. Im Modus Bearbeiten können Sie nur einen existierenden
Pfad bearbeiten. Ausserhalb eines Pfades ändert sich der Mauszeiger in einen durchgestrichenen
Kreis und es stehen keinerlei Funktionen zur Verfügung.

Ein Segment zwischen Knoten einfügen: Klicken Sie auf einen Knoten am Ende des Pfades. Der Maus-
zeiger ändert sich in ein Vereinigungssymbol. Klicken sie nun auf einen anderen Knoten, um beide
Knoten zu verbinden. Dieses Vorgehen ist sehr nützlich, um nicht geschlossene Komponenten zu
verbinden.

Ein Segment aus einem Pfad entfernen: Drücken Sie, während Sie Shift–Strg gedrückt halten, auf ein
Segment. Der Mauszeiger ändert sich in ’-’ und das Pfadsegment wird gelöscht.

Einen Knoten zu einem Pfad hinzufügen: Bewegen Sie den Mauszeiger über ein Pfadsegment. Der
Mauszeiger verwandelt sich in ein ’+’. Sobald Sie die Maustaste drücken, wird ein neuer Knoten
eingefügt.

Einen Knoten entfernen: Bewegen Sie den Mauszeiger über einen Knoten. Wenn Sie die Tasten Shift–
Strg gedrückt halten, verwandelt sich der Mauszeiger in ein ’-’. Durch Klicken wird der Knoten
gelöscht.

ACHTUNG

Beim Entfernen eines Knotens oder Pfadsegmentes erfolgt keine Sicher-
heitsabfrage. Natürlich steht Ihnen aber die übliche Funktion ”Rückgängig
machen“ zur Verfügung.

Werkzeugmodus Verschieben Mit dem Modus Verschieben lässt sich der gesamte Pfad verschieben.
Um den Pfad zu bewegen, reicht es aus, den Pfad mit einem Mausklick zu selektieren und bei
gedrückter Maustaste zu verschieben. Durch gedrückt halten der Taste Shift können Sie alle im
Bild befindlichen Pfade und Komponenten gleichzeitig verschieben.

Polygonal Mit dieser Optionen entfallen die Kontrollpunkte, so dass Sie nur gerade Linien erstellen
können.

Pfad aus Auswahl Diese Schaltfläche ermöglicht es eine Auswahl basierend auf einem Pfad zu erstel-
len. Die Auswahl wird von den üblichen ”Marschierenden Ameisen“ begrenzt. Beachten Sie, dass
die Auswahl nach wie vor zur Verfügung steht, das aktuelle Werkzeug ist immernoch ”Pfade“. Sie
können den Pfad weiterbearbeiten ohne die Auswahl zu verändern.

Wenn der Pfad nicht geschlossen ist, wird GIMP den Pfad automatisch durch ein gerades Segment
schliessen.

Pfad nachziehen In alten Versionen von GIMP konnten Sie diesen Befehl nur über ein kompliziertes
Untermenü erreichen. Nun können Sie die Funktion Pfad nachziehen direkt über diese Schalt-
fläche erreichen.

7.6.2. Farbpipette

Die Farbpipette erlaubt es, pixelweise Farben auf der aktuellen Ebene zu selektieren. Selektieren können
Sie eine Farbe, indem Sie einfach auf einen beliebigen Punkt des Bildes klicken. Durch die Benutzung
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Abbildung 7.76. Das Werkzeug ”Farbpipette“ im Werkzeugfenster

der Eigenschaft Vereinigung Abtasten lassen sich auch Farbwerte aufnehmen, welche durch die Farb-
mischung der Ebenen entstehen. Zusätzlich wird ein Informationsdialog angezeigt, der die wichtigsten
Informationen über die aktuell ausgewählte Farbe anzeigt.

7.6.2.1. Werkzeugaufruf

Sie haben verschiedene Möglichkeiten das Werkzeug ”Farbpipette“ zu aktivieren:

• Über das Menü Werkzeuge → Farbpipette im Bildfenster,

• Mit einen Mausklick auf das Symbol im Werkzeugfenster, sowie

• Über das TastenkürzelO.

• Durch gedrückt halten der Strg Taste, während Sie die Malwerkzeuge benutzen. Benutzen Sie die
linke Maustaste um die Vordergrundfarbe aufzunehmen.

7.6.2.2. Tastenbelegungen (Vorgabe-Einstellungen)

Tastenkürzel Die Taste O aktiviert die Farbpipette.

Strg Durch drücken der Taste Strg wird zwischen dem Setzen der Vordergrundfarbe und dem Setzen
der Hintergrundfarbe durch die Pipette umgeschaltet.

Shift Durch drücken der Taste Shift wird die Einstellung Zur Farbpalette hinzufügen umgeschaltet.

7.6.2.3. Eigenschaften

Aufruf Die Werkzeugeinstellungen für die Farbpipette lassen sich durch einen Doppelklick auf das

Symbol anzeigen.

Vereinigung abtasten Durch Anklicken des Kontrollkästchens ”Vereinigung abtasten”, werden Farb-
informationen selektiert, die durch Farbmischung entstehen. Die Sichtbarkeit der einzelnen Ebe-
nen beeinflusst das Mischverhältnis und dementsprechend die daraus resultierende Mischfarbe.
Weitere Informationen finden Sie im Glossar unter Vereinigung abtasten.
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Abbildung 7.77. Eigenschaften für das Werkzeug ”Farbpipette“

Abtastgröße Mit dem Schieberegler Radius können Sie die Abtastgrösse der Farbpipette einstellen.
Die Farbe wird über eine quadratische Fläche abgetastet und ergibt einen durchschnittlichen Farb-
wert. Bei der Farbselektion durch die Pipette, wird die aktive Fläche beim Klick auf die Ebene
visuell dargestellt. Der Radius kann einen Wert zwischen 1 und 30 annehmen.

Auswahlmodus

Nur auswählen Der aufgenommene Farbwert wird nur in einem Informationsdialog dargestellt.

Vordergrundfarbe ersetzen Standardmässig wird bei jeder Benutzung der Farbpipette der Farb-
wert der Vordergrundfarbe durch den aufgenommenen Farbwert ersetzt.

Hintergrundfarbe ersetzen Der Farbwert der Hintergrundfarbe wird durch den aufgenomme-
nen Farbwert der Pipette ersetzt.

Zur Farbpalette hinzufügen Wenn Sie diese Kontrollkästchen aktiviert haben, wird die mit der
Pipette aufgenommene Farbe zur aktuellen Farbpalette hinzugefügt. Hierzu öffnet sich der
Farbpaletteneditor.

7.6.3. Vergrößern / Verkleinern

Abbildung 7.78. Das Werkzeug ”Vergrößern / Verkleinern“ im Werkzeugfenster

Die Werkzeug ”Vergrössern / Verkleinern“ wird benutzt, um die Ansicht des Bildes zu verändern.
Vergrössern oder Verkleinern der Ansicht kann auch als Herein- oder Herauszoomen bezeichnet wer-
den. Wenn Sie einfach in das Bild hineinklicken wird das gesamte Bild vergrössert dargestellt. Sie
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können aber auch mit dem Werkzeug einen Rahmen im Bild aufziehen, um genau den ausgewählten
Bereich auf die Maße des Bildfensters zu vergrössern.

7.6.3.1. Werkzeugaufruf

Sie haben verschiedene Möglichkeiten das Werkzeug ”Vergrössern / Verkleinern“ zu aktivieren:

• Über das Menü Werkzeuge → Vergrössern bzw. Verkleinern im Bildfenster, sowie

• Mit einen Mausklick auf das Symbol

7.6.3.2. Tastenkombinationen (Vorgabe-Einstellungen)

Strg Durch drücken der Taste Strg können Sie jederzeit zwischen den Modi Vergrössern und Verklei-
nern umschalten.

7.6.3.3. Eigenschaften

Abbildung 7.79. Eigenschaften für das Werkzeug ”Vergrössern / Verkleinern“

Aufruf Die Eigenschaften für das Werkzeug lassen sich durch einen Doppelklick auf das Symbol
anzeigen.

Fenstergrösse beim Vergrössern und Verkleinern anpassen Wenn diese Eigenschaft aktiviert ist, wird
das umgebende Fenster, soweit erforderlich, der Grösse des Bildes angepasst.

Werkzeug Modus Hier können Sie einstellen, ob das Werkzeug in welchem der Modi Vergrössern oder
Verkleinern das Werkzeug arbeiten soll. Der nicht ausgewählte Modus lässt sich dabei jederzeit
durch gedrückt halten der Taste Strg aktivieren.

Schwelle Mit dieser Eigenschaft können Sie einstellen, wie gross das aufgezogene Rechteck zum zoo-
men sein muss, damit die Vergrößerung bzw. Verkleinerung ausgeführt wird. Ein hoher Wert er-
fordert ein grösseres Rechteck. Wenn der Wert zu klein ist, wird die Veränderung nur eine Stufe
betragen.
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Abbildung 7.80. Das Werkzeug ”Maßband“ im Werkzeugfenster

7.6.4. Maßband

Das Werkzeug wird benutzt, um Entfernungen oder Winkel im aktuellen Bild auszumessen. Wenn Sie
die Maustaste gedrückt halten, können Sie die Entfernung zur aktuellen Position des Mauszeigers mes-
sen. Die Messwerte können in der Statuszeile oder in einem Informationsfenster angezeigt werden.

Wenn Sie die Maustaste loslassen und über den zuerst gewählten Punkt bewegen, verwandelt sich
der Mauszeiger in ein Verschiebesymbol und Sie können den ersten Punkt verschieben.

7.6.4.1. Statuszeile

Die gemessenen Werte werden in der Statuszeile am unteren Rand des Bildfensters angezeigt. Es er-
scheinen zwei Zahlenpaare. Die erste Zahl beschreibt den Abstand zwischen dem ersten Messpunkt und
der aktuellen Position des Mauszeigers. Die zweite Zahl ist der Winkel. Dieser wird für den angezeigten
Quadranten im Wertebereich von 0° bis 90° gemessen.

7.6.4.2. Werkzeugaufruf

Sie haben verschiedene Möglichkeiten das Werkzeug ”Messen“ zu aktivieren:

• Über das Menü Werkzeuge → Massband im Bildfenster, sowie

• Mit einen Mausklick auf das Symbol

7.6.4.3. Tastenkombinationen (Vorgabe-Einstellungen)

Strg Durch gedrückt halten von Strg wird das Werkzeug in den Modus ”Beschränkte gerade Linie“ ge-
schaltet. Die Linie rastet jeweils immer bei einem Winkel, welcher einem vielfachen von 15 Grad
entspricht (z.B. 0, 15, 30, usw.), ein. Dies ist sehr hilfreich, wenn Sie exakt waagerechte oder senk-
rechte Linien zeichnen möchten.

Durch gedrückt halten von Strg und klicken auf den zweiten Messpunkt, erzeugen Sie eine hori-
zontale Hilfslinie.

Alt Durch gedrückt halten von Alt während des Verschiebens des Mauszeigers, wird die Messung mit
einer vertikalen Linie zwischen Anfangspunkt und Mauszeiger ausgeführt.

Durch drücken von Alt und klicken auf den Endpunkt, erzeugen Sie eine vertikale blau gestrichel-
te Hilfslinie.

Strg–Alt Durch gedrückt halten dieser Tastenkombination können Sie die komplette Messung inklusi-
ve Anfangs- und Endpunkt verschieben.
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Shift Durch gedrückt halten von Shift und einen Mausklick auf den zweiten Messpunkt, erzeugen Sie
eine weitere Messlinie. Klicken Sie nochmals mit der Maus um den dritten Messpunkt zu setzen.

7.6.4.4. Eigenschaften

Abbildung 7.81. Eigenschaften für das Werkzeug ”Maßband“

Aufruf Die einzige Eigenschaft des Maßbandes kann durch einen Doppelklick auf das Symbol auf-
gerufen werden.

Info-Fenster verwenden Durch aktivieren des Kontrollkästchens wird ein Informationsfenster mit den
aktuellen Messdaten angezeigt. Ausserdem werden die aktuellen Messdaten in der Statuszeile
angezeigt.

7.6.5. Text

Abbildung 7.82. Das Werkzeug ”Text“ im Werkzeugfenster

Das Textwerkzeug ermöglicht es Ihen auf dem aktuellen Bild, formatierten Text in der gewünschten
Form, Farbe und Schriftart zu zeichnen. Wenn Sie bei gewähltem Werkzeug in ein Bildfenster klicken,
öffnet sich ein Texteditor, in dem Sie den gewünschten Text eingeben können.

7.6.5.1. Werkzeugaufruf

Sie haben verschiedene Möglichkeiten das Werkzeug ”Text“ zu aktivieren:
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• Über das Menü Werkzeuge → Text im Bildfenster,

• Mit einen Mausklick auf das Symbol im Werkzeugfenster, sowie

• Über das Tastenkürzel T.

7.6.5.2. Eigenschaften

Abbildung 7.83. Eigenschaften für das Werkzeug ”Text“

Übersicht Die Werkzeugeigenschaften für das Textwerkzeug lassen sich durch ein Doppelklick auf das

Symbol anzeigen.

Schrift GIMP bietet Ihnen zwei verschiedene Möglichkeiten, die Schriftart auszuwählen. Zum Einen
kann die gewünschte Schriftart aus dem Schriftenbrowser ausgewählt werden, zum anderen über
den Dialog ”Schriften“, den Sie über das Menü Dialoge→Schriften im Bildmenü erreichen. Beide
Dialoge zeigen ein Beispieltext an, um Ihnen die Auswahl zu erleichtern.

Größe Die Größe beeinflusst die Höhe und die Breite des gezeichneten Textes. Zusätzlich kann die
Einheit der Grösse aus dem Klappmenü gewählt werden.

Hinting Hinting ist eine Methode um Buchstaben (Glyphen) fehlerfreier, auf das Bild zu zeichnen. Vor
allem bei kleinen Buchstaben kommt es vor, dass diese Darstellungsfehler aufweisen. Diese kom-
men durch Fehlinterpretation des Schriftenprozessors zustande. Die Informationen für das Hin-
ting werden von der Schriftart zur Verfügung gestellt. Mit diesen Informationen ist es dem Schrif-
tenprozessor dann möglich, die Darstellungsfehler für zu minimieren. Im direkten Vergleich sieht
Text, der ohne Hinting erzeugt wurde ausgefranst und unschön aus.

Auto-Hinting erzwingen Wenn die Eigenschaft Auto-Hinting erzwingen aktiviert ist, wird versucht
automatisch Informationen zur besseren Darstellung aus der Schriftart zu berechnen. Wie unter
Hinting beschrieben, werden diese Informationen normalerweise von der Schriftart selber zur
Verfügung gestellt. Der Auto-Hinter bietet eine Möglichkeit, die Darstellungsinformationen un-
abhängig von der Schriftart zu berechnen.

Kantenglättung Mit aktivierter Kantenglättung wird Text sehr viel weicher auf das Bild gezeichnet,
indem schräge Kanten weichgezeichnet werden. Dadurch kann vor allem bei großer Schrift die
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Lesbarkeit erheblich gesteigert werden. Jedoch bewirkt die Kantenglättung bei sehr kleiner Schrift
leider genau das Gegenteil. Der Text ist nur noch schwer lesbar und wirkt verschwommen. Vor
allem bei Schriften mit einer konstanten Schriftgrösse (Pixelschriftarten) ist die Kantenglättung
nicht zu empfehlen.

Farbe Klicken Sie auf die Schaltfläche, um aus dem erscheinenden Farbendialog die Textfarbe aus-
zwählen.

TIPP

Alternativ können Sie auch eine Farbe aus dem Werkzeugfenster
auswählen und die ausgewählte Farbe auf den Text ziehen.

Ausrichtung Die Ausrichtung bestimmt die Anordnung des mehrzeiligen Textes. So besteht die Möglichkeit,
Text zentriert, links- oder rechtsbündig auszurichten. Blocksatz ist nur dann sinnvoll, wenn der
Text durch Silbentrennung auch richtig umgebrochen werden kann. So ist diese Einstellung im
Moment noch als optional anzusehen.

Einzug Der Einzug bestimmt bei mehrzeiligen Texten den Grad der Einrückung der ersten Zeile. Mit
einem Einzug ist es möglich Absätze besser zu kennzeichnen und die Lesbarkeit zu erhöhen.

Zeilenabstand Der Zeilenabstand bestimmt den Leerraum zwischen den Zeilen. Diese Option hat kei-
ne Auswirkung auf einzeiligen Text.

Pfad aus Text erzeugen Es ist möglich, die Umrisse des Textes als Pfad darzustellen. Mit dem Pfad-
werkzeug lässt sich der Text weiter modifizieren und verformen.

7.6.5.3. Text Editor

Abbildung 7.84. Eigenschaften für das Werkzeug ”Text Editor“

Aufruf Das Dialogfenster ”Text Editor“ öffnet sich, sobald Sie mit aktiviertem Textwerkzeug in ein Bild
klicken. Es ist ein einfacher Texteditor, der es erlaub mehrere Zeilen Text einzugeben. Automa-
tische Zeilenumbrüche sind nicht möglich, Sie müssen diese unter Verwendung der Enter Taste
einfügen, um zur nächsten Zeile zu gelangen.

Den Text, den sie eingeben erscheint sofort im Bild, in einer rechteckigen Auswahl, welche ihre
linke obere Ecke an der Stelle im Bild hat, die Sie angeklickt haben.
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Sie können den eingegebenen Text korrigieren und Sie können die Schriftart ändern.

Sie können den Text im Bild mit dem Werkeug ”Verschieben“ bewegen, aber Sie verlieren dann
den Texteditor. Wie Sie den Text dann weiter bearbeiten können, wird im jetzt beschrieben.

Sobald Sie mit dem Schreiben beginnen, wird eine Textebene im Ebenedialog erzeugt. In einem
Bild mit einer solchen Ebene können Sie den Text jederzeit weiterbearbeiten, indem Sie auf die
Ebene doppelklicken.

Um einen weiteren Text in das Bild einzufügen aktivieren Sie eine Ebene die keine Texteben ist.
Ein neuer Texteditor wird angezeigt und eine neue Textebene angelegt.

Öffnen Mit dem Dateidialog lässt sich eine Textdatei öffnen, deren Inhalt dann im Eingabefenster des
Editors erscheint.

Löschen Hiermit lässt sich der gesamte Text aus dem Eingabefenster des Editors löschen.

Von Links nach Rechts Der Text wird von links nach rechts geschrieben, wie es in den westlichen und
auch vielen östlichen Sprachen gebräuchlich ist.

Von Rechts nach Links Der Text wird von rechts nach links geschrieben, wie es beispielsweise in he-
bräischer und arabischer Sprache üblich ist.

7.7. Farb- und Pinsel-, Muster-, Verlaufsübersicht

7.7.1. Farbübersicht

Abbildung 7.85. Farbübersicht in der Werkzeugleiste

Farbübersicht Der Farbbereich besteht aus zwei Farbindikatoren. Zum einen zeigt das linke Viereck
die Vordergrund- und das rechte Viereck die Hintergrundfarbe. Standardmässig sind beide Indi-
katoren auf Schwarz und Weiss gestellt. Durch einen Doppelklick auf das jeweilige Symbol errei-
chen Sie den Farbauswahldialog. Hier können Sie die Farbe aussuchen, die Sie gern als Vorder-
oder Hintergrundfarbe benutzen möchten. Die Farbindikatoren nehmen die Farbe an, die Sie im
Farbauswahldialog bestätigt haben.

Standardfarben Klicken Sie auf das Symbol für Standardfarben (schwarz, weiss), um den Farbbereich
wieder auf Schwarz und Weiss zu setzen.

Farben vertauschen Durch klicken auf das Pfeilsymbol können Sie die Vorder- und Hintergrundfarbe
miteinander vertauschen.

161



7.7. FARB- UND PINSEL-, MUSTER-, VERLAUFSÜBERSICHT KAPITEL 7. WERKZEUGE

7.7.2. Pinsel-, Muster-, Verlaufsübersicht

Abbildung 7.86. Active tool indicator area

In diesem Teil des Werkzeugfensters haben Sie mit einem Mausklick Zugriff auf die Pinsel-, Muster-
und Farbverlaufsauswahl.
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8. Dialoge

8.1. Allgemeines zu Dialogen

Dialoge in GIMP sind Fenster, mit denen Sie Eigenschaften von Bildern und Werkzeugen anzeigen und
verändern und GIMP verwalten können. Das Besondere an Dialogen ist, dass sie diese ständig geöffnet
lassen und ganz nach Belieben anordnen und in Docks zusammenfassen können.

8.2. Bildaufbau bezogene Dialoge

Die Dialoge dieser Gruppe ermöglichen Ihnen die Kontrolle und Manipulation von Bildstrukturen wie
Ebenen, Kanälen oder Pfaden.

8.2.1. Der Dialog ”Ebenen“

Abbildung 8.1. Ansicht des Dialoges ”Ebene“

Der Ebenendialog dient der Verwaltung von Ebenen. Die Anordnung mehrerer Ebenen kann man
sich wie viele übereinander gelegte Blätter transparenten Papiers vorstellen. Diese ergeben bei Drauf-
sicht ein Gesamtbild. Durch die Benutzung von Ebenen kann man ein Bild aus verschiedenen Bestand-
teilen zusammensetzen. Die einzelnen Elemente lassen sich unabhängig voneinander bearbeiten. Der
Hintergrund des Bildes ist die unterste Ebene im Dialog. In allen Ebenen darüber sind die Elemente des
Vordergrundes enthalten.

8.2.1.1. Dialogaufruf

Der Dialog ”Ebenen“ kann mit anderen Dialogen gruppiert werden. Weitere Informationen dazu finden
Sie im Abschnitt 2.1.3 auf Seite 23. Sie können den Dialog auf verschiedene Arten sichtbar machen:

• aus dem Werkzeugfenstermenü: Datei → Dialoge → Ebenen

• aus dem Bildmenü: Dialog → Ebenen

• aus einem anderen Dialogmenü: Reiter hinzufügen → Ebenen

• über ein Vorgabe-Tastenkürzel: Strg–L
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Abbildung 8.2. Ein Bild mit mehreren Ebenen

(a) Ebenen des Bildes (b) Wirkung der Ebe-
nen im Bild

8.2.1.2. Aufbau und Benutzung des Dialoges ”Ebenen“

Übersicht Die Ebenen werden im Ebenendialog als Liste von Miniaturbildern angezeigt. Der Hinter-
grund des Bildes ist die unterste Ebene im Dialog. In allen Ebenen darüber sind die Elemente des
Vordergrundes enthalten. Der untere Bereich des Ebenendialogs bietet Schaltflächen zur Verwal-
tung der Ebenen. Mit einem rechten Mausklick auf eine Ebene, öffnet sich deren Kontextmenü.

Ebenenattribute Jeder Ebene können Attribute zugeordnet werden, die mit einem linken Mausklick
erfolgen. So können folgende Attribute für eine Ebene vergeben werden:

Sichtbarkeit der Ebene Standardmäßig ist jede Ebene sichtbar. Dies wird durch ein Augen-
symbol repräsentiert. Um die Ebene unsichtbar zu machen, klicken Sie auf das Auge mit der
linken Maustaste. Um die Ebene wieder sichtbar werden zu lassen, klicken Sie erneut mit der
linken Maustaste auf die linke Schaltfläche dieser Ebene. Das Augensymbol erscheint dann
wieder.

Ebenen verankern Um die Inhalte verschiedener Ebenen simultan zu verschieben, müssen
diese miteinander verkettet werden. Klicken Sie hierzu auf das Kettensymbol rechts neben
dem oben genannten Augensymbol. Wiederholen Sie diesen Schritt für jeder Ebene, die mit
verkettet werden soll. Ein erneuter Klick auf diese Schaltfläche löst die Verkettung der jewei-
ligen Ebene wieder. Das Kettensymbol verschwindet.

Ebenenname Um eine Ebene umzubenennen, genügt ein Doppelklick mit
der linken Maustaste auf den angezeigten Ebenennamen (z.B. Hintergrund). In dem Einga-
befeld können Sie jetzt einen anderen Namen eintragen.

TIPP

In GIMP können Sie nicht nur einfache Namen für eine Ebene vergeben.
Für die Erstellung von Animationen bietet GIMP die Möglichkeit, Zeitanga-
ben hinter den Ebenennamen zu schreiben. Die Parameter werden stets
in Klammern geschrieben und erklären sich wie folgt: Die Verzögerung in
gibt an, nach wieviel Millisekunden die nächste Ebene in der Animation
angezeigt wird, z.B. Ebenenname (100 ms). Die Angabe des Kombinati-
onsmodus ist optional. Dieser Parameter gibt an, ob die aktuelle Ebene mit
der nächsten Ebene ersetzt (replace) oder kombiniert (combine) werden
soll, z.B. Ebenenname (100 ms) (replace).
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Ebeneneigenschaften Für jede aktuell ausgewählte Ebene können Eigenschaften spezifiziert werden,
die sich im oberen Bereich des Dialoges befinden.

Abbildung 8.3. Ebenenmodi

Ebenenmodi

Mit Ebenenmodi lassen sich Ebenen untereinander überblenden. Genau beschrieben sind die
zur Verfügung stehenden Modi im Glossar.

Abbildung 8.4. Transparenz behalten

Transparenz behalten

Um transparente Bildbereiche einer Ebene nicht aus versehen mit Farbe zu füllen, kann dieses
Kontrollkästchen angeklickt werden. Danach können in transparenten Bereichen einer Ebene
keine Maloperationen ausgeführt werden. Denken Sie daran, dass Operationen die transpa-
rente Beeinflussen (z.B. Weichzeichner) nicht zu dem Resultat führen, wenn diese Option
nicht gesetzt ist.

Abbildung 8.5. Deckkraft

Deckkraft

Der Schieberegler und das Eingabefeld daneben, lassen die Deckkraft der Ebene zu den an-
deren einstellen. Ist die Deckkraft auf 0 gesetzt, ist die Ebene vollkommen durchscheinend
und somit unsichtbar. Standardmässig haben Ebenen eine Deckkraft von 100, wodurch Sie
vollkommen sichtbar sind. Werte dazwischen regeln die Deckkraft der Ebene.

Ebenen verwalten Im unteren Bereich des Ebenendialogs befinden sich Schaltflächen die der Verwal-
tung der Ebenen dienen.

Ebeneneigenschaften bearbeiten Diese Schaltfläche bietet die Möglichkeit den Namen der
Ebene zu verändern.

165



8.2. BILDAUFBAU BEZOGENE DIALOGE KAPITEL 8. DIALOGE

Neue Ebene Durch klick auf die Schaltfläche wird eine transparente Ebene mit Standardna-
men angelegt. Den Dialog zur Erstellung einer neuen Ebene erhalten Sie, indem Sie die Shift
Taste gedrückt halten, während Sie auf die Schaltfläche klicken. In dem sich nun öffnenden
Dialog können Sie einen Ebenennamen vergeben, sowie Höhe, Breite und die Ebenenfüllart
bestimmen.

Ebene anheben Die Ebene kann um einen Schritt in der Ebenenliste nach oben verschoben
werden. Um die Ebene an den Anfang der Liste (oben) zu verschieben, halten Sie bitte die
Shift Taste gedrückt.

Ebene absenken Die Ebene kann um ein Schritt nach unten verschoben werden. Möchten Sie
die Ebene an das Ende der Liste (unten) verschieben, halten Sie bitte die Shift Taste gedrückt.

TIPP

Standardmäßig ist jede Ebene sichtbar. Dies wird durch ein Augen-
symbol repräsentiert. Um die Ebene unsichtbar zu machen, klicken
Sie auf das Auge mit der linken Maustaste. Um die Ebene wieder
sichtbar werden zu lassen, klicken Sie erneut mit der linken Maustaste
auf die linke Schaltfläche dieser Ebene. Das Augensymbol erscheint
dann wieder.

Ebene duplizieren Erstellen Sie eine Kopie der aktuell ausgewählten Ebene, indem Sie auf
die Schaltfläche klicken.

Schwebende Auswahl verankern Bei einer schwebenden Auswahl , (temporäre Ebene)
kann diese Ebene wieder mit der vorhergehenden Ebene verankert werden. Die vorherge-
hende Ebene ist jeweils die Ebene, aus der die schwebende Auswahl erstellt wurde.

Ebene löschen Durch klicken auf die Schaltfläche löschen Sie die aktuell, ausgewählte Ebe-
ne.

8.2.1.3. Ebenenmaske

Abbildung 8.6. Ansicht des Dialogfensters ”Maske hinzufügen“
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Allgemeines Für jede Ebene können transparente Masken hinzugefügt werden, die sich Ebenenmas-
ken nennen. Eine Ebenenmaske hat die gleiche Grösse und Pixeldichte wie die dazugehörige Ebe-
ne. So ist es möglich, jeden Pixel der Ebenenmaske einen Transparenzwert zuzuordnen. Die Maske
selber ist eine Grauwertmaske, so dass jedem Pixel einen Wert von 0 für Schwarz bis 255 für Weiss
zugeordnet werden kann. Einen schwarzen Pixel bedeutet hierbei ein transparenter Pixel, wobei
Weiss den Pixel der Ebene nicht beeinflusst.

Um eine Ebenenmaske zu erstellen, klicken Sie mit der rechten Maustaste auf eine Ebene und
das Ebenenkontextmenü aufzurufen. Hier klicken Sie auf den Menüpunkt Ebenenmaske hin-
zufügen. Sollte der Menüpunkt Ebenenmaske hinzufügen ausgegraut sein, fehlt dem Bild ein
Alpha-Kanal. Den fügen Sie, durch ein Klick auf den Menüpunkt Alphakanal hinzufügen, hinzu.

Nach einem Mausklick auf den Menüpunkt Ebenenmaske hinzufügen, erscheint ein Dialog.
Hier können Sie einstellen, was für eine Eigenschaft die neu erstellte Ebenenmaske haben soll:

ACHTUNG

Da die Ebenenmaske die Transparenz einer einzelnen Ebene beeinflusst,
sollte bei vielen Ebenen darauf geachtet werden, dass die Alphatranspa-
renz das gesamte Bild beeinflusst.

• Weiß (volle Deckkraft): die neu erstellte Ebenenmaske hat keinen Effekt auf die Ebene. Alle
Pixel der Ebene sind sichtbar.

• Schwarz (volle Transparenz): alle Pixel der Ebene sind mit der Ebenenmaske transparent.

• Alphakanal der Ebene: Die Maske wird mit den Werten des Alphakanals initialisiert.

• Alphakanal der Ebene übernehmen: Der einzige Unterschied wenn Sie diese Einstellung
wählen, besteht darin, dass auch der Alphakanal der Eben auf volle Deckkraft gesetzt wird.

• Auswahl: Die Ebenenmaske wird nach den Werten der Auswahl erstellt.

• Graustufen-Kopie der Ebene: Die Ebenenmaske wird nach den Graustufenwerten des Bil-
des erstellt.

• Maske invertieren: Bei aktivieren des Kontrollkästchens wird die Ebenenmaske invertiert
angelegt.

Die angelegte Ebenenmaske wird als Miniaturbild im Ebenendialog angezeigt. Die jetzt aktivierte
Ebenenmaske können Sie zum Beispiel mit dem Pinselwerkzeug bearbeiten. Durch malen im Bild
wird nun die Ebenenmaske verändert. Möchten Sie das Bild selber bearbeiten, reicht ein Mausklick
im Ebenendialog auf das Miniaturbild der Ebene. Der Ebenendialog markiert das gerade aktive
Element (Ebenenmaske oder Ebene) durch eine Umrandung.

ACHTUNG

Da die Ebenenmaske die Transparenz einer einzelnen Ebene beeinflusst,
sollte bei vielen Ebenen darauf geachtet werden, dass die Alphatranspa-
renz das gesamte Bild beeinflusst.

8.2.2. Der Dialog ”Kanäle“

Der Kanaldialog dient der Verwaltung der Kanäle. Der Dialog is in zwei Bereiche aufgeteilt. Der obere
Bereich zeigt die Farbkanäle des jeweiligen Bildes und der untere Bereich angelegte Auswahlmasken.
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Abbildung 8.7. Ansicht des Dialoges ”Kanäle“

Die Bedienung gestaltet sich ähnlich dem Ebenendialog. In der linken Spalte befinden sich Augensym-
bole, die für die Sichtbarkeit des jeweiligen Kanales zuständig sind. Daneben befinden sich graustufige
Miniaturbilder, bei denen weisse Bereiche 100% und schwarze Bereiche 0% der Primärfarbe ausmachen.
Bilder mit einem Alphakanal besitzen einen Eintrag der Alpha heißt. Dieser Kanal repräsentiert Trans-
parenzwerte des Bildes, wobei auch hier wiederum gilt: weiss heisst hundertprozentige Deckkraft der
Pixel und schwarz völlige Durchsichtigkeit (Transparenz).

Die Farbkanäle des Bildes basieren auf dem RGB-Farbmodell. So kann das Gesamtbild jeweils in einen
roten, grünen und blauen Kanal aufgeteilt werden, so dass jeder Kanal einen entsprechenden Farbwert
pro Pixel im Bild repräsentiert. Indizierte Bilder besitzen nur einen Kanal, der den Namen Indexed
trägt. Bei Bildern die von Grund auf keinen Alphakanal besitzen, wird dieser im Kanaldialog nicht
angezeigt. Dieser kann jedoch aus dem Ebenendialog hinzugefügt werden. GIMP erstellt automatisch
einen Alphakanal, bei einem Bild mit mehreren Ebenen.

ANMERKUNG

GIMP unterstützt noch keine CMYK und YUV Farbmodelle.

Abbildung 8.8. Bildkomposition durch die Farbkanäle

Das rechte Beispielbild besteht aus den vier Kanälen auf der linken Seite (Rot, Grün und Blau, Alpha).
Hervorzuheben ist hier die rote Nikolausmütze des Wilber. Diese ist nur im roten Kanal sichtbar. In den
anderen Kanälen taucht sie nicht auf.

8.2.2.1. Dialogaufruf

Der Kanaldialog kann auf verschiedenen Wegen erreicht werden:

• aus dem Werkzeugfenstermenü: Datei → Dialoge → Kanäle
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• aus dem Bildmenü: Dialoge → Kanäle

• aus einem anderen Dialogmenü: Reiter hinzufügen → Kanäle

8.2.2.2. Aufbau und Benutzung des Dialoges ”Kanäle“

Übersicht Die Farbkanäle und der Alphakanal können über diesen Dialog nicht gelöscht werden.
Jeder Kanal erscheint in der Liste in Form eines Vorschaubildes. Ein Rechtsklick hierauf öffnet das Ka-
nalmenü.

Kanalattribute Jeder Kanal hat drei Attribute, die ähnlich wie die Ebenenattributen verwendet wer-
den können.

Augensymbol Standardmäßig ist jeder Kanal und somit jeder Farbanteil eines Bildes für den Be-
nutzer sichtbar. Um die Sichtbarkeit eines Kanals zu verändern, genügt ein Linksklick auf das
Augensymbol. Hierdurch wird der entsprechenden Farbanteil des Bildes ausgeblendet. Das Au-
gensymbol verschwindet aus der Spalte verschwindet. Durch wiederholtes Klicken in den Leer-
raum wird der Farbanteil des Kanals im Bild wieder sichtbar.

Kanalname Die Namen der Primärkanäle (Rot, Grün, Blau, Alpha) können nicht verändert werden.
Kanäle die im unteren Bereich des Kanaldialogs angelegt werden lassen sich durch einen Dop-
pelklick umbenennen.

Kettensymbol Neu angelegte Kanäle in der unteren Hälfte des Dialogs können mit Hilfe des Ket-
tensymbols gruppiert werden. Hierdurch sich auf die gruppierte Kanäle simultan Operationen
ausführen.

Für die Primärkanäle gibt es ebenfalls eine Gruppierungsmöglichkeit. Standardmäßig werden
Operationen auf alle Kanäle ausgeführt, da jeder Kanal selektiert (farbig hinterlegt) ist. Sie können
einzelne Kanäle aus der Gruppierung entfernen, indem Sie mit einem Mausklick auf den Namen
des Kanals klicken und somit die Auswahl aufheben. Klicken sie nochmals auf den Namen ist der
Kanal wieder mit auszuwählen.

Kanäle verwalten Im unteren Bereich des Kanaldialogs befinden sich Schaltflächen die der Verwal-
tung der Kanäle dienen. Bitte denken Sie daran, dass sich die Verwaltung der Kanäle auf neu angelegte
Kanäle im unteren Dialogbereich bezieht.

Kanaleigenschaften bearbeiten Diese Schaltfläche bietet die Möglichkeit den Namen des Ka-
nals, die Deckkraft und die Indikatorfarbe zu verändern. Die Veränderung der Deckkraft ist ana-
log zur Deckkraft von Ebenen einzustellen.

Neuer Kanal Durch klick auf die Schaltfläche wird ein neuer Kanal angelegt, der eine Deckkraft
von 50% und einen Standardnamen trägt. Möchten Sie einen Dialog zur Erstellung eines neuen
Kanals sehen, halten Sie die Shift Taste gedrückt, während Sie auf die Schaltfläche klicken. Sie
können in dem jetzt erscheinenden Dialog einen Kanalnamen und die Deckkraft bestimmen.

Kanal anheben Der Kanal kann um einen Schritt in der Kanalliste nach oben verschoben werden.
Um den Kanal an den Anfang der Liste (oben) zu verschieben, halten Sie bitte die Shift Taste
gedrückt.
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Kanal absenken Der Kanal kann um ein Schritt nach unten verschoben werden. Möchten Sie den
Kanal an das Ende der Liste (unten) verschieben, halten Sie bitte die Shift Taste gedrückt.

Kanal duplizieren Erstellen Sie eine Kopie des aktuell, ausgewählten Kanals, indem Sie auf die
Schaltfläche klicken.

TIPP

Farbkanäle und der Alphakanal aus dem oberen Bereich des Dialogs
können ebenfalls dupliziert werden.

Auswahl aus Kanal Aus dem aktuellen Kanal kann eine neue Auswahl erstellt werden. Sie können
durch Tastendruck beeinflussen, wie die neu erstellte Auswahl Auswirkung auf bereits angelegten
Auswahlen hat:

• Shift: Die Auswahl aus dem Kanal wird zur vorhandenen Auswahl hinzugefügt.

• Strg: Die Auswahl aus dem Kanal wird von der vorhandenen Auswahl abgezogen.

• Shift–Strg: Es wird eine neue Auswahl erstellt, die aus der Schnittmenge der Kanalauswahl
und der vorhandenen Auswahl besteht.

Kanal löschen Über diese Schaltfläche wird der aktuell ausgewählten Kanal gelöscht.

8.2.2.3. Das Kontextmenü des Dialoges ”Kanäle“

Abbildung 8.9. Inhalt des Kontextmenüs

Übersicht Das Kanalmenü kann mit einem rechten Mausklick auf einen Kanalnamen aufgerufen wer-
den. Das Kanalmenü bietet ähnliche Funktionen wie das Ebenenkontextmenü. Durch einen Klick
auf einen Menüeintrag wird die Funktion auf die aktuell ausgewählten Ebene ausgeführt.

• Die Hilfe für die Menüeinträge Kanaleigenschaften, Neuer Kanal, Kanal anheben, Kanal
absenken, Kanal duplizieren, Kanal löschen finden Sie unter der Beschreibung der Kanal-
schaltflächen.

• Auswahl aus Kanal: Aus dem aktuellen Kanal kann eine neue Auswahl erstellt werden. Die
neu angelegte Auswahl ersetzt alle vorhandenen Auswahlen.

• Zur Auswahl hinzufügen: Die Auswahl aus dem Kanal wird zur vorhandenen Auswahl
hinzugefügt.
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• Von Auswahl abziehen: Die Auswahl aus dem Kanal wird von der vorhandenen Auswahl
abgezogen.

• Mit Auswahl schneiden: Es wird eine neue Auswahl erstellt, die durch die Schnittmenge der
Kanalauswahl und der vorhandenen Auswahl entsteht.

8.2.2.4. Auswahlmasken

Abbildung 8.10. Eine Auswahl erstellt aus verschiedenen Kanälen

Kanäle können benutzt werden um Auswahlen zu speichern und wieder herzustellen. Es gibt zahl-
reiche Auswahlwerkzeuge im Gimp, mit denen neue Auswahlen erstellt werden können. Auch Quick-
Masks können in einen Kanal gespeichert werden.

Erstellen von Auswahlmasken Erstellen Sie eine Auswahl mit einen Auswahlwerkzeug. Danach überführen
Sie die erstellte Auswahl in ein Kanal.

Benutzen Sie dafür über das Bildmenü Auswahl/In Kanal speichern. Danach erscheint ein neuer
Kanal mit einem Miniaturbild im Kanaldialog. Standardmässig ist die erstellte Auswahlmaske
nicht sichtbar; dem Kanal fehlt das gesetzte Augensymbol.

Möchten Sie die gespeicherte Auswahl aus dem Kanal wieder herstellen, benutzen Sie dazu die
Auswahl aus Kanal Schaltfläche.

Auswahlmasken benutzen Sobald Sie eine Auswahl in einen Kanal gespeichert haben, können Sie
diese Auswahl bearbeiten. Die Bearbeitung des Kanals erfolgt vorrangig mit Malwerkzeugen. Die aus-
gewählten Farben spielen hier eine besondere Rolle.

Benutzen Sie die Farbe Weiss um die erstellte Auswahl zu vergrössern und die Farbe Schwarz um
die Auswahl zu verkleinern. Nur durch die Benutzung der beiden Farbarten, können erzeugen Sie ei-
ne Auswahl mit harten Kanten, d.h. das Ende der Auswahl wird durch die Schwarze Farbe bzw. der
laufenden Ameisen gekennzeichnet.

Möchten Sie die Auswahl langsam ausblenden, benutzen Sie Farben die sich zwischen Schwarz und
Weiss befinden, also Grautöne. Je höher der Anteil von Weiss im Grau ist, desto durchsichtiger ist die
Auswahl.

ACHTUNG

Solang die Auswahlmaske aktiviert ist (gekennzeichnet durch das gesetzte Au-
gensymbol des Kanals), haben die eingesetzten Werkzeuge nur auf die Aus-
wahlmaske einen Effekt.
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8.2.2.5. Schnell-Maske (QuickMask)

Abbildung 8.11. Dialog ”Schnelle Maske“

Eine Schnelle Maske ist eine besondere Form der Auswahlmaske und wird vorrangig dafür genutzt,
um schnell (engl. für quick) neue Auswahlen mit einem Pinselwerkzeug zu erstellen. So lassen sich vor
allem sehr feine und auf ein Bildobjekt angepasste Auswahlen erstellen, wo die primären Auswahl-
werkzeuge an Ihre Grenzen stossen.

Werkzeugaufruf

• Durch einen Mausklick auf die Schaltfläche die sich in der rechten, unteren Ecke des Bildfensters
befindet, aktivieren Sie die Schnelle Maske.

• Eine Schnelle Maske lässt sich über das Bildmenü aufrufen: Auswahl → In Kanal speichern.

• Ebenfalls kann die Schnelle Maske über das Tastenkürzel: Shift–Q aufgerufen werden.

Erstellen einer Schnelle Maske Die Schnelle Maske wird durch einen Klick auf die Schaltfläche in
der linken, unteren Ecke des Bildfensters aktiviert. Standardmässig wird das Bild nun rötlich eingefärbt,
welches die Maske präsentiert. Ist eine Auswahl vor aktivieren der Schnelle Maske aktiv, so wird die
bestehende Auswahl als durchscheinender Bildbestandteil sichtbar. Der Schnelle Masken-Modus kann
mit einem weiteren Klick auf die linke, untere Schaltfläche beendet werden. Dann werden die vorge-
nommenen Änderungen im Schnelle Masken-Modus in eine Auswahl konvertiert.

Bei aktiver Schnelle Maske, erscheint ein Eintrag mit dem Namen Qmask im Kanaldialog. Die Sicht-
barkeit, sowie andere Kanalattribute können wie alle anderen Auswahlmasken mit einem Klick auf das

Augensymbol beeinflusst werden. Die Füllfarbe der Quickmask kann über die Schaltfläche der
Kanaleigenschaften verändert werden.

Um eine neue Auswahl über die Schnelle Maske anzulegen, benutzen Sie einfach ein Pinselwerkzeug
ihrer Wahl. Benutzen Sie die Farbe Weiss um die neue Auswahl zu erstellen. Sie werden merken, dass
die Deckkraft des rötlichen Farbtons der Quickmask durch das malen im Bild entfernt wird. Wenn Sie
Schwarz als Malfarbe benutzen, wird die Auswahl entfernt. Kennzeichnend ist hier wiederum, das der
rötliche Farbton der Quickmask das Bild füllt.

Benutzen von Schnelle Maske ***
BESCHREIBUNG
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*. Ansicht des Bildfensters bei eingeschalteter Schnelle Maske: Zur Verdeutlichung wie Grautöne in
einer Schnelle Maske eingesetzt werden können, wurde ein Farbverlauf auf die Schnelle Maske
angewendet. Der Farbverlauf verläuft von Schwarz (links) nach Weiss (rechts).

*. Das Bildfenster bei ausgeschalteter Schnelle Maske und der daraus erstellten Auswahl.

*. Das Bild wurde bei bestehender Auswahl mit Hilfe des Füllwerkzeugs mit Schwarz gefüllt. Auf-
grund des Farbverlaufs und der daraus erstellten Auswahl, erscheint nun die Füllung wie ein
Farbverlauf. Wichtig hierbei ist, dass Schwarz in der Schnelle Maske volle Transparenz der Aus-
wahl und Weiss volle Deckkraft der Auswahl entspricht.

Die vorhandenen Auswahlwerkzeuge reichen nicht aus, feine Bildobjekte zu selektieren. Mit Hil-
fe der Malwerkzeuge ist es möglich, jede mögliche Auswahl zu erstellen, die Sie haben möchten. Die
Farbe spielt dabei eine besondere Rolle. Es steht Ihnen nicht nur Schwarz und Weiss zur Verfügung,
sondern auch alle 256 Graustufen dazwischen. Durch die Benutzung von grauen Farben, können Sie
zum Beispiel Auswahlen mit weichen Kanten erstellen.

TIPP

Um eine mit einer Schnellen Maske angelegte Auswahl in einen Kanal zu spei-
chern, steht Ihnen das Kommando Auswahl → In Kanal speichern im Menü
des Bildfensters zur Verfügung.

Benutzung

1. Öffnen Sie ein schon vorhandenes Bild oder legen Sie ein neues Bild an.

2. Aktivieren Sie die Schnelle Maske, indem Sie auf die Schaltfläche klicken, die sich im Bildfenster
links unten befindet. Bei vorhandener Auswahl, wird die Schnelle Maske mit bestehender Aus-
wahl initialisiert.

3. Benutzen Sie ein von Ihnen gewähltes Malwerkzeug mit Graustufenfarben, um die Quickmask zu
bearbeiten.

4. Deaktivieren Sie die Schnelle Maske, indem Sie wieder auf die Schaltfläche klicken, die sich links
unten im Bildfenster befindet.

8.2.3. Der Dialog ”Pfade“

Abbildung 8.12. Ansicht des Dialoges ”Pfade“

Der Pfaddialog wird benutzt um Pfade zu Erstellen, zu Verwalten und Sie wieder zu Löschen.
Der Pfaddialog ist ein dockbarer Dialog und kann auf verschiedenen Wegen aufgerufen werden:
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8.2.3.1. Dialogaufruf

• Aus dem Werkzeugfenstermenü: Datei → Dialoge → Pfade

• Aus dem Bildmenü: Dialoge → Pfade.

8.2.3.2. Aufbau und Benutzung des Dialoges ”Pfade“

Der Pfaddialog zeigt eine Liste der zum aktuellen Bild gehörigen Pfade. Die Pfade lassen sich ähnlich
den Ebenen oder den Kanäle verwalten.

Sichtbarkeit des Pfades Die Sichtbarkeit eines Pfades wird durch ein Augensymbol gekennzeich-
net. Um den Pfad aus dem aktiven Bild auszublenden, klicken Sie auf das Auge mit der linken
Maustaste. Um den Pfad wieder sichtbar werden zu lassen, klicken Sie nocheinmal mit der linken
Maustaste auf den linken Bereich in der Pfadliste, damit das Augensymbol wieder erscheint.

Pfade verketten Um mehrere Pfade zu verschieben, können diese verkettet werden. Klicken Sie auf
das Kettensymbol (links neben dem Ebenennamen) um eine Ebene zu verketten. Wiederholen Sie
diesen Schritt mit jeder Ebene, die Sie z.B. gemeinsam verschieben wollen. Um die Verkettung zu
lösen, klicken Sie auf das Kettensymbol, so dass es verschwindet.

Miniaturbild Ein kleines Miniaturbild zeigt eine Skizze des Pfades. Ziehen Sie das Miniaturbild auf das
aktuelle Bild um eine Kopie des Pfades zu erstellen.

Pfadname Der Name des Pfades kann durch einen Doppelklick verändert
werden. Der Name muss eindeutig sein und kann nicht zweimal im Pfaddialog vergeben werden.

Jedes Bild hat einen aktiven Pfad (angezeigt durch eine Markierung), sobald der Pfaddialog eine nicht
leere Liste zeigt. Dieser Pfad kann mit Funktionen, die per Schaltfläche am unteren Ende des Dialogs
aufgerufen werden können, verändert werden.

Durch einen Rechtsklick (Strg + Mausklick Links auf einen Apple Macintosh) kann das Pfadkontex-
menü aufgerufen werden. Das Kontextmenü kann ebenso aus dem Tabmenü aufgerufen werden.

8.2.3.3. Schaltflächen

Die unteren Schaltflächen der Dialoge korrespondieren zu gleichen Funktionen im Kontextmenü.

Neuer Pfad Durch gedrückt halten der Shift Taste wird ein Dialog aufgerufen mit dem eine Name
für den neuen Pfad vergeben werden kann. Schauen Sie unter Neuer Pfad im Kontextmenü für
weitere Informationen.

Pfad anheben Schauen Sie unter Pfad anheben im Pfadkontextmenü für mehr Informationen.

Pfad absenken Schauen Sie unter Pfad nach unten im Pfadkontextmenü für mehr Informationen.

Pfad duplizieren Schauen Sie unter Pfad duplizieren im Pfadkontextmenü für mehr Informationen.

Auswahl aus Pfad Konvertiert einen Pfad in eine Auswahl; mehr Informationen unter Auswahl aus
Pfad. Taste: Nichts Aktion: Aktive Auswahl ersetzen.
Taste: Shift Aktion: Zur Auswahl hinzufügen.
Taste: Strg Aktion: Von Auswahl subtrahieren.
Taste: Shift–Ctrl Aktion: Schnittmenge mit Auswahl bilden.
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Pfad aus Auswahl Durch gedrückt halten der Shift Taste, wird ein Dialog für Erweiterte Einstellun-
gen zur Konvertierung angezeigt. Hier können Sie alle Parameter zur Konvertierung von einer
Auswahl zu einem Pfad einstellen.

Pfad nachziehen Schauen Sie unter Pfad nachziehen im Pfadkontextmenü für weitere Informationen.

Pfad löschen Durch Drücken der Schaltfläche können Sie den aktiven Pfad entfernen.

8.2.3.4. Pfadkontextmenü

Abbildung 8.13. Ansicht des Pfadkontextmenüs.

Pfadwerkzeug Der Klick auf Pfadwerkzeug ist ein alternativer Weg, um das Pfadwerkzeug aus dem
Werkzeugfenster aufzurufen.

Pfadeigenschaften Durch den Klick auf Pfadeigenschaften erscheint ein neuer Dialog zum Verändern
des Pfadnamens. Es ist ebenfalls möglich den Dialog per Doppelklick zu öffnen.

Neuer Pfad Neuer Pfad erstellt einen neuen Eintrag in der Pfadliste. Der neue Pfad wird automatisch
zum aktiven Pfad welcher markiert in der Liste erscheint. Der neue Pfad besitzt noch keine Kno-
tenpunkte, die Sie selbst hinzufügen müssen um einen Pfad zu erstellen.

Pfad anheben Pfad anheben verschiebt den aktuellen Pfadeintrag um einen Eintrag nach oben. Die
Anordnung der Pfade in der Liste hat keine Bedeutung.

Pfad absenken Pfad absenken verschiebt den aktuellen Pfadeintrag um Eintrag nach unten. Die An-
ordnung der Pfade in der Liste hat keine Bedeutung.

Pfad duplizieren Pfad duplizieren erstellt eine 1:1 Kopie des aktuellen Pfades.
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Duplizierte Pfade sind nicht sichtbar, solang nicht ein Pfad unsichtbar ist.
Die Sichtbarkeit des Pfades wird durch das Augensymbol abgebildet.

Pfad löschen Pfad löschen entfernt den aktuell ausgewählten Pfad.

Sichtbare Pfade vereinen Sichtbare Pfade vereinen vereint alle Pfade die sichtbar (Augensymbol)
sind, in einem Pfad.

Auswahl aus Pfad; Zur Auswahl hinzufügen; Von Auswahl abziehen; Schnittmenge mit Auswahl bilden.
Diese Funktionen erstellen aus einem Pfad eine Auswahl. Der Unterschied besteht in der Art wie
die Auswahl erstellt wird (ob durch Hinzufügen, Schnittmenge bilden oder Abziehen). Falls nötig
werden ungeschlossene Knotenpunkte zur Erstellung der Auswahl geschlossen.

Pfad aus Auswahl Diese Funktion kann auf verschiedener Weise erreicht werden:

• Aus dem Bildmenü unter Auswahl → Nach Pfad
• Aus dem Pfaddialogmenü, unter Auswahl nach Pfad.
• Aus der unteren Symbolleiste des Pfaddialogs durch Klicken auf die Auswahl aus Pfad

Schaltfläche.
• Aus den Werkzeugoptionen des Pfadwerkzeugs durch Klicken auf die Auswahl aus Pfad

Schaltfläche.

Pfad aus Auswahl erstellt einen neuen Pfad aus einer Auswahl. In den meisten Fällen ist die Form
des Pfades ähnlich der Form der ”laufenden Ameisen”.

Pfad nachziehen... Diese Funktion kann auf verschiedenem Wege erreicht werden:

• Aus dem Bildmenü unter Bearbeiten → Pfad nachziehen
• Aus dem Pfaddialogmenü durch einen Klick auf den Pfad nachziehen Eintrag.
• Aus der unteren Symbolleiste des Pfaddialoges durch Klick auf die Pfad nachziehen Schalt-

fläche.
• Durch Klick auf die Pfad nachziehen Schaltfläche in den Werkzeugeinstellungen des Pfad-

werkzeugs.

Pfad nachziehen zeichnet den aktuellen Pfad auf die aktuelle Ebene. Durch Klicken auf die
Schaltfläche zum Nachziehen des Pfades, erscheint ein Dialog indem Sie einstellen können, wie
der nachgezogene Pfad aussehen soll. Schauen Sie unter Nachziehen nach, um mehr Informatio-
nen zu den Nachzieheinstellungen zu erhalten.

Pfad kopieren Pfad kopieren kopiert den aktuellen Pfad in die Zwischenablage.

TIPP

Alternativ können Sie einen Pfad auch kopieren, indem Sie das Miniaturbild
des Pfades auf das Bild ziehen.
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Pfad einfügen Pfad einfügen fügt einen vorher kopierten Pfad aus der Zwischenablage in die Liste
der Pfade ein.

Pfad importieren Pfad importieren erstellt einen neuen Pfad aus der angegebenen Datei, die im SVG
Format abgespeichert sein muss. Schauen Sie unter Pfade nach, um mehr über diese Technik zu
erfahren.

Pfad exportieren Pfad exportieren speichert den Pfad in eine Datei im SVG Format. In Vektorgrafik-
programmen wie Sodipodi oder Inkscape können Sie die abgespeicherten Pfade weiter bearbeiten.
Schauen Sie unter Pfade nach, um mehr über diese Technik zu erfahren. Sie können die abgespei-
cherten Pfade ebenfalls mit dem Pfad importieren wieder öffnen und weiterbearbeiten.

8.2.4. Der Dialog ”Farbtabelle“

Abbildung 8.14. Ansicht des Dialoges ”Farbtabelle“

Der Dialog ”Farbtabelle“ ermöglicht es Ihnen die Farbtabellen von Bildern im Farbmodus ”indiziert“
zu bearbeiten. Falls sich das aktive Bild in einem anderen Farbmodus befindet, ist dieser Dialog deakti-
viert und nutzlos. Der Dialog kann auf verschiedene Arten aufgerufen werden:

8.2.4.1. Dialogaufruf

• Im Menü des Werkzeugfensters über das Kommando: Datei → Dialoge → Farbtabelle

• Im Menü des Bildfensters über das Kommando: Dialoge → Farbtabelle

8.2.4.2. Farbtabellen und Bilder im Modus ”indiziert“

Wenn sich ein Bild im Farbmodus ”indiziert“ befindet, wird die Farbe den Pixeln indirekt zugewiesen.
Dies bedeutet, dass die Pixel statt einer Farbe, einen Eintrag in einer Farbtabelle zugewiesen bekommen.
In der Farbtabelle wird dann für die einzelnen Einträge die Farbe selbst zugewiesen. In GIMP können
Farbtabellen maximal 256 Einträge haben. Dabei kann jedem Eintrag eine beliebige Farbe zugeordnet
werden.

Es ist wichtig zu beachten, dass die Farben in der Farbtabelle eines Bildes im Farbmodus ”indiziert“
dien einzigen Farben sind, die in diesem Bild zur Verfügung stehen. Dies gilt natürlich auch für Aktio-
nen wie das Füllen von Bereichen eines solchen Bildes mit einem Muster. Dabei wird GIMP vermutlich
nicht alle Farben des Musters in der Farbtabelle des Bildes finden. In einem solchen Fall werden die
nicht verfügbaren Farben angenähert. Die dabei verwendeten Algorithmen werden im Glossar als Far-
brasterung beschrieben.

Der Dialog erlaubt es Ihnen die Farbtabelle des Bildes zur bearbeiten. Dabei können Sie nicht nur
die Farbe der Einträge ändern, sondern auch Einträge entfernen und neue Einträge hinzufügen. Die

177



8.2. BILDAUFBAU BEZOGENE DIALOGE KAPITEL 8. DIALOGE

Änderungen werden sofort im Bild sichtbar. Wenn Sie einen Eintrag der Farbtabelle entfernen, so wer-
den alle nachfolgenden Einträge der Tabelle nach oben rutschen. Dadurch ändert sich auch die Nummer
des Eintrages in der Farbtabelle und damit auch die Farben im Bild.

8.2.4.3. Aufbau und Benutzung des Dialoges ”Farbtabelle“

Die folgenden Kommandos können Sie im Dialog ausführen:

Mausklick auf einen Eintrag der Farbtabelle Damit setzen Sie die Farbe des Eintrages der Farbtabelle
als aktuelle Vordergrundfarbe in GIMP. Diese Farbe wird also für alle nachfolgenden Anwendun-
gen eines Malwerkzeuges verwendet.

Strg–Mausklick auf einen Eintrag der Farbtabelle Hierbei setzen Sie die aktuelle Hintergrundfarbe
in GIMP auf die Farbe der Tabellenzelle, welche Sie angeklickt haben.

Doppelklick auf einen Eintrag in der Farbtabelle Hiermit können Sie den GIMP Farbwähler öffnen,
um die Farbe des Eintrages zu ändern. Gleichzeitig wird der Eintrag auch zur aktuellen Vorder-
grundfarbe von GIMP.

Farbindex Mit diesem Eingabefeld können Sie einen anderen Farbeintrag durch Eingabe der Nummer
des Eintrages auswählen. Ausserdem wird in diesem Feld die Nummer des jeweils aktuellen Ein-
trages der Farbtabelle angezeigt.

HTML-Notation In diesem Eingabefeld wird Ihnen die Farbe des aktuellen Eintrages der Farbtabelle
als sogenanntes HexTriplet angezeigt. Dabei die Intensität jeder der Grundfarben Rot, Grün und
Blau als Hexadezimalzahl angezeigt. Diese Art eine Farbe durch sechs Zeichen zu beschreiben ist
bei der Erstellung von Webseiten üblich. Sie können die Farbe auch durch Eingabe eines anderen
Farbcodes verändern.

”Farbe bearbeiten“ Schaltfläche Mit dieser Schaltfläche können Sie den Farbwähler Dialog öffnen,
um die Farbe des aktuellen Eintrages der Farbtabelle zu bearbeiten.

”Farbe hinzufügen“ Schaltfläche Mit dieser Schaltfläche können Sie neue Einträge zur Farbtabelle
hinzufügen. Wenn Sie dieses Kommando ausführen, wird die aktuelle Vordergrundfarbe in GIMP
als neuer Eintrag an die vorhandene Farbtabelle angefügt. Um statt der Vorder- die aktuelle Hin-
tergrundfarbe zu verwenden, halten Sie wie üblich die Strg Taste während des klickens auf die
Schaltfläche gedrückt. Bitte beachten Sie, dass eine Farbtabelle in GIMP maximal 256 Einträge
umfassen kann. Sofern die Tabelle bereits die maximale Anzahl an Einträgen enthält, wird die
Schaltfläche inaktiviert (ausgegraut).

TIPP

Falls Ihnen bei der Änderung ein Fehler unterläuft, können Sie diesen
Rückgängig machen, indem Sie das Bildfenster des Bildes aktivieren für dass
Sie versehentlich die Farbtabelle verändert haben und dann das Kommando Be-
arbeiten → Rückgängig aufrufen. Alternativ können Sie auch das Tastenkürzel
Strg–Z verwenden.
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Bitte beachten Sie, dass Sie mit diesem Dialog die wichtigsten Möglichkeiten zur
Veränderung von Farben in Bildern im Farbmodus ”indiziert“ kennen gelernt ha-
ben. Die für Bilder im Farbmodus RGB üblichen Werkzeuge zur Kontrast- und
Farbkorrektur können in diesem Fall genauso wenig verwendet werden wie ver-
schiedene Filter.

8.2.5. Der Dialog ”Histogramm“

Abbildung 8.15. Ansicht des Dialoges ”Histogram“

Dieser Dialog zeigt Ihnen verschiedene statistische Informationen zur Verteilung von Farb- und Hel-
ligkeitswerten im aktuellen Bild. Diese Informationen sind gerade für die Einstellung von Farbbalance
und Helligkeit in Bildern sehr wichtig. Dabei hat der Inhalt dieses Dialoges jedoch rein informativen
Charakter. Es sind mit ihm keinerlei Änderungen am Bild möglich. Hierzu stehen Ihnen verschiedene
Möglichkeiten, allen voran das Werkzeug Werte zur Verfügung.

8.2.5.1. Dialogaufruf

Der Dialog, welchen Sie, wie alle Dialog in GIMP mit zusammen mit anderen Dialogen gruppieren
können, lässt sich auf verschiedenen Wegen öffnen:

• Im Menü des Werkzeugfensters über das Kommando: Datei → Dialoge → Histogram

• Im Menü des Bildfensters über das Kommando: Dialoge → Histogramm

8.2.5.2. Über Histogramme

In GIMP besteht jede Ebene eines Bildes aus einem oder mehreren Kanälen. Für Bilder im RGB Farbmo-
dus sind das die Kanäle R, G und B, für Bilder Bilder im Graustufenmodus der Schwarzkanal. Ebenen,
welche Transparenz beinhalten können, haben einen weiteren, den sogenannten Alphakanal. Jeder Ka-
nal kann eine bestimmte Anzahl von Intensitäten abbilden. In GIMP sind dies zur Zeit 256 verschiedene
Werte. Dabei repräsentiert 0 die geringste Intensität (bzw. Deckkraft) und 255 die Höchste.

Für Bilder im Farbmodus RGB ist es nützlich einen Pseudokanal zu definieren. Dies ist kein richtiger
Kanal, er enthält keine Werte, die direkt den Bildinhalt bestimmen. Vielmehr ist es ein Kanal, dessen
Werte sich aus der Funktion [code] V = max(R,G,B) [/code] ergeben. Damit erhält man in etwa den
Wert, der sich für das Pixel ergeben würde, wenn das Bild im Graustufenmodus wäre.

Weitere Informationen zu Kanälen finden Sie im Abschnitt 2.3 auf Seite 29.
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Abbildung 8.16. Kanal Auswahlmöglichkeiten für eine RGB Bild mit Alphakanal

Kanal

8.2.5.3. Aufbau und Benutzung des Dialoges ”Histogramm“

Diese Auswahlbox ermöglicht es Ihnen einen Kanal auszuwählen, für den das Histogramm ange-
zeigt wird. GIMP stellt Ihnen hier folgende Auswahlmöglichkeiten zur Verfügung:

Wert Für Bilder im RGB oder Graustufenmodus, wird mit dieser Einstellung die Verteilung der
Helligkeitswerte im Bild angezeigt. Für Bilder im Farbmodus Graustufen werden dazu direkt
die vorhandenen Helligkeitswerte verwendet. Für Bilder im RGB Modus werden die Werte
aus dem oben beschriebenen Pseudokanal verwendet.
Für Bilder im Farbmodus ”indiziert“ wird mit dieser Einstellung die Häufigkeit der Verwen-
dung jedes Eintrages der Farbtabelle angezeigt.

Rot, Grün, Blau Diese Auswahlmöglichkeiten repräsentieren die Kanäle eines Bildes im RGB
Modus und werden daher auch nur für diese angezeigt. Wenn Sie eine dieser Auswahlmöglichkeiten
einstellen, wird die Intensitätsverteilung im entsprechenden Farbkanal angezeigt.

Alpha Wenn Sie diese Auswahlmöglichkeit einstellen, wird die Verteilung der Deckkraft in der
aktiven Ebene angezeigt. Im Fall von vollständiger Deckkraft, oder vollständiger Transparenz
besteht das Histogramm jeweils nur nur einem Balken am linken bzw. rechten Rand des
Histogramms.

Abbildung 8.17. Kombiniertes RGB Histogramm

RGB

Diese Auswahlmöglichkeit ist nur dann vorhanden, wenn sich das aktuelle Bild im Farbmo-
dus RGB befindet. Es zeigt die einzelnen Histogramme für den Rot-, Grün- und Blaukanal
gleichzeitig an. Dies ermöglicht Ihnen die Verteilung aller Primärfarben des Bildes gleichzei-
tig zu sehen.

Mit diesen Schaltflächen können Sie einstellen, ob das Histogramm mit einer linearen oder einer
logarithmischen Y-Achse angezeigt wird. Für Fotografien ist der Modus ”Linear“ in der Regel bes-
ser geeignet. Für Bilder in denen große Bildbereiche einfarbig sind, würde die lineare Darstellung
des Histogramms von einer oder wenigen Farben dominiert. Um in einem solchen Fall trotzdem
eine aussagekräftige Darstellung des Histogramms zu erhalten empfiehlt sich die Aktivierung der
logarithmischen Y-Achse.
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Abbildung 8.18.

”Linear / Logarithmisch“ Schaltflächen

Abbildung 8.19. Histogramm mit ausgewähltem Bereich

Bereichsauswahl

Sie können den Bereich des Histogramms, der für die Analyse der Statistik verwendet wird, die Sie
im unteren Bereich des Dialoges sehen, einschränken. Hierzu stehen Ihnen folgende Möglichkeiten
zur Verfügung:

• Bewegen Sie den Mauszeiger, während Sie die Maustaste gedrückt halten, über den Bereich
des Histogramms, den Sie auswählen wollen.

• Wählen Sie einen Bereich des Histogramms durch verschieben der Dreiecksregler unterhalb
des Histogramms.

• Verwenden Sie die Eingabefelder links und rechts unterhalb des Histogramms, um einen
Wertebereich des Histogramms auszuwählen.

Statistik Im unteren Bereich des Dialoges werden einige grundlegende statistische Kennzahlen ange-
zeigt. Diese werden aus den im Histogramm angezeigten Werten berechnet. Sollte im Histogramm
ein Bereich ausgewählt sein, so werden nur die Werte im ausgewählten Bereich für die Berech-
nung herangezogen. Im Einzelnen werden folgende Kennzahlen angezeigt: Durchschnitt der Wer-
te; Standardabweichung der Werte; Median; Anzahl der Pixel im Bild; Anzahl der Pixel die zur
Berechnung verwendet wurden sowie das Verhältnis der Pixelanzahlen als Prozentsatz.

8.2.6. Der Dialog ”Navigation“

Die Ansichtsnavigation soll Ihnen das Navigieren auf ihren Bildern erleichtern. Sie können hinein- und
heraus zoomen, sowie die aktuelle Bildansicht verändern. Diese wird Ihnen als Umriss in der Ansichts-
navigation dargestellt, falls ihre Ansicht grösser als das Bildfenster ist. Die Umrahmung verschwindet,
wenn Sie wieder aus dem Bild zoomen.

8.2.6.1. Dialogaufruf

Der Dialog kann auf verschiedenen Wegen erreicht werden:
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Abbildung 8.20. Ansicht des Dialoges ”Navigation“

• aus dem Bildfenster: Datei → Dialoge → Navigation

• aus dem Bildfenster: Ansicht → Navigationsfenster

• aus einem anderen Dialogmenü in einem Dock: Reiter hinzufügen → Navigation

Das Bild selber bietet eine Ansichtsnavigation ohne Zoom in der rechten unteren Ecke des Bildfensters:

8.2.6.2. Aufbau und Benutzung des Dialoges ”Navigation“

Der Zoomregler Der Schieberegler erlaubt es, die Ansicht im Bildfenster vergrößern oder verkleinern
zu können. Er verhält sich ähnlich der Lupe.

Die Zoomschaltflächen

• Benutzen Sie Herauszoomen um die Ansicht mehr der Fenstergröße anzupassen. Mit der Hin-
einzoomen Schaltfläche können Sie ihre Ansicht gegenüber dem Bildfenster vergrößern. Die
Maßstab 1:1 Schaltfläche setzt den Zoomlevel wieder auf die Ausgangsposition.

• Die Auf Fenstergröße zoomen Schaltfläche passt die Ansicht auf das Bild an die Fenstergröße
an.

• Die Fenster anpassen Schaltfläche passt das aktuelle Fenster an die Ansicht an.

8.2.7. Der Dialog ”Journal“ (Historie)

In diesem Dialog wird eine Liste der zuletzt auf einem Bild ausgeführten Kommandos angezeigt. Zusätzlich
enthält jeder Eintrag der Liste ein kleines Vorschaubild, welches den Zustand des Bildes nach der
Ausführung des Kommandos zeigt. Sie können zu diesem Stand des Dokumentes zurückkehren, in-
dem Sie auf einen der Einträge der Liste klicken. Detailliertere Informationen hierzu finden Sie im Ab-
schnitt 2.3.5 auf Seite 38.

8.2.7.1. Dialogaufruf

Der Dialog ”Journal“ kann mit anderen Dialogen gruppiert werden. Weitere Informationen dazu finden
Sie im Abschnitt 2.1.3 auf Seite 23. Sie können den Dialog auf verschiedene Arten sichtbar machen:

• Indem Sie das Kommando Datei→Dialoge→ Journal im Menü des Werkzeugfensters ausführen;

• das Kommando Datei → Dialoge → Dock hinzufügen → Ebenen, Kanäle und Pfade im Menü
des Werkzeugfensters ausführen (dabei wird ein neues Dock geöffnet, welches neben dem Dialog

”Journal“ auch andere Dialoge enthält);
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Abbildung 8.21. Ansicht des Dialoges ”Journal“

• oder das Kommando Bearbeiten → Journal im Menü eines Bildfensters;

• beziehungsweise alternativ das Kommando Dialoge → Journal im Menü eines Bildfensters auf-
rufen;

8.2.7.2. Aufbau und Benutzung des Dialoges ”Journal“

Die einfachste Art den Dialog zu verwenden, ist einen der Einträge in der Historie von Kommandos
anzuklicken, die im aktuellen Bild ausgeführt wurden. Sie können einfach zwischen den verschiedenen
Zuständen eines Bildes vor und nach der Ausführung eines Kommandos, beispielsweise eines Filters,
umschalten.

Am unteren Rand des Dialoges finden Sie drei Schaltflächen:

Rückgängig machen (Undo) Wenn Sie diese Schaltfläche betätigen, führt GIMP das gleiche Komman-
do aus, welches Sie auch über den Eintrag Bearbeiten → Rückgängig im Menü des Bildfensters
oder das Tastenkürzel Strg–Z erreichen können; der zuletzt auf dem Bild ausgeführte Bearbei-
tungsschritt wird rückgängig gemacht. Alternativ können Sie sich auf vorstellen, dass in den Ein-
trägen des Journale um einen Eintrag zurück gegangen wird.

Wiederholen (Redo) Wenn Sie diese Schaltfläche betätigen, führt GIMP das gleiche Kommando aus,
welches Sie auch über den Eintrag Bearbeiten → Wiederholen im Menü des Bildfensters oder
das Tastenkürzel Strg–Y erreichen können; Im Journal wird um einen Schritt vorgeblättert.

Liste alter Operationen aufräumen Durch Betätigen dieser Schaltfläche wird die gesamte Historie des
Bildes gelöscht. Das heisst alle Einträge im Journal, bis auf den aktuellen werden aus der Liste
entfernt. Da dies eine recht gefährliche Aktion ist, fragt GIMP vor der Ausführung nocheinmal
mit Hilfe eines Dialogfensters nach einer Bestätigung. Der einzige Grund, warum Sie diese Aktion
möglicherweise ausführen wollen, ist dass dadurch der durch die Aktionen belegte Speicherplatz
wieder freigegeben wird.
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Abbildung 8.22. Ansicht des Dialoges VG/HG Farbe

8.3. Bildinhalt bezogene Dialoge

8.3.1. Der Dialog ”VG/HG Farbe“

Der Dialog VG/HG Farbe dient zur Einstellung von Vordergrund- (VG) und Hintergrundfarben (HG).
Hierzu stehen Ihnen die verschiedenen Farbwähler GIMP, CMYK, Triangle, Watercolor und Skalen zur
Verfügung. Außerdem können Sie mit Hilfe der Pipette eine Farbe durch Mausklick vom aktuelle Bild-
schirminhalt aufnehmen.

8.3.1.1. Dialogaufruf

Der Dialog ”VG/HG Farbe“ kann mit anderen Dialogen gruppiert werden. Weitere Informationen da-
zu finden Sie im Abschnitt 2.1.3 auf Seite 23. Sie können den Dialog auf verschiedene Arten sichtbar
machen:

• Indem Sie das Kommando Datei→Dialoge→ Farben im Menü des Werkzeugfensters ausführen;

• Indem Sie im Werkzeugfenster in die aktuelle Vorder- oder Hintergrundfarbe klicken;

• das Kommando Dialog → Farben im Menü eines Bildfensters aufrufen;

• oder aus einem anderen Dialog das Kommando Reiter hinzufügen→ Farben im Menü unter der

Schaltfläche auswählen.

8.3.1.2. Aufbau und Benutzung des Dialoges ”VG/HG Farbe“

Der Dialog stellt Ihnen verschiedene Farbwähler zur Verfügung, um Ihnen die Auswahl der gewünschten
Vorder- und Hintergrundfarbe so einfach wie möglich zu machen. Die Aktivierung der Farbwähler er-
folgt über die sechs Schaltflächen im oberen Bereich des Dialoges. Die verschiedenen Möglichkeiten
werden im Folgenden detailliert beschrieben.

GIMP Im Farbwähler Gimp (symbolisiert durch einen kleinen Wilber) finden Sie zum Einstellen der
Farbe einen großen rechteckigen Bereich mit einem Fadenkreuz, rechts daneben ein Farbband so-
wie wiederum rechts vom Farbband eine Reihe von Schaltflächen. Die Schaltflächen H, S, V, R,
G sowie B ermöglichen Ihnen die Auswahl der Komponente, die Sie im Farbstreifen einstellen
können. Dabei stehen H, S und V für die Komponenten des HSV Farbmodells und R, G und B für
die des RGB Farbmodells. Der rechteckige Bereich mit Fadenkreuz dient bildet dann die jeweils
verbleibenden zwei Komponenten des Modells ab.

CMYK Der Farbwähler CMYK (symbolisiert durch einen kleinen Drucker) ermöglicht Ihnen die Einstel-
lung einer Farbe basierend auf den Komponenten C, M, Y und K des Farbmodells CMY, CMYK.
Dabei erfolgt die Einstellung durch Schieberegler, jeweils im Bereich von 0% bis 100%.
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Dreieck (HSV Farbkreis) Der Farbwähler Dreieck ist auch bekannt als HSV-Farbkreis und wird durch
ein kleines Dreieck in einem farbigen Kreis symbolisiert. Wie der Name schon sagt, erfolgt die Ein-
stellung einer Farbe bei diesem Farbwähler auf der Basis des HSV Farbmodells. Hierzu wird der
Farbton (H) als Ring angeordnet. Innerhalb des Ringes befindet sich ein Dreieck. In diesem wird in
horizontaler Richtung die Helligkeit (V) und in vertikaler Richtung die Sättigung (S) abgebildet.
Die Einstellung des Farbtones erfolgt durch Drehen des Dreiecks oder Verschieben des Punktes
im Ring. Die Einstellung von Helligkeit und Sättigung erfolgt durch Verschieben des Punktes im
Dreieck.

Wasserfarbe Dieser Farbwähler wird durch einen Pinsel symbolisiert. Die Funktionsweise des Farbwählers
ist ein bisschen anders als die der bisher vorgestellten Modelle. Das Prinzip besteht darin, die ak-
tuelle Vordergrundfarbe durch Klicken in in die rechteckige Farbpalette zu verändern. Wenn die
aktuelle Vordergrundfarbe beispielsweise weiß ist, so wird dieses durch einen klicken in den ro-
ten Farbbereich rötlich abgetönt. Mehrfaches Klicken verstärkt den Effekt. Mit dem Schieberegler,
welcher sich rechts neben dem Farbbereich befindet, können Sie die Farbmenge einstellen, welche
mit jedem Klick aufgenommen wird. Je weiter oben sich der Schieberegler befindet, um so mehr
Farbe wird pro Klick aufgenommen.

Schieberegler Dieser Farbwähler wird durch zwei kleine Schieberegler symbolisiert. Die Einstellung
der Farben mit Hilfe dieses Farbwählers erfolgt über sechs Schieberegler, denen jeweils ein Einga-
befeld angefügt ist. Die Schieberegler repräsentieren die Komponenten der Farbmodelle HSV und
RGB.

Pipette Mit diesem Farbwähler, welcher durch eine Pipette auf einem stilisierten Bildschirm symbo-
lisiert wird, ist es möglich, Farben vom aktuellen Bildschirm aufzunehmen. Um eine Farbe aus-
serhalb des GIMPs aufzunehmen, aktivieren Sie den Farbwähler durch einen Klick auf die Pi-
pettenschaltfläche und klicken Sie dann auf den Bildschirmbereich dessen Farbe Sie aufnehmen
möchten.

Im unteren Bereich des Dialoges befindet sich eine Anzeige der aktuellen Vorder- und Hintergrundfarbe.
Eine der beiden Farben ist jeweils aktiv, erkennbar an einem dünnen grauen Rahmen, der die aktive
Farbbox umgibt. Um eine Farbbox zu aktivieren, klicken Sie die gewünschte Box einfach an. Sämtliche
Einstellungen, welche Sie mit den Farbwählern vornehmen, wird auf die aktive Farbe angewendet.

Rechts oberhalb finden Sie ein Symbol, bestehend aus zwei Pfeilen, mit welchem Sie die Vorder- und
Hintergrundfarbe vertauschen können. Links unterhalb der Farbanzeige finden Sie eine Schaltfläche mit
zwei kleinen, überlappenden Quadraten. Wenn Sie auf diese klicken, werden die Vorder- und Hinter-
grundfarbe auf Schwarz und Weiss zurückgesetzt.

8.3.2. Der Dialog ”Pinsel“

Abbildung 8.23. Ansicht des Dialoges Pinsel
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Dieser Dialog dient Ihnen zur Auswahl einer Pinselspitze für die GIMP Malwerkzeuge (siehe Ab-
schnitt 7.3 auf Seite 90). Informationen zu Pinselspitzen und den wie Sie diese in GIMP anwenden
können, finden Sie im Abschnitt 2.3.8 auf Seite 45. Die am häufigsten benutzte Funktion des Dialoges
Pinsel ist sicher die Aktivierung einer Pinselspitze. Hierzu klicken Sie einfach die gewünschte Pinselspit-
ze an. Die aktive Spitze wird durch einen Rahmen gekennzeichnet. Zusätzlich bietet Ihnen der Dialog
Pinsel weitere Möglichkeiten, wie beispielsweise die Bearbeitung von Pinselspitzen im Pinseleditor.

8.3.2.1. Dialogaufruf

Der Dialog ”Pinsel“ kann mit anderen Dialogen gruppiert werden. Weitere Informationen dazu finden
Sie im Abschnitt 2.1.3 auf Seite 23. Sie können den Dialog auf verschiedene Arten sichtbar machen:

• Indem Sie das Kommando Datei→ Dialoge→ Pinsel im Menü des Werkzeugfensters ausführen;

• Indem Sie das Kommando Datei → Dialoge → Dock hinzufügen → Pinsel, Muster und Farb-
verläufe im Menü des Werkzeugfensters aufrufen. Hierbei werden automatisch die Dialoge Pin-
sel, Muster und Farbverläufe geöffnet;

• Indem Sie im Werkzeugfenster in das Symbol der aktiven Pinselspitze klicken;

• Indem Sie das Kommando Dialog → Pinsel im Menü eines Bildfensters aufrufen;

• Indem Sie in einem anderen Dialog das Kommando Reiter hinzufügen → Pinsel im Menü unter

der Schaltfläche auswählen.

8.3.2.2. Aufbau und Benutzung des Dialoges ”Pinsel“

Raster- und Listendarstellung Im Reitermenü des Dialoges können Sie die Darstellung zwischen als
Liste anzeigen und als Raster anzeigen umschalten. In der Rasterdarstellung (welche die Stan-
darddarstellung ist), werden die Formen der verschiedenen Pinselspitzen in einem rechteckigen
Feld angezeigt. In der Listendarstellung hingegen wird jede Pinselspitze als Eintrag in einer Liste
dargestellt. Neben der Form der Spitze wird dabei der Name der Spitze angezeigt.

Abbildung 8.24. Ansicht des Dialoges ”Pinsel“

(a) Der Dialog in Rasterdarstellung (b) Der Dialog in Listendarstellung

Rasterdarstellung Am oberen Rand des Dialoges wird der Name der aktuell aktiven Pinselspit-
ze, sowie deren Größe in Pixeln angezeigt.
Im zentralen Bereich des Dialoges werden die verschiedenen Pinselspitzen in einem Raster
angezeigt. Die aktive Spitze wird durch einen Rahmen hervorgehoben. Bei manchen Pinsel-
spitzen sehen Sie rechts unterhalb der Form ein kleines ”+“ Zeichen. Dieses kennzeichnet,
dass die Pinselspitze in Wirklichkeit größer ist, als sie im Dialog angezeigt wird. An gleicher
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Stelle kann sich auch ein kleines rotes Dreieck befinden, welches symbolisiert, dass es sich bei
dieser Pinselspitze um eine animierte Spitze handelt.
Einmaliges anklicken einer Pinselspitze im Dialog bewirkt, dass diese Spitze aktiv wird.
Durch einen Doppelklick können Sie den Pinseleditor für diese Pinselspitze aufrufen.

Listendarstellung Im Wesentlichen funktioniert der Dialog in dieser Darstellung genau so, wie
in der Rasterdarstellung. Einzigen Ausnahme:
Wenn Sie auf den Namen einer Pinselspitze doppelklicken, haben Sie die Möglichkeit den
Namen zu bearbeiten. Beachten Sie in diesem Zusammenhang bitte, dass Sie generell die
mit GIMP ausgelieferten Spitzen nicht bearbeiten, folglich auch nicht umbenennen können.
Dieses Verhalten gilt übrigens nicht nur für Pinselspitzen, sondern auch für alle Muster, Farb-
verläufe, Farbpaletten usw. soweit diese mit GIMP ausgeliefert werden. Sie können jedoch je-
derzeit eine Kopie dieser Elemente anlegen und diese dann selbstverständlich auch beliebig
bearbeiten.

Abstand Unterhalb der Darstellung der Pinselform befindet sich der Schieberegler Abstand. Mit die-
sem können Sie einstellen, in welchem Abstand GIMP die Pinselspitze aufsetzt, wenn Sie mit
einem der Malwerkzeuge einen Pinselstrich ziehen.

Pinsel bearbeiten Mit dieser Schaltfläche, welche sich am unteren Rand des Dialoges befindet, können
Sie den Pinseleditor aufrufen. Bitte beachten Sie, dass Sie mit dem Pinseleditor ausschließlich pa-
rametrisierte Pinsel bearbeiten können. Für alle anderen Typen von Pinselspitzen wird der Editor
zwar geöffnet, Sie können die Spitze jedoch nicht bearbeiten.

Neuer Pinsel Mit dieser Schaltfläche, welche sich ebenfalls am unteren Rand des Dialoges befindet,
können Sie eine neue Pinselspitze erzeugen. Diese wird sofort im Pinseleditor geöffnet und kann
von Ihnen bearbeitet werden. Die neue Pinselspitze wird automatisch im Ordner brushes Ihres
persönlichen GIMP Profiles gespeichert.

Pinsel duplizieren Mit dieser Schaltfläche, welche Sie - sie werden es erraten haben - ebenfalls am unte-
ren Rand des Dialoges finden, können Sie eine Pinselspitze duplizieren. Wenn Sie das Kommando
aufrufen, wird von der aktiven Spitze eine Kopie erzeugt und diese im Pinseleditor geöffnet. Die
Kopie wird automatisch im Ordner brushes Ihres persönlichen GIMP Profiles gespeichert.

Pinsel löschen Mit dieser Schaltfläche können Sie die aktive Pinselspitze löschen. Sie wird dann so-
wohl aus dem Dialog, als auch aus Ihrem persönlichen GIMP Profil entfernt. Da Sie diese Aktion
nicht rückgängig machen können, zeigt Ihnen GIMP vor der Ausführung des Kommandos einen
Bestätigungsdialog an.

Pinsel neu laden Indem Sie dieses Kommando durch anklicken der Schaltfläche ausführen, werden
die Pinselspitzen neu geladen. Hierzu durchsucht GIMP den Ordner brushes Ihres GIMP Profi-
les, sowie die anderen in GIMP als Ablageort für Pinselspitzen eingestellten Ordner nach Dateien
die Pinselspitzen enthalten. Dies ist sehr nützlich, wenn Sie neue Pinselspitzen als Datei erhalten
oder speichern und diese noch nicht im Dialog angezeigt werden.

Die in der Liste beschriebenen Kommandos können Sie auch im Kontextmenü des Dialoges, sowie im
Pinselmenü des Reitermenüs finden.

8.3.2.3. Der Pinseleditor

Der Pinseleditor ist ein vollständiger GIMP Dialog. Sie können ihn daher mit anderen Dialogen in einem
Dock zusammenfassen. Mit dem Pinseleditor können Sie eigene Pinsel erstellen und bearbeiten, sowie
die Parameter der mit GIMP ausgelieferten Pinselspitzen ansehen.
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Am oberen Rand des Pinseleditors befinden sich, wie bei allen anderen Dialogen auch, der Name des
Dialoges und das Reitermenü, sowie eine Schaltfläche, um den Dialog zu schließen.

Darunter finden Sie ein Eingabefeld, in welchem Sie den Namen der aktuell bearbeiteten Pinselspitze
ändern können.

Das obere Drittel des Dialoges nimmt der Vorschaubereich ein. Dieser zeigt ihnen eine Vorschau (ach?)
der aktuellen Pinselspitze.

Den Rest des Dialoges füllen verschiedene Bedienelemente aus, mit deren Hilfe Sie Form und Größe
der Pinselspitze Ihren Bedürfnissen entsprechend anpassen können.

Form Mit dieser Eigenschaft legen Sie die Grundform der Pinselspitze fest. Hierzu stehen Ihnen Kreis,
Quadrat sowie Diamant zur Auswahl.

Radius Mit dieser Eigenschaft können Sie den Abstand zwischen Mitte und Rand der Spitze einstellen.
Ein Quadrat mit einem Radius von 10 Pixeln wird eine Kantenlänge von 20 Pixeln haben. Um die
Einstellungen vorzunehmen, stehen Ihnen ein Schieberegler, sowie ein Eingabefeld zur Verfügung.

Spitzen Diese Eigenschaft ist nur für die Grundformen Quadrat und Diamant sinnvoll. Sie bestimmt
die Anzahl der Ecken und Kanten der Pinselspitze. Ein Quadrat wird so zum Polygon und ein
Diamant verwandelt sich in einen Stern.

Härte Mit dieser Eigenschaft kontrollieren Sie die Härte der Kante der Spitze. Die Einstellung können
Sie mit Hilfe eines Schiebereglers oder des zugeordneten Eingabefeldes im Bereich von 0.00 bis
1.00 vornehmen. Ein Wert von 1.00 steht dabei für eine maximal harte Kante.

Seitenverhältnis Mit dieser Eigenschaft können Sie das Verhältnis von Breite zu Höhe der Pinselspitze
bestimmen. Bei einem Wert von 2 wird die Pinselspitze also doppelt so breit wie hoch sein. Bitte
beachten Sie, dass sich das Seitenverhältnis auf die Grundform bezieht. Insbesondere wenn Sie die
Anzahl der Spitzen erhöhen, kann die Einstellung des Seitenverhältnisses zu sehr überraschenden
Ergebnisse führen.

Winkel Mit dieser Eigenschaft können Sie die Pinselspitze um ihr Zentrum drehen. Die Einstellung
können Sie im Bereich von 0° bis 180° mittels Schieberegler oder Eingabefeld vornehmen.

Abstand Wenn Sie mit einer Pinselspitze eine Linie zeichnen, wird die Form der Pinselspitze wieder-
holt aufgetragen. Mit dieser Eigenschaft können Sie den Abstand zwischen zwei Stellen einstellen,
an denen die Pinselspitze beim malen einer Linie aufgetragen wird.

8.3.3. Der Dialog ”Muster“

Dieser GIMP Dialog unterstützt Sie bei der Verwaltung und Auswahl von Mustern. Muster sind kleine
Bildstücke, die wiederholend aneinander gereiht dazu dienen größere Bereiche zu füllen.

Sie können Muster mit den Werkzeugen Füllen, Klonen sowie dem Kommando Mit Muster füllen
verwenden. Weitere Informationen zu Mustern und Ihrer Verwendung finden Sie im Abschnitt 2.3.10
auf Seite 48.

Der Dialog wird dazu verwendet Muster zu verwalten und auszuwählen.

8.3.3.1. Dialogaufruf

Der Dialog ”Muster“ kann mit anderen Dialogen gruppiert werden. Weitere Informationen dazu finden
Sie im Abschnitt 2.1.3 auf Seite 23. Sie können den Dialog auf verschiedene Arten sichtbar machen:
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Abbildung 8.25. Ansicht des Dialoges ”Muster“

8.3.3.2. Aufbau und Benutzung des Dialoges ”Muster“

Raster- und Listendarstellung Im Reitermenü des Dialoges können Sie die Darstellung zwischen als
Liste anzeigen und als Raster anzeigen umschalten. In der Rasterdarstellung (welche die Stan-
dardeinstellung ist) werden die verschiedenen Muster in mehreren Zeilen und Spalten dargestellt.
In der Listendarstellung hingegen wird jedes Muster als einzelner Eintrag in einer Liste darge-
stellt. Neben dem Muster wird dabei zusätzlich der Name des Musters, sowie dessen Größe in
Pixel angezeigt.

TIPP

Unabhängig davon, ob Sie den Dialog in der Raster- oder der Listendarstel-
lung anzeigen werden alle Muster in der gleichen Größe angezeigt. Da die
verschiedenen Muster jedoch sehr verschieden groß sind, wird von allen
Mustern, die eine bestimmte Größe überschreiten, nur ein Ausschnitt an-
gezeigt. Durch anklicken eines Musters und gedrückt halten der Maustaste,
wird GIMP das Muster in voller Größe darstellen. Dies ist sehr hilfreich, um
die Wirkung eines Musters richtig einschätzen zu können.

ANMERKUNG

Die Größe des Vorschaubildes, welches für jedes Muster angezeigt wird,
können Sie im Reitermenü des Dialoges als Vorschaugröße einstellen.

Rasterdarstellung Am oberen Rand des Dialoges wird der Name und die Größe des aktiven
Musters angezeigt. Dies ist das Muster, welches aktuell in den GIMP Malwerkzeugen ver-
wendet wird, sofern dort nicht explizit ein anderes Muster ausgewählt ist.
Im zentralen Bereich des Dialoges werden alle in GIMP aktuell verfügbaren Muster ange-
zeigt. Wenn Sie eines dieser Muster anklicken, wird es aktiviert. Das aktivierte Muster erken-
nen Sie innerhalb des Dialoges an seinem einem dünnen, schwarzen Rahmen.

Listendarstellung In dieser Ansicht wird statt der Darstellung aller Muster in einer Gitterdar-
stellung für jedes Muster ein eigener Eintrag in einer Liste dargestellt. Dieser Eintrag enthält
neben dem Muster selbst noch dessen Namen und Größe. Wenn Sie auf einen solchen Eintrag
klicken, wird das entsprechende Muster, ebenso wie in der Rasterdarstellung, aktiviert.
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Abbildung 8.26. Ansicht des Dialoges ”Muster“

(a) Der Dialog in Listendarstellung (b) Der Dialog in Rasterdarstellung

Wenn Sie auf den Namen eines Musters doppelklicken, haben Sie die Möglichkeit den Namen
zu bearbeiten. Beachten Sie in diesem Zusammenhang bitte, dass Sie generell die mit GIMP
ausgelieferten Muster nicht bearbeiten, folglich auch nicht umbenennen können. Dieses Ver-
halten gilt übrigens nicht nur für Muster, sondern auch für alle Pinselspitzen, Farbverläufe,
Farbpaletten usw. soweit diese mit GIMP ausgeliefert werden. Sie können jedoch jederzeit
eine Kopie dieser Elemente anlegen und diese dann selbstverständlich auch beliebig bearbei-
ten.

Muster löschen Mit dieser Schaltfläche, welche Sie am unteren Rand des Dialoges finden, können Sie
das aktuell ausgewählte Muster löschen. Dabei wird nicht nur das Muster selbst aus dem Dialog
entfernt, sondern auch die Datei, die das Muster enthält, gelöscht. Beachten Sie in diesem Zusam-
menhang bitte, das Sie nur Muster löschen können, welche Sie selbst zu GIMP hinzugefügt haben,
die mit GIMP ausgelieferten Muster können hingegen nicht gelöscht werden.

Muster neu laden Indem Sie dieses Kommando durch anklicken der Schaltfläche ausführen, werden
die Muster neu geladen. Hierzu durchsucht GIMP den Ordner patters Ihres GIMP Profiles,
sowie die anderen in GIMP als Ablageort für Muster eingestellten Ordner nach Dateien die Muster
enthalten. Dies ist sehr nützlich, wenn Sie neue Muster als Datei erhalten oder speichern und diese
noch nicht im Dialog angezeigt werden.

8.3.4. Der Dialog ”Farbverlauf“

Abbildung 8.27. Ansicht des Dialoges Farbverlauf
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Mit dem Farbverlaufsdialog können Sie den gerade aktiven Farbverlauf wählen. Dieser wird unter
anderem von dem Farbverlaufswerkzeug verwendet. Den gewählten Verlauf sehen Sie im Werkzeug-
fenster in der Farb- und Werkzeugübersicht. Über 50 verschiedene Farbverläufe sind in GIMP bereits
vorinstalliert. Über den –>Farbverlaufseditor können Sie neue erstellen bzw. vorhandene bearbeiten.
Grundsätzliche Informationen zu der Verwendung von Farbverläufen finden Sie in dem Kapitel über
Farbverläufe.

8.3.4.1. Dialogaufruf

Der Farbverlaufsdialog ist ein dockbarer Dialog und kann auf verschiedenen Wegen aufgerufen werden:

• Über das Werkzeugfenstermenü: Datei → Dialoge → Farbverläufe

• Über das Werkzeugfenstermenü: Datei → Dialoge → Dock hinzufügen → Pinsel, Muster und
Farbverläufe Dies öffnet ein Dock mit fünf Reitern, der Falbverlaufsdialog ist einer davon.

• Über das Werkzeugfenster, indem Sie auf den aktiven Farbverlauf in der Farb- und Werkzeugübersicht
klicken.

• Über das Bildmenü: Dialoge → Farbverläufe

• Über das Reitermenü eines anderen Dialogs: Reiter hinzufügen → Farbverläufe

• Indem Sie im Bildfenster die Tastenkombination Strg–G benutzen.

8.3.4.2. Aufbau und Benutzung des Dialoges ”Farbverlauf“

Die grundlegendste Verwendung des Farbverlaufsdialogs ist es, einen Farbverlauf mit einem Mausklick
auszuwählen. Dieser wird von GIMP bei allen Operationen, die einen Farbverlauf verwenden, einge-
setzt.

Wenn Sie einen Doppelklick auf den Namen eines Farbverlaufs ausführen, können Sie ihn umbenen-
nen. Wenn Sie das Vorschaubild doppelklicken, öffnet sich der Farbverlaufseditor zum Bearbeiten des
Verlaufs. Änderungen lassen sich nur bei selbst erstellten Farbverläufen durchführen. Diejenigen, wel-
che bei GIMP vorinstalliert sind, können nicht bearbeitet werden. Diese Regel gilt nicht nur bei Farb-
verläufen. Auch vorinstallierte Pinsel, Muster, etc. dürfen nicht direkt verändert werden. Sie können
allerdings eine Kopie erstellen und diese nach Belieben anpassen.

Raster/Listen Modus Im Reitermenü des Farbverlaufsdialogs können Sie zwischen Als Liste anzei-
gen und Als Raster anzeigen wählen. Bei der letzteren Anzeigeart werden die Farbverläufe
platzsparend, einer neben dem anderen, dargestellt. Die Übersichtlichkeit leidet zu Gunsten des
schnellen Zugriffs. Im Listenmodus (Vorgabe-Einstallung) ist die Darstellung übersichtlicher, benötigt
allerdings mehr Platz.

ANMERKUNG

Unter dem Menüpunkt Vorschaugröße im Reitermenü können Sie die Dar-
stellungsgröße der Vorschaubilder ändern.

Im unteren Bereich des Dialogs befinden sich Schaltflächen, die der Verwaltung von Farbverläufen die-
nen:

Alle oben beschriebenen Funktionen lassen sich auch durch einen Rechtsklick in der Farbverlaufsliste
bzw. über das Reitermenü erreichen. Bei letzterem gibt es zudem noch eine weitere Funktion:

Als POV-Ray-Datei speichern Hiermit haben Sie die Möglichkeit den Farbverlauf in einem Format zu
speichern, welches von der 3D Raytracing Anwendung POV-Ray gelesen werden kann.
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8.3.4.3. Der Farbverlaufseditor

Abbildung 8.28. Ansicht des GIMP Farbverlaufseditors

Der Farbverlaufseditor ermöglicht es Ihnen Farbverläufe zu bearbeiten, also die verwendeten Farben
und deren Anordnung zu verändern. Zu beachten ist, dass Sie nur selbst erstellte Farbverläufe bearbei-
ten können. Die mit GIMP ausgelieferten Verläufe können nicht verändert, wohl aber dupliziert wer-
den. Die Duplikate wiederum gehören nicht zu den ursprünglich mit GIMP ausgelieferten Verläufen
und können daher verändert werden.

Aus der Sicht des Farbverlaufseditors bestehen Farbverläufe aus einem oder mehreren, aneinander
gereihten, Segmenten. Jedes Segment beschreibt dabei den Verlauf zwischen der Farbe am linken, und
der Farbe am rechten Rand des Segmentes. Darüber hinaus kann die Form des Verlaufes innerhalb jedes
Segmentes eingestellt werden.

Aufruf des Editors Der Farbverlaufseditor ist ein eigenständiger GIMP Dialog. Er kann daher mit an-
deren Dialogen gruppiert werden. Weitere Informationen dazu finden Sie im Abschnitt 2.1.3 auf Seite 23.
Sie können den Editor auf verschiedene Arten sichtbar machen:

• Indem Sie auf einen der Farbverläufe im Dialog einen Doppelklick ausführen.

• Indem Sie im Kontextmenü eines Farbverlaufes im Dialog ”Farbverlauf“ das Kommando Farb-
verlauf bearbeiten ausführen.

• Durch Benutzung der Schaltfläche Farbverlauf bearbeiten am unteren Rand des Dialoges ”Farb-
verlauf“.

• Indem Sie im Dialog Farbverlauf das Kommando Farbverlaufsmenü → Farbverlauf bearbeiten

im Menü unter der Schaltfläche auswählen.

Aufbau und Benutzung des Dialoges ”Farbverlaufseditors“

Name Im oberen Bereich des Dialoges finden Sie den Namen des bearbeiteten Farbverlaufes. Falls
der zur Bearbeitung geöffnete Farbverlauf mit GIMP ausgeliefert wurde oder aus einem ande-
ren Grund nicht bearbeitet werden kann, wird der Name mit dem Vermerk ”Schreibgeschützt“
versehen. Ausserdem befindet sich in diesem Bereich des Dialoges das Konfigurationsmenü.

Anzeigebereich für den Farbverlauf Im zentralen Bereich des Editors wird der aktuelle Farbverlauf
angezeigt. Ein Mausklick in das Farbband bewirkt, dass die Farbe unter dem Mauszeiger als
aktive Vordergrundfarbe ausgewählt wird. Durch gedrückt halten der Taste Strg während des
Mausklicks wird statt der Vordergrund- die Hintergrundfarbe gesetzt.
Während sich der Mauszeiger über dem Farbband befindet, werden im unteren Bereich des Dia-
loges verschiedene Informationen zu der aktuell unter dem Mauszeiger befindlichen Farbe ange-
zeigt. Zu diesen Informationen gehören die Position, die RGB und HSV Werte der Farbe sowie
Intensität und die Deckkraft.
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Begrenzungs- und Kontrollschieberegler Direkt unter dem Band des Verlaufes befindet sich eine
Leiste, welche mit kleinen Dreiecken gekennzeichnet, verschiedene Segmente des Farbverlaufes
darstellt. Unter Verwendung dieser Dreiecke können Sie das Aussehen des Verlaufes einstellen.

Jeweils zwei benachbarte schwarze Dreiecke begrenzen ein Segment des Farbverlaufes. Ein Seg-
ment besteht aus zwei Farben zwischen denen ein Verlauf erzeugt wird und einem Kontrollregler,
welcher zur Einstellung der Form des Farbüberganges innerhalb des Segmentes dient. Der Kon-
trollregler wird im Editor durch ein kleines weisses Dreieck dargestellt. Sie können ein Segment
aktivieren, indem Sie in die Leiste zwischen den zwei schwarzen Begrenzungsreglern des Segmen-
tes klicken. Ist ein Segment ausgewählt, so färbt sich der entsprechende Abschnitt auf der Leiste
blau. Sie können durch gedrückt halten der Shift Taste beim auswählen auch mehrere Segmente
gleichzeitig aktivieren.

Die Regler, Segmente und aktivierten Bereich lassen sich sehr leicht verschieben. Hierbei werden
die Übergänge in den jeweils angrenzenden Segmenten verändert. Beim Verschieben eines Begren-
zungsreglers verändert die beiden Segmente, welche durch den Regler begrenzt werden. Beim
Verschieben eines Segmentes werden die Übergänge in den angrenzenden Segmenten gestaucht
oder gedehnt. Eine Verschiebung ist entweder in den Grenzen der jeweils nächsten Kontrollpunkte
(Standardverhalten), oder bis zu den jeweils nächsten Begrenzungspunkten möglich (hierzu muss
beim Verschieben zusätzlich die Shift Taste gedrückt werden).

Scrollbar Unterhalb der Kontrollleiste befindet sich ein Schieberegler. Diesen benötigen Sie nur, wenn
Sie mit Hilfe der am unteren Rand des Editorfensters befindlichen Schaltflächen die Darstellung
des Farbverlaufes vergrößern.

Dauernd auffrischen Mit diesem Kontrollkästchen können Sie einstellen, ob die am Farbverlauf vor-
genommenen Änderungen sofort angezeigt werden sollen, oder erst nach einem weiteren Klick
auf eine Schaltfläche

Schaltflächen Am unteren Rand des Editorfensters befinden sich, von links nach rechts betrachtet,
folgende Schaltflächen:

Speichern Beim Betätigen dieser Schaltfläche wird der Farbverlauf in seinem aktuellen Zustand
unter dem angegebenen Namen in Ihrem persönlichen GIMP Profil im Ordner gradients
gespeichert. So gesicherte Farbverläufe werden bei späteren Neustarts von GIMP automa-
tisch geladen.

Zurücksetzen Durch Anklicken dieser Schaltfläche werden alle im Editor vorgenommenen Änderungen
zurückgesetzt. Anmerkung: Diese Funktion ist in den aktuellen Versionen von GIMP leider
nicht verfügbar.

Herauszoomen Durch Betätigen dieser Schaltfläche können Sie aus einer vergrößerten Darstel-
lung des Farbverlaufes wieder heraus zoomen.

Hineinzoomen Durch Anklicken dieser Schaltfläche können Sie die aktuelle Darstellung des Farb-
verlaufes vergrößern. Sie können dann die unterhalb der Kontrollleiste befindliche Scrollbar
benutzen, um in der Darstellung des Farbverlaufes zu navigieren.

Alles anzeigen Durch Anklicken dieser Schaltfläche wird die Vergrößerung der Darstellung des
Farbverlaufes so eingestellt, dass dieser gerade noch vollständig angezeigt wird.
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Abbildung 8.29. Ansicht des Kontextmenüs des Editors

Das Kontextmenü des Farbverlaufseditors Das Kontextmenü zum Farbverlaufseditor enthält wich-
tige Kommandos, um Segmente und die zugeordneten Farben zu bearbeiten. Beachten Sie, dass das
Kontextmenü nur für solche Farbverläufe zugänglich ist, die Sie auch verändern dürfen. Insbesondere
ist das Kontextmenü des Editors nicht zugänglich, wenn Sie einen mit GIMP ausgelieferten Farbverlauf
im Editor geöffnet haben.

Im Folgenden werden die einzelnen Kommandos, welche über das Kontextmenü aufgerufen werden
können, erläutert.

Farbe des linken/rechten Endpunktes Mit diesem Kommando können Sie die Farbe des linken bzw.
rechten Endpunktes des aktiven Segmentes einstellen. Hierzu wird bei Ausführung des Komman-
dos der GIMP Farbeditor geöffnet.

Abbildung 8.30. Inhalt des Untermenüs ”Farbe laden von“

Linke/Rechte Farbe laden von

Diese Menüeinträge geben Ihnen verschiedene Alternativen zur Beschaffung der Farben der Be-
grenzungspunkte. Die Menüeinträge sind für die Auswahl der Farbe eines linken Begrenzungs-
punktes. die Einträge für rechte Begrenzungspunkte lauten entsprechend.

Rechtem Endpunkt des linken Nachbars Mit diesem Kommando wird die Farbe aus dem rech-
ten Begrenzungspunkt des Segmentes bestimmt, welches auf der linken Seite an das aktive
angrenzt. Dies ist sozusagen die ”andere Seite“ des Punktes für den die Farbe geladen werden
soll.
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Rechter Endpunkt Mit diesem Kommando wird die Farbe aus dem rechten Begrenzungspunkt
des aktiven Segmentes bestimmt. Damit erhalten beide Begrenzungspunkte des Segmentes
die gleiche Farbe.

Vordergrundfarbe; Hintergrundfarbe Mit diesen beiden Kommandos wird die Farbe für den Be-
grenzungspunkt aus der aktiven Vordergrund- bzw. Hintergrundfarbe bestimmt.

RGBA Einträge Die weiteren Einträge dieses Menüs enthalten verschiedene vordefinierte Far-
beinträge. Sie können diese zuweisen, indem Sie das weiter unten in diesem Kapitel beschrie-
bene Speichern Kommando verwenden. Für die Einträge sind jeweils die Farbkomponenten
Rot, Grün, Blau sowie Deckkraft (Alpha) als Werte von 0.0 bis 1.0 angegeben.

Linke / Rechte Farbe speichern Bei diesem Menüpunkt handelt es sich um ein Untermenü, in wel-
chem die verschiedenen Speicherplätze für die vordefinierten Farben enthalten Sind. Sie können
durch Auswählen eines dieser Plätze die aktuelle Farbe des Begrenzungspunktes speichern.

Abbildung 8.31. Ansicht des Untermenüs ”Farbverlaufsfunktionen“

Farbverlaufsfunktion für Segment

Mit den Kommandos in diesem Menü können Sie festlegen, welche Form der Farbübergang in-
nerhalb eines Segmentes haben soll. Die Form wird dabei durch eine mathematische Funktion
beschrieben. Folgende Funktionen stehen zur Auswahl:

Linear Dies ist die Standardeinstellung. Die der Übergang erfolgt linear von einer Farbe zur An-
deren.

Kurven Die Veränderung der Farb erfolgt an den Rändern stärker als in der Mitte (Gaussglocke).

Sinusartig Das Gegenstück zu ”Kurven“. Die Veränderung ist in der Mitte wesentlich stärker, als
an den Rändern.

Sphärisch (zunehmend) Der Übergang erfolg an der linken Seite schneller, als an der Rechten.

Sphärisch (abnehmend) Der Übergang erfolg an der rechten Seite schneller, als an der Linken.

Abbildung 8.32. Ansicht des Untermenüs ”Färbungsart“

Färbungsart für Segment

In diesem Untermenü sind verschiedene Kommandos enthalten, mit denen Sie die einstellen können,
auf Basis welches Farbmodells die die beiden Grundfarben eines Segmentes ineinander überführt
werden.

Segment spiegeln Mit diesem Kommando können Sie ein einzelnes, oder mehrere aktivierte Segmente
spiegeln.
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Segment duplizieren Mit diesem Kommando können Sie die aktivierten Segmente duplizieren. Dabei
werden die duplizierten Segmente so gestaucht, dass das Original und das Duplikat jeweils die
halbe Ausgangsbreite haben.

Segment mittig teilen Mit diesem Kommando splitten Sie jedes der ausgewählten Segmente am Kon-
trollpunkt des Segmentes in zwei neue Segmente auf.

Segment gleichmäßig teilen Dieses Kommando wirkt ähnlich wie das vorher beschriebene, mit dem
Unterschied, dass die Segmente in der Mitte und nicht am Kontrollpunkt aufgesplittet werden.

Segment löschen Mit diesem Kommando können Sie alle ausgewählten Segmente löschen. Dabei
wird der gesamte gelöschte Bereich entfernt und der linke und rechte Begrenzungspunkt des
gelöschten Bereiches werden verschmolzen. Die direkt angrenzenden Segmente werden entspre-
chend vergrößert.

Mittelpunkt des Segmentes zentrieren Mit diesem Kommando werden die durch die weissen Dreie-
cke dargestellten Kontrollpunkte jedes Segmente mittig zwischen den zugehörigen Begrenzungs-
punkten ausgerichtet.

Punkte gleichmäßig im Segment verteilen Mit diesem Kommando können Sie die Begrenzungs- und
Kontrollpunkte in den ausgewählten Segmenten so verteilen, dass zwischen allen jeweils der glei-
che Abstand besteht.

Farben der Endpunkte mitteln Wenn Sie dieses Kommando ausführen, werden die Farben Begren-
zungspunkte der ausgewählten Segmente so eingestellt, dass der Verlauf möglichst ”weich“ er-
scheint. Dieses Kommando ist nur ausführbar, wenn mindestens zwei Segmente ausgewählt wur-
den.

Deckkraft der Endpunkte mitteln Wenn Sie dieses Kommando ausführen, wird die Deckkraft der Be-
grenzungspunkte der ausgewählten Segmente so eingestellt, dass der Verlauf möglichst ”weich“
erscheint. Dieses Kommando ist nur ausführbar, wenn mindestens zwei Segmente ausgewählt
wurden.

ACHTUNG

Da es im Farbverlaufseditor momentan keine ”Undo“ Funktion gibt, sollten Sie
beim ausprobieren Vorsicht walten lassen.

8.3.5. Der Dialog ”Farbpaletten“

Eine Farbpaletten in GIMP ist eine festgelegte Menge von Farben ohne feste Reihenfolge. Weitere Infor-
mationen zum GIMP Konzept der Paletten finden Sie im Abschnitt 2.3.11 auf Seite 50.

Eine der zentralen Aufgaben des Dialoges ist die Präsentation und Aktivierung, sowie die Erstellung
und Bearbeitung von Farbpaletten zu ermöglichen. Hierzu werden die Farbpaletten in einer Listen- oder
alternativ in einer Rasterdarstellung angezeigt. Selbst wenn Sie noch keine eigenen Farbpaletten erstellt
haben, stehen Ihnen verschiedene mit GIMP ausgelieferte Farbpaletten zur Verfügung.

196



KAPITEL 8. DIALOGE 8.3. BILDINHALT BEZOGENE DIALOGE

Abbildung 8.33. Ansicht des Dialoges Farbpaletten

ANMERKUNG

Bitte beachten Sie, dass auch wenn Die Namen ähnlich klingen und die Dialoge
ähnlich aussehen mögen der Dialog ”Farbtabellen“ nichts mit dem hier beschrie-
benen Dialog ”Farbpaletten“ zu tun hat. Farbtabellen dienen in GIMP dazu die in
Bildern im Farbmodus ”Indiziert“ zur Verfügung stehenden Farben mit dem zu-
gehörigen Index zu verwalten. Farbpaletten hingegen stellen eine freie Auswahl
an Farben da, welche Sie bei der Bearbeitung von Bildern in beliebigen Farbmodi
verwenden können.

8.3.5.1. Dialogaufruf

Der Farbpalettendialog ist ein dockbarer Dialog und kann auf verschiedenen Wegen aufgerufen werden:

• Über das Werkzeugfenstermenü: Datei → Dialoge → Farbpaletten

• Über das Bildmenü: Dialoge → Farbpaletten

• Über das Reitermenü eines anderen Dialogs: Reiter hinzufügen → Farbpaletten

8.3.5.2. Aufbau und Benutzung des Dialoges ”Farbpaletten“

Sie können eine Palette aktivieren, indem Sie diese im Dialog anklicken. Die aktive Palette wird dann
entsprechend optisch hervorgehoben. Durch einen Doppelklick auf eine Palette wird diese Palette im
Paletteneditor zur Bearbeitung geöffnet.

Falls die Darstellung der Farbpaletten im Dialog im Listenmodus erfolgt, können Sie durch einen
Doppelklick auf den Namen der Palette ein Eingabefeld öffnen, um den Namen der Farbpalette zu
ändern. Beachten Sie in diesem Zusammenhang bitte, dass diejenigen Farbpaletten, welche mit GIMP
ausgeliefert wurden nicht verändert werden können. Dies gilt auf für die Änderung des Namens. Um
eine solche Palette zu verändern, erstellen Sie sich einfach eine eigene Kopie.

Im Reitermenü des Dialoges können Sie die Darstellung zwischen als Liste anzeigen und als
Raster anzeigen umschalten. In der Rasterdarstellung (welche die Standarddarstellung ist), wer-
den die Farbpaletten in einem rechteckigen Feld angezeigt. In der Listendarstellung hingegen wird
jede Palette als Eintrag in einer Liste dargestellt. Neben der schematischen Darstellung der Palet-
ten wird dabei deren Name angezeigt.
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Abbildung 8.34. Ansicht des Dialoges ”Farbpaletten“

Raster- und Listendarstellung
(a) Der Dialog in Rasterdar-
stellung

(b) Der Dialog in Listendar-
stellung

TIPP

Im Reitermenü können Sie im Untermenü Vorschaugröße die Größe sym-
bolischen Darstellung im Dialog einstellen.

Farbpalette bearbeiten Unterhalb der Darstellung der Farbpaletten befinden sich verschiedene Schalt-
flächen. Durch Verwenden der Schaltfläche Farbpalette bearbeiten öffnet sich die aktive Farbpa-
lette im Farbpaletteneditor.

Neue Farbpalette Eine Beschreibung dieser Schaltfläche finden Sie im Abschnitt Neue Farbpalette.

Farbpalette duplizieren Eine Beschreibung dieser Schaltfläche finden Sie im Abschnitt Farbpalette du-
plizieren.

Farbpalette löschen Eine Beschreibung dieser Schaltfläche finden Sie im Abschnitt Farbpalette löschen.

Farbpaletten neu laden Eine Beschreibung dieser Schaltfläche finden Sie im Abschnitt Farbpaletten
neu laden.

8.3.5.3. Kontextmenü des Dialoges ”Farbpaletten“

Abbildung 8.35. Ansicht des Kontextmenüs des Dialoges ”Farbpaletten“

Alternativ zum Kontextmenü finden Sie die Kommandos auch im Untermenü Farbpalettenmenü
des Reitermenüs des Dialoges.
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Farbpalette bearbeiten Mit diesem Kommando steht Ihnen ein alternativer Weg zur Verfügung, um
den Paletteneditor zu öffnen. Dabei wird die im Dialog aktivierte Farbpalette zur Bearbeitung in
den Editor geladen.

Neue Farbpalette Mit diesem Kommando wird eine neue Farbpalette erzeugt, welche zunächst weder
einen Namen hat, noch Farben enthält. Diese Farbpalette wird automatisch im Farbpaletteneditor
zur Bearbeitung geöffnet.

Abbildung 8.36. Das Dialogfenster ”Farbpalette importieren“

Farbpalette importieren

Mit diesem Kommando können Sie eine neue Farbpalette aus einem gespeicherten Farbverlauf, ei-
nem Bild oder einer gespeicherten Farbpalette erzeugen. Hierzu wird bei Aufruf des Kommandos
ein Dialogfenster mit folgendem Inhalt angezeigt:

Quelle auswählen In oberen Bereich des Dialogfensters können Sie die Quelle auswählen, aus
der Sie die Farbpalette im portieren möchten. Zur Auswahl stehen dabei sämtliche aktuell
in GIMP geladene Farbverläufe und Bilder. Darüber hinaus haben Sie die Möglichkeit eine
Datei anzugeben. Dabei kann es sich um eine Datei mit der Endung .pal handeln. Das da-
zugehörige RIFF Dateiformat wird unter anderem von verschiedenen Microsoft Windows
Anwendungen erzeugt.

Palettenname In dem zugehörigen Texteingabefeld können Sie einen Namen für die neu zu er-
stellende Farbpalette angeben. Falls der gewählte Name bereits an eine Farbpalette vergeben
ist, wird an den eingegebenen Name automatisch eine Erweiterung der Form ”#1“ angehängt.

Anzahl der Farben Hier steht Ihnen ein Schieberegler mit zugeordnetem Eingabefeld zur Verfügung,
welches der Festlegung der Anzahl der Farben der neuen Farbpalette dient. Die Standarde-
instellung ist 256. Die Gründe, weshalb die Standardeinstellung so gewählt wurde sind fol-
gende: (1) Jeder Farbverlauf besteht aus genau 256 Farben; (2) Im GIF Format gespeicherte
Bilder bestehen aus maximal 256 verschiedenen Farben; (3) Bilder im Farbmodus ”Indiziert“
umfassen höchstens 256 verschiedene Farben. Sollten Sie für de Import die Anzahl der Far-
ben größer wählen, als die Anzahl der Farben in der Quelle, so wird GIMP die Farbpalette
mit zusätzlichen Farben füllen, welche Zwischentöne zu den importieren Farben sind.

Spalten In diesem Bereich steht Ihnen ein Schieberegler mit zugeordnetem Eingabefeld zur Ein-
stellung der Anzahl der Spalten zur Verfügung. Diese Einstellung hat lediglich Einfluss dar-
auf, wie die Palette dargestellt wird, nicht auf deren Inhalt.
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Intervall Hmm, keine Ahnung. Wenn Sie es herausfinden, schicken Sie uns eine mail :)

Die importierte Palette wird im Dialog angezeigt und automatisch in Ihrem GIMP Profil im Ordner
palettes gespeichert. Daher steht sie Ihnen auch nach einem Neustart von GIMP wieder zur
Verfügung.

Farbpalette duplizieren Mit diesem Kommando können Sie die im Dialog ausgewählte Farbpalette
duplizieren. Darüber hinaus wird die neu erzeugte Palette automatisch im Paletteneditor geöffnet,
so dass Sie beispielsweise den Namen anpassen können. Die neue Farbpalette wird automatisch in
Ihrem GIMP Profil im Ordner palettes abgelegt, und daher bei jedem Start von GIMP geladen.

Farbpaletten vereinen Dieses Kommando ist aktuell leider (noch) nicht verfügbar.

Farbpalette löschen Mit diesem Kommando können Sie die aktuell im Dialog ausgewählte Farbpalet-
te löschen. Dabei wird auch die Palette auch aus Ihrem persönlichen GIMP Profil gelöscht, steht
Ihnen also auch nach einem Neustart von GIMP nicht mehr zur Verfügung.

Farbpaletten neu laden Mit diesem Kommando können Sie GIMP veranlassen alle Ordner, welche
in GIMP als Ablage von Dateien mit Farbpaletten bekannt sind, nach neuen Paletten zu durch-
suchen. Werden dabei neue Farbpaletten gefunden, so werden diese geladen und im Dialog an-
gezeigt. Sinnvoll ist dieses Kommando, wenn Sie während GIMP gestartet ist, neue Dateien mit
Farbpaletten erhalten, einspielen und nutzen möchten.

8.3.5.4. Der Paletteneditor

Abbildung 8.37. Ansicht des GIMP Paletteneditors

Der Farbpaletteneditor wird hauptsächlich für zwei Aufgaben verwendet: Auf der einen Seite wird er
zur Auswahl der aktiven Vorder- und Hintergrundfarbe im GIMP verwendet. Der andere Einsatzzweck
ist die Bearbeitung einer Palette, also das Hinzufügen, entfernen und verändern von Farbeinträgen in
der Palette. Sie können den Farbpaletteneditor für jede Palette, die im Dialog angezeigt wird, aufrufen.
Verändern können Sie jedoch nur Farbpaletten, welche Sie selbst erzeugt haben. Insbesondere können
Sie die Farbpaletten, welche mit GIMP ausgeliefert wurden, nicht verändern. Um eine mitgelieferte
Palette zu ändern, erzeugen Sie am besten eine Kopie, indem Sie die gewünschte Palette duplizieren. Die
im Farbpaletteneditor vorgenommenen Veränderungen werden beim Beenden von GIMP automatisch
in Ihrem GIMP Profil gespeichert.

Aufruf des Editors Der Farbpaletteneditor kann ausschließlich aus dem Dialog Farbpaletten heraus
aufgerufen werden. Dies kann entweder durch einen Doppelklick auf einen Paletteneintrag im Dialog
erfolgen, durch Anklicken der Schaltfläche Farbpalette bearbeiten oder durch den Aufruf des gleich-
namigen Kommandos aus dem Reitermenü des Dialoges.

Der Farbpaletteneditor ist ein eigenständiger GIMP Dialog. Er kann daher mit anderen Dialogen
gruppiert werden. Weitere Informationen dazu finden Sie im Abschnitt 2.1.3 auf Seite 23.

200



KAPITEL 8. DIALOGE 8.3. BILDINHALT BEZOGENE DIALOGE

Aufbau und Benutzung des Dialoges ”Farbpaletteneditor“ Im zentralen Bereich des Dialogfensters
werden die einzelnen in der Palette enthaltenen Farben in kleinen, rechteckigen Bereichen angezeigt.
Durch anklicken einer Farbe, wird diese zur aktuellen Vordergrundfarbe in GIMP. Wenn Sie während
des Anklickens die Strg Taste gedrückt halten, wird statt der Vordergrund- die Hintergrundfarbe ge-
setzt.

Wenn Sie auf die Farbeinträge des Editors einen Doppelklick ausführen, wird zusätzlich zum Setzen
der aktiven Vordergrund- bzw. Hintergrundfarbe noch der GIMP Farbeditor geöffnet. Diesen können
Sie dazu verwenden, die Farbe des Paletteneintrages zu verändern.

Im Bereich unterhalb der Anzeige der Farbfelder der Palette befindet sich ein Bereich, in dem der
Name und die Beschreibung der aktuell ausgewählten Farbe angezeigt werden. Diese Anzeige dient
ausschließlich zur informativen Zwecken.

Rechts neben der Anzeige für den Farbnamen befindet sich ein Textfeld zur Eingabe der Anzahl der
Spalten in denen die Farbfelder angeordnet werden. Diese Einstellung hat keinen Einfluß auf den Inhalt
der Palette, sondern bestimmt ausschließlich die Anordnung der Farbfelder in der Darstellung.

Im unteren Bereich des Dialogfensters befindet sich eine Reihe von Schaltflächen. Diese stellen im
Wesentlichen die gleichen Funktionen zur Verfügung wie das Kontextmenü des Farbpaletteneditors.
Die folgenden Abschnitte enthalten eine Beschreibung der Schaltflächen.

Speichern Beim Betätigen dieser Schaltfläche wird die Farbpalette in ihrem aktuellen Zustand unter
dem angegebenen Namen in Ihrem persönlichen GIMP Profil im Ordner palettes gespeichert.
So gesicherte Farbpaletten werden bei späteren Neustarts von GIMP automatisch geladen.

Zurücksetzen Durch Anklicken dieser Schaltfläche werden alle im Editor vorgenommenen Änderungen
zurückgesetzt. Anmerkung: Diese Funktion ist in den aktuellen Versionen von GIMP leider nicht
verfügbar.

Farbe bearbeiten Durch Anklicken dieser Schaltfläche können Sie die Farbe des aktiven Farbfeldes
verändern. Hierzu wird die Farbe des Feldes in den sich öffnenden Farbeditor geladen. Fall Sie die
im Editor angezeigt Farbpalette nicht verändern dürfen, ist die Schaltfläche ausgegraut dargestellt.

Neue Farbe aus VG/HG Beim Betätigen dieser Schaltfläche wird eine neues Farbefeld in die Palette
aufgenommen. Dieses wird mit der aktuellen Vordergrund- bzw. bei gedrückt halten der Strg, der
aktuellen Hintergrundfarbe gefüllt. Fall Sie die im Editor angezeigt Farbpalette nicht verändern
dürfen, ist die Schaltfläche ausgegraut dargestellt.

Farbe löschen Mit Hilfe dieser Schaltfläche können Sie das aktuelle Farbfeld aus der Palette entfernen.
Fall Sie die im Editor angezeigt Farbpalette nicht verändern dürfen, ist die Schaltfläche ausgegraut
dargestellt.

Herauszoomen Durch Betätigen dieser Schaltfläche können Sie aus einer vergrößerten Darstellung der
Farbfelder wieder heraus zoomen.

Hineinzoomen Durch Anklicken dieser Schaltfläche können Sie die aktuelle Darstellung der Farbfelder
vergrößern.

Alles anzeigen Durch Anklicken dieser Schaltfläche wird die Vergrößerung der Darstellung der Farb-
palette so eingestellt, dass diese gerade noch vollständig angezeigt wird.

8.3.5.5. Kontextmenü des Farbpaletteneditors

Sie können das Kontextmenü des Farbpaletteneditors neben den üblichen Möglichkeiten auch über den
ersten Eintrag des Reitermenüs öffnen. Außerdem stehen die Kommandos des Kontextmenüs alternativ
über die Schaltflächen am unteren Rand des Editorfensters zur Verfügung.
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Abbildung 8.38. Ansicht des Kontextmenüs des Farbpaletteneditors

Farbe bearbeiten Durch Anklicken dieser Schaltfläche können Sie die Farbe des aktiven Farbfeldes
verändern. Hierzu wird die Farbe des Feldes in den sich öffnenden Farbeditor geladen. Fall Sie die
im Editor angezeigt Farbpalette nicht verändern dürfen, ist die Schaltfläche ausgegraut dargestellt.

Neue Farbe aus VG/HG Beim Betätigen dieser Schaltfläche wird eine neues Farbefeld in die Palette
aufgenommen. Dieses wird mit der aktuellen Vordergrund- bzw. bei gedrückt halten der Strg, der
aktuellen Hintergrundfarbe gefüllt. Fall Sie die im Editor angezeigt Farbpalette nicht verändern
dürfen, ist die Schaltfläche ausgegraut dargestellt.

Farbe entfernen Mit Hilfe dieser Schaltfläche können Sie das aktuelle Farbfeld aus der Palette ent-
fernen. Fall Sie die im Editor angezeigt Farbpalette nicht verändern dürfen, ist die Schaltfläche
ausgegraut dargestellt.

Herauszoomen Durch Betätigen dieser Schaltfläche können Sie aus einer vergrößerten Darstellung der
Farbfelder wieder heraus zoomen.

Hineinzoomen Durch Anklicken dieser Schaltfläche können Sie die aktuelle Darstellung der Farbfelder
vergrößern.

Alles anzeigen Durch Anklicken dieser Schaltfläche wird die Vergrößerung der Darstellung der Farb-
palette so eingestellt, dass diese gerade noch vollständig angezeigt wird.

8.3.6. Der Dialog ”Schriften“

Abbildung 8.39. Ansicht des Dialoges ”Schriften“

Der Dialog ”Schriften“ dient Ihnen zur Auswahl von Schriftarten, um diese im Textwerkzeug zu ver-
wenden. Ausserdem erlmöglicht es Ihnen der Dialog die Liste der verfügbaren Schriften zu aktualisie-
ren. Dies ist hilfreich sobald Sie, während GIMP gestartet ist, Schriften zu Ihrem System hinzufügen.
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8.3.6.1. Dialogaufruf

Der Dialog ”Schriften“ ist ein dockbarer Dialog und kann auf verschiedenen Wegen aufgerufen werden:

• Über das Werkzeugfenstermenü: Datei → Dialoge → Schriften

• Über das Bildmenü: Dialoge → Schriften

8.3.6.2. Aufbau und Benutzung des Dialoges ”Farbverlauf“

Die einfachste Art und Weise den Dialog zu verwenden besteht darin auf eine der aufgelisteten Schrift-
arten zu klicken. Diese Schriftart wird damit aktiviert und wird im Textwerkzeug verwendet. Um eine
ausführlichere Darstellung der Schriftart zu erhalten, klicken Sie auf eines der Schriftsymbole ( Aa ) und
halten die Maustaste gedrückt. Nach einigen Sekunden wird ein Fenster eingeblendet, in welchem ein
kurzer Text in der entsprechenden Schriftart angezeigt wird.

Abbildung 8.40. Ansicht des Dialoges ”Schriften“

Raster/Listen Modus
(a) Der Dialog in Rasterdar-
stellung

(b) Der Dialog in Listendar-
stellung

Im Reitermenü des Schriftendialoges können Sie zwischen Als Liste anzeigen und Als Raster
anzeigen wählen. Bei der letzteren Anzeigeart werden die Schriftarten platzsparend, einer ne-
ben dem anderen, dargestellt. Die Übersichtlichkeit leidet zu Gunsten des schnellen Zugriffs. Im
Listenmodus (Vorgabe-Einstallung) ist die Darstellung übersichtlicher, benötigt allerdings mehr
Platz.

Schriftenliste neu einlesen Diese Schaltfläche finden Sie am unteren Rand des Dialoges. Eine Betätigung
bewirkt, dass GIMP die durch das Betriebssystem Ihres Computers zur Verfügung gestellte Liste
von verfügbaren Schriftarten neu einliest und diese Schriftarten in GIMP zur Verfügung stellt. Sie
können diese Funktion alternativ auch über das Kontextmenü des Dialoges unter der Bezeichnung
Schriften neu einlesen aufrufen.

TIPP

Sie können die Größe der Schriftartenvorschau im Dialogmenü mit Hilfe
der Kommandos im Untermenü Vorschaugröße anpassen.
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Abbildung 8.41. Ansicht des Dialoges ”Bilder“

8.4. Verwaltungsbezogene Dialoge

8.4.1. Der Dialog ”Bilder“

Der ”Bilder“ Dialog zeigt die Liste der aktuell geöffneten Bilder. Jedes dieser Bilder wird als Vorschau-
bild angezeigt. Dieser Dialog ist besonders nützlich, wenn Sie viele sich überlappende Bilder auf Ihrem
Bildschirm haben. Über diesen Dialog können Sie das gewünschte Bild in den Vordergrund bringen.

Der Bilder Dialog ist dockbar. Sehen Sie dazu auch: Docken von Dialogen um eine Hilfe für den
Umgang damit zu erhalten. Er kann auf verschiedene Arten aufgerufen werden:

• Aus dem Werkzeugfenstermenü: Datei → Dialoge → Bilder.

• Aus dem Bildmenü: Dialoge → Bilder.

• Über das Reitermenü eines anderen Dialoges: Reiter hinzufügen → Bilder.

8.4.1.1. Raster/Listen Modus, Größe der Vorschaubilder

Wie in jedem Dialog mit Vorschaubildern ermöglicht Ihnen das Reitermenü, die Art der Vorschau nach
Belieben anzupassen. Sehen Sie dazu auch Docken von Dialogen

8.4.1.2. Bilderdialog benutzen

Als erster in der Liste erscheint der Name des aktuell aktiven Bildes, wenn die ”Bildauswahl anzeigen“
Option im Reitermenü ausgewählt ist. Das gilt nicht bei gewählter Option ”Als Raster anzeigen“. Aber
in jedem Fall: Der Name wird angezeigt.

Dahinter werden die geöffneten Bilder angezeigt, je nach Modus als Raster oder als Liste. Im Lis-
tenmodus wird das aktuell aktive Bild farbig unterlegt. Im Rastermodus wird es umrandet angezeigt.
Mit einem Doppelklick mit der linken Maustaste auf ein Vorschaubild bringen Sie das gewünschte Bild
in den Vordergrund. Um Aktionen über die Schaltflächen im unteren Bereich des Dialogfensters aus-
zuführen, wählen Sie das jeweilige Vorschaubild mit einem einfachen Mausklick aus.

Im unteren Bereich des Dialogfensters befinden sich Schaltflächen, die folgendem Zwecken dienen:

• Die Ansichten dieses Bildes anheben: Das ausgewählte Bild wird in den Vordergrund Ihres Bild-
schirms ”gehoben“.

• Eine neue Ansicht für dieses Bild erzeugen: Erstellt ein Duplikat des gewählten Bildes.

• Löschen: Diese Schaltfläche hat keine Wirkung.

8.4.2. Der Dialog ”Dokumentenindex“

Öffnen Sie Bilder, die Sie in früheren Sitzungen geöffnet haben.
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Abbildung 8.42. Ansicht des Dialoges Dokumentenindex

8.4.2.1. Aufbau und Benutzung des Dialoges ”Dokumentenindex“

Die Bilder öffnen Sie entweder mit einem doppelten Mausklick auf das Bild oder die erste Schaltfläche
von Links.

Sie können mit der mittleren Schaltfläche selektierte Einträge löschen.
Mit der letzten Schaltflächen können Sie die Liste erneuern, um Änderungen die den Speicherort des

Bildes betreffen berücksichtigen zu können. Halten Sie dabei Strg gedrückt, um gelöschte Bilder vom
früheren Speicherort aus der Liste zu entfernen.

8.5. Sonstige Dialoge

8.5.1. Einstellungen Einführung

8.5.1.1. Einführung

Abbildung 8.43. Die Liste der verschiedenen Einstellungsansichten

Im Einstellungen Dialog können Sie jede Funktion oder Werkzeug des GIMPs Ihren Wünschen an-
passen. Der Einstellungsdialog kann nur im Werkzeugfenster erreicht werden: Datei→ Einstellungen.
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8.5.1.2. Vorgabeeinstellungen für neue Bilder

Abbildung 8.44. Die Einstellungsansicht für neue Bilder

Verändern Sie Vorgabe-Einstellungen des Dialogs zum Erstellen eines neuen Bildes.

8.5.1.3. Vorgabe-Bildgitter

Diese Ansicht lässt Sie Vorgabe-Einstellungen des Bildgitters verändern. Für weitere Informationen
schauen Sie bitte unter Konfigurieren des Bildgitters nach.

8.5.1.4. Benutzeroberfläche

OPTIONEN

Vorschaubilder Durch das standardmässig aktivierte Kontrollkästchen unter Vorschau von Ebenen
und Kanälen aktivieren werden im Ebenen- undKanaldialog automatisch Miniaturbilder ange-
zeigt.

Sie können die Standardgrösse der Miniaturbilder in Dialogen vorbestimmen. Wählen Sie eine
Grössenordnung zwischen Winzig und Gigantisch.

Tastenkürzel Aktivieren Sie das Kontrollkästchen um Tastenkürzel in Menüs dynamisch zuordnen zu
können.

Wählen Sie mit der Maus einen Menüpunkt, dem Sie einen neuen Tastenkürzel zuordnen möchten;
klicken dabei aber nicht den Menüpunkt an. Durch betätigen der Tasten Ihres Tastenkürzels wei-
sen Sie einen neuen Tastenkürzel dem Menüpunkt zu.
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Abbildung 8.45. Einstellen des Vorgabe-Bildgitters

ANMERKUNG

Nachdem Sie neue Tastenkürzel zugeordnet haben, werden die GIMP ei-
genen Standardtastaturkürzel überschrieben.

8.5.1.5. Thema

GIMP bietet Ihnen die Möglichkeit, zwischen zwei Standardthemen zu wählen. Themen haben Aus-
wirkung auf das Aussehen der Benutzeroberfläche. Es beeinflußt die zu benutzenden Symbole (oder
auch Icons genannt), Schriftarten oder Elementeanordnung in Dialogen. GIMP erscheint mit zwei Stan-
dardthemen: Default und Small. Default wird für die meisten Benutzer genau das richtige sein, wobei
Small Symbole für kleinere Montiorauflösungen bietet. Sobald Sie auf ein Theme klicken, findet dieses
sofort Anwendungen. Sie können sich gleich entscheiden, ob es Ihnen gefällt oder nicht.

Es steht Ihnen somit frei, welche Themen sie verwenden. Sie können verfügbare Themen aus dem In-
ternet herunterladen, oder einfach selber eines erstellen, indem Sie eins der vorhandenen kopieren und
anpassen. Angepaßte Themen sollten in das themes Verzeichnis in ihrem lokalen GIMP Verzeichnis
plaziert werden. Sobald das Thema dort plaziert ist, erscheint es in der Liste nach dem nächsten Start.
Jedes Thema ist eine Menge an Bild- und ASCII Dateien. Die Anpassung dieser gehört leider nicht mehr
zu dieser Benutzerdokumentation. Sie selber sind jedoch dazu angespornt herum zu experimentieren.
Im schlimmsten Fall, können Sie wieder zu einem der Standardthemen zurückkehren.

Beim editieren von Themen können Sie GIMP mitteilen, die veränderten Themendaten wieder zu
aktualisieren damit ihre Änderungen auch sichtbar werden. Durch einen Klick auf die Momentan ver-
wendetes Thema neuladen Schaltfläche können Sie die Themendaten aktualisieren.
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Abbildung 8.46. Die Einstellungsansicht zum Anpassen der Benutzeroberfläche. Verändern Sie das Ver-
halten von Dialogen oder Menüs in dieser Einstellungsansicht.

8.5.1.6. Hilfesystem

Optionen ALLGEMEIN

Minihilfen anzeigen Bei aktiviertem Kontrollkästchen, werden Ihnen Minihilfen (sog. Tooltips) ange-
zeigt. Bewegen sie den Mauszeiger über Bedienelemente von GIMP und warten wenige Sekunden
um Minihilfen zu sehen.

”F1ßeigt kontextabhängige Hilfe an Es wird Ihnen bei drücken der F1-Taste eine Hilfe angezeigt. Die
angezeigte Hilfe richtet sich nach dem Bedienelement, über dem sich der Mauszeiger bei aktivie-
ren der Hilfe, befindet.

Tipps beim Start anzeigen Bei jedem Start von Gimp wird ihnen in einem Dialog, ein Tipp über die
Benutzung von Gimp angezeigt.

HILFE-BROWSER

Zu verwendender Hilfe-Browser Wählen Sie als Anzeigeprogramm zwischen den Gimp internen Hil-
febrowser oder den Web Browser, den sie nachfolgend einstellen können.

ANMERKUNG

Der Hilfe-Browser steht für einige Plattformen (z.B. Microsoft Windows)
nicht zur Verfügung wie auch die Möglichkeit den Browser manuell anzu-
geben. Um die Gimp Hilfe dennoch anzuzeigen, wird der im System als
Standard eingestellte Browser benutzt.
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Abbildung 8.47. Einstellen des GIMP Themas

WEBBROWSER

Zu verwendender Hilfe-Browser Wählen Sie einen Webbrowser, der die Hilfeseiten anzeigen soll.

ANMERKUNG

Die Möglichkeit um den Browser manuell anzugeben, steht nicht auf al-
len Plattformen zur Verfügung (z.B. Microsoft Windows). Um dennoch die
Gimp Hilfe anzeigen zu können, benutzt Gimp Ihren Standardbrowser.

8.5.1.7. Werkzeugeinstellungen

Optionen MAGNETISCHE HILFSLINIEN UND GITTER

Reichweite des Magneten ”Magnetisch”heisst in Bezug auf Hilfslinien, dass diese Mauseingaben auf
die in den Einstellungen angegebenen Wert anziehen. Das ist in der Hinsicht nützlich, dass sie z.B.
Bildobjekte anordnen können oder mit Hilfe der Malwerkzeuge gerade Linien zeichnen können.
Bildobjekte die in Reichweite der Hilfslinien kommen, werden zu den Hilfslinien angezogen.

ZUSAMMENHÄNGENDE BEREICHE FINDEN

Voreingestellter Schwellwert Werkzeuge wie der Fülleimer oder den Zauberstab benutzen Algorith-
men um Farbbereiche zu finden, die sich in ihrer Farbe ähnlich sind, aber vielleicht in Bezug auf
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Abbildung 8.48. Die Einstellungen zum Hilfesystem (Linux Screenshot). Diese Ansicht lässt Sie das
Verhalten und den Gebrauch der Gimp-Hilfe anpassen.

Helligkeit unterscheiden. Mit dem voreingestellten Schwellwert bestimmen Sie, ab welchen Punkt
diese Werkzeuge Farbbereiche noch als ähnlich bestimmen.

SKALIERUNG

Voreingestellte Interpolationsart Bei der Skalierung von Bildobjekten, wird jeder neuer Pixel ”hin-
zugeraten”(sog. interpolieren). Damit das Resultat ohne großen Qualitätsverlust erscheint, bietet
Gimp drei verschiedene Interpolationsarten die sich in ihrer Schnelligkeit und damit verbunden
Qualität unterscheiden.

Keine stellt die schnellste Interpolationsart dar, jedoch mit erheblichen Qualitätseinbußen.

Linear ist ein guter Mittelweg zwischen Schnelligkeit und Qualität.

Kubisch ist die qualitativ beste Interpolationsart, die jedoch auf Kosten der Schnelligkeit geht.

MALEINSTELLUNGEN WERDEN

Pinsel, Muster, Farbverlauf Klicken Sie die Kontrollkästchen an, welche Werkzeugeinstellungen ge-
meinsam von den aufgeführten Werkzeugen benutzt werden sollen. Ändern Sie zum Beispiel den
Farbverlauf im Pinselwerkzeug, wird er ebenso im Farbverlaufswerkzeug geändert.
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Abbildung 8.49. Die Einstellungsansicht um die Werkzeuge anzupassen. Die Einstellungsansicht für
Werkzeugeinstellungen lassen sich das Verhalten der Werkzeuge anpassen.

8.5.1.8. Werkzeugfenster

Optionen In der Einstellungsansicht zum Werkzeugfenster können Sie das Aussehen des Werkzeug-
fensters verändern.

ERSCHEINUNGSBILD

Vorder- und Hintergrundfarbe anzeigen Kontrolliert ob die Farbübersicht angezeigt werden soll.

Ausgewählten Pinsel, Muster und Farbverlauf anzeigen Kontrolliert, ob die Werkzeugübersicht an-
gezeigt werden soll.

Aktuelles Bild anzeigen Kontrolliert ob der Bereich zur Anzeige des aktuellen Bildes angezeigt wer-
den soll.

8.5.1.9. Bildfenster

Optionen ALLGEMEIN

”Punkt für Punktäls Vorgabe verwenden ”Punkt für Punkt”bedeuted, dass bei einer Zoomstufe von
1:1 (100%) jeder Pixel der Pixel dem eines Bildschirmpixels entspricht. Bei ausgeschalteter Option,
ist das angezeigte Bild von seiner X und Y Auflösung abhängig. Wenn Sie Grafiken für das Web
erstellen, sollte ”Punkt für Punktëingeschaltet sein. Bei der Erstellung von Druckvorlagen, sollte
die Option jedoch ausgeschaltet sein.

Geschwindigkeit der laufenden Ameisen Hilfslinien zum kennzeichnen von Auswahlen bestehen aus
kleinen weissen und schwarzen Streifen. Da diese Streifen abwechseln angezeigt werden, schei-
nen die Hilfslinien sich wie Ameisen zu bewegen. Das Eingabefeld läßt sie diese Geschwindigkeit
einstellen, wie schnell dieser Wechsel zwischen weiss und schwarz geschehen soll.
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Abbildung 8.50. Die Einstellungsansicht um das Werkzeugfenster anzupassen

Abbildung 8.51.

VERHALTEN BEI GRÖSSENÄNDERUNGEN

Fenstergröße beim Vergrößern und Verkleinern anpassen Bei aktiviertem Kontrollkästchen, wird die
Bildfenstergrösse automatisch der Leinwand angepasst, wenn Sie die Ansicht vergrössern (z.B.
durch Hineinzoomen).

Fenstergröße anpassen, wenn sich die Bildgröße ändert Bei aktiviertem Kontrollkästchen, wird die
Bildfenstergröße automatisch der Leinwand angepasst, wenn sich die Fenstergröße ändert.

Anfänglicher Skalierungsfaktor Wählen sie zwischen Ans Fenster anpassen um ggf. die Leinwand
zu verkleinern, um zu verhindern, dass das Bildfenster zu groß wird. Oder wählen Sie 1:1 um zu
jeder Zeit das Bild in Originalgröße zu sehen.

ZEIGERBEWEGUNG
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Abbildung 8.52. Einstellungsansicht für das Verhalten des Bildfensters. In dieser Ansicht lässt Sie das
Verhalten der Bildfensters anpassen.

Pinselumriss anzeigen Bei aktiviertem Kontrollkästchen, wird Ihnen ein Umriss des aktuell ausgewählten
Pinsels als Mauszeiger angezeigt.

Zeiger des Malwerkzeugs anzeigen Wenn das Kontrollkästchen aktiviert ist, wird neben dem Maus-
zeiger auch ein Symbol des aktuell benutzten Malwerkzeugs angezeigt.

Zeigermodus Wählen Sie zwischen Werkzeug-Icon, Werkzeug-Icon mit Fadenkreuz und Nur Fa-
denkreuz als Mauszeiger.

Zeigeranzeige Wählen Sie Änschaulichüm einen Graustufen Cursor, welcher das aktuelle Werkzeu-
gicon zeigt, zu erhalten. Sie sollten einen SSchwarz/Weiß”Cursor bevorzugen, wenn Sie wenig
Grafikresourcen zur Verfügung haben.

8.5.1.10. Erscheinungsbild der Bildfenster

Die wohl einzigen Einstellungen die einer Erklärung bedürfen sind die Einstellungen der Rahmenfarbe.
Die Rahmenfarbe ist der (Hintergrund-)Bereich des aktiven Bildes1. Für die Rahmenfarbe stehen ihnen
vier verschiedene Optionen zur Verfügung. Letztere läßt ihnen eine eigene Farbe für die Rahmenfarbe
einstellen.

8.5.1.11. Titel und Status des Bildfensters

Auswählen des Formates Sie können zwischen zahlreich, vordefinierten Formaten wählen oder ih-
re eigenes Format erstellen. Eigene Formate werden durch einer selbst definierten Formatzeichenkette
festgelegt, die Gimp interpretieren kann. Die Zeichenkette mag im ersten Augenblick sehr kryptisch
aussehen, ist jedoch nicht schwer zu interpretieren. Alles was sie in die Eingabezeile an Zeichen ein-
geben, wird 1:1 in Titel- oder Statuszeile angezeigt, ausser Variablen. Variablen beginnen alle mit einem
”%”. Folgende Liste gibt einen Überblick, über die zur Verfügung stehenden Variablen:

1 Das aktive Bild bezeichnet hier den Bereich des Bildfensters, auf den Bildoperationen und Werkzeuge angewendet werden
können um das eigentliche Bild zu verändern.
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Abbildung 8.53. Die Einstellungsansicht zum Anpassen des Bildfensters. In dieser Ansicht können Sie
die Vorgabeeinstellungen des Bildfensters anpassen (Vollbild oder normales Fenster). Zusätzlich lassen
sich Einstellungen für ein spezifisches Bildfenster im Ansichtmenü verändern.

ANMERKUNG

Die Variablenbezeichnungen können nicht internationalisiert werden und sind
demzufolge die englischen Originale.

Variable: %f Bedeutung: Blanker Dateiname des Bildes oder ”Namenlos”
Variable: %F Bedeutung: Absoluter Pfad zur Datei oder ”Namenlos”
Variable: %p Bedeutung: Bild-ID, welche eindeutig ist
Variable: %i Bedeutung: Nummer, wenn ein Bild auf mehreren Bildschirmen angezeigt wird
Variable: %t Bedeutung: Bildtyp (RGB, Graustufen, Indiziert)
Variable: %z Bedeutung: Zoom-Faktor in Prozent
Variable: %s Bedeutung: Quellskalierungsfaktor
Variable: %d Bedeutung: Zielskalierungsfaktor
Variable: %Dx Bedeutung: Wird auf x erweitert, falls das Bild als schmutzig gekennzeichnet ist
Variable: %Cx Bedeutung: Wird auf x erweitert, falls das Bild als sauber gekennzeichnet ist.
Variable: %l Bedeutung: Anzahl an Ebenen
Variable: %L Bedeutung: Anzahl an Ebenen (Ausführliche Form)
Variable: %m Bedeutung: Speichernutzung
Variable: %n Bedeutung: Name der aktiven Ebene/Kanal
Variable: %P Bedeutung: ID der aktuellen Ebene/Kanal
Variable: %w Bedeutung: Bildbreite in Pixel
Variable: %W Bedeutung: Bildbreite in Reale Maße
Variable: %h Bedeutung: Bildhöhe in Pixel
Variable: %H Bedeutung: Bildhöhe in Reale Maße
Variable: %u Bedeutung: Einheitensymbol (z.B. px für Pixel)
Variable: %U Bedeutung: Einheitenabkürzung
Variable: %% Bedeutung: ein Buchstabensymbol
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Abbildung 8.54. Einstellungsansicht für die Formatierung der Titel- und Statuszeile. In dieser Ansicht
des Einstellungsdialoges können Sie die Ausgabe der Titel- und Statuszeile formatieren. Die Titelzeile
erscheint gewöhnlicherweise am oberen Rand und die Statuszeile am unteren Rand des Bildfensters.

8.5.1.12. Anzeige

Optionen TRANSPARENZ

Transparenz Typ Den Vorgabeeinstellungen entsprechend, stellt Gimp transparente Bildbereiche mit
einem Schachbrettmuster dar. Sie können verschiedene Arten von Schachbrettmustern auswählen,
sowie normale Farben (weiss, grau, schwarz) als Transparenzindikator wählen.

Größe des Schachbrettes Mit Hilfe der Auswahlliste können sie die Größe des Schachbrettmusters
auswählen.

Monitorauflösung Die Monitorauflösung ist die Beziehung zwischen horizontal und vertikal angeord-
neten Pixeln und Zoll (engl. Inch). Sie haben folgende Möglichkeiten um die Monitorauflösung zu
kalibrieren:

• Die Auflösung vom Fenstermanager (Window-Manager) beziehen, welches am einfachsten
ist, jedoch zu falsch sein kann.

• Die Auflösung manuell einstellen.

• Die Kalibrieren Schaltfläche benutzen und die Auflösung in Abhängigkeit vom verwendeten
Monitor einzustellen. Mit Hilfe eines Lineals können Sie im Dialog für die Kalibrierung der
Monitorauflösung die richtigen Werte ermitteln. Abbildung 8.56 auf der nächsten Seite zeigt
ein Bildschirmfoto des Dialogs.
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Abbildung 8.55. Die Einstellungsansicht für die Anzeige. In der Einstellungsansicht für die Anzeige
können Sie die Transparenz und Bildschirmauflösung ändern.

8.5.1.13. Fensterverwaltung

In dieser Ansicht können Sie Vorgabe-Einstellungen das Zusammenspiel zwischen Gimp und Window-
Manager beeinflussen.

ANMERKUNG

Gimp verwaltet die Fenster nicht selbständig sondern überläßt diese mehr oder
weniger dem Fenstersystem. Mittels Kommunikation mit dem Fenstersystem ist
es so möglich, das jeder Benutzer plattformübergreifend seinen eigenen Fens-
termanager (WindowManager im Englischen) benutzen kann.

Abbildung 8.56. Der Dialog zur Kalibrierung der Monitorauflösung
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Abbildung 8.57. Die Ansicht in den Einstellungen zum Anpassen der Fensterverwaltung

Optionen FENSTERTYP-HINTS

Fenstertyp-Hints für das Werkzeugfenster und den Docks Wählen sie hier, wie sich das Werkzeug-
fenster und die Docks gegenüber dem Fensterverwaltungssystem (WindowManager) verhalten
soll.

Normales Fenster: Fenster werden wie jedes andere Fenster verwaltet ohne spezielles Verhalten.

Werkzeugfenster: Sollten andere Fenster das Werkzeugfenster überdecken, wird das darunterlie-
gende Werkzeugfenster wieder sichtbar gemacht.

Oben behalten: Diese Fenster werden immer über jedes Fenster behalten.

ANMERKUNG

Veränderungen werden erst nach dem Neustart von Gimp wirksam.

FOKUS

Das fokussierte Bild aktivieren Normalerweise erhalten fokusierte Fenster alle Maus- und Tastaturein-
gaben. Die Fokusierung kann auf verschiedenen Wegen erfolgen, z.B. durch Mausklick (Click to
Focus) oder durch überfahren des Fensters mit dem Mauszeiger (Sloppy Focus). Sollten Sie ihren
Fenstermanager auf die erste Variante eingestellt haben, sollte das Kontrollkästchen aktiviert sein.
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Fensterpositionen beim Beenden speichern Bei aktiviertem Kontrollkästchen wird Gimp die Dialo-
ge und Docks an gleicher Position öffnen, wie Sie Gimp beendet haben.

Fensterposition jetzt speichern

ANMERKUNG

Diese Schaltfläche hat nur einen Effekt, wenn ”Fensterposition beim Been-
den speichernäktiviert ist.

Die Schaltfläche erlaubt es ihnen die Fenster so zu positionieren, wie sie möchten. Klicken Sie
einmal auf die Schaltfläche, damit Gimp sich die Position der Fenster merkt.

Fensterpositionen jetzt auf Vorgabewerte setzen Sollten sie wieder zu den Vorgabeeinstellungen für
die Fensterpositionierung zurückkehren wollen, klicken Sie diese Schaltfläche.

8.5.1.14. Umgebung

Abbildung 8.58. Die Einstellungsansicht für die GIMP Umgebung. Beeinflussen Sie den Ressourcenver-
brauch, sowie das Verhalten beim Speichern von Dateien von GIMP in dieser Einstellungsansicht.

Optionen RESSOURCENVERBRAUCH
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Minimale Anzahl an Schritten Verändern sie wie oft sie Operationen rückgängig machen möchten.

Maximaler Speicher für Rückgängigmachung Beeinflussen sie die Bereitstellung von Speicher, um
die Minimale Anzahl an Schritten rückgängig zu machen.

Größe des Datenspeichers Beeinflussen sie die Größe des Speichers, welcher für ein geladenes Bild
zur Verfügung steht.

Zurückhaltende Speichernutzung Hier stellen sie die Größe in Megabyte ein, die ein neues Bild maxi-
mal benutzen darf. Wird das neue Bild mehr als ihr eingetragener Wert an Hauptspeicher belegen,
wird GIMP nochmals nachfragen.

BILD VORSCHAU

Größe der Vorschaubilder Die Standardbildgröße die verwendet werden soll, um Miniaturbilder im
Öffnendialog anzuzeigen.

Maximale Dateigröße für Vorschaubilder Legt fest, ab welcher Dateigrösse ein Miniaturbild im Öffnendialog
aktualisiert wird.

BILDER SPEICHERN

Schließen ungespeicherter Bilder bestätigen Aktivieren sie dieses Kontrollkästchen, damit Gimp sie
nochmal vor dem Beenden des Programmes erinnert, dass Bilder geöffnet sind, die noch abgespei-
chert werden müssen.

8.5.1.15. Datenordner

Die Ordnervewaltung in den Einstellungen ermöglicht es ihnen Ordner für temporäre Daten anzupas-
sen.

ORDNER

Temporärer Ordner Der temporäre Ordner bewahrt Dateien auf, die nur während einer GIMP Sitzung
gebraucht werden. Das geschieht zum Beispiel beim erstellen eines neuen Bildes. Die Voreinstel-
lung benutzt das tmp Verzeichnis in ihrem persönlichen Gimp Ordner. Wenn Sie ein anderes Ver-
zeichnis wünschen, geben Sie einfach einen neuen Pfad fuer temporäre Dateien an.

Auslagerungsordner Der Auslagerungsordner wird benutzt um mehr Speicher zur Verfügung zu stel-
len, als Arbeitsspeicher(RAM) im Computer zur benutzbar ist. Wenn Sie mit sehr grossen oder res-
sourcenintensiven Bildern arbeiten, ist es nötig ungebrauchte Bildbestandteile in diesem Ordner
auszulagern.
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Abbildung 8.59. Einstellungsdialog: Ordneransicht

WARNUNG

Beide Pfadangaben zu Verzeichnissen sollten lesbar und gültig sein, da es
sonst zum Absturz von Gimp kommen kann.

8.5.1.16. Datenordner

Gimp benutzt verschiedene Arten von Ressourcen, wie Pinsel, Muster, Farbverläufe. Solche Daten wer-
den beim ersten Start von Gimp in ihren persönlichen Ordner installiert. Wenn Sie selber aus dem In-
ternet Ihre Pinselsammlung erweitern wollen, können Sie entweder die Pinsel in ihr persönliches Pin-
selverzeichnis legen oder sie benutzen ein eigenes Verzeichnis welches ausserhalb ihres persönlichen
Gimp Ordners ist. Letzteres erfordert eine Anpassung der Pfade, welches sie in den Ansichten der Da-
tenordner machen können.
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Abbildung 8.60. Ansicht der Datenordner im Einstellungsdialog. Das Bildschirmfoto zeigt die Ansicht
des Pinselordners
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9. Menü

9.1. Einführung in die GIMP Menüs

Abbildung 9.1. Die Menüleiste im Werkzeugfenster Le menu de la Boı̂te à outils

In GIMP finden Sie an verschiedensten Stellen Menüs. In diesem Kapitel werden die Menüeinträge
des Werkzeug- sowie des Bildfensters beschrieben. Die in GIMP ebenfalls häufig vorhandenen Kontext-
menüs werden dort beschrieben, wo auch der entsprechende Kontext, also beispielsweise der Dialog,
beschrieben ist.

9.2. Das Menü ”Datei“ im Werkzeugfenster

9.2.1. Einführung in das Menü ”Datei“ im Werkzeugfenster

Abbildung 9.2. Inhalt des Datei Menüs im Werkzeugfenster

Im Menü Datei des Werkzeugfensters finden Sie verschiedene Menüs, welche Ihnen zentrale Kom-
mandos zur Arbeit mit GIMP zur Verfügung stellen. Das Menü Datei finden Sie mit ähnlichem Inhalt
auch in jedem Bildfenster. Daher sind die folgenden Kommandos dort beschrieben:

• Abschnitt 9.5.2 auf Seite 223

• Abschnitt 9.5.3 auf Seite 225

• Abschnitt 9.5.5 auf Seite 227

• Abschnitt 9.5.6 auf Seite 227

• Abschnitt 9.5.14 auf Seite 231
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Neben den an dieser Stelle vorgestellten Kommandos können sich weitere Einträge im Menü befinden.
Diese gehören nicht zum Standardumfang von GIMP, sondern sind Programmerweiterungen (Plug-In).
Eine Beschreibung der Funktionalität entnehmen Sie bitte der Dokumentation der Erweiterung.

9.2.2. Das Untermenü ”Holen“

Abbildung 9.3. Das Untermenü ”Holen“

In diesem Untermenü finden Sie verschiedene Kommandos, um beispielsweise Bilder aus dem Inhalt
der Zwischenablage zu erstellen, oder ein Bildschirmfoto zu erstellen und dies dann in GIMP zu öffnen.
Außerdem können Sie gegebenenfalls Bilder von Digitalkameras oder Scannern einlesen.

9.2.2.1. Aufruf des Untermenüs

• Das Untermenü kann aus dem Werkzeugfenster erreicht werden: Datei → Holen

9.2.3. Einstellungen

Mit diesem Kommando rufen Sie das Dialogfenster auf, in dem Sie eine ganze Reihe verschiedener
GIMP betreffende Einstellungen vornehmen können. Eine detaillierte Beschreibung des Dialoges und
der verschiedenen Einstellungen ist im Abschnitt 8.5.1 auf Seite 197 beschrieben.

9.2.3.1. Aufruf des Kommandos

• Dieses Kommando kann aus dem Werkzeugfenster erreicht werden: Datei → Einstellungen

9.2.4. Das Untermenü ”Dialoge“

Über dieses Menü könnnen Sie alle in GIMP zur Verfügung stehenden Dialoge öffnen. Diese sind im
Kapitel 8 auf Seite 155 ”Dialoge“ detailliert beschrieben.

9.2.4.1. Aufruf des Untermenüs

• Das Untermenü kann aus dem Werkzeugfenster erreicht werden: Datei → Dialoge

9.3. Das Menü ”Xtns“ im Werkzeugfenster

9.3.1. Einführung in das Menü ”Xtns“

Dieses Menü hat seinen etwas kryptischen Namen vom englischen Begriff für ”Erweiterungen“ (Exten-
sions). Entsprechend finden Sie hier verschiedene Kommandos zur Verwaltung von Erweiterungen und
zum Zugriff auf Skripte.

Neben den an dieser Stelle vorgestellten Kommandos können sich weitere Einträge im Menü be-
finden. Diese gehören nicht zum Standardumfang von GIMP, sondern sind Programmerweiterungen
(Plug-In). Eine Beschreibung der Funktionalität entnehmen Sie bitte der Dokumentation der Erweite-
rung.
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Abbildung 9.4. Das Untermenü ”Dialoge“

Abbildung 9.5. Inhalt des Hilfe Menüs.

9.3.2. Modulverwaltung

Mit diesem Kommando können Sie die verschiedenen Erweiterungsmodule anzeigen, welche in GIMP
verfügbar sind. Sie können über das angezeigte Dialogfenster steuern, welche Module geladen werden
sollen. Eine Änderung der Einstellungen wird wirksam, sobald Sie GIMP das nächste Mal starten.

9.3.2.1. Aufruf des Kommandos

• Dieses Kommando kann aus dem Werkzeugfenster erreicht werden: Xtns → Modulverwaltung

9.3.2.2. Dialogbeschreibung

9.3.3. Einheiten Editor

Der Aufruf dieses Kommandos bewirkt, dass sie ein Dialogfenster öffnet, in welchem Sie vorhandene
Maßeinheiten bearbeiten und neue anlegen können. Diese Einheiten können Sie dann innerhalb von
GIMP an den verschiedensten Stellen verwenden.

9.3.3.1. Aufruf des Kommandos

• Dieses Kommando kann aus dem Werkzeugfenster erreicht werden: Xtns → Einheiten bearbei-
ten
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Abbildung 9.6. Das Dialogfenster ”Modulverwaltung“

9.3.3.2. Dialogbeschreibung

Abbildung 9.7. Das Dialogfenster ”Einheiten bearbeiten“

9.3.4. Plugin Browser

Mit diesem Kommando können Sie ein Dialogfenster öffnen, welches Ihnen in einer Baumstruktur alle
aktuell in GIMP geladenen Erweiterungen (Plug-In) anzeigt. Da viele der Filter als Erweiterung ent-
standen Sind, finden Sie im Baum sicherlich viele bekannte Namen. Beachten Sie aber bitte, dass dieses
Dialogfenster nicht der richtige Ort ist, um die Erweiterungen auszuführen. Nutzen Sie stattdessen Bitte
den zugehörigen Menüeintrag.

9.3.4.1. Aufruf des Kommandos

• Dieses Kommando kann aus dem Werkzeugfenster erreicht werden: Xtns → Plug-In Browser
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9.3.4.2. Dialogbeschreibung

Abbildung 9.8. Das Dialogfenster ”Plug-In Browser“

9.3.5. Prozeduren Browser

Mit diesem Kommando können Sie den sogenannten Prozeduren-Browser von GIMP öffnen. Dieser
zeigt Ihnen alle in der Anwendung verfügbaren Kommandos auf, welche Sie beispielsweise in Skrip-
ten (kleinen Erweiterungen) verwenden können. Eine detailliertere Beschreibung finden Sie im Glossar
unter PDB.

9.3.5.1. Aufruf des Kommandos

• Dieses Kommando kann aus dem Werkzeugfenster erreicht werden: Xtns → Prozeduren Brow-
ser

9.3.5.2. Dialogbeschreibung

9.3.6. Das Untermenü ”Skript-Fu“

Unter diesen Menüpunkt lässt sich alles nähere über Script-Fu Skripte erfahren. Enthalten ist nicht nur
eine Übersicht der verfügbaren Skripte, sondern auch die Script-Fu Konsole.

9.3.6.1. Aufruf des Untermenüs

• Dieses Untermenü kann aus dem Werkzeugfenster erreicht werden: Xtns → Skript-Fu

9.4. Das Menü ”Hilfe“ im Werkzeugfenster

9.4.1. Einführung in das Menü ”Hilfe“

In diesem Menü finden Sie verschiedene Kommandos, die Ihnen bei Ihrer Arbeit mit GIMP Unterstützung
geben.

Neben den an dieser Stelle vorgestellten Kommandos können sich weitere Einträge im Menü be-
finden. Diese gehören nicht zum Standardumfang von GIMP, sondern sind Programmerweiterungen
(Plug-In). Eine Beschreibung der Funktionalität entnehmen Sie bitte der Dokumentation der Erweite-
rung.
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Abbildung 9.9. Das Dialogfenster ”Prozeduren Browser“

Abbildung 9.10. Das Untermenü ”Skrip-Fu“

9.4.2. Hilfe

Mit diesem Kommando können Sie die GIMP Hilfe aufrufen. Die Startseite des Handbuches wird je
nach Einstellung entweder im eingebauten Hilfe-Browser, oder im eingestellten Webbrowser geöffnet.
Wie Sie diese Einstellung ändern können, ist im Abschnitt 8.5.1.6 auf Seite 200 ausführlich beschrieben.

TIPP

Sollte dieses Kommando bei Ihnen nicht funktionieren, stellen Sie bitte sicher,
dass die notwendigen Hilfedateien des Handbuches auf Ihrem Computer instal-
liert sind. Sie können diese im Internet finden <http://docs.gimp.org> und
herunterladen.

Abbildung 9.11. Inhalt des Hilfe Menüs.
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KAPITEL 9. MENÜ 9.4. DAS MENÜ ”HILFE“ IM WERKZEUGFENSTER

9.4.2.1. Aufruf des Kommandos

• Dieses Kommando kann aus dem Werkzeugfenster erreicht werden: Hilfe → Hilfe

• alternativ können Sie auch das Tastenkürzel F1 verwenden.

9.4.3. Kontexthilfe

Ein Klick auf den Menüeintrag der Kontexthilfe genügt, um einen kontextsensitiven Mauszeiger in
der Form eines Fragezeichens zu erhalten. Um die Hilfe zu einem beliebigen Fenster, Dialog oder
Menüeintrag zu erhalten, klicken Sie einfach auf das Element. Daraufhin wird sich die GIMP Hilfe
öffnen und Ihnen das passende Kapitel anzeigen.

9.4.3.1. Aufruf des Kommandos

• Dieses Kommando kann aus dem Werkzeugfenster erreicht werden: Hilfe → Kontexthilfe

alternativ können Sie auch das Tastenkürzel Shift–F1 verwenden.

9.4.4. Tip des Tages

Dieser Menüpunkt öffnet den Tip des Tages Dialog. Er zeigt nützliche Tips und Tricks, um mit GIMP
besser arbeiten zu können.

9.4.4.1. Aufruf des Kommandos

• Dieses Kommando kann aus dem Werkzeugfenster erreicht werden: Hilfe → Tipp des Tages

9.4.4.2. Dialogbeschreibung

Abbildung 9.12. Das Dialogfenster ”Tipp des Tages“

9.4.5. Über

Dieser Menüpunkt ruft das Infofenster auf, welches Informationen über die Version und die Autoren
von GIMP anzeigt.

9.4.5.1. Aufruf des Kommandos

• Dieses Kommando kann aus dem Werkzeugfenster erreicht werden: Hilfe → Über

9.4.5.2. Dialogbeschreibung

9.4.6. Das Untermenü ”GIMP online“

Über dieses Untermenü können Sie schnell auf hilfreiche Webseiten zugreifen, welche sich mit verschie-
denen Aspekten vom GIMP beschäftigen. Die entsprechenden Seiten werden nach dem Anklicken im
Webbrowser geöffnet.
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Abbildung 9.13. Das Dialogfenster ”Über“

Abbildung 9.14. Das Untermenü ”GIMP online“

9.4.6.1. Aufruf des Untermenüs

• Dieses Untermenü kann aus dem Werkzeugfenster erreicht werden: Hilfe → GIMP online

9.5. Das Menü ”Datei“ im Bildfenster

9.5.1. Einführung in das Menü ”Datei“

Abbildung 9.15. Inhalt des Datei Menüs.

In diesem Abschnitt werden Ihnen die Kommandos erklärt, welche Sie im Menü Datei finden. Alle
diese Funktionen haben mit dem Anlegen, öffnen, speichern von Bilddateien und der Verwaltung von
GIMP zu tun.

Neben den an dieser Stelle vorgestellten Kommandos können sich weitere Einträge im Menü be-
finden. Diese gehören nicht zum Standardumfang von GIMP, sondern sind Programmerweiterungen
(Plug-In). Eine Beschreibung der Funktionalität entnehmen Sie bitte der Dokumentation des Plug-In.
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9.5.2. Neu

Mit dieser Funktion können Sie in GIMP ein neues Bild erstellen. Hierzu öffnet sich ein Einstellungsdia-
log, in welchem Sie die Eigenschaften des Bildes festlegen. Sie können so viel neue Bilder erstellen wie
Sie möchten, begrenzt nur durch die bereitgestellten Ressourcen wie Haupt- und Festplattenspeicher.

Der Dialog zum Anlegen eines neuen Bildes lässt sich über das Menü der Werkzeug- und Bildfenster
aufrufen: Datei → Neu

Alternativ können Sie das Tastenkürzel Strg–D verwenden.

Abbildung 9.16. Der Dialog zum Erstellen eines neuen Bildes

Eigenschaften

Abbildung 9.17. Der Dialog zum erstellen eines neuen Bildes

Vorlage

GIMP bietet ihnen eine Anzahl von Standardvorlagen, aus denen Sie durch Mausklick auswählen
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können. Vorlagen sind Bilder, bei denen Bildgröße, Bildart, Füllart sowie Bildkommentar be-
reits voreingestellt sind. Diese Vorlagen können Sie im Dialog Vorlagen pflegen.

Bildgröße Die Bildgröße oder die Abmessungen des Bildes werden in Breite und Höhe von Pi-
xeln (Bildpunkten) angegeben. Standardmässig hat ein neu erstelltes Bild eine Bildgröße von
256(Breite) x 256(Höhe) Pixel, bei einer Auflösung von 72 Pixel/in. Die Bildgröße wird Ihnen
gleichzeitig in Millimeter (mm) angezeigt. Wenn Sie für einen anderen Zweck Bilder anlegen
möchten, können Sie über das Auswahlmenü eine andere Maßzahl als Millimeter auswählen.

ANMERKUNG

Achten Sie beim Erstellen von neuen Bildern darauf, dass Gimp jeden
Pixel in den Arbeitsspeicher lädt. Wenn Sie grosse Bilder mit einer ho-
hen Pixeldichte erstellen, wird das Programm dementsprechend viel
Prozessorleistung und Arbeitsspeicher benötigen.

Schaltflächen Hoch- und Querformat Neben den Eingabefeldern für Höhe und Breite befinden
sich zwei Icons, die Hochformat und Querformat des anzulegenden Bildes darstellen. Für das
Standardformat von 256x256 Pixeln, sind beide Symbole nicht aktiviert, da dass Bild quadra-
tisch ist.

Erweiterte Einstellungen Die Einstellungen in diesem Bereich sind für erfahrene GIMP Anwender. Sie
können diese mit Hilfe des kleinen Dreiecks am unteren Rand des Dialogfensters einblenden.

X und Y Auflösung Diese Einstellungen spielen hauptsächlich dann eine Rolle, wenn Sie ein Bild
für den Druck erstellen möchten. Mit ihnen können Sie nicht die Größe des Bildes in Pixeln
einstellen, wohl aber die physische Größe wenn das Bild gedruckt wird. Sie legen mit dieser
Einstellung fest, wie die Maßeinheit Pixel in die verschiedenen Längenmaße wie mm oder
Zoll umgerechnet werden.

TIPP

Wenn Sie die korrekte Ausmaße eines Bildes am Bildschirm sehen
möchten, schalten Sie die Einstellung Ansicht → Punkt für Punkt
ab. Stellen Sie die Vergrößerung auf 100%, um das Bild in den echten
Ausmaßen angezeigt zu bekommen. Wenn die Größe nicht korrekt
dargestellt wird, müssen Sie möglicherweise die Bildschirmeinstellun-
gen in GIMP korrigieren. Dies können Sie im Einstellungsdialog tun.

Abbildung 9.18. Farbraum Klappmenü

Farbraum

Sie können ein Bild in zwei verschiedenen Farbräumen erstellen: RGB und Graustufen.
Nachträglich lässt sich die Bildart wieder verändern. Die Funktionen dazu finden Sie im Bild-
fenster unter: Bild → Modus
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Abbildung 9.19. Füllen Klappmenü

Füllen

In diesem Bereich können Sie festlegen, mit welcher Hintergrundfarbe GIMP das neu erstellte
Bild anlegen soll. Sie können die Füllart eines Bildes bzw. einer Ebene nachträglich wieder
ändern. Mehr Informationen finden Sie im Ebenendialog.

• Es wird mit der aktuellen Vordergrundfarbe gefüllt.
• Es wird mit der aktuellen Hintergrundfarbe gefüllt.
• Es wird mit Weisser Farbe gefüllt.
• Transparent; Wenn Sie diese Einstellung auswählen, wird das Bild mit einem Alphaka-

nal versehen und der Hintergrund ist transparent. Im Bild wird dann an den transparen-
ten Stellen das voreingestellte (Karo-) Muster angezeigt.

Bildkommentar Versehen Sie das Bild einen Standardkommentar. Der Kommentar wird beim
Speichern des Bildes in die Bildinformationen eingetragen.

ANMERKUNG

Bitte beachten Sie, dass nicht jedes Bildformat Kommentare spei-
chern kann.

9.5.3. Öffnen

Der Öffnen Dialog erlaubt es, vorhandene Bilddateien von der Festplatte oder einem externen Medium
zu laden.

9.5.3.1. Aufruf des Kommandos

• Der Dialog zum Öffnen eines Bildes lässt sich über das Werkzeugfenster und dem Bildmenü auf-
rufen: Datei → Öffnen

• Das Kommando läßt sich ebenfalls mit einem Tastenkürzel aufrufen: Strg–O

9.5.3.2. Dialogbeschreibung

*. Die Ansicht untergliedert sich in zwei Bereiche: oben und unten. Oben werden Ihnen Orte angezeigt,
die sich nicht ändern lassen, wobei Sie unten Favoriten hinzufügen können. Die Favoriten sind
Ordner, an denen Bilder immer wieder speichern und schnell hingelangen wollen.

*. Diese Ansicht zeigt Ihnen den Inhalt des Ordners in dem Sie sich befinden. Doppelklicken Sie auf
Ordner um hinein zu wechseln. Mit einem Doppelklick öffnen Sie eine Datei im GIMP. Sie können
auch mit einem Klick die Datei markieren und dann auf Öffnen klicken.
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Abbildung 9.20. Dateiauswahldialog (Öffnen)

* * ** **

*. Das Vorschaufenster bietet Ihnen eine Dateivorschau, wenn Sie bereits eine bestehende Datei aus-
gewählt haben.

TIPP

Die Vorschauansicht könnte veraltet sein, wenn Sie in der Zwischenzeit mit
einem anderen Programm die Bilder in diesem Ordner angeschaut haben.
Klicken Sie einmal in die Vorschauansicht, um die Vorschau zu erneuern.

*. Der Pfad gibt Ihnen Ihren aktuellen Standpunkt im Dateisystem an. Die Schaltflächen repräsentieren
Ordner, in denen Sie sich in der Vergangenheit befanden. Klicken Sie auf eine der Schaltflächen
um in vorherige Ordner zurück zu kehren.

*. Beeinflussen Sie die Anzeige von Dateien mit bestimmten Dateiendungen in der Dateiansicht. Wählen
Sie ein Dateiformat aus, so werden Ihnen in der Dateiansicht nur Dateien diesen Formates ange-
zeigt.

*. Bestimmen Sie das Bildformat in welches Sie Ihr Bild öffnen möchten. Haben Sie Automatisch gewählt,
wird der Dateityp von GIMP automatisch bestimmt.

TIPP

In vielen Unixartigen Betriebssystemen, werden Dateiformate nicht zwin-
gend an ihren Endungen wie JPG oder PNG erkannt.
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9.5.4. Von Ort öffnen

Mit diesem Kommando können Sie ein Bild öffnen, dessen Herkunft Sie als URI angeben. Auf diese
Weise können Sie beispielsweise Bilder aus dem Internet direkt öffnen.

Zur Eingabe der URI öffnet sich ein Dialogfenster.

9.5.4.1. Aufruf des Kommandos

• Dieses Kommando kann aus dem Werkzeugfenster erreicht werden: Datei → Von Ort öffnen

9.5.4.2. Dialogbeschreibung

Abbildung 9.21. Das Dialogfenster ”Bild von Ort öffnen“

9.5.5. Zuletzt geöffnet ...

Dieses Menü zeigt die von Ihnen zuletzt geöffneten Dateien. So haben Sie immer einen schnellen Zu-
griff, ohne diese Dateien über den Öffnen Dialog laden zu müssen. Sie können unter Größe des zuletzt-
geöffnet Menüs einstellen, wie viele Einträge dieses Menü enthalten soll. Um weitere Informationen zu
erhalten, sei Ihnen das Kapitel Dokumentenindex zur Lektüre empfohlen.

9.5.5.1. Aufruf des Kommandos

• Der Menüeintrag kann aus dem Werkzeug- und dem Bildfenster erreicht werden: Datei→ Zuletzt
geöffnet

• Alternativ können Sie das Tastenkürzel Strg–O verwenden.

9.5.6. Als Ebene öffnen

Mit diesem Kommando können Sie eine Datei öffnen und als neue Eben in das aktuelle Bild einfügen.
Hierzu öffnet sich der schon für das Kommando Öffnen beschriebene Dateiauswahldialog. Die aus-
gewählte Datei wird als oberste Ebene in das Bild eingefügt.

9.5.6.1. Aufruf des Kommandos

• Der Menüeintrag kann aus dem Bildfenster erreicht werden: Datei → Als Ebene öffnen

• Alternativ können Sie das Tastenkürzel Strg–Alt–O verwenden.

9.5.7. Speichern

Mit diesem Kommando können Sie die Änderungen, welche Sie in einem Bild vorgenommen haben,
speichern. Wenn Sie das Bild schon einmal in eine Datei gespeichert haben, wird diese Datei automatisch
bei der Ausführung dieses Kommandos mit der aktuellen Version des Bildes überschrieben. Sollten Sie
die Datei unter einem anderen Namen oder in einem anderen Verzeichnis speichern wollen, benutzen
Sie bitte das Speichern unter oder das Kopie speichern unter Kommando.

Falls Sie das Bild zuvor noch nie gespeichert haben, wird ein Dateiauswahldialog geöffnet, in wel-
chem Sie das Dateiformat, den Speicherort und den Namen der Bilddatei festlegen können.
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9.5.7.1. Aufruf des Kommandos

• Der Menüeintrag kann aus dem Bildfenster erreicht werden: Datei → Speichern

• Alternativ können Sie das Tastenkürzel Strg–S verwenden.

9.5.8. Speichern unter

Das Kommando ist weitgehend identisch mit Speichern. Jedoch werden Sie zu jeder Zeit nach einen Da-
teinamen gefragt. Nützlich ist dies vor allem bei Speichern eines Bildes in verschiedenen Bildformaten.

9.5.8.1. Aufruf des Kommandos

• Der Menüeintrag kann aus dem Bildfenster erreicht werden: Datei → Speichern unter.

• Alternativ können Sie das Tastenkürzel Shift–Strg–S verwenden.

9.5.8.2. Dialogbeschreibung ohne Ordner-Browser

Das Dialogfenster zum Speichern erscheint zunächst in einer sehr einfachen Form. Sie haben nur die
Möglichkeit einen Dateinamen anzugeben und den Ordner in dem die Bilddatei gespeichert werden soll
aus einem Klappmenü auszuwählen. Sollte der Ordner nicht in der Liste enthalten sein, so können Sie
zusätzlich zum Dateinamen den Pfad zum Zielordner eintippen. Außerdem müssen Sie das Bildformat
festlegen, indem Sie an den Dateinamen die entsprechende Endung, also beipsielsweise .xcf für das
GIMP Dateiformat, anhängen.

Abbildung 9.22. Speichern Dialog ohne Ordner-Browser

9.5.8.3. Dialogbeschreibung mit Ordner-Browser

*. Die Ansicht untergliedert sich in zwei Bereiche: oben und unten. Oben werden Ihnen Orte angezeigt,
die sich nicht ändern lassen, wobei Sie unten Favoriten hinzufügen können. Die Favoriten sind
Ordner, an denen Bilder immer wieder abspeichernt und schnell hingelangen wollen.

*. Diese Ansicht zeigt Ihnen den Inhalt des Ordners in dem Sie sich befinden. Klicken Sie auf Ordner
um in Ihnen hinein zu wechseln. Wenn Sie bestehende Dateien überschreiben möchten, können
Sie auch einen Doppelklick auf die in dieser Ansicht angezeigten Datei machen.

*. Das Vorschaufenster bietet Ihnen eine Dateivorschau, wenn Sie bereits eine bestehende Datei aus-
gewählt haben. So können Sie sicher sein, dass Sie nicht die falsche Datei überschreiben.
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Abbildung 9.23. Speichern Dialog mit Ordner-Browser

* * *
** ** *

*

TIPP

Die Vorschauansicht könnte veraltet sein, wenn Sie in der Zwischenzeit mit
einem anderen Programm die Bilder in diesem Ordner angeschaut haben.
Klicken Sie einmal in die Vorschauansicht, um die Vorschau zu erneuern.

*. Geben Sie hier eine Namen ein, unter dem GIMP das Bild abspeichern soll.

ANMERKUNG

Ist das Bild bereits gespeichert, schlägt GIMP Ihnen den Namen des ge-
speicherten Bildes vor. Klicken Sie auf Speichern, überschreiben Sie das
Bild.

*. Dieses Klappmenü steht Ihnen ausschließlich in der einfachen Variante des Dialogfensters zur Verfügung.
Es beinhaltet eine Liste von Vorschlägen für Verzeichnisse, in denen Sie das Bild speichern können.

*. Der Pfad gibt Ihnen Ihren aktuellen Standpunkt im Dateisystem an. Die Schaltflächen repräsentieren
Ordner, in denen Sie in der Vergangenheit hinein wechselten. Klicken Sie auf eine der Schaltflächen
um vorherige Ordner zurück zu kehren.

*. Wenn Sie das Bild in einen Ordner speichern möchten, welcher noch nicht existiert, so können sie
diesen durch einen Klick auf diese Schaltfläche erzeugen.
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*. Beeinflussen Sie die Anzeige von Dateien mit bestimmten Dateiendungen in der Dateiansicht. Wählen
Sie ein Dateiformat aus, so werden Ihnen in der Dateiansicht nur Dateien diesen Formates ange-
zeigt.

*. Bestimmen Sie das Dateiformat in welchem Sie Ihr Bild speichern möchten. Haben Sie Automatisch
gewählt, müssen Sie den Namen, sowie die Dateiendung selber bestimmen.

ANMERKUNG

Um Text und Ebenen auch beim nächsten Öffnen des Bildes weiterbear-
beiten zu können, speichern Sie das Bild als XCF ab.

9.5.9. Kopie speichern unter

Mit diesem Kommando ist dem Kommando ”Speichern unter“ sehr ähnlich. Der entscheidende Unter-
schied ist, dass das in GIMP geöffnete Bild seinen ursprünglichen Namen und seinen Änderungsstatus
behält.

Dadurch ist dieses Kommando sehr gut geeignet, wenn Sie ohne Ihren Arbeitsfluss zu unterbrechen,
eine Kopie des aktuellen Arbeitsstandes sichern möchten.

9.5.9.1. Aufruf des Kommandos

• Der Menüeintrag kann aus dem Bildfenster erreicht werden: Datei → Kopie speichern unter

9.5.10. Als Vorlage speichern

Dieses Kommando erzeugt eine Vorlage aus der Größe und dem Farbraum des aktuellen Bildes. Beim
Aufruf des Kommandos wird ein Dialogfenster angezeigt, in welchem Sie der neuen Vorlage einen
Namen geben. Die Vorlage ist dann im Dialogfenster des Kommandos Neu verfügbar. Falls der Na-
me, den Sie der Vorlage geben wollen bereits existiert, wird automatisch eine Ziffer angehängt, um ein
Überschreiben der Vorlage zu vermeiden. Um Vorlagen umzubenennen oder zu löschen, steht Ihnen
der Dialog Vorlagen zur Verfügung.

9.5.10.1. Aufruf des Kommandos

• Der Menüeintrag kann aus dem Bildfenster erreicht werden: Datei → Als Vorlage speichern.

9.5.11. Zurücksetzen

Mit diesem Kommando können Sie ein geöffnetes Bild neu laden, also alle Bearbeitungsschritte seit
dem letzten Speichern rückgängig machen. Wenn Sie diese Aktion ausführen wird GIMP das aktuelle
Bildfenster schließen und die zugehörige Bilddatei in einem neuen Fenster laden.

WARNUNG

Bitte beachten Sie, dass dieses Kommando nicht rückgängig gemacht wer-
den kann und das Journal der letzten Änderungen verloren geht. GIMP warnt
Sie daher, wenn Sie versuchen ein Bild neu zu laden, welches ungespeicherte
Änderungen beinhaltet.
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9.5.11.1. Aufruf des Kommandos

• Der Menüeintrag kann aus dem Bildfenster erreicht werden: Datei → Zurücksetzen

9.5.12. Drucken

Dieses Kommando gehört nicht zur Kernanwendung GIMP, es handelt sich vielmehr um eine Erweite-
rung.

9.5.13. Schließen

Mit diesem Kommando können Sie das Bildfenster schließen. Diesen Vorgang können Sie nicht über
das ”Rückgängig“ Kommando zurück nehmen. Wenn das Fenster einmal geschlossen ist, sind alle
Änderungen inklusive des ”Journals“ verloren. Daher werden Sie, sofern das Bild ungespeicherte Änderungen
enthält, von GIMP gewarnt und müssen nocheinmal extra bestätigen, dass Sie dieses Bildfenster wirk-
lich schließen und alle Änderungen verwerfen möchten. Bitte beachten Sie auch, dass ein Bild nach dem
Speichern als unverändert gilt, egal ob das zum Speichern verwendete Dateiformat alle Bildeigenschaf-
ten wie Ebenen oder Transparenzen vollständig erhalten konnte. Es sei Ihnen daher empfohlen vor dem
Schließen eines Bildfensters einen Augenblick innezuhalten. Eine Kopie im XCF Dateiformat kann nie
schaden.

9.5.13.1. Aufruf des Kommandos

• Der Menüeintrag kann aus dem Bildfenster erreicht werden: Datei → Sließen

• Alternativ können Sie das Tastenkürzel Strg–W verwenden.

• Auf den meisten Plattformen auf denen GIMP funktioniert, steht Ihnen in der Titelleiste des Bild-
fensters eine Schaltfläche zum Schließen des Fensters zur Verfügung. Wie diese genau aussieht
und wo Sie diese finden hängt allerdings von dem verwendeten Betriebssystem und gegebenen-
falls vom Erscheinungsbild der verwendeten Oberfläche ab.

9.5.14. Beenden

Mit diesem Kommando können Sie GIMP beenden. Falls es geöffnete Bildfenster gibt, die ungespeicher-
te Änderungen enthalten, werden Sie hierauf hingewiesen und haben die Möglichkeit die betroffenen
Bilder zu speichern oder das Kommando abzubrechen.

9.5.14.1. Aufruf des Kommandos

• Der Menüeintrag kann aus dem Werkzeug- und dem Bildfenster erreicht werden: Datei → Been-
den

• Alternativ können Sie das Tastenkürzel Strg–Q verwenden.

• Auf den meisten Plattformen auf denen GIMP funktioniert, steht Ihnen in der Titelleiste des Werk-
zeugfensters eine Schaltfläche zum Schließen des Fensters zur Verfügung. Wie diese genau aus-
sieht und wo Sie diese finden hängt allerdings von dem verwendeten Betriebssystem und gegebe-
nenfalls vom Erscheinungsbild der verwendeten Oberfläche ab.

9.6. Das Menü ”Bearbeiten“ im Bildfenster

9.6.1. Einführung in das Menü ”Bearbeiten“

In diesem Abschnitt werden Ihnen die Kommandos erklärt, welche Sie im Menü C finden.
Neben den an dieser Stelle vorgestellten Kommandos können sich weitere Einträge im Menü be-

finden. Diese gehören nicht zum Standardumfang von GIMP, sondern sind Programmerweiterungen
(Plug-In). Eine Beschreibung der Funktionalität entnehmen Sie bitte der Dokumentation des Plug-In.
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Abbildung 9.24. Inhalt des ”Bearbeiten“ Menüs

9.6.2. Rückgängig

Dieses Kommando erlaubt es Ihnen, einzelne auf ein Bild angewandte Operationen wieder zurück zu
nehmen. Fast jeder Bearbeitungsschritt, den Sie auf einem Bild durchführen, wird von GIMP registriert
und lässt sich auch wieder rückgängig machen.

Wie viele Schritte sich GIMP merkt können Sie im Bereich Umgebung des Einstellungsdialoges fest-
legen.

Weitere Informationen über das GIMP Konzept zum ”Rückgängig machen“ finden Sie im Abschnitt 2.3.5
auf Seite 38.

9.6.2.1. Aufruf des Kommandos

• Der Menüeintrag kann aus dem Bildfenster erreicht werden: Bearbeiten → Rückgängig

• Alternativ können Sie das Tastenkürzel Strg–S verwenden.

9.6.3. Wiederherstellen

Die Wiederherstellen Funktion, ist das Gegenteil der Rückgängig Funktion. Wiederherstellen stellt rückgängig
gemachte Operationen wieder her.

Um einen Überblick über die rückgängig und wieder hergestellten Operationen zu behalten, sei auf
das Journal verwiesen.

9.6.3.1. Aufruf des Kommandos

• Der Menüeintrag kann aus dem Bildfenster erreicht werden: Bearbeiten → Wiederholen

• Alternativ können Sie das Tastenkürzel Strg–Y verwenden.

9.6.4. Journal

Mit diesem Kommando rufen Sie den Dialog ”Journal“ auf. Eine detaillierte Beschreibung finden Sie im
Abschnitt Dialoge / Journal.

Das Journal zeigt die bisher von ihnen ausgeführten Operationen auf das aktuelle Bild als Miniaturbil-
der an. Diese Übersicht erleichtert es, Schritte wieder rückgängig zu machen oder bestimmte Operatio-
nen wieder herzustellen. Benutzen Sie die Pfeile für Rückgängig und Wiederherstellen, oder alternativ
können Sie auch ein Miniaturbild anklicken.
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TIPP

Soll eine große Anzahl von Schritten Rückgängig gemacht werden, kann Ihnen
das Journal eine große Hilfe sein. Klicken Sie einfach auf ein Miniaturbild, um zu
diesen Bildstatus zurück zu kehren.

9.6.4.1. Aufruf des Kommandos

• Der Menüeintrag kann aus dem Bildfenster erreicht werden: Bearbeiten → Journal

9.6.5. Ausschneiden

Mit diesem Kommando können Sie Auswahlen ausschneiden und vorübergehend in der Zwischen-
ablage gespeichert halten. Um eine ausgeschnittene Auswahl wieder in ihr Bild einzufügen, benutzen
Sie das Kommando Einfügen. An der Stelle des Bildes, an der Sie die Auswahl ausschneiden wird die
Hintergrundfarbe oder, falls die Ebene einen Alphakanal besitzt, die Transparenz angezeigt. Haben Sie
nichts ausgewählt, wird die gesamte Ebene ausgeschnitten.

ANMERKUNG

Bitte beachten Sie, das das Kommando nur auf der aktuellen Ebene wirkt. Alle
Ebenen darüber oder darunter werden ignoriert.

9.6.5.1. Aufruf des Kommandos

• Der Menüeintrag kann aus dem Bildfenster erreicht werden: Bearbeiten → Ausschneiden

• Sie können Bildelemente mit dem Tastenkürzel Strg–X ausschneiden.

9.6.6. Kopieren

Mit diesem Kommando können Sie ausgewählte Bildbestandteile kopieren. Beim Kopieren werden die
kopieren Daten in die Zwischenablage übertragen. Mit Hilfe der Kommandos Einfügen, In Auswahl
einfügen oder Als neues Bild einfügen können die Bildteile wieder in ein Bild eingefügt werden.

9.6.6.1. Aufruf des Kommandos

• Der Menüeintrag kann aus dem Bildfenster erreicht werden: Bearbeiten → Kopieren

• Sie können Bildelemente mit dem Tastenkürzel Strg–C kopieren.

9.6.7. Kopiere Sichtbares

Dieses Kommando ähnelt dem Kommando Kopieren, allerdings wird nicht nur der Inhalt der aktuellen
Ebene kopiert, sondern der Inhalte der Auswahl über alle sichtbaren Ebenen hinweg.
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ANMERKUNG

Bitte beachten Sie, dass die kopierten Bildinhalte beim Transfer in die Zwischen-
ablage zu einer Ebene zusammengefasst werden. Die Ebeneninformationen ge-
hen also verloren.

9.6.7.1. Aufruf des Kommandos

• Der Menüeintrag kann aus dem Bildfenster erreicht werden: Bearbeiten → Kopiere Sichtbares

9.6.8. Einfügen

Dieses Kommando fügt ein vorher kopiertes Bildobjekt aus der Zwischenablage in das Bild ein. Das
eingefügte Objekt wird als schwebende Auswahl erstellt und erscheint separat im Ebenendialog.

Existiert eine Auswahl im aktuellen Bild, wird diese als Mittelpunkt benutzt, um das eingefügte Ob-
jekt zu platzieren.

ANMERKUNG

Sie können im aktuellen Bild nur eine schwebende Auswahl benutzen. Sobald
eine schwebende Auswahl existiert, lassen sich keine weiteren Operationen auf
andere Ebenen ausführen. Entweder die Auswahl wird verankert oder entfernt.

9.6.8.1. Aufruf des Kommandos

• Der Menüeintrag kann aus dem Bildfenster erreicht werden: Bearbeiten → Einfügen

• Das Kommando lässt sich ebenfalls mit einem Tastenkürzel aufrufen: Strg–V

9.6.9. In Auswahl einfügen

Dieses Kommando wirkt ähnlich wie das Kommando Einfügen. Der Hauptunterschied kommt zum
Vorschein wenn eine Auswahl im Bild existiert. Bei Verwendung des Kommandos ”Einfügen“ würde
das eingefügte Objekt in der Auswahl zentrieren und die alte Auswahl mit einer dem eingefügten Ob-
jekt angepassten Auswahl ersetzen. Anders jedoch das Kommando ”In Auswahl einfügen“. Dieses be-
schneidet das eingefügte Objekt auf die Maße der erstellten Auswahl und fügt es ein.

Sollte keine Auswahl existieren, verhält sich das Kommando genau wie Einfügen.

9.6.9.1. Aufruf des Kommandos

• Der Menüeintrag kann aus dem Bildfenster erreicht werden: Bearbeiten→ In auswahl einfügen

9.6.10. Als neues Bild einfügen

Jedes Bildobjekt welches mit Als neues Bild einfügen aus der Zwischenablage eingefügt wird, be-
kommt ein eigenes Bildfenster.
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9.6.10.1. Aufruf des Kommandos

• Der Menüeintrag kann aus dem Bildfenster erreicht werden: Bearbeiten→Als neues Bild einfügen

9.6.11. Ablagen

Abbildung 9.25. Untermenü Ablagen

In GIMP stehen Ihnen neben der Zwischenablage noch beliebig viele weitere Ablagen zur Verfügung.
Dieses Untermenü enthält verschiedene Kommandos, mit denen Sie diese Ablagen verwalten können.
Um eine bequeme Übersicht über die weiteren Ablagen und deren Inhalte zu bekommen können Sie
den Dialog ”Ablagen“ verwenden.

9.6.11.1. Aufruf des Untermenüs

• Der Menüeintrag kann aus dem Bildfenster erreicht werden: Bearbeiten → Ablagen

9.6.11.2. In Ablage ausschneiden

Mit diesem Kommando können Sie den Inhalt der Auswahl der aktiven Ebene in eine Ablage transfe-
rieren. Der Name dieser Ablage wird in einem sich öffnenden Dialog abgefragt und kann frei vergeben
werden.

AUFRUF DES KOMMANDOS

• Der Menüeintrag kann aus dem Bildfenster erreicht werden: Bearbeiten→Ablagen→ In Ablage
ausschneiden

• Alternativ können Sie zum Aufruf das Tastenkürzel Shift–Strg–X verwenden.

9.6.11.3. In Ablage kopieren

Mit diesem Kommando können Sie den Inhalt der Auswahl der aktiven Ebene in eine Ablage kopieren.
Der Name dieser Ablage wird in einem sich öffnenden Dialog abgefragt und kann frei vergeben werden.

AUFRUF DES KOMMANDOS

• Der Menüeintrag kann aus dem Bildfenster erreicht werden: Bearbeiten→Ablagen→ In Ablage
kopieren

• Alternativ können Sie zum Aufruf das Tastenkürzel Shift–Strg–C verwenden.

9.6.11.4. Aus Ablage einfügen

Beim Aufruf dieses Kommandos öffnet sich der Dialog ”Ablagen“. Dort können Sie eine Ablage auswählen
und durch betätigen einer der Schaltflächen am unteren Rand des Dialogfensters die Ablage auf ver-
schiedene Weise weiterverwenden.

AUFRUF DES KOMMANDOS

• Der Menüeintrag kann aus dem Bildfenster erreicht werden: Bearbeiten → Ablagen → Aus Ab-
lage einfügen

• Alternativ können Sie zum Aufruf das Tastenkürzel Shift–Strg–V verwenden.
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9.6.12. Löschen

Mit diesem Kommando können Sie den Inhalt der Auswahl im aktuellen Bild löschen. Falls sich im Bild
keine Auswahl befindet, wird der Inhalt der aktuellen Ebene gelöscht. An der Stelle im Bild, an der sich
die Auswahl befindet, wird nach dem Löschen der Bildhintergrund erscheinen. Normalerweise ist dies
die Hintergrundfarbe, falls die Ebene jedoch einen Alphakanal besitzt, wird die Transparenz angezeigt.

Dieses Kommando löscht lediglich den Inhalt der Auswahl, die Auswahl selbst bleibt erhalten. Der
Inhalt der Zwischenablage wird durch die Ausführung des Kommandos nicht verändert.

9.6.12.1. Aufruf des Kommandos

• Der Menüeintrag kann aus dem Bildfenster erreicht werden: Bearbeiten → Löschen

• Sie können Bildelemente mit dem Tastenkürzel Strg–K löschen.

9.6.13. Mit Vordergrundfarbe füllen

Mit diesem Kommando können Sie die Auswahl im aktuellen Bild mit der aktuellen Vordergrundfarbe
füllen. Diese wird in den Vorgabe-Einstellungen im unteren Bereich des Werkzeugfensters angezeigt
und kann über den Dialog Vordergrundfarbe ändern Vordergrundfarbe ändern angepasst werden.

ANMERKUNG

Bitte beachten Sie, dass falls das aktuelle Bild keine Auswahl enthält, die gesam-
te Ebene gefüllt wird.

9.6.13.1. Aufruf des Kommandos

• Der Menüeintrag kann aus dem Bildfenster erreicht werden: Bearbeiten → Mit VG-Farbe füllen

• Das Kommando lässt sich ebenfalls mit einem Tastenkürzel aufrufen: Strg–,

9.6.14. Mit Hintergrundfarbe füllen

Mit diesem Kommando können Sie die Auswahl im aktuellen Bild mit der aktuellen Hintergrundfarbe
füllen. Diese wird in den Vorgabe-Einstellungen im unteren Bereich des Werkzeugfensters angezeigt
und kann über den Dialog Hintergrundfarbe ändern Hintergrundfarbe ändern angepasst werden.

ANMERKUNG

Bitte beachten Sie, dass falls das aktuelle Bild keine Auswahl enthält, die gesam-
te Ebene gefüllt wird.

9.6.14.1. Aufruf des Kommandos

• Der Menüeintrag kann aus dem Bildfenster erreicht werden: Bearbeiten → Mit HG-Farbe füllen

• Das Kommando lässt sich ebenfalls mit einem Tastenkürzel aufrufen: Strg–.
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9.6.15. Mit Muster füllen

Mit diesem Kommando können Sie eine in einem Bild existierende Auswahl mit dem aktuellen Muster
füllen. Dieses Muster wird in den Vorgabe-Einstellungen im Werkzeugfenster angezeigt und kann über
den Dialog Muster eingestellt werden.

ANMERKUNG

Bitte beachten Sie, dass falls das aktuelle Bild keine Auswahl enthält, die gesam-
te Ebene gefüllt wird.

9.6.15.1. Aufruf des Kommandos

• Der Menüeintrag kann aus dem Bildfenster erreicht werden: Bearbeiten → Mit Muster füllen

• Das Kommando lässt sich ebenfalls mit einem Tastenkürzel aufrufen: Strg–;

9.6.16. Auswahl nachziehen

Mit diesem Kommando können Sie eine im Bild befindliche Auswahl nachziehen. Dies bedeutet, dass
Sie die Auswahlgrenzen, welche im Bild durch eine gestrichelte Linie hervorgehoben sind, mit einem
Strich nachzeichnen lassen können. Hierzu stehen Ihnen verschiedene Eigenschaften zur Verfügung,
mit denen Sie einstellen können wie dieser Strich gestaltet sein soll.

ANMERKUNG

Bitte beachten Sie, dass dieses Kommando im Menü nur dann auswählbar ist,
wenn im Bild auch tatsächlich eine Auswahl existiert.

9.6.16.1. Aufruf des Kommandos

• Der Menüeintrag kann aus dem Bildfenster erreicht werden: Bearbeiten→ Auswahl nachziehen

• Alternativ können Sie dieses Kommando auch über den Dialog ”Auswahleditor“ erreichen.

9.6.16.2. Abschnitt

ANMERKUNG

Da die Eigenschaften für das Nachziehen von Auswahlen und Pfaden gleich sind,
finden Sie die Dokumentation des Dialogfensters im Kapitel Pfad nachziehen.
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9.6.17. Pfad nachziehen

Mit diesem Kommando können Sie einen im Bild befindlichen Pfad nachziehen. Dies bedeutet, dass Sie
den Pfad mit einem Strich nachzeichnen lassen können. Hierzu stehen Ihnen verschiedene Eigenschaf-
ten zur Verfügung, mit denen Sie einstellen können wie dieser Strich gestaltet sein soll.

ANMERKUNG

Bitte beachten Sie, dass dieses Kommando im Menü nur dann auswählbar ist,
wenn im Bild auch tatsächlich ein Pfad existiert.

9.6.17.1. Aufruf des Kommandos

• Der Menüeintrag kann aus dem Bildfenster erreicht werden: Bearbeiten → Pfad nachziehen

• Alternativ können Sie dieses Kommando auch über den Dialog ”Auswahleditor“ Auswahleditor
erreichen.

9.6.17.2. Beschreibung des Dialogfensters

Abbildung 9.26. Dialogfenster Auswahl nachziehen

Sie haben die Möglichkeit die Eigenschaften mit denen der Pfad nachgezogen wird in den Nach-
zieheinstellungen selbst festzulegen. Alternativ können Sie die Linie Mit Hilfe eines der Malwerkzeu-
ge nachziehen lassen. In diesem Fall werden die Eigenschaften des ausgewählten Werkzeuges ange-
wendet.

Nachzieheinstellungen Standardmäßig wird die aktuelle im Werkzeugfenster eingestellte Vordergrund-
farbe zum nachziehen benutzt. Sie haben aber durch einen Mausklick auf Linienstil die Möglichkeit
zusätzliche Stileigenschaften einzustellen:
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Linienbreite Mit dieser Eigenschaft können Sie die Breite der Linie festlegen, mit welcher der
Pfad nachgezogen wird. Die Einstellung erfolgt über ein Eingabefeld. Zusätzlich können Sie
über ein Klappmenü die Maßeinheit festlegen, in der Sie die Einstellung vornehmen.

Aufsatzstil Die Form des Aufsatzstils beeinflusst den Linienanfang und das Linienende. Sie können
zwischen Stumpf, Rund und Quadratisch wählen.

Verbindungsstil Die Form des Verbindungsstiles beeinflusst die Verbindung einzelner Pfadseg-
mente. Wählen Sie zwischen Gehrung, Rund und Schräg.

Gehrung–Limit Bei der Verbindung zweier Pfadsegmente bestimmt die Gehrung den Winkel
dieser Eckverbindung. Zum Beispiel bewirkt bei einer stumpfen Eckverbindung das Geh-
rung–Limit, dass die beide Enden zugespitzt werden. Die Einstellung kann über einen Schie-
beregler oder das zugeordnete Eingabefeld im Bereich von 0,0 bis 100,0 vorgenommen wer-
den.

Abbildung 9.27. Beispiel für das Gehrung–Limit. Links: Limit=0; Rechts: Limit=5;

Strichmuster Mit dieser Eigenschaft können Sie das Strichmuster einstellen. Hierzu wird der
Strich beispielhaft als Linie von einzelnen Pixeln dargestellt. Klicken Sie auf die schwarzen
Pixel um das Strichmuster festzulegen. Die beiden grauhinterlegten Enden deuten an, wie
sich das Muster in der Linie fortsetzt.

Strich Vordefiniert Alternativ zum selbst Erstellen eines Musters können Sie mit diesem Klapp-
menü das Strichmuster aus einer Reihe von Vorschlägen auswählen. Das ausgewählte Muster
wird dann im Bereich Strichmuster angezeigt, so dass Sie eine Vorstellung des entstehenden
Strichmusters bekommen.

Kantenglättung Die Kantenglättung bewirkt eine Glättung bei runden Kanten.

Stil Sie können mit dieser Eigenschaft einstellen, ob die Linie einfarbig (Durchgezogen), oder
mit einem Muster gefüllt wird. Wenn die Einstellung Muster aktiv ist, wird das aktuell im

”Muster“ Dialog eingestellte Muster zum Füllen der Linie benutzt.

Mit Hilfe eines Malwerkzeuges nachziehen

Malwerkzeug Wählen Sie ein Malwerkzeug aus, welches benutzt werden soll, um den Pfad nach-
zuzeichnen. Dabei werden die Eigenschaften des ausgewählten Malwerkzeuges benutzt.
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9.7. Das Menü ”Auswahl“ im Bildfenster

9.7.1. Einführung in das Menü ”Auswahl“

Abbildung 9.28. Der Inhalt des Menüs Auswahl

In diesem Abschnitt werden Ihnen die Kommandos erklärt, welche Sie im Menü Auswahl finden.
Neben den an dieser Stelle vorgestellten Kommandos können sich weitere Einträge im Menü be-

finden. Diese gehören nicht zum Standardumfang von GIMP, sondern sind Programmerweiterungen
(Plug-In). Eine Beschreibung der Funktionalität entnehmen Sie bitte der Dokumentation der installier-
ten Erweiterung.

9.7.2. Alles

Mit diesem Kommando können Sie eine Auswahl erstellen, welche die kompletten aktuelle Ebene um-
fasst.

9.7.2.1. Aufruf des Kommandos

• Der Menüeintrag kann aus dem Bildfenster erreicht werden: Auswahl → Alles

• Alternativ können Sie das Tastenkürzel Strg–A verwenden.

9.7.3. Aufheben

Mit diesem Kommando können Sie alle Auswahlen aufheben. Schwebende Auswahlen werden nicht
verändert.

9.7.3.1. Aufruf des Kommandos

• Der Menüeintrag kann aus dem Bildfenster erreicht werden: Auswahl → Aufheben.

• Alternativ können Sie das Tastenkürzel Shift–Strg–A verwenden.

9.7.4. Invertieren

Mit diesem Kommando können Sie die im aktuellen Bild enthaltene Auswahl umkehren. Dies bedeutet,
dass alle Bildinhalte, welche zuvor innerhalb der Auswahl lagen, nach der Ausführung außerhalb sind
und umgekehrt.
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9.7.4.1. Aufruf des Kommandos

• Der Menüeintrag kann aus dem Bildfenster erreicht werden: Auswahl → Invertieren.

• Alternativ können Sie das Tastenkürzel Strg–I verwenden.

9.7.5. Schwebend

Mit diesem Kommando können Sie eine im Bild vorhandene Auswahl in eine ”Schwebende Auswahl“
umwandeln.

9.7.5.1. Aufruf des Kommandos

• Der Menüeintrag kann aus dem Bildfenster erreicht werden: Auswahl → Schwebend.

• Alternativ können Sie das Tastenkürzel Shift–Strg–L verwenden.

9.7.6. Nach Farbe

Mit diesem Kommando können Sie das Werkzeug Nach Farbe auswählen aufrufen. Eine ausführliche
Beschreibung finden Sie in Abschnitt 7.2.6 auf Seite 86.

9.7.6.1. Aufruf des Kommandos

• Der Menüeintrag kann aus dem Bildfenster erreicht werden: Auswahl → Nach Farbe.

• Alternativ können Sie das Tastenkürzel Shift–O verwenden.

9.7.7. Vom Pfad

Mit diesem Kommando können Sie einen Pfad in eine Auswahl überführen. Falls der Pfad nicht ge-
schlossen ist, werden die beiden Endpunkte durch eine gerade Linie verbunden. Der Pfad bleibt bei
dieser Aktion unverändert erhalten.

9.7.7.1. Aufruf des Kommandos

• Der Menüeintrag kann aus dem Bildfenster erreicht werden: Auswahl → Vom Pfad.

• Sie können das Kommando auch ausführen, indem Sie auf die Schaltfläche Pfad zu Auswahl im

Pfaddialog klicken.

• Alternativ können Sie das Tastenkürzel Shift–V verwenden.

9.7.8. Auswahleditor

9.7.8.1. Aufruf des Kommandos

• Der Menüeintrag kann aus dem Bildfenster erreicht werden: Auswahl → Auswahleditor.
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Abbildung 9.29. Das Dialogfenster ”Auswahleditor“

9.7.8.2. Dialogbeschreibung

Schaltflächen In diesem Dialogfenster stehen Ihnen verschiedene Schaltflächen zur Verfügung, um
Auswahlen zu verändern:

• Die Schaltfläche Alles auswählen.

• Die Schaltfläche Auswahl aufheben.

• Die Schaltfläche Invertieren.

• Die Schaltfläche In Kanal speichern.

• Die Schaltfläche Nach Pfad.

• Sowie die Schaltfläche Auswahl nachziehen.

Der Vorschaubereich In diesem Bereich wird die Auswahl schematisch dargestellt. Das Bild wird
schwarz, die Auswahl weiß angezeigt. Das Klicken in den Vorschaubereich bewirkt eine Auswahl
nach Farbe.

9.7.9. Ausblenden

Mit diesem Kommando können Sie die Auswahlkanten ausblenden. Damit bewirken Sie, dass ein wei-
cher Übergang zwischen der Auswahl und deren Umgebung geschaffen wird. Die Breite des Übergangs
legen Sie mit dem Parameter Auswahl ausblenden um fest.

9.7.9.1. Aufruf des Kommandos

• Der Menüeintrag kann aus dem Bildfenster erreicht werden: Auswahl → Ausblenden.

9.7.9.2. Dialogbeschreibung

Auswahl ausblenden um Mit dieser Eigenschaft können Sie einstellen, wie breit der Übergang an der
Auswahlkante wird. Hierzu stehen Ihnen ein Eingabefeld zur Festlegung des Wertes, sowie ein
Klappmenü zur Einstellung der Maßeinheit zur Verfügung.
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Abbildung 9.30. Das Dialogfenster ”Auswahl ausblenden“

9.7.10. Schärfen

Mit diesem Kommando können entfernen sie eine hinzugefügte ausgeblendete Auswahlkante, wie un-
ter Abschnitt 9.7.9 auf der vorherigen Seite beschrieben. Der neue Rand der Auswahl verläuft an der
gestrichelten Linie der alten Auswahl. Zusätzliche Kantenglättungen gehen ebenfalls verloren.

ANMERKUNG

Bitte verwecheln Sie dieses Kommando nicht mit dem Filter Schärfen.

9.7.10.1. Aufruf des Kommandos

• Der Menüeintrag kann aus dem Bildfenster erreicht werden: Auswahl → Schärfen.

9.7.11. Verkleinern

Mit diesem Kommando können Sie eine im Bild befindliche Auswahl verkleinern. Hierbei wird jeder
Punkt der Auswahlbegrenzung um einen bestimmten Wert von der nächstgelegenen Bildkante weg
verschoben. Eine weiche Auswahlkante bleibt erhalten, aber deren Form kann sich ändern.

9.7.11.1. Aufruf des Kommandos

• Der Menüeintrag kann aus dem Bildfenster erreicht werden: Auswahl → Verkleinern.

9.7.11.2. Dialogbeschreibung

Abbildung 9.31. Das Dialogfenster ”Auswahl verkleinern“

Auswahl verkleinern um Mit dieser Eigenschaft können Sie einstellen, um welchen Betrag die Aus-
wahl verkleinert wird. Hierzu stehen Ihnen ein Eingabefeld zur Festlegung des Wertes, sowie ein
Klappmenü zur Einstellung der Maßeinheit zur Verfügung.
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Verkleinere vom Bildrand Diese Eigenschaft ist nur dann interessant, wenn die Auswahl entlang der
Bildkante verläuft. Ist die Eigenschaft in einem solchen Fall aktiviert, ist die Bildkante zur Berech-
nung der Verkleinerung der Bezugspunkt. Bei ausgeschalteter Option, werden Sie keine Verklei-
nerung wahrnehmen.

9.7.12. Vergrößern

Mit diesem Kommando können Sie eine im aktuellen Bild vorhandene Auswahl vergrößern. Die Funk-
tionsweise ist ähnlich dem unter Abschnitt 9.7.11 auf der vorherigen Seite beschriebene Kommando.

9.7.12.1. Aufruf des Kommandos

• Der Menüeintrag kann aus dem Bildfenster erreicht werden: Auswahl → Vergrößern.

9.7.12.2. Dialogbeschreibung

Abbildung 9.32. Das Dialogfenster ”Auswahl vergrößern“

Auswahl vergrößern um Mit dieser Eigenschaft können Sie einstellen, um welchen Betrag die Aus-
wahl vergrößert wird. Hierzu stehen Ihnen ein Eingabefeld zur Festlegung des Wertes, sowie ein
Klappmenü zur Einstellung der Maßeinheit zur Verfügung.

9.7.13. Rand

Abbildung 9.33. Beispiel für einen Rand an einer Auswahl

(a) Bild mit einer Auswahl (b) Rand aus der Auswahl
erstellt

Mit diesem Kommando können Sie entlang der Kanten einer im aktuellen Bild befindliche Auswahl
eine neue Auswahl erstellen. Hierbei wird die aktuelle Auswahlkante als Form verwendet. Um die-
se Form herum wird dann eine neue Auswahl erzeugt. Die Breite des Randes, wird im Dialogfenster
eingestellt. Dabei liegt die Hälfte des Randes sowohl innerhalb als auch außerhalb des ausgewählten
Bereiches.
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9.7.13.1. Aufruf des Kommandos

• Der Menüeintrag kann aus dem Bildfenster erreicht werden: Auswahl → Rand

9.7.13.2. Dialogbeschreibung

Abbildung 9.34. Das Dialogfenster ”Rand“

Neue Auswahl größer um Mit dieser Eigenschaft können Sie die Breite des Auswahlrandes einstel-
len. Hierzu stehen Ihnen ein Eingabefeld zur Festlegung des Wertes, sowie ein Klappmenü zur
Einstellung der Maßeinheit zur Verfügung.

9.7.14. Abgerundetes Rechteck

Mit diesem Kommando können Sie eine bestehende Auswahl in ein Rechteck mit abgerundeten Kanten
verwandeln. Die Ecken können dabei nach innen (konkav) oder nach aussen (konvex) geformt werden.

9.7.14.1. Aufruf des Kommandos

• Der Menüeintrag kann aus dem Bildfenster erreicht werden: Auswahl → Abgerundetes Recht-
eck.

9.7.14.2. Dialogbeschreibung

Abbildung 9.35. Dialogfenster ”Abgerundetes Rechteck“

Radius Mit dieser Eigenschaft können Sie den Radius der abgerundeten Ecken einstellen. Den Wert
stellen Sie mit Hilfe eines Schiebereglers oder des zugeordneten Eingabefeldes in Prozent ein.

Konkav Wenn Sie diese Eigenschaft aktivieren, werden die Ecken nich konvex (also nach Aussen), son-
den konkav (also nach Innen) gebogen.
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9.7.15. Schnelle Maske aktivieren / deaktivieren

Mit diesem Kommando können Sie die ”Schnelle Maske“ ein- und ausschalten. Weitere Informationen
finden Sie in Abschnitt 8.2.2.5 auf Seite 164.

TIPP

Die einfachste und schnellste Möglichkeit den Modus ein- und auszuschalten ist
das kleine Maskensymbol in der linken unteren Ecke jedes Bildfensters.

9.7.15.1. Aufruf des Kommandos

• Der Menüeintrag kann aus dem Bildfenster erreicht werden: Auswahl → Schnelle Maske akti-
vieren/deaktivieren.

• Alternativ können Sie das Tastenkürzel Shift–Q verwenden.

9.7.16. In Kanal speichern

Mit diesem Kommando können Sie eine im Bild enthaltene Auswahl als Kanal speichern. Hierbei wird
die Auswahl als Kanalmaske angelegt. Weitere Informationen hierzu finden Sie unter Abschnitt 8.2.2
auf Seite 159.

9.7.16.1. Aufruf des Kommandos

• Der Menüeintrag kann aus dem Bildfenster erreicht werden: Auswahl → In Kanal speichern.

• Ausserdem können Sie dieses Kommando im Auswahleditor ausführen.

9.7.17. Nach Pfad

Mit diesem Kommando kann eine Auswahl in einen Pfad umgewandelt werden. Der neue Pfad wird
im Pfaddialog angezeigt. Wenn Sie das Pfadwerkzeug aktivieren, können Sie den Pfad bearbeiten.

9.7.17.1. Aufruf des Kommandos

• Der Menüeintrag kann aus dem Bildfenster erreicht werden: Auswahl → Nach Pfad.

• Ausserdem können Sie dieses Kommando im Auswahleditor ausführen.

9.8. Das Menü ”Ansicht“ im Bildfenster

9.8.1. Einführung in das Menü ”Ansicht“

In diesem Abschnitt werden Ihnen die Kommandos erklärt, welche Sie im Menü Ansicht finden. Alle
diese Funktionen haben mit der Darstellung im Bildfester von GIMP zu tun.

Neben den an dieser Stelle vorgestellten Kommandos können sich weitere Einträge im Menü be-
finden. Diese gehören nicht zum Standardumfang von GIMP, sondern sind Programmerweiterungen
(Plug-In). Eine Beschreibung der Funktionalität entnehmen Sie bitte der Dokumentation des Plug-In.
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Abbildung 9.36. Inhalt des Ansicht Menüs.

9.8.2. Neue Ansicht

Mit diesem Kommando können Sie für das aktuelle Bild eine neue Ansicht in einem neuen Bildfenster
erzeugen. Mit der neuen Ansicht erzeugen Sie kein neues Bild, haben aber die Möglichkeit beispielswei-
se mit unterschiedlichen Vergrößerungsstufen auf ein Bild zu schauen. Alle Änderungen die Sie an dem
Bild vornehmen, werden automatisch in allen weiteren Bildansichten dargestellt. Beispielsweise wer-
den Änderungen die Sie in einer hohen Vergrößerungsstufe vornehmen anschaulicher, wenn sie diese
in einer zweiten Ansicht bei ”normaler“ Vergrößerung verfolgen können.

Sie können eine Ansicht einfach durch schließen des entsprechenden Bildfensters entfernen. Das
Schließen der letzten Ansicht eines Bildes schließt auch das Bild selbst. Sollten noch ungesicherte Änderungen
im Bild existieren, werden Sie darauf hingewiesen und haben die Möglichkeit das Bild zu speichern.

9.8.2.1. Aufruf des Kommandos

• Der Menüeintrag kann aus dem Bildfenster erreicht werden: Ansicht → Neue Ansicht.

9.8.3. Punkt für Punkt

Mit diesem Kommando können Sie einstellen, ob sich die Vergrößerungsstufen auf die physische oder
logische Bildgröße beziehen. Bei aktivierter Funktion und einer Zoom-Stufe von 100% entspricht jedem
Pixel des Bildes einen Bildschirm-Pixel. Dieser Modus eignet sich besonders für die Erstellung von Icons
und Web-Grafiken. Für die Erstellung von Bildern für den Druck wird empfohlen, die Funktion auszu-
stellen. Dann wird die Bildschirmauflösung und die des Bildes berücksichtigt. Die Darstellung erfolgt
in Druckgröße.

Um diesen, zugegebenermaßen etwas komplexen Sachverhalt zu erläutern, hilft folgendes Beispiel.
Gegeben seien folgende Bildeigenschaften:

• Physische Bildgröße: 100x100 Pixel

• Bildauflösung: 300dpi (Punkte pro Zoll)

• Darstellung im Bildfenster bei 100%; Modus ”Punkt für Punkt“ eingeschaltet: 100x100 Pixel

• Darstellung im Bildfenster bei 100%; Modus ”Punkt für Punkt“ ausgeschaltet:

100Pixel ÷ 300dpi =
1
3
Zoll ≈ 0, 85cm
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Die Anzahl der Bildschirmpunkte mit denen das Bild bei ausgeschalteter ”Punkt für Punkt“ Funktion
im Bildfenster angezeigt wird, von der im Dialog Bildschirmeigenschaften eingestellten Bildschirm-
auflösung abhängt.

9.8.3.1. Aufruf des Kommandos

• Der Menüeintrag kann aus dem Bildfenster erreicht werden: Ansicht → Punkt für Punkt.

9.8.4. Zoom

Abbildung 9.37. Das Untermenü Zoom

In diesem Untermenü finden Sie verschiedene Kommandos, welche die Vergrößerung der Darstellung
des Bildes im Bildfenster (Zoom) betreffen. Ein Bild zu vergrößern (hineinzoomen) ist sinnvoll, wenn
Veränderungen vorgenommen werden sollen, die mit hoher Präzision auf den Pixel genau erfolgen
müssen. Eine Verkleinerung (herauszoomen) ist hingegen gut geeignet, um sich einen Überblick über
das gesamt Bild zu verschaffen und die Wirkung von Veränderungen zu sehen, welche das gesamte Bild
betreffen. Bitte beachten Sie, dass Sie eine Veränderung der Vergrößerung nicht Rückgängig machen
können, da dabei ja lediglich die Darstellung, und nicht das Bild selbst, verändert wird.

TIPP

Neben den Einträgen in diesem Menü steht Ihnen auch ein Klappmenü am un-
teren Rand jedes Bildfensters zur Steuerung des Zooms zur Verfügung. Ausser-
dem können Sie Einstellungen zur Vergrößerung im Dialog Ansichtsnavigation
vornehmen. Dieser ist im Abschnitt 8.2.6 auf Seite 173 beschrieben.

9.8.4.1. Aufruf des Kommandos

• Der Menüeintrag kann aus dem Bildfenster erreicht werden: Ansicht → Zoom.

9.8.4.2. Der Inhalt des Untermenüs Zoom

Nachfolgend werden Ihnen die verschiedenen Kommandos des Untermenüs vorgestellt. Soweit vor-
handen, sind auch die Tastenkürzel zum Aufruf angegeben.

Herauszoomen (-) Mit diesem Kommando können Sie die Vergrößerung um jeweils 30% reduzieren.
Die kleinste mögliche Vergrößerung sind 6%.
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Hineinzoomen (+) Mit diesem Kommando können Sie die Vergrößerung um jeweils 30% erhöhen. Die
maximale Vergrößerung beträgt 1600%.

Fenster an Bild anpassen ( Shift–Ctrl–E) Wenn Sie dieses Kommando ausführen, wird das Bild so-
weit vergrößert, dass es gerade noch vollständig in das Bildfenster passt.

Bild dem Fenster anpassen Wenn Sie dieses Kommando ausführen wird das Bild soweit vergrößert,
dass es das Bildfenster komplett ausfüllt. Dies wird in aller Regel dazu führen, dass sich in der
Darstellung mindestens ein oder zwei Ränder des Bildes ausserhalb des Bildfensters befinden.

16:1 (1600%); ... 1:1 (100%) (1); ... 1:16 (6,25%) Mit diesen Menüeinträgen können Sie eine vorgege-
bene Vergrößerungsstufe einstellen. In der Beschriftung ist diese jeweils als Verhältnis, sowie in
Prozent angegeben.

Anders Mit diesem Kommando können Sie jede beliebige Vergrößerung einstellen. Hierzu öffnet sich
nach dem Aufruf des Kommandos ein Dialogfenster, in dem Sie die Skalierung als Verhältnis im
Bereich 1:256 bis 256:1 oder als Prozentangabe im Bereich 0,39% bis 25600,0% einstellen können

9.8.5. Fenster anpassen

Mit diesem Kommando können Sie die Größe des Bildfensters so anpassen, dass das enthaltene Bild in
der gewählten Vergrößerungsstufe genau hineinpasst. Sollte das Bild in der gewählten Vergrößerung
nicht komplett auf den Bildschirm passen, so wird das Bildfenster soweit vergrößert, dass ein möglichst
großer Teil des Bildes dargestellt wird. An dieser Stelle sei darauf hingewiesen, dass GIMP diese Darstel-
lung automatisch vornehmen kann, wenn Sie die Eigenschaften Fenstergröße beim Vergrößern
und Verkleinern anpassen und Fenstergröße anpassen, wenn sich die Bildgröße ändert
im Einstellungsdialog für das Bildfenster aktivieren.

ANMERKUNG

Bitte beachten Sie, dass das hier beschriebene Verhalten nicht von GIMP selbst
durchgeführt wird, sondern vom ”Fenstermanager“ (einem Teil des Betriebssys-
tems Ihres Computers). Es kann daher sein, dass die beschriebene Funktio-
nalität auf Ihrem Computer abweicht oder im schlimmsten Fall gar nicht zur
Verfügung steht.

9.8.5.1. Aufruf des Kommandos

• Der Menüeintrag kann aus dem Bildfenster erreicht werden: Ansicht → Fenster anpassen.

• Alternativ können Sie das Tastenkürzel Strg–E verwenden.

9.8.6. Vollbild

Mit diesem Kommando können Sie die Darstellung in den Vollbildmodus umschalten. Möglicherweise
wird dann die Menüleiste nicht mehr angezeigt, Sie können die Menüs jedoch alternativ über das Kon-
textmenü des Bildes erreichen. Sie können das Erscheinungsbild des Bildfensters im Vollbildmodus in
den Einstellungen anpassen.
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TIPP

Sie können im Abschnitt 8.5.1.10 auf Seite 205 nachlesen, wie Sie das Erschei-
nungsbild im Vollbildmodus an Ihre Bedürfnisse anpassen können.

ANMERKUNG

Wenn Sie mit GIMP auf einem Apple Macintosh Computer arbeiten, wird der
Vollbildmodus möglicherweise nicht funktionieren, da Apple die benötigte Funk-
tionalität leider nicht zur Verfügung stellt. Sie können alternativ das Bildfenster
mit einem Klick auf den ”grünen Knopf“ maximieren, um den Platz auf dem Bild-
schirm optimal auszunutzen.

9.8.6.1. Aufruf des Kommandos

• Der Menüeintrag kann aus dem Bildfenster erreicht werden: Ansicht → Vollbild.

• Alternativ können Sie das Tastenkürzel F11 verwenden.

9.8.7. Info-Fenster

Mit diesem Kommando können Sie das Info-Fenster einblenden. In diesem Dialogfenster finden Sie
verschieden allgemeine Informationen zum aktuellen Bild, sowie Informationen über das aktuell unter
dem Mauszeiger befindliche Pixel.

9.8.7.1. Aufruf des Kommandos

• Der Menüeintrag kann aus dem Bildfenster erreicht werden: Ansicht → Info-Fenster.

• Alternativ können Sie das Tastenkürzel Shift–Strg–I verwenden.

9.8.7.2. Dialogbeschreibung

In diesem Dialogfenster finden Sie verschiedene Informationen über das aktuelle Bild sowie das aktuell
unter dem Mauszeiger befindliche Pixel.

Abbildung 9.38. Der Reiter ”Allgemein“ des Dialogfensters

Allgemein
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• Größe in Pixel: Hier wird die physische Größe des Bildes angezeigt.
• Größe beim Drucken: Hier finden Sie die aktuelle logische Größe des Bildes. Diese hängt von

der physischen Größe und der eingestellten Bildschirmauflösung ab.
• Auflösung: In diesem Bereich wir die für das Bild eingestellte Auflösung in dpi (Punkte pro

Zoll) angezeigt.
• Skalierungsfaktor: Zeigt Ihnen den aktuellen Vergrößerungsfaktor der Anzeige des Bildes an.
• Anzahl der Ebenen: enthält die Anzahl der Ebenen im aktuellen Bild.
• Größe im Speicher: Zeigt Ihnen den aktuellen Verbrauch an Hauptspeicher durch das Bild an.
• Anzeigeart: Hier können Sie herausfinden, in welchem Farbraum das aktuelle Bild vorliegt.
• Visuelle Klasse: Zeigt Ihnen die Farbtiefe des aktuellen Bildes an. Bsp. ”Echtfarben“
• Visuelle Tiefe: Hier finden Sie die Farbtiefe des Bildes angegeben in Bits. Die Angabe kann sich

auf mehrere Komponenten des Farbmodells verteilen. Beispielsweise hat ein Bild im RGB
Modus drei Komponenten (R, G, B). Bei einer Gesamttiefe von 24 Bit ergeben sich daraus
24/8 Bit pro Komponente, also je 256 Farbstufen für Rot, Grün und Blau.

Abbildung 9.39. Der Reiter ”Zeiger“ des Dialogfensters

Zeiger

In diesem Reiter finden Sie detaillierte Informationen zu dem Bildpunkt, der sich aktuell unter
dem Mauszeiger befindet.

• Pixel: Hier werden die Koordinaten des Pixels angezeigt. Der Ursprungspunkt (0,0) befindet
sich in der linken oberen Ecke des Bildes.

• Einheiten: In diesem Bereich werden die Koordinaten des Pixels, also dessen Abstand zum
Ursprungspunkt in logischen Einheiten wie beispielsweise cm angezeigt.

• Pixel-Werte: Im unteren Bereich des Dialogfensters finden Sie zwei Klappmenüs. Mit diesen
können Sie sich die Farbwerte des aktuellen Pixels in verschiedenen Farbmodellen (RGB,
HSV, CMYK) anzeigen lassen. Zusätzlich werden der Farbwert in hexadezimaler Schreibwei-
se angegeben, sowie weitere Informationen über die Transparenz angezeigt.

Abbildung 9.40. Der Reiter ”Kommentar“ des Dialogfensters

Kommentar

In diesem Reiter wird der Kommentar angezeigt, welcher im Bild hinterlegt sein kann. Dieser ist
Abhängig vom verwendeten Dateiformat.
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9.8.8. Navigationsfenster

Mit diesem Kommando können Sie den Dialog Ansichtsnavigation aufrufen. Dieser ermöglicht es Ihnen
sehr komfortabel durch das Bild zu navigieren, Vergrößerungsstufen einzustellen und den sichtbaren
Bildausschnitt zu verschieben.

9.8.8.1. Aufruf des Kommandos

• Der Menüeintrag kann aus dem Bildfenster erreicht werden: Ansicht → Navigationsfenster.

• Alternativ können Sie das Tastenkürzel Shift–Strg–N verwenden.

9.8.9. Auswahl anzeigen

Mit diesem Kommando können Sie die Anzeige der gestrichelten Linie ein- und ausschalten, welche
eine Auswahl umgibt. Bitte beachten Sie, dass die Auswahl im Bild, unabhängig davon ob sie durch
eine Umrandung hervorgehoben wird oder nicht, existiert.

Die Vorgabe-Einstellung für diese Eigenschaft können Sie im Dialog Erscheinungsbild vornehmen.

9.8.9.1. Aufruf des Kommandos

• Der Menüeintrag kann aus dem Bildfenster erreicht werden: Ansicht → Auswahl anzeigen.

• Alternativ können Sie das Tastenkürzel Strg–T verwenden.

9.8.10. Ebenenrahmen anzeigen

Mit diesem Kommando können Sie die Anzeige der gelben gestrichelten Linie ein- und ausschalten,
welche die Ebenen umrandet.

Die Vorgabe-Einstellung für diese Eigenschaft können Sie im Dialog Erscheinungsbild vornehmen.

9.8.10.1. Aufruf des Kommandos

• Der Menüeintrag kann aus dem Bildfenster erreicht werden: Ansicht → Ebenenrahmen anzei-
gen.

9.8.11. Hilfslinien anzeigen

Mit diesem Kommando können Sie die Anzeige der Hilfslinien im Bildfenster ein- und ausschalten.
Die Vorgabe-Einstellung für diese Eigenschaft können Sie im Dialog Erscheinungsbild vornehmen.

9.8.11.1. Aufruf des Kommandos

• Der Menüeintrag kann aus dem Bildfenster erreicht werden: Ansicht → Hilfslinien anzeigen.

• Alternativ können Sie das Tastenkürzel Shift–Strg–T verwenden.

9.8.12. Magnetische Hilfslinien

Mit diesem Kommando können Sie die magnetischen Hilfslinien ein- und ausschalten. Magnetische
Hilfslinien haben die Eigenschaft eine Auswahl oder Ebene anzuziehen. Der Mauszeiger rastet beim
Verschieben sozusagen an der Hilfslinie ein und kann dadurch das pixelgenaue Arbeiten enorm un-
terstützen.

9.8.12.1. Aufruf des Kommandos

• Der Menüeintrag kann aus dem Bildfenster erreicht werden: Ansicht→Magnetische Hilfslinien.
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9.8.13. Gitter anzeigen

Mit diesem Kommando können Sie die Anzeige des Gitters im Bildfenster ein- und ausschalten.
Die Vorgabe-Einstellung für diese Eigenschaft können Sie im Dialog Erscheinungsbild vornehmen.

TIPP

Weitere Informationen finden Sie unter Abschnitt 9.9.26 auf Seite 268, sowie
Abschnitt 9.8.14.

9.8.13.1. Aufruf des Kommandos

• Der Menüeintrag kann aus dem Bildfenster erreicht werden: Ansicht → Gitter anzeigen.

9.8.14. Magnetisches Gitter

Mit diesem Kommando können Sie das magnetische Gitter ein- und ausschalten. Das Magnetische Git-
ter hat die Eigenschaft eine Auswahl oder Ebene anzuziehen. Der Mauszeiger rastet beim Verschieben
sozusagen an der Gitterlinie ein und kann dadurch das pixelgenaue Arbeiten enorm unterstützen.

9.8.14.1. Aufruf des Kommandos

• Der Menüeintrag kann aus dem Bildfenster erreicht werden: Ansicht → Magnetisches Gitter.

9.8.15. Benutzerdefinierte Rahmenfarbe

Abbildung 9.41. Inhalt des Untermenüs ”Benutzerdefinierte Rahmenfarbe“

Die Funktionen des Untermenüs lassen Sie den Rahmen der das Bild umgibt farblich anpassen.

9.8.15.1. Aufruf des Untermenüs

• Der Menüeintrag kann aus dem Bildfenster erreicht werden: Ansicht→ Benutzerdefinierte Rah-
menfarbe.

9.8.15.2. Dem Thema entsprechend

Die Farbe, welche im ausgewählten Thema der GIMP Benutzeroberfläche eingestellt ist.

9.8.15.3. Helle-; Dunkle Schachbrett-Farbe

Die Farbe, wie Sie im Einstellungsdialog Anzeige ausgewählt ist.

9.8.15.4. Benutzerdefinierte Farbe wählen

Wenn Sie dieses Kommando aufrufen, wird ein Farbauswahldialog geöffnet, in dem Sie die gewünschte
Farbe festlegen können.
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9.8.15.5. Den Einstellungen entsprechend

Wenn Sie dieses Kommando ausführen wird die im Einstellungsdialog Erscheinungsbild ausgewählte
Farbe verwendet.

9.8.16. Menüleiste anzeigen

Mit diesem Kommando können Sie die Anzeige der Menüleiste im Bildfenster ein- und ausschalten.
Diese auszuschalten kann hilfreich sein, wenn Sie im Vollbildmodus arbeiten.

Die Vorgabe-Einstellung für diese Eigenschaft können Sie im Dialog Erscheinungsbild vornehmen.

9.8.16.1. Aufruf des Kommandos

• Der Menüeintrag kann aus dem Bildfenster erreicht werden: Ansicht → Menüleiste anzeigen.

9.8.17. Lineale anzeigen

Mit diesem Kommando können Sie die Anzeige der Lineale im Bildfenster ein- und ausschalten. Diese
auszuschalten kann hilfreich sein, wenn Sie im Vollbildmodus arbeiten.

Die Vorgabe-Einstellung für diese Eigenschaft können Sie im Dialog Erscheinungsbild vornehmen.

9.8.17.1. Aufruf des Kommandos

• Der Menüeintrag kann aus dem Bildfenster erreicht werden: Ansicht → Lineale anzeigen.

• Alternativ können Sie das Tastenkürzel Shift–Strg–R verwenden.

9.8.18. Scrollbalken anzeigen

Mit diesem Kommando können Sie die Anzeige der Scrollbalken im Bildfenster ein- und ausschalten.
Diese auszuschalten kann hilfreich sein, wenn Sie im Vollbildmodus arbeiten.

Die Vorgabe-Einstellung für diese Eigenschaft können Sie im Dialog Erscheinungsbild vornehmen.

9.8.18.1. Aufruf des Kommandos

• Der Menüeintrag kann aus dem Bildfenster erreicht werden: Ansicht → Scrollbalken anzeigen.

9.8.19. Statusleiste anzeigen

Mit diesem Kommando können Sie die Anzeige der Statusleiste im Bildfenster ein- und ausschalten.
Die Statusleiste auszuschalten kann hilfreich sein, wenn Sie im Vollbildmodus arbeiten.

Den Standardzustand können Sie im Dialogfenster Erscheinungsbild einstellen.

9.8.19.1. Aufruf des Kommandos

• Der Menüeintrag kann aus dem Bildfenster erreicht werden: Ansicht → Statusleiste anzeigen.

9.9. Das Menü ”Bild“ im Bildfenster

9.9.1. Einführung in das Menü ”Bild“

In diesem Abschnitt werden Ihnen die Kommandos erklärt, welche Sie im Menü Bild finden. Alle diese
Funktionen haben mit der Arbeit an Bildern zu tun.

Neben den an dieser Stelle vorgestellten Kommandos können sich weitere Einträge im Menü be-
finden. Diese gehören nicht zum Standardumfang von GIMP, sondern sind Programmerweiterungen
(Plug-In). Eine Beschreibung der Funktionalität entnehmen Sie bitte der Dokumentation der Erweite-
rung.
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Abbildung 9.42. Inhalt des Bild Menüs.

9.9.2. Duplizieren

Mit diesem Kommando können Sie das aktuelle Bild duplizieren. Es wird eine vollständige Kopie mit
allen Ebenen, Kanälen und Pfaden erstellt. Die Inhalte der Zwischenablagen sowie das Journal bleiben
jedoch unberücksichtigt.

9.9.2.1. Aufruf des Kommandos

• Der Menüeintrag kann aus dem Bildfenster erreicht werden: Bild → Duplizieren.

• Alternativ können Sie das Tastenkürzel Strg–D verwenden.

9.9.3. Modus

Abbildung 9.43. Das Untermenü ”Modus“

In diesem Untermenü finden Sie einige Kommandos, die es Ihnen erlauben das Farbmodell des Bildes
zu verändern.

9.9.3.1. Aufruf des Untermenüs

• Der Menüeintrag kann aus dem Bildfenster erreicht werden: Bild → Modus.
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9.9.3.2. Der Inhalt des Untermenüs

Im Untermenü Modus stehen Ihnen folgende Kommandos zur Verfügung:

• RGB Modus

• Graustufen Modus

• Indiziert Modus

• Zerlegen

• Zusammensetzen

9.9.4. RGB

Mit diesem Kommando können Sie Bilder in das RGB Farbmodell ( RGB ) überführen.
Standardmässig werden Sie meistens im RGB Modus arbeiten, wenn Sie neue Bilder anlegen. RGB

Bilder können in Graustufenbilder oder Bilder mit einer indizierten Farbpalette konvertiert werden.
Verfügt das Bild über einen Alphakanal, wird er bei der Konvertierung verworfen, da diese Bildmodi
keinen Alphakanal unterstützen.

9.9.4.1. Aufruf des Kommandos

• Der Menüeintrag kann aus dem Bildfenster erreicht werden: Bild → Modus → RGB.

9.9.5. Graustufen

Mit diesem Kommando können Sie das Bild in ein Graustufenbild umwandeln. Die Pixel können im
Graustufenmodus Farbwerte von 0 (Schwarz) bis 255 (Weiss) annehmen (siehe auch Graustufen.

9.9.5.1. Aufruf des Kommandos

• Der Menüeintrag kann aus dem Bildfenster erreicht werden: Bild → Modus → Graustufen.

9.9.6. Indiziert

Mit diesem Kommando können Sie das Bild in das Farbmodell ”Indizierte Farben“ umwandeln. Weitere
Informationen zu diesem Farbmodell finden Sie im Kapitel Indizierte Farben.

9.9.6.1. Aufruf des Kommandos

• Der Menüeintrag kann aus dem Bildfenster erreicht werden: Bild → Modus → Indiziert.

9.9.6.2. Beschreibung des Dialogfensters ”Bild in indizierte Farben konvertieren“

Farbtabelle

• Optimale Palette erzeugen : Diese Auswahl erzeugt die bestmögliche Farbpalette mit ei-
ner maximalen Anzahl von 256 Farben. Sie können die maximale Anzahl von Farben durch
Eingabe eines anderen Wertes verändern. Beachten Sie jedoch, dass ohne Farbrasterung ei-
ne maximale Anzahl von 256 Farben für weiche Übergänge in einem Foto bspw. unschön
aussehen kann.

• Internet-optimierte Palette verwenden : Erstellt eine Palette mit Farben die Websave sind.

• Schwarz/Weiss-Palette (1-Bit) verwenden : Diese Option reduziert das Bild auf die Ver-
wendungen von zwei Farben: Schwarz und Weiss.
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Abbildung 9.44. Das Dialogfensters ”Bild in indizierte Farben konvertieren“

• Eigene Palette verwenden : lässt Sie Ihre eigene Palette verwenden. Per Klick auf die Schalt-
fläche öffnet sich der Palettendialog bei dem Sie vorinstallierte, oder eigene Paletten für die
Indizierung verwenden können.

Farbrasterung Durch die Farbreduktion treten bei weichen Farbverläufen in Bildern unschöne, harte
Farbübergänge auf. Mittels Farbrasterung ist es möglich Farben so zu vermischen, die Pixel so
anzuordnen, dass ein Farbverlauf erkennbar ist.

Drei Filter stehen zur Auswahl, die einen unterschiedlichen Effekt auf das Bild haben. Somit sind
Sie angehalten, am besten alle drei Farbrasterungsarten auszuprobieren, und das beste Resultat zu
behalten.

Abbildung 9.45. Beispiel alle Farben kein Dithering. Beispielbild mit weichen Farbverläufen im RGB
Modus.

Abbildung 9.46. Beispiel 4 Farben kein Dithering. Bild mit indizierter Farbtabelle und vier Farben.

9.9.7. Zerlegen

Mit diesem Kommando können Sie ein Bild in seine Farbkomponenten zerlegen. Diese werden dann
in einzelnen Ebenen abgebildet. Weitere Informationen zur Anwendung und Wirkungsweise des Kom-
mandos finden Sie im Abschnitt 10.3.15 auf Seite 319.

9.9.7.1. Aufruf des Kommandos

• Der Menüeintrag kann aus dem Bildfenster erreicht werden: Bild → Modus → Zerlegen.
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Abbildung 9.47. Beispiel Floyd-Steinberg (normal). Bild mit indizierter Farbpalette von vier Farben und
einer Farbrasterung mittels Floyd-Steinberg (normal).

Abbildung 9.48. Beispiel Floyd-Steinberg 4 Farben. Bild mit indizierter Farbpalette von vier Farben und
einer Farbrasterung mittels Floyd-Steinberg (reduziertes Farbbluten).

9.9.8. Zusammensetzen

Mit diesem Kommando können Sie ein Bild, welches mit dem Kommando ”Zerlegen“ in seine Farb-
komponenten aufgeteilt wurde wieder zu einem Bild zusammensetzen. Weitere Informationen zur An-
wendung und Wirkungsweise des Kommandos finden Sie im Abschnitt 10.3.15 auf Seite 319.

9.9.8.1. Aufruf des Kommandos

• Der Menüeintrag kann aus dem Bildfenster erreicht werden: Bild→Modus→ Zusammensetzen.

9.9.9. Transformation

Abbildung 9.49. Inhalt des Untermenüs ”Transformation“

Mit den Kommandos dieses Untermenüs können Sie ein Bild transformieren, das heißt spiegeln, dre-
hen oder zerteilen.

9.9.9.1. Aufruf des Untermenüs

• Der Menüeintrag kann aus dem Bildfenster erreicht werden: Bild → Transformation.

9.9.9.2. Der Inhalt des Untermenüs

Im Untermenü Transformation stehen Ihnen folgende Kommandos zur Verfügung:

• Horizontal Spiegeln; Vertikal Spiegeln

• 90° drehen (rechts); 90° drehen (links), 180° drehen

• Guillotine

9.9.10. Horizontal Spiegeln; Vertikal Spiegeln

Mit diesen Kommandos können Sie ein Bild an der horizontalen oder vertikalen Achse spiegeln. Dabei
wird grundsätzlich das gesamte Bild gespiegelt. Um eine Auswahl oder eine Ebene zu spiegeln, können
Sie das Werkzeug Spiegeln verwenden.
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9.9.10.1. Aufruf des Kommandos

• Der Menüeintrag kann aus dem Bildfenster erreicht werden: Bild→ Transformation→ Horizon-
tal spiegeln.

• Der Menüeintrag kann aus dem Bildfenster erreicht werden: Bild → Transformation → Vertikal
spiegeln.

9.9.11. 90° drehen (rechts); 90° drehen (links), 180° drehen

Mit diesen Kommandos können Sie das Bild um 90° im und gegen den Uhrzeigersinn sowie um 180°
drehen. Wenn Sie eine Auswahl, eine Ebene oder um einen anderen Winkel drehen möchten, verwenden
Sie bitte das Werkzeug Drehen.

9.9.11.1. Aufruf des Kommandos

• Der Menüeintrag kann aus dem Bildfenster erreicht werden: Bild → Transformation → 90° dre-
hen (rechts).

• Der Menüeintrag kann aus dem Bildfenster erreicht werden: Bild → Transformation → 90° dre-
hen (links).

• Der Menüeintrag kann aus dem Bildfenster erreicht werden: Bild→ Transformation→ 180° dre-
hen.

9.9.12. Guillotine

Mit diesem Werkzeug können Sie das Bild unter Verwendung von Hilfslinien zerschneiden. Dabei wer-
den die einzelnen, durch die Hilfslinien festgelegten, Bereiche jeweils zu neuen Bildern. Weitere Infor-
mationen zu Hilfslinien finden Sie im Glossareintrag Hilfslinien.

9.9.12.1. Aufruf des Kommandos

• Der Menüeintrag kann aus dem Bildfenster erreicht werden: Bild → Transformation → Guilloti-
ne.

9.9.13. Leinwandgröße

Als ”Leinwand“ wird in GIMP die Zeichenfläche bezeichnet. Wenn Sie ein Bild öffnen oder neu anlegen
wird die Leinwand exakt so gewählt, dass sie der Größe der Ebenen entspricht. Mit dem Kommando

”Leinwandgröße“ können Sie die Größe der Leinwand selbst bestimmen und jederzeit ändern, ohne die
Größe der Bildinhalte zu beeinflussen. Wenn Sie die Leinwand vergrößern, erscheint diese wie ein Rah-
men um die aktuellen Ebenen. Verkleinern Sie die Leinwand hingegen, so wird nur noch der Ausschnitt
der Ebenen angezeigt, welcher auf die Leinwand passt. Die Inhalte der Ebenen sind jedoch nach wie
vor unverändert vorhanden.

9.9.13.1. Aufruf des Kommandos

• Der Menüeintrag kann aus dem Bildfenster erreicht werden: Bild → Leinwandgröße
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Abbildung 9.50. Das Dialogfenster ”Leinwandgröße festlegen“

9.9.13.2. Beschreibung des Dialogfensters

LEINWANDGRÖSSE

Breite; Höhe Mit den Eigenschaften Breite und Höhe können Sie die Größe einstellen, welche die Lein-
wand erhalten soll. Hierzu stehen Ihnen zwei Eingabefelder zur Verfügung. Zusätzlich können
Sie in einem Klappmenü verschiedene Maßeinheiten zur Auswahl. Wenn das die Eingabefelder
verknüpfenden Kettensymbol geschlossen ist, wird das Seitenverhältnis konstant gehalten. Wenn
Sie dann einen der Werte ändern, wird der Andere automatisch angepasst. Sie können die Ver-
knüpfung durch einen Klick auf das Kettensymbol aufheben.

Unabhängig davon welche Maßeinheit Sie zur Einstellung verwenden werden Ihnen unterhalb
der Eingabefelder immer die eingestellte Größe in Pixel und die logische Auflösung in dpi zur
Kontrolle angezeigt.

Wie Sie die logische Auflösung des Bildes verändern können ist in Abschnitt 9.9.14 auf der nächsten
Seite beschrieben.

VERSATZ
Der Versatz wird benutzt, um die vorhandenen Bildebenen auf der Leinwand auszurichten. Sie se-

hen die Größe und den Inhalt der Leinwand mit den aktuellen Einstellungen im Vorschaubereich des
Dialogfensters. Dort können Sie gut erkennen, wie die Bildinhalte auf der Leinwand angeordnet sind.
Sie können den Versatz durch einfaches Verschieben des Bildinhaltes im Vorschaubereich unter Verwen-
dung der Maus einstellen. Exakter geht dies allerdings mit Hilfe der dafür vorgesehenen Eingabefelder.

X; Y Mit diesen Eigenschaften legen Sie die Anordnung der vorhandenen Bildinhalte auf der neuen
Leinwand fest. Hierzu stehen Ihnen zwei Eingabefelder, mit deren Hilfe Sie den Abstand der Bild-
inhalte zur linken oberen Ecke der Leinwand einstellen können.

Zentrieren Mit Hilfe dieser Schaltfläche können Sie die Bildinhalte sehr einfach auf der neuen Lein-
wand zentrieren. Die Werte für den Versatz werden beim Klicken auf die Schaltfläche berechnet
und automatisch eingefügt.
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ANMERKUNG

Der beim Vergrößern der Leinwand hinzugefügte Bereich enthält normalerweise
noch keine Ebene. Daher können Sie diesen Bereich auch nicht mit den Mal-
werkzeugen oder ähnlichem bearbeiten. Sie haben aber die Möglichkeit mit-
tels Bild → Bild zusammenfügen das Bild zusammenzufügen (wie in Ab-
schnitt 9.9.20 auf Seite 265 beschrieben). In diesem Fall werden alle Ebenen
des Bildes in einer neuen Ebene zusammengefasst, welche exakt so groß ist,
wie die Leinwand. Alternativ können Sie mittels Ebene → Ebene auf Bildgröße
die aktive Ebene an die Größe der Leinwand anpassen (siehe Abschnitt 9.10.51
auf Seite 288).

9.9.14. Druckgröße

Mit diesem Kommando können Sie die Größe des gedruckten Bildes ändern. Hierzu wird die logi-
sche Auflösung angepasst. Beachten Sie bitte, dass dieses Kommando nicht die Anzahl der Pixel im
Bild verändert. Sollte dies Ihr Ziel sein, benutzen Sie stattdessen bitte das im Abschnitt 9.9.15 auf der
nächsten Seite beschriebene Kommando.

9.9.14.1. Aufruf des Kommandos

• Der Menüeintrag kann aus dem Bildfenster erreicht werden: Bild → Druckgröße.

9.9.14.2. Beschreibung des Dialogfensters

Abbildung 9.51. Das Dialogfenster ”Bildauflösung ändern“

Breite; Höhe Mit diesen Eigenschaften können Sie die gewünschte Größe des Ausdrucks dieses Bildes
einstellen. Hierzu stehen Ihnen Eingabefelder zur Verfügung. Ausserdem können Sie aus einem
Klappmenü die Maßeinheit auswählen, in der Sie die Einstellungen vornehmen möchten.

Sobald Sie die Höhe oder Breite verändern, wird der zugehörige Auflösungswert automatisch an-
gepasst. Sofern die beiden Auflösungswerte verknüpft sind, wird automatisch auch das Verhältnis
von Bildbreite und Bildhöhe konstant gehalten. Sollten Sie dies nicht wünschen, heben Sie die Ver-
knüpfung durch einen Klick auf das Kettensymbol auf.

X Auflösung; Y Auflösung Mit diesen Beiden Eigenschaften können Sie die Auflösung einstellen, wel-
che verwendet wird, um aus der physischen Größe des Bildes, also der Anzahl der Pixel im Bild,
die Breite und Höhe der Druckgröße zu berechnen.

Sie können die Auflösungswerte beliebig verändern. Hierzu stehen Ihnen zwei Eingabefelder zur
Verfügung. Diese können verknüpft sein, um das Verhältnis der beiden Werte konstant zu halten.
Dies erkennen Sie am geschlossenen Kettensymbol, welches die beiden Eingabefelder verbindet.
Die Verknüpfung können Sie durch einen Klick auf das Kettensymbol auch aufheben, um das
Seitenverhältnis frei einstellen zu können.
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9.9.15. Bild skalieren

Mit diesem Kommando könne Sie die physische Größe des Bildes, also die Anzahl der Pixel verändern.
Der Inhalt des Bildes wird dabei skaliert, dass heißt an die neue Bildgröße angepasst.

Dieses Kommando wirkt auf das gesamte Bild. Wenn das Bild Ebenen mit verschiedenen Größen hat,
kann es beim verkleinern des Bildes passieren, dass Ebenen komplett gelöscht werden, da diese nicht
kleiner als 1 Pixel sein können. In einem solchen Fall werden Sie vor der Ausführung des Kommandos
gewarnt.

Wenn Sie statt des Bildes nur eine Ebene skalieren möchten, steht Ihnen dafür das Kommando Ebene
skalieren zur Verfügung.

Bei der Anwendung dieses Kommandos sollten Sie berücksichtigen, dass sie ein Bild an vier verschie-
denen Stellen befinden kann: gespeichert in einer Bilddatei, geladen in den Hauptspeicher (RAM) Ihres
Computers, angezeigt auf dem Bildschirm und ausgedruckt auf Papier. Wenn Sie das Bild skalieren
ändert sich die Anzahl der Pixel im Bild und damit die Information die das Bild beinhaltet. Ausserdem
wird die Größe des Platzes den das Bild im Hauptspeicher (geladen) und auf der Festplatte (gespeichert)
benötigt verändert.

Die gedruckte Größe des Bildes hängt neben der physischen Auflösung, der Anzahl von Pixeln im
Bild, auch von der logischen Auflösung, also der Punkte pro Zoll, wie sie beim Drucken verwendet
werden, ab. Wenn Sie die gedruckte Größe des Bildes verändern wollen, ohne die physische Größe des
Bildes zu ändern, sollten Sie das Kommando Druckgröße verwenden.

ANMERKUNG

Wenn Sie mit dem Kommando ein Bild soweit vergrößern, dass es die maximale
Größe für neue Bilde, die in den GIMP Einstellungen überschreitet, müssen Sie
die Ausführung extra bestätigen.

9.9.15.1. Aufruf des Kommandos

• Der Menüeintrag kann aus dem Bildfenster erreicht werden: Bild → Bild skalieren.

9.9.15.2. Beschreibung des Dialogfensters ”Bild skalieren“

Abbildung 9.52. Das Dialogfenster ”Bild skalieren“
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Bildgröße Wenn Sie das Bild über die Originalgröße hinaus vergrößern, werden die neuen Pixel aus
den vorhandenen berechnet. Dieser Vorgang wird ”Interpoltion“ genannt. Bitte beachten Sie, dass
durch eine Interpolation, egal mit welchem Algorithmus nie neue Informationen in das Bild ein-
gebracht werden. Wo keine Details in Ihrem Bild sind, wird auch eine Vergrößerung keine hinzau-
bern können. Vielmehr kann das Bild nach einer Skalierung unscharf wirken.

Eine Verringerung der Bildgröße ist beispielsweise angebracht, wenn Sie das Bild auf einer Web-
seite im Internet verwenden möchten. Hierbei sollten Sie beachten, dass die meisten Anwender
im WWW mit einer Bildschirmauflösung von 1024x768 Pixel arbeiten, manche gar mit weniger.
Ein zu großes Bild kann dann nicht vollständig auf einer Bildschirmseite dargestellt werden.

Breite; Höhe Wenn Sie den Dialog aufrufen, werden in den Eingabefeldern Breite und Höhe
zunächst die bisherigen Ausmaße angezeigt. Sie können diese beliebig verändern. Zu be-
achten ist dabei, dass hinter den Eingabefeldern ein Kettensymbol angezeigt wird. Ist dieses
geschlossen,wird GIMP das Seitenverhältnis automatisch konstant halten. Wenn Sie also für
die Breite oder Höhe des Bildes einen neuen Wert eintragen, so wird GIMP den jeweils ande-
ren Wert automatisch anpassen. Sollten Sie das Seitenverhältnis ändern wollen und für Breite
und Höhe des Bildes unabhängig voneinander Werte eingeben wollen, so müssen Sie das
Kettensymbol zunächst durch anklicken öffnen.
Neben der Eistellung der Bildgröße in Pixeln stehen Ihnen noch weitere Maßeinheiten in
einem Klappmenü zur Auswahl. So können Sie beispielsweise sehr einfach die Bildgröße
prozentual einstellen. Außerdem stehen Ihnen hier physische Längeneinheiten wie Milli-
meter oder Zoll zur Auswahl. Wenn Sie diese verwenden wird die notwendige physische
Auflösung in Pixel von GIMP automatisch unter Berücksichtigung der im Dialogfenster an-
gegebenen X; Y Auflösung bestimmt.

X Auflösung; Y Auflösung Mit diesen zwei Eigenschaften können Sie die logische Auflösung
des Bildes einstellen. Dies geschieht üblicherweise in der Einheit ”Pixel pro Inch“ (dpi), Sie
können aus dem Klappmenü jedoch auch andere Einheiten wie ”Pixel pro Millimeter“ auswählen.

Qualität Um eine Veränderung an der Bildgröße vorzunehmen müssen entweder vorhandene Pixel
entfernt, oder neue Pixel zum Bild hinzugefügt werden. Mit welchem Verfahren dies geschieht
bestimmt maßgeblich die Qualität des Ergebnisses. GIMP stellt Ihnen hierzu verschiedene Algo-
rithmen zur Auswahl:

Interpolation

• Keine: Mit dieser Einstellung wird keine Interpolation durchgeführt. Die einzelnen Pixel
werden durch einfaches weglassen oder duplizieren entfernt oder hinzugefügt. Das geht
zwar sehr schnell, die Ergebnisse sind aber von sehr geringer Qualität.

• Linear: In dieser Einstellung wird eine lineare Interpolationsmethode verwendet. Diese
ist ein Kompromiss zwischen Geschwindigkeit und Qualität.

• Kubisch: Mit dieser Einstellung wird eine kubische Interpolationsmethode verwendet.
Diese ist zwar in der Berechnung recht aufwändig, erzeugt aber die qualitativ besten
Ergebnisse.

9.9.16. Bild zuschneiden

Mit diesem Kommando können Sie das Bild auf die aktuelle Auswahl zuschneiden. Bei der Ausführung
werden alle Randbereiche des Bildes, welche sich außerhalb des Auswahlbereiches befinden, abge-
schnitten. Das Bild wird dabei entsprechend verkleinert. Weiche Auswahlkanten werden berücksichtigt
und in keinem Fall abgeschnitten.

Wenn sich im aktuellen Bild keine Auswahl befindet, ist der Menüeintrag des Kommandos ausge-
graut.
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ANMERKUNG

Bitte beachten Sie, dass dieses Kommando das gesamte Bild, also insbesonde-
re alle Ebenen beschneidet. Sollten Sie nur eine einzelne Ebene zuschneiden
wollen, verwenden Sie bitte das in Abschnitt 9.10.53 auf Seite 289 beschriebene
Kommando.

9.9.16.1. Aufruf des Kommandos

• Der Menüeintrag kann aus dem Bildfenster erreicht werden: Bild → Bild zuschneiden.

9.9.17. Automatisch zuschneiden

Mit diesem Kommando können Sie einfarbige Randbereiche des Bildes entfernen. Hierzu wird an jeder
Seite des Bildes die aktive Ebene auf einen einfarbigen Bereich geprüft und dieser, sofern vorhanden,
abgeschnitten. Dabei wird das Bild entsprechend verkleinert.

ACHTUNG

Beachten Sie, dass GIMP zur Bestimmung des zu entfernenden Randberei-
ches nur die aktive Eben auswertet. Wenn der Randbereich in anderen Ebenen
möglicherweise Inhalte besitzt, werden diese durch die Ausführung des Kom-
mandos trotzdem entfernt.

9.9.17.1. Aufruf des Kommandos

• Der Menüeintrag kann aus dem Bildfenster erreicht werden: Bild → Automatisch zuschneiden.

9.9.18. Fanatisch Zuschneiden

Mit diesem Kommando können Sie ein Bild auf der Basis von einfarbigen Bildbereichen automatisch zu-
schneiden. Ränder werden wie beim Kommando Automatisch Zuschneiden entfernt. Zusätzlich werden
jedoch auch durch das Bild hindurchgehende Bildbereiche, welche die Farbe des Randes haben, wegge-
schnitten.

ANMERKUNG

Bitte beachten Sie, dass das Kommando zwar alle Ebenen zuschneidet, aber
nur die aktive Ebene analysiert.

9.9.18.1. Beispiel

9.9.18.2. Aufruf des Kommandos

• Der Menüeintrag kann aus dem Bildfenster erreicht werden: Bild → Fanatisch Zuschneiden.
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Abbildung 9.53. Beispielbild ”Fanatisch Zuschneiden“

(a) Originalbild (b) ”Automatisch
Zuschneiden“
angewandt

(c) ”Fanatisch
Zuschneiden“
angewandt

9.9.19. Sichtbare Ebenen vereinen

9.9.19.1. Aufruf des Kommandos

• Der Menüeintrag kann aus dem Bildfenster erreicht werden: Bild→ Sichtbare Ebenen vereinen

• Alternativ können Sie das Tastenkürzel Strg–M verwenden

9.9.19.2. Beschreibung des Dialogfensters ”Bild in indizierte Farben konvertieren“

Abbildung 9.54. Das Dialogfenster ”Ebenen vereinigen“

Die fertige, vereinigte Ebene soll sein:

• Nach Bedarf erweitern : Wenn Sie diese Einstellung wählen, wird die erzeugte Ebene so groß
sein, dass alle vereinigten Ebenen vollständig hineinpassen. Beachten Sie bitte, dass in GIMP
eine Ebene durchaus größer sein kann, als das Bild.

• Auf Bild beschnitten : Wenn Sie diese Einstellung wählen, wird die erzeugte Ebene die Größe
des Bildes haben. Sollte eine der vereinigten Ebenen größer sein als das Bild, so wird diese
auf die Bildgröße beschnitten.

• Auf oberste Ebene beschnitten : Wenn sie diese Einstellung wählen, wird die erzeugte Ebene von
der Größe der oberste sein. Die Inhalte aller anderen Ebenen werden, sofern sie sich nicht im
Bereich der obersten Ebene befinden, beschnitten.

9.9.20. Bild zusammefügen

Mit diesem Kommando werden alle Ebenen des Bildes zu einer Ebene zusammengefügt. Gegebenenfalls
vorhandene Alphakanäle werden entfernt. Das Bild erscheint nach der Ausführung so wie es zuletzt
angezeigt wurde, nur dass sich dann alle Inhalte auf einer einzigen Ebene ohne Transparenz befinden.
Stellen des Bildes an denen die Transparenz durch alle Ebenen reichte, werden auf die Hintergrundfarbe
des Bildes projeziert.

Dieses Kommando führt weitreichende Änderungen an der Struktur des Bildes durch. Dies ist nor-
malerweise nur dann Notwendig, wenn Sie das Bild in einem Dateiformat speichern möchten, welches
weder Ebenen, noch Transparenz (Alphakanäle) unterstützt.
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9.9.20.1. Aufruf des Kommandos

• Der Menüeintrag kann aus dem Bildfenster erreicht werden: Bild → Bild zusammenfügen

9.9.21. Hilfslinie

Abbildung 9.55. Das Untermenü ”Hilfslinie“

In diesem Untermenü finden Sie verschiedene Kommandos zum erzeugen und entfernen von Hilfs-
linien.

9.9.21.1. Aufruf des Untermenüs

• Das Untermenü kann aus dem Bildfenster erreicht werden: Bild → Hilfslinie

9.9.21.2. Der Inhalt des Untermenüs

Im Untermenü Hilfslinie stehen Ihnen folgende Kommandos zur Verfügung:

• Alle Hilfslinien entfernen

• Neue Hilfslinie (in Prozent)

• Neue Hilfslinie

• Neue Hilfslinien aus Auswahl

9.9.22. Alle Hilfslinien entfernen

Mit diesem Kommando können Sie alle Hilfslinien aus dem Bild entfernen.

9.9.22.1. Aufruf des Kommandos

• Der Menüeintrag kann aus dem Bildfenster erreicht werden: Bild→Hilfslinien→Alle Hilfslinien
entfernen

9.9.23. Neue Hilfslinie (in Prozent)

Mit diesem Kommando können sie Hilfslinien in das Bild einfügen.

TIPP

Schneller als mit diesem Kommando können Sie eine Hilfslinie anlegen, indem
Sie diese einfach aus dem Lineal des Bildfensters ziehen und beliebig im Bild
positionieren.

9.9.23.1. Aufruf des Kommandos

• Der Menüeintrag kann aus dem Bildfenster erreicht werden: Bild→Hilfslinien→Neue Hilfslinie
(in Prozent)
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9.9.23.2. Beschreibung des Dialogfensters

Abbildung 9.56. Das Dialogfenster ”Neue Hilfslinie (in Prozent)“

Richtung Mit dieser Eigenschaft können Sie in einem Klappmenü auswählen, ob die Hilfslinie hori-
zontal oder vertikal verlaufen soll.

Position Mit dieser Eigenschaft können Sie in Prozent festlegen, an welcher Position die Hilfslinie er-
zeugt werden soll. Die Position 0% befindet sich am oberen bzw. linken Bildrand.

9.9.24. Neue Hilfslinie

Mit diesem Kommando können sie Hilfslinien in das Bild einfügen.

TIPP

Schneller als mit diesem Kommando können Sie eine Hilfslinie anlegen, indem
Sie diese einfach aus dem Lineal des Bildfensters ziehen und beliebig im Bild
positionieren.

9.9.24.1. Aufruf des Kommandos

• Der Menüeintrag kann aus dem Bildfenster erreicht werden: Bild→Hilfslinien→Neue Hilfslinie

9.9.24.2. Beschreibung des Dialogfensters

Abbildung 9.57. Das Dialogfenster ”Neue Hilfslinie“

Richtung Mit dieser Eigenschaft können Sie in einem Klappmenü auswählen, ob die Hilfsline horizon-
tal oder vertikal verlaufen soll.

Position Mit dieser Eigenschaft können Sie festlegen, an welcher Position die Hilfslinie erzeugt werden
soll. Die Position 0 befindet sich am oberen bzw. linken Bildrand.
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9.9.25. Neue Hilfslinien aus Auswahl

Mit diesem Kommando können sie Hilfslinien auf der Basis der aktuellen Auswahl erzeugen. Hierbei
wird für die obere, untere, linke und rechte Kante der Auswahl je eine Hilfslinie erzeugt. Sollte es im
aktuellen Bild keine Auswahl geben, werden keine Hilfslinien erzeugt.

9.9.25.1. Aufruf des Kommandos

• Der Menüeintrag kann aus dem Bildfenster erreicht werden: Bild→ Hilfslinien→ Neue Hilfslini-
en aus Auswahl

9.9.26. Gitter konfigurieren

Mit diesem Kommando können Sie Einstellungen für das Gitter vornehmen, welches Sie als Arbeitshilfe
über das Bild blenden können.

9.9.26.1. Aufruf des Kommandos

• Der Menüeintrag kann aus dem Bildfenster erreicht werden: Bild → Gitter konfigurieren.

9.9.26.2. Beschreibung des Dialogfensters

Abbildung 9.58. Das Dialogfenster ”Gitter konfigurieren“

ERSCHEINUNGSBILD
Wählen Sie eine Gitterrepräsentation, die standardmässig beim Aufruf des Bildgitters angezeigt wer-

den soll.

Linienstil

Schnittpunkte (Punkte) Diese Einstellung ist die am wenigten Auffällige. Es werden einfache
Punkte an den Schnittstellen des Gitters angezeigt.
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Schnittpunkte (Fadenkreuze) In dieser Einstellung werden die Schnittpunkte des Gitters durch
kleine Fadenkreuze markiert.

Gestrichelt In dieser Einstellung wird das Gitter durch gestrichelte Linien dargestellt. Dies ist bei
einem kleinen Abstand der Gitterlinien eine eher ungeeignete Einstellung.

Doppelt gestrichelt In dieser Einstellung wird ebenfalls eine gestrichelte Linie zur Visualisie-
rung des Gitters verwendet. Allerdings werden die einzelnen Striche abwechselnd mit der
eingestellten Vorder- und Hintergrundfarbe gezeichnet.

Durchgezogen Wenn Sie diese Einstellung wählen, wird das Gitter mit durchgehenden Linine in
der ausgewählten Vordergrundfarbe gezeichnet.

Vordergrund- und Hintergrundfarbe Klicken Sie jeweils auf eine Farbwahlschaltfläche, um eine neue
Farbe für das Gitter zu verwenden.

ABSTAND

Breite und Höhe Verändern Sie die Größe einer Gitterzelle, indem Sie die Werte in den Eingabefeldern
verändern.

VERSATZ

Breite und Höhe Verändern Sie den Abstand der ersten Gitterzelle vom Koordinatenursprung des
Bildes. Der Koordinatenursprung ist die linke, obere Ecke ihres Bildes. Standardmässig beginnt
das Gitter im Koordinatenursprung (0,0). Sie können auch nachträglich das Gitter noch mit dem
Menüpunkt ”Konfiguriere Gridäus dem Bildmenü verändern.

9.10. Das Menü ”Ebene“ im Bildfenster

9.10.1. Einführung in das Menü ”Ebene“

Die in diesem Menü befindlichen Kommandos dienen Ihnen zur Bearbeitung von Ebenen.
Neben den an dieser Stelle vorgestellten Kommandos können sich weitere Einträge im Menü be-

finden. Diese gehören nicht zum Standardumfang von GIMP , sondern sind Programmerweiterungen
(Plug-In). Eine Beschreibung der Funktionalität entnehmen Sie bitte der Dokumentation des Plug-In.

9.10.2. Neue Ebene

Mit diesem Kommando können Sie eine neue, leere Ebene beliebiger Größe für das aktuelle Bild erzeu-
gen.

9.10.2.1. Aufruf des Kommandos

• Das Kommando kann aus dem Bildfenster erreicht werden: Ebene → Neue Ebene
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9.10. DAS MENÜ ”EBENE“ IM BILDFENSTER KAPITEL 9. MENÜ

Abbildung 9.59. Inhalt des Ebene Menüs.

Abbildung 9.60. Das Dialogfenster ”Neue Ebene“

9.10.2.2. Beschreibung des Dialogfensters

Ebenenname Mit dieser Eigenschaft legen Sie einen Namen für die neue Ebene fest. Dieser hat keine
funktionalen Auswirkungen und dient lediglich dazu, die Ebene wieder zu erkennen. Sollte der
Name, den Sie in das Eingabefeld eintragen bereits für eine andere Ebene verwendet werden, so
wird der Name beim Anlegen der Ebene automatisch um einen Zusatz der Art ”#1“ erweitert.

Breite; Höhe Mit diesen Eigenschaften können Sie die Größe der neuen Ebene einstellen. Hierzu ste-
hen Ihnen zwei Eingabefelder und zusätzlich ein Klappmenü zur Auswahl der Maßeinheit zur
Verfügung.

Ebenenfüllart Mit dieser Eigenschaft können Sie den Hintergrund für die neue Ebene einstellen. Es
stehen die aktuelle Vordergrundfarbe, die aktuelle Hintergrundfarbe, Weiß sowie Transparenz
zur Auswahl.

9.10.3. Ebene duplizieren

Mit diesem Kommando können Sie die aktive Ebene des Bildes duplizieren. Dies bedeutet, es wird eine
nahezu identische Kopie der Ebene angelegt, welche sich nur im Namen unterscheidet. Der Name der
Kopie wird durch den Namen der originalen Ebene, mit angehängtem ”-Kopie“ gebildet.
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Bitte beachten Sie, dass falls Sie eine Hintergrundebene ohne Alphakanal duplizieren, die Kopie mit
einem Alphakanal versehen wird. Ausserdem werden die sogenannten Parasiten der Originalebene
nicht dupliziert. Sollte sich die Bedeutung des Wortes ”Parasiten“ für Sie auf kleine, unangenehme Tier-
chen beschränken, ignorieren Sie die letzte Information einfach.

9.10.3.1. Aufruf des Kommandos

• Der Menüeintrag kann aus dem Bildfenster erreicht werden: Ebene → Ebene duplizieren

9.10.4. Ebene verankern

Mit diesem Kommando können Sie eine schwebende Auswahl in der aktiven Ebene verankern. Wenn
das aktuelle Bild keine schwebende Auswahl enthält, ist der Menüeintrag für dieses Kommando ausge-
graut.

9.10.4.1. Aufruf des Kommandos

• Der Menüeintrag kann aus dem Bildfenster erreicht werden: Ebene → Ebene verankern

• Alternativ können Sie das Tastenkürzel Strg–H verwenden.

9.10.5. Nach unten vereinen

Mit diesem Kommando können Sie die aktive Ebene mit der darunter liegenden Ebene vereinen. Dabei
werden die verschiedenen Eigenschaften der aktiven Ebene, also beispielsweise die Transparenz und
der Ebenenmodus berücksichtigt.

9.10.5.1. Aufruf des Kommandos

• Der Menüeintrag kann aus dem Bildfenster erreicht werden: Ebene → Nach untten vereinen

9.10.6. Ebene löschen

Mit diesem Kommando können Sie die aktive Ebene des Bildes löschen.

9.10.6.1. Aufruf des Kommandos

• Der Menüeintrag kann aus dem Bildfenster erreicht werden: Ebene → Ebene löschen

9.10.7. Das Untermenü ”Stapel“

Abbildung 9.61. Das Stapel Untermenü

In diesem Untermenü finden Sie verschiedene Kommandos, mit denen Sie eine ausgewählte Ebene
aktivieren oder die Reihenfolge in der die Ebenen übereinander gestapelt sind verändern können.
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9.10.7.1. Aufruf des Untermenüs

• Das Untermenü kann aus dem Bildfenster erreicht werden: Ebene → Stapel

9.10.7.2. Der Inhalt des Untermenüs

Im Untermenü Stapel stehen Ihnen folgende Kommandos zur Verfügung:

• Abschnitt 9.10.8

• Abschnitt 9.10.9 auf der nächsten Seite

• Abschnitt 9.10.10 auf der nächsten Seite

• Abschnitt 9.10.11 auf der nächsten Seite

• Abschnitt 9.10.12 auf Seite 274

• Abschnitt 9.10.13 auf Seite 274

• Abschnitt 9.10.14 auf Seite 274

• Abschnitt 9.10.15 auf Seite 275

9.10.8. Vorherige Ebene auswählen

Mit diesem Kommando können Sie die Ebene, welche sich über der aktuell aktiven Ebene befindet, zur
aktiven Ebene des Bildes machen. Wenn die oberste Ebene des Bildes bereits die aktive Ebene ist, wird
das Kommando im Menü ausgegraut.

ANMERKUNG

Bitte beachten Sie, dass sich das Tastenkürzel für dieses Kommando auf die
Page Up Taste bezieht welche sich links vom Block der Zifferntasten befindet.
Die gleichnamige Taste innerhalb des Ziffernblockes dient nicht als Tastenkürzel.

TIPP

Die Tastenkürzel für die Kommandos ”Vorherige Ebene auswählen“ und ”Nächste
Ebene auswählen“ sind sehr nützlich, wenn Sie wiederholt Farben aus einer Ebe-
ne aufnehmen, mit denen Sie in einer anderen Ebene malen. Dies gilt insbeson-
dere dann, wenn Sie zum Aufnehmen der Farben die Pipette verwenden, wel-
che Ihnen bei allen Malwerkzeugen durch drücken der Strg Taste zur Verfügung
steht.

9.10.8.1. Aufruf des Kommandos

• Das Kommando kann aus dem Bildfenster erreicht werden: Ebene→ Stapel→ Vorherige Ebene
auswählen

• oder durch drücken der Page Up Taste,

• der ”Pfeil hoch“ Taste,
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9.10.9. Nächste Ebene auswählen

Mit diesem Kommando können Sie die Ebene welche sich unterhalb der aktuell aktiven Ebene befindet,
zur aktiven Ebene des Bildes machen. Falls die aktive Ebene bereits die unterste Ebene des Bildes ist,
wird dieses Kommando ausgegraut.

ANMERKUNG

Bitte beachten Sie, dass sich das Tastenkürzel für dieses Kommando auf die
Page Down Taste bezieht welche sich links vom Block der Zifferntasten befindet.
Die gleichnamige Taste innerhalb des Ziffernblockes dient nicht als Tastenkürzel.

9.10.9.1. Aufruf des Kommandos

• Das Kommando kann aus dem Bildfenster erreicht werden: Ebene → Stapel → Nächste Ebene
auswählen

• oder durch drücken der Page Down Taste

• oder der ”Pfeil runter“ Taste.

9.10.10. Oberste Ebene auswählen

Mit diesem Kommando können Sie oberste Ebene des aktuellen Bildes zur aktiven Ebene machen. Wenn
die oberste Ebene des Bildes bereits die aktive Ebene ist, wird dieses Kommando im Menü ausgegraut.

ANMERKUNG

Bitte beachten Sie, dass sich das Tastenkürzel für dieses Kommando auf die
Home Taste bezieht welche sich links vom Block der Zifferntasten befindet. Die
gleichnamige Taste innerhalb des Ziffernblockes dient nicht als Tastenkürzel.

9.10.10.1. Aufruf des Kommandos

• Das Kommando kann aus dem Bildfenster erreicht werden: Ebene → Stapel → Oberste Ebene
auswählen

• oder durch drücken der Home Taste

9.10.11. Unterste Ebene auswählen

Mit diesem Kommando können Sie die unterste Ebene des aktuellen Bildes zur aktiven Ebene machen.
Wenn die unterste Ebene des Bildes bereits die aktive Ebene ist, wird dieses Kommando im Menü aus-
gegraut.

ANMERKUNG

Bitte beachten Sie, dass sich das Tastenkürzel für dieses Kommando auf die
End Taste bezieht welche sich links vom Block der Zifferntasten befindet. Die
gleichnamige Taste innerhalb des Ziffernblockes dient nicht als Tastenkürzel.
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9.10.11.1. Aufruf des Kommandos

• Das Kommando kann aus dem Bildfenster erreicht werden: Ebene → Stapel → Oberste Ebene
auswählen

• oder durch drücken der End Taste

9.10.12. Ebene anheben

Mit diesem Kommando können Sie die aktive Ebene des Bildes im Ebenenstapel um eine Position nach
oben verschieben. Wenn die aktive Ebene bereits die oberste Ebene des Ebenenstapels ist, so ist das
Kommando im Menü ausgegraut.

ANMERKUNG

Sollte die aktive Ebene des Bildes die unterste Ebene im Ebenenstapel sein und
außerdem keinen Alphakanal besitzen, so können Sie die Ebene nicht innerhalb
des Ebenenstapels verschieben, ohne einen Alphakanal hinzuzufügen.

9.10.12.1. Aufruf des Kommandos

• Das Kommando kann aus dem Bildfenster erreicht werden: Ebene → Stapel → Ebene anheben

• oder durch drücken der Tastenkombination Shift–Page Up

9.10.13. Ebene absenken

Mit diesem Kommando können Sie die aktive Ebene des Bildes im Ebenenstapel um eine Position nach
unten verschieben. Wenn die aktive Ebene bereits die unterste Ebene des Ebenenstapels ist, so ist das
Kommando im Menü ausgegraut.

9.10.13.1. Aufruf des Kommandos

• Das Kommando kann aus dem Bildfenster erreicht werden: Ebene→ Stapel→ Ebene absenken

• oder durch drücken der Tastenkombination Shift–Page Down

9.10.14. Ebene nach ganz oben

Mit diesem Kommando können Sie die aktive Ebene des Bildes im Ebenenstapel ganz nach oben ver-
schieben. Wenn die aktive Ebene bereits die oberste Ebene des Ebenenstapels ist, so ist das Kommando
im Menü ausgegraut.

ANMERKUNG

Sollte die aktive Ebene des Bildes die unterste Ebene im Ebenenstapel sein und
außerdem keinen Alphakanal besitzen, so können Sie die Ebene nicht innerhalb
des Ebenenstapels verschieben, ohne einen Alphakanal hinzuzufügen.
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9.10.14.1. Aufruf des Kommandos

• Das Kommando kann aus dem Bildfenster erreicht werden: Ebene→ Stapel→ Ebene ganz nach
oeben

• oder durch drücken der Tastenkombination Shift–Home.

9.10.15. Ebene nach ganz unten

Mit diesem Kommando können Sie die aktive Ebene des Bildes im Ebenenstapel ganz nach unten ver-
schieben. Wenn die aktive Ebene bereits die unterste Ebene des Ebenenstapels ist, so ist das Kommando
im Menü ausgegraut.

9.10.15.1. Aufruf des Kommandos

• Das Kommando kann aus dem Bildfenster erreicht werden: Ebene→ Stapel→ Ebene ganz nach
unten

9.10.16. Das Untermenü ”Farben“

Abbildung 9.62. Das Untermenü ”Farben“

In diesem Untermenü finden Sie verschiedene Kommandos, mit denen Sie die Farben der aktiven
Ebene verändern können. Einige der Kommandos stehen Ihnen alternativ auch im Werkzeugfenster zur
Verfügung. Diese werden im Abschnitt 7.5 auf Seite 133 beschrieben.

9.10.16.1. Aufruf des Untermenüs

• Das Untermenü kann aus dem Bildfenster erreicht werden: Ebene → Farben

9.10.16.2. Der Inhalt des Untermenüs

Im Untermenü Farben stehen Ihnen folgende Kommandos zur Verfügung:

• Abschnitt 9.10.17 auf der nächsten Seite

• Abschnitt 9.10.18 auf der nächsten Seite

• Abschnitt 9.10.19 auf der nächsten Seite
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9.10.17. Sättigung entfernen

Mit diesem Kommando können Sie die aktuelle Ebene entfärben. Dabei werden alle Farbwerte in die
entsprechenden Graustufen umgewandelt. Zur Umwandlung des gesamten Bildes in ein Graustufen-
bild gibt es dabei zwei wesentliche Unterschiede. Zum einen wirkt dieses Kommando nur auf die aktive
Ebene, das heißt die Farben in sämtlichen anderen Ebenen bleiben unverändert. Zum anderen besteht
die Ebene auch weiterhin aus den drei Kanälen Rot, Grün und Blau. Dies bedeutet, dass Sie die Ebene,
oder einzelne Bereiche davon, jederzeit wieder einfärben können.

ANMERKUNG

Bitte beachten Sie, dass Sie dieses Kommando nur auf Bildern im RGB Farbmo-
dell ausführen können. Sollte sich das aktuelle Bild in einem anderen Farbmodell
befinden, so wird dieses Kommando im Menü ausgegraut.

9.10.17.1. Aufruf des Kommandos

• Das Kommando kann aus dem Bildfenster erreicht werden: Ebene → Farben → Sättigung ent-
fernen

9.10.18. Invertieren

Mit diesem Kommando können Sie die Farbwerte und die Helligkeit der aktuellen Ebene umkehren.
Dunkle Bereiche der Ebene erscheinen hell und die Farben selbst werden durch ihre jeweiligen Komple-
mentärfarben ersetzt. Weitere Informationen finden Sie im Glossar unter Farbraum, Farbmodell.

ANMERKUNG

Bitte beachten Sie, dass Sie dieses Kommando nur auf Bildern im RGB oder
Graustufen Farbmodell ausführen können. Sollte sich das aktuelle Bild in einem
anderen Farbmodell befinden, so wird dieses Kommando im Menü ausgegraut.

9.10.18.1. Aufruf des Kommandos

• Das Kommando kann aus dem Bildfenster erreicht werden: Ebene → Farben → Invertieren

9.10.19. Das Untermenü ”Automatisch“

Abbildung 9.63. Das Untermenü ”Automatisch“

In diesem Untermenü finden Sie verschiedene Kommandos, welche die Farben einer Ebene automa-
tisch anpasst.
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9.10.19.1. Aufruf des Untermenüs

• Das Untermenü kann aus dem Bildfenster erreicht werden: Ebene → Farben → Automatisch

9.10.19.2. Der Inhalt des Untermenüs

Im Untermenü Automatisch stehen Ihnen folgende Kommandos zur Verfügung:

• Abschnitt 9.10.20

• Abschnitt 9.10.21

• Abschnitt 9.10.22

• Abschnitt 9.10.23 auf der nächsten Seite

• Abschnitt 9.10.24 auf der nächsten Seite

9.10.20. Egalisieren

Mit diesem Kommando können Sie die Helligkeit der aktiven Ebene automatisch so einstellen, dass
das Histogramm der Helligkeitswerte annähernd gleichverteilt ist. Das Ergebnis dieses Kommandos
kann sehr unterschiedlich sein. Entweder der Kontrast der Ebene wird sehr gut erhöht und die Ebene
wirkt stark verbessert, oder das Ergebnis wirkt sehr schlecht. In jedem Fall ist dieses Kommando sehr
wirkungsvoll und einen Versuch zur Bildverbesserung wert.

9.10.20.1. Aufruf des Kommandos

• Das Kommando kann aus dem Bildfenster erreicht werden: Ebene→ Farben→ Automatisch→
Egalisieren

• oder durch drücken der Tastenkombination Shift–Page Down

9.10.21. Automatische Kontrastspreizung

Mit diesem Kommando können Sie einen ähnlichen Effekt erzielen, wie mit dem Kommando Norma-
lisieren, mit dem Unterschied, dass die ”Automatische Kontrastspreizung“ auf jeden Kanal der Ebene
wirkt und nicht nur auf die Helligkeitswerte. Daraus resultieren gelegentlich leichte Farbverschiebun-
gen, welche zu einem unerwünschten Ergebnis führen können.

9.10.21.1. Aufruf des Kommandos

• Das Kommando kann aus dem Bildfenster erreicht werden: Ebene→ Farben→ Automatisch→
Automatische Kontrastspreizung

9.10.22. Farbverbesserung

Mit diesem Kommando können Sie den Wertebereich der Farbsättigung in der aktiven Ebene erhöhen.
Dabei werden weder die Farbwerte, noch die Helligkeit verändert. Dies geschieht, indem die Ebene
in das HSV Farbmodell überführt wird und dann das Histogramm des Farbsättigungskanals optimiert
wird. Hiernach wird die Eben zurück in das RGB Farbmodell gewandelt. Dieses Kommando kann auf
Graustufenbildern nicht ausgeführt werden (da wäre ja auch nicht sonderlich viel an der Farbsättigung
anzupassen).

9.10.22.1. Aufruf des Kommandos

• Das Kommando kann aus dem Bildfenster erreicht werden: Ebene→ Farben→ Automatisch→
Farbverbesserung
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9.10.23. HSV strecken

Mit diesem Kommando können Sie einen ähnlichen Effekt erzielen wie mit dem Kommando Automati-
sche Kontrastspreizung. Wesentlicher Unterschied zu diesem ist, dass hier die Ebene im HSV Farbmo-
dell betrachtet wird, während die Automatische Kontrastspreizung im RGB Farbmodell arbeitet. Bitte
beachten Sie, dass dieses Kommando nicht auf Graustufenbildern ausgeführt werden kann.

9.10.23.1. Aufruf des Kommandos

• Das Kommando kann aus dem Bildfenster erreicht werden: Ebene→ Farben→ Automatisch→
HSV strecken

9.10.24. Normalisieren

Mit diesem Kommando können Sie die Helligkeit der aktiven Ebene so optimieren, dass der dunkels-
te Punkt zu schwarz und der hellste Bildpunkt nahezu zu weiss wird. Alle Zwischenwerte werden
entsprechen angepasst. Dieses Kommando ist so eine Art ”Wundermittel“ gegen flache, kontrastarme
Bilder.

9.10.24.1. Aufruf des Kommandos

• Das Kommando kann aus dem Bildfenster erreicht werden: Ebene→ Farben→ Automatisch→
Normalisieren

9.10.25. Das Untermenü ”Maske“

Abbildung 9.64. Das Untermenü ”Maske“

In diesem Untermenü finden Sie verschiedene Kommandos, um mit Masken zu arbeiten. Informatio-
nen wie Masken in GIMP eingesetzt werden können finden Sie im Abschnitt 8.2.1.3 auf Seite 158.

9.10.25.1. Aufruf des Untermenüs

• Das Untermenü kann aus dem Bildfenster erreicht werden: Ebene → Maske

9.10.25.2. Der Inhalt des Untermenüs

Im Untermenü Maske stehen Ihnen folgende Kommandos zur Verfügung:

• Abschnitt 9.10.26 auf der nächsten Seite

• Abschnitt 9.10.27 auf Seite 280

• Abschnitt 9.10.28 auf Seite 280

• Abschnitt 9.10.29 auf Seite 280

• Abschnitt 9.10.30 auf Seite 281

• Abschnitt 9.10.31 auf Seite 281

• Abschnitt 9.10.32 auf Seite 281
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9.10.26. Ebenenmaske hinzufügen

Mit diesem Kommando können Sie eine Maske zur aktiven Ebene hinzufügen. Hierzu öffnet sich ein
Dialogfenster, in dem Sie verschiedene Eigenschaften der Ebenenmaske einstellen könne. Falls die ak-
tive Ebene bereits eine Ebenenmaske hat, oder das Anlegen nicht möglich ist (weil beispielsweise kein
Alphakanal für die Ebene verfügbar ist), wird das Kommando im Menü ausgegraut. Beachten Sie hierzu
bitte auch Abschnitt 8.2.1.3 auf Seite 158.

9.10.26.1. Aufruf des Kommandos

• Das Kommando kann aus dem Bildfenster erreicht werden: Ebene → Maske → Ebenenmaske
hinzufügen

• Alternativ können Sie das Kommando über das Kontextmenü im Ebenendialog aufrufen.

9.10.26.2. Beschreibung des Dialogfensters

Abbildung 9.65. Das Dialogfenster ”Ebenenmaske hinzufügen“

Initialisierung Ebenenmaske nach

Weiß (volle Deckkraft) Wenn Sie diese Einstellung wählen, wir die neu angelegte Ebenenmaske
mit voller Deckkraft gefüllt. Seien Sie daher nicht irritiert, wenn Sie nach dem Anlegen keine
Veränderung im Bild bemerken.

Schwarz (volle Transparenz) Wenn Sie diese Einstellung wählen, wird die neu angelegte Ebe-
nenmaske komplett transparent sein. Sie müssen daher zunächst Farbe auf die Maske auftra-
gen, um etwas von der Ebene zu sehen.

Alphakanal der Ebene Mit dieser Einstellung wird der Inhalt des Alphakanals verwendet, um
die neu angelegte Ebenenmaske zu füllen. Der Alphakanal wird dabei nicht verändert. Beach-
ten Sie, dass sich dadurch die Transparenz in halbtransparenten Bereichen der Ebene erhöht.

Alphakanal der Ebene übernehmen Diese Einstellung unterscheidet sich von der Vorigen nur
insofern, als der Alphakanal der Ebene zunächst in die Ebenenmaske kopiert und dann auf
volle Deckkraft zurückgesetzt wird. Das Erscheinungsbild der Ebene bleibt somit gleich, nur
dass die Sichtbarkeit jetzt durch die Ebenenmaske und nicht mehr durch den Alphakanal der
Ebene bestimmt wird.

Auswahl Wenn Sie diese Einstellung wählen, wird die aktuelle Auswahl zum Inhalt der neu an-
gelegten Ebenenmaske konvertiert. Dabei werden die ausgewählten Bereiche deckend und
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die Bereiche ausserhalb der Auswahl transparent. Für Bereiche welche teilweise ausgewählt
sind, ermöglicht ein Umschalten auf den Modus Schnelle Maske eine Abschätzung des Er-
gebnisses.

Graustufen-Kopie der Ebene Wenn Sie diese Einstellung wählen, wird die neu angelegte Ebe-
nenmaske mit einer Graustufenkopie des aktuellen Inhaltes der Ebene gefüllt. Dies ist vor
allem dann hilfreich, wenn Sie vorhaben neuen Inhalt in die Ebene einzufügen.

Maske invertieren Wenn Sie diese Eigenschaft aktivieren wird der Inhalt der neu angelegten Maske
umgekehrt, dass heißt deckende Bereiche werden transparent und transparente deckend.

Sobald Sie die Ebenenmaske durch einen Klick auf die Schaltfläche OK anlegen, wird im Ebenendia-
log neben dem Vorschaubild der Ebene zusätzlich ein Vorschaubild mit dem Inhalt der Ebenenmaske
angezeigt.

9.10.27. Ebenenmaske anwenden

Mit diesem Kommando können Sie die Ebenenmaske auf die aktive Ebene anwenden. Die Transparenz,
welche aus der Ebenenmaske resultiert, wird dabei auf den Alphakanal übertragen. Die Ebenenmaske
wird gelöscht. Wenn die aktive Ebene keine Ebenenmaske hat, ist dieses Kommando im Menü ausge-
graut. Weitere Informationen zu diesem Thema finden Sie im Abschnitt 8.2.1.3 auf Seite 158.

9.10.27.1. Aufruf des Kommandos

• Das Kommando kann aus dem Bildfenster erreicht werden: Ebene → Maske → Ebenenmaske
anwenden

• Alternativ können Sie das Kommando über das Kontextmenü im Ebenendialog aufrufen.

9.10.28. Ebenenmaske löschen

Mit diesem Kommando können Sie die Ebenenmaske der aktiven Ebene löschen. Die Maske wird dabei
nicht auf die Ebene angewendet. Falls die aktive Ebene keine Ebenenmaske hat, ist der Menüeintrag des
Kommandos ausgegraut.

9.10.28.1. Aufruf des Kommandos

• Das Kommando kann aus dem Bildfenster erreicht werden: Ebene → Maske → Ebenenmaske
löschen

• Alternativ können Sie das Kommando über das Kontextmenü im Ebenendialog aufrufen.

9.10.29. Auswahl aus Maske

Mit diesem Kommando können Sie die Ebenenmaske der aktiven Eben in eine Auswahl für das aktuelle
Bild umwandeln. Weiße Bereiche der Ebenenmaske werden ausgewählt, schwarze Bereiche befinden
sich außerhalb der Auswahl. Die grauen Bereiche der Ebenenmaske werden in weiche Auswahlkanten
umgewandelt. Die Ebenenmaske selbst wird durch dieses Kommando nicht verändert.

9.10.29.1. Aufruf des Kommandos

• Das Kommando kann aus dem Bildfenster erreicht werden: Ebene → Maske → Auswahl aus
Maske

• Alternativ können Sie das Kommando im Kontextmenü des Ebenendialoges aufrufen.
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9.10.30. Zur Auswahl hinzufügen

Mit diesem Kommando können Sie die Ebenenmaske der aktiven Eben in eine Auswahl umwandeln,
welche zu einer im aktuellen Bild bereits vorhandenen Auswahl hinzugefügt wird. Weiße Bereiche der
Ebenenmaske werden ausgewählt, schwarze Bereiche befinden sich außerhalb der Auswahl. Die grauen
Bereiche der Ebenenmaske werden in weiche Auswahlkanten umgewandelt. Die Ebenenmaske selbst
wird durch dieses Kommando nicht verändert.

9.10.30.1. Aufruf des Kommandos

• Das Kommando kann aus dem Bildfenster erreicht werden: Ebene → Maske → Zur Auswahl
hinzufügen

• Alternativ können Sie das Kommando im Kontextmenü des Ebenendialoges aufrufen.

9.10.31. Von Auswahl abziehen

Mit diesem Kommando können Sie die Ebenenmaske der aktiven Eben in eine Auswahl umwandeln.
Diese Auswahl wird dann von einer schon im Bild befindlichen Auswahl abgezogen. Weiße Bereiche
der Ebenenmaske werden ausgewählt, schwarze Bereiche befinden sich außerhalb der Auswahl. Die
grauen Bereiche der Ebenenmaske werden in weiche Auswahlkanten umgewandelt. Die Ebenenmaske
selbst wird durch dieses Kommando nicht verändert.

9.10.31.1. Aufruf des Kommandos

• Das Kommando kann aus dem Bildfenster erreicht werden: Ebene → Maske → Von Auswahl
abziehen

• Alternativ können Sie das Kommando im Kontextmenü des Ebenendialoges aufrufen.

9.10.32. Schnittmenge bilden

Mit diesem Kommando können Sie die Ebenenmaske der aktiven Eben in eine Auswahl umwandeln.
Die Schnittmenge dieser Auswahl und einer bereits im Bild vorhandenen Auswahl bildet dann die neue
Auswahl für das Bild. Weiße Bereiche der Ebenenmaske werden ausgewählt, schwarze Bereiche befin-
den sich außerhalb der Auswahl. Die grauen Bereiche der Ebenenmaske werden in weiche Auswahl-
kanten umgewandelt. Die Ebenenmaske selbst wird durch dieses Kommando nicht verändert.

9.10.32.1. Aufruf des Kommandos

• Das Kommando kann aus dem Bildfenster erreicht werden: Ebene → Maske → Schnittmenge
bilden

• Alternativ können Sie das Kommando im Kontextmenü des Ebenendialoges aufrufen.

9.10.33. Das Untermenü ”Transparenz“

Abbildung 9.66. Das Untermenü ”Transparenz“

In diesem Untermenü finden Sie verschiedene Kommandos, um mit dem Alphakanal, also der Trans-
parenz der Ebene, zu arbeiten.
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9.10.33.1. Aufruf des Untermenüs

• Das Untermenü kann aus dem Bildfenster erreicht werden: Ebene → Trasparenz

9.10.33.2. Der Inhalt des Untermenüs

Im Untermenü Transparenz stehen Ihnen folgende Kommandos zur Verfügung:

• Abschnitt 9.10.34

• Abschnitt 9.10.37 auf der nächsten Seite

• Abschnitt 9.10.35

• Abschnitt 9.10.36

• Abschnitt 9.10.38 auf der nächsten Seite

• Abschnitt 9.10.39 auf der nächsten Seite

• Abschnitt 9.10.40 auf Seite 284

• Abschnitt 9.10.41 auf Seite 284

9.10.34. Alphakanal hinzufügen

Mit diesem Kommando können Sie einen Alphakanal zur aktiven Ebene hinzufügen. Sie benötigen
diesen, um die Transparenz der Ebene zu steuern und mit Ebenenmasken zu arbeiten. Falls die aktuelle
Ebene bereits über einen Alphakanal verfügt, ist der Menüeintrag für dieses Kommando ausgegraut.

9.10.34.1. Aufruf des Kommandos

• Das Kommando kann aus dem Bildfenster erreicht werden: Ebene→ Transparenz→Alphakanal
hinzufügen

9.10.35. Farbe zu Transparenz

Mit diesem Kommando können Sie Farben der Ebene gezielt transparent machen. Hierzu wird ein GIMP
Filter verwendet, dessen Beschreibung Sie im Abschnitt 10.3.13 auf Seite 317 finden.

9.10.35.1. Aufruf des Kommandos

• Das Kommando kann aus dem Bildfenster erreicht werden: Ebene → Transparenz → Farbe zu
Transparenz

9.10.36. Semi-Flatten

Dieses Kommando hilft Ihnen, wenn Sie geglättete (Antialias) Bilder mit indizierten Farben und einer
Transparenz benötigen. Das. Hierbei wird das GIMP Kommando aufgerufen, welches in Abschnitt 10.3.19
auf Seite 327 beschrieben ist.

9.10.36.1. Aufruf des Kommandos

• Das Kommando kann aus dem Bildfenster erreicht werden: Ebene → Transparenz → Semi-
Flatten
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9.10.37. Alpha-Schwellwert

Mit diesem Kommando können Sie halbtransparente Bereiche des Bildes, unter Verwendung eines von
Ihnen eingestellten Schwellwertes, in binär transparente Bereiche umwandeln. Binär transparent be-
deutet, dass es nur noch Bereiche mit voller Deckkraft und Bereiche mit voller Transparenz, aber keine
halbtransparenten Bereiche mehr gibt. Voraussetzung ist ein Bild im RGB Farbmodell inklusive einem
Alpha Kanal, ansonsten ist der Menüeintrag ausgegraut.

9.10.37.1. Aufruf des Kommandos

• Das Kommando kann aus dem Bildfenster erreicht werden: Ebene → Transparenz → Alpha-
Schwellwert

9.10.37.2. Beschreibung des Dialogfensters

Abbildung 9.67. Der ”Alpha Schwellwert“ Dialog.

Schwellwert Mit dieser Eigenschaft können Sie den Transparenzwerte einstellen, der als Schwellwert
verwendet werden soll. Sie können die Einstellung mit Hilfe eines Schiebereglers oder des zu-
gehörigen Eingabefeldes im Bereich von 0 bis 255 vornehmen. Alle Transparenzwerte unterhalb
des Schwellwertes werden durch die Ausführung des Kommandos komplett deckend, die Trans-
parenzwerte oberhalb des Schwellwertes sind nach Ausführung des Kommandos hingegen vollständig
transparent.

9.10.38. Auswahl aus Alphakanal

Mit diesem Kommando können Sie den Alphakanal der aktiven Eben in eine Auswahl für das aktuelle
Bild umwandeln. Eine möglicherweise bereits im Bild existierende Auswahl wird dadurch ersetzt. Be-
reiche des Alphakanals mit hoher Deckkraft werden ausgewählt, transparente Bereiche befinden sich
außerhalb der Auswahl. Die halbtransparenten Bereiche werden in weiche Auswahlkanten umgewan-
delt. Der Alphakanal selbst wird durch dieses Kommando nicht verändert.

9.10.38.1. Aufruf des Kommandos

• Das Kommando kann aus dem Bildfenster erreicht werden: Ebene → Transparenz → Auswahl
aus Alphakanal

• Alternativ können Sie das Kommando im Kontextmenü des Ebenendialoges aufrufen.

9.10.39. Zur Auswahl hinzufügen

Mit diesem Kommando können Sie Pixel der aktiven Ebene in Abhängigkeit von ihrer Transparenz, in
eine Auswahl umwandeln. Diese wird dann zu einer im aktuellen Bild bereits vorhandenen Auswahl
hinzugefügt. Weiße (deckende) Bereiche des Alphakanals werden ausgewählt, schwarze (transparente)
Bereiche befinden sich außerhalb der Auswahl. Die grauen Bereiche des Alphakanals werden in weiche
Auswahlkanten umgewandelt. Der Alphakanal selbst wird durch dieses Kommando nicht verändert.
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9.10.39.1. Aufruf des Kommandos

• Das Kommando kann aus dem Bildfenster erreicht werden: Ebene → Transparenz → Zur Aus-
wahl hinzufügen

• Alternativ können Sie das Kommando im Kontextmenü des Ebenendialoges aufrufen.

9.10.40. Von Auswahl abziehen

Mit diesem Kommando können Sie den Alphakanal der aktiven Ebene in eine Auswahl umwandeln.
Diese Auswahl wird dann von einer schon im Bild befindlichen Auswahl abgezogen. Weiße (deckende)
Bereiche der Ebene werden ausgewählt, schwarze (transparente) Bereiche befinden sich außerhalb der
Auswahl. Die grauen Bereiche des Alphakanals werden in weiche Auswahlkanten umgewandelt. Der
Alphakanal selbst wird durch dieses Kommando nicht verändert.

9.10.40.1. Aufruf des Kommandos

• Das Kommando kann aus dem Bildfenster erreicht werden: Ebene → Transparenz → Von Aus-
wahl abziehen

• Alternativ können Sie das Kommando im Kontextmenü des Ebenendialoges aufrufen.

9.10.41. Schnittmenge bilden

Mit diesem Kommando können Sie den Inhalt des Alphakanals der aktiven Ebene in eine Auswahl
umwandeln. Die Schnittmenge dieser Auswahl und einer bereits im Bild vorhandenen Auswahl bildet
dann die neue Auswahl für das Bild. Weiße (deckende) Bereiche des Alphakanals werden ausgewählt,
schwarze (transparente) Bereiche befinden sich außerhalb der Auswahl. Die grauen Bereiche des Al-
phakanals werden in weiche Auswahlkanten umgewandelt. Der Alphakanal selbst wird durch dieses
Kommando nicht verändert.

9.10.41.1. Aufruf des Kommandos

• Das Kommando kann aus dem Bildfenster erreicht werden: Ebene → Transparenz → Schnitt-
menge bilden

• Alternativ können Sie das Kommando im Kontextmenü des Ebenendialoges aufrufen.

9.10.42. Das Untermenü ”Transformation“

Abbildung 9.68. Das Untermenü ”Transformation“

In diesem Untermenü finden Sie verschiedene Kommandos, um Ebenen zu spiegeln und zu drehen.

9.10.42.1. Aufruf des Untermenüs

• Das Untermenü kann aus dem Bildfenster erreicht werden: Ebene → Transformation
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9.10.42.2. Der Inhalt des Untermenüs

Im Untermenü Transformation stehen Ihnen folgende Kommandos zur Verfügung:

• Abschnitt 9.10.34 auf Seite 282

• Abschnitt 9.10.43

• Abschnitt 9.10.44

• Abschnitt 9.10.45

• Abschnitt 9.10.46

• Abschnitt 9.10.47 auf der nächsten Seite

• Abschnitt 9.10.48 auf der nächsten Seite

• Abschnitt 9.10.49 auf der nächsten Seite

9.10.43. Horizontal Spiegeln

Mit diesem Kommando können Sie die aktive Ebene horizontal, also entlang der x-Achse, spiegeln.

9.10.43.1. Aufruf des Kommandos

• Das Kommando kann aus dem Bildfenster erreicht werden: Ebene → Transformation → Hori-
zontal spiegeln

9.10.44. Vertikal Spiegeln

Mit diesem Kommando können Sie die aktive Ebene vertikal, also entlang der y-Achse, spiegeln.

9.10.44.1. Aufruf des Kommandos

• Das Kommando kann aus dem Bildfenster erreicht werden: Ebene→ Transformation→ Vertikal
spiegeln

9.10.45. 90° drehen (rechts)

Mit diesem Kommando können Sie die aktive Ebene um 90° nach rechts (also im Uhrzeigersinn) drehen.
Die Drehung erfolgt um den Mittelpunkt der Ebene und ist für deren Inhalt verlustfrei. Die Form der
Ebene wird ebenfalls nicht verändert. Beachten Sie, dass die gedrehte Ebene über die Kanten des Bildes
hinausragen kann. Das heißt, auch wenn Sie nach dem Drehen der Ebene möglicherweise Randbereiche
nicht sehen, so sind diese trotzdem noch vorhanden und können beispielsweise durch verschieben der
gedrehten Ebene wieder sichtbar gemacht werden.

9.10.45.1. Aufruf des Kommandos

• Das Kommando kann aus dem Bildfenster erreicht werden: Ebene → Transformation → 90°
drehen (rechts)

9.10.46. 90° drehen (links)

Mit diesem Kommando können Sie die aktive Ebene um 90° nach links (also gegen den Uhrzeigersinn)
drehen. Die Drehung erfolgt um den Mittelpunkt der Ebene und ist für deren Inhalt verlustfrei. Die
Form der Ebene wird ebenfalls nicht verändert. Beachten Sie, dass die gedrehte Ebene über die Kanten
des Bildes hinausragen kann. Das heißt, auch wenn Sie nach dem Drehen der Ebene möglicherweise
Randbereiche nicht sehen, so sind diese trotzdem noch vorhanden und können beispielsweise durch
verschieben der gedrehten Ebene wieder sichtbar gemacht werden.
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9.10. DAS MENÜ ”EBENE“ IM BILDFENSTER KAPITEL 9. MENÜ

9.10.46.1. Aufruf des Kommandos

• Das Kommando kann aus dem Bildfenster erreicht werden: Ebene → Transformation → 90°
drehen (links)

9.10.47. 180° drehen

Mit diesem Kommando können Sie die aktive Ebene um 180° drehen. Die Drehung erfolgt um den
Mittelpunkt der Ebene und ist für deren Inhalt verlustfrei. Die Form der Ebene wird ebenfalls nicht
verändert. Beachten Sie, dass die gedrehte Ebene über die Kanten des Bildes hinausragen kann. Das
heißt, auch wenn Sie nach dem Drehen der Ebene möglicherweise Randbereiche nicht sehen, so sind
diese trotzdem noch vorhanden und können beispielsweise durch verschieben der gedrehten Ebene
wieder sichtbar gemacht werden.

9.10.47.1. Aufruf des Kommandos

• Das Kommando kann aus dem Bildfenster erreicht werden: Ebene → Transformation → 180°
drehen

9.10.48. Beliebig drehen

Mit diesem Kommando können Sie eine Ebene um einen beliebigen Winkel drehen. Hierzu verwendet
GIMP das Werkzeug ”Drehen“, welches im Abschnitt 7.4.4 auf Seite 124 ausführlich beschrieben ist.

9.10.48.1. Aufruf des Kommandos

• Das Kommando kann aus dem Bildfenster erreicht werden: Ebene→ Transformation→Beliebig

• alternativ können Sie das Tastenkürzel Shift–R verwenden.

9.10.49. Ebene verschieben

Mit diesem Kommando können Sie den Inhalt der aktiven Ebene verschieben. Wie weit der Inhalt ver-
schoben wird und wie die dadurch entstehenden leeren Bereiche der Ebene gefüllt werden können Sie
im zugehörigen Dialogfenster einstellen.

9.10.49.1. Aufruf des Kommandos

• Das Kommando kann aus dem Bildfenster erreicht werden: Ebene → Maske → Versatz

• alternativ können Sie auch das Tastenkürzel Shift–Strg–O verwenden.

9.10.49.2. Beschreibung des Dialogfensters

Versatz

X;Y Mit diesen beiden Eigenschaften können Sie einstellen, um wie weit der Inhalt der Ebene in
der jeweiligen Richtung verschoben werden soll. Hierzu stehen Ihnen zwei Eingabefelder zur
Verfügung. Zusätzlich können Sie in einem Klappmenü die Maßeinheit einstellen, in der Sie
die Werte angeben möchten.

Versatz um (x/2),(y/2) Mit dieser Schaltfläche können Sie die Werte für X und Y so einstellen las-
sen, dass der Inhalt um die halbe Breite und Höhe der Größe der Ebene verschoben wird.
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Abbildung 9.69. Das Dialogfenster ”Ebene verschieben“

Kantenverhalten Mit dieser Eigenschaft haben können Sie einstellen, wie mit den Bereichen der Ebene
verfahren werden soll, aus denen der Inhalt ”herausgeschoben“ wird. Es stehen drei Möglichkeiten
zur Auswahl:

• Falten: Mit dieser Einstellung werden die Bereiche der Ebene aus denen Inhalt herausgescho-
ben wird, durch den herausgeschobenen Inhalt ersetzt. Es gehen also keine Inhalte verloren.

• Mit Hintergrundfarbe auffüllen: Mit dieser Einstellung werden die Bereiche der Ebene aus de-
nen der Inhalte herausgeschoben wird mit der aktuellen Hintergrundfarbe gefüllt.

• Transparent machen: Wenn Sie diese Einstellung auswählen, werden die Bereiche aus denen
der Inhalte durch das Kommando herausgeschoben wird transparent gemacht.

9.10.50. Ebenengröße

Eine Ebene hat in GIMP nicht immer die selbe Größe wie das Bild zu der sie gehört. Mit diesem Kom-
mando können Sie die Größe der aktiven Ebene verändern. Dazu wird nach dem Aufruf des Komman-
dos ein Dialogfenster angezeigt, ein dem sie die Einstellungen vornehmen können.

9.10.50.1. Aufruf des Kommandos

• Der Menüeintrag kann aus dem Bildfenster erreicht werden: Ebene → Ebenengröße

9.10.50.2. Beschreibung des Dialogfensters

Bildgröße

Breite; Höhe Wenn Sie den Dialog aufrufen, werden in den Eingabefeldern Breite und Höhe
zunächst die bisherigen Ausmaße angezeigt. Sie können diese beliebig verändern. Zu be-
achten ist dabei, dass hinter den Eingabefeldern ein Kettensymbol angezeigt wird. Ist dieses
geschlossen,wird GIMP das Seitenverhältnis automatisch konstant halten. Wenn Sie also für
die Breite oder Höhe des Bildes einen neuen Wert eintragen, so wird GIMP den jeweils ande-
ren Wert automatisch anpassen. Sollten Sie das Seitenverhältnis ändern wollen und für Breite
und Höhe des Bildes unabhängig voneinander Werte eingeben wollen, so müssen Sie das
Kettensymbol zunächst durch anklicken öffnen.
Neben der Eistellung der Bildgröße in Pixeln stehen Ihnen noch weitere Maßeinheiten in
einem Klappmenü zur Auswahl. So können Sie beispielsweise sehr einfach die Bildgröße
prozentual einstellen. Außerdem stehen Ihnen hier physische Längeneinheiten wie Milli-
meter oder Zoll zur Auswahl. Wenn Sie diese verwenden wird die notwendige physische
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Auflösung in Pixel von GIMP automatisch unter Berücksichtigung der im Dialogfenster an-
gegebenen X; Y Auflösung bestimmt.

X Auflösung; Y Auflösung Mit diesen zwei Eigenschaften können Sie die logische Auflösung
des Bildes einstellen. Dies geschieht üblicherweise in der Einheit ”Pixel pro Inch“ (dpi), Sie
können aus dem Klappmenü jedoch auch andere Einheiten wie ”Pixel pro Millimeter“ auswählen.

9.10.51. Ebene auf Bildgröße

Mit diesem Kommando können Sie die Größe der Ebene an die Bildgröße anpassen. Der Inhalt der
Ebene wird dabei nicht verschoben.

9.10.51.1. Aufruf des Kommandos

• Der Menüeintrag kann aus dem Bildfenster erreicht werden: Ebene → Ebene auf Bildgröße

9.10.52. Ebene skalieren

Dieses Kommando verändert die Größe des Bildes durch Skalierung. Hierbei kann ein Qualitätsverlust
der Bildobjekte auf der Ebene entstehen.

9.10.52.1. Aufruf des Kommandos

• Der Menüeintrag kann aus dem Bildfenster erreicht werden: Ebene → Ebene sskalieren

9.10.52.2. Beschreibung des Dialogfensters

Ebenengröße Wenn Sie die Ebene über die Originalgröße hinaus vergrößern, werden die neuen Pixel
aus den vorhandenen berechnet. Dieser Vorgang wird ”Interpolation“ genannt. Bitte beachten Sie,
dass durch eine Interpolation, egal mit welchem Algorithmus nie neue Informationen in die Ebene
eingebracht werden. Wo keine Details in Ihrer Ebene sind, wird auch eine Vergrößerung keine
hinzaubern können. Vielmehr kann die Ebene nach einer Skalierung unscharf wirken.

Breite; Höhe Wenn Sie den Dialog aufrufen, werden in den Eingabefeldern Breite und Höhe
zunächst die bisherigen Ausmaße angezeigt. Sie können diese beliebig verändern. Zu be-
achten ist dabei, dass hinter den Eingabefeldern ein Kettensymbol angezeigt wird. Ist dieses
geschlossen,wird GIMP das Seitenverhältnis automatisch konstant halten. Wenn Sie also für
die Breite oder Höhe der Ebene einen neuen Wert eintragen, so wird GIMP den jeweils ande-
ren Wert automatisch anpassen. Sollten Sie das Seitenverhältnis ändern wollen und für Breite
und Höhe der Ebene unabhängig voneinander Werte eingeben wollen, so müssen Sie das
Kettensymbol zunächst durch anklicken öffnen.
Neben der Eistellung der Ebenengröße in Pixeln stehen Ihnen noch weitere Maßeinheiten
in einem Klappmenü zur Auswahl. So können Sie beispielsweise sehr einfach die Ebenen-
größe prozentual einstellen. Außerdem stehen Ihnen hier physische Längeneinheiten wie
Millimeter oder Zoll zur Auswahl. Wenn Sie diese verwenden wird die notwendige physi-
sche Auflösung in Pixel von GIMP automatisch unter Berücksichtigung der im Dialogfenster
angegebenen X; Y Auflösung bestimmt.

Qualität Um eine Veränderung an der Ebenengröße vorzunehmen müssen entweder vorhandene Pixel
entfernt, oder neue Pixel zum Bild hinzugefügt werden. Mit welchem Verfahren dies geschieht
bestimmt maßgeblich die Qualität des Ergebnisses. GIMP stellt Ihnen hierzu verschiedene Algo-
rithmen zur Auswahl:
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Interpolation

• Keine: Mit dieser Einstellung wird keine Interpolation durchgeführt. Die einzelnen Pixel
werden durch einfaches weglassen oder duplizieren entfernt oder hinzugefügt. Das geht
zwar sehr schnell, die Ergebnisse sind aber von sehr geringer Qualität.

• Linear: In dieser Einstellung wird eine lineare Interpolationsmethode verwendet. Diese
ist ein Kompromiss zwischen Geschwindigkeit und Qualität.

• Kubisch: Mit dieser Einstellung wird eine kubische Interpolationsmethode verwendet.
Diese ist zwar in der Berechnung recht aufwändig, erzeugt aber die qualitativ besten
Ergebnisse.

9.10.53. Ebene zuschneiden

Mit diesem Kommando können Sie die aktive Ebene auf die Größe einer im Bild befindlichen Aus-
wahl zuschneiden. Alle Bereiche außerhalb der Auswahl werden dabei entfernt. Bereiche einer weichen
Auswahlkante werden hingegen nicht abgeschnitten. Falls es im Bild keine Auswahl gibt, wird der
Menüeintrag des Kommandos ausgegraut.

9.10.53.1. Aufruf des Kommandos

• Das Kommando kann aus dem Bildfenster erreicht werden: Ebene → Ebene zuschneiden

9.10.54. Automatisch zuschneiden

Mit diesem Kommando können Sie die aktuellen Ebene automatisch zuschneiden. Dabei werden in der
aktiven Ebene alle einfarbigen Randbereiche entfernt.

9.10.54.1. Aufruf des Kommandos

• Das Kommando kann aus dem Bildfenster erreicht werden: Ebene→ Automatisch zuschneiden

9.10.55. Sichtbare Ebenen anordnen

Mit diesem Kommando können Sie die im Bild sichtbaren Ebenen sehr exakt ausrichten. Dies hilfreich
sein, wenn Sie an Animationen arbeiten, die typischerweise viele kleine Ebenen erfordern. Nach wel-
chen Regeln die Ebenen ausgerichtet werden können Sie in einem Dialogfenster einstellen, welches
Ihnen nach dem Aufruf des Kommandos angezeigt wird.

ANMERKUNG

In GIMP 1.2 war das Bezugsobjekt der Ausrichtung standardmäßig die oberste
sichtbare Ebene im Bild. In GIMP 2 ist dies die Zeichenfläche. Sie können je-
doch durch aktivieren der Eigenschaft Die unterste (unsichtbare) Ebene als
Basis verwenden auch im aktuellen GIMP eine Ebene als Bezugsobjekt der
Ausrichtung verwenden.

9.10.55.1. Aufruf des Kommandos

• Das Kommando kann aus dem Bildfenster erreicht werden: Ebene → Sichtbare Ebenen anord-
nen
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Abbildung 9.70. Beispielbild zur Ebenenausrichtung. Das Beispielbild enthält vier Ebenen auf einer
großen Zeichenfläche. Die rote ist 10x10 Pixel, die Grüne 10x20 Pixel und die Gelbe ist 20x10 Pixel
groß. Die Hintergrundebene (blau: 100x100 Pixel) wird nicht durch das Kommando beeinflusst, da die
Eigenschaft Die unterste Ebene ignorieren aktivier ist.

Abbildung 9.71. Das Dialogfenster ”Sichtbare Ebenen anordnen“ La fenêtre de dialogue ”Aligner les
calques visibles“

9.10.55.2. Beschreibung des Dialogfensters

Horizontaler Stil; Vertikaler Stil Mit dieser Eigenschaft können Sie einstellen wie die Ebenen aneinan-
der ausgerichtet werden sollen. Es stehen Ihnen verschiedene Einstellungen zur Auswahl:

• Kein: Es wird in dieser Orientierung keine Ausrichtung vorgenommen.

• Zusammenfassen: Wenn Sie diese Einstellung wählen, werden die Ebenen alle an der Zei-
chenfläche ausgerichtet. Welche Kante der Zeichenfläche zu Einsatz kommen soll, legen Sie
mit der Eigenschaft Horizontale Basis bzw. Vertikale Basis fest.

Abbildung 9.72. Horizontale, zusammenfassende Ausrichtung (Zeichenfläche)

(a) Originalbild mit Ebenenstapel (b) Die Ebenen
wurden horizontal
an der linken Kante
der Zeichenfläche
zusammenfassend
ausgerichtet.

• Füllen (von links nach rechts); Füllen (von oben nach unten): Mit dieser Einstellung wer-
den die Ebenen an der Zeichenfläche ausgerichtet. Welche Kante der Zeichenfläche zu Einsatz
kommen soll, legen Sie mit der Eigenschaft Horizontale Basis bzw. Vertikale Basis fest. Da-
bei werden die Ebenen so angeordnet, dass sie einander nicht überlappen. Die oberste Ebene
wird direkt an der gewählten Kante positioniert, alle anderen dann auffüllend versetzt.
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Abbildung 9.73. Horizontale, zusammenfassende Ausrichtung (Ebene)

(a) Originalbild mit Ebenenstapel (b) Die Ebenen
wurden horizontal
an der linken Kante
der untersten Ebene
zusammenfassend
ausgerichtet.

Abbildung 9.74. Horizontale, auffüllende Ausrichtung (Zeichenfläche)

(a) Originalbild mit Ebenenstapel (b) Horizontal
auffüllende Ausrich-
tung von links nach
rechts. Die grüne
Ebene, die oberste
des Ebenenstapels,
wurde an der linken
Kante ausgerichtet.
Nach rechts versetzt
folgen die gelbe
und die rote Ebene
auffüllend.

• Füllen (von rechts nach links); Füllen (von unten nach oben): Diese Einstellung wirkt
ähnlich der zuvor beschriebenen, nur dass in die entgegengesetzte Richtung aufgefüllt wird.

9.11. Das Menü ”Werkzeuge“ im Bildfenster

9.11.1. Einführung in das Menü ”Werkzeuge“

Die in diesem Menü befindlichen Kommandos dienen Ihnen zur Aktivierung der GIMP Werkzeuge.
Alle Werkzeuge, welche Ihnen in GIMP zur Verfügung stehen sind im Kapitel 7 auf Seite 75 ”Werk-

zeuge“ ausführlich beschrieben.

9.12. Das Menü ”Filter“ im Bildfenster

9.12.1. Einführung in das Menü ”Filter“

Mit Ausnahme der ersten drei Kommandos sind alle Einträge dieses Menüs im Kapitel 10 auf Seite 295

”Filter“ beschrieben.
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Abbildung 9.75. Horizontale, auffüllende Ausrichtung (Ebene)

(a) Originalbild mit Ebenenstapel (b) Parameter wie im
vorherigen Beispiel,
aber mit der unters-
ten (blauen) Ebene
als Bezugsobjekt.

Abbildung 9.76. Vertikal, auffüllende Ausrichtung (Ebene)

(a) Originalbild mit Ebenenstapel (b) Vertikal
auffüllende Ausrich-
tung von unten nach
oben mit der unters-
ten Ebene des Stapels
als Bezugsobjekt

9.12.2. Filter wiederholen

Mit diesem Kommando können Sie das zuletzt ausgeführte Filter erneut ausführen. Dabei werden ge-
nau die Filtereigenschaften benutzt, die Sie bei der letzten Anwendung des Filters eingestellt hatten.
Das Dialogfenster zur Einstellung der Eigenschaften wird hierbei nicht erneut angezeigt.

Abbildung 9.77. Inhalt des Werkzeuge Menüs
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Abbildung 9.78. Inhalt des Filter Menüs

ANMERKUNG

Bitte beachten Sie, dass technisch betrachtet die zuletzt verwendete GIMP Er-
weiterung (Plug-In) erneut ausgeführt wird. Da alle Filter als Erweiterung reali-
siert sind, ist dies in aller Regel das zuletzt benutzte Filter. Das muss aber nicht
so sein. Es kann sich auch um eine andere Erweiterung handeln, welche nicht-
einmal notwendigerweise im Filter Menü erreichbar sein muss.

9.12.2.1. Aufruf des Kommandos

• Das Kommando kann aus dem Bildfenster erreicht werden: Filter → Filter wiederholen

• alternativ können Sie das Tastenkürzel Strg–F verwenden

9.12.3. Filter nochmal anzeigen

Mit diesem Kommando können Sie das zuletzt ausgeführte Filter interaktiv erneut aufrufen. Interaktiv
bedeutet, dass im Gegensatz zum Kommando Filter → Filter wiederholen sämtliche Dialogfenster
und Meldungen des Filters angezeigt werden. Dabei enthält das Dialogfenster zur Einstellung der Fil-
tereigenschaften genau die Werte, mit denen Sie das Filter das letzte Mal ausgeführt haben. ( Jedenfalls
wenn das Filter richtig programmiert wurde. )

ANMERKUNG

Bitte beachten Sie, dass technisch betrachtet die zuletzt verwendete GIMP Er-
weiterung (Plug-In) erneut ausgeführt wird. Da alle Filter als Erweiterung reali-
siert sind, ist dies in aller Regel das zuletzt benutzte Filter. Das muss aber nicht
so sein. Es kann sich auch um eine andere Erweiterung handeln, welche nicht-
einmal notwendigerweise im Filter Menü erreichbar sein muss.
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TIPP

Da einige Filter in GIMP leider noch nicht über eine Vorschau verfügen, ist es
gelegentlich notwendig die Einstellung der Filtereigenschaften mehrfach anzu-
passen, um das gewünschte Ergebnis zu erhalten. Der schnellste Weg dies zu
erreichen besteht darin über die Tastenkürzel nacheinander Rückgängig Strg–Z
gefolgt von Filter nochmal anzeigen Ctrl–Shift–F auszuführen.

9.12.3.1. Aufruf des Kommandos

• Das Kommando kann aus dem Bildfenster erreicht werden: Filter → Filter nochmal anzeigen

• alternativ können Sie das Tastenkürzel Strg–Shift–F verwenden

9.12.4. Alle Filtereinstellungen zurücksetzen

Wenn Sie ein Filter mit Dialogfenster mehrfach aufrufen werden normalerweise jeweils die Einstellun-
gen wieder angezeigt, mit denen Sie das Filter zuletzt ausgeführt haben. Gelegentlich kann es passieren,
dass ein Zurücksetzen der Wert auf die Standardeinstellung des Filters hilfreich wäre, weil Sie sich bei-
spielsweise im Dschungel der Filtereigenschaften verrannt haben. Mit diesem Kommando könne Sie
genau das tun. Beachten Sie aber bitte, dass Sie mit diesem Kommando die Einstellungen aller GIMP Er-
weiterungen zurücksetzen. Sie können die Ausführung dieses Kommandos nicht rückgängig machen!

9.12.4.1. Aufruf des Kommandos

• Das Kommando kann aus dem Bildfenster erreicht werden: Filter→Alle Filtereinstellung zurücksetzen
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10. Filter

10.1. Einführung in die Digitalen Filter

Mit digitalen Filtern können Sie mathematische Algorithmen auf Bilder oder Bildbereiche wie Ebenen
oder Auswahlen anwenden. GIMP stellt Ihnen eine ganze Reihe von Filtern zur Verfügung, um Effekte
verschiedenster Art zu erzeugen. Dazu gehören Filter, mit denen Sie Bildrauschen entfernen oder hin-
zufügen, Kanten hervorheben oder Farben verfremden können. Wie Sie diese anwenden, wird in den
folgenden Kapiteln beschrieben.

Die Filter sind in verschiedene Kategorien unterteilt:

• Weichzeichnen

• Farben

• Rauschen

• Kanten finden

• Verbessern

• Generisch

• Glas-Effekte

• Licht-Effekte

• Verzerren

• Künstlerisch

• Abbilden

• Render

• Web

• Animation

• Kombinieren

10.2. Weichzeichnen

10.2.1. Einführung in die Weichzeichnungsfilter

Abbildung 10.1. Originalbild

Weichzeichnungsfilter setzen die Bildschärfe unter Verwendung verschiedener Algorithmen herab.
Das Beispielbild soll Ihnen bei der Auswahl eines passenden Filters helfen. Dabei wird jedes Filter auf
das Originalbild angewendet und erklärt wie das Filter wirkt. Durch die verschiedenen Eigenschaften
der meisten Filter haben Sie die Möglichkeit die Stärke und den Typ der Weichzeichnung zu variieren.
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Abbildung 10.2. Gaußscher Weichzeichner (Radius 10)

Der am weitesten verbreitete und bekannte Weichzeichnungsfilter ist der Gaußsche Weichzeichner. Las-
sen Sie sich von dem Namen ”Gauß“ nicht zu sehr beeindrucken, dies ist einer der einfachsten Weich-
zeichnungsfilter. Aber er ist sehr effizient und erlaubt eine sehr starke Weichzeichnung bei sehr kurzen
Rechenzeiten.

Abbildung 10.3. Weichzeichnen

Wenn Sie ein Bild weichzeichnen wollen, sollten Sie den Filter ”Weichzeichnen“ in Betracht ziehen.
Er benötigt keine Parameter. Der Effekt kann so subtil ausfallen, dass Sie selbst gar nicht bemerken,
dass das Bild weichgezeichnet wurde. Zur Verstärkung des Effektes können Sie den Filter mehrfach
anwenden. Um einen starken Weichzeichnungseffekt zu erreichen, ist das Filter zu langsam um eine
gute Wahl zu sein. Probieren Sie stattdessen den ”Gaußschen Weichzeichner“.

Abbildung 10.4. Selektiver Gaußscher Weichzeichner

Der Selektive Gaußsche Weichzeichner erlaubt es Ihnen einen Schwellwert anzugeben, so dass nur
Pixel die einander ähnlich sind zur Berechnung des Effektes herangezogen werden. Dies ist sehr hilf-
reich, wenn Sie beispielsweise das Rauschen aus Fotos entfernen wollen, ohne die Schärfe der Kanten zu
zerstören1. Dieser Filter ist – im Vergleich zum normalen Gaußschen Weichzeichner – sehr aufwendig zu
berechnen. Sie sollten ihn also nur dann einsetzen, wenn Sie seine speziellen Eigenschaften benötigen.

Der Filter Pixeln verwandelt das Bild in eine Menge von grossen, quadratischen Klötzchen2.

ANMERKUNG

Dieser Filter ist auch als ”Abraham Lincoln Effekt“ bekannt. Eine Beschreibung
des Effektes findet sich bei [Bach04].

Der Filter Bewegungsunschärfe zeichnet von einem bestimmten Punkt aus in eine bestimmte Richtung
unscharf. Dies erlaubt es eine Bewegung im Bild darzustellen und erzeugt eine sehr dynamische Wir-
kung. Die Bewegung kann dabei linear, kreisförmig oder als Zoom simuliert werden.

Schlussendlich entspricht der Kachelbare Weichzeichner exakt dem Gaußschen Weichzeichner, mit dem
einzigen Unterschied, dass er über die Kanten des Bildes hinaus wirkt. Da beim wiederholten Zusam-
mensetzen des Bildes Kacheln entstehen, werden diese mit dem Kachelbaren Weichzeichner vermieden.

1 Beachten Sie, wie sich im Beispielbild der Hintergrund verändert hat.
2 Der Filter Ölgemälde in der Kategorie künstlerische Filter wirkt ähnlich, verwendet jedoch statt der Klötzchen unregelmässige

Blasen.
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Abbildung 10.5. Pixeln

Abbildung 10.6. Bewegungsunschärfe (Zoom)

ANMERKUNG

Der kachelbare Weichzeichner ist ein Script-Fu Skript, welches den Gaußschen
Weichzeichner benutzt.

10.2.2. Weichzeichnen

10.2.2.1. Wirkungsweise

Abbildung 10.7. Der Filter ”Weichzeichnen“ angewandt auf ein Foto

(a) Original (b) Weichzeichnen angewandt

Dieses Filter ist ein sehr einfaches Weichzeichnungsfilter. Für jeden Pixel unter Hinzunahme angren-
zender Pixel werden die Farbwerte gemittelt. Danach wird der errechnete Mittelwert dem aktuellen
Pixel als Farbwert zugewiesen.

Vorteil dieses Filters ist der geringe Rechenaufwand. Der Filter ist sehr schnell berechnet, auch für
grosse Bilder.

Der Nachteil des Filters ist, dass er für alle Bilder gleich wirkt. Während er in sehr grossen Bildern
kaum wahrnehmbar ist, wirkt er in kleinen Bildern sehr stark.

10.2.2.2. Filteraufruf

Dieses Filter lässt sich über das Menü Filter → Weichzeichnen → Weichzeichnen im Bildfenster auf-
rufen.
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10.2.3. Gaußscher Weichzeichner

10.2.3.1. Wirkungsweise

Abbildung 10.8. v.l.n.r: Original; Gaußscher Weichzeichner angewandt

(a) (b)

Der Gaußsche Weichzeichner wird auf jeden Pixel der aktiven Ebene oder Auswahl angewendet. Er
setzt den jeweiligen Farbwert auf den Mittelwert aller umliegenden Pixel in einem bestimmten Radius.
Diesen können Sie in das Filtereigenschaften einstellen. Um den Weichzeichner in eine Richtung stärker
anzuwenden, können Sie auf die Ketten-Schaltfläche klicken. Wenn die Kette durchtrennt ist, lassen
sich die Werte für Horizontal und Vertikal unterschiedlich einstellen. GIMP bietet zwei verschiedene
Gaußsche Weichzeichner: IRR und RLE. Beide liefern das selbe Ergebnis, IRR ist allerdings schneller,
wenn das Bild viele verschiedene Farbwerte hat, wie beispielsweise bei digitalen Fotos. RLE ist hingegen
schneller, sofern das Bild viel grosse gleichfarbige Bereiche enthält. Dies ist zum Beispiel bei Comics der
Fall.

10.2.3.2. Filteraufruf

Dieses Filter lässt sich über das Menü Filter→Weichzeichnen→ Gaußscher Weichzeichner im Bild-
fenster aufrufen.

10.2.3.3. Eigenschaften

Abbildung 10.9. Eigenschaften für das Filter ”Gaußscher Weichzeichner“
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Radius Hier können sie die Stärke des Weichzeichners einstellen. Wenn Sie das Verhältnis horizontal
zu vertikal ändern, lassen sich Bewegungsunschärfeeffekte erzielen. Über das Klappmenü können
Sie die verwendete Maßeinheit einstellen.

Methode IRR steht für Ïnfinite Impulse Response”. Dieser Algorithmus funktioniert am besten mit
großen Radien und Bildern, welche nicht mit dem Computer generiert wurden.

RLE steht für ”Run Length Encoding”. Am besten arbeitet diese Methode bei computergenerierten
Bildern. Auch bei Bildern mit großen einheitlichen Flächen ist der RLE Weichzeichner vorzuzie-
hen.

10.2.4. Selektiver Gaußscher Weichzeichner

10.2.4.1. Wirkungsweise

Abbildung 10.10. v.l.n.r: Original, Selektiver Gaußscher Weichzeichner angewandt

(a) Original (b) Weichzeichnen angewandt

Im Gegensatz zu den anderen Weichzeichnungsfiltern wirkt der Selektive Gaußsche Weichzeichner
nicht auf alle Pixel des Bildes, der Auswahl oder der aktuellen Ebene. Das Filter wirkt nur auf den Pixel,
deren Farbe höchstens um einen definierten Deltawert von der Farbe der Nachbarpixel abweicht. Daher
werden Kanten im Bild erhalten.

10.2.4.2. Filteraufruf

Dieses Filter lässt sich über das Menü Filter→Weichzeichnen→ Selektiver Gaußscher Weichzeich-
ner im Bildfenster aufrufen.

10.2.4.3. Eigenschaften

Radius Hier können Sie den Radius in Pixeln angeben, der zum Berechnen des Filters verwendet wird.
Dieser Wert beeinflusst massgeblich die Intensität der Wirkung.

Max. Delta Mit dieser Eigenschaft können Sie die maximale Farbdifferenz im Bereich von 0 bis 255 ein-
stellen. Diese Farbdifferenz bestimmt welche Pixel aus der Umgebung weichgezeichnet werden.
Dieser Wert beeinflusst massgeblich wie gut Kanten gegen das Weichzeichnen geschützt werden.
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Abbildung 10.11. Eigenschaften für das Filter ”Selektiver Gaußscher Weichzeichner“

Abbildung 10.12. Anwendungsbeispiele für das Filter Bewegungsunschärfe

(a) Originalbild (b) Bewegungsunschärfe linear

10.2.5. Bewegungsunschärfe

10.2.5.1. Wirkungsweise

Das Filter ”Bewegungsunschärfe“ kann die Wirkung von Bewegung in linearer, radialer (kreisförmiger)
und zoom Richtung im Bild erzeugen. Neben der Richtung können Sie auch die Stärke der Weichzeich-
nungswirkung sowie den Ausgangspunkt der gedachten Bewegung einstellen.

10.2.5.2. Filteraufruf

Dieses Filter lässt sich über das Menü Filter → Weichzeichnen → Bewegungsunschärfe im Bildfens-
ter aufrufen.

10.2.5.3. Eigenschaften

Weichzeichnungsart

Linear Bei dieser Einstellung wird die Bewegung in einer einzigen, bestimmten Richtung aus-
geführt. In diesem Fall wirkt die Eigenschaft Länge wie in anderen Weichzeichnungsfiltern
der Radius; sie bestimmt die Stärke, mit der weichgezeichnet wird. Die Eigenschaft Winkel
beschreibt, in welcher Richtung die Bewegung ausgeführt wird. Ein Wert von 0 ist horizontal,
90 beschreibt eine vertikale Bewegung.
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Abbildung 10.13. Anwendungsbeispiele für das Filter Bewegungsunschärfe

(a) Bewegungsunschärfe radial (b) Bewegungsunschärfe zoom ange-
wandt

Radial Dieser Typ beschreibt eine radiale, also kreisförmige Bewegung. Die Eigenschaft Länge
ist nicht von Bedeutung. Der Winkel hingegen ist von zentraler Bedeutung. Die Einstellung
dieser Eigenschaft bestimmt wie stark die Drehung erfolgt.

Zoom In diesem Modus wird eine Bewegungsunschärfe produziert die dem Effekt entspricht der
beim Fotografieren durch ein Verstellen der Brennweite (des Zooms) während der Belichtung
erreicht wird. Es entsteht der Eindruck einer ”Hinbewegung“, also einer Bewegung zum Ob-
jekt hin. Der Ausgangspunkt der Bewegung bleibt fast unverändert, während die Unschärfe
zu den Rändern hin start zunimmt. Die Eigenschaft Länge ist hierbei der entscheidende Pa-
rameter. Er bestimmt sozusagen die scheinbare Geschwindigkeit der Bewegung.

Parameter

Länge Diese Eigenschaft beschreibt die Länge der Bewegung. Der Wertebereich reicht von 0 bis
256.

Winkel Die Wirkung der Eigenschaft hängt von der gewählten Weichzeichnungsart ab. Der Wer-
tebereich kann zwischen 0 und 360 eingestellt werden.

Unschärfezentrum Mit dieser Eigenschaft legen Sie den Anfangspunkt der Bewegung fest. Je nach
gewählter Art kann dies unterschiedliche Auswirkungen haben. Bei der radialen Bewegung legen
Sie beispielsweise das Rotationszentrum fest.

TIPP

Sie müssen bei dieser Eigenschaft die Koordinaten des Bewegungszen-
trums eingeben. Leider können Sie diese nicht automatisch durch einen
Mausklick bestimmen. Sie können aber im Bildfenster den Mauszeiger über
den gewünschten Punkt verschieben. Die zugehörigen Koordinaten wer-
den dann in der Statusleiste am unteren Bildschirmrand angezeigt.
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Abbildung 10.14. Eigenschaften für das Filter ”Bewegungsunschärfe“

10.2.6. Pixeln

10.2.6.1. Wirkungsweise

Abbildung 10.15. v.l.n.r.: Originalbild, Pixeln Filter angewandt

(a) Original (b) Weichzeichnen angewandt

Der Pixeln Filter reduziert das Bild auf einige grosse, farbige Blöcke. Dies ist dem Effekt sehr ähnlich,
mit dem in den Bildmedien Gesichter von Personen unkenntlich gemacht werden, welche nicht erkannt
werden sollen. Dieser Effekt ist auch unter dem Namen ”Abraham Lincoln Effekt“ bekannt. Weiter In-
formationen hierzu finden Sie im Internet <http://www.michaelbach.de/ot/fcs mosaic/>.

10.2.6.2. Filteraufruf

Dieses Filter lässt sich über das Menü Filter → Weichzeichnen → Pixeln im Bildfenster aufrufen.
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10.2.6.3. Eigenschaften

Abbildung 10.16. Eigenschaften für das Filter ”Bewegungsunschärfe“

Pixelbreite Diese Eigenschaft bestimmt die Breite der Blöcke.

Pixelhöhe Diese Eigenschaft bestimmt die Höhe der Blöcke.

Kettensymbol Wenn das Symbol eine geöffnete Kette darstellt, können Sie die Werte für Breite und
Höhe unabhängig voneinander einstellen. Andernfalls sind sie voneinander abhängig.

Klappmenü Maßeinheiten In diesem Klappmenü können Sie die Maßeinheit einstellen, in der Sie die
Werte für Breite und Höhe angeben möchten.

10.2.7. Kachelbarer Weichzeichner

10.2.7.1. Wirkungsweise

Abbildung 10.17. v.l.n.r.: Originalbild, Kachelbarer Weichzeichner angewandt

(a) Original (b) Weichzeichnen angewandt

Diesen Filter können Sie verwenden, wenn Sie das Bild kacheln, also mehrfach aneinander legen
wollen, um ein grösseres Bild zu erhalten. Das Filter sorgt dabei für weiche Übergänge an den Rändern,
an denen die Kacheln zusammenstossen.
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TIPP

Wenn Sie nur die Randbereiche des Bildes weichzeichnen möchten, reicht es
nicht aus das Filter auf das gesamte Bild anzuwenden. Der Ablauf, um das
gewünschte Ergebnis zu erzielen ist wie folgt:

Machen Sie eine Kopie der Ebene ( Ebene → Ebene duplizieren ) und wählen
Sie diese aus, um damit zu arbeiten.

Wenden Sie das Filter ”Kachelbarer Weichzeichner“ mit einem Radius von 20
Pixeln auf die Ebene an.

Wählen Sie alles aus ( Strg–A) und beschränken Sie die Auswahl ( Auswahl →
Verkleinern ), um einen Rand zu erhalten.

Geben Sie der Auswahl mittels Auswahl → Ausblenden eine weiche Kante.

Löschen Sie die Auswahl mittels Strg–K.

Führen Sie die Ebenen mittels Ebene → Nach unten vereinen wieder zusam-
men.

10.2.7.2. Filteraufruf

Dieses Filter lässt sich über das Menü Filter → Weichzeichnen → Kachelbarer Weichzeichner im
Bildfenster aufrufen.

10.2.7.3. Eigenschaften

Abbildung 10.18. Eigenschaften für das Filter ”Kachelbarer Weichzeichner“

Radius Mit dieser Eigenschaft können Sie die Stärke der Weichzeichnung einstellen. Je grösser der
Radius, um so grösser die Wirkung des Filters.

Vertikal / Horizontal weichzeichnen Mit diesen beiden Kontrollkästchen können Sie einstellen, ob Sie
die horizontalen, und/oder die vertikalen Ränder kachelbar machen möchten.

Art des Weichzeichnens Mit diesem Klappmenü können Sie den Algorithmus einstellen, der zum
Weichzeichnen verwendet werden soll. Auswahlmöglichkeiten sind IIR und RLE. Beide liefern
das gleiche Ergebnis, jedoch ist IIR schneller bei Bildern mit vielen kleinen Farbflächen (Fotos)
und RLE schneller bei Bildern mit wenigen grossen Farbflächen (Comics).

312



KAPITEL 10. FILTER 10.3. FARBE

10.3. Farbe

10.3.1. Einführung in die Farbfilter

Die Gruppe der Farbfilter umfasst verschiedenste Filter, welche die Farben in einem Bild, einer Ebe-
ne oder einer Auswahl verändern. Es stehen Filter zum Einfärben, Umfärben, Entfärben und für viele
andere Anforderungen zur Verfügung. Probieren Sie sie aus.

10.3.2. VG-HG anpassen

10.3.2.1. Wirkungsweise

Abbildung 10.19. v.l.n.r.: Originalbild, VG-HG anpassen (VG:blau, HG:rot) angewandt

(a) (b)

Dieses Filter gehört zur Gruppe der Farbabbildungsfilter, welche eine Verbindung zwischen den ak-
tuellen Vorder- und Hintergrundfarben und dem Bild herstellen. In diesem Fall werden die Pixel des
Bildes, welche die aktuelle Vordergrundfarbe (VG) haben zu schwarz, während die Pixel im Bild, wel-
che die aktuelle Hintergrundfarbe (HG) haben zu weiss werden. Die anderen Farben werden in ihre
Komplementärfarben umgewandelt.

10.3.2.2. Filteraufruf

Dieser Filtes lässt sich über das Menü Filter→ Farben→ Abbilden→ VG-HG anpassen im Bildfenster
aufrufen.

10.3.3. Alien Map 2

10.3.3.1. Wirkungsweise

Dieses Filter verändert die Farben des Bildes unter Verwendung trigonometrischer Funktionen. Alien
Map 2 arbeitet mit den Farbmodellen RGB und HSV.

10.3.3.2. Filteraufruf

Dieses Filter lässt sich über das Menü Filter → Farben → Abbilden → Alien Map 2 im Bildfenster
aufrufen.

10.3.3.3. Eigenschaften

Vorschau Das Vorschaufenster zeigt wie das Bild aussehen würden, wenn der Filter mit den aktuellen
Einstellungen ausgeführt würde.
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Abbildung 10.20. v.l.n.r.: Originalbild, Alien Map 2 angewandt

(a) (b)

Modus Mit Hilfe dieser Eigenschaft können Sie einstellen, mit welchem Farbmodell (RGB oder HSV)
Sie arbeiten möchten.

Je nach gewählter Einstellung erscheinen dann Kontrollkästchen mit denen Sie die einzelnen Farb-
kanäle ein- und ausschalten können.

Schieberegler Für jeden Kanal können Sie die Frequenz im Bereich 0 bis 5 und die Phasenverschie-
bung der Sinus-Kosinus Funktion im Bereich 0° bis 360° einstellen. Hierzu stehen Ihnen jeweils
ein Schieberegler und ein numerisches Eingabefeld zur Verfügung.

Eine Frequenz zwischen 0,3 und 0,7 führt zu einer Funktionskurve, die ähnlich der linearen Funk-
tion (Originalbild) ist, nur dunkler und mit erhöhtem Kontrast. Sobald Sie die Frequenz erhöhen,
bekommen Sie eine grössere Variation von Pixelveränderungen. Dies bedeutet, das das Bild mehr
und mehr ”alien“ wird.

Die Eigenschaft Phasenverschiebung ändert die Transformation der Farbwerte. 0° und 360° ha-
ben für die Sinusfunktion den gleichen Wert, 180° kehrt den Wert für Sinus um, 270° den für die
Kosinusfunktion.

10.3.4. Farben vertauschen

10.3.4.1. Wirkungsweise

Dieses Filter ersetzt eine Farbe durch eine andere.

10.3.4.2. Filteraufruf

Dieses Filter lässt sich über das Menü Filter → Farben → Abbilden → Farben vertauschen im Bild-
fenster aufrufen.

10.3.4.3. Eigenschaften

Vorschau Das Vorschaufenster zeigt das Bild, wenn das Filter mit den aktuellen Einstellungen aus-
geführt würde.

Wenn Sie in die Vorschau klicken, wird die Farbe des angeklickten Pixels als Quellfarbe übernommen.
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Abbildung 10.21. Eigenschaften für das Filter ”Alien Map 2“

Quellfarbe In diesem Abschnitt können Sie einstellen, welche Pixel durch den Filter bearbeitet werden
sollen.

Es gibt in diesem Abschnitt drei Schieberegler, mit denen Sie die Farbintensität der drei Farbkanäle
Rot, Grün und Blau im Wertebereich von 0,0 bis 1,0 einstellen können. Sie können die Quellfar-
be alternativ auch in einem Farbauswahldialog einstellen. Dieser öffnet sich, sobald Sie auf die
aktuelle Quellfarbe klicken.

Ausserdem gibt es für jeden Farbkanal einen Schieberegler für den Schwellwert. Je höher der
Schwellwert, um so mehr Pixel werden in den Effekt des Filters einbezogen.

Mit dem Kontrollkästchen Schwellwerte gleich können Sie festlegen, dass die drei Schwellwerte
für Rot, Grün und Blau den gleichen Wert haben.

Abbildung 10.22. v.l.n.r.: Originalbild, Farben vertauschen (Blau durch Schwarz) angewandt

(a) (b)
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Abbildung 10.23. Eigenschaften für das Filter ”Farben vertauschen“

Zielfarbe Dieser Bereich enthält drei Schieberegler (Rot, Grün, Blau), mit denen Sie die Zielfarbe ein-
stellen können. Ausserdem können Sie durch einen Klick auf die aktuelle Zielfarbe einen Dialog
zur Farbauswahl öffnen.

10.3.5. Farben drehen

10.3.5.1. Wirkungsweise

Dieses Filter ermöglicht es Ihnen, in einem Bild die Farben aus beliebigen Ausschnitt des Farbkreises
gegen einen beliebigen anderen Ausschnitt auszutauschen.

10.3.5.2. Filteraufruf

Dieses Filter lässt sich über das Menü Filter → Farben → Abbilden → Farben drehen im Bildfenster
aufrufen.

10.3.5.3. Reiter Haupteigenschaften

In den Eigenschaften des Dialoges werden zwei Farbkreise dargestellt. Mit dem oberen können Sie
auswählen welche Farben durch das Filter verändert werden. Mit dem unteren bestimmen Sie auf wel-
chen Bereich des Farbkreises die zu bearbeitenden Farben abgebildet werden.
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Abbildung 10.24. v.l.n.r.: Originalbild, Farben drehen angewandt

(a) (b)

Von Zwei Achsen im Farbkreis bestimmen den Quellfarbbereich. Der gebogene Pfeil innerhalb des Win-
kels macht die Richtung des Bereiches kenntlich. Sie können die beiden Schenkel des Winkels mit
der Maus verschieben, um einen eigenen Bereich des Farbkreises zu bestimmen.

Die Schaltfläche Gegen den Uhrzeigersinn dient zum ändert der Richtung des gewählten Farb-
bereiches.

Die Schaltfläche Reihenfolge der Pfeile ändern kehrt die beiden Achsen um. Dies führt dazu,
dass genau der entgegengesetzte Farbbereich gewählt wird.

Die Schaltfläche Alles auswählen wählt den gesamten Farbkreis als Bereich aus.

Die Eingabefelder Von und Nach erlauben eine direkte numerische Eingabe der Werte (in rad/PI).

Nach Die Eingabeelemente für den Zielfarbbereich entsprechen denen zur Auswahl eines Quellfarbbe-
reiches.

10.3.5.4. Reiter Grau-Eigenschaften

Diese Filtereigenschaften erlauben es Ihnen festzulegen, wie Grau durch das Filter behandelt wird. Stan-
dardmässig wird Grau nicht als Farbe betrachtet und durch das Filter ignoriert. Mit diesen Eigenschaf-
ten können Sie wenig gesättigte Farben in Grautöne wandeln und ebenso Grautöne einfärben.

Farbkreis - Grau Im Zentrum des Farbkreises befindet sich ein kleiner Kreis. Im Zentrum repräsentiert
dieser die Farbe Grau. Wenn Sie den Schwellwert erhöhen, werden die Pixel im Bild, welche eine
geringere Farbsättigung als der Schwellwert haben, werden wie grau behandelt.

Wenn Sie den kleinen Kreis im Farbkreis verschieben, oder die Werte in den Eingabefeldern Farb-
ton und Sättigung ändern, wird eine Farbe bestimmt. Diese Farbe ersetzt bei der Anwendung des
Filters alle die Bereiche die als Grau betrachtet werden.

Graumodus In diesem Bereich können Sie für den Graumodus einstellen. Diese Eigenschaft bestimmt,
wie die anderen Einstellungen durch das Filter umgesetzt werden.

• Die Einstellung Behandle als dies bewirkt, dass die Grauwerte des Bildes durch das Filter
in die im Farbkreis eingestellte Farbe unter Berücksichtigung der eingestellten Von und Zu
aus den Haupteigenschaften des Filters.

• Die Einstellung Ändere in dies bewirkt, dass die Grauwerte des Bildes durch das Filter direkt
in die im Farbkreis eingestellte Farbe umgewandelt werden.
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Abbildung 10.25. Eigenschaften (Haupteigenschaften) für das Filter ”Farben drehen“

Schwellwert Grau Hier stellen Sie ein, welchen Wert der Farbsättigung im Bild der Filter noch als Grau
betrachtet wird. Wenn Sie den Wert erhöhen, wird der kleine Kreis im Farbkreis grösser.

10.3.5.5. Vorschau

Original und Gedreht Die Vorschau besteht aus zwei Bildern. Im oberen wird das Originalbild ange-
zeigt, das Untere zeigt das Bild nach der Ausführung des Filters mit den aktuellen Parametern.

Ständig neu berechnen Wenn dieses Kontrollkästchen aktiviert ist, wird eine Vorschau angezeigt.

Bereich In diesem Klappmenü können Sie auswählen zwischen:

• Ganze Ebene: wirkt auf die gesamte Ebene (das Bild, sofern es keine Auswahl gibt).
• Auswahl: es wird nur die Auswahl dargestellt,
• Umgebung: zeigt die Auswahl im Bildkontext an.

10.3.5.6. Einheiten

In diesem Bereich können Sie die Maßeinheit auswählen, die zur Winkelangabe in den Farbkreisen
genutzt wird. Zur Auswahl stehen die Werte Radian, Radian/Pi und Grad.

10.3.6. Farbbereiche vertauschen

10.3.6.1. Wirkungsweise

Das Filter erlaubt es Ihnen einen definierten Farbbereich im Bild mit einem anderen Farbbereich zu
vertauschen.
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Abbildung 10.26. Eigenschaften (Grau-Eigenschaften) für das Filter ”Farben drehen“.

10.3.6.2. Filteraufruf

Dieses Filter lässt sich über das Menü Filter → Farben → Abbilden → Farbbereiche vertauschen im
Bildfenster aufrufen.

10.3.6.3. Eigenschaften

Vorschau Das Vorschaufenster zeigt wie das Bild aussehen würden, wenn der Filter mit den aktuellen
Einstellungen ausgeführt würde.

Quell-Farbbereich Mit Hilfe der zwei farbigen Schaltflächen können Sie den ersten Farbbereich ein-
stellen. Durch anklicken der Schaltflächen öffnet sich der GIMP Dialog zur Farbwahl.

Abbildung 10.27. v.l.n.r.: Originalbild, Farbbereich vertauschen angewandt

(a) (b)
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Abbildung 10.28. Eigenschaften für das Filter ”Farbbereiche vertauschen“

Ziel-Farbbereich Auch hier finden Sie zwei farbigen Schaltflächen, mit deren Hilfe Sie den zweiten
Farbbereich einstellen können. Durch anklicken der Schaltflächen öffnet sich der GIMP Dialog zur
Farbwahl.

10.3.7. Einfärben

10.3.7.1. Wirkungsweise

Abbildung 10.29. v.l.n.r.: Originalbild, Einfärben angewandt

(a) (b)

Mit diesem Filter können Sie schwarz/weiss Bilder unter Verwendung eines Farbverlaufes oder eines
Bildes einfärben.

ACHTUNG

Das Bild, welches Sie einfärben möchten, muss im RGB Modus vorliegen, um
das Filter anzuwenden.
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10.3.7.2. Filteraufruf

Dieses Filter lässt sich über das Menü Filter → Farben → Abbilden → Einfärben im Bildfenster aufru-
fen.

10.3.7.3. Eigenschaften

Abbildung 10.30. Eigenschaften für das Filter ”Einfärben“

Das Dialogfenster mit den Filtereigenschaften ist in zwei Bereiche gegliedert. Auf der linken Seite
befindet sich das Zielbild, auf der rechten Seite die Quelle zur Einstellung der Einfärbung.

Ziel, Quelle Standardmässig wird die Vorschau für Quelle und Ziel auf der Basis des Bildes erstellt, für
das Sie das Filter aufgerufen haben.

Im Klappmenü Quelle können Sie ein anderes Bild, oder einen Verlauf (gegebenenfalls auch in-
vertiert) als Quelle auswählen. Wenn Sie Aus Farbverlauf (oder Aus invertiertem Farbverlauf)
auswählen, wird der aktuelle Verlauf als Quelle verwendet. Er wird im Verlaufsbalken unterhalb
der Vorschau des Quellbildes angezeigt Die Vorschau selbst wird dann ausgegraut.

Im Klappmenü Ziel ist standardmässig das Bild ausgewählt, für welches Sie das Filter aufgerufen
haben. Zusätzlich werden die weiteren aktuell geöffneten Bilder zur Auswahl angezeigt.

Auswahl anzeigen Mit diesem Kontrollkästchen können Sie zwischen dem gesamten Bild und einer
eventuell existierenden Auswahl umschalten.

Farbe zeigen Dieses Kontrollkästchen schaltet zwischen Farbe und Graustufen um.

Musterfarbe auswählen Diese Schaltfläche ist nur aktiviert, wenn Sie als Quelle ein Bild ausgewählt
haben. Sobald Sie die Schaltfläche betätigen, werden in dem Verlaufsbalken unterhalb des Quell-
bildes die Farbwerte des des Quellbildes angezeigt. Wenn Ihr Quellbild zu wenige Farben enthält,
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kann der Verlauf sehr stufig sein. In diesem Fall können Sie die Einstellung Muster verweichen
einschalten, um eine Verbesserung zu erzielen.

Die Eigenschaft Zwischenfarben verwenden ist ein bisschen komplizierter. Zunächst ist es wich-
tig zu wissen, dass es in einem Graustufenbild nur Helligkeitsinformationen gibt. In einem RGB
Bild hingegen, hat jeder Pixel Informationen über die drei Grundfarben. Daher können Pixel mit
unterschiedlichen Farbwerten in einem Graustufenbild durchaus den selben Helligkeitswert ha-
ben. Wenn nun die Eigenschaft Zwischenfarben verwenden aktiviert ist, werden die Farben ge-
mischt und auf die Pixel mit dem Wert übertragen. Ist die Eigenschaft nicht aktiviert wird hinge-
gen die dominierende Farbe aufgetragen.

Zielwerte Hier stehen Ihnen zwei Eingabefelder und zwei Schieberegler zur Verfügung, mit denen Sie
das gleiche erreichen können. Sie dienen zur Beschränkung des Farbbereiches, der zum Einfärben
benutzt wird.

Quellwerte Mit Hilfe dieser drei Eingabefelder, bzw. alternativ mittels der zugeordneten Schieberegler,
können Sie die Gewichtung von Schatten, Mitteltönen und Lichtern einstellen.

Erhalte Intensität Wenn diese Einstellung aktiv ist, wird die durchschnittliche Helligkeit des Bildes
durch das Filter nicht verändert.

Urspr. Intensität Wenn diese Einstellung aktiv ist, wird die Intensität der Quellwerte nicht beachtet.
Die Intensität des Originalbildes bleibt erhalten.

10.3.8. Auf Farbverlauf

10.3.8.1. Wirkungsweise

Abbildung 10.31. v.l.n.r.: Originalbild, Filter Auf Farbverlauf (Verlauf: blau nach rot) angewandt

(a) (b)

Dieses Filter benutzt den aktuell eingestellten Farbverlauf, welcher im Werkzeugfenster angezeigt
wird, um das Bild, die aktuelle Ebene oder eine Auswahl umzufärben. Um das Filter zu benutzen soll-
ten Sie zunächst den gewünschten Farbverlauf über den zugehörigen Dialog einstellen. Da der Filter
keine weiteren Eigenschaften besitzt, wird er direkt ausgeführt, wenn Sie ihn aus dem Menü aufrufen.
Dabei wird die Farbintensität der Pixel auf den Farbverlauf abgebildet. Die dunkelsten Pixel erhalten
die Farbe am linken Rand des Verlaufes, die hellsten entsprechend die Farbe des rechten Randes des
Farbverlaufes. Die Zwischentöne werden entsprechend auf die restlichen Farben des Verlaufes abgebil-
det.
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10.3.8.2. Filteraufruf

Dieses Filter lässt sich über das Menü Filter → Farben → Abbilden → Auf Farbverlauf im Bildfenster
aufrufen.

10.3.9. Randmittelwert

10.3.9.1. Wirkungsweise

Dieses Filter berechnet die Durchschnittsfarbe in einem Rand der aktiven Ebene oder einer Auswahl.
Die berechnete Farbe wird zur aktiven Vordergrundfarbe. Dieses Filter kann sehr hilfreich sein, wenn
Sie zum Beispiel ein Bild vor einen farbigen Hintergrund bringen möchten, der möglichst wenig von
der Farbe des Bildrandes abweicht.

10.3.9.2. Filteraufruf

Dieses Filter lässt sich über das Menü Filter → Farben → Randmittelwert im Bildfenster aufrufen.

10.3.9.3. Eienschaften

Abbildung 10.32. Eigenschaften für das Filter ”Randmittelwert“

Randgrösse Mit dieser Eigenschaft können Sie die Dicke des Randes festlegen, der zur Berechnung
der Durchschnittsfarbe benutzt wird.

Anzahl der Farben Hier können Sie die Eimergrösse, also die Anzahl der Farben im Bereich zwischen
1 und 256 festlegen, die zur Berechnung der Durchschnittsfarbe benutzt werden.

10.3.10. Kanalmixer

10.3.10.1. Wirkungsweise

Dieses Filter kombiniert die Werte der RGB Farbkanäle.

10.3.10.2. Filteraufruf

Dieses Filter lässt sich über das Menü Filter → Farben → Kanalmixer im Bildfenster aufrufen.

10.3.10.3. Eigenschaften

Ausgabekanal Aus diesem Klappmenü können Sie einen Kanal auswählen, in den die Werte hinein
gemixt werden. Zur Auswahl stehen Rot, Grün und Blau. Das Klappmenü ist ausgegraut, wenn
die Eigenschaft Monochrom aktiviert ist.
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Abbildung 10.33. v.l.n.r.: Originalbild, Kanalmixer angewandt

(a) (b)

Rot; Grün; Blau Diese drei Schieberegler ermöglichen es, den Beitrag der einzelnen Farben zum Er-
gebnis zu steuern. Die Werte können im Bereich von -200 bis 200 eingestellt werden. Alternativ zu
den Schiebereglern stehen Ihnen Eingabefelder zur Verfügung.

Monochrom Mit dieser Eigenschaft können Sie alle Kanäle vereinheitlichen. Es entsteht ein Graustu-
fenbild, für welches Sie die Helligkeitsanteile aus den verschiedenen Farbkanälen sehr genau steu-
ern können. Das Klappmenü Ausgabekanal steht bei aktiviertem Kontrollkästchen nicht mehr
zur Verfügung.

Helligkeit erhalten Wenn diese Eigenschaf aktiviert ist, sorgt das Filter dafür, dass die Helligkeit des
Bildes unabhängig von der Einstellung der Kanäle konstant gehalten wird.

10.3.10.4. Schaltflächen

Öffnen Lädt die zuvor gespeicherten Einstellungen des Filters aus einer Datei.

Speichern Speichert die Einstellungen des Filters in einer Datei.

10.3.11. Farbraumanalyse

10.3.11.1. Wirkungsweise

Dieses Filter gibt Ihnen einige interessante Informationen zu einem Bild.

10.3.11.2. Filteraufruf

Dieses Filter lässt sich über das Menü Filter → Farben → Farbraumanalyse im Bildfenster aufrufen.

10.3.12. Einfärben

10.3.12.1. Wirkungsweise

Bilder, die mit diesem Filter bearbeitet werden, erscheinen dann wie durch eine farbige Glasscheibe
betrachtet.
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Abbildung 10.34. Eigenschaften für das Filter ”Kanalmixer“

10.3.12.2. Filteraufruf

Dieses Filter lässt sich über das Menü Filter → Farben → Einfärben im Bildfenster aufrufen.

10.3.12.3. Eigenschaften

Eigenschaften Eine Farbpalette steht zur Verfügung, aus der Sie eine der vorhandenen Farben, oder
mittels der Schaltfläche Benutzerdefinierte Farbe eine eigene Farbe auswählen können.

10.3.13. Farbe zu Transparenz

10.3.13.1. Wirkungsweise

Mit diesem Filter können Sie eine bestimmte Farbe in Transparenz umwandeln. Ein Alphakanal für das
Bild wird angelegt und die weichen Kanten im Bild bleiben weitgehend vorhanden, da das Filter Pixel,
welche nur schwach mit der gewählten Farbe gesättigt sind auch nur schwach transparent macht. Auf
diese Art und Weise werden auch Objekte, die die gewählte Farbe enthalten sanft in ihre Umgebung
eingeblendet.

10.3.13.2. Filteraufruf

Dieses Filter lässt sich über das Menü Filter → Farben → Farbe zu Transparenz im Bildfenster aufru-
fen.

10.3.13.3. Eigenschaften

Farbe Durch Klicken auf die farbige Schaltfläche können Sie die Farbe auswählen, die transparent wer-
den soll. Um eine Farbe aus dem Bild zu übernehmen wählen Sie die Farbe mit der Pipette als
aktuelle Vorder- oder Hintergrundfarbe aus. Im Kontextmenü der farbigen Schaltfläche können
Sie dann die Vorder- oder Hintergrundfarbe als Eigenschaft des Filters einstellen.
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Abbildung 10.35. v.l.n.r.: Originalbild, Farbraumanalyse für das Originalbild

(a) (b)

Abbildung 10.36. v.l.n.r.: Originalbild, Einfärben angewandt

(a) (b)

10.3.14. Zusammensetzen

10.3.14.1. Wirkungsweise

Dieses Filter kehrt die Wirkung des Filters Zerlegen um. Es fügt ein Bild aus extrahierten Farbkompo-
nenten zusammen.

10.3.14.2. Filteraufruf

Dieses Filter lässt sich über das Menü Filter → Farben → Zusammensetzen im Bildfenster aufrufen.

10.3.14.3. Eigenschaften

Kanäle zusammensetzen Hier wählen Sie aus, aus welchen Farbkomponenten das Bild zusammen-
gesetzt werden soll. Zur Auswahl stehen verschiedene Farbmodelle, welche im Filter Zerlegen
bereits ausführlich beschrieben wurden.

Kanalzuweisungen Hier können Sie einstellen, aus welchen Ebenen die Farbkanäle wiederhergestellt
werden sollen.
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Abbildung 10.37. Eigenschaften für das Filter ”Einfärben“

Abbildung 10.38. v.l.n.r.: Originalbild, Farbe zu Transparenz (blau) angewandt

(a) (b)

TIPP

Wenn die Einstellungen beim Zusammensetzen von denen des Zerlegens
verschieden sind, Sie also beispielsweise ein Bild nach RGB zerlegen und
dann die RGB Farbkanäle als Lab Kanäle wieder zusammensetzen lassen
sich sehr interessante Farbeffekte erzielen. Probieren Sie es einmal aus.

10.3.15. Zerlegen

10.3.15.1. Wirkungsweise

Das Filter separiert ein die Farbkanäle eines Bildes in einzelne Ebenen. So können Sie sehr einfach drei
Ebenen erzeugen, von denen eine den Rotkanal, eine den Grünkanal und eine den Blaukanal enthält
(alternativ auch CMYK, HSV, Lab und andere). Diese Zerlegung kann über das Filter Zusammensetzten
umgekehrt werden.

10.3.15.2. Filteraufruf

Dieses Filter lässt sich über das Menü Filter → Farben → Zerlegen im Bildfenster aufrufen.
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Abbildung 10.39. Eigenschaften für das Filter ”Farbe zu Transparenz“

Abbildung 10.40. v.l.n.r.: Komponentenbild (RGB zerlegt), Zusammengesetztes Originalbild

(a) (b)

10.3.15.3. Eigenschaften

In Ebenen Zerlegen Wenn diese Eigenschaft aktiviert ist, wird ein neues Bild erzeugt, in dem jede Ebe-
ne einen Farbkanal repräsentiert. Ist diese Eigenschaft nicht aktiviert, wird stattdessen für jeden
Farbkanal ein neues Bild erzeugt, welches automatisch nach dem entsprechend dem Kanal aus
dem es erzeugt wurde benannt wird.

Die folgenden Eigenschaften werden für den Fall beschrieben, dass In Ebenen zerlegen aktiviert
ist.

RGB Kanäle extrahieren Wenn die Einstellung RGB ausgewählt ist, wird ein Graustufenbild erzeugt,
welches für jeden der drei Kanäle Rot, Grün und Blau eine Ebene enthält und aus zwei Kanälen
(Grau und Transparenz) besteht.

Diese Funktion ist interessant, wenn Sie das Werkzeug Schwellwert benutzen. Sie können ausser-
dem Funktionen wie Ausschneiden, Einfügen verwenden, oder Auswahlen in einem einzelnen
RGB Kanal vornehmen. Sie können eine extrahierten Farbkanal auch speichern.

RGBA Kanäle extrahieren Wenn Sie diese Einstellung ausgewählt haben, wird ein ähnliches Bild er-
zeugt wir für RGB, zusätzlich wird aber eine Ebene erzeugt, die die Transparenzwerte des Aus-
gangsbildes enthält. Vollständig transparente Pixel werden dabei schwarz, komplett deckende Pi-
xel werden weiss.
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Abbildung 10.41. Eigenschaften für das Filter ”Zusammensetzen“

Abbildung 10.42. v.l.n.r.: Originalbild, Zerlegen (RGB) angewandt

(a) (b)

HSV Kanäle extrahieren In dieser Einstellung wird das Bild in drei Graustufenebenen zerlegt, eine für
den Farbton, eine für die Sättigung und eine für die Helligkeit. Dies entspricht den Farbkanälen
des Farbmodells HSV

Auch wenn die Ebene für den Farbton nur Graustufen enthält, sie repräsentiert trotzdem Farb-
werte. Schwarz und Weiss sind die Anfangs- und Endpunkte des Farbkreises. Sie repräsentieren
das Rot des Farbkreises. Die Graustufen dazwischen korrespondieren mit den Zwischentönen im
Farbkreis; dunkles Grau mit Orange, mittleres Grau mit Grün und helles Grau mit Magenta.

Für Farbsättigung und Helligkeit gilt, dass Schwarz jeweils die minimalen Sättigungs- und Hel-
ligkeitswerte repräsentiert und Weiss die maximalen.

CMY Kanäle extrahieren Mit dieser Einstellung wird das Filter das Originalbild in drei Ebenen mit
Graustufen zerlegen. Jeweils eine Ebene für Gelb (Yellow), eine für Magenta und eine für Cyan.

Dies ist hilfreich, wenn Bilder zu Druckprogrammen transferiert werden sollen, die mit dem CMY
Farbraum arbeiten.

CMYK Kanäle extrahieren Diese Einstellung ist CMY sehr ähnlich. Einziger Unterschied ist, dass eine
zusätzliche Ebene für schwarz angelegt wird.
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Abbildung 10.43. Eigenschaften für das Filter ”Zerlegen“

Dies ist hilfreich, wenn Bilder zu Druckprogrammen transferiert werden sollen, die mit dem
CMYK Farbraum arbeiten.

Alphakanal extrahieren Mit dieser Einstellung wird die im Alphakanal eines Bildes enthaltene Trans-
parenz in eine Ebene extrahiert. Dabei werden die vollständig transparenten Pixel schwarz, die
vollständig deckenden zu weiss und die Zwischenstufen auf Graustufen abgebildet.

Lab Kanäle extrahieren Diese Einstellung bewirkt, dass das Filter das Bild in drei Ebenen aus Grau-
stufen zerlegt. Eine Ebene ”L“ für die Leuchtkraft (Luminanz), eine Ebene ”a“, welche die Farbtöne
zwischen Grün und Rot enthält und eine Ebene ”b“, welche die Farbtöne zwischen Blau und Gelb
enthält.

Lab ist ein Farbmodell aus der Leuchtkraft-Farbe Familie. Dabei wird ein Kanal benutzt, um die
Leuchtkraft abzubilden und zwei weitere werden für die Farbtöne benutzt. Das Lab Modell wird
auch in Adobe Photoshop verwendet.

YCbCr Kanäle extrahieren In GIMP gibt es vier YCbCr Extraktionen mit verschiedenen Werten. Jede
erzeugt ein Bild mit drei Ebenen. Einer Ebene für die Leuchtkraft und je zwei Ebenen, um bläuliche
und rötliche Farben abzubilden.

Das YCbCr Farbmodell ist dem Modell YUV ähnlich und wird heute für digitales Video benutzt.
Ursprünglich war es das Farbmodell für analoges Video nach dem PAL Standard. Es basiert auf
der Tatsache, dass das menschliche Auge sehr empfindlich für die Leuchtkraft ist und erst in zwei-
ter Linie für Farben. Die Extraktion erfolgt auf Basis einer Transformationsmatrix. Die verschiede-
nen Typen entsprechen den verschiedenen Werten, die von der ITU (International Telecommuni-
cation Union) empfohlen werten.

10.3.16. Filterpaket

10.3.16.1. Wirkungsweise

Dieses Filter bietet Ihnen einen schnellen Zugriff auf mehrere Filter, mit denen Sie die Farben im Bild
verändern können. Es ist nützlich, um Farbstiche und Farbsättigung zu korrigieren.

10.3.16.2. Filteraufruf

Dieses Filter lässt sich über das Menü Filter → Farben → Filterpaket im Bildfenster aufrufen.
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Abbildung 10.44. v.l.n.r.: Originalbild, Filterpaket (mehr Blau, höhere Sättigung) angewandt

(a) (b)

10.3.16.3. Eigenschaften

Abbildung 10.45. Allgemeine Eigenschaften für das Filter ”Filterpaket“

Original und aktuelle Vorschau Diese zwei Bilder zeigen Ihnen das aktuelle Bild und eine Vorschau
auf das Bild nachdem das Filter mit den aktuellen Einstellungen angewendet wurde.

Ansicht Mit der Eigenschaft Ansicht können Sie einstellen, was in der Vorschau angezeigt werden soll.
Es stehen folgende Werte zur Auswahl:

• Ganzes Bild
• Nur Auswahl
• Auswahl mit Umgebung (die Auswahl im Bild)

Beeinflusster Bereich Mit der Eigenschaft Beeinflusster Bereich können Sie einstellen, auf welchen
Bildbereichen das Filter wirken soll. Sie haben folgende Werte zur Auswahl:
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• Schatten; die dunklen Bereiche des Bildes

• Mitten; die Bereiche mittlerer Helligkeit

• Glanzlichter; die Bereiche des Bildes mit einer sehr hohen Helligkeit

Selektiere Pixel nach Mit dieser Eigenschaft können Sie einstellen, welcher HSV Kanal zur Auswahl
der zu verändernden Pixel herangezogen wird. Sie können zwischen folgenden Einstellungen
wählen:

• Farbton

• Sättigung

• Wert (Helligkeit)

Gröbe Mit diesem Schieberegler können Sie im Bereich 0 bis 1 einstellen, wie stark die einzelnen Kor-
rekturschritte beim Klick auf ein Vorschlagsbild sein sollen.

Fenster Hier können Sie die einzelnen Filter des Paketes ein- und ausblenden. Folgende Filter stehen
zur Auswahl:

• Farbton; Hier können sie Korrekturen am Farbton des Bildes vornehmen. Dazu werden Ih-
nen verschiedene Vorschaubilder dargestellt. Durch Klicken auf eines der Vorschaubilder,
wird der Farbwert entsprechend erhöht. Um den Farbwert wieder verringern zu können, kli-
cken Sie auf das Vorschaubild auf der gegenüberliegenden Seite. Wie stark die Änderung bei
jedem Klick ausfällt, können Sie in der Eigenschaft Gröbe einstellen.

Abbildung 10.46. Farbtoneigenschaften für das Filter ”Filterpaket“

• FarbsättigungHier können Sie Korrekturen an der Farbsättigung vornehmen. Dazu klicken
Sie einfach auf dasjenige Vorschaubild, welches Ihren Vorstellungen am ähnlichsten ist.

• (Helligkeits-)Wert; Hier können Sie Korrekturen an der Farbhelligkeit vornehmen. Dazu kli-
cken Sie einfach auf dasjenige Vorschaubild, welches Ihren Vorstellungen am ähnlichsten ist.

• Erweitere; Diese Eigenschaften werden im nächsten Abschnitt separat beschrieben.
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Abbildung 10.47. Farbsättigungseigenschaften für das Filter ”Filterpaket“

Abbildung 10.48. Farbhelligkeitseigenschaften für das Filter ”Filterpaket“

Grösse der Vorschau Hier können Sie die Grösse der Vorschau einstellen. Standardwert ist 80
(Pixel).

Glätte der Kanten Diese Eigenschaft ist eng mit dem Übergang zwischen Tönen verbunden. Wenn
der Schieberegler auf 0 gesetzt ist, ist die Kurve eckig und der Übergang sehr abrupt. Es sind
kleine Schieberegler vorhanden, um den Übergang zwischen den Farbtönen einzustellen.

10.3.17. Heiss

10.3.17.1. Wirkungsweise

Dieses Filter identifiziert und verändert Pixel, welche problematisch sind, wenn das Bild auf einem PAL
oder NTSC Fernsehschirm angezeigt werden.

10.3.17.2. Filteraufruf

Dieses Filter lässt sich über das Menü Filter → Farben → Heiss im Bildfenster aufrufen.

Abbildung 10.49. Erweiterte Eigenschaften für das Filter ”Filterpaket“

Erweiterte Einstellungen
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10.3.17.3. Eigenschaften

Abbildung 10.50. Eigenschaften für das Filter ”Heiss“

Modus Diese Eigenschaft legt fest, für welchen TV Standard die Optimierung ausgeführt werden soll.
Zu Auswahl stehen NTSC und PAL.

Aktion Hier legen Sie fest, welche Aktion das Filter zur Optimierung vornehmen soll. Zur Auswahl
stehen:

• Helligkeit reduzieren

• Sättigung reduzieren

• Schwärzen; bei dieser Einstellung werden die kritischen Pixel schwarz gefärbt.

Neue Ebene erzeugen Wenn diese Eigenschaft aktiviert ist, werden Änderungen nicht im Original-
bild, sondern auf einer separaten, neu angelegten Ebene ausgeführt.

10.3.18. Max RGB

10.3.18.1. Wirkungsweise

Abbildung 10.51. v.l.n.r.: Originalbild, Max RGB angewandt

(a) (b)

Dieses Filter erhält für jedes Pixel des Bildes den Wert desjenigen Farbkanals, der die höchste Inten-
sität hat. Gleichzeitig werden die Werte der beiden anderen Kanäle gelöscht. Das Ergebnis ist ein Bild
in welchem jeder Pixel entweder nur einen roten, nur einen grünen oder nur einen blauen Farbanteil
besitzt.
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10.3.18.2. Filteraufruf

Dieses Filter lässt sich über das Menü Filter → Farben → Max RGB im Bildfenster aufrufen.

10.3.18.3. Eigenschaften

Abbildung 10.52. Eigenschaften für das Filter ”Max RGB“

Vorschau Die Vorschau zeigt das Bild, wie es nach der Ausführung des Filters mit den aktuellen Pa-
rametern aussehen würde. Über das Kontrollkästchen kann die Vorschau ein- und ausgeschaltet
werden.

Kanaleinstellung Die maximalen Kanäle behalten: Für jeden Pixel erhält das Filter die Intensität des
RGB Farbkanals, welcher den höchsten Intensitätswert hat und setzt die Werte der anderen beiden
Kanäle auf 0. Beispiel: 220, 158, 175 max –> 220, 0, 0. Wenn zwei Kanäle die gleiche Intensität
haben, bleiben beide erhalten. Beispiel: 210, 54, 210 max –> 210, 0, 210.

Die minimalen Kanäle behalten: für jeden Pixel erhält das Filter die Intensität des RGB Farbka-
nals, welcher den niedrigsten Intensitätswert hat und setzt die Werte der anderen beiden Kanäle
auf 0. Beispiel 220, 158, 175 min –> 0, 158, 0. Wenn zwei Kanäle den gleichen minimalen Wert
haben, bleiben beide Werte erhalten. Beispiel: 210, 54, 54 min –> 0, 54, 54.

Grauwerte werden nicht verändert, da bei Grauwerten die Intensität in allen drei Kanälen immer
gleich ist.

10.3.19. Semi-Flatten

10.3.19.1. Wirkungsweise

Das Filter Semi-Flatten hilft Ihnen, wenn Sie geglättete (Antialias), Bilder mit indizierten Farben und
einer Transparenz benötigen. Das Dateiformat GIF unterstützt indizierte Farben und komplette Trans-
parenz (Alphawerte von 0 oder 255), aber keine Halbtransparenz (Alphawerte zwischen 1 und 254).
Halbtransparente Pixel werden daher entweder komplett oder gar nicht transparent. Dies schadet dem
Antialias Effekt, der sehr wichtig ist, wenn Sie beispielsweises Logos in das Internet stellen wollen,
erheblich.

Bevor Sie das Filter anwenden, sollten Sie wissen, welche Hintergrundfarbe die Webseite haben wird,
auf der Sie das Bild verwenden möchten. Benutzen Sie die Farbpipette, um den genauen Farbwert zu
bestimmen. Stellen Sie diese Farbe dann als aktive Hintergrundfarbe ein.

Die Ausführung des Filters wird die aktive Hintergrundfarbe und die Farbe des Bildes proportional
entsprechend dem Transparenzwert des Pixels mischen und das Antialiasing wieder herstellen.
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10.3.19.2. Filteraufruf

Dieses Filter lässt sich über das Menü Filter → Farben → Semi-Flatten im Bildfenster aufrufen.

10.3.20. Palette glätten

10.3.20.1. Wirkungsweise

Abbildung 10.53. v.l.n.r.: Originalbild, Palette glätten angewandt

(a) (b)

Das Filter erzeugt eine gestreifte Palette der Farben der aktiven Ebene oder einer Auswahl. Der
hauptsächliche Zweck dieses Filters ist es, Farbkarten für das Flammen Filter zu erzeugen.

10.3.20.2. Filteraufruf

Dieses Filter lässt sich über das Menü Filter → Farben → Palette glätten im Bildfenster aufrufen.

10.3.20.3. Eigenschaften

Abbildung 10.54. Eigenschaften für das Filter ”Palette glätten“

Breite; Höhe Mit diesen Eigenschaften legen Sie die Breite und Höhe des Ausgabebildes fest. Die Ma-
ße sind abhängig voneinander, werden also proportional zueinander konstant gehalten, solan-
ge das Kettensymbol geschlossen ist. Zusätzlich können Sie die Maßeinheit über ein Klappmenü
auswählen.

Suchtiefe Eine Erhöhung der Suchtiefe, die im Bereich von 1 bis 1024 einstellbar ist, führt zu einer
grösseren Anzahl von Farbschattierungen in der Palette.
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10.3.21. Wert invertieren

10.3.21.1. Wirkungsweise

Abbildung 10.55. v.l.n.r.: Originalbild, Wert invertieren angewandt

(a) (b)

Dieses Filter kehrt die Helligkeitswerte der Pixel der aktiven Ebene oder einer Auswahl um. Farb-
wert und Sättigung werden dabei nicht verändert, gelegentlich auftretende minimale Farbverschie-
bungen können jedoch durch Rundungsfehler verursacht werden. Möchten Sie auch die Farb- und
Sättigungswerte umkehren, können Sie Ebene → Farben → Invertieren benutzen.

10.3.21.2. Filteraufruf

Dieses Filter lässt sich über das Menü Filter → Farben → Wert invertieren im Bildfenster aufrufen.

10.4. Rauschfilter

10.4.1. Einführung in die Rauschfilter

Die Rauschfilter in GIMP können Sie anwenden, um Rauschen zu Bildern oder Auswahlen hinzuzufügen.
Um ein unerwünschtes Rauschen oder kleine Bildfehler zu beseitigen seien Ihnen der Selektive Gauß-
sche Weichzeichner und der Filter Flecken entfernen empfohlen.

10.4.2. Verwirbeln

10.4.2.1. Wirkungsweise

Das Filter verändert Pixel in eine Zufallsfarbe, so dass echtes Weisses Rauschen produziert wird. Alle
Kanäle (inklusive eines gegebenenfalls vorhandenen Alphakanals) werden in die Zufallsveränderungen
einbezogen. Alle möglichen Werte werden mit der gleichen Wahrscheinlichkeit verwendet. Die Origi-
nalwerte spielen dabei keine Rolle. Ob alle, oder nur ein Teil der Pixel des Bildes verändert werden,
können Sie in den Eigenschaften des Filters einstellen.

10.4.2.2. Filteraufruf

Dieses Filter lässt sich über das Menü Filter → Rauschen → Verwirbeln im Bildfenster aufrufen.

10.4.2.3. Eigenschaften

Zufallssaat Mit dieser Eigenschaft können Sie den Zufallsgenerator des Filters steuern. Mit der glei-
chen Zufallssaat sind die Ergebnisse bei mehreren Anwendungen des Filters reproduzierbar. Der
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Abbildung 10.56. v.l.n.r.: Originalbild, Verwirbeln angewandt

(a) (b)

Abbildung 10.57. Eigenschaften für das Filter ”Verwirbeln“

Wert kann von Hand eingetragen, oder durch einen Klick auf die Schaltfläche Neu Würfelnguilabel>
per Zufall bestimmt werden.

Wenn das Kontrollkästchen Zufällig aktiviert ist, wird die Zufallssaat automatisch bei jeder Ausführung
des Filters neu bestimmt.

Zufallsanteil (%) Mit dieser Eigenschaft können Sie einstellen, wieviel Prozent der Pixel zufallsgesteu-
ert verändert werden. Die Einstellung kann über den Schieberegler vorgenommen, oder in das
Eingabefeld eingetragen werden.

Wiederholen Diese Eigenschaft legt fest, wie oft der Filter auf das Bild aufgetragen wird.

10.4.3. Streue RGB

10.4.3.1. Filterwirkung

Dieses Filter fügt zu einer Ebene oder einer Auswahl normalverteiltes Rauschen hinzu. Das RGB Farb-
modell wird benutzt, um das Rauschen zu erzeugen. Dabei wird ein Rauschanteil zu den Rot- Blau- und
Grünanteilen jedes Pixels hinzugefügt. Normalverteilt bedeutet, dass die meisten Pixel mit einem ge-
ringen und nur wenige Pixel mit einem grossen Rauschanteil versehen werden. Wenn Sie dieses Filter
auf eine einfarbig graue Fläche anwenden würden, könnten Sie im Histogramm eine klassische glo-
ckenförmige Gaußkurve sehen.

Das Ergebnis dieses Filters ist ein sehr natürlich wirkendes Rauschen.

10.4.3.2. Filteraufruf

Dieses Filter lässt sich über das Menü Filter → Rauschen → Streue RGB im Bildfenster aufrufen.
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Abbildung 10.58. v.l.n.r.: Originalbild, Streue RGB angewandt

(a) (b)

10.4.3.3. Eigenschaften

Abbildung 10.59. Eigenschaften für das Filter ”Streue RGB“

Vorschau Die Vorschau zeigt Ihnen einen Ausschnitt des Bildes, so wie das Bild aussehen würde, wenn
Sie den Filter mit den aktuellen Einstellungen ausführen würden.

Korreliertes Rauschen Wenn diese Eigenschaft aktiviert ist, haben werden die drei Schieberegler für
Rot, Grün und Blau alle den gleichen Wert haben. Das gleich relative Rauschen wird damit auf
alle Kanäle jedes Pixels angewendet. Daher ändert sich der Farbton der Pixel nicht sehr.

Unabhängige RGB Kanäle Wenn diese Eigenschaft aktiviert ist, können die Schieberegler unabhängig
voneinander bewegt werden.

Rot, Blau, Grün, Alpha Mit diesen Schiebereglern und den zugeordneten Eingabefeldern können Sie
das Rauschniveau im Bereich 0,00 bis 1,00 einstellen. Der Alphakanal wird nur angezeigt, wenn
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das Bild über einen solchen verfügt. Falls dasd Bild ein Graustufenbild ist, wird an Stelle der RGB
Felder Grau angezeigt.

Der Wert, der durch die Schieberegler eingestellt wird ist die Standardabweichung von der Nor-
malverteilung des aufgebrachten Rauschens. Die benutzte Standardabweichung ist die Hälfte des
hier eingetragenen Wertes. Dabei ist 1 der Abstand zwischen dem höchsten und dem niedrigsten
möglichen Wert in einem Kanal.

TIPP

Falls sich der letzte Abschnitt für Sie nach einer Vorlesung in Statistik
anhört, so liegen Sie nicht ganz falsch. Sollten Sie dabei kein Wort ver-
standen haben, so macht das gar nichts. Betrachten Sie die Einstellung
einfach als Menge des durch das Filter aufgetragenen Rauschens und ex-
perimentieren Sie ein bisschen mit den Werten.

10.4.4. Auswählen

10.4.4.1. Wirkungsweise

Abbildung 10.60. v.l.n.r.: Originalbild, Auswählen angewandt

(a) (b)

Dieses Filter ersetzt Pixel durch einen zufällig ausgewählten direkten Nachbarpixel. Ob alle, oder nur
ein bestimmter Prozentsatz der Pixel einer Ebene oder Auswahl verändert werden können Sie in den
Eigenschaften des Filters einstellten.

10.4.4.2. Filteraufruf

Dieses Filter lässt sich über das Menü Filter → Rauschen → Auswählen im Bildfenster aufrufen.

10.4.4.3. Eigenschaften

Zufallssaat Mit dieser Eigenschaft können Sie den Zufallsgenerator des Filters steuern. Mit der glei-
chen Zufallssaat sind die Ergebnisse bei mehreren Anwendungen des Filters reproduzierbar. Der
Wert kann von Hand eingetragen, oder durch einen Klick auf die Schaltfläche Neu Würfelnguilabel>
per Zufall bestimmt werden.

Wenn das Kontrollkästchen Zufällig aktiviert ist, wird die Zufallssaat automatisch bei jeder Ausführung
des Filters neu bestimmt.
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Abbildung 10.61. Eigenschaften für das Filter ”Auswählen“

Zufallsanteil (%) Mit dieser Eigenschaft können Sie einstellen, wieviel Prozent der Pixel zufallsgesteu-
ert verändert werden. Die Einstellung kann über den Schieberegler vorgenommen, oder in das
Eingabefeld eingetragen werden.

Wiederholen Diese Eigenschaft legt fest, wie oft der Filter auf das Bild aufgetragen wird. Durch eine
mehrfache Ausführung können Pixel über grössere Entfernungen übertragen werden.

10.4.5. Streue HSV

10.4.5.1. Wirkungsweise

Abbildung 10.62. v.l.n.r.: Originalbild, Streue HSV angewandt

(a) (b)

Das Filter erzeugt ein Rauschen in der aktiven Ebene oder einer Auswahl unter Verwendung der
Pixeleigenschaften Farbton, Sättigung und Wert (Leuchtkraft).

10.4.5.2. Filteraufruf

Dieses Filter lässt sich über das Menü Filter → Rauschen → Streue HSV im Bildfenster aufrufen.

10.4.5.3. Eigenschaften

Vorschau In der Vorschau wird ein Ausschnitt des Bildes so dargestellt, als wäre das Filter mit den
aktuellen Einstellungen auf das Bild angewandt worden.

Festhalten Mit dieser Eigenschaft können Sie über einen Schieberegler im Bereich von 1 bis 8 einstellen,
wie start die Farbe eines veränderten Pixels von der ursprünglichen abweichen darf. Ein niedriger
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Abbildung 10.63. Eigenschaften für das Filter ”Streue HSV“

Wert führt zu grossen farblichen Abweichungen, während ein grosser Wert zu einer schwachen
farblichen Variation führt.

Farbton Mit diesem Schieberegler können Sie den Farbton der Pixel eines Zufallsmusters ändern. Ein
hoher Wert vergrössert den verfügbaren Farbbereich im HSV Farbkreis beginnend mit der Origi-
nalfarbe des Pixels.

Sättigung Mit Hilfe dieses Schiebereglers können Sie einstellen, wie stark die Farbsättigung der ver-
streuten Pixel sein soll.

Wert Mit diesem Schieberegler können Sie die Helligkeit der verstreuten Pixel einstellen.

10.4.6. Schmelzen

10.4.6.1. Wirkungsweise

Abbildung 10.64. v.l.n.r.: Originalbild, Schmelzen angewandt

(a) (b)

Dieses Filter produziert einen Effekt, der die Farben scheinbar nach unten verschmelzen lässt. Wenn
ein Pixel durch das Filter verändert wird, wird es mit einer Wahrscheinlichkeit von 80% durch den Pixel
direkt darüber ersetzt. Andernfalls erhält es die Farbe eines der beiden schräg oberhalb befindlichen Pi-
xel. Es werden durch das Filter entweder alle, oder ein bestimmter Prozentsatz an Pixeln des Bildes oder
der aktuellen Auswahl verändert. Diesen Wert können Sie in den Eigenschaften des Filters einstellen.

10.4.6.2. Filteraufruf

Dieses Filter lässt sich über das Menü Filter → Rauschen → Schmelzen im Bildfenster aufrufen.
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10.4.6.3. Eigenschaften

Abbildung 10.65. Eigenschaften für das Filter ”Schmelzen“

Zufallssaat Mit dieser Eigenschaft können Sie den Zufallsgenerator des Filters steuern. Mit der glei-
chen Zufallssaat sind die Ergebnisse bei mehreren Anwendungen des Filters reproduzierbar. Der
Wert kann von Hand eingetragen, oder durch einen Klick auf die Schaltfläche Neu Würfelnguilabel>
per Zufall bestimmt werden.

Wenn das Kontrollkästchen Zufällig aktiviert ist, wird die Zufallssaat automatisch bei jeder Ausführung
des Filters neu bestimmt.

Zufallsanteil (%) Mit dieser Eigenschaft können Sie einstellen, wieviel Prozent der Pixel zufallsgesteu-
ert verändert werden. Die Einstellung kann über den Schieberegler vorgenommen, oder in das
Eingabefeld eingetragen werden.

Wiederholen Diese Eigenschaft legt fest, wie oft der Filter auf das Bild aufgetragen wird. Ein höherer
Wert führt zu einem stärkeren Effekt, da die Farben über eine grössere Distanz verschmolzen wer-
den.

10.4.7. Verstreuen

10.4.7.1. Wirkungsweise

Abbildung 10.66. v.l.n.r.: Originalbild, Verstreuen angewandt

(a) (b)

Dieses Filter vertauscht einen Pixel der aktiven Ebene oder einer Auswahl mit einem anderen aus
einer bestimmten Umgebung. Dieses Filter wirkt nicht auf einfarbigen Flächen. Es werden keine neu-
en Farben in das Bild eingebracht, da wie schon beschrieben, lediglich vorhandenen Pixel vertauscht
werden.

343



10.5. KANTENERKENNUNGSFILTER KAPITEL 10. FILTER

10.4.7.2. Filteraufruf

Dieses Filter lässt sich über das Menü Filter → Rauschen → Verstreuen im Bildfenster aufrufen.

10.4.7.3. Eigenschaften

Abbildung 10.67. Eigenschaften für das Filter ”Verstreuen“

Vorschau In der Vorschau wird ein Ausschnitt des Bildes so dargestellt, als wäre das Filter mit den
aktuellen Einstellungen auf das Bild angewandt worden.

Verteilungsmenge Mit dieser Eigenschaft können Sie einstellen über welche Distanz die Pixel Hori-
zontal und Vertical verstreut werden. Die Werte sind, solange das Kettensymbol geschlossen ist,
immer proportional fix.

10.5. Kantenerkennungsfilter

10.5.1. Einführung

Kantenerkennungsfilter sind in der Lage Kante zwischen verschiedenen Farben und die Umrisse von
Objekten aus Bildern zu extrahieren.

Diese Filter können benutzt werden, um Auswahlen zu erstellen und verschiedene künstlerische Ef-
fekte zu erreichen.
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Die meisten der Filter zur Kantenerkennung basieren auf der Analyse von Farbveränderungen und
erzeugen dicke Kantenlinien. Beachten Sie den ersten Teil der Abbildung, welche die Veränderungen
der Farbintensität symbolisch darstellt. Auf der linken Seite befinden sich leichte Veränderungen, wel-
che keine Kanten darstellen. Auf der linken Seite sehen Sie eine Kante, dargestellt als Änderung der
Farbintensität. Die zweite Abbildung zeigt die Stärke der Veränderung der Farbintensität angezeigt.
Dies ist mathematisch betrachtet die erste Ableitung des Graphen im ersten Teil der Abbildung. Ein
Algorithmus zur Kantenerkennung muss nun entscheiden, ab welcher Höhe der Ableitung eine Kante
als erkannt gilt. Dies entspricht im Wesentlichen der Arbeitsweise des Sobel-Filters.

Der Laplace-Operator verwendet zur Kantenerkennung die zweite Ableitung, welche im dritten Teil
der Abbildung zu sehen ist. Die daraus entstehenden Kanten sind wesentlich schmaler, meist nur einen
Pixel breit. Bei kleineren Farbabweichungen können hier jedoch falsch erkannte Kanten angezeigt wer-
den.

Gegen diese falsch erkannten Kanten hilft eine leichte Weichzeichnung des Bildes vor der Anwen-
dung des Filters.

10.5.2. Differenz der Mittelwerte

10.5.2.1. Wirkungsweise

Abbildung 10.68. v.l.n.r.: Originalbild, Differenz der Mittelwerte angewandt

(a) (b)

Dieses Filter extrahiert Kanten aus Bildern indem der Gaußsche Weichzeichnungsfilter mit zwei ver-
schiedenen Stärken auf das Bild angewendet wird. Aus den beiden Ergebnisbildern wird die Differenz
berechnet. Dieser Algorithmus wird in der Forschungsrichtung Künstliches Sehen sehr oft verwendet,
da die Berechnung des Gaußschen Weichzeichners sehr effizient ist. Die beiden wichtigsten Eigenschaf-
ten des Filters sind die beiden Radien, mit denen die Anwendung der Weichzeichner erfolgt. Bei der
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Einstellung der Werte kann es hilfreich sein zu wissen, dass eine Erhöhung des kleineren Radius ty-
pischerweise zu stärkeren Kanten führt, und eine Verkleinerung des grösseren Radius tendenziell die
Schwelle etwas im Bild als Kante zu erkennen erhöht. In den meisten Fällen werden Sie gute Ergebnisse
erreichen, wenn der Radius 2 kleiner ist als der Radius 1. Manchmal jedoch, insbesondere bei Bildern
mit dunklem Hintergrund lohnt es sich, es andersherum zu probieren.

10.5.2.2. Filteraufruf

Dieses Filter lässt sich über das Menü Filter → Kanten finden → Differenz der Mittelwerte im Bild-
fenster aufrufen.

10.5.2.3. Eigenschaften

Abbildung 10.69. Eigenschaften für das Filter ”Differenz der Mittelwerte“

Parameter abgleichen Radius 1 und Radius 2 sind die beiden Parameter, mit denen der Gaußsche
Weichzeichner ausgeführt wird. Die einzige Bedingung an die beiden Werte ist, dass sie unter-
schiedlich sein müssen, da ansonsten keine Kanten gefunden werden können. In den meisten
Fällen führt es zu besseren Ergebnissen, wenn Radius 2 etwas kleiner ist als Radius 1.

Normalisieren Wenn diese Eigenschaft aktiviert ist, wird das Ergebnis den maximal möglichen Kon-
trastumfang erhalten. Das bedeutet, dass die Kanten im Ergebnisbild soweit verstärkt werden, bis
der volle Helligkeitsumfang des Bildes ausgeschöpft ist.

Invertieren Diese Eigenschaft kehrt die Farbe des Ergebnisses um, so dass dunkle Kanten auf einem
weissen Hintergrund angezeigt werden. Das eigentliche Ergebnis des Filters wäre umgekehrt, also
helle Kanten auf einem schwarzen Hintergrund.

10.5.3. Kanten

10.5.3.1. Wirkungsweise

Dieses Filter stellt Ihnen verschiedene Kantenerkennungsalgorithmen zur Verfügung. Diese sind mit
ihren Eigenschaften in den nächsten Abschnitten detailliert erklärt.
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Abbildung 10.70. Beispiele für Kantenerkennungsfilter

(a) Originalbild (b) Kantenerkennung (Sobel)

Abbildung 10.71. Beispiele für Kantenerkennungsfilter

(a) Kantenerkennung (Prewitt) (b) Kantenerkennung (Verlauf)

10.5.3.2. Filteraufruf

Dieses Filter lässt sich über das Menü Filter → Kanten finden → Kanten im Bildfenster aufrufen.

10.5.3.3. Eigenschaften

Algorithmus Das Filter erlaubt Ihnen die Verwendung verschiedener Methoden der Kantenerkennung:

• Sobel: Im Kontext dieses Filters wird der Sobeloperator nur mit den Vorgabe-Einstellungen
angeboten. Er ist aber als separates Filter zusätzlich verfügbar.

• Prewitt: Das Ergebnis unterscheidet sich nicht wesentlich von Sobel.
• Verlauf: Die Kanten werden dünner, mit weniger Kontrast und unschärfer dargestellt als bei

Sobel.
• Roberts: Kein grosser Unterschied zu Sobel.
• Differentiell: Die Kanten sind weniger hell als bei Sobel.
• Laplace: Im Kontext dieses Filters wird der Laplaceoperator nur mit den Vorgabe-Einstellungen

angeboten. Er ist aber als separates Filter zusätzlich verfügbar.

Menge Mit dieser Eigenschaft können Sie die Stärke des Filters einstellen. Ein niedriger Wert führt zu
einem Bild in dem nur wenige Kanten erkannt werden, ein hoher zu einem Ergebnis, in dem aus
kleinste Kanten dargestellt sind.
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Abbildung 10.72. Beispiele für Kantenerkennungsfilter

(a) Kantenerkennung (Roberts) (b) Kantenerkennung (Differentiell)

Abbildung 10.73. Beispiele für Kantenerkennungsfilter. Kantenerkennung (Laplace)

Umfalten, Verwischen, Schwarz Diese Eigenschaft gibt an, wie die Bildkanten behandelt werden. Das
ist nützlich, wenn Sie Bilder aneinander setzen wollen.

10.5.4. Laplace

10.5.4.1. Wirkungsweise

Dieser Filter extrahiert die Kanten in einem Bild durch Verwendung des Laplace Algorithmus. Dabei
werden die Kanten als dünne Linien abgebildet.

Das Laplacefilter basiert auf dem Ableitungsoperator der zweiten Ordnung. Damit ist es isotrop (rich-
tungsunabhängig) und entfernt nicht nur einfarbige Flächen sehr effektiv, sondern auch lineare Farb-
verläufe.

10.5.4.2. Filteraufruf

Dieses Filter lässt sich über das Menü Filter → Kanten finden → Laplace im Bildfenster aufrufen.

10.5.5. Neon

10.5.5.1. Wirkungsweise

Dieses Filter extrahiert Kanten in einem Bild.
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Abbildung 10.74. Eigenschaften für das Filter ”Kanten“

Abbildung 10.75. v.l.n.r.: Originalbild, Laplace angewandt

(a) (b)

10.5.5.2. Filteraufruf

Dieses Filter lässt sich über das Menü Filter → Kanten finden → Neon im Bildfenster aufrufen.

10.5.5.3. Eigenschaften

Radius Mit dieser Eigenschaft können Sie einstellen, in welchem Radius das Filter arbeitet.

Stärke Mit diesem Schieberegler können Sie einstellen, wie stark das Filter wirkt.

10.5.6. Sobel

10.5.6.1. Wirkungsweise

Dieses Filter extrahiert Kanten in einem Bild durch Verwendung des Sobel-Operators. Eine detailliertere
Beschreibung des Operators finden Sie im Internet in der Wikipedia <http://de.wikipedia.org/
wiki/Sobel-Operator>.
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Abbildung 10.76. v.l.n.r.: Originalbild, Neon angewandt

(a) (b)

Abbildung 10.77. Eigenschaften für das Filter ”Neon“

10.5.6.2. Filteraufruf

Dieses Filter lässt sich über das Menü Filter → Kanten finden → Sobel im Bildfenster aufrufen.

10.5.6.3. Eigenschaften

Sobel Horizontal / Vertikal Mit diesen Eigenschaften legen Sie fest, in welche Richtungen der der Sobel-
Operator ausgeführt wird. Da dieser auf der Ableitung der ersten Ordnung basiert ist er grundsätzlich
anisotrop (richtungsabhängig). Mit diesen Einstellungen können Sie bestimmen, ob das Filter ho-
rizontale und/oder vertikale Kanten finden soll.

Vorzeichen des Ergebnisses beibehalten Mit dieser Einstellung können Sie festlegen wie das Filter
wirkt, wenn Sie nur eine Richtung zur Anwendung ausgewählt haben. Ist die Eigenschaft akti-
viert, wird ein graues, reliefartiges Bild das Ergebnis sein.
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Abbildung 10.78. v.l.n.r.: Originalbild, Sobel angewandt

(a) (b)

Abbildung 10.79. Eigenschaften für das Filter ”Sobel“

10.6. Verbessern

10.6.1. Einführung

Filter der Kategorie ”Verbessern“ werden benutzt, um kleine Bildfehler zu bereinigen. Derartige Störungen
können von Staubkörnchen über Bildrauschen bis hin zu streifigen Bildern und unzureichender Schärfe
reichen.

10.6.2. Entflackern

10.6.2.1. Wirkungsweise

Bilder, die aus Videomaterial gewonnen werden enthalten, besonders wenn sie aus einer Szene mit
schnellen Bewegungen sind, oftmals horizontale Streifen und unscharfe Objektkanten. Dies resultiert
aus der Art wie viele Kameras arbeiten. Diese erfassen oftmals nicht 25 Vollbilder pro Sekunde, sondern
50 Bilder im sogenannten Halbbildverfahren. Dabei wird zunächst ein Bild mir der halben vertikalen
Auflösung erfasst und gleich darauf ein zweites Bild ebenfalls mit halber vertikaler Auflösung. Diese
beiden Halbbilder werden dann zu einem Vollbild zusammengesetzt. Wenn es aber in der Zeit zwischen
den beiden aufgenommenen Halbbildern Bewegungen im Bild gab, so werden diese Stellen unscharf
und fehlerhaft dargestellt. Normalerweise ist das menschliche Auge zu träge, um in einem Video diese
Fehler wahrzunehmen. Wird aber ein einzelnes Bild extrahiert, ist der Effekt deutlich zu erkennen.
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Abbildung 10.80. v.l.n.r.: Originalbild (allerdings ohne Interlace Effekt), Entflackern angewandt

(a) (b)

Das Filter extrahiert eines der beiden Halbbilder wieder aus dem zusammengesetzten Vollbild und
ersetzt die fehlende vertikale Auflösung durch eine Zeilenverdopplung. Dabei werden die fehlenden
Bildstellen interpoliert. Dies führt zu einer etwas unscharfen Darstellung, die aber durch weitere Filter
verbessert werden kann.

10.6.2.2. Filteraufruf

Dieses Filter lässt sich über das Menü Filter → Verbessern → Entflackern im Bildfenster aufrufen.

10.6.2.3. Eigenschaften

Abbildung 10.81. Eigenschaften für das Filter ”Entflackern“

Vorschau In der Vorschau wird ein Ausschnitt des Bildes so dargestellt, als wäre das Filter mit den
aktuellen Einstellungen auf das Bild angewandt worden.

Erhalte gerade / ungerade Zeilen Hier können Sie auswählen welches der beiden Halbbilder erhalten
bleiben soll. Probieren Sie beide aus.
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10.6.3. Flecken entfernen

10.6.3.1. Wirkungsweise

Abbildung 10.82. v.l.n.r.: Originalbild, Flecken entfernen angewandt

(a) (b)

Dieses Filter können Sie benutzen, um kleine Schadstellen im Bild wie Staub oder Kratzer auf einem
gescannten Bild zu entfernen. Es hilft auch gegen Moiré Effekte wie sie beim Scannen gedruckter Vorla-
gen auftreten können. Es sei Ihnen empfohlen die betroffenen Stellen auszuwählen, bevor Sie das Filter
anwenden.

10.6.3.2. Filteraufruf

Dieses Filter lässt sich über das Menü Filter→ Verbessern→ Flecken entfernen im Bildfenster aufru-
fen.

10.6.3.3. Eigenschaften

Abbildung 10.83. Eigenschaften für das Filter ”Flecken entfernen“
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Vorschau In der Vorschau wird ein Ausschnitt des Bildes so dargestellt, als wäre das Filter mit den
aktuellen Einstellungen auf das Bild angewandt worden.

Median

• Anpassend: Wenn diese Eigenschaft aktiviert ist, wird der Radius an den Inhalt des Bildes
oder der Auswahl unter Verwendung eines Histogramms angepasst. Der Schieberegler für
den Radius wird dann deaktiviert. Diese Einstellung führt in der Regel zu besseren Ergeb-
nissen, als das Einstellen des Radius von Hand.

• Rekursiv: Das Einschalten dieser Eigenschaft bewirkt eine mehrfache Ausführung des Fil-
ters, was dessen Wirkung verstärkt.

Radius Mit dieser Eigenschaft können Sie über einen Schieberegler die Grösse des Bereiches einstellen,
den das Filter zur Berechnung verwendet. Die Einstellung kann im Wertebereich von 1 (3x3 Pixel)
bis 20 (41x41 Pixel) liegen. Bitte beachten Sie, dass die Werte für diese Eigenschaft automatisch
vergeben werden, wenn die Eigenschaft Anpassend aktiviert ist.

Schwellwert Schwarz / Weiss Mit diesen beiden Eigenschaften können Sie einstellen, dass Pixel die
entweder nah an Schwarz, oder nah an Weiss sind, entfernt werden. Die Einstellung erfolgt über
die beiden Schieberegler Schwellwert Schwarz, der gewöhnlich Werte aus dem Bereich 0 bis 20
hat, und dem Schieberegler Schwellwert Weiss, der festlegt ab welcher Helligkeit ein Pixel ent-
fernt werden soll und gewöhnlich Werte zwischen 240 und 255 annimmt.

10.6.4. Streifen entfernen

10.6.4.1. Wirkungsweise

Abbildung 10.84. v.l.n.r.: Originalbild, Streifen entfernen angewandt

(a) (b)

Dieses Filter können Sie anwenden, um vertikale Streifen, wie sie durch schlechte Scanner verursacht
werden, zu entfernen. Es arbeitet durch hinzufügen eines Musters, welches mit die Bildfehler aufhebt,
sofern die Einstellungen korrekt vorgenommen sind. Dieses ”Negativmuster“ wird auf der Basis von
im Bild vorhandenen vertikalen Bildelementen berechnet. Wundern Sie sich daher nicht, wenn die Vor-
schau für ein Bild welches keine vertikalen Streifen enthält plötzlich Streifen hinzufügt (siehe Beispiel-
bild).

Wenn nach der ersten Anwendung des Filters noch einzelne Streifen im Bild nicht entfernt wurden,
wählen Sie den betroffenen Bereich aus und wenden Sie das Filter auf diese Auswahl erneut an. Achten
Sie darauf eine rechteckige Auswahl zu verwenden, bei anderen Auswahltypen kann sich das Ergebnis
erheblich verschlechtern.
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10.6.4.2. Filteraufruf

Dieses Filter lässt sich über das Menü Filter→ Verbessern→ Streifen entfernen im Bildfenster aufru-
fen.

10.6.4.3. Eigenschaften

Abbildung 10.85. Eigenschaften für das Filter ”Streifen entfernen“

Vorschau In der Vorschau wird ein Ausschnitt des Bildes so dargestellt, als wäre das Filter mit den
aktuellen Einstellungen auf das Bild angewandt worden.

Breite Mit dieser Eigenschaft können Sie über einen Schieberegler die Stärke des Filters im Bereich von
2 bis 100 einstellen. Ein Wert grösser als 60 ist dabei selten sinnvoll und kann unschöne Artefakte
im Bild erzeugen.

Create histogram: This ”histogramı̈s a black and white image showing the interference pattern
more legibly.

Histogramm erstellen Wenn diese Eigenschaft aktiviert ist, wird das Filter ein Graustufenbild erzeu-
gen, in dem das Muster deutlich erkennbar ist.

10.6.5. NL Filter

10.6.5.1. Wirkungsweise

NL steht für ”Nich Linear“. Abgeleitet von dem UNIX Kommando pnmnlfilt, beinhaltet dieses Fil-
ter Funktionen zur Weichzeichnung, Fleckentfernung und Schärfeerhöhung. Dieses Filter kann nur auf
komplette Bilder, nicht auf Auswahlen angewendet werden.

Dieses Filter ist so eine Art ”Schweizer Messer“ der Bildbearbeitung. Es hat drei verschiedene Wir-
kungsmodi. In jedem Modus werden alle Pixel des Bildes untersucht und in Abhängigkeit von ihren
Nachbarpixeln verarbeitet. Statt dabei wie andere Filter eine 3x3 Pixel Matrix zu verwenden, arbeitet
das NL Filter mit einer hexagonalen Umgebung, deren Grösse über die Eigenschaft Radius eingestellt
werden kann.

10.6.5.2. Filteraufruf

Dieses Filter lässt sich über das Menü Filter → Verbessern → NL Filter im Bildfenster aufrufen.
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Abbildung 10.86. v.l.n.r.: Originalbild, NL Filter angewandt

(a) (b)

10.6.5.3. Eigenschaften

Abbildung 10.87. Eigenschaften für das Filter ”NL Filter“

Vorschau In der Vorschau wird ein Ausschnitt des Bildes so dargestellt, als wäre das Filter mit den
aktuellen Einstellungen auf das Bild angewandt worden.

Alpha, Radius • Alpha: Die Bedeutung dieser Eigenschaft ist vom eingestellten Filtermodus abhängig.

• Radius: Mit dieser Eigenschaft können Sie die Stärke der Filterwirkung im Bereich von 0,33
bis 1,00 einstellen.

10.6.5.4. Filter

Das Filter kann je nach eingestelltem Modus verschieden wirken. Davon abhängig ist auch die Bedeu-
tung der Eigenschaft Alpha.
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Alphabasierter Mittelwert In diesem Modus wirkt das Filter als Weichzeichner. Jedes Pixel wird durch
den Mittelwert der es umgebenden 7 hexagonalen Pixel ersetzt. Dabei werden die Werte der Pixel
sortiert und die Alpha Werte von jedem Ende nicht in die Berechnung einbezogen. Dies bedeutet,
dass bei einer Einstellung von alpha = 0.0, das Filter das selbe Ergebnis wie ein normales Mittel-
wertfilter ergibt. Empfehlenswert sind in diesem Fall Radius zwischen 0,55 und 1,00.

Optimale Mittelung In diesem Modus führt der Filter eine Weichzeichnung auf dem Bild aus. Für je-
des Pixel wird die Abweichung der umgebenden 7 hexagonalen Pixel berechnet. Die Stärke der
Weichzeichnung ist umgekehrt proportional zu dieser Abweichung. Die Idee dahinter ist, dass
wenn die Abweichung gering ist, diese durch Rauschen verursacht wird. Ist die Abweichung aber
grösser, wird angenommen, dass diese durch gewollte Kanten im Bild verursacht ist. Wie in den
anderen Modi auch, können Sie mit dem Radius die effektive Größe der einbezogenen Umge-
bung beeinflussen. Es ist aber empfehlenswert diese Einstellung zwischen 0,8 und 1,0 zu belassen.
Die Einstellung für den Wert Alpha bestimmt den Schwellwert für das Rauschen für welches die
Weichzeichnung vorgenommen wird. Dies bedeutet, dass kleine Werte fast keine sichtbare Aus-
wirkung im Bild haben, während grössere Werte dann mehr und mehr Bildteile weichzeichnen.
Gute Startwerte sind Alpha = 1.2 und Radius = 1.0. Davon ausgehend können Sie den Wert für
Alpha solange anpassen, bis Sie die für Ihr Bild optimalen Einstellungen gefunden haben.

Kantenverstärkung In diesem Modus wird das Gegenteil des vorher beschriebenen Modus erreicht.
Kanten werden in diesem Modus hervorgehoben. Mit dem Wert von Alpha kontrollieren Sie die
Stärke der Hervorhebung der Kanten von kaum sichtbar (-0.1) bis sehr stark (-0.9). Der Wert von
Radius kontrolliert auch in diesem Modus den effektiven Radius. Sinnvolle Werte hierfür lieben
im Bereich von 0.5 bis 0.9. Gute Startwerte sind Alpha = 0.3 und Radius = 0.8.

10.6.6. Schärfen

10.6.6.1. Wirkungsweise

Abbildung 10.88. v.l.n.r.: Originalbild, Schärfen angewandt

(a) (b)

Die meisten digitalisierten Bilder benötigen eine Korrektur der Schärfe. Dies resultiert aus den techni-
schen Gegebenheiten dieses Vorganges, bei dem ein kontinuierliches Farbspektrum auf ein diskretes
abgebildet werden muss. Elemente, welche kleiner als die Abtastfrequenz sind, werden mit Durch-
schnittsfarbe gefüllt. Dabei werden scharfe Kanten zwangsläufig weichgezeichnet. Der gleiche Effekt
tritt auf, wenn farbig gedruckt wird.

Das Filter verstärkt die Kanten, aber auch ein möglicherweise im Bild vorhandenes Rauschen. Dies
kann sogar dazu führen, dass nach der Anwendung des Filters ein Rauschen sichtbar wird, welches
zuvor scheinbar nicht vorhanden war. Alternativ können Sie auch das Unscharf Maskieren Filter in
Betracht ziehen. Dieses ist exakter steuerbar und liefert damit oftmals bessere Ergebnisse.
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10.6.6.2. Filteraufruf

Dieses Filter lässt sich über das Menü Filter → Verbessern → Schärfen im Bildfenster aufrufen.

10.6.6.3. Eigenschaften

Abbildung 10.89. Eigenschaften für das Filter ”Schärfen“

Vorschau In der Vorschau wird ein Ausschnitt des Bildes so dargestellt, als wäre das Filter mit den
aktuellen Einstellungen auf das Bild angewandt worden.

Schärfe Mit diesem Schieberegler können Sie die Stärke der Filterwirkung im Bereich von 1 bis 99
einstellen.

10.6.7. Unscharf Maskieren

10.6.7.1. Wirkungsweise

Abbildung 10.90. v.l.n.r.: Originalbild, Unscharf Maskieren angewandt

(a) (b)

Die meisten digitalisierten Bilder benötigen eine Korrektur der Schärfe. Dies resultiert aus den techni-
schen Gegebenheiten dieses Vorganges, bei dem ein kontinuierliches Farbspektrum auf ein diskretes
abgebildet werden muss. Elemente, welche kleiner als die Abtastfrequenz sind, werden mit Durch-
schnittsfarbe gefüllt. Dabei werden scharfe Kanten zwangsläufig weichgezeichnet. Der gleiche Effekt
tritt auf, wenn farbig gedruckt wird.
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Unscharf Maskieren bezeichnet eine Filtermethode, um die Bildschärfe von Fotos durch die Kon-
trastanhebung kleiner Helligkeitswechsel zu erhöhen. Geschärfte Bilder erscheinen detailreicher, da die
Wahrnehmung des Menschen auf die Erkennung von Kanten und Linien hin optimiert ist. Der Informa-
tionsgehalt wird, wie bei allen nachträglich durchgeführten Bildoperationen, nicht erhöht.

TIPP

Einige Scanner und Digitalkameras können Bilder direkt im Gerät nachschärfen.
Es ist allerdings empfehlenswert dieses auszuschalten, um die volle Kontrolle
über die Bilder zu behalten.

TIPP

Um Farbstörungen, die durch das Schärfen verursacht werden können, zu ver-
meiden, ist es empfehlenswert das Bild unter Verwendung des HSV Farbmodells
zu zerlegen und den Schärfefilter nur auf die Ebene anzuwenden, die die Leucht-
kraft (V) enthält.

10.6.7.2. Filteraufruf

Dieses Filter lässt sich über das Menü Filter → Verbessern → Unscharf Maskieren im Bildfenster
aufrufen.

10.6.7.3. Eigenschaften

Abbildung 10.91. Eigenschaften für das Filter ”Unscharf Maskieren“

Vorschau In der Vorschau wird ein Ausschnitt des Bildes so dargestellt, als wäre das Filter mit den
aktuellen Einstellungen auf das Bild angewandt worden.

Radius Mit dieser Eigenschaft können Sie einstellen, wie viele Pixel auf jeder Seite der geschärften
Kante auch geschärft werden sollen. Der optimale Wert hängt von der Auflösung des Bildes ab. Je
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höher diese ist, umso grösser sollte der Wert gewählt werden. Dies bedeutet auch, dass Sie Bilder
erst dann schärfen sollten, wenn diese ihre endgültige Auflösung haben. Die Einstellung können
Sie mittels eines Schiebereglers und eines Eingabefeldes im Bereich von 0 bis 120 vornehmen.

Menge Mit diesem Schieberegler können Sie die Stärke der Schärfewirkung des Filters im Bereich von
0,0 bis 5,0 einstellen.

Schwellwert Mit dieser Eigenschaft können Sie im Bereich 0 bis 255 einstellen, wie unterschiedlich die
Farbe zweier Pixel sein müssen, damit diese als Kante betrachtet und damit geschärft werden. Mit
dieser Eigenschaft können Sie also Bereich ähnlicher Farbe oder gleichmässiger Farbverläufe vor
dem Schärfen schützen.

10.7. Generisch

10.7.1. Einführung

Generische Filter in GIMP sind Filter, mit denen Sie eigene Filter bauen können. Das klingt kompliziert?
Schauen Sie sich das Filter Faltungsmatrix an, dort gibt es eine Menge guter Beispiele.

10.7.2. Faltungsmatrix

10.7.2.1. Wirkungsweise

Dieses Filter erlaubt Ihnen eigene Filter zu entwerfen und auszuprobieren. Dies geschieht über eine
sogenannte Faltung unter Verwendung einer Faltungsmatrix (als Kern bezeichnet). Da dieses höhere
Mathematik ist, sei Ihnen an dieser Stelle nur ein pragmatischer Überblick gegeben. Falls Ihnen dies
nicht reicht und Sie Mut zur Mathematik haben, können Sie im Internet nachlesen <http://de.
wikipedia.org/wiki/Faltung %28Mathematik%29>. Viele andere Filter in GIMP basieren übrigens
genau auf dieser Technik der Faltung. Seien Sie also nicht verwundert, wenn Ihnen das Ergebnis bereits
bekannt vorkommt.

Was ist nun aber eine Faltung? Eine Faltung ist zunächsteinmal die Anwendung einer Matrix die

”Kern“ genannt wird, auf eine zweite Matrix. Die Beschaffenheit und der Inhalt des Kernes bestimmen
welcher Effekt bei der Anwendung erreicht wird.

Das Filter betrachtet das Bild, auf welches es angewendet wird als zweidimensionale Matrix, auf die
der Kern angewendet wird.

GIMP verwendet als Kern Matrizen mit 5x5 oder 3x3 Einträgen. Hier werden nur 3x3 Matrizen
betrachtet, da diese weiter verbreitet sind und die wesentlichen Effekte mit ihnen realisiert werden
können.

Das Filter betrachtet nacheinander jedes Pixel des Bildes. Für das aktive Pixel und seine 8 Nachbarpi-
xel wird eine Multiplikation mit den zugehörigen Elementen des Kernes durchgeführt. Die Ergebnisse
dieser Multiplikationen werden als neuer Wert des aktuellen Pixels übernommen.

Die nachfolgende Abbildung verdeutlicht den Ablauf:

Auf der linken Seite sehen Sie das Bild, als Matrix dargestellt. Die Farbwerte werden durch Zahlen
repräsentiert. Der aktuell bearbeitete Pixel ist rot umrandet. Der Bereich auf den der Kern angewendet
wird ist grün umrandet. In der Mitte des Bildes sehen Sie den Kern. Auf der rechten Seite das Bild, nach
Anwendung des Kerns, also das Ergebnis der Faltung.

Was ist nun genau passiert? Das Filter liest von links nach rechts, Zeile für Zeile alle Werte des Berei-
ches auf das der Kern angewendet wird. Dabei werden die Werte der Bildmatrix mit den korrespondie-
renden Werten des Kerns multipliziert und die Ergebnisse addiert: (100*0)+(50*1)+(50*0)*(100*0)+(100*0)+(100*0)+(100*0)+(100*0)+(100*0)+(100*0)
= 50. Der aktuell bearbeitete Pixel bekommt also den Wert 50.
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10.7.2.2. Filteraufruf

Dieses Filter lässt sich über das Menü Filter → Generisch → Faltungsmatrix im Bildfenster aufrufen.

10.7.2.3. Eigenschaften

Abbildung 10.92. Eigenschaften für das Filter ”Faltungsmatrix“

Matrix Dies ist die 5x5 Matrix, der Kern. Sie können die gewünschten Werte direkt in die Eingabefelder
eintragen.

Divisor: Das Ergebnis der Berechnung wird durch den in diesem Eingabefeld angegebenen Wert
geteilt. Dadurch können Sie verhindern, dass die Rechenergebnisse zu gross werden, um als Farb-
wert dargestellt zu werden.

Versatz: Dieser Wert wird zum Ergebnis der Berechnung hinzuaddiert. Dies kann sehr hilfreich
sein, um negative Rechenergebnisse zu vermeiden. Der eingetragene Wert kann auch negativ sein.

Rand

v.l.n.r: Original, Rand Erweitern, Rand umfalten, Rand abschneiden

Wenn sich der aktuell bearbeitete Pixel am Rand des Bildes befindet, ist ein Teil des Kernes aus-
serhalb des Bildes. Sie können einstellen, wie sich das Filter in einem solchen Fall verhält:

• Erweitern: der Teil des Kernes wird nicht berücksichtigt.

• Umfalten: der Teil des Kernes betrachtet die Pixel auf der gegenüberliegenden Seite des Bil-
des.

• Abschneiden: die Pixel am Rand werden nicht bearbeitet und abgeschnitten.

Kanäle Hier können Sie einen oder mehrere Kanäle auswählen, um festzulegen, auf welche Kanälen
das Filter angewendet werden soll.

Automatisch Wenn diese Eigenschaft des Filters aktiviert ist, werden die Werte für Divisor und Ver-
satz automatisch optimal gewählt.
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Alpha-Gewichtung Wenn diese Eigenschaft nicht aktiviert ist, wird ein im Bild vorhandener Alpha-
kanal nicht in die Berechnung einbezogen. Dies kann zu Artefakten im Bild führen, wenn eine
Weichzeichnung durch die Faltungsmatrix vorgenommen wird.

10.7.2.4. Anwendungsbeispiele

Der Entwurf von Kernen erfordert spezielle mathematische Kenntnisse. Die folgenden Beispiele enthal-
ten Kerne, die Sie ausprobieren können, auch wenn Sie kein Diplom in höherer Mathematik erworben
haben.

Abbildung 10.93. v.l.n.r.: Kern (Schärfen), Kern angewandt

(a) (b)

Abbildung 10.94. v.l.n.r.: Kern (Weichzeichnen), Kern angewandt

(a) (b)

10.7.3. Erweitern

10.7.3.1. Wirkungsweise

Dieses Filter erweitert und verbessert die dunklen Bereiche der aktiven Ebene oder einer im Bild vor-
handenen Auswahl.

Für jedes Pixel im Bild verringert das Filter die Helligkeit auf den minimalen Wert der 8 direkten
Nachbarpixel. Dies bewirkt, dass eine helle Bildregion um einen Pixel vergrössert wird. Ein isolierter
Pixel auf einem hellen Untergrund, wird zu einem 3x3 Pixel grossen, dunklen Bereich.
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Abbildung 10.95. v.l.n.r.: Kern (Kanten verstärken), Kern angewandt

(a) (b)

Abbildung 10.96. v.l.n.r.: Kern (Kanten erkennen), Kern angewandt

(a) (b)

In dieser schematischen Darstellung hat der aktuell bearbeite Pixel einen roten, die aktuell untersuch-
te Umgebung einen grünen Rand. Das dunkelste Pixel der grünen Umgebung bestimmt nun die Farbe
des rot umrandeten Pixels. Dieser Vorgang wird für alle Pixel des Bildes durchgeführt.

In komplexen Bildern werden die dunklen Bildbereiche vergrössert und das gesamte Pild wird ”pi-
xelig“ wirken.

10.7.3.2. Filteraufruf

Dieses Filter lässt sich über das Menü Filter → Generisch → Erweitern im Bildfenster aufrufen.

10.7.4. Erodieren

10.7.4.1. Wirkungsweise

Dieses Filter erweitert und verbessert die hellen Bereiche der aktiven Ebene oder einer im Bild vorhan-
denen Auswahl.

Für jedes Pixel im Bild erhöht das Filter die Helligkeit auf den maximalen Wert der 8 direkten Nach-
barpixel. Dies bewirkt, dass eine helle Bildregion um einen Pixel vergrössert wird. Ein isolierter Pixel
auf einem dunkleren Untergrund, wird zu einem 3x3 Pixel grossen, hellen Bereich.
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Abbildung 10.97. v.l.n.r.: Kern (Relief), Kern angewandt

(a) (b)

Abbildung 10.98. v.l.n.r.: Originalbild, Erweitern angewandt

(a) (b)

In komplexen Bildern werden die hellen Bildbereiche vergrößert und das gesamte Bild wird ”pixelig“
wirken.

10.7.4.2. Filteraufruf

Dieses Filter lässt sich über das Menü Filter → Generisch → Erodieren im Bildfenster aufrufen.

10.8. Glas-Effekte

10.8.1. Einführung in die Glaseffekte

Die Filter dieser Kategorie verändern das Bild in einer Weise, dass es den Anschein hat als würde es
durch eine Linse oder ein Stück Glas betrachtet werden.

10.8.2. Lupeneffekt

10.8.2.1. Wirkungsweise

Dieses Filter lässt einen Teil des Bildes erscheinen, als würde man ihn durch eine Lupe betrachten.

10.8.2.2. Filteraufruf

Dieses Filter lässt sich über das Menü Filter → Glas-Effekte → Lupeneffekt im Bildfenster aufrufen.
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Abbildung 10.99. v.l.n.r.: Originalbild, Erodieren angewandt

(a) (b)

Abbildung 10.100. v.l.n.r.: Originalbild, Lupeneffekt angewandt

(a) (b)

10.8.2.3. Eigenschaften

Vorschau In der Vorschau wird ein Ausschnitt des Bildes so dargestellt, als wäre das Filter mit den
aktuellen Einstellungen auf das Bild angewandt worden.

Ursprüngliche Umgebung beibehalten Wenn diese Eigenschaft ausgewählt ist, wird die Lupe schein-
bar auf das Bild gelegt. Der Bildhintergrund bleibt erhalten.

Umgebung auf Hintergrundfarbe setzen Wenn diese Eigenschaft ausgewählt ist, wird der Teil des
Bildes, der nicht durch die Lupe erscheint, mit der aktuellen Hintergrundfarbe gefüllt.

Umgebung transparent machen Diese Auswahlmöglichkeit ist nur vorhanden, wenn das Bild eine
Transparenzebene enthält. Wird diese Eigenschaft ausgewählt, so wird der Teil des Bildes, der
nicht durch die Lupe erscheint, transparent.

Brechungsindex der Linse Mit dieser Eigenschaft können Sie den Brechungsindex der Linse, also die
Stärke der Lupe, im Bereich von 1,0 bis 100,0 einstellen.

365



10.8. GLAS-EFFEKTE KAPITEL 10. FILTER

Abbildung 10.101. Eigenschaften für das Filter ”Lupeneffekt“

10.8.3. Glasbausteine

10.8.3.1. Wirkungsweise

Abbildung 10.102. v.l.n.r.: Originalbild, Glasbausteine angewandt

(a) (b)

Dieses Filter lässt das Bild erscheinen, als würde es durch eine Wand aus Glasbausteinen betrach-
tet werden. Das Filter kann auf die aktive Ebene oder eine im Bild befindliche Auswahl angewendet
werden.

10.8.3.2. Filteraufruf

Dieses Filter lässt sich über das Menü Filter→Glas-Effekte→Glasbausteine im Bildfenster aufrufen.

10.8.3.3. Eigenschaften

Vorschau In der Vorschau wird ein Ausschnitt des Bildes so dargestellt, als wäre das Filter mit den
aktuellen Einstellungen auf das Bild angewandt worden.

Kachelbreite; Kachelhöhe • Kachelbreite: Mit dieser Eigenschaft können Sie die breite der Glas-
bausteine im Bereich von 10 bis 50 Pixel einstellen.
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Abbildung 10.103. Eigenschaften für das Filter ”Glasbausteine“

• Kachelhöhe: Mit dieser Eigenschaft können Sie die Höhe der Glasbausteine im Bereich von
10 bis 50 Pixel einstellen.

10.9. Licht-Effekte

10.9.1. Einführung Beleuchtugseffekte

Die Filter dieser Kategorie zeichnen verschiedene Beleuchtungseffekte in ein Bild. Prominentes Beispiel
sind die Lichtflecken, wie sie zum Beispiel beim fotografieren ohne Gegenlichtblende auftreten können.

10.9.2. Linsenreflexe

10.9.2.1. Wirkungsweise

Abbildung 10.104. v.l.n.r.: Originalbild, Linsenreflexe angewandt

(a) (b)

Dieses Filter können Sie verwenden, um dem Bild Lichtreflexe hinzuzufügen wie sie entstehen, wenn
Sie ohne Gegenlichtblende ein Photo erstellen und Streulicht auf eine Linse fällt. Zumindest in der Pho-
tographie ist dies ein eher unerwünschter Effekt :)

10.9.2.2. Filteraufruf

Dieses Filter lässt sich über das Menü Filter → Licht-Effekte → Linsenreflexe im Bildfenster aufrufen.
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10.9.2.3. Eigenschaften

Abbildung 10.105. Eigenschaften für das Filter ”Linsenreflexe“

Vorschau In der Vorschau wird ein Ausschnitt des Bildes so dargestellt, als wäre das Filter mit den
aktuellen Einstellungen auf das Bild angewandt worden.

Mitte des Reflexes Mit den zwei Eigenschaften X und Y können Sie Einstellen wo im Bild der Licht-
reflex erscheinen soll. Sie können alternativ auch an die gewünschte Stelle im Vorschaubereich
klicken.

Zeige den Cursor Wenn diese Eigenschaft aktiviert ist, wird die Stelle an welcher der Effekt im Bild
erscheinen wird, durch ein Fadenkreuz markiert. Sie können dieses Fadenkreuz, und damit die
Position des Effektes, verschieben.

10.9.3. GFlare

10.9.3.1. Wirkungsweise

Dieses Filter bring the ”GFlare“ Effekt im Bild auf. Dieser Effekt ist den Lichtflecken in Photographien
ähnlich, wenn diese entweder gegen eine Lichtquelle, oder ohne Gegenlichtblende aufgenommen wer-
den. Der Effekt entsteht normalerweise durch Streulicht, dass an den verschiedenen Linsen der Kamera
gebeugt und gebrochen wird und dann auf den Film oder Bildsensor fällt.

Der Effekt besteht aus drei Komponenten. Einem zentralen Glühen, welches von Strahlen umgeben ist
und äusseren Aufhellungen.

10.9.3.2. Filteraufruf

Dieses Filter lässt sich über das Menü Filter → Licht-Effekte → GFlare im Bildfenster aufrufen.

10.9.3.3. Eigenschaften

Die Eigenschaften des Filters sind in zwei Reiter aufgeteilt. unter Einstellungen können Sie alle Para-
meter manuell einstellen. Im Reiter Auswahl finden Sie dagegen eine Auswahl an vorbereiteten Einstel-
lungen, welche Sie verwenden oder verändern können.
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Abbildung 10.106. v.l.n.r.: Originalbild, GFlare angewandt

(a) (b)

Vorschau In der Vorschau wird ein Ausschnitt des Bildes so dargestellt, als wäre das Filter mit den
aktuellen Einstellungen auf das Bild angewandt worden.

10.9.3.4. Eigenschaften - Einstellungen

Abbildung 10.107. Eigenschaften im Reiter ”Einstellungen“ für das Filter ”GFlare“

Mitte Mit dieser Eigenschaft können Sie festlegen, an welcher Stelle des Bildes der Effekt erscheint. Sie
können die Werte direkt in die beiden Eingabefelder schreiben, oder an die Stelle des Vorschaubil-
des klicken, die Sie einstellen möchten.

Parameter
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• Radius: Mit dieser Eigenschaft können Sie die Grösse des Effektes einstellen. Die Einstellung
können Sie über den Schieberegler vornehmen, allerdings ist dabei nur ein Bereich von 1 bis
150 möglich. Grössere Werte können Sie direkt in das zugehörige Eingabefeld schreiben.

• Drehung: Mit dieser Eigenschaft können Sie den Effekt drehen. Hierzu können Sie Werte
zwischen -180° und 180° eingeben.

• Farbwert Rotation: Hiermit können Sie den Farbton des Effektes im Farbkreis verschieben.
Möglich sind Eingaben im Bereich von -180° bis 180° auf bezogen auf den Farbkreis. 0° ent-
spricht einem Rotton.

• Vektorwinkel: Mit dieser Eigenschaft können Sie die Richtung der äusseren Aufhellungen
des Effektes im Bereich 0° bis 360° festlegen.

• Vektorlänge: Mit dieser Eigenschaft können Sie den Abstand der äusseren Aufhellungen
vom Zentrum des Effektes einstellen.

Anpassende Hochrechnung Anpassende Hochrechnung: Mit dieser Eigenschaft können sie das An-
tialiasing aktivieren und einstellen, mit welcher Max. Tiefe und welchem Schwellwert die Glättung
vorgenommen wird.

10.9.3.5. Eigenschaften - Auswahl

Abbildung 10.108. Eigenschaften im Reiter ”Auswahl“für das Filter ”GFlare“

In diesem Reiter der Einstellungen des Filters können Sie aus vordefinierten Filtereinstellungen auswählen,
aber auch neue Filtereinstellungen anlegen und die Vorhandenen verändern.

Neu Mit dieser Schaltfläche können Sie ein neues Set von Filtereinstellungen erzeugen und einen Na-
men dafür angeben.

Bearbeiten Mit dieser Schaltfläche können Sie die aktuell ausgewählten Filtereinstellungen zur Bear-
beitung öffnen.
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Kopieren Mit dieser Schaltfläche können Sie die aktuell ausgewählten Filtereinstellungen duplizieren,
um sie unter einem anderen Namen weiter zu bearbeiten.

Löschen Mit dieser Schaltfläche können Sie die aktuell ausgewählten Filtereinstellungen löschen.

10.9.3.6. GFlare Editor

Abbildung 10.109. Eigenschaften im Reiter ”Allgemein“ für den ”GFlare Editor“
Allgemein

Zeicheneinstellungen für Glühen

• Deckkraft: Mit dieser Eigenschaft können Sie über einen Schieberegler und das zugeord-
nete Eingabefeld die Deckkraft im Bereich von 0 bis 100 einstellen.

• Zeichenmodus: Sie können bei dieser Eigenschaft über ein Klappmenü zwischen vier
Einstellungen auswählen:

– Normal: In diesem Zeichenmodus wird der Effekt aufgetragen, ohne das das Filter
berücksichtig, was sich unter dem Effekt befindet.

– Addieren: In diesem Zeichenmodus werden die Farbwerte der Pixel aus dem Effekt
und dem darunter befindlichen Pixel des Bildes addiert. Der Effekt wirkt dadurch
heller.

– Überlagern: In diesem Zeichenmodus verstärken die hellen bzw. dunklen Bereiche des
Effektes die hellen bzw. dunklen Bereiche des Bildes.

– Schirm: In diesem Zeichenmodus werden die dunklen Bereiche des Bildes durch hel-
lere Bereiche des Effektes aufgehellt. Dies ist, als würden zwei Dias auf den selben
Schirm projiziert werden.

Zeicheneinstellungen für Strahlen Die Eigenschaften in diesem Bereich entsprechen denen für
Glühen
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Zeicheneinstellungen für anderes Flare Die Eigenschaften in diesem Bereich entsprechen de-
nen für Glühen

Abbildung 10.110. Eigenschaften im Reiter ”Glühen“ für den ”GFlare Editor“
Glühen

Farbverläufe In den Klappmenüs können Sie aus einer grossen Auswahl von Farbverläufen auswählen.
Die Verläufe, welche mit ”%“ beginnen, gehören zum Filter.

• Radialer Farbverlauf: Der ausgewählte Farbverlauf wird kreisförmig von der Mitte bis
zum Rand gezeichnet.

• Drehungs-Gradient: Der ausgewählte Farbverlauf wird um das Zentrum herum, entge-
gen dem Uhrzeigersinn, aufgetragen.

• Umfangs-Gradient: Der ausgewählte Farbverlauf bestimmt die Form des Umrisses des
Effekts. Dabei wird die Form durch die Farbhelligkeit bestimmt. Eine Helligkeit von 0%
wird in einen Radius von 0% transformiert, eine Helligkeit von 100% entsprechend in
einen Radius von 100%.

Parameter

• Grösse (%): Mit dieser Eigenschaft können Sie die Grösse des Glühens im Bereich von
0% bis 200% einstellen.

• Rotation: Mit dieser Eigenschaft können Sie im Bereich von -180° bis 180° einstellen, wie
der Drehungs-Gradient aufgetragen wird. 0° entspricht dabei ”Osten“ (3 Uhr).

• Farbton Rotation: Mit dieser Eigenschaft können Sie die Farbe entsprechend des Farb-
kreises im Bereich von -180° bis 180° einstellen.

Farbverläufe Die Einstellungen in diesem Bereich entsprechen den unter Glühen beschriebenen.
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Abbildung 10.111. Eigenschaften im Reiter ”Strahlen“ für den ”GFlare Editor“
Strahlen

Parameter Die Bedeutung der Eigenschaften Grösse, Rotation und Farbton Rotation entspricht
den gleichnamigen, im Bereich Glühen beschriebenen. Zwei neue Eigenschaften kommen
dazu:

• Anzahl der Strahlen: Mit dieser Eigenschaft können Sie einstellen, wie viele Strahlen
das Filter zeichnet. Die Einstellung können Sie im Bereich zwischne 1 und dreihundert
vornehmen.

• Dicke der Strahlen: Mit dieser Eigenschaft können Sie im Bereich zwischen 1 und 100
einstellen, wie dick die Strahlen werden, die das Filter erzeugt.

Farbverläufe Diese Eigenschaften entsprechen den unter Glühen beschriebenen.

Parameter Diese Eigenschaften entsprechen den unter Glühen beschriebenen.

Form des anderen Flares Die äusseren hellen Bereiche, also die Satelliten des zentralen Glühens,
können zwei verschiedene Formen haben: Kreis und Polygon. Sie können die Anzahl der Kan-
ten des Polygons angeben.

Zufallssaat und Würfeln

• Zufallssaat: Der Zufallsgenerator benutzt den hier eingestellten Wert, um Zufallszahlen
zu generieren. Wenn Sie einen festen Wert einstellen, wird immer die gleiche Folge von

”Zufallszahlen“ verwendet und die Ergebnisse werden reproduzierbar.
• Würfeln: Wenn Sie diese Schaltfläche benutzen, wird für die Zufallssaat eine Zufallszahl

bestimmt.
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Abbildung 10.112. Eigenschaften im Reiter ”Zweites Flare“ für den ”GFlare Editor“
Zweites Flare

10.9.4. Lichteffekte

10.9.4.1. Wirkungsweise

Dieses Filter simuliert den Effekt, den man bekommt, wenn man mit einem Scheinwerfer an eine Wand
leuchtet. Dabei werden aber keine Schatten erzeugt.

10.9.4.2. Filteraufruf

Dieses Filter lässt sich über das Menü Filter → Licht-Effekte → Lichteffekte im Bildfenster aufrufen.

10.9.4.3. Eigenschaften

Abbildung 10.113. v.l.n.r.: Originalbild, Lichteffekte angewandt

(a) (b)
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Vorschau In der Vorschau wird ein Ausschnitt des Bildes so dargestellt, als wäre das Filter mit den
aktuellen Einstellungen auf das Bild angewandt worden.

Innerhalt der Vorschau wird durch einen kleinen blauen Punkt die Stelle im Bild gekennzeich-
net, an der der Effekt aufgetragen wird. Diesen Punkt können Sie innerhalb der Vorschau einfach
verschieben.

Wenn die Eigenschaft Interaktiv nicht aktiviert ist, wird die Vorschau nur beim klicken auf die
Schaltfläche Neu zeichnen aktualisiert. Diese Einstellung ist sehr nützlich, wenn Sie GIMP auf
einem langsamen Computer benutzen.

Abbildung 10.114. Eigenschaften (Einstellungen) für das Filter ”Lichteffekte“

Generelle Einstellungen

Transparenter Hintergrund Wenn diese Eigenschaft eingeschaltet ist, wird das Bild an den Stel-
len, an denen die Bumpmap eine Höhe von 0 hat (also schwarz ist), transparent.

Neues Bild erzeugen Wenn diese Eigenschaft aktiviert ist, wird das Filter auf einer Kopie des
Bildes, die als neues Bild erzeugt wird, ausgeführt. Das Originalbild bleibt unverändert.

Vorschau in hoher Qualität Wenn diese Eigenschaft aktiviert ist, wird die Vorschau in einer höheren
Qualität berechnet. Dies ist nur auf schnelleren Rechnern zu empfehlen, zumal der Unter-
schied wegen der Grösse der Vorschau kaum zu erkennen ist.

In diesem Reiter können Sie verschiedene Eigenschaften des Lichtes einstellen, dass das Filter als
Effekt verwendet. Sie können zudem bis zu sechs verschiedene Lichtquellen einstellen, die auf das
Bild einwirken.

Typ Das Filter verfügt über verschiedene Lichttypen, die Sie mit Hilfe eines Klappmenüs auswählen
können.
Der Typ Punkt wird durch einen blauen Punkt in der Vorschau symbolisiert. Sie können
diesen durch anklicken verschieben und die Lichtquelle beliebig im Bild positionieren.
Der Typ Gerichtet wird in der Vorschau durch einen blauen Punkt, verbunden mit dem Bild-
zentrum durch eine dünne Linie, symbolisiert. Diese Linie gibt die Richtung an, in die das
Licht gerichtet ist.
Zusätzlich finden Sie noch die Einstellung Kein in der Auswahl. Dies schaltet die Lichtquelle
aus. Sie haben insgesamt sechs Lichtquellen zur Verfügung, die Sie unabhängig voneinander
konfigurieren können.
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Abbildung 10.115. Eigenschaften (Licht) für das Filter ”Lichteffekte“

Licht

Farbe Mit dieser Eigenschaft können Sie die Farbe des Lichtes beeinflussen. Klicken Sie auf die
Schaltfläche, um ein Farbauswahldialog zu erhalten, mit dem Sie die gewünschte Farbe auswählen
können.

Intensität Mit dieser Eigenschaft können Sie die Stärke der Lichtquelle einstellen.

Position Mit den dieser Eigenschaft zugeordneten drei Eingabefeldern X, Y und Z können Sie die
Position der Lichtquelle im Raum einstellen.

Richtung Mit den dieser Eigenschaft zugeordneten drei Eingabefeldern X, Y und Z können Sie
die Richtung der Lichtquelle im Raum einstellen.

Isolieren Mit dieser Eigenschaft können Sie einstellen, ob Sie alle vorhandenen, oder nur die ak-
tuell bearbeitete Lichtquelle in der Vorschau angezeigt bekommen möchten.

Beleuchtungsvorlagen Sie können die hier vorgenommenen Einstellungen speichern und später
wieder laden. Dazu stehen Ihnen die beiden Schaltflächen Speichern und Öffnen zur Verfügung.

Die Eigenschaften, welche Sie in diesem Reiter einstellen können, betreffen nicht das Licht selbst,
sondern die Art wie es reflektiert wird.

Glühen Mit dieser Eigenschaft können Sie einstellen, wie stark die Oberfläche selbst Licht strahlt.

Hell Mit dieser Eigenschaft können Sie die Helligkeit einstellen.

Glanz Mit dieser Eigenschaft können Sie einstellen, wie stark die Oberflächen glänzen.

Poliert Mit dieser Eigenschaft können Sie einstellen, wie stark das Licht von der Oberfläche ge-
streut wird.

Metallisch Wenn diese Eigenschaft aktiv ist, erscheinen die Oberflächen metallisch.
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Abbildung 10.116. Eigenschaften (Material) für das Filter ”Lichteffekte“

Material

Abbildung 10.117. Eigenschaften (Bumpmap) für das Filter ”Lichteffekte“

Bumpmap

In diesem Reiter können Sie Eigenschaften des Filters einstellen, welche zum Thema Bumpmap-
ping gehören.

Bumpmapping aktivieren Mit diesem Kontrollkästchen können Sie die Einstellungen für das
Bumpmapping aktivieren. Zusammen mit den Eigenschaften des Reiters Environmentmap-
ping lassen sich interessante Effekte erzeugen. Als Textur können Sie Graustufenbilder ver-
wenden. Deren helle Bereiche werden als Erhöhung interpretiert, die dunklen bleiben un-
verändert.

Bumpmap Bild Hier können Sie aus den geöffneten Bildern eines auswählen, dass als Textur
verwendet werden soll. Bitte beachten Sie, dass es sich dabei um ein Graustufenbild handeln
muss.

Kurve Zur Auswahl des Kurventypes stehen Ihnen in einem Klappmenü verschiedene Möglichkeiten
zur Verfügung: Linear, Logarithmisch, Sinusförmig und Sphärisch. Eine detailierte Erläuterung
zu diesen Einstellungen finden Sie in Abschnitt Bumpmapping Filter.
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Maximale Höhe Mit dieser Eigenschaft können Sie die maximale Höhe der durch die Textur si-
mulierten Erhöhungen einstellen.

Abbildung 10.118. Eigenschaften (Environmentmap) für das Filter ”Lichteffekte“

Environmentmapping

Environmentmapping aktivieren Mit diesem Kontrollkästchen aktivieren Sie das Environment-
mapping und die zugehörigen Eigenschaften.

Umgebungsbild Hier können Sie aus den geöffneten Bildern eines auswählen, welches als Textur
verwendet wird. Es muss sich dabei um ein Bild im RGB Modus handeln.

10.9.5. Glitzern

10.9.5.1. Wirkungsweise

Abbildung 10.119. v.l.n.r.: Originalbild, Glitzern angewandt

(a) (b)

Mit diesem Filter können Sie Sterne in Ihrem Bild aufbringen. Diese werden an den hellsten Stellen
des Bildes angebracht und wirken wie ein Glitzern. Um gezielt Sterne einbringen zu können, ist ein
kleiner Trick hilfreich: Markieren Sie die Stellen in Ihrem Bild mit kleinen, weissen Punkten.
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10.9.5.2. Filteraufruf

Dieses Filter lässt sich über das Menü Filter → Licht-Effekte → Glitzern im Bildfenster aufrufen.

10.9.5.3. Eigenschaften

Abbildung 10.120. Eigenschaften für das Filter ”Glitzern“

Leuchtstärke Schwellwert Mit diesem Schieberegler können Sie im Bereich von 0,0 bis 0,1 einstellen
wie hell die Stellen im Bild sein müssen, damit ein Glitzereffekt aufgetragen wird.

Leuchtintensität Wenn Sie den Wert dieser Eigenschaft erhöhen, werden der zentrale Leuchtpunkt
und die Strahlen erweitert. Sie können die Einstellung im Bereich von 0,0 bis 0,1 vornehmen.

Strahlenlänge Mit dieser Eigenschaft können Sie einstellen, wie lang die Strahlen der aufgetragenen
Sternchen sind. Die Einstellung kann im Bereich von 1 bis 100 erfolge. Wenn Sie den Wert verklei-
nern, wird der Effekt zuerst an kleinen Sternchen sichtbar.

Strahlzentren Mit dieser Eigenschaft legen Sie fest, wie viele große Strahlen es pro Stern gibt. Zusätzlich
wird die gleiche Anzahl kleiner Strahlen erzeugt. Wenn die Anzahl ungerade ist, werden die klei-
nen Strahlen jeweils gegenüber einem großen erzeugt. Wenn die Anzahl gerade ist, steht einem
grossen Strahl jeweils ein weiterer grosser gegenüber. Die Einstellung kann im Bereich von 0 bis
16 vorgenommen werden.

Strahlwinkel Diese Eigenschaft legt fest, in welchem Winkel der erste Strahl aufgetragen wird. Diese
Einstellung kann im Bereich von -1 bis 360° vorgenommen werden. Dabei nimmt der Wert -1 eine
Sonderstellung ein, da er eine zufällige Bestimmung des Winkels bewirkt.

Strahlendichte Mit dieser Eigenschaft bestimmen Sie, die Anzahl von Sternen im Bild. Der Wert gibt
den Prozentsatz der Sterne an, die von der Gesamtheit der möglichen Sterne tatsächlich gezeichnet
werden. Die Einstellung ist im Bereich von 0,0 bis 1,0 möglich.
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Deckkraft Wenn Sie den Wert der Deckkraft verringern, werden die Sterne zunehmend transparent
und der Hintergrund scheint durch. Die Einstellung kann im Bereich von 0,0 bis 1,0 vorgenommen
werden.

Zufallsfarbton Mit dieser Eigenschaft können Sie die Sterne einfärben. Der Wert kann im Bereich von
0,0 bis 1,0 liegen.

Zufällige Sättigung Mit dieser Eigenschaft könne Sie die Farbsättigung im Bereich von 0,0 bis 1,0 ein-
stellen.

Helligkeit erhalten Wenn diese Eigenschaft aktiviert ist, erhalten alle Pixel des Zentrums des Ster-
nes die Helligkeit des hellsten Pixels. Damit können Sie die Gesamthelligkeit des Glitzereffektes
erhöhen.

Invertieren Statt die hellsten Pixel des Bildes mit dem Glitzereffekt zu versehen, werden, wenn diese
Eigenschaft aktiviert ist, die dunkelsten Pixel mit einem Effekt versehen.

Rand hinzufügen Anstatt Sternchen für jedes der hellsten Pixel des Bildes zu erzeugen, werden, wenn
diese Eigenschaft aktiviert ist, diese Pixelbereiche durch Sternchen umrandet.

Natürliche-; Vorder-; Hintergrundfarbe Mit dieser Eigenschaft haben Sie die Möglichkeit die Farbe
der zentralen Pixel der Sterne zu beeinflussen. Folgende Auswahlmöglichkeiten stehen Ihnen zur
Verfügung: Natürliche Farbe, Vordergrundfarbe sowie Hintergrundfarbe.

10.9.6. Supernova

10.9.6.1. Wirkungsweise

Abbildung 10.121. v.l.n.r.: Originalbild, Supernova angewandt

(a) (b)

10.9.6.2. Filteraufruf

Dieses Filter lässt sich über das Menü Filter → Licht-Effekte → Supernova im Bildfenster aufrufen.
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Abbildung 10.122. Eigenschaften für das Filter ”Supernova“

10.9.6.3. Eigenschaften

Vorschau In der Vorschau wird ein Ausschnitt des Bildes so dargestellt, als wäre das Filter mit den
aktuellen Einstellungen auf das Bild angewandt worden.

Mitte der Nova

• X, Y sind die Eigenschaften, mit denen Sie das Zentrum der Nova festlegen. Sie können die
Einstellung entweder über die Eingabefelder vornehmen, oder an die gewünschte Stelle der
Vorschau klicken. Die Werte werden dann automatisch eingetragen.

• Show Cursor; wenn dieses Kontrollkästchen aktiviert ist, wird die Stelle an der die Superno-
va im Bild erscheint in der Vorschau durch ein Fadenkreuz symbolisiert.

Farbe Mit dieser Eigenschaft können Sie die Farbe der Supernova beeinflussen. Klicken Sie auf die
Schaltfläche, um mit Hilfe des Farbauswahldialoges eine Farbe einzustellen.

Radius Hier können Sie den Radius der Supernova mit Hilfe eines Schiebereglers im Bereich 0 bis 100
einstellen. Die Anzahl der weissen Pixel im Zentrum der Nova entspricht dem Quadrat des in der
Eigenschaft eingestellten Wertes.

Strahlen Mit dieser Eigenschaft können Sie einstellen, wie viele Strahlen (1-1024) die Supernova haben
soll.

Zufallsfarbton Mit dieser Eigenschaft können Sie die Strahlen der Nova zufällig einfärben. Der Wert
kann im Bereich von 0° bis 360° eingestellt werden und beeinflusst den verwendeten Bereich des
Farbkreises.
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10.10. Verzerren

10.10.1. Einführung in die Verzerrungsfilter

Die Filter in dieser Kategorie verzerren das Bild auf verschiedene Weisen.

10.10.2. Jalousie

10.10.2.1. Wirkungsweise

Abbildung 10.123. v.l.n.r.: Originalbild, Jalousie angewandt

(a) (b)

Dieses Filter generiert einen Jalousie-Effekt mit horizontalen oder vertikalen Lamellen.

10.10.2.2. Filteraufruf

Dieses Filter lässt sich über das Menü Filter → Verzerren → Jalousie im Bildfenster aufrufen.

10.10.2.3. Eigenschaften

Abbildung 10.124. Eigenschaften für das Filter ”Jalousie“
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Vorschau In der Vorschau wird ein Ausschnitt des Bildes so dargestellt, als wäre das Filter mit den
aktuellen Einstellungen auf das Bild angewandt worden.

Orientierung Mit dieser Eigenschaft können Sie einstellen, ob der Effekt Horizontal oder Vertikal aus-
gerichtete Lamellen zeichnet.

Hintergrund Für die Farbe der Lamellen wird die aktuelle Hintergrundfarbe verwendet. Mit dieser
Eigenschaft können Sie alternativ die Lamellen Transparent machen. Dazu muss das Bild einen
Alphakanal für die Transparenz haben.

Verschiebung Mit dieser Eigenschaft können Sie die Breite der Lamellen einstellen.

Anzahl der Segmente Mit dieser Eigenschaft können Sie die Anzahl der Bildsegmente einstellen, die
zwischen den Lamellen sichtbar sind.

10.10.3. Verbiegen

10.10.3.1. Wirkungsweise

Abbildung 10.125. v.l.n.r.: Originalbild, Verbiegen angewandt

(a) (b)

10.10.3.2. Filteraufruf

Dieses Filter lässt sich über das Menü Filter → Verzerren → Verbiegen im Bildfenster aufrufen.

10.10.3.3. Eigenschaften

Vorschau In der Vorschau wird ein Ausschnitt des Bildes so dargestellt, als wäre das Filter mit den
aktuellen Einstellungen auf das Bild angewandt worden.

Vorschau einmal Diese Schaltfläche aktualisiert die Vorschau wenn sie Sie anklicken.

Automatische Vorschau Wenn Sie diese Eigenschaft aktivieren, wird die Vorschau automatisch
aktualisiert. Dies ist im Allgemeinen sehr praktisch, kostet aber einige Rechenleistung. Bei
älteren Computern ist es empfehlenswert die Vorschau nicht automatisch, sondern über die
Schaltfläche Vorschau einmal zu aktualisieren.
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Abbildung 10.126. Eigenschaften für das Filter ”Verbiegen“

Einstellungen

Drehung Mit dieser Eigenschaft können Sie einstellen in welchem Winkel der Filter auf das Bild
wirkt. Die Einstellung erfolgt im Bereich von 0° bis 360°. 0° ist die Vorgabe-Einstellung, der
Filter wird vom oberen und unteren Rand aus angewandt. Wenn dieser Wert beispielsweise
auf 90° gesetzt wird, so wird das das Filter vom rechten und linken Rand aus aufgetragen.

Glättung; Kantenglättung Durch die Anwendung des Filters können harte oder stufige Kanten
entstehen. Mit diesen beiden Eigenschaften können Sie diese wieder glätten.

Mit Kopie arbeiten Wenn diese Eigenschaft aktiviert ist, wird das Filter nicht auf dem Original-
bild, sondern auf einer Kopie ausgeführt. Diese Kopie wird als neue Ebene unter dem Namen

”curve bend dummy layer b“ im aktuellen Bild angelegt und zur aktiven Ebene.

Kurven bearbeiten In diesem Bereich des Filterdialoges haben Sie einen durch ein Gitter gekennzeich-
neten Bereich zur Verfügung. In diesem Bereich finden Sie eine schwarze Linie, welche horizontal
durch den Bereich gezeichnet, und an Beiden Enden mit einem Knoten versehen ist. Diese Linie
beschreibt die obere Kante des Bildes. Wenn Sie diese Linie anklicken, wird ein neuer Knoten ein-
gefügt und Sie können die Kurve frei gestalten. Sie können auf diese Weise auch mehrere Knoten
in die Kurve einfügen.

Sie können höchstens zwei Kurven im Gitterbereich erzeugen. Eine beschreibt die ”obere“ und die
andere die ”untere“ Kante des Bildes.

Kurve für Rand In dieser Eigenschaft haben Sie zwei Einstellungen zur Auswahl, mit denen Sie festle-
gen können, ob sie die Kurve für den Oberen oder die für den Unteren Rand bearbeiten wollen.
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ACHTUNG

Bitte beachten Sie an dieser Stellen, dass der Rand des Bildes auf welchen
die Kurve angewendet wird zusätzlich von der Einstellung der Eigenschaft
Drehen abhängt. Bei einer Einstellung von beispielsweise 90° wird die Kur-
ve für den oberen Rand in Wirklichkeit auf den rechten Bildrand angewandt.

Kurventyp Mit dieser Eigenschaft können Sie die Art der Kurve einstellen, mit der Sie arbeiten möchten.
Sie haben zwei verschiedene Typen zur Auswahl:

Der Typ Glatt erzeugt automatisch eine geglättete Kurve, welche Sie durch das Einfügen und
verschieben von Knoten verformen können.

Der Typ Frei hingegen, erlaubt Ihnen die Kurve direkt freihand in den Gitterbereich hineinzu-
zeichnen.

Schaltflächen

Kopieren Mit der Schaltfläche Kopieren können Sie die ausgewählte Kurve kopieren und damit
die andere Kurve ersetzen.

Spiegeln Mit der Schaltfläche Spiegeln können Sie die aktuelle Kurve spiegeln und damit die
andere Kurve ersetzen.

Austauschen Mit der Schaltfläche Austauschen können Sie die beiden Kurven vertauschen.

Rücksetzen Mit dieser Schaltfläche können Sie die beiden Kurven in den Ausgangszustand zurückversetzen.

Öffnen Mit dieser Schaltfläche können Sie eine Kurvendefinition aus einer Datei laden.

Speichern Mit dieser Schaltfläche können Sie die aktuellen Kurvendefinitionen in eine Datei spei-
chern.

10.10.4. Relief

10.10.4.1. Wirkungsweise

Dieses Filter erzeugt im Bild einen Effekt, bei dem die Kanten wie Erhöhungen und Vertiefungen er-
scheinen. Es entsteht so ein dreidimensionaler Eindruck, als würde Licht aus einer bestimmten Richtung
auf ein Relief fallen.

ANMERKUNG

Dieses Filter kann ausschliesslich auf Farbbilder angewendet werden. Falls das
aktuelle Bild ein Graustufenbild ist, wird der Menüeintrag ausgegraut.

10.10.4.2. Filteraufruf

Dieses Filter lässt sich über das Menü Filter → Verzerren → Relief im Bildfenster aufrufen.

385



10.10. VERZERREN KAPITEL 10. FILTER

Abbildung 10.127. v.l.n.r.: Originalbild, Relief angewandt

(a) (b)

Abbildung 10.128. Eigenschaften für das Filter ”Relief“

10.10.4.3. Eigenschaften

Vorschau In der Vorschau wird ein Ausschnitt des Bildes so dargestellt, als wäre das Filter mit den
aktuellen Einstellungen auf das Bild angewandt worden.

Funktion Sie haben die Möglichkeit mit dieser Eigenschaft festzulegen, wie der Effekt aussehen soll. Es
stehen Ihnen zwei Auswahlmöglichkeiten zur Verfügung:

Bumpmap: Das Relief wird weich aufgetragen und die Farben bleiben erhalten.

Relief: Das Bild wird in ein Graustufenbild umgewandelt. Der Effekt wirkt wesentlich markanter
und leicht metallisch.

Längengrad (Azimut) Mit dieser Eigenschaft bestimmen Sie die Richtung, aus der das Licht auf das
Bild scheint. Die Einstellung können Sie im Bereich von 0° bis 360° vornehmen. 0° entspricht der
Himmelsrichtung Osten, 90° Norden, 180° Osten und 270° Süden.
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Breitengrad (Elevation) Mit dieser Eigenschaft legen Sie fest, aus welcher Höhe das Licht auf das Bild
fällt. Die Einstellung kann im Bereich von 0° bis 180° vorgenommen werden. 0° entspricht einer
Lichtquelle auf der Höhe des Horizonts, 90° einer senkrecht über dem Bild, im Zenit.

Tiefe Tiefe: Mit dieser Eigenschaft können Sie einstellen, wie stark die Höhen und Vertiefungen ausge-
prägt sind. Sie können Werte zwischen 1 und 100 einstellen. Je höher der Wert ist, um so extremer
werden die Höhenunterschiede.

10.10.5. IWarp

10.10.5.1. Wirkungsweise

Abbildung 10.129. v.l.n.r.: Originalbild, IWarp angewandt

(a) (b)

Dieses Filter ermöglicht es Ihnen interaktive Bilder zu deformieren und von diesen Veränderungen
eine Animation zu erzeugen.

Um das Filter zu verwenden, rufen Sie es zunächst auf und können dann interaktiv mit dem Maus-
zeiger in der Vorschau agieren.

10.10.5.2. Filteraufruf

Dieses Filter lässt sich über das Menü Filter → Verzerren → IWarp im Bildfenster aufrufen.

10.10.5.3. Eigenschaften

Die Eigenschaften des Filters sind so umfangreich, dass sie auf zwei Reiter aufgeteilt wurden. Der erste
beschäftigt sich mit allgemeinen Einstellungen, der andere mit Eigenschaften, die sich auf Animationen
beziehen.

Die Eigenschaften in diesem Reiter erlauben es Ihnen die Einstellungen vorzunehmen, die auch
die Vorschau beeinflussen. Sie können zu Beispiel verschiedene Deformationsmodi ausprobieren.

Vorschau In der Vorschau wird ein Ausschnitt des Bildes so dargestellt, als wäre das Filter mit
den aktuellen Einstellungen auf das Bild angewandt worden.
Ausserdem ist die Vorschau bei diesem Filter Ihre Arbeitsfläche. Klicken Sie in die Vorschau,
und verschieben Sie den Mauszeiger. Der darunter befindliche Teil des Bildes wird, entspre-
chend den eingestellten Eigenschaften des Filters, verzerrt. Sollte das Ergebnis nicht Ihren
Vorstellungen entsprechen, können Sie es jederzeit durch drücken der Schaltfläche Rücksetzen
wieder in den Ausgangszustand versetzen.
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Abbildung 10.130. Eigenschaften (Einstellungen) für das Filter ”IWarp“

Einstellungen

Deformationsmodus

• Bewegen: Dieser Modus erlaubt es Teile des Bildes zu verschieben.
• Entfernen: In diesem Modus werden die Verzerrungen wieder entfernt. Die Bildteile die

bereits durch die Behandlung mit anderen Modi verzerrt wurden, werden in diesem Mo-
dus wieder in die Ursprungsform zurückversetzt. Sie können damit Änderungen, welche
nicht Ihren Vorstellungen entsprechen rückgängig machen. Beachten Sie bitte, dass die-
ser Modus nur auf einem Frame arbeitet, also nicht animierbar ist.

• Vergrössern: In diesem Modus arbeitet das Filter wie eine Lupe. Die Bereiche im Bild,
die Sie mit in diesem Modus bearbeiten werden vergrössert.

• Schrumpfen: Dieser Modus ist die Umkehrung des Modus Vergrössern.
• Verdrehen gegen den Uhrzeigersinn: Mit diesem Modus können Sie Bildteile entgegen

dem Uhrzeigersinn, also linksherum, verdrehen.
• Verdrehen im Uhrzeigersinn: Mit diesem Modus können Sie Bildteile im Uhrzeigersinn,

also rechtsherum, verdrehen.

Deformationsradius Mit dieser Eigenschaft können Sie den Radius einstellen, in dem das Fil-
ter auf das Bild einwirkt. Die Einstellung können Sie über einen Schieberegler oder das zu-
gehörige Eingabefeld im Bereich von 5 bis 100 vornehmen.

Deformation Mit dieser Eigenschaft können Sie beeinflussen, wie stark das Filter auf das Bild
einwirkt. Die Einstellung können Sie über einen Schieberegler, oder das zugeordnete Einga-
befeld im Bereich von 0,0 bis 1,0 vornehmen.

Bilinear Wenn diese Eigenschaft aktiviert ist, wird der Effekt weicher.

Anpassende Hochrechnung Wenn diese Eigenschaft eingeschaltet ist, wird das Ergebnis we-
sentlich aufwendiger berechnet, kann aber dadurch auch von besserer Qualität sein. Es gibt
zwei zugehörige Eigenschaften, um diesen Effekt zu steuern, Max. Tiefe und Schwellwert.

In diesem Reiter können Sie Eigenschaften einstellen, die dazu dienen den Effekt des Filters nicht
nur auf das Bild anzuwenden, sondern eine Animation zu erstellen, die wiedergibt, wie der Effekt
schrittweise in das Bild eingefügt wird (Morphing). Sie können die Animationen mit dem Plugin
wiedergeben.
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Abbildung 10.131. Eigenschaften (Animation) für das Filter ”IWarp“

Animation

Anzahl der Frames Hier können Sie festlegen, aus wie vielen Frames die Animation bestehen
soll. Dabei können zwischen 2 und 200 Frames verwendet werden. Die Frames werden als
Ebenen in das Bild eingefügt.

Umgekehrt Wenn diese Eigenschaft aktiviert ist, wird die Animation rückwärts, also vom veränderten
zum originalen Bild erzeugt.

Ping-Pong Wenn diese Eigenschaft aktiviert ist, wird die Animation zunächst vorwärts und dann
rückwärts erzeugt.

10.10.6. Mosaik

10.10.6.1. Wirkungsweise

Abbildung 10.132. v.l.n.r.: Originalbild, Mosaik angewandt

(a) (b)

Dieses Filter schneidet die aktive Ebene oder Auswahl in Vielecke, welche leicht erhöht, und durch
Stege getrennt werden. Dadurch entsteht der Eindruck eines Mosaiks.
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10.10.6.2. Filteraufruf

Dieses Filter lässt sich über das Menü Filter → Verzerren → Mosaik im Bildfenster aufrufen.

10.10.6.3. Eigenschaften

Abbildung 10.133. Eigenschaften für das Filter ”Mosaik“

Einstellungen

Kantenglättung Wenn Sie diese Eigenschaft einschalten, werden die Kanten, welche das Filter in
das Bild einfügt geglättet.

Farbmittelwerte berechnen Wenn diese Eigenschaft eingeschaltet ist, werden die einzelnen Ele-
mente mit der Durchschnittsfarbe des Bereiches gefüllt.

Zerteilung der Kacheln erlauben Wenn Sie diese Eigenschaft einschalten, werden die Kacheln
in Bildbereichen mit vielen Farben geteilt. Dies führt zu einer weit detaillierteren Farbwie-
dergabe in diesen Bereichen.

Vertiefungen in der Oberfläche Wenn Sie diese Eigenschaft einschalten, wird die Oberfläche der
Kacheln körnig gestaltet.

VG/HG Beleuchtung Wenn diese Eigenschaft eingeschaltet ist, werden die Kacheln auf der Licht-
seite mit der Vorder- und auf der Schattenseite mit der Hintergrundfarbe gefüllt. Die Stege
zwischen den Kacheln werden ebenfalls mit der Hintergrundfarbe gefüllt.

Einstellungen

Kachelgrösse Mittels eines Schiebereglers und des zugeordneten Eingabefeldes können Sie die
Größe der Kacheln im Bereich von 5,0 bis 100,0 einstellen.

Kachelhöhe Die Kacheln erhalten durch einen optischen Trick eine bestimmte Höhe, mit der sie
über die Stege dazwischen hinausragen. Mittels eines Schiebereglers und des zugeordneten
Eingabefeldes können Sie diese Höhe im Bereich von 1,0 bis 50,0 einstellen.

Kachelabstand Mit dieser Eigenschaft können Sie die Abstände zwischen den einzelnen Ka-
cheln, also die Breite der Stege einstellen im Bereich von bis einstellen.
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Kachelordnung Wenn Sie diese Eigenschaft auf 1 einstellen, werden alle Kacheln eine sehr ähnliche
Grösse haben. Mit einer Einstellung von 0 wird die Kachelgröße vom Zufall bestimmt.

Richtung des Lichtes In der Vorgabe-Einstellung befindet sich die Lichtquelle, welche bestimmt
an welcher Seite die hellen und an welcher die dunklen Kanten einer Kachel sind, in der
linken, oberen Ecke (135°). Sie können diese Position mit dieser Eigenschaft im Bereich von
0° bis 360° frei bestimmen.

Farbvariation Jede Kachel hat nur eine geringe Anzahl von Farben. Die Gesamtzahl der Farben
im Bild wird also zumeist stark verringert. Mit dieser Eigenschaft können Sie die Anzahl der
Farben, welche erhalten bleiben, erhöhen.

Primitive für die Kacheln

• Viereck, alle Kacheln haben vier Kanten.

• Sechseck, alle Kacheln haben sechs Kanten.

• Achtecke und Quadrate, alle Kacheln haben acht Kanten.

10.10.7. Einrollen

10.10.7.1. Wirkungsweise

Abbildung 10.134. v.l.n.r.: Originalbild, Einrollen angewandt

(a) (b)

Dieses Filter biegt eine Ecke der aktuellen Ebene oder Auswahl in der Form eines Eselsohres um.
Dabei wird eine neue Ebene, welche das ”Eselsohr“ sowie einen Transparenzkanal enthält, im Bild an-
gelegt. Der Teil des ursprünglichen Bildes, welcher durch den Effekt nicht mehr sichtbar ist, wird im
Bild gelöscht.

10.10.7.2. Filteraufruf

Dieses Filter lässt sich über das Menü Filter → Verzerren → Eeinrollen im Bildfenster aufrufen.

10.10.7.3. Eigenschaften

Position Mit dieser Eigenschaft können Sie festlegen, welche der vier Ecken des Bildes eingerollt wird.
Es stehen die vier Einstellungen Oben Links, Oben Rechts, Unten Links sowie Unten Rechts
zur Auswahl.
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Abbildung 10.135. Eigenschaften für das Filter ”Einrollen“

Orientierung Mit dieser Eigenschaft können Sie einstellen, ob die Ecke Horizontal oder Vertikal einge-
rollt werden soll.

Unter der Ecke abdunkeln Wenn Sie diese Eigenschaft eingeschaltet haben, wird innerhalb der Eselse-
cke ein Schatten angezeigt.

Farbe der Rückseite Zur Auswahl der Farbe der im eingerollten Bereich angezeigten Bildrückseite
steht Ihnen ein Klappmenü mit den Einträgen Vorder- und Hintergrundfarbe, Aktueller Farb-
verlauf sowie Aktueller Farbverlauf (umgekehrt) zur Verfügung.

Deckkraft Mit dieser Eigenschaft können Sie einstellen, wie stark das der eingerollte Bereich das Bild
verdeckt. Die Einstellung kann jeden Wert zwischen 0% und 100% annehmen.

10.10.8. Polarkoordinaten

10.10.8.1. Wirkungsweise

Dieses Filter erzeugt eine rechteckige oder runde Darstellung des Bildes inklusive aller möglichen Zwi-
schenstufen.

10.10.8.2. Filteraufruf

Dieses Filter lässt sich über das Menü Filter→ Verzerren→ Polarkoordinaten im Bildfenster aufrufen.

10.10.8.3. Eigenschaften

Vorschau In der Vorschau wird ein Ausschnitt des Bildes so dargestellt, als wäre das Filter mit den
aktuellen Einstellungen auf das Bild angewandt worden.

Kreistiefe in Prozent Mit dieser Eigenschaft können Sie festlegen, ”wie rund“ die Transformation aus-
geführt wird. Die Einstellung wird über einen Schieberegler oder das zugeordnete Eingabefeld im
Bereich von 0% (rechteckig) bis 100% (rund) vorgenommen.
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Abbildung 10.136. v.l.n.r.: Originalbild, Polarkoordinaten angewandt

(a) (b)

Abbildung 10.137. Eigenschaften für das Filter ”Polarkoordinaten“

Versatzwinkel Mit dieser Eigenschaft legen Sie fest ob, und in welchem Winkel das Bild gedreht wird.
Die Einstellung können Sie mittels eines Schiebereglers oder des zugeordneten Eingabefeldes im
Bereich von 0° bis 359° vornehmen. Die Drehung erfolgt entgegen dem Uhrzeigersinn.

Umgekehrt abbilden Wenn Sie diese Eigenschaft aktiviert haben, erfolgt die Verzerrung in vertikal
gespiegelter Form.

Oben beginnen Wenn Sie diese Eigenschaft aktiviert haben, wird die obere Kante des Ausgangsbildes
in das Zentrum des verzerrten Bildes transformiert. Andernfalls wird im Zentrum des verzerrten
Bildes die untere Kante abgebildet.

Nach Polar Mit dieser Eigenschaft können Sie die Wirkung des Filters umkehren. Wenn die Eigenschaft
eingeschaltet ist, wird das Ausgangsbild um das Zentrum herumgebogen. Andernfalls wird ein
um das Zentrum herum gebogenes Ausgangsbild in eine rechteckige Form transformiert.
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Abbildung 10.138. Text gebogen. Beachten Sie, dass Sie die Ebenen nach unten vereinigen müssen,
bevor Sie das Filter anwenden.

Abbildung 10.139. Text gebogen

10.10.8.4. Weitere Beispiele

10.10.9. Zacken

10.10.9.1. Wirkungsweise

Abbildung 10.140. v.l.n.r.: Originalbild, Zacken angewandt

(a) (b)

Mit diesem Filter können Sie die aktive Ebene oder Auswahl wellenförmig verzerren.

10.10.9.2. Filteraufruf

Dieses Filter lässt sich über das Menü Filter → Verzerren → Zacken im Bildfenster aufrufen.

10.10.9.3. Eigenschaften

Vorschau In der Vorschau wird ein Ausschnitt des Bildes so dargestellt, als wäre das Filter mit den
aktuellen Einstellungen auf das Bild angewandt worden.

Einstellungen

Kantenglättung Wenn Sie diese Eigenschaft aktivieren, werden die Kanten bei Anwendung des
Filters geglättet. Damit können Sie das Erscheinungsbild des Effektes verbessern.

Kachelbarkeit erhalten Wenn diese Eigenschaft aktiviert ist, wird die Kachelbarkeit des Bildes
durch das Filter nicht beeinflusst. Kachelbarkeit ist die Möglichkeit ein Bild wiederholt an-
einander zu fügen, ohne das die Bildkanten sichtbar werden.
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Abbildung 10.141. Eigenschaften für das Filter ”Zacken“

Orientierung Mit dieser Eigenschaft können Sie einstellen, ob die Wellen im Bild Horizontal oder Ver-
tikal verlaufen sollen.

Kanten

• Mit der Einstellung Umfalten werden Pixel, die an einer Seite des Bildes hinausgeschoben
werden, auf der gegenüberliegenden Seite wieder eingefügt.

• Mit der Einstellung Verwischen werden die umliegenden Pixel verstreut, um die fehlenden
Pixel zu ersetzen.

• Mit der Einstellung Schwarz werden die fehlenden Pixel durch schwarze Pixel ergänzt.

Wellentyp Mit dieser Eigenschaft können Sie die Form der Wellen einstellen.

• Sägezahn; die Wellen steigen gleichmässig an und fallen dann steil ab

• Sinus; die Wellen steigen und fallen gleichmässig.

Periode Mit dieser Eigenschaft können Sie die Wellenlänge im Bereich von 0 bis 200 Pixel über einen
Schieberegler oder das zugeordnete Eingabefeld einstellen.

Amplitude Mit dieser Eigenschaft können Sie die Wellenhöhe mittels eines Schiebereglers oder des
zugeordneten Eingabefeldes einstellen. Die Werte müssen zwischen 0 und 200 Pixel liegen.

10.10.10. Verschieben

10.10.10.1. Wirkungsweise

Dieses Filter verschiebt alle Zeilen oder Spalten der aktuellen Ebene oder Auswahl horizontal oder
vertikal um einen zufälligen Betrag.
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Abbildung 10.142. v.l.n.r.: Originalbild, Verschieben angewandt

(a) (b)

10.10.10.2. Filteraufruf

Dieses Filter lässt sich über das Menü Filter → Verzerren → Verschieben im Bildfenster aufrufen.

10.10.10.3. Eigenschaften

Abbildung 10.143. Eigenschaften für das Filter ”Verschieben“

Vorschau In der Vorschau wird ein Ausschnitt des Bildes so dargestellt, als wäre das Filter mit den
aktuellen Einstellungen auf das Bild angewandt worden.

Horizontal / Vertikal verschieben Mit dieser Eigenschaft legen Sie fest, ob das Filter zeilen- oder spal-
tenweise verschieben soll.

Verschiebung Mit dieser Eigenschaft können Sie einstellen um welchen Betrag die Verschiebung ma-
ximal durchgeführt werden soll. Die Einstellung nehmen Sie über ein Eingabefeld im Bereich von
1 bis 200 Pixel vor.
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10.10.11. Zeitungsdruck

10.10.11.1. Wirkungsweise

Abbildung 10.144. v.l.n.r.: Originalbild, Zeitungsdruck angewandt

(a) (b)

Dieses Filter rastert das Bild unter Verwendung von im Zeitungsdruck üblichen Algorithmen. Ras-
terung ist ein Prozess, bei welchem ein Bild mit vielen verschieden Farben so aufbereitet wird, dass
es auf einem Ausgabegerät welches nur über wenige Farben verfügt optimal dargestellt werden kann.
Druckmaschinen sind typischerweise solche Geräte. Es gibt in der Wikipedia einen interessanten Artikel
<http://de.wikipedia.org/wiki/Druckraster>, der sich mit diesem Thema beschäftigt.

Der grundsätzliche Ansatz besteht darin, Bildauflösung zu Gunsten einer besseren Farbdarstellung
zu ”opfern“.

Es gibt viele verschiedene Algorithmen, um dies zu erreichen, Einer der einfachsten besteht darin,
einen Teil der Farbinformationen (die niederwertigen Bits der Farbinformationen) einfach ”wegzuwer-
fen“ - das ist genau was Sie mit dem Werkzeug Posterisieren erreichen können. Allerdings ist das Er-
gebnis dieser Methode oft nicht befriedigend, dafür bleibt die Auflösung vollständig erhalten.

Dieses Filter verwendet einen Algorithmus der die Auflösung des Bildes reduziert, indem Pixel zu
Zellen zusammengefasst werden, welche je nach erforderlicher (Farb-) Intensität mehr oder weniger
vollständig gefüllt werden.

Stellen Sie sich ein Gitter vor, welches über das originale Bild gelegt wird. Das Bild wird damit Git-
terzellen geteilt. Jede Zelle enthält genau einen Farbpunkt, dessen Grösse die originale Helligkeit des
Ausgangsbildes annähernd wiedergibt.

Offensichtlich führt eine grosse Zellengrösse zu einem starken Verlust an Auflösung! Die Punkte in
den Zellen starten typischerweise in Form eines kleinen Kreises. Wenn eine stärkere Füllung nötig ist,
nehmen sie die Form eines Diamanten an. Diese Veränderung der Form könne Sie in den Eigenschaften
des Filters beeinflussen.

10.10.11.2. Filteraufruf

Dieses Filter lässt sich über das Menü Filter → Verzerren → Zeitungsdruck im Bildfenster aufrufen.

10.10.11.3. Eigenschaften

Vorschau In der Vorschau wird ein Ausschnitt des Bildes so dargestellt, als wäre das Filter mit den
aktuellen Einstellungen auf das Bild angewandt worden.

Auflösung Mit dieser Gruppe von Eigenschaften können Sie die Grösse der Zellen einstellen. Dies
geschieht entweder durch Einstellen der Ein- und Ausgabeauflösung, oder direkt.
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Abbildung 10.145. Eigenschaften für das Filter ”Zeitungsdruck“

Eingabe-SPI Mit dieser Eigenschaft stellen Sie die Auflösung (Punkte pro Zoll) des Originalbil-
des ein. Diese Eigenschaft wird automatisch aus der im Bild hinterlegten Auflösung einge-
stellt.

Ausgabe-LPI Mit dieser Eigenschaft können Sie die gewünschte Ausgabeauflösung (Zeilen pro
Zoll) einstellen.

Zellgrösse Die Zellgröße wird automatisch aus den Werten Ein- und Ausgabeauflösung berech-
net. Sie können diese aber auch direkt einstellen, in diesem Fall wird die Ausgabeauflösung
entsprechend angepasst.

Schirm

Separiere nach RGB; CMYK; Intensität Mit dieser Eigenschaft können Sie einstellen, für wel-
chen Farbraum die Separation vorgenommen wird. In der Einstellung RGB wird keine Far-
braumkonvertierung vorgenommen. In der Einstellung CMYK wird das Bild zunächst in den
CMYK Farbraum konvertiert und dann wird die Separation vorgenommen. Abschliessend
wird das Bild zurück in den RGB Farbraum transformiert. In der Einstellung Intensität wird
das Bild intern zunächst in ein Graustufenbild konvertiert, und dann als Transparenzkanal
für die Separation verwendet. Diese Einstellung ist sehr gut für spezielle Effekte geeignet.
Wenn Sie nicht sicher sind, welche Einstellung die Richtige ist, sei Ihnen CMYK empfohlen.

Schwarz-Auszug (%) Mit dieser Eigenschaft legen Sie fest, wieviel Schwarz für die RGB nach
CMYK Konvertierung verwendet wird.

Kanäle verbinden Wenn Sie diese Eigenschaft aktivieren, werden die Einstellungen für die Farb-
kanäle für alle Kanäle gemeinsam vorgenommen.

Fabrikeinstellungen Mit dieser Schaltfläche können Sie die Eigenschaften der Farbkanäle wieder
auf die Vorgabe-Einstellungen zurücksetzen.
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Winkel Mit dieser Einstellung können Sie den Rasterwinkel einstellen. Gebräuchliche Rasterwin-
kel beim vierfarbigen Offsetdruck sind nach DIN 16 547 zum einen Cyan = 75°, Magenta =
15°, Gelb = 0°, Schwarz = 135° (-45°) oder Cyan = 15°, Magenta = 75°, Gelb = 0°, Schwarz =
45°.

Punktfunktion Mit dieser Eigenschaft können Sie einstellen, welche Form die Füllung der Zellen
haben wird.

Kantenglättung Die Kantenglättung ist für die Druckrasterung selbst nicht angebracht, oder gar not-
wendig. Wenn Sie dieses Filter jedoch ausschliesslich als Effekt verwenden, kann es sehr vorteil-
haft wirken, wenn die Kanten geglättet werden.

Oversample Mit dieser Eigenschaft können Sie einstellen wie viele Subpixel zur Kantenglättung
verwendet werden. Setzen Sie diesen Wert auf 1, so wird die Kantenglättung ausgeschaltet.
Rechenaufwand, und damit zu einer langen Wartezeit bei der Anwendung des Filters führen
können.

10.10.12. Video

10.10.12.1. Wirkungsweise

Abbildung 10.146. v.l.n.r.: Originalbild, Video angewandt

(a) (b)

Dieses Filter rastert ein Bild als würde es auf einem Bildschirm angezeigt werden. Das Bild wird dazu
in viele kleine rote, grüne und blaue Bereiche verschiedener Intensität geteilt.

10.10.12.2. Filteraufruf

Dieses Filter lässt sich über das Menü Filter → Verzerren → Video im Bildfenster aufrufen.

10.10.12.3. Eigenschaften

Vorschau In der Vorschau wird ein Beispielbild so dargestellt, als wäre das Filter mit den aktuellen
Einstellungen auf das Bild angewandt worden.

Video-Muster Mit dieser Eigenschaft können Sie einstellen, wie das Bild gerastert werden soll. Hierzu
steht Ihnen eine Auswahl verschiedener Algorithmen zur Verfügung.
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Abbildung 10.147. Eigenschaften für das Filter ”Video“

Additiv Wenn diese Eigenschaft aktiviert ist, wird das Ergebnis des Filters zum Ausgangsbild hinzuad-
diert.

Gedreht Wenn diese Eigenschaft aktiviert ist, wird die Rasterung um 90° gedreht aufgetragen.

10.10.13. Wert propagieren

10.10.13.1. Wirkungsweise

Abbildung 10.148. v.l.n.r.: Originalbild, Wert propagieren angewandt

(a) (b)

Dieses Filter verändert Farbkanten. Es verteilt Pixel, welche einen Wert in dem eingestellten Bereich
haben, in ausgewählte Richtungen. Hierzu werden für jedes Pixel jeweiligen Nachbarpixel betrachtet.
Mit der Eigenschaft Modus können Sie festlegen, nach welchen Kriterien die Pixel propagiert werden.

10.10.13.2. Filteraufruf

Dieses Filter lässt sich über das Menü Filter→ Verzerren→Wert propagieren im Bildfenster aufrufen.

10.10.13.3. Eigenschaften

Vorschau In der Vorschau wird ein Ausschnitt des Bildes so dargestellt, als wäre das Filter mit den
aktuellen Einstellungen auf das Bild angewandt worden.

400



KAPITEL 10. FILTER 10.10. VERZERREN

Abbildung 10.149. Eigenschaften für das Filter ”Wert propagieren“

Modus Die verschiedenen Modi, die Sie für diese Eigenschaft einstellen können, werden anhand des
folgenden Beispiels vorgestellt (8-fach vergrössert):

Abbildung 10.150. Beispielbild

• Mehr Weiss (grösserer Wert): In diesem Modus wird dabei dasjenige Nachbarpixel propa-
giert, welches die grösste Helligkeit hat. Daher werden in diesem Modus helle Bildbereiche
vergrössert.

Abbildung 10.151. Mehr weiss

• Mehr Schwarz (kleinerer Wert): In diesem Modus wird dabei dasjenige Nachbarpixel pro-
pagiert, welches die geringste Helligkeit hat. Daher werden in diesem Modus dunkle Bildbe-
reiche vergrössert.

• Mittlere Werte in den Spitzen: In diesem Modus erhält das propagierte Pixel als Farbwerte
den Mittelwert der Extremwerte.

• Vordergrund in den Spitzen: In diesem Modus werden die propagierten Bereich mit der
aktuellen Vordergrundfarbe gefüllt.
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Abbildung 10.152. Mehr Schwarz

Abbildung 10.153. Mittlere Werte in den Spitzen

• Nur Vordergrund: In diesem Modus werden nur die Bereiche propagiert, welche die aktuelle
Vordergrundfarbe haben.

• Nur Hintergrund: In diesem Modus werden nur die Bereiche propagiert, welche die aktuelle
Hintergrundfarbe haben.

• Mehr Deckung und Mehr Transparenz: In diesen Modi wird jeweils der Nachbarpixel pro-
pagiert, welcher die geringste, respektive höchste Transparenz hat. Hierzu muss das Bild über
einen Transparenzkanal verfügen.

Propagieren

Unterer / Oberer Schwellwert Mit diesen beiden Eigenschaften können Sie den Wertebereich für
die Helligkeit festlegen, in dem die Pixel beim propagieren berücksichtigt werden. Um die
Einstellung der Werte vorzunehmen stehen Ihnen Schieberegler und Eingabefelder zur Verfügung.
Die Werte können im Bereich von 0 bis 255 liegen.

Propagier-Rate Mit dieser Eigenschaft können Sie die Stärke einstellen, mit der propagiert wird.
Je höher der Wert ist, umso stärker ist die Wirkung des Filters.

Nach Links / Rechts / Oben / Unten Mit diesen Kontrollkästchen können Sie steuern in welche
Richtung propagiert wird.

10.10.14. Wellen

10.10.14.1. Wirkungsweise

Mit diesem Filter können Sie einen Effekt erzeugen, welcher Ihr Bild wie eine Wasseroberfläche formt,
in welche ein Stein geworfen wurde. Es werden kreisförmige Wellen aufgetragen.

10.10.14.2. Filteraufruf

Dieses Filter lässt sich über das Menü Filter → Verzerren → Wellen im Bildfenster aufrufen.

Abbildung 10.154. Vordergrund in den Spitzen
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Abbildung 10.155. Nur Vordergrund

Abbildung 10.156. v.l.n.r.: Originalbild, Wellen angewandt

(a) (b)

10.10.14.3. Eigenschaften

Vorschau In der Vorschau wird ein Ausschnitt des Bildes so dargestellt, als wäre das Filter mit den
aktuellen Einstellungen auf das Bild angewandt worden.

Modus Durch die Verzerrung des Bildes entstehen am Rand der Wellen Bildbereiche für die der Inhalt
nicht definiert ist. Mit dieser Eigenschaft bestimmen Sie, wie mit diesen Bereichen verfahren wird.

• Verwischen: Die fehlenden Pixel werden durch die in der Umgebung vorhandenen Bildin-
halte gefüllt. Dabei wird die Farbe verwischt.

• Schwärzen: Die fehlenden Pixel werden durch schwarze Pixel ersetzt.

Reflektierend Wenn diese Eigenschaft eingeschaltet ist, werden die Wellen am Bildrand zurückgeworfen
und mit den ankommenden Wellen überlagert.

Amplitude Mit dieser Eigenschaft können Sie die Höhe der Wellen mit Hilfe eines Schiebereglers oder
des zugeordneten Eingabefeldes im Bereich von 0,0 bis 101,0 einstellen.

Phase Mit dieser Eigenschaft können Sie festlegen mit welcher Phase einer Welle (Wellenberg, Wel-
lental und alles dazwischen) im Zentrum des Bildes begonnen wird. Die Einstellung erfolgt über
einen Schieberegler oder das zugeordnete Eingabefeld im Bereich von 0° bis 360°.

Wellenlänge Mit dieser Eigenschaft können Sie festlegen, wie weit zwei Wellen auseinander liegen.
Diese Einstellung kann über einen Schieberegler oder das zugeordnete Eingabefeld im Bereich
von 0,1 bis 50,0 vorgenommen werden.
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Abbildung 10.157. Eigenschaften für das Filter ”Wellen“

10.10.15. Drehen und Drücken

10.10.15.1. Wirkungsweise

Abbildung 10.158. Anwendungsbeispiel

(a) Originalbild (b) Drehen und Drücken angewandt

Dieses Filter verzerrt das Bild oder die aktuelle Auswahl auf konzentrische Weise.

”Drehen“ ähnelt dem Wirbel der entsteht, wenn Wasser aus einer Badewanne abläuft.
Den Effekt bei ”Drücken“ können Sie sich am besten beschreiben, indem Sie sich das Bild als eine

dehnbare Plastikfolie vorstellen, welche aufgespannt ist und die in der Mitte eingedrückt wird. Das
Bild wird dann zur Mitte hin verzerrt.

10.10.15.2. Filteraufruf

Dieses Filter lässt sich über das Menü Filter → Verzerren → Drehen und Drücken im Bildfenster auf-
rufen.
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Abbildung 10.159. Schematische Darstellung

(a) Gedreht (b) Gedrückt

Abbildung 10.160. Eigenschaften für das Filter ”Drehen und Drücken“

10.10.15.3. Eigenschaften

Vorschau In der Vorschau wird ein Ausschnitt des Bildes so dargestellt, als wäre das Filter mit den
aktuellen Einstellungen auf das Bild angewandt worden.

Drehwinkel Mit dieser Eigenschaft können Sie einstellen, wie stark die Drehung sein soll. Die Einstel-
lung können Sie mittels eines Schiebereglers oder des zugeordneten Eingabefeldes im Bereich von
-360,0° bis 360,0° vornehmen.

Druck Mit dieser Eigenschaft können Sie Richtung und Stärke des Druckes im Bereich von -1,0 bis 1,0
einstellen. Hierzu stehen Ihnen ein Schieberegler und ein Eingabefeld zur Verfügung.

Radius Mit dieser Eigenschaft können Sie einstellen, wie stark der Effekt des Filters ausgeführt wird.
Diese Einstellung können Sie mittels eines Schiebereglers oder des zugeordneten Eingabefeldes
im Bereich zwischen 0,0 und 2,0 einstellen. Bei einem Wert von 2,0 wird das gesamte, bei 1,0 die
Hälfte des Bildes durch das Filter verzerrt.
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10.10.16. Wind

10.10.16.1. Wirkungsweise

Abbildung 10.161. v.l.n.r.: Originalbild, Wind angewandt

(a) (b)

Dieses Filter können Sie verwenden, um eine Bewegungsunschärfe im Bild zu erzeugen. Charakteris-
tisch für dieses Filter ist, das es dünne schwarze oder weisse Linien an die Kanten des Bildes zeichnet.

10.10.16.2. Filteraufruf

Dieses Filter lässt sich über das Menü Filter → Verzerren → Wind im Bildfenster aufrufen.

10.10.16.3. Eigenschaften

Abbildung 10.162. Eigenschaften für das Filter ”Wind“

Vorschau In der Vorschau wird ein Ausschnitt des Bildes so dargestellt, als wäre das Filter mit den
aktuellen Einstellungen auf das Bild angewandt worden.
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Stil

• Wind: Diese Einstellung ist sehr empfehlenswert, wenn Sie einen Bewegungseffekt erzielen
möchten. Sie erzeugt sehr feine Linien.

• Böe: Diese Einstellung ist empfehlenswert, wenn Sie einen Explosionseffekt erzeugen möchten.
Die Linien sind wesentlich stärker.

Richtung Mit dieser Eigenschaft legen Sie fest aus welcher Richtung der Wind kommt. Die möglichen
Einstellungen sind Links und Rechts.

Betroffene Kante

• Führende: Die Linien starten auf der dem Wind zugewandten Seite und weisen in das Objekt
hinein.

• Schließende: Die Linien starten am Ende des Objektes.

• Beide: Mit dieser Einstellung werden sowohl führende, als auch schliessende Kanten berücksichtigt.

Schwellwert Mit dieser Eigenschaft können Sie den Schwellwert einstellen, ab dem die Kanten des
Bildes für den Effekt berücksichtigt werden. Die Einstellung kann mit Hilfe des Schiebereglers
oder über das zugeordnete Eingabefeld im Bereich von 0 bis 50 vorgenommen werden.

Stärke Mit dieser Eigenschaft können Sie die Stärke des Effektes im Bereich von 1 bis 50 einstellen.
Hierzu stehen Ihnen ein Schieberegler, sowie ein Eingabefeld zur Verfügung.

10.11. Künstlerisch

10.11.1. Einführung in die Künstlerischen Filter

Die Filter dieser Kategorie erzeugen verschiedene Effekte, welche an diverse Malstile und -techniken,
wie Kubismus oder Ölgemälde erinnern.

10.11.2. Leinwand

10.11.2.1. Wirkungsweise

Abbildung 10.163. v.l.n.r.: Originalbild, ”Leinwand“ angewandt

(a) (b)

Mit diesem Filter können Sie eine Struktur, ähnlich einer Leinwand, in die aktuelle Ebene oder Aus-
wahl Ihres Bildes einbringen.
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10.11.2.2. Filteraufruf

Dieses Filter lässt sich über das Menü Filter → Künstlerisch → Leinwand im Bildfenster aufrufen.

10.11.2.3. Eigenschaften

Abbildung 10.164. Eigenschaften für das Filter ”Leinwand“

Vorschau Dieses Filter stellt Ihnen eine kleines Vorschaufenster zur Verfügung, in dem Sie die Wirkung
der aktuellen Einstellungen der Filtereigenschaften ansehen können, ohne das Filter bereits direkt
auf das Bild angewendet zu haben.

Richtung Mit dieser Eigenschaft können Sie einstellen in welcher Richtung das Zeichnen der Leinwand
beginnt.

Tiefe Mit dieser Eigenschaft können Sie die Tiefe der Struktur einstellen. Hierzu stehen Ihnen ein Schie-
beregler sowie ein Eingabefeld zur Verfügung. Die Werte können im Bereich von 1 (sehr flach) bis
50 (extrem tief) eingestellt werden.

10.11.3. Cartoon

10.11.3.1. Wirkungsweise

Dieses Filter verändert die aktive Ebene oder eine Auswahl so, dass diese wie ein Cartoon aussieht.
Das Ergebnis ähnelt einer Zeichnung, welche farbig schattiert wurde. Dieser Effekt wird erreicht, indem
Bildbereich die bereits erkennbar dunkler sind als ihre Umgebung, weiter abgedunkelt werden.

10.11.3.2. Filteraufruf

Dieses Filter lässt sich über das Menü Filter → Künstlerisch → Cartoon im Bildfenster aufrufen.
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Abbildung 10.165. v.l.n.r.: Originalbild, Cartoon angewandt

(a) (b)

Abbildung 10.166. Eigenschaften für das Filter ”Cartoon“

10.11.3.3. Eigenschaften

Vorschau Dieses Filter stellt Ihnen eine kleines Vorschaufenster zur Verfügung, in dem Sie die Wirkung
der aktuellen Einstellungen der Filtereigenschaften ansehen können, ohne das Filter bereits direkt
auf das Bild angewendet zu haben.

Masken Radius Mit dieser Eigenschaft können Sie die Grösse der Flächen einstellen, mit denen das
Filter arbeitet. Sie können den Wert über einen Schieberegler, oder das zugeordnete Eingabefeld im
Bereich von 1,0 bis 50,0 einstellen. Grosse Werte führen zu sehr breiten schwarzen Rändern und es
werden wenige Details dargestellt. Kleine Werte führen zu wesentlich unauffälligeren schwarzen
Zeichenstrichen und es bleiben wesentlich mehr Details erhalten.

Schwarzanteil (%) Mit dieser Eigenschaft können Sie unter Verwendung eines Schiebereglers oder des
zugeordneten Eingabefeldes, die Menge an schwarzer Farbe einstellen, die dem Bild hinzugefügt
wird. Die Einstellung können Sie im Bereich von 0,0 bis 1,0 vornehmen. Kleine Werte führen zu
weicheren Übergängen zwischen farbigen und den schwarzen Bildbereichen. Ausserdem sind
dünnere und unauffälligere Kanten das Ergebnis. Verwenden Sie hingegen grössere Werte, so
werden diese Linien dicker, dunkler und schärfer. Die natürlichsten Ergebnisse erreichen Sie mit
Werten aus dem mittleren Bereich.
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10.11.4. Kubismus

10.11.4.1. Wirkungsweise

Abbildung 10.167. v.l.n.r.: Originalbild, Kubismus angewandt

(a) (b)

Dieses Filter verändert das Bild so, als wäre es aus vielen kleinen quadratischen, halbtransparenten
Stücken Seidenpapiers zusammengesetzt.

TIPP

Wenn Ihnen die Einstellungsmöglichkeiten dieses Filters nicht genügen, schauen
Sie sich das Filter GIMPressionist an. Mit diesem können Sie ähnliche Effekte
erzeugen, allerdings bietet es Ihnen eine grössere Fülle von Eigenschaften und
Variationsmöglichkeiten.

10.11.4.2. Filteraufruf

Dieses Filter lässt sich über das Menü Filter → Künstlerisch → Kubismus im Bildfenster aufrufen.

10.11.4.3. Eigenschaften

Vorschau Dieses Filter stellt Ihnen eine kleines Vorschaufenster zur Verfügung, in dem Sie die Wirkung
der aktuellen Einstellungen der Filtereigenschaften ansehen können, ohne das Filter bereits direkt
auf das Bild angewendet zu haben.

Kachelgrösse Diese Eigenschaft des Filters bestimmt die Grösse der Quadrate aus denen das Bild zu-
sammengesetzt wird. Die Einstellung können Sie über einen Schieberegler oder das zugeordnete
Eingabefeld im Bereich von 0,0 bis 100,0 Pixel vornehmen.

Kachel-Sättigung Mit dieser Eigenschaft können Sie einstellen wie intensiv die Quadrate, aus denen
das Bild zusammengesetzt wird, gefärbt sind. Dies beeinflusst auch die Deckkraft der Flächen.
Die Einstellung können Sie mit Hilfe eines Schiebereglers oder des zugeordneten Eingabefeldes
im Bereich von 0,0 bis 10,0 vornehmen. Ein hoher Wert wird zu sehr intensiv gefärbten und we-
nig durchsichtigen Flächen führen. Im Gegensatz dazu führt ein niedriger Wert zu zart gefärbte
Flächen, die durchscheinend sind. Wird der Wert auf 0 gesetzt und die Eigenschaft Hintergrund-
farbe verwenden nicht aktiviert, wird die gesamte Ebene schwarz, beziehungsweise transparent,
sofern ein Alphakanal vorhanden ist.
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Abbildung 10.168. Eigenschaften für das Filter ”Kubismus“

Hintergrundfarbe verwenden Wenn Sie diese Eigenschaft aktiviert haben, werden die Stellen an wel-
chem bei einem niedrigen Wert für die Kachel-Sättigung der Hintergrund durchscheint, mit der
aktuellen Hintergrundfarbe gefüllt. Anderenfalls werden diese Bildbereiche entweder schwarz,
oder, sofern die Ebene über einen Alphakanal verfügt, transparent.

TIPP

Sie können dieses Filter sehr gut verwenden, um Hintergrundbilder für Web-
seiten und ähnliches zu erstellen. Erzeugen Sie hierzu zunächst ein Bild mit
wenigen Farben auf einem kleinen Bild. Wenden Sie dann das Filter mit den
gewünschten Einstellungen an. In einem letzten Schritt machen Sie mittels des
Filters Filter → Abbilden → Nahtlos machen ein nahtloses Kacheln des Bildes
möglich.

10.11.5. GIMPressionist

10.11.5.1. Wirkungsweise

Dieses Filter ist der König unter den Filtern der Kategorie ”Künstlerisch“. Sie können damit die Effekte
der Filter Kubismus und Leinwand nachbilden. Das Filter gibt Ihren Bild den Anschein, als wäre es mit
einem frei gewählten Pinsel auf eine Leinwand Ihrer Wahl gemalt. Sie können es auf eine Ebene oder
Auswahl anwenden.

10.11.5.2. Filteraufruf

Dieses Filter lässt sich über das Menü Filter → Künstlerisch → GIMPressionist im Bildfenster aufru-
fen.

10.11.5.3. Eigenschaften

Vorschau Dieses Filter stellt Ihnen eine kleines Vorschaufenster zur Verfügung, in dem Sie die Wirkung
der aktuellen Einstellungen der Filtereigenschaften ansehen können, ohne das Filter bereits direkt
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Abbildung 10.169. v.l.n.r.: Originalbild, GIMPressionist angewandt

(a) (b)

auf das Bild angewendet zu haben. Durch einen Klich auf die Schaltfläche Neu zeichnen können
Sie den Inhalt des Vorschaubereiches aktualisieren. Über die Schaltfläche Rücksetzen können Sie
das Vorschaubild auf das Orginalbild zurücksetzen.

Abbildung 10.170. Eigenschaften (Voreinstellungen) für das Filter ”GIMPressionist“
Reiter Voreinstellungen

Das Filter ”GIMPressionist“ verfügt über eine Vielzahl von Eigenschaften. Wenn Sie die dafür
möglichen Einstellungen miteinander kombinieren, erhalte Sie eine astronomische Anzahl von
Möglichkeiten. Daher ist es wichtig, dass Sie, wenn Sie eine interessante Kombination gefunden
haben, diese speichern können, um sie später genau so wieder anwenden zu können. Die gespei-
cherten Einstellungen stehen in einer Auswahlliste zur Verfügung.

• Einstellungen speichern: Mit dieser Schaltfläche könne Sie die aktuellen Einstellungen des
Filters unter einem frei wählbaren Namen speichern. Den Namen können Sie in das Einga-
befeld links neben der Schaltfläche eintragen.

• Anwenden: Mit dieser Schaltfläche können Sie die in der Auswahlliste aktivierte Einstellung
laden.

• Löschen: Mit dieser Schaltfläche können Sie eine gespeicherte Einstellung Löschen. Bitte
beachten Sie, dass Sie nur selbst gespeicherte Einstellungen löschen können.

412



KAPITEL 10. FILTER 10.11. KÜNSTLERISCH

• Aktualisieren: Mit dieser Schaltfläche können Sie die Auswahlliste aktualisieren.

Abbildung 10.171. Eigenschaften (Papier) für das Filter ”GIMPressionist“

Reiter Papier

In diesem Reiter finden Sie die Eigenschaften des Filters, welche die Oberfläche des Materials
beschreiben auf dem die Farbe aufgetragen wird.

Invertieren Wenn Sie diese Eigenschaft aktivieren, wird der Höheneffekt der Oberflächenstruktur
umgekehrt. Aus Vertiefungen werden Erhöhungen und umgekehrt.

Überlagern Wenn Sie diese Eigenschaft aktivieren, wird die gewählte Oberflächenstruktur wie
ein halbdurchsichtiges Papier über das Bild gelegt, ohne dass die Struktur auf das Bild übertragen
wird.

Skalierung Mit dieser Eigenschaft können Sie einstellen, wie die Oberflächentextur auf das Bild
skaliert wird. Die Einstellung können Sie über einen Schieberegler oder das zugeordnete Ein-
gabefeld im Bereich von 3,0% bis 150,0% vornehmen. Bei einer Einstellung von 100% wird
das Muster in der Grösse im Bild eingefügt, in der es auch in der Vorschau sichtbar ist.

Relief Mit dieser Eigenschaft können Sie beeinflussen, wie stark die Struktur im Bild wirken soll.
Die Einstellung können Sie mittels eines Schiebereglers oder des zugeordeten Eingabefeldes
im Bereich von 0,0 bis 100,0 vornehmen.

In diesem Reiter finden Sie verschiedene Eigenschaften, mit denen Sie einstellen können ”womit“
die Farbe aufgetragen wird. Pinsel ist da ein nicht ganz treffender Begriff, da die Möglichkeiten
weit über die eines herkömmlichen Pinsels hinausgehen. Wie schon im Reiter Papier, steht Ihnen
auch in diesem Bereich eine Auswahlliste zur Verfügung, welche verschieden Pinseltypen enthält
und erweitert werden kann.

Gamma Mit dieser Eigenschaft können Sie mittels eines Schiebereglers den Gammawert des Pin-
sels einstellen. Die Auswirkung der Einstellung können Sie im Vorschaufenster des Pinsels
kontrollieren.
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Abbildung 10.172. Eigenschaften (Pinsel) für das Filter ”GIMPressionist“

Reiter Pinsel

Auswählen Sie können als Pinsel auch ein Bild verwenden. Hierzu finden Sie die aktuell geöffneten
Bilder in einem Klappmenü. Grosse Bilder sind für diesen Zweck naturgemäss nicht so gut
geeignet.
Wenn das aktuelle Bild aus mehreren Ebenen besteht, so bekommen Sie diese ebenfalls im
Klappmenü zur Auswahl angeboten und können diese als Pinsel einstellen.
Über die Schaltfläche Speichern unter haben Sie die Möglichkeit, den ausgewählten Pinsel
zu speichern. Hierzu öffnet sich nach Betätigung der Schaltfläche ein Dateiauswahldialog.

Seitenverhältnis Mit dieser Eigenschaft können Sie das Verhältnis der Höhe zur Breite des Pin-
sels einstellen. Hierzu stehen Ihnen ein Schieberegler sowie ein Eingabefeld zur Verfügung.
Die Einstellung kann im Bereich von -1,0 bis 1,0 vorgenommen werden. Eine Einstellung von
-1,0 entspricht einer starken horizontalen Stauchung, 1,0 im Gegensatz dazu einer extremen
vertikalen Stauchung. Die Auswirkung der aktuellen Einstellung können Sie im Vorschau-
fenster des Pinsels kontrollieren.

Relief Mit dieser Eigenschaft können Sie die Stärke einstellen, mit welcher die Pinselkonturen in
das Bild eingebracht werden.

In diesem Reiter können Sie die Orientierung der Pinselstriche beeinflussen, mit denen das Bild
durch das Filter gemalt wird. Die einzelnen Pinselstriche werden nicht in immer der gleichen
Richtung ausgeführt. Um verschiedene Effekte zu erzeugen, wird die Richtung variiert.

Richtungen Mit dieser Eigenschaft wird die Anzahl der Pinselstriche eingestellt, die über jede
Stelle des Bildes einwirken. Dabei wird jedesmal ein Pinselstrich in einer anderen Richtung
aufgetragen. Die Einstellung können Sie unter Verwendung eines Schiebereglers order des
zugeordneten Eingabefeldes im Bereich 1 von bis 30 eingestellt werden.

Startwinkel Mit dieser Eigenschaft können Sie eine Hauptrichtung festlegen, in der die Pinsel-
striche ausgeführt werden sollen. Eine solche Richtung wird oftmals eingestellt, um den Ein-
druck von Bewegung im Bild zu erzeugen. Die Einstellung können Sie mit Hilfe eines Schie-
bereglers oder des zugeordneten Eingabefeldes im Bereich von 0° bis 360° vornehmen.
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Abbildung 10.173. Eigenschaften (Orientierung) für das Filter ”GIMPressionist“
Reiter Orientierung

Winkelgrösse Mit dieser Eigenschaft können Sie einstellen, innerhalb welchen Winkels die Ori-
entierung der Pinstelstriche variiert wird. Die Einstellung kann mittels eines Schiebereglers
oder des zugeordneten Eingabefeldes im Bereich von 0° bis 360° erfolgen.

Orientierung Mit dieser Eigenschaft legen Sie fest, nach welchem Kriterium die Richtung der
Pinselstriche bestimmt wird.

• Wert: Die Richtung der Pinselstriche wird auf Basis der Helligkeitswerte ermittelt.
• Radius: Die Richtung der Pinselstriche wird durch den Abstand des Pinselstriches zum

Bildzentrum bestimmt.
• Zufällig: Die Richtung der Pinselstriche ist zufällig.
• Radial: Die Pinselstriche werden vom Bildzentrum ausgehend nach aussen gemalt.
• Fliessend: Diese Einstellung hat keinen direkten Einfluss auf die Richtung. Sie bewirkt

ein Malen mit fliessenden Pinselstrichen.
• Farbton: Die Richtung der Pinselstriche wird durch die Farbwerte bestimmt.
• Anpassend: Die Richtung der Pinselstriche wird durch die Ähnlichkeit des Pinsels und

der entsprechenden Bildregion bestimmt.
• Manuell: Bei dieser Einstellung können Sie über die Schaltfläche Bearbeiten den Orientation-

Map Editor öffnen und dort weitere Einstellungen vornehmen.

In diesem Reiter können Sie alle Einstellungen vornehmen, welche die Grösse des Pinsels beein-
flussen.

Grössen, Min. Grösse, Max. Grösse

• Grössen: Mit dieser Eigenschaft können Sie einstellen wieviele verschiedene Pinsel-
grössen durch das Filter verwendet werden. Die Einstellung kann mit Hilfe eines Schie-
bereglers oder des zugeordneten Eingabefeldes im Bereich von 1 bis 30 vorgenommen
werden.

• Min. Grösse und Max. Grösse: Mit diesen beiden Eigenschaften legen Sie fest, in wel-
chem Bereich die Grösse der Pinsel variiert wird. Die Einstellungen erfolgen jeweils über
Schieberegler oder die zugeordneten Eingabefelder im Bereich von 0 bis 360.
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Abbildung 10.174. Eigenschaften (Grösse) für das Filter ”GIMPressionist“

Reiter Grösse

Grösse Mit dieser Eigenschaft legen Sie fest, auf Basis welches Kriteriums die Pinselgrössen va-
riiert werden.

• Wert: Der Helligkeitswert bestimmt die Grösse des Pinsels.
• Radius: Die Entfernung des Striches zum Bildmittelpunkt bestimmt die Grösse des Pin-

sels.
• Zufällig: Der Zufall bestimmt die Grösse des Pinsels.
• Radial: Die Richtung zum Bildzentrum bestimme die Pinselgrösse.
• Fliessend: Die Grösse des Pinsels ist fliessend.
• Farton: Der Farbwert bestimmt die Grösse des Pinsels.
• Anpassend: Die Grösse des Pinsels wird an die Bildgegebenheiten angepasst.
• Manuell: Unter Verwendung der Schaltfläche Bearbeiten können Sie mit Hilfe des Grössen-

Map Editors weitere Einstellungen vornehmen.

In diesem Reiter können Sie die Eigenschaften einstellen, die bestimmen wie die Pinselstriche im
Bild verteilt werden.

Platzierung Die Platzierung der Pinselstriche kann nach zwei verschiedenen Methoden erfolgen:

• Zufällig: In dieser Einstellung werden die Pinselstriche zufällig verteilt. Dies führt zu
einer sehr realistischen Darstellung.

• Gleichmässig verteilt: Wenn Sie diese Einstellung wählen, werden die Pinselstriche
gleichmässig im Bild verteilt.

Strichdichte Mit dieser Eigenschaft legen Sie fest, wie dicht die Pinselstricht im Bild erscheinen.
An den nicht durch einen Pinselstrich überdeckten Stellen scheint das Papier durch.

Am Mittelpunkt orientieren Wenn diese Eigenschaft aktiviert ist, erfolgt die Platzierung der Pin-
selstriche um das Bildzentrum herum.

In diesem Reiter legen Sie fest, mit welcher Farbe die Pinselstriche ausgeführt werden.
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Abbildung 10.175. Eigenschaften (Platzierung) für das Filter ”GIMPressionist“
Reiter Platzierung

Farbe Mit dieser Eigenschaft legen Sie fest, wie die Farbe bestimmt wird, mit der der Pinselstrich
ausgeführt wird. Es stehen hierzu zwei Methoden zur Auswahl:

• Mittelwert unter dem Pinsel: In dieser Einstellung wird die Farbe aus dem Mittelwert
der Farbwerte im entsprechenden Bereich des Originalbildes bestimmt.

• Mitte des Pinsels: Wenn Sie diese Einstellung aktivieren, wird die Farbe aus der Mitte
des betroffenen Bereiches im Originalbild bestimmt.

Farb-Rauschen Mit dieser Eigenschaft können Sie bestimmen, wie homogen die Pinselstriche in
farblicher Hinsicht sein werden. Die Einstellung können Sie über einen Schieberegler oder
das zugeordnete Eingabefeld im Bereich von 0 bis 100 vornehmen.

In diesem Reiter können Sie einige allgemeine Eigenschaften des Filters einstellen.

Hintergrund Mit dieser Eigenschaft bestimmen Sie, wie die Bereiche des Bildes aussehen sollen,
die nicht durch Pinselstriche überdeckt sind. Sie haben hierfür folgende Möglichkeiten zur
Auswahl:

• Original beibehalten: In dieser Einstellung wird das Originalbild als Hintergrund ver-
wendet.

• Vom Papier: Wenn Sie diese Einstellung aktiviert haben, verwendet das Filter die Textur
des ausgewählten Papiers als Hintergrund.

• Einfarbig: In dieser Einstellung wird der Hintergrund einfarbig gestaltet. Die Farbe, wel-
che hierzu verwendet wird, können Sie nach einem Klick auf die farbige Schaltfläche
einstellen.

• Transparent: Wenn Sie diese Einstellung wählen, werden die Pinselstriche auf einen
transparenten Hintergrund aufgebracht. Bitte beachten Sie, dass diese Einstellung nur
verfügbar ist, wenn das Bild über einen Alphakanal verfügt.

Kanten zeichnen Wenn Sie diese Eigenschaft aktivieren, wird an den Rändern des Bildes eine
schmale Kante gezeichnet.
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Abbildung 10.176. Eigenschaften (Farbe) für das Filter ”GIMPressionist“

Reiter Farbe

Nahtlos Wenn Sie diese Eigenschaft aktiviert haben, wird das Bild, welches das Filter malt, naht-
los anneinander passen. Sie können es jeweils oben und unten bzw. links und rechts anein-
andersetzen, ohne das die Bildkante sichtbar wird.

Dop-Shadow Wenn Sie diese Eigenschaft aktiviert haben, wird jeder Pinselstrich einen kleinen
Schatten in das Bild werfen.

Am Rand verdunkeln Mit dieser Eigenschaft können Sie einstellen, wie stark die Ränder eines
Pinselstriches abgedunkelt werden. Die Einstellung können Sie mit einem Schieberegler oder
dem zugeordneten Eingabefeld im Bereich von 0,0 bis 1,0 vornehmen. Ein hoher Wert führt
zu dem Eindruck einer dicken Farbschicht.

Dunkelheit des Schattens Über einen Schieberegler oder das zugeordnete Eingabefeld können
Sie im Bereich von 0,0 bis 99,0 die Dunkelheit des Schattens einstellen.

Tiefe des Schattens Mit dieser Eingenschaft können Sie einstellen, wie weit der Schlagschatten
vom Objekt entfernt sein wird. Die Einstellung könenn Sie mit Hilfe eines Schiebereglers oder
des zugeordneten Eingabefeldes im Bereich von 0 bis 99 vornehmen.

Weiche des Schattens Mit dieser Eigenschaft können Sie einstellen, wie weich der verwende-
te Schlagschatten sein wird. Die Einstellung können Sie mit einem Schieberegler, oder dem
zugeordeten Eingabefeld im Bereich von 0 bis 99 vornehmen.

Abweichgungs-Schwellwert Mit dieser Eigenschaft können Sie den Schwellwert für die Abwei-
chung der Anpassung einstellen. Die Einstellung kann im Bereich von 0,0 bis 1,0 unter Ver-
wendung eines Schiebereglers oder Eingabefeldes vorgenommen werden.

10.11.6. GIMPressionist - Orientation-Map Editor

10.11.6.1. Überblick

Der Orientation-Map Editor ist Bestandteil des Filters GIMPressionist. Er dient Ihnen zur Einstellung
der Richtung in der die Pinselstriche ausgeführt werden, mit denen das Filter das Bild malt.

418



KAPITEL 10. FILTER 10.11. KÜNSTLERISCH

Abbildung 10.177. Eigenschaften (Allgemein) für das Filter ”GIMPressionist“

Reiter Allgemein

10.11.6.2. Eigenschaften

Abbildung 10.178. Eigenschaften des Dialoges ”Orient-Map Editor“

Vektoren In diesem Bereich können Sie die Vektoren bearbeiten, welche die Richtung der Pinselstriche
für diesen Bildbereich vorgeben. Die Vektoren werden als kleine Striche dargestellt, welche einen
Ankerpunkt (weiss) und eine Stärke für eine bestimmte Richtung vorgeben. Die Stärke wird dabei
durch die Länge des Vektors dargestellt. Der aktive Vektor wird rot dargestellt.

Durch Betätigen der Schaltfläche Hinzufügen können Sie neue Vektoren einsetzen. Alternativ
können Sie durch Klicken mit der Mittleren Maustaste neue Vektoren an einer beliebigen Stelle
hinzufügen.

Durch einen Klick mit der Linken Maustaste wird der aktive Vektor an die Stelle des Bildes ver-
schoben, welche Sie angeklickt haben.

Ein Klick mit der Rechten Maustaste legt die Richtung des aktuellen Vektors fest.
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Mit den Schaltflächen << und >> können Sie den aktiven Vektor wechseln.

Wenn Sie die Schaltfläche Entfernen betätigen, wird der aktuelle Vektor gelöscht.

TIPP

Mit dem Schieberegler neben dem Vorschaubild können Sie die Helligkeit
des Bildes einstellen. Dies kann sehr nützlich sein, wenn das Bild sehr hell
ist und Sie die Vektoren sehr schlecht erkennen können.

Vorschau In diesem Vorschaufenster werden für das gesamte Bild die aktuellen Richtungen der Pin-
selstriche angezeigt.

Typ Sie haben mit dieser Eigenschaft die Möglichkeit zu bestimmen, wie aus den von Ihnen erzeug-
ten Vektoren ein Vektorfeld erzeugt wird, welches für jeden Bereich des Bildes eine Richtung für
die Pinselstriche enthält. Die verschiedenen Einstellungen haben sehr komplexe Wirkungsmecha-
nismen, daher ist es am leichtesten die verschiedenen Möglichkeiten auszuprobieren und in der
Vorschau zu begutachten.

Voronoi Ein Varonoi Diagramm zerteilt eine Fläche mit n Hauptpunkten in n Poygone. Dabei hat jedes
der Polygone einen Hauptpunkt und jeder Punkt des Polygons ist näher an diesem Hauptpunkt
als an jedem anderen. Daher ist die Grenze für jedes Poygon die halbe Entfernung zwischen zwei
Hauptpunkten. Die folgende Abbildung enthält ein Beispiel:

Wenn diese Eigenschaft aktiviert ist, beeinflusst nur der Vektor, welcher einem bestimmten Punkt
am nächsten ist diesen Punkt.

Winkel Mit dieser Eigenschaft legen Sie die Richtung des aktiven (also rot markierten) Vektors fest.
Sie können Die Einstellung mit Hilfe eines Schiebereglers oder des zugeordneten Eingabefeldes
im Bereich von 0° bis 360° vornehmen. Alternativ haben Sie die Möglichkeit die Richtung durch
einen Klick mit der Rechten Maustaste festzulegen.

Winkel-Versatz Mit dieser Eigenschaft haben Sie die Möglichkeit die Richtung aller Vektoren zu verändern.
Die Einstellung können Sie mit Hilfe eines Schiebereglers oder des zugeordneten Eingabefeldes
im Bereich von 0° bis 360° vornehmen. Eine Vergrößerung des Wertes führt zu einer Drehung im
Uhrzeigersinn.

Stärke Mit dieser Eigenschaft können Sie die Stärke des Vektors einstellen. Durch seine Stärke beein-
flusst der Vektor die ihn umgebenden Vektoren.Die Einstellung können Sie über einen Schiebe-
regler oder mit Hilfe des zugeordneten Eingabefeldes im Bereich von 0,1 bis 5,0 vornehmen. In
Abhängigkeit von seiner Stärke wird der Vektor mit verschiedenen Längen dargestellt.

Stärke Exp. Mit dieser Eigenschaft können Sie die Stärke aller Vektoren, und damit die Stärke aller Pin-
selstriche beeinflussen. Die Einstellung wird mit Hilfe eines Schiebereglers oder des zugeordneten
Eingabefeldes im Bereich von 0,1 bis 10,9 vorgenommen.
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10.11.7. GIMPressionist - Size-Map Editor

10.11.7.1. Überblick

Der Size-Map Editor ist Bestandteil des Filters GIMPressionist. Er dient Ihnen zur Einstellung der Grösse
in der die Pinselstriche ausgeführt werden, mit denen das Filter das Bild malt.

10.11.7.2. Eigenschaften

Abbildung 10.179. Eigenschaften des Dialoges ”Grössen-Map Editor“

Sm-Vektoren In diesem Bereich können Sie die Vektoren bearbeiten, welche die Grösse der Pinselstri-
che für diesen Bildbereich vorgeben. Die Vektoren werden als kleine Kreuze dargestellt. Der aktive
Vektor wird rot dargestellt.

Durch Betätigen der Schaltfläche Hinzufügen können Sie neue Vektoren einsetzen. Alternativ
können Sie durch Klicken mit der Mittleren Maustaste neue Vektoren an einer beliebigen Stelle
hinzufügen.

Durch einen Klick mit der Linken Maustaste wird der aktive Vektor an die Stelle des Bildes ver-
schoben, welche Sie angeklickt haben.

Mit den Schaltflächen << und >> können Sie den aktiven Vektor wechseln.

Wenn Sie die Schaltfläche Entfernen betätigen, wird der aktuelle Vektor gelöscht.

TIPP

Mit dem Schieberegler neben dem Vorschaubild können Sie die Helligkeit
des Bildes einstellen. Dies kann sehr nützlich sein, wenn das Bild sehr hell
ist und Sie die Vektoren sehr schlecht erkennen können.

Vorschau In diesem Vorschaufenster werden für das gesamte Bild die aktuellen Grössen und Stärken
der Pinselstriche angezeigt.

Grösse Mit dieser Eigenschaft können Sie die Grösse der Pinselstriche einstellen. Hierzu stehen Ihnen
ein Schieberegler, sowie ein Eingabefeld zur Verfügung. Der Wert kann zwischen 0,0 und 100,0
eingestellt werden.
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Stärke Mit dieser Eigenschaft können Sie die Stärke des Vektors einstellen. Durch seine Stärke beein-
flusst der Vektor die ihn umgebenden Vektoren.Die Einstellung können Sie über einen Schiebereg-
ler oder mit Hilfe des zugeordneten Eingabefeldes im Bereich von 0,1 bis 5,0 vornehmen.

Stärke Exp. Mit dieser Eigenschaft können Sie den Exponent der Stärke einstellen. Hierzu stehen Ihnen
ein Schieberegler sowie ein Eingabefeld zur Verfügung. Die Einstellung können Sie im Bereich von
0,1 bis 10,9 vornehmen.

Voronoi Ein Varonoi Diagramm zerteilt eine Fläche mit n Hauptpunkten in n Poygone. Dabei hat jedes
der Polygone einen Hauptpunkt und jeder Punkt des Polygons ist näher an diesem Hauptpunkt
als an jedem anderen. Daher ist die Grenze für jedes Poygon die halbe Entfernung zwischen zwei
Hauptpunkten. Die folgende Abbildung enthält ein Beispiel:

Wenn diese Eigenschaft aktiviert ist, beeinflusst nur der Vektor, welcher einem bestimmten Punkt
am nächsten ist diesen Punkt.

10.11.8. Ölgemälde

10.11.8.1. Wirkungsweise

Abbildung 10.180. v.l.n.r.: Originalbild, Ölgemälde angewandt

(a) (b)

Dieses Filter ermöglicht es Ihnen Ihr Bild wie ein Ölgemälde erscheinen zu lassen. Die Eigenschaft
Maskengrösse bestimmt dabei wesentlich das Ergebnis. Ein grosser Wert führt zu wenigen Details,
als wäre mit einem sehr grossen Pinsel gemalt worden.
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TIPP

Wenn Ihnen die Einstellungsmöglichkeiten dieses Filters nicht genügen, schauen
Sie sich das Filter GIMPressionist an. Mit diesem können Sie ähnliche Effekte
erzeugen, allerdings bietet es Ihnen eine grössere Fülle von Eigenschaften und
Variationsmöglichkeiten.

10.11.8.2. Filteraufruf

Dieses Filter lässt sich über das Menü Filter → Künstlerisch → Ölgemälde im Bildfenster aufrufen.

10.11.8.3. Eigenschaften

Abbildung 10.181. Eigenschaften für das Filter ”Ölgemälde“

Vorschau Dieses Filter stellt Ihnen eine kleines Vorschaufenster zur Verfügung, in dem Sie die Wirkung
der aktuellen Einstellungen der Filtereigenschaften ansehen können, ohne das Filter bereits direkt
auf das Bild angewendet zu haben.

Maskengrösse Mit dieser Eigenschaft legen Sie die Grösse des Pinsels fest, mit dem das Bild gemalt
wird. Ein grosser Wert verstärkt den ”öligen“ Eindruck. Die Einstellung können Sie mit Hilfe eines
Schiebereglers oder des zugeordneten Eingabefeldes im Bereich von 3 bis 50 vornehmen.

Intensitäts-Algorithmus verwenden Wenn Sie diese Eigenschaft aktivieren, bleiben Bilddetails und
Farben besser erhalten.

10.11.9. Fotokopiie

10.11.9.1. Wirkungsweise

Mit diesem Filter können Sie Ihrem Bild das Aussehen einer Fotokopie geben. Es stehen Ihnen verschie-
dene Eigenschaften zur Verfügung, um den Effekt nach Ihren Wünschen zu gestalten.

10.11.9.2. Filteraufruf

Dieses Filter lässt sich über das Menü Filter → Künstlerisch → Fotokopie im Bildfenster aufrufen.
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Abbildung 10.182. v.l.n.r.: Originalbild, Fotokopie angewandt

(a) (b)

10.11.9.3. Eigenschaften

Abbildung 10.183. Eigenschaften für das Filter ”Fotokopie“

Vorschau Dieses Filter stellt Ihnen eine kleines Vorschaufenster zur Verfügung, in dem Sie die Wirkung
der aktuellen Einstellungen der Filtereigenschaften ansehen können, ohne das Filter bereits direkt
auf das Bild angewendet zu haben.

Masken Radius Mit dieser Eigenschaft können Sie einstellen, wie stark das Filter wirkt. Die Einstellung
können Sie über einen Schieberegler oder das zugeordnete Eingabefeld vornehmen. Der Wert kann
im Bereich von 3,0 bis 50,0 Pixel liegen.

Schärfe Mit dieser Eigenschaft können Sie einstellen, wie scharf die Fotokopie sein soll. Die Einstellung
können Sie über einen Schieberegler oder das zugeordnete Eingabefeld im Bereich von 0,0 bis 1,0
vornehmen.
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Schwarz (%) Mit dieser Eigenschaft können Sie den Prozentsatz der abgedunkelten Pixel einstellen,
die geschwärzt werden. Die Einstellung können Sie im Bereich von 0,0 bis 1,0 mit Hilfe eines
Schiebereglers oder des zugeordneten Eingabefeldes vornehmen.

Weiss (%) Mit dieser Eigenschaft können Sie den Prozentsatz der aufgehellten Pixel einstellen, die
weiss gefärbt werden. Die Einstellung können Sie im Bereich von 0,0 bis 1,0 mit Hilfe eines Schie-
bereglers oder des zugeordneten Eingabefeldes vornehmen.

10.11.10. Warmes Glühen

10.11.10.1. Wirkungsweise

Abbildung 10.184. v.l.n.r.: Originalbild, Warmes Glühen angewandt

(a) (b)

Dieses Filter erzeugt im Bild ein weiches Leuchten. Dieser Effekt wird durch die Verstärkung der
hellen Bildbereiche und eine gleichzeitige Weichzeichnung hervorgerufen.

10.11.10.2. Filteraufruf

Dieses Filter lässt sich über das Menü Filter → Künstlerisch → Warmes Glühen im Bildfenster aufru-
fen.

10.11.10.3. Eigenschaften

Vorschau Dieses Filter stellt Ihnen eine kleines Vorschaufenster zur Verfügung, in dem Sie die Wirkung
der aktuellen Einstellungen der Filtereigenschaften ansehen können, ohne das Filter bereits direkt
auf das Bild angewendet zu haben.

Leuchtradius Mit dieser Eigenschaft können Sie die Stärke des Leuchteffektes einstellen. Hierzu ste-
hen Ihnen, wie bei allen Eigenschaften dieses Filters, ein Schieberegler und ein Eingabefeld zur
Verfügung. Der Wert kann im Bereich von 1,0 bis 50,0 Pixel liegen.

Helligkeit Mit dieser Eigenschaft können Sie die Helligkeit des Leuchtens einstellen. Mit dem Wert,
welchen Sie im Berich von 0,0 bis 1,0 einstellen können, bestimmen Sie wie stark die hellen Bild-
bereiche verstärkt werden.

Schärfe Mit dieser Eigenschaft können Sie einstellen, wie kontrolliert oder diffus der Leuchteffekt sein
soll. Der Wert muss im Bereich zwischen 0,0 und 1,0 liegen. Ein Wert von 0,0 bewirkt einen sehr
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Abbildung 10.185. Eigenschaften für das Filter ”Warmes Glühen“

lokal beschränkten Leuchteffekt, während bei einer Einstellung von 1,0 ein sehr weit über das Bild
verteilter, diffuser Effekt entsteht.

10.12. Render

10.12.1. Einführung in die Renderfilter

Während die meisten Filter in GIMP auf der Basis von Ebenen arbeiten und diese transformieren, ver-
halten sich die Filter dieser Gruppe anders. Sie erzeugen Muster, in der Regel vernichten sie dabei alles
was sich zuvor in der Ebene befand. Einige erzeugen Zufalls- oder Rauschmuster, andere geordnete
oder fraktale Muster.

10.12.2. Plasma

10.12.2.1. Wirkungsweise

Abbildung 10.186. v.l.n.r.: Originalbild, Plasma angewandt

(a) (b)

Mit diesem Filter können Sie farbige Wolken erzeugen. Hierzu stehen Ihenen einige Eigenschaften
zur Verfügung, um das Ergebnis Ihren Wünschen entsprechend zu gestalten.
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Alle Farben die durch das Filter verwendet werden sind komplett gesättigt. Gelegentlich kann diese
sehr starke Färbung unerwünscht sein. In einem solchen Fall hilft es, wenn Sie die Farbsättigung mittels
Ebene → Farben → Sättigung entfernen reduzieren.

ANMERKUNG

Inzwischen verfügt GIMP über ein neues Filter zu Erzeugung von Farbwolken.
Dieses neue Filter (Plasma2) stellt Ihnen weitaus mehr Eigenschaften zur Sei-
te, um den Effekt an Ihre Vorstellungen anzupassen. Leider ist das Filter noch
nicht Bestandteil der Standardversion von GIMP, Sie können es jedoch im GIMP
Plug-In Bereich herunterladen <http://registry.gimp.org/plugin?id=
501>.

10.12.2.2. Filteraufruf

Dieses Filter lässt sich über das Menü Filter → Render → Wolken → Plasma im Bildfenster aufrufen.

10.12.2.3. Eigenschaften

Abbildung 10.187. Eigenschaften für das Filter ”Plasma“

Vorschau In der Vorschau wird ein Ausschnitt des Bildes so dargestellt, als wäre das Filter mit den
aktuellen Einstellungen auf das Bild angewandt worden.

Zufallssaat Die Eigenschaft Zufallssaat bestimmt den Zufallswert des Filters. Durch einen Klick auf
die Schaltfläche Neu Würfeln wird ein neuer Zufallswert berechnet. Wenn Sie die Eigenschaft
Zufällig aktivieren, wird bei jedem Aufruf des Filters automatisch eine neue Zufallssaat erzeugt.

Turbulenz Mit dieser Eigenschaft können Sie einstellen, wie stark die Farben verwirbelt werden. Die
Einstellung erfolgt über einen Schieberegler oder das zugeordnete Eingabefeld im Bereich von 0,1
bis 7,0. Ein kleiner Wert lässt die Farben weich ineinander übergehen, während ein hoher Wert zu
sehr harten Übergängen führt.
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10.12.3. Plastisches Rauschen

10.12.3.1. Wirkungsweise

Abbildung 10.188. v.l.n.r.: Originalbild, Plastisches Rauschen angewandt

(a) (b)

Dieses Filter ist hervorragend geeignet, um Texturen zu erstellen. Das Ergebnis dieses Filters ist ein
Graustufenbild, welches den Inhalt der aktiven Ebene ersetzt. Muster, welche Sie mit diesem Filter er-
stellen lassen sich auch in den Filtern Warp oder Bump Map verwenden.

10.12.3.2. Filteraufruf

Dieses Filter lässt sich über das Menü Filter → Render → Wolken → Plastisches Rauschen im Bild-
fenster aufrufen.

10.12.3.3. Eigenschaften

Abbildung 10.189. Eigenschaften für das Filter ”Plastisches Rauschen“

Vorschau Dieses Filter stellt Ihnen eine kleines Vorschaufenster zur Verfügung, in dem Sie die Wirkung
der aktuellen Einstellungen der Filtereigenschaften ansehen können, ohne das Filter bereits direkt
auf das Bild angewendet zu haben.
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Zufallssaat Mit dieser Eigenschaft können Sie dem Zufall, welcher massgeblich das entstehende Mus-
ter bestimmt, auf die Sprünge helfen. Durch einen Klick auf die Schaltfläche Neu Würfeln können
Sie einen neuen Wert erzeugen. Das daraus resultierende Muster wird in der Vorschau angezeigt.
Sie können den Wert auch direkt in das Eingabefeld eintragen und so ein Muster für Ihr Geburts-
datum oder Ihre persönliche Lieblingszahl erhalten.

Wenn Sie diese Eigenschaft aktivieren, wird automatisch bei jedem Aufruf des Filters eine neue
Zufallszahl erzeugt. Falls die Eigenschaft nicht aktiviert ist, wird der zuletzt verwendete Wert
beibehalten. Dies kann nützlich sein, wenn Sie die Ergebnisse des Filters reproduzieren wollen.

Turbulenz Wenn Sie diese Eigenschaft aktivieren, werden Sie sehr interessante Muster erhalten. Manch-
mal ähneln sie einem Ölfilm auf einer Wasseroberfläche, manchmal einer Rauchwolke, oder einem
Rorschach <http://de.wikipedia.org/wiki/Hermann Rorschach> Fleck.

Details Mit dieser Eigenschaft kontrollieren Sie den Detailgehalt des Musters. Den Wert können Sie
über ein Eingabefeld im Bereich von 1 (wenige Details) bis 15 (viele Details) einstellen. Mit einem
niedrigen Wert wirken die Muster eher weich und wolkenhaft, mit einem hohen eher härter und
kräftiger.

Kachelbar Wenn Sie diese Eigenschaft aktivieren, wird das vom Filter erzeugte Muster so gestaltet sein,
dass Sie es problemlos kacheln, also endlos aneinandersetzen können.

X-Grösse; Y-Grösse Mit diesen Eigenschaften können Sie einstellen, wie stark das Filter das Muster
in horizontaler und vertikaler Richtung dehnt, bzw. staucht. Die Einstellung erfolgt dabei mit den
jeweils vorhandenen Schiebereglern oder den zugeordneten Eingabefeldern im Bereich von 0,1 bis
16,0. Kleine Werte dehnen das Muster in die entsprechende Richtung, grosse stauchen es.

10.12.4. Flammen

10.12.4.1. Wirkungsweise

Abbildung 10.190. v.l.n.r.: Originalbild, Flammen angewandt

(a) (b)

Mit diesem Filter können Sie bemerkenswerte, zufällige fraktale Muster erzeugen. Sie können diese
Fraktale auf ähnliche Weise steuern, wie im Filter IFS Fraktal. Zusätzlich können Sie den Zufallsgenera-
tor in eine bestimmte Richtung beeinflussen und aus einer grossen Auswahl vorbereiteter Filtereinstel-
lungen wählen.
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10.12.4.2. Filteraufruf

Dieses Filter lässt sich über das Menü Filter → Render → Natur → Flammen im Bildfenster aufrufen.

10.12.4.3. Eigenschaften

Vorschau In der Vorschau wird ein Ausschnitt des Bildes so dargestellt, als wäre das Filter mit den
aktuellen Einstellungen auf das Bild angewandt worden.

Abbildung 10.191. Flamme bearbeiten

Bearbeiten

Beim Betätigung der Schaltfläche Bearbeiten öffnet sich der Dialog ”Flamme bearbeiten“.

Richtungen Im oberen Bereich des Dialoges befindet sich die Eigenschaft Richtungen. Dort wer-
den Ihnen neun verschiedene Muster angezeigt, wobei sich das aktuell ausgewählte im Zen-
trum befindet. Die restlichen acht Muster rundherum sind Zufallsvariationen des aktuellen
Musters. Mit einem Klick auf das zentrale Muster können Sie acht neue Variationen erzeugen.
Ein Klick auf eines der acht Muster verschiebt dieses in die Mitte und macht es zum aktuellen
Muster.

Kontrollen

Geschwindigkeit Mit dieser Eigenschaft können Sie einstellen, wie sehr sich die verschie-
denen Muster unterscheiden. Die Einstellung können Sie mit Hilfe eines Schiebereglers
order Eingabefeldes im Bereich von 0,05 bis 0,5 vornehmen. Je höher die eingestellte Ge-
schwindigkeit ist, um so stärker sind die Variationen zwischen den zur Auswahl ange-
botenen Mustern.

Variation Diese Eigenschaft enthält verschiedene Themen, welche Sie über ein Klappmenü
auswählen können. Diese Themen erzeugen Zufallsmuster die zu einer bestimmten Op-
tik wie beispielsweise Wirbel passen.

Zufall Mit einem Klick auf diese Schaltfläche können Sie alle neuen Muster durch neue zu-
fallsgesteuerte Muster austauschen.

430



KAPITEL 10. FILTER 10.12. RENDER

Öffnen Mit dieser Schaltfläche können Sie eine zuvor gespeicherte Filtereinstellung aus einer Datei
laden.

Speichern Mit dieser Schaltfläche können Sie die aktuellen Einstellungen des Filters in eine Datei spei-
chern, um Sie später wieder zu verwenden.

Reiter Rendern In diesem Reiter können Sie verschiedene Eigenschaften einstellen, welche auf das
Abbilden der Flammen Einfluss haben.

Abbildung 10.192. Eigenschaften (Rendern) für das Filter ”Flamme“

Helligkeit Mit dieser Eigenschaft steuern Sie die Helligkeit der Flamme. Die Einstellung können
Sie mit Hilfe eines Schiebereglers, oder des zugehörigen Eingabefeldes im Bereich von 0,0
(dunkel) bis 5,0 (hell) vornehmen.

Kontrast Mit dieser Eigenschaft steuern Sie den Kontrast der Flamme. Die Einstellung können
Sie mit Hilfe eines Schiebereglers, oder des zugehörigen Eingabefeldes im Bereich von 0,0 bis
5,0 vornehmen.

Gamma Mit dieser Eigenschaft steuern Sie den Gammawert der Flamme. Die Einstellung können
Sie mit Hilfe eines Schiebereglers, oder des zugehörigen Eingabefeldes im Bereich von 1,0 bis
5,0 vornehmen.

Stichprobendichte Mit dieser Eigenschaft steuern Sie die Stichprobendichte der Flamme. Die
Einstellung können Sie mit Hilfe eines Schiebereglers, oder des zugehörigen Eingabefeldes
im Bereich von 0,1 bis 20,0 vornehmen.

Räumliche Hochrechnung Mit dieser Eigenschaft können Sie die Räumliche Hochrechnung der
Flamme einstellen. Die Einstellung können Sie mit Hilfe eines Schiebereglers, oder des zu-
gehörigen Eingabefeldes im Bereich von 1 bis 4 vornehmen.
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Räumlicher Filterradius Mit dieser Eigenschaft können Sie den Räumlichen Filterradius der Flam-
me einstellen. Die Einstellung können Sie mit Hilfe eines Schiebereglers, oder des zugehörigen
Eingabefeldes im Bereich von 0,0 bis 4,0 vornehmen.

Farbpalette Mit dieser Eigenschaft haben Sie die Möglichkeit mittels eines Klappmenüs eine
Farbpalette auszuwählen mit der die Flamme gefüllt wird:

• Eigener Farbverlauf
• Verschiedene verfügbare Farbpaletten
• Die Farben eines der Bilder die aktuell in GIMP geöffnet sind.

Reiter Kamera In diesem Reiter können Sie verschiedene Eigenschaften einstellen, welche auf das Ab-
bilden der Flammen Einfluss haben.

Abbildung 10.193. Eigenschaften (Kamera) für das Filter ”Flamme“

Zoom Diese Eigenschaft erlaubt es Ihnen das Muster der Flamme beliebig zu vergrössern oder zu
verkleinern. Die Einstellung können Sie mittels eines Schiebereglers oder des zugeordneten
Eingabefeldes im Bereich von -4,0 bis 4,0 vornehmen.

X; Y Diese Eigenschaften erlauben es Ihnen das Flammenmuster in horizontaler und vertikaler
Richtung zu verschieben. Hierzu stehen Ihnen Schieberegler und Eingabefelder zur Verfügung.
Die Einstellung erfolgt im Bereich von -2,0 bis 2,0.

10.12.5. IFS Fraktal

10.12.5.1. Wirkungsweise

Dieses auf Fraktalen <http://de.wikipedia.org/wiki/Fraktal> basierende Filter ist wahrhaft
wundervoll! Mit diesem universellen Werkzeug können Sie verblüffend natürliche organische Formen
wie Blätter, Zweige oder sogar ganzen Bäumen erzeugen.
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Abbildung 10.194. v.l.n.r.: Originalbild, IFS Fraktal angewandt

(a) (b)

Der Schlüssel zur erfolgreichen Anwendung des Filters liegt in sehr kleinen und präzisen Bewegun-
gen im Raum der Fraktale. Das Ergebnis ist sehr schwer vorherzusagen, und Sie sollten sehr rücksichtsvoll
sein, wenn Sie das Muster verändern. Wenn Sie ein Komponentendreieck zu gross machen, oder es zu
weit bewegen, kann sich die Vorschau augenblicklich schwarz, oder was wahrscheinlicher ist, in eine
grosse, formlose Pixelwolke verwandeln.

Für eine kurze Einführung in IFS (englisch für Ïterated Function System”) zu erhalten sei Ihnen das
Buch ”Foley and van Dam, et al,. Computer Graphics, Principles and Practice, 2nd Ed., (Addison Wesley,
1990) empfohlen.

10.12.5.2. Filteraufruf

Dieses Filter lässt sich über das Menü Filter→ Render→ Natur→ IFS Fraktal im Bildfenster aufrufen.

10.12.5.3. Eigenschaften

Aufbau des Dialogfensters Das Dialogfenster für dieses Filter besteht aus verschiedenen Bereichen.
Am oberen Rand befindet sich eine Funktionsleiste mit verschiedenen Schaltflächen zur Bearbei-
tung der Fraktalform. Darunter sehen Sie zwei Bereiche, die in den Vorgabe-Einstellungen des
Filters eine Menge von Dreiecken beinhalten. Der linke dient zur Bearbeitung der Fraktalform,
der rechte beinhaltet ein Vorschau. Unterhalb sehen Sie zwei Reiter mit weiteren Eigenschaften.
Darunter befinden sich, am unteren Rand des Fensters, weitere Schaltflächen.

Funktionsleiste Die Funktionsleiste beinhaltet verschiedene Schaltflächen, die Ihnen bei der Bearbei-
tung der Fraktalform helfen. Dies umfasst Funktionen zum Verschieben, Drehen, Dehnen, Neu
anlegen, Löschen, Rückgängig machen, Wiederholen, Alles Auswählen, Zentrieren sowie zum
Einstellen der Rendereigenschaften.

Render Einstellungen

Max. Speicher Mit dieser Eigenschaft können Sie den maximalen Verbrauch an Hauptspei-
cher für das Filter einstellen. Eine Erhöhung des Wertes kann die Berechnung, gerade für
grosse Punkt Radius Werte enorm beschleunigen. Setzten Sie den Wert immer auf ein
Vielfaches des Standardwertes (4096), also 8192, 16384 etc.

Iterationen Mit dieser Eigenschaft können Sie einstellen wie oft das Fraktal sich selbst bein-
halten soll. Ein grosser Wert ist jedoch nur für sehr grosse Bilder sinnvoll, andernfalls
wird einfach nur länger gerechnet, aber es werden keine weiteren Details im Bild sicht-
bar sein.
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Abbildung 10.195. Eigenschaften (Raumtransformation) für das Filter ”IFS Fraktal“

Unterteilung Mit dieser Eigenschaft kontrollieren Sie wie viele Details im Fraktal dargestellt
werden. Ein grosser Wert ist jedoch nur für sehr grosse Bilder sinnvoll, andernfalls wird
einfach nur länger gerechnet, aber es werden keine weiteren Details im Bild sichtbar sein.

Punkt Radius Mit dieser Eigenschaft können Sie die Dichte der ”Pinselstriche“ einstellen,
mit denen das Bild gemalt wird. Ein kleiner Wert ist sehr gut geeignet für Partikelwolken
oder Spray, während ein grosser Wert zu dicken Linien, ähnlich dem Malen mit Was-
serfarben, führt. Ausserdem benötigt ein grosser Radius erheblich mehr Zeit zur Berech-
nung als ein kleiner. Die Einstellung können Sie mittels eines Schiebereglers oder des
zugeordneten Eingabefeldes im Bereich von 0,0 bis 5,0 vornehmen.

Reiter Raumtransformation In diesem Reiter finden Sie verschiedene Eigenschaften zum aktiven Drei-
eck. Sie können die Eigenschaften X, Y, Skalierung, Winkel, Asymmetrie sowie Scheren über
Eingabefelder einstellen. Dies ist gegenüber der Manipulation der Werte mit der Maus sehr viel
genauer und leichter kontrollierbar.

In diesem Reiter können Sie verschiedene Eigenschaften einstellen, welche die Farbgebung des
Fraktals betreffen.

Einfach In dieser Einstellung können Sie die Farbe der aktiven Fraktalkomponente einstellen. Die
Farbgebung beginnt mit der aktuellen Vordergrundfarbe und endet mit einer Farbe, die Sie
durch einen Klick auf die Farbschaltfläche selbst festlegen können.
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Abbildung 10.196. Eigenschaften (Farbtransformation) für das Filter ”IFS Fraktal“
Reiter Farbtransformation

Ganz Mit dieser Einstellung können Sie die ebenfalls die Farbe der aktuellen Fraktalkomponente
bestimmen. In diesem Fall jedoch für jeden Farbkanal und den Alphakanal (schwarz ange-
zeigt) getrennt.

Skaliere Farbton; Skaliere Wert Wenn Sie viele verschiedene Fraktale mit verschiedenen Far-
ben haben, werden die Farben ineinander übergeblendet. Daher wird ein Fraktal, auch wenn
Sie es mit reinem Rot eingestellt haben, möglicherweise verfärbt. Mit diesen beiden Eigen-
schaften können Sie die Farbstärke (Dominanz) der aktuellen Fraktalkomponente einstellen.
Hierzu stehen Ihnen je ein Schieberegler und ein Eingabefeld zur Verfügung. die Einstellung
erfolgt im Bereich von 0,0 bis 1,0.

Rel. Wahrscheinlichkeit Mit dieser Eigenschaft können Sie den Einfluss und die Auswirkungen einer
bestimmten Fraktalkomponente auf das gesamte Fraktal einstellen. Hierzu stehen Ihnen ein Schie-
beregler sowie ein zugeordnetes Eingabefeld zur Verfügung. Die Einstellung kann im Bereich von
0,0 bis 5,0 vorgenommen werden.

10.12.5.4. Kurzanleitung

Das Filter IFS Fraktal ist eines der komplexeren Filter in GIMP. Daher soll Ihnen diese Kurzanleitung
einen Einblick in die Arbeit mit Fraktalen geben. Anhand der Anleitung werden Sie sehen, wie Sie ein
Blatt oder einen Zweit erstellen können. branch.

Viele natürliche Formen, besonders bei Pflanzen, sind fraktal aufgebaut. Dies bedeutet, das sich eine
bestimmte Form immerfort bis in das kleinste Detail wiederholt. Sie können die Form eines Blattes oder
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Zweiges sehr leicht mit Hilfe von vier (oder mehr) Fraktalen nachbilden. Drei Fraktale bilden dabei die
Spitze und die Seiten des Blattes, während das Vierte den Stiel bildet.

1. Zur Vorbereitung erzeugen Sie zu nächst mittels Datei → Neu ein neues Bild und fügen mittels
Ebene→ Neue Ebene eine neue, transparente Ebene hinzu. Ausserdem stellen Sie bitte die aktu-
elle Vordergrundfarbe auf schwarz und die Hintergrundfarbe auf weiss.

2. Rufen Sie das Filter ”IFS Fraktal“ auf. Beginnen Sie damit das Rechte und das Untere der Dreiecke
so zu drehen, dass diese nach oben zeigen. Sie sind nun in der Lage grob zu erkennen, wo sich die
Blattspitze und die Seiten der Blätter befinden werden.

Abbildung 10.197. Kurzanleitung Schritt 2. Drehen Sie die Dreiecke 2 und 3. Versuchen Sie diese
möglichst gleich gross zu machen.

3. Um das Blatt symmetrisch zu machen, stellen Sie das untere Dreieck so ein, dass es leicht nach
links zeigt. Ebenso sollte das rechte Dreieck leicht nach rechts zeigen.

4. Fügen Sie durch betätigen der Schaltfläche Neu eine weitere Komponente hinzu. Diese wird den
Stiel des Blattes bilden. Hierzu machen Sie diese lang und dünn. Dazu aktivieren Sie Stretch, und
ziehen, um das neue Dreieck zu dehnen. Lassen Sie sich nicht irritieren, wenn das Bild dadurch
zunächst etwas unerwartet aussieht, verwenden Sie Skalieren, um die Grösse des überlangen
Dreiecks einzustellen. Sie müssen das neue Fraktal möglicherweise noch etwas verschieben und
drehen, um mit dem Ergebnis zufrieden zu sein.

Abbildung 10.198. Kurzanleitung Schritt 3. Fügen Sie eine vierte Komponente hinzu. Dann dehnen,
skalieren und verschieben Sie es wie im Bild ersichtlich.

5. Sie werden noch einige kleine Korrekturen vornehmen müssen, um das Bild einem Blatt noch
ähnlicher erscheinen zu lassen. Vergrössern Sie zunächst die Grösse des oberen Dreiecks, bis Sie
es dick und einem Blatt ähnlich erscheint. Stellen Sie alle Fraktale ein, bis Sie mit dem Ergebnis
zufrieden sind. Wählen Sie Select all aus dem Kontextmenü aus. Hiernach sind alle Komponenten
ausgewählt und sie können das gesamte Blatt drehen und die Grösse ändern.

6. Der letzte Schritt besteht in der Zuweisung der Farben zu den Komponenten. Aktivieren Sie den
Reiter Farbtransformation und wählen Sie eine unterschiedliche Farbe für jede Komponente.
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Abbildung 10.199. Kurzanleitung Schritt 4. Vergrössern Sie die Komponente 1, arrangieren Sie die an-
deren Komponenten passend, dass wählen Sie alle Komponenten aus, drehen und dehnen Sie diese.

Hierzu wählen Sie Einfach aus, und klicken auf die rechte Farbschaltfläche. In dem erscheinenden
Farbauswahldialog können Sie die Farbe einstellen.

Abbildung 10.200. Kurzanleitung Schritt 5. Weisen Sie der Komponente 4 einen Braunton und den
anderen Komponenten Grünschattierungen zu.

7. Klicken sie auf OK und - voilà - Sie haben ein perfektes fraktales Blatt erstellt! Nun können Sie
nach Herzenslust experimentieren und Ihre eigenen Muster entwerfen. Alle Fraktale die Pflanzen
nachbilden werden nach dem hier vorgestellten Prinizip erstellt. Egal ob es sich dabei um Blätter,
Eichbäume oder Farne handelt. Alles was sie tun müssen ist ein paar mehr Stiele einzufügen und
hier und da ein bisschen zu drehen und zu dehnen. Das Ergebnis wird eine völlig andere Pflanze
sein.

10.12.6. Beugungsmuster

10.12.6.1. Wirkungsweise

Mit diesem Filter können Sie Texturen erstellen, die Beugungs- oder Interferenzmuster beinhalten. Sie
können Frequenz, Ränder und Kantenschärfe für jeden RGB Kanal einstellen. Ausserdem können
Sie Helligkeit, Streuung und Polarisation beeinflussen.

Es ist klar, das dieses Filter die physikalischen Effekte simuliert, die auftreten wenn Licht auf eine
Kante trifft. Leider haben die Entwickler des Filters keine ausführliche Dokumentation über die Theorie
und die Eigenschaften des Filters hinterlassen. Empfehlenswert ist es, mit den Einstellungen ein biss-
chen herumzuspielen und das Filter einfach auszuprobieren.

10.12.6.2. Filteraufruf

Dieses Filter lässt sich über das Menü Filter → Render → Muster → Beugungsmuster im Bildfenster
aufrufen.
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Abbildung 10.201. v.l.n.r.: Originalbild, Beugungsmuster angewandt

(a) (b)

10.12.6.3. Eigenschaften

Vorschau In der Vorschau wird ein Ausschnitt des Bildes so dargestellt, als wäre das Filter mit den
aktuellen Einstellungen auf das Bild angewandt worden. Da dieses Filter sehr aufwendig zu be-
rechnen ist, wird die Vorschau nicht automatisch aktualisiert. Um eine Vorschau für die aktuellen
Einstellungen zu erhalten, betätigen Sie einfach die Schaltfläche Vorschau.

Eigenschaften im Reiter Frequenzen In diesem Reiter können Sie die Frequenz für die verschiedenen
RGB Kanäle einstellen.

Abbildung 10.202. Eigenschaften (Frequenzen) für das Filter ”Beugungsmuster“

Rot; Grün; Blau Mit diesem Eigenschaften können Sie die Frequenzen für die drei Farbkanäle
rot, grün und blau einstellen. Hierzu stehen Ihnen jeweils ein Schieberegler und ein zuge-
ordnetes Eingabefeld zur Verfügung. Die Einstellung können Sie im Bereich von 0,0 bis 20,0
vornehmen.

Eigenschaften im Reiter Ränder In diesem Reiter könne Sie die Ränder für die verschiedenen RGB
Kanäle einstellen.

Rot; Grün; Blau Mit diesem Eigenschaften können Sie die Ränder für die drei Farbkanäle rot,
grün und blau einstellen. Hierzu stehen Ihnen jeweils ein Schieberegler und ein zugeord-
netes Eingabefeld zur Verfügung. Die Einstellung können Sie im Bereich von 0,0 bis 10,0
vornehmen.
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Abbildung 10.203. Eigenschaften (Ränder) für das Filter ”Beugungsmuster“

Eigenschaften im Reiter Scharfe Kanten In diesem Reiter könne Sie die Kanten für die verschiede-
nen RGB Kanäle einstellen.

Abbildung 10.204. Eigenschaften (Scharfe Kanten) für das Filter ”Beugungsmuster“

Rot; Grün; Blau Mit diesem Eigenschaften können Sie die Kanten für die drei Farbkanäle rot,
grün und blau einstellen. Hierzu stehen Ihnen jeweils ein Schieberegler und ein zugeordnetes
Eingabefeld zur Verfügung. Die Einstellung können Sie im Bereich von 0,0 bis 1,0 vornehmen.

Eigenschaften im Reiter Andere Einstellungen In diesem Reiter könne Sie verschiedene Einstellun-
gen für das Filter vornehmen, die die Art des Lichtes festlegen, welche simuliert wird.

Abbildung 10.205. Eigenschaften (Andere Einstellungen) für das Filter ”Beugungsmuster“

Helligkeit Mit dieser Eigenschaft können Sie die Helligkeit des Lichtes einstellen. Hierzu stehen
Ihnen ein Schieberegler und ein zugeordnetes Eingabefeld zur Verfügung. Die Einstellung
können Sie im Bereich von 0,0 bis 1,0 vornehmen.
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Streuung Mit dieser Eigenschaft können Sie die Streuung des Lichtes einstellen. Hierzu stehen
Ihnen ein Schieberegler und ein zugeordnetes Eingabefeld zur Verfügung. Die Einstellung
können Sie im Bereich von 0,0 bis 100,0 vornehmen.

Polarisation Mit dieser Eigenschaft können Sie die Polarisation des Lichtes einstellen. Hierzu
stehen Ihnen ein Schieberegler und ein zugeordnetes Eingabefeld zur Verfügung. Die Ein-
stellung können Sie im Bereich von -1,0 bis 1,0 vornehmen.

10.12.7. CML Explorer

10.12.7.1. Wirkungsweise

Abbildung 10.206. v.l.n.r.: Originalbild, CML Explorer angewandt

(a) (b)

Dieses Filter ist sozusagen der Ferrari unter den Filtern mit denen Sie Texturen erzeugen können. Es
ist ausserordentlich Leistungsfähig, aber dafür auch sehr komplex. Der Name CML Explorer basiert auf
der englischen Bezeichnung ”Coupled-Map Lattice“ und bedeutet im Deutschen soviel wie ”Gekoppelte
Abbildungs-Gitter“. Technisch basiert das Filter auf den sogenannten Zellularen Automaten <http:
//de.wikipedia.org/wiki/Zellulare Automaten>.

10.12.7.2. Filteraufruf

Dieses Filter lässt sich über das Menü Filter → Render → Muster → CML Explorer im Bildfenster
aufrufen.

10.12.7.3. Eigenschaften

Die Eigenschaften des Filters sind in die verschiedenen Reiter Farbton, Sättigung, Wert, Erwei-
tert, Andere und Sonst. Vorg. aufgeteilt. Darüber hinaus gibt es noch einige Eigenschaften, wel-
che Ihnen allgemein zur Verfügung stehen. Diese werden im folgenden Abschnitt beschrieben.

Vorschau Dieses Filter stellt Ihnen eine kleines Vorschaufenster zur Verfügung, in dem Sie die
Wirkung der aktuellen Einstellungen der Filtereigenschaften ansehen können, ohne das Filter
bereits direkt auf das Bild angewendet zu haben.

Neue Init-Zahl; Feste Init-Zahl; Zufallssaat Der Zufall spielt bei der Erzeugung des Musters durch
das Filter eine grosse Rolle. Mit diesen Schaltflächen können Sie beeinflussen, wie die benötigten
Zufallszahlen ermittelt werden. Durch einen Klick auf die Schaltfläche Neue Init-Zahl können
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Abbildung 10.207. Eigenschaften (Farbton) für das Filter ”CML Explorer“

Allgemeine Eigenschaften

Sie das Filter auffordern eine neue Zufallszahl zu verwenden. Die Vorschau zeigt Ihnen das
entsprechende Ergebnis sofort an. Die beiden Schaltflächen Feste Init-Zahl und Zufallssaat
dienen Ihnen dazu selbst eine Zufallszahl vorzugeben. Dies ermöglicht es Ihnen die Muster
des Filters zu reproduzieren.

Öffnen; Speichern Mit diesen beiden Schaltflächen haben Sie die Möglichkeit die Einstellungen
des Filters in eine Datei zu speichern und später wieder zu verwenden.

Reiter Farbton Das Filter arbeitet auf den Komponenten des HSV Farbmodells. In diesem Reiter können
Sie die Einstellungen für die Komponente Farbton vornehmen.

Funktionstyp Mit dieser Eigenschaft können Sie den Typ der Funktion, welcher auf die Farbtöne
der aktuellen Ebene angewandt wird, aus einem Klappmenü auswählen. Die möglichen Ein-
stellungen umfassen:

• Behalte Werte des Bildes bei; In dieser Einstellung bleibt die Komponente ”Farbtöne“
unverändert. Die Einstellungen der aller anderen Eigenschaften werden nicht wirksam.

• Behalte ersten Wert; In dieser Einstellung wird die Ausgangsfarbe auf den Standard-
wert (cyan) gesetzt.

• Parameter k einsetzen, k{x(1-x)}ˆp, k{x(1-x)}ˆp schrittweise, kxˆp, kxˆp schrittwei-
se, k(1-xˆp), k(1-xˆp) schrittweise; In diesen Einstellungen wird der Parameter k in
der Funktion verwendet. Die Ausprägung des Musters ist dann von der Einstellung
abhängig, welche Sie für die Eigenschaft Parameter k vornehmen.

• Deltafunktion, Deltafunktion schrittweise; In diesen Einstellungen werden FIXME
• sinˆp basierte Funktion, sinˆp schrittweise; In diesen Einstellungen werden weiche,

wellenartige Muster erzeugt.

Zusammensetzung Mit dieser Eigenschaft legen Sie die Zusammensetzung für die Komponente

”Farbtöne“ fest. Hierzu stehen Ihnen in einem Klappmenü folgende Einstellungen zur Aus-
wahl:
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Kein, Max(x, -), Max(x+d, -), Max(x-d, -), Min(x, -), Min(x+d, -), Min(x-d, -), Max(x+d, -), (x
< 0,5), Max(x+d, -), (0,5 < x), Max(x-d, -), (x < 0,5), Max(x-d, -), (0,5 < x), Min(x+d, -), (x <
0,5), Min(x+d, -), (0,5 < x), Min(x-d, -), (x < 0,5) sowie Min(x-d, -), (0,5 < x).
Die einzelnen Einstellungen in ihren Auswirkungen zu beschreiben würde ein eigenes Buch
füllen. Daher sind Sie zum experimentieren aufgerufen.

Sonstige Anordnung Mit dieser Eigenschaft können Sie die sonstige Anordnung der Kompo-
nente ”Farbtöne“ einstellen. Hierzu steht Ihnen ein Klappmenü mit folgenden Einträgen zur
Verfügung:
Standard, Durchschnittswert verwenden, Umgekehrten Wert verwenden, Mit zufälligem
Exponenten (0,10), Mit zufälligem Exponenten (0,1), Mit gradiertem Exponenten (0,1),
Multipl. Zufallswert (0,1), Multipl. Zufallswert (0,2), Multipl. Farbverlauf (0,1) sowie Mit p
und Zufallszahl (0,1).
Auch für diese Eigenschaft gilt, dass die einzelnen Einstellungen in ihren Auswirkungen zu
beschreiben ein eigenes Buch füllen würde.

Zyklische Reichweite verwenden Wenn Sie diese Eigenschaft aktiviert haben, // TODO

Änderungsrate Mit dieser Eigenschaft können Sie die Änderungsrate festlegen. Um die Einstel-
lung vorzunehmen stehen Ihnen ein Schieberegler sowie ein Eingabefeld zur Verfügung. Sie
können Werte im Bereich von 0,0 bis 1,0 einstellen. Ein niedriger Wert führt eher zu gestreif-
ten, ein höherer eher zu runden Mustern.

Umgebungsempfindlichkeit Mit dieser Eigenschaft können Sie Umgebungsempfindlichkeit fest-
legen. Um die Einstellung vorzunehmen stehen Ihnen ein Schieberegler sowie ein Eingabe-
feld zur Verfügung. Sie können Werte im Bereich von 0,0 bis 1,0 einstellen.

Diffusionsentfernung Mit dieser Eigenschaft können Sie die Richtung und die Grösse der Mus-
ter beeinflussen. Um die Einstellung vorzunehmen stehen Ihnen ein Schieberegler sowie ein
Eingabefeld zur Verfügung. Sie können Werte im Bereich von 2 bis 10 einstellen.

Anzahl der Unterbereiche Mit dieser Eigenschaft können Sie die einstellen, wie komplex das
Muster sein wird. Um die Einstellung vorzunehmen stehen Ihnen ein Schieberegler sowie
ein Eingabefeld zur Verfügung. Sie können Werte im Bereich von 1 bis 10 einstellen.

Exponenten-Faktor (p) Mit dieser Eigenschaft können Sie die Funktionstypen, welche den Pa-
rameter p verwenden, beeinflussen. Um die Einstellung vorzunehmen stehen Ihnen ein Schie-
beregler sowie ein Eingabefeld zur Verfügung. Sie können Werte im Bereich von 0,0 bis 10,0
einstellen.

Parameter k Mit dieser Eigenschaft können Sie die Funktionstypen, welche den Parameter k
verwenden, beeinflussen. Um die Einstellung vorzunehmen stehen Ihnen ein Schieberegler
sowie ein Eingabefeld zur Verfügung. Sie können Werte im Bereich von 0,0 bis 10,0 einstellen.

Untere Grenze Mit dieser Eigenschaft können Sie die untere Grenze der Farbtöne einstellen, die
in die Berechnungen des Filters einbezogen werden. Um die Einstellung vorzunehmen stehen
Ihnen ein Schieberegler sowie ein Eingabefeld zur Verfügung. Sie können Werte im Bereich
von 0,0 bis 1,0 einstellen.

Obere Grenze Mit dieser Eigenschaft können Sie die untere Grenze der Farbtöne einstellen, die in
die Berechnungen des Filters einbezogen werden. Um die Einstellung vorzunehmen stehen
Ihnen ein Schieberegler sowie ein Eingabefeld zur Verfügung. Sie können Werte im Bereich
von 0,0 bis 1,0 einstellen.
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Zeichne den Graphen dieser Einstellungen Durch Betätigung dieser Schaltfläche öffnet sich ein
Fenster, in welchem der Funktionsgraph der aktuellen Einstellungen für die Komponente

”Farbtöne“ dargestellt wird.

Abbildung 10.208. Funktionsgraph der aktuellen Einstellungen

Abbildung 10.209. Eigenschaften (Sättigung) für das Filter ”CML Explorer“

Reiter Sättigung

In diesem Reiter können Sie die Eigenschaften einstellen, welche festlegen, wie das Filter die
Sättigungskomponente des HSV Farbmodells zur Berechnung des Musters verwendet.

Die Eigenschaften und Einstellmöglichkeiten entsprechen den für den Reiter Farbton beschriebe-
nen.

In diesem Reiter können Sie die Eigenschaften einstellen, welche festlegen, wie das Filter die
Sättigungskomponente des HSV Farbmodells zur Berechnung des Musters verwendet.

Die Eigenschaften und Einstellmöglichkeiten entsprechen den für den Reiter Farbton beschriebe-
nen.

443



10.12. RENDER KAPITEL 10. FILTER

Abbildung 10.210. Eigenschaften (Wert) für das Filter ”CML Explorer“

Reiter Wert

In diesem Reiter sind die Erweiterten Eigenschaften des Filters zusammengefasst. Diese sind
stehen wiederum jeweils für alle drei Komponenten des HSV Modells zur Verfügung.

Kanalempfindlichkeit // TODO:

Mutationsrate // TODO:

Mutationsentfernung // TODO:

In diesem Reiter sind weitere Eigenschaften enthalten, welche den Bildausschnitt und die Zufalls-
steuerung betreffen.

Anfangswert // TODO

Zoomfaktor // TODO

Anfangsversatz // TODO

Init-Zahl // TODO

In diesem Reiter sind verschiedene Eigenschaften zusammengefasst, welche das Kopieren von
Einstellungen sowie Öffnungseinstellungen betreffen.

Einstellungen kopieren Diesen Bereich können Sie nutzen, um die doch recht komplexen Ein-
stellungen, welche Sie für einen der Kanäle (Farbton, Sättigung, Wert) vorgenommen ha-
ben, für einen anderen Kanal zu übernehmen. Hierzu stehen Ihnen zwei Klappmenüs zur
Verfügung, in denen Sie auswählen von wo, nach wo Sie die Einstellungen kopieren möchten.
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Abbildung 10.211. Eigenschaften (Erweitert) für das Filter ”CML Explorer“

Reiter Erweitert

Selektive Öffnungseinstellungen Sie können mit Hilfe der Schaltfläche Öffnen des Filters ein-
mal gespeicherte Einstellungen wieder laden. Wenn Sie nicht die Einstellungen für alle, son-
dern nur für ausgewählte Kanäle wiederherstellen wollen, können Sie dies in diesem Bereich
einstellen. Sie müssen hierzu in den beiden Klappmenüs lediglich auswählen welchen Kanal
der gespeicherten Einstellungen Sie in welchen Kanal hineinladen möchten.

10.12.8. Hilfslinien

10.12.8.1. Wirkungsweise

Dieses Filter zeichnet ein Gitter aus Hilfslinien in das Bild. Die Breite, der Abstand und der Versatz
und vieles andere lassen sich einstellen.

TIPP

Wenn Sie die Breite der Linien auf 0 einstellen, werden nur die Schnittpunkte als
Kreuze eingezeichnet.

10.12.8.2. Filteraufruf

Dieses Filter lässt sich über das Menü Filter→Render→Muster→Hilfslinien im Bildfenster aufrufen.

10.12.8.3. Eigenschaften

Einige der Eigenschaften des Filters sind miteinander verbunden. Dies können Sie an den Kettensym-
bolen erkennen. Wenn Sie eine solche Eigenschaft neu einstellen, wird auch der Wert der verbundenen
Eigenschaft angepasst. Sie können die Verbindungen durch einen Klick auf das Kettensymbol auflösen.
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Abbildung 10.212. Eigenschaften (Andere) für das Filter ”CML Explorer“

Reiter Andere

Zusätzlich können Sie für einige der Eigenschaften die Masseinheit auswählen, in der Sie den Wert
einstellen möchten. Die Auswahl erfolgt über ein Klappmenü.

Vorschau In der Vorschau wird ein Ausschnitt des Bildes so dargestellt, als wäre das Filter mit den
aktuellen Einstellungen auf das Bild angewandt worden.

Breite Mit dieser Eigenschaft können Sie die Breite der Linien einstellen, aus denen das Gitter gezeich-
net wird. Verschiedene Eingabefelder ermöglichen Ihnen die Einstellung getrennt nach horizonta-
len, vertikalen und Schnittlinien vorzunehmen.

Abstand Mit dieser Eigenschaft können Sie die Abstände zwischen den Linien einstellen. Hierzu stehen
jeweils für die horizontalen, die vertikalen und die Abstände in den Schnittpunkten Eingabefelder
zur Verfügung. Bei den Schnittpunkten bestimmt der Wert die Grösse des zentralen Schnittpunk-
tes, welcher nicht gefärbt wird.

Versatz Mit dieser Einstellung können Sie das Gitter in Bezug auf die obere linke Ecke verschieben. Für
die Schnittpunkte bestimmt die Eigenschaft die Länge des Bereiches in denen der Schnittpunkt
gezeichnet wird. Zur Einstellung der Werte stehen Ihnen Eingabefelder zur Verfügung.

Farbwähler Unterhalb der Eingabefelder steht Ihnen für jeden Bereich eine Schaltfläche zur Farbaus-
wahl zur Verfügung. Mit ihrer Hilfe können Sie für jeden Bereich des Gitters (horizontale und
vertikale Linien, sowie die Schnittpunkte) eine eigene Zeichenfarbe einstellen.

10.12.9. Labyrinth

10.12.9.1. Wirkungsweise

Dieses Filter erzeugt ein zufälliges Labyrinth als schwarz/weiss Bild. Das Ergebnis des Filters ersetzt
den vorherigen Inhalt der aktuellen Ebene komplett.
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Abbildung 10.213. Eigenschaften (Sonstige Vorgaben) für das Filter ”CML Explorer“

Reiter Sonstige Vorgaben

10.12.9.2. Filteraufruf

Dieses Filter lässt sich über das Menü Filter→ Render→Muster→ Labyrinth im Bildfenster aufrufen.

10.12.9.3. Eigenschaften

Breite; Höhe Mit dieser Eigenschaft können Sie die Breite und Höhe der Mauern und Wege im Laby-
rinth einstellen. Hierzu steht Ihnen jeweils ein Schieberegler mit zugeordnetem Eingabefeld zur
Verfügung. Die Einstellung kann im Bereich von 1 bis 75 Pixel erfolgen. Alternativ können Sie
mit den Eigenschaften Stücke auch die Anzahl der Mauern bzw. Wege in der entsprechenden
Richtung vorgeben. Die Höhe und Breite wird dann jeweils automatisch eingetragen.

Nahtlos Wenn Sie das Labyrinth endlos aneinanderlegen (kacheln) möchten, so sollten Sie diese Eigen-

Abbildung 10.214. v.l.n.r.: Originalbild, Hilfslinien angewandt

(a) (b)
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Abbildung 10.215. Eigenschaften für das Filter ”Hilfslinien“

schaft aktivieren.

Init-Zahl Der Zufall spielt eine wichtige Rolle bei der Erstellung eines Labyrinthes. Mit dieser Eigen-
schaft können Sie entweder bei jedem Aufruf des Filters eine neue Zufallsvariante verwenden (
Die Eigenschaft Zufällig ist hierzu zu aktivieren), oder von Hand, durch klicken auf die Schalt-
fläche Neu Würfeln eine Zufallszahl erzeugen, welche immer wieder verwendet wird. Die zweite
Variante hat den Vorteil, dass das Ergebnis des Filters reproduzierbar ist.

Algorithmus Mit dieser Eigenschaft können Sie den Algorithmus auswählen, welcher zur Erzeugung
des Labyrinthes verwendet wird. Zur Auswahl stehen Tiefe zuerst und Prim’scher Algorithmus.

Abbildung 10.216. v.l.n.r.: Originalbild, Labyrinth angewandt

(a) (b)
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Abbildung 10.217. Eigenschaften für das Filter ”Labyrinth“

10.12.10. Puzzle

10.12.10.1. Wirkungsweise

Abbildung 10.218. v.l.n.r.: Originalbild, Puzzle angewandt.

(a) (b)

Dieses Filter ”zerschneidet“ Ihr Bild in viele kleine Puzzleteile. Das Ergebnis kann leichte Treppen-
stufen an den Kanten aufweisen. Diesen begegnen Sie am besten mit einem leichten Weichzeichner.
Empfehlenswert ist der Gaußsche Weichzeichner mit einem Radius von 1,0.

TIPP

Wenn Sie die einzelnen Puzzleteile einfach auswählen möchten, beispielsweise
um sie weiter zu bearbeiten, empfiehlt es sich das Filter auf einer separaten Ebe-
ne auszuführen. Diese sollte weiss gefüllt sein, und der Ebenenmodus sollte auf

”Multiplizieren“ gestellt sein. Sie können die einzelnen Puzzleteile dann bequem
mit dem Zauberstab auswählen.

10.12.10.2. Filteraufruf

Dieses Filter lässt sich über das Menü Filter → Render → Muster → Puzzle im Bildfenster aufrufen.
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10.12.10.3. Eigenschaften

Abbildung 10.219. Eigenschaften für das Filter ”Puzzle“

Vorschau In der Vorschau wird ein Ausschnitt des Bildes so dargestellt, als wäre das Filter mit den
aktuellen Einstellungen auf das Bild angewandt worden.

Anzahl der Teile Horizontal; Vertikal Mit diesen Eigenschaften können Sie einstellen, in wie viele Zei-
len und Spalten das Bild unterteilt werden soll, um daraus Puzzleteile zu erstellen. Die Einstellung
können Sie jeweils mit Hilfe eines Schiebereglers 1 bis 20 vornehmen.

Breite der Rundung Mit dieser Eigenschaft können Sie einstellen, wie gross der Höhenunterschied
zwischen der Mitte und dem Rand eines Puzzleteiles ist. Ein kleiner Wert lässt die einzelnen Teile
sehr flach erscheinen, ein grosser führt zu starken Rundungen an den Kanten der Puzzleteile. Die
Einstellung können Sie mit Hilfe eines Schiebereglers oder des zugeordneten Eingabefeldes im
Bereich von 0 bis 10 vornehmen.

Glanzlicht Mit dieser Eigenschaft können Sie die Stärke des Beleuchtungseffektes steuern, welcher die
Puzzleteile dreidimensional erscheinen lässt. Die Einstellung können Sie mit Hilfe eines Schiebe-
reglers oder des zugeordneten Eingabefeldes im Bereich von 0,0 bis 1,0 vornehmen. Bitte beachten
Sie, dass das Glanzlicht nur auf angeschrägte Bereiche der Puzzleteile wirkt. Wenn Sie also einen
sehr kleinen Wert für Breite der Rundung angegeben haben, so wird das Glanzlicht wenig
oder gar nicht sichtbar sein.

Puzzle Stil Sie können mit dieser Eigenschaft aus zwei Typen von Puzzles auswählen. In der Einstel-
lung Quadratisch erzeugt das Filter Einzelteile mit geraden Kanten, während in der Einstellung
Rund leicht geschwungene Kanten entstehen.
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10.12.11. Qbist

10.12.11.1. Wirkungsweise

Abbildung 10.220. v.l.n.r.: Originalbild, Qbist angewandt

(a) (b)

Das Qbist Filter erzeugt zufallsgesteuert Texturen. Diese enthalten geometrische Figuren und Farb-
verläufe.

Abbildung 10.221. Drei weitere Beispiele für das Qbist Filter

(a) (b) (c)

10.12.11.2. Filteraufruf

Dieses Filter lässt sich über das Menü Filter → Render → Muster → Qbist im Bildfenster aufrufen.

10.12.11.3. Eigenschaften

Im oberen Bereich des Filterdialoges werden neun kleine Vorschaufenster angezeigt. Diese können Sie
verwenden, um ein Ihnen gefallendes Muster als Textur auszuwählen. Das aktuelle Muster ist dasjenige,
welches sich in der Mitte befindet. Um ein anderes Muster zum aktuellen Muster zu machen, klicken
Sie es einfach an. Es wird dann in die Mitte übernommen. Sollten keines der angebotenen Muster Ihren
Vorstellungen entsprechen, können Sie sich mit einem Klick auf das aktuelle Muster einen komplett
neuen Satz an Vorschlägen anzeigen lassen.

Kantenglättung Wenn Sie diese Eigenschaft aktivieren, werden die in der Textur enthaltenen Kanten
geglättet.

Öffnen; Speichern Mit diesen beiden Schaltflächen können Sie das aktuelle Muster speichern, um es
später wieder zu verwenden. Dies ist wichtig, da sich die Muster nur schwer reproduzieren lassen.
Stichwort: Zufall!
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Abbildung 10.222. Eigenschaften für das Filter ”Plasma“

10.12.12. Schachbrett

10.12.12.1. Wirkungsweise

Abbildung 10.223. v.l.n.r.: Originalbild, Schachbrett angewandt

(a) (b)

Dieses Filter ist erzeugt ein Schachbrettmuster, welches den Inhalt der aktuellen Ebene ersetzt. Die
Farben mit denen das Muster gestaltet wird sind die aktuellen Vorder- und Hintergrundfarbe.

10.12.12.2. Filteraufruf lancement de filtre

Dieses Filter lässt sich über das Menü Filter→ Render→Muster→ Schachbrett im Bildfenster aufru-
fen.

10.12.12.3. Eigenschaften

Psychobilly Wenn Sie diese Eigenschaft aktivieren, wird das Schachbrettmuster an den Rändern ver-
zerrt, so dass ein interessanter Kisseneffekt entsteht.

Grösse Mit dieser Eigenschaft können Sie die Grösse der Felder des Schachbrettmusters einstellen.
Hierzu steht Ihnen ein Eingabefeld zur Verfügung. Die Einstellung kann in verschiedenen Mass-
einheiten vorgenommen werden, welche Sie in einem Klappmenü auswählen.
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Abbildung 10.224. Eigenschaften für das Filter ”Schachbrett“

10.12.13. Sinus

10.12.13.1. Wirkungsweise

Abbildung 10.225. v.l.n.r.: Originalbild, Sinus angewandt

(a) (b)

Mit diesem Filter können Sie farbige Texturen erstellen, welche durch Verwendung der Sinusfunk-
tion mit wellenförmigen Farbübergängen versehen werden. Die erzeugten Muster ähneln gelegentlich
polierten Holzoberflächen.

Sie können einstellen, welche Farben in den Mustern verwendet und wie es in X und Y Richtung ge-
dehnt oder gestaucht wird. Ausserdem können Sie einstellen, wie hoch die Komplexität des Musters
sein soll.

10.12.13.2. Filteraufruf

Dieses Filter lässt sich über das Menü Filter → Render → Muster → Sinus im Bildfenster aufrufen.

10.12.13.3. Eigenschaften

Vorschau Dieses Filter stellt Ihnen eine kleines Vorschaufenster zur Verfügung, in dem Sie die Wirkung
der aktuellen Einstellungen der Filtereigenschaften ansehen können, ohne das Filter bereits direkt
auf das Bild angewendet zu haben.

Reiter Einstellungen In diesem Reiter können Sie allgemeine Einstellungen für das Filter vornehmen.

X Skalierung; Y Skalierung Mit diesen Eigenschaften können Sie einstellen, wie stark das Fil-
ter das Muster in horizontaler und vertikaler Richtung dehnt, bzw. staucht. Die Einstellung
erfolgt dabei mit den jeweils vorhandenen Schiebereglern oder den zugeordneten Eingabefel-
dern im Bereich von 0,0001 bis 100,0. Kleine Werte dehnen das Muster in die entsprechende
Richtung, grosse stauchen es.
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Abbildung 10.226. Eigenschaften (Einstellungen) für das Filter ”Sinus“

Komplexität Mit dieser Eigenschaft können Sie kontrollieren, wie stark das durch das Filter er-
zeugte Muster Verläufe und Verwirbelungen aufweist, also wie stark die Farben miteinander
interagieren. Die Einstellung erfolgt mit Hilfe eines Schiebereglers oder des zugeordneten
Eingabefeldes im Bereich von 0,0 bis 15,0. Kleine Werte führen zu einem sehr einfachen, har-
monischen Muster, während sehr grosse Werte eher zu komplexen Mustern führen.

Zufallssaat Mit dieser Eigenschaft können Sie dem Zufall, welcher massgeblich das entstehen-
de Muster bestimmt, auf die Sprünge helfen. Durch einen Klick auf die Schaltfläche Neu
Würfeln können Sie einen neuen Wert erzeugen. Das daraus resultierende Muster wird in
der Vorschau angezeigt. Sie können den Wert auch direkt in das Eingabefeld eintragen und
so ein Muster für Ihr Geburtsdatum oder Ihre persönliche Lieblingszahl erhalten.
Wenn Sie diese Eigenschaft aktivieren, wird automatisch bei jedem Aufruf des Filters eine
neue Zufallszahl erzeugt. Falls die Eigenschaft nicht aktiviert ist, wird der zuletzt verwendete
Wert beibehalten. Dies kann nützlich sein, wenn Sie die Ergebnisse des Filters reproduzieren
wollen.

Kachelung erzwingen? Wenn Sie diese Eigenschaft aktivieren, wird das vom Filter erzeugte
Muster so gestaltet sein, dass Sie es problemlos kacheln, also endlos aneinandersetzen können.

Ideal; Gestört Mit diesem beiden Einstellungen haben Sie die Möglichkeit die Art des entste-
henden Musters zu beeinflussen. Wenn Sie Ideal auswählen, wird das Muster wesentlich
harmonischer sein, als wenn Sie die Einstellung Gestört wählen.

In diesem Reiter können Sie einstellen, mit welchen Farben das Filter das Muster erstellen wird.

Farben Mit dieser Eigenschaft haben Sie die Möglichkeit festzulegen, welche Farben das Filter bei
der Erzeugung des Muster verwendet. Zur Auswahl stehen: Schwarz-Weiss - In dieser Ein-
stellung wird das Filter die Farben Schwarz und Weiss verwenden. Vorder- und Hintergrund
- In dieser Einstellung wird das Filter die aktuelle Vorder- und Hintergrundfarbe verwenden.
Hier auswählen - In dieser Einstellung können Sie mit Hilfe von zwei Farbschaltflächen den
Farbauswahldialog aufrufen und selbst die Farben bestimmen.

Alphakanäle In diesem Bereich können Sie die Deckkraft der beiden Farben festlegen. Um diese
Einstellung vorzunehmen, stehen Ihnen jeweils ein Schieberegler sowie ein Eingabefeld zur
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Abbildung 10.227. Eigenschaften (Farben) für das Filter ”Sinus“

Reiter Farben

Verfügung. Der Wertebereich umfasst 0,0 (voll transparent) bis 1,0 (voll deckend). Bitte be-
achten Sie, dass Ihnen diese Eigenschaften nur dann zur Verfügung stehen, wenn die aktive
Eben über einen Alphakanal verfügt.

Abbildung 10.228. Eigenschaften (Verlauf) für das Filter ”Sinus“

Reiter Verlauf

In diesem Reiter können Sie Einstellungen vornehmen, welche festlegen wie das Filter die aus-
gewählten Farben in Farbverläufe umsetzt.

Farbverlauf Mit dieser Eigenschaft legen Sie die Form der Wellen fest, mit denen der Verlauf
zwischen den Farben gestaltet wird. Es stehen Ihnen folgende Einstellungen zur Auswahl:
Linear, Bilinear sowie Sinusförmig.

Exponent Mit dieser Eigenschaft können Sie einstellen, welche der beiden Farben das Muster do-
miniert. Diese Einstellung können Sie mit Hilfe eines Schiebereglers oder des zugeordneten
Eingabefeldes im Bereich von -7,5 bis 7,5 vornehmen. Dabei bewirkt ein Wert kleiner 0,0 eine
Dominanz der linken Farbe, ein Wert größer 0,0 entsprechend eine Dominanz der Rechten.
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10.12.14. Fraktal Explorer

10.12.14.1. Wirkungsweise

Abbildung 10.229. v.l.n.r.: Originalbild, Fraktal Explorer angewandt

(a) (b)

Mit diesem Filter können Sie Fraktale <http://de.wikipedia.org/wiki/Fraktal>, also ”bun-
te Bilder am Rande des Chaos“ erzeugen. Im Gegensatz zum IFS Fraktal Filter, mit welchem Sie unter
Verwendung von fraktalen Strukturen selbst Objekte erstellen können, bietet Ihnen dieses Filter die
Möglichkeit mit einfachen Mitteln vorgegebene Fraktale zu erkunden.

10.12.14.2. Filteraufruf Lancement du filtre

Dieses Filter lässt sich über das Menü Filter → Render → Fraktal Explorer im Bildfenster aufrufen.

10.12.14.3. Eigenschaften

Vorschau Dieses Filter stellt Ihnen eine kleines Vorschaufenster zur Verfügung, in dem Sie die Wirkung
der aktuellen Einstellungen der Filtereigenschaften ansehen können, ohne das Filter bereits direkt
auf das Bild angewendet zu haben. Da der Rechenaufwand zur Erzeugung des Vorschaubildes
sehr hoch sein kann, haben Sie die Möglichkeit die automatische Erstellung der Vorschau mit der
Eigenschaft Echtzeitvorschau zu auszuschalten. In diesem Fall können Sie die Erstellung eines
aktuellen Vorschaubildes durch einen Klick auf die Schaltfläche Neu zeichnen selbst auslösen.

Zoom In diesem Bereich stehen Ihnen verschiedene Schaltflächen zur Verfügung. Diese können Sie be-
nutzen, um das Fraktal heranzuzoomen, herauszuzoomen, den letzten Bearbeitungsschritt rückgängig
zu machen oder zu wiederholen.

Reiter Parameter Dieser Reiter enthält Eigenschaften, mit denen Sie festlegen können, wie das Fraktal
berechnet wird und welcher Fraktaltyp verwendet werden soll.

Fraktalparameter Mit diesen Eigenschaften können Sie die Berechnung des Fraktales, also den
Ausschnitt und die Berechnungstiefe einstellen.

XMIN; XMAX; YMIN; YMAX Mit diesen vier Eigenschaften legen Sie den Ausschnitt fest, für
den das Fraktal berechnet werden soll. Die Einstellung kann jeweils über einen Schiebe-
regler, oder ein Eingabefeld im Bereich von -3,0 bis 3,0 vorgenommen werden.

ITER Mit dieser Eigenschaft können Sie die Berechnungstiefe einstellen. Die Einstellung kann
über einen Schieberegler oder das zugeordnete Eingabefeld im Bereich von 0,0 bis 1000,0
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Abbildung 10.230. Eigenschaften (Allgemein) für das Filter ”Fraktal Explorer“

vorgenommen werden. Je höher der Wert ist, umso detaillierter wird das Fraktal berech-
net, allerdings steigt damit natürlich auch der Aufwand zur Berechnung und die Details
sind im Bild sowieso nur bis zu einem bestimmten Grad erkennbar.

CX; CY Mit diesen Eigenschaften können Sie den Aspekt des Fraktals in horizontaler bzw.
vertikaler Richtung beeinflussen. Die Einstellung erfolgt über einen Schieberegler oder
das zugeordnete Eingabefeld im Bereich von -2,5 bis 2,5. Bitte beachten Sie, dass die-
se Eigenschaften bei Fraktalen vom Typ Mandelbrot und Sierpinski keine Auswirkung
haben.

Öffnen; Speichern; Rücksetzen Mit diesen Schaltflächen können Sie die aktuellen Einstel-
lungen in eine Datei speichern, die Einstellungen aus einer Datei wiederherstellen und
die Einstellungen auf die Vorgabe-Einstellungen zurücksetzen.

Fraktaltyp Mit dieser Eigenschaft legen Sie fest, von welchem Typ das Fraktal sein soll. Es stehen
alle gängigen Fraktaltypen wie Mandelbrot, Julia, Barnsley oder Sierpinski zur Auswahl.

Dieser Reiter enthält Eigenschaften, mit denen Sie festlegen können, wie das Fraktal eingefärbt
wird.

Anzahl der Farben Mit dieser Eigenschaft können Sie einstellen, wie viele Farben das Filter ver-
wendet, um das Fraktal darzustellen. Sie können diese Eigenschaft mit Hilfe eines Schiebe-
reglers oder des zugeordneten Eingabefeldes im Bereich von 2 bis 8192 vornehmen.
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Abbildung 10.231. Eigenschaften (Farben) für das Filter ”Fraktal Explorer“

Reiter Farben

loglog-Glättung verwenden Wenn Sie diese Eigenschaft aktivieren, wird das Filter eine mögliche
Streifenbildung in den Fraktalen vermindern. Die Farbverläufe wirken hierdurch wesentlich
weicher.

Abbildung 10.232. Beispiel für Loglog-Glätung

Farbdichte Mit dieser Eigenschaft können Sie für jeden der drei Farbkanäle Rot, Grün und Blau
die Farbdichte einstellen. Hierzu stehen Ihnen Schieberegler und Eingabefelder zur Verfügung,
um die Einstellung im Bereich von 0,0 bis 1,0 vorzunehmen.

Farbfunktion Mit dieser Eigenschaft können Sie für jeden der drei Farbkanäle Rot, Grün und
Blau eine Funktion auswählen, welche bestimmt wie die Farbe aufgetragen wird. Diese Funk-
tion bildet die für das Fraktal berechneten Werte auf den Farbkanal ab. Es stehen folgende
Funktionen zur Auswahl:

• Sinus; In dieser Einstellung wird der Farbauftrag durch die Sinusfunktion moduliert.
• Kosinus; In dieser Einstellung wird der Farbauftrag durch die Kosinusfunktion modu-

liert. Diese ähnelt der Sinusfunktion stark, ist aber gegen diese Verschoben, was im Bild
zu interessanten Farbverläufen führt.

• Keine; In dieser Einstellung wird der Farbauftrag nicht moduliert und linear aufgetra-
gen. Diese führt dazu, dass jedem Funktionswert des Fraktals genau ein Farbwert zuge-
wiesen wird. Dadurch entsteht ein gleichmässiger Verlauf.
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• Invertieren; Wenn Sie diese aktivieren, werden die Werte der Funktion umgekehrt. Bit-
te beachten Sie, dass hierdurch auch die Schieberegler zur Einstellung der Farbdichte
scheinbar falschherum wirken.

Farbmodus Mit dieser Eigenschaft können Sie einstellen woher das Filter die zur Färbung des
Fraktals nötigen Farbwerte nehmen soll.

• Wie oben angegeben; In dieser Einstellung werden Farbwerte so verwendet, wie Sie
diese in den Eigenschaften Farbdichte eingestellt haben.

• Aktiven Farbverlauf auf das endgültige Bild Anwenden; In dieser Einstellung wird
der aktuelle Farbverlauf zur Färbung des Fraktals verwendet. Sie können diesen durch
einen Klick auf die Verlaufsschaltfläche auswählen.

Abbildung 10.233. Eigenschaften (Fraktale) für das Filter ”Fraktal Explorer“

Reiter Fraktale

Dieser Reiter enthält eine umfangreiche Liste von gespeicherten Filtereinstellungen, welche Sie als
Vorlage für eigene Einstellungen verwenden können. Mit einem Klick auf einen der Einträge der
Liste werden die vorgegeben Filtereigenschaften aktiviert.

10.12.15. Gfig

10.12.15.1. Wirkungsweise

Mit diesem Filter, welches schon fast den Charakter eines Werkzeuges hat, haben Sie die Möglichkeit
verschiedene geometrische Figuren in zu erzeugen und in das Bild einzufügen. Hierzu steht eine kom-
plexe Oberfläche bereit, mit deren Hilfe Sie die verschiedenen Operationen ausführen können.

Die durch dieses Filter dem Bild hinzugefügten Elemente werden auf einer eigenen Ebene eingefügt.
Dies bedeutet, dass das Bild selbst unverändert bleibt, alle Änderungen erfolgen auf einer neu erzeugten
Ebene.
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Abbildung 10.234. v.l.n.r.: Originalbild, Gfig angewandt

(a) (b)

10.12.15.2. Filteraufruf

Dieses Filter lässt sich über das Menü Filter → Render → Gfig im Bildfenster aufrufen.

10.12.15.3. Eigenschaften

Abbildung 10.235. Eigenschaften für das Filter ”Gfig“

Funktionsleiste Am obere Rand des Dialogfensters finden Sie eine Funktionsleiste. Diese beinhaltet
verschiedene Werkzeuge zum Zeichnen und verwalten von Objekten.

Funktionen zum Zeichnen von Objekten In diesem Bereich der Funktionsleiste finden Sie ver-
schiedene Funktionen zum Zeichnen von Funktionen. Diese lassen sich durch Anklicken der
Schaltflächen aktivieren. Im Einzelnen stehen Ihnen folgende Funktionen zur Verfügung:
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• Linie; Mit diesem Werkzeug können Sie Linien zeichnen. Hierzu klicken Sie einfach in
die Zeichenfläche, um den Startpunkt zu bestimmen. Halten Sie die Maustaste gedrückt
und ziehen Sie die gewünschte Linie.

• Kreis; Mit diesem Werkzeug können Sie Kreise zeichnen. Hierzu klicken Sie einfach in
die Zeichenfläche, um den Mittelpunkt zu bestimmen. Ziehen Sie dann einfach bei ge-
drückter Maustaste den gewünschten Radius.

• Ellipse; Mit diesem Werkzeug können Sie Ellipsen zeichnen. Hierzu klicken Sie einfach
in die Zeichenfläche, um den Mittelpunkt zu bestimmen. Ziehen Sie dann einfach bei
gedrückter Maustaste die Ellipse in der gewünschten Form und Grösse auf.

• Bogen; Mit diesem Werkzeug können Sie Bögen zeichnen. Hierzu klicken Sie einfach in
der Zeichenfläche den gewünschten Startpunkt an. Nun klicken Sie sie erneut, um einen
weiteren Punkt des Bogens zu bestimmen. Beim dritten Klick werden alle drei Punkte
durch einen Bogen verbunden.

• Regelmässiges Polygon; Mit diesem Werkzeug können Sie sehr einfach regelmässige
Vielecke erzeugen. Hierzu stellen Sie in den Werkzeugeigenschaften die Anzahl der
Seiten ein, die das Objekt haben soll. Hiernach können sie mit einem Klick in die Zei-
chenfläche den Mittelpunkt festlegen und mit gedrückter Maustaste das Objekt in der
gewünschten Grösse und Ausrichtung aufziehen.

• Stern; Mit diesem Werkzeug können Sie sehr einfach Sterne erzeugen. Hierzu stellen Sie
in den Werkzeugeigenschaften die Anzahl der Seiten (Arme) ein, die der Stern haben
soll. Hiernach können sie mit einem Klick in die Zeichenfläche den Mittelpunkt festlegen
und mit gedrückter Maustaste das Objekt in der gewünschten Grösse und Ausrichtung
aufziehen.

• Spirale; Mit diesem Werkzeug können Sie sehr einfach Spiralen erzeugen. Hierzu stellen
Sie in den Werkzeugeigenschaften die Anzahl der Seiten (Umdrehungen) ein, die die
Spirale haben soll. Ausserdem können Sie die Orientierung festlegen. Hiernach können
sie mit einem Klick in die Zeichenfläche den Mittelpunkt festlegen und mit gedrückter
Maustaste das Objekt in der gewünschten Grösse und Ausrichtung aufziehen.

• Bezier Kurve; Mit diesem Werkzeug können Sie sehr einfach Bezier-Kurven erstellen.
Hierzu klicken Sie einfach in die Zeichenfläche, um den Start- und die weiteren Punkte
festzulegen, durch welche die Kurve führen soll. Um die Erzeugung von Punkten abzu-
schliessen, halten Sie bei der Erzeugung des letzten Punktes die Shift Taste gedrückt.

Funktionen zum Zeichnen von Objekten In diesem Bereich der Funktionsleiste finden Sie ver-
schiedene Funktionen zum Bearbeiten von Objekten. Diese lassen sich durch Anklicken der
Schaltflächen aktivieren. Im Einzelnen stehen Ihnen folgende Funktionen zur Verfügung:

• Verschieben (Objekt); Mit dieser Funktion könne Sie das aktive Objekt verschieben. Ak-
tivieren Sie hierzu das zu verschiebende Objekt zunächst, indem Sie auf einen der Anker-
punkte des gewüschten Objektes klicken. Dann können Sie dieses beliebeig verschieben.

• Verschieben (Punkt); Mit dieser Funktion können Sie einzelne Kontrollpunkte der Ob-
jekte verschieben und damit deren Form nachträglich korrigieren. Hierzu aktivieren Sie
zunächst den Punkt, welchen Sie verschieben wollen, indem Sie diesen anklicken. Den
aktivierten Punkt erkennen Sie an seiner weissen Färbung. Hiernach können Sie den
Punkt beliebig verschieben.

• Kopieren; Mit dieser Funktion können Sie Objekte duplizieren. Klicken Sie hierzu ein-
fach einen der Kontrollpunkte des Objektes an und ziehen Sie diesen an die Stelle an der
die Kopie des Objektes erstellt werden soll.

• Löschen; Mit dieser Funktion können Sie sehr einfach Objekte löschen. Hierzu klicken
Sie einfach in einen der Kontrollpunkte des zu löschenden Objektes.

• Auswählen; Mit dieser Funktion können Sie Objekte durch einen Klick in einen seiner
Kontrollpunkte aktivieren.

Funktionen zum Ausrichten von Objekten In diesem Bereich der Funktionsleiste finden Sie ver-
schiedene Funktionen zum Ausrichten von Objekten. Mit diesen Funktionen können Sie fest-
legen wie die Objekte übereinander liegen. Im Einzelnen stehen Ihnen folgende Funktionen
zur Verfügung:
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• Nach oben; Nach unten; Mit diesen Funktionen können Sie das ausgewählte Objekt
eine Stufe nach oben oder unten schieben.

• Oben; Unten; Mit diesen Funktionen können Sie das ausgewählte Objekt auf die oberste
oder unterste Stufe schieben.

Funktionen zur Anzeige von Objekten In diesem Bereich der Funktionsleiste finden Sie verschie-
dene Funktionen zur Anzeige von Objekten. Im Einzelnen stehen Ihnen folgende Funktionen
zur Verfügung:

• Zurück; Vor; Mit diesen Funktionen können Sie durch die Objekte blättern. Es wird je-
weils das vorherige oder nachfolgende Objekt angezeigt.

• Alle anzeigen; Mit dieser Funktion können Sie alle Objekte wieder anzeigen.

Zeichenbereich In diesem Bereich können Sie die Objekte erstellen und verändern.

Einstellungen In diesem Bereich stehen Ihnen verschiedene Eigenschaften zur Verfügung, um mit dem
Filter zu arbeiten.

Werkzeugoptionen Hier werden je nach Werkzeug verschiedene Werkzeugeigenschaften ange-
zeigt.

Strich Wenn Sie diese Eigenschaft aktiviert haben, wird für das Objekt ein Strich gezeichnet. Des-
sen Farbe und Gestalt können Sie mit Hilfe der Farbschaltfläche sowie der Schaltfläche
Durchsuchten (zur Pinselauswahl) einstellen.

Füllung Mit Hilfe dieses Klappmenüs können Sie einstellen, ob und wie das aktive Objekt gefüllt
werden soll. Sie können wahlweise gar nicht, mit einer Farbe, einem Muster oder einem Ver-
lauf füllen.

Gitter anzeigen Wenn Sie diese Eigenschaft aktivieren, wird im Zeichenbereich ein Gitter zur
Orientierung angezeigt.

Am Gitter ausrichten Wenn Sie diese Eigenschaft aktiviert haben, werden die Objekte am Gitter
ausgerichtet.

Bild anzeigen Wenn Sie diese Eigenschaft aktiviert haben, wird im Zeichenbereich das aktuelle
Bild als Hintergrund angezeigt. Falls nicht, zeichnen Sie auf einer weissen Fläche. Ausserdem
werden in diesem Fall die Farbe und Gestalt der Striche und die Füllung nicht angezeigt.

10.12.16. Kugel-Designer

10.12.16.1. Wirkungsweise

Dieses Filter ist erzeugt dreidimensional erscheinende Kugeln.

10.12.16.2. Filteraufruf

Dieses Filter lässt sich über das Menü Filter → Render → Kugel-Designer im Bildfenster aufrufen.
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Abbildung 10.236. v.l.n.r.: Originalbild, Kugel-Designer angewandt

(a) (b)

Abbildung 10.237. Eigenschaften für das Filter ”Kugel-Designer“

10.12.16.3. Eigenschaften

10.13. Kombinieren

10.13.1. Einführung in die Kombinieren-Filter

Die Filter dieser Kategorie kombinieren zwei oder mehr Bilder zu einem Bild.

10.13.2. Tiefenkombination

10.13.2.1. Wirkungsweise

Mit diesem Filter können Sie zwei Bilder eineinanderblenden. Die jeweils dunkleren Werte werden
sichtbar. Diesen Effekt könnten Sie auch über die Ebenmodi erreichen, dabei stehen Ihnen jedoch we-
sentlich weniger Eigenschaften zur Gestaltung des Ergebnisses zur Verfügung.
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Abbildung 10.238. v.l.n.r.: Originalbild, Tiefenkombination angewandt

(a) (b)

ANMERKUNG

Um dieses Filter sinnvoll verwenden zu können, benötigen Sie mindestens zwei
Bilder gleicher Grösse.

10.13.2.2. Filteraufruf

Dieses Filter lässt sich über das Menü Filter → Kombinieren → Tiefenkombination im Bildfenster
aufrufen.

10.13.2.3. Eigenschaften

Quelle 1; Quelle 2 Mit dieser Eigenschaft legen Sie die Bilder fest, welche kombiniert werden sollen.
Hierzu stehen Ihnen Klappmenüs zur Verfügung, in denen die momentan geöffneten Bilder zur
Auswahl angezeigt werden.

Tiefenkarte Mit dieser Eigenschaft legen Sie das Bild fest, welches als Tiefenkarte für die Transforma-
tion verwendet wird. Die Auswahl können Sie über Klappmenüs vornehmen.

Überlappung Mit dieser Eigenschaft legen Sie fest wie weich die Bilder ineinander übergehen sollen.
Die Einstellung können Sie mit Hilfe eines Schiebereglers oder des zugeordneten Eingabefeldes
im Bereich von 0,0 bis 2,0 vornehmen.

Versatz Mit dieser Eigenschaft können Sie steuern, wie die Überblendung vorgenommen wird. Die
Einstellung können Sie über einen Schieberegler oder das zugeordnete Eingabefeld im Bereich
von -1,0 bis 1,0 vornehmen. Wenn Sie einen sehr kleinen Wert einstellen, wird das in Quelle 1
ausgewählte Bild angezeigt. Je weiter Sie den Wert erhöhen, um so grössere Teile des in Quelle
2 ausgewählten Bildes werden angezeigt. Welche Bildteile für welchen Wert erscheinen hängt von
deren Helligkeit ab.

Skalierung 1; Skalierung 2 Mit diesen beiden Eigenschaften können Sie ähnliche Einstellungen vor-
nehmen, wie mit Versatz, allerdings können Sie die Wirkung für beide Tiefenkarten getrennt
und sehr fein einstellen.
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Abbildung 10.239. Eigenschaften für das Filter ”Tiefenkombination“

10.13.3. Film

10.13.3.1. Wirkungsweise

Dieses Filter ermöglicht es Ihnen eines oder mehrere Bilder zu einem Filmstreifen zu kombinieren.

ANMERKUNG

Bitte beachten Sie, dass dieses Filter die Farben des Bildes nicht verändert.
Insbesondere werden die Farben nicht wie auf einem herkömmlichen Negativfilm
umgekehrt.

10.13.3.2. Filteraufruf

Dieses Filter lässt sich über das Menü Filter → Kombinieren → Film im Bildfenster aufrufen.

10.13.3.3. Eigenschaften

Höhe an Bilder anpassen Wenn Sie diese Eigenschaft aktiviert haben, wird die Höhe des Origi-
nalbildes als Höhe des Filmstreifens verwendet.

Höhe Diese Eigenschaft ermöglicht es Ihnen die Höhe des Filmstreifens in Pixeln einzustellen.
Falls die Originalbilder eine abweichende Höhe haben, werden diese entsprechend skaliert.
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Abbildung 10.240. v.l.n.r.: Originalbild, Film angewandt

(a) (b)

Abbildung 10.241. Eigenschaften (Auswahl) für das Filter ”Film“

Reiter Auswahl

Die Einstellung können Sie mit Hilfe eines Eingabefeldes vornehmen.

Farbe Durch einen Klick auf die Farbschaltfläche können Sie die Farbe des Filmstreifens, also
des Rahmens um die Bilder herum, einstellen. Hierzu steht Ihnen ein Farbauswahldialog zur
Verfügung.

Startindex Die Bilder auf dem Filmstreifen werden fortlaufend nummeriert. Mit dieser Eigen-
schaft können Sie den Startwert festlegen. Hierzu steht Ihnen ein Eingabefeld zur Verfügung.

Schrift Mit dieser Eigenschaft können Sie die Schriftart wählen, in der die Beschriftung des Film-
streifens vorgenommen wird. Klicken Sie hierzu auf die Schaltfläche zur Schriftauswahl.

Farbe Durch einen Klick auf die Farbschaltfläche können Sie die Farbe der Beschriftung des
Filmstreifens einstellen. Hierzu steht Ihnen ein Farbauswahldialog zur Verfügung.

Am Kopf; Am Fuss Mit diesen beiden Eigenschaften können Sie festlegen, ob die Beschriftung
ober- und/oder unterhalb der Bilder erfolgen soll.
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Vorhandene Bilder Diese Liste enthält die Bilder welche Sie auf einem Filmstreifen kombinieren
können. Wählen Sie eines oder mehrere Bilder aus und betätigen Sie die Schaltfläche Hin-
zufügen, um die Bilder auf mit auf dem Filmstreifen zu erhalten.

Auf dem Film Diese Liste enthät die Bilder, welche auf dem Filmstreifen erscheinen sollen. Sie
können Bilder zur auswählen und Betätigen der Schaltfläche Entfernen wieder aus der Liste
streichen.

Abbildung 10.242. Eigenschaften (Erweitert) für das Filter ”Film“

Reiter Erweitert

Bildhöhe Mit dieser Eigenschaft können Sie die Höhe des Bildes im Filmstreifen einstellen. Hier-
zu stehen Ihnen ein Schieberegler und ein zugeordnetes Eingabefeld zur Verfügung. Die Ein-
stellung kann im Bereich von 0,0 bis 1,0 erfolgen.

Bildabstand Mit dieser Eigenschaft können Sie die Stegbreite des Filmstreifens zwischen den
Bildern einstellen. Hierzu stehen Ihnen ein Schieberegler und ein Eingabefeld zur Verfügung.
Die Einstellung kann im Bereich von 0,0 bis 1,0 erfolgen.

Lochversatz Mit dieser Eigenschaft können Sie den Abstand des ersten Loches des Filmstrei-
fens vom Rand einstellen. Hierzu stehen Ihnen ein Schieberegler sowie ein Eingabefeld zur
Verfügung. Die Einstellung kann im Bereich von 0,0 bis 1,0 erfolgen.

Lochbreite Mit dieser Eigenschaft können Sie den Breite der Löcher des Filmstreifens einstellen.
Hierzu stehen Ihnen ein Schieberegler sowie ein Eingabefeld zur Verfügung. Die Einstellung
kann im Bereich von 0,0 bis 1,0 erfolgen.

Lochhöhe Mit dieser Eigenschaft können Sie den Höhe der Löcher des Filmstreifens einstellen.
Hierzu stehen Ihnen ein Schieberegler sowie ein Eingabefeld zur Verfügung. Die Einstellung
kann im Bereich von 0,0 bis 1,0 erfolgen.

Lochabstand Mit dieser Eigenschaft können Sie den Abstand zwischen den Löchern des Film-
streifens einstellen. Hierzu stehen Ihnen ein Schieberegler sowie ein Eingabefeld zur Verfügung.
Die Einstellung kann im Bereich von 0,0 bis 1,0 erfolgen.
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Nummernhöhe Mit dieser Eigenschaft können Sie die Höhe der Beschriftung auf dem Filmstrei-
fen, proportional zur Höhe des Bildes einstellen. Hierzu stehen Ihnen ein Schieberegler sowie
ein Eingabefeld zur Verfügung. Die Einstellung kann im Bereich von 0,0 bis 1,0 erfolgen.
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A

Ausblenden Beim Ausblenden werden die Kanten einer Region weich in den Hintergrund überblendet.

Alpha Der Alphawert gibt die Deckkraft des Pixels an. Je kleiner der Alphawert eines Pixels ist, desto
stärker wird die Farbe der darunter liegenden Ebene sichtbar. Ein Pixel mit dem Alphawert 0 ist
vollkommen transparent.

Ein Fachartikel <http://de.wikipedia.org/wiki/Alphakanal>, welcher sich ausführlich
mit dem Thema beschäftigt, findet sich bei Wikipedia <http://de.wikipedia.org>.

Antialiasing Antialiasing ist eine Maßnahme gegen Aliasing. Beim Antialiasing werden Kanten zur
angrenzenden Farbe so berechnet, dass diese keinen störenden Treppeneffekt bilden. In der Regel
werden Intensitäten oder Deckkraft so angepasst, dass ein weicherer Übergang zum Hintergrund
erreicht wird. Bei Auswahlen wird die Deckkraft der Kanten entsprechend reduziert.

Ein Fachartikel <http://de.wikipedia.org/wiki/Antialiasing>, welcher sich ausführlich
mit dem Thema beschäftigt, findet sich bei Wikipedia <http://de.wikipedia.org>.

B

Bilderschlauch Bilderschläuche sind spezielle Pinselformen, welche aus mehreren Bildern bestehen.
Ein Beispiel hierfür wäre ein Pinsel für Fussspuren, der aus zwei Bildern besteht, einem für den lin-
ken Fussabdruck und einem für den Rechten. Würde man mit dieser Pinselform malen, so würde
zunächst ein linker Fussabdruck, dann ein Rechter, dann wieder ein Linker usw. gemalt werden.
Derartige animierte Pinsel sind sehr mächtig - probieren Sie es einmal aus!

BMP Ein unkomprimiertes Dateiformat von Microsoft, welches hauptsächlich in Windows verwendet
wird. Typischerweise wird es mit Farbtiefen von 1, 4 oder 8 Bit verwendet. Das Format unterstützt
aber auch höhere Farbtiefen. Wegen der fehlenden Koprimierung, und den daraus resultierenden
Dateigrössen, ist es jedoch für die Verwendung im Internet ungeeignet.

Ein Fachartikel <http://de.wikipedia.org/wiki/Windows bitmap>, welcher sich ausführlich
mit dem Format beschäftigt, findet sich bei Wikipedia <http://de.wikipedia.org>.

Bitmap Eine Rastergrafik oder Pixelgrafik (Englisch Bitmap) speichert die Information für jeden erfass-
ten Punkt (Pixel) eines Bildes. Im Gegensatz dazu beschreibt eine Vektorgrafik das Bild durch ma-
thematische Funktionen und legt nur die Funktionsparameter ab. Typische Formate für Rastergra-
fiken sind z.B. BMP (Rastergrafikformat der Firma Microsoft), GIF (Graphics Interchange Format),
JPEG (Joint Photographics Expert Group), TIFF (Tagged Image File Format) und PNG (Portable
Network Graphics). (Quelle: Wikipedia <http://de.wikipedia.org/wiki/Rastergrafik>)

Bumpmapping Bumpmapping ist eine Technik zur Darstellung von extrem detailreichen Objekten oh-
ne die Geometriekomplexität des Objekts zu erhöhen, die vor allem in 3D-Visualisierungsprogrammen
zum Einsatz kommt. Der Trick dabei: die nötigen Informationen werden in eine Textur gepackt,
mit deren Hilfe Schattierungen auf eine Oberfläche gezeichnet werden.

Bumpmapping ist somit nur ein (sehr wirksamer) Darstellungs-”Trick”, der Oberflächenunebenheiten
simuliert, die in der Geometrie des Modells gar nicht vorhanden sind. (Quelle: Wikipedia <http:
//de.wikipedia.org/wiki/Bump Mapping>)
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C

CMY, CMYK CMYK steht für Cyan (Türkis), Magenta (Fuchsinrot), Yellow (Gelb) und Key (Schlüsselfarbe)
und ist ein subtraktives Farbmodell, welches bei Druckverfahren eine Rolle spielt. Es ist komple-
mentär zum RGB-Farbmodell.

Der Wertebereich jeder einzelnen Farbe geht von 0% bis 100%, wobei 0% einer unbedruckten und
100% einer Volltonfläche entspricht. Durch Mischen der drei Grundfarben entsteht der Farbraum.

Die Schlüsselfarbe K zu sämtlichen Helligkeitsstufen, Schwarz, dient nicht der Farbgebung, son-
dern lediglich zum Abdunkeln von Farben. Der Begriff ”Key”bzw. Black oder auch Kontrast
(Schwarz) wird anstelle von ”Black”verwendet, um Missverständnissen mit dem ”B”vorzubeugen,
das im Englischen für ”Blueßteht. Die Druckfarbe Schwarz ist unter anderem nötig, weil der Zu-
sammendruck der drei anderen Farben zwar theoretisch (subtraktives Farbmodell), aber nicht
praktisch Schwarz ergibt, da die im Druck verwendeten Cyan-, Magenta- und Gelb-Farbstoffe kei-
ne perfekten Sekundärfarben sind. (Quelle: Wikipedia <http://de.wikipedia.org/wiki/
Dithering>)

Abbildung 10.243. Schematische Darstellung des CMYK Farbmodells

Das CMYK Farbmodell wird von GIMP momentan noch nicht direkt unterstützt. Ein experimen-
telles Modul, welches diese Unterstützung bietet ist unter www.blackfiveservices.co.uk/separate.shtml
<http://www.blackfiveservices.co.uk/separate.shtml> verfügbar.

Dieses Farbmodell wird beim Drucken verwendet. Ihr Farbdrucker enthält diese Farben in sei-
nen Kartuschen. Es ist das Modell in dem gemalt wird, dass immer dann verwendet wird, wenn
Licht nicht ausgestrahlt, sondern reflektiert wird. Objekte reflektieren dabei Licht bestimmter Wel-
lenlängen, während der Rest absorbiert wird. Vom menschlichen Auge werden nur die reflektieren
Wellenlängen wahrgenommen. Ein rotes Objekt erscheint rot, weil der blaue und grüne Anteil des
Lichtes absorbiert wird. Grün und Blau kombiniert ergibt bekanntlich Cyan. Es wird also Cyan
absorbiert, wenn Sie Rot hinzufügen. Umgekehrt wird, wenn Sie Cyan hinzufügen das komple-
mentäre Rot absorbiert. Daher wird das zählt das CMYK Farbmodell zu den subtraktiven Farbmo-
dellen. Wenn Sie Gelb hinzufügen wird Blau reduziert und wenn Sie Magenta hinzufügen wird
Grün reduziert.

Sie könnten sich logisch herleiten, dass durch das Mischen von Cyan, Magenta und Gelb, welches
ja einer Reduktion von Rot, Grün und Blau entspricht, Schwarz entsteht. Leider ist die Sache ein
wenig komplizierter. Wenn Sie es tatsächlich ausprobieren, werden Sie feststellen, dass sich statt
Schwarz ein dunkler Braunton ergibt. Aus diesem Grund verfügt das Farbmodell, ebenso wie
CMYK basierte Drucker, zusätzlich reines Schwarz enthalten. Dises Vorgehen spart ausserdem
noch Geld, das Schwarz nich in schlechter Qualität aus Farbtinte gemischt werden muss.

D

Dateiformat Ein Dateiformat oder Dateityp bestimmt die Form der Abspeicherung von Computerda-
ten. Die Notwendigkeit hierfür entspringt aus der Tatsache, dass für ein Betriebssystem Datei-
en gewöhnlich nur eindimensionale Aneinanderreihungen von Bytes sind. Solche beschränkten,
linearen Strukturen können aber viele Arten von real anfallenden Daten nicht in einer offen-
sichtlichen Weise beschreiben, sodass Konventionen ihre Interpretation als Repräsentanten von
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komplexeren Daten bestimmen. Eine Gesamtheit solcher Konventionen für eine Ärt”von Datei-
en wird als Dateiformat bezeichnet. (Quelle: Wikipedia <http://de.wikipedia.org/wiki/
Dateiformat>)

Typische Dateiformate zur Abspeicherung von Bildern sind JPEG, TIFF, PNG und GIF. Welches
Dateiformat zur Abspeicherung am geeignetsten ist hängt vom Verwendungszweck des Bildes
ab. Im Internet beispielsweise spielt die Dateigrösse eine entscheidende Rolle, im Druckbereich
dagegen sind höchste Auflösungen und Qualität entscheidende Merkmale.

E

Ebenen Ebenen dienen der logischen Gliederrung einzelner Bildbestandteile in einem Bild. Stellen Sie
sich einige Blätter durchsichtiges Papier vor, auf denen einzelne Bildobjekte verteilt sind. Legen
Sie nun alle Blätter zusammen und schauen von oben auf den Stabel ergibt sich das Gesamtbild.

Abbildung 10.244. Darstellung eines Bildes aufgeteilt in Ebenen.

Abbildung 10.245. Ein zusammengefügtes Bild.

F

Farbraum, Farbmodell Ein Farbraum ist eine Menge von Farben, die von einem Ein- oder Ausgabe-
gerät (Scanner, Bildschirm, Drucker etc.) oder unter spezifischen Bedingungen erkannt bzw. dar-
gestellt werden können. Die Farben eines Farbraumes werden durch ein Farbraumsystem quanti-
fiziert. Ein Farbraumsystem ist ein Koordinatensystem, in dem die einzelnen Farben durch Basis-
koordinaten auf verschiedenen Achsen charakterisiert werden. Bedingt durch den Aufbau des
menschlichen Auges sind es bei für menschliche Betrachter gedachte Farbräume in den aller-
meisten Fällen drei Achsen. Verwendung finden etwa 30-40 Farbraumsysteme. Prominente Bei-
spiele sind RGB, HSV, CMY(K), YUV und YCbCr. Häufig wird ein Farbraumsystem und der
entsprechende Farbraum, auf dem das System basiert, nicht unterschieden, sondern zusammen-
gefasst als Farbmodell bezeichnet. (Quelle: Wikipedia <http://de.wikipedia.org/wiki/
Farbmodell>)

Farbrasterung Die Farbrasterung, auch als Dithering (englisch ”dither”, ”schwanken“, ”zittern“) be-
zeichnet, ist eine Technik in der Computergrafik, um bei Bildern mit geringer Farbtiefe die Illusi-
on einer größeren Farbtiefe zu erzeugen. Bei einem gedithertem Bild werden die fehlenden Far-
ben durch eine bestimmte Pixel-Anordnung aus verfügbaren Farben nachgebildet. Das mensch-
liche Auge nimmt diese als Mischung der einzelnen Farben wahr. (Quelle: Wikipedia <http:
//de.wikipedia.org/wiki/Dithering>)

Schwebende Auswahl Schwebende Auswahlen ähneln normalen Ebenen mit dem Unterschied, dass
verankert werden müssen um mit GIMP weiterarbeiten zu können. Auf schwebenden Auswah-
len können alle möglichen Funktionen angewandt werden um die Bilddaten der schwebenden
Auswahl zu verändern.
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Zwei Möglichkeiten existieren um eine schwebende Auswahl zu verankern. Die Erste ist die Er-
stellung einer neuen Ebene aus der schwebenden Auswahl. Bei der zweiten Möglichkeit wird die
schwebende Auswahl auf der darunterliegenden, aktiven Ebene verankert. Dies geschieht, in dem
ausserhalb der schwebenden Auswahl mit der linken Maustaste geklickt wird.

Jede kopierte und neu eingefügte Auswahl wird als schwebende Auswahl angelegt.

G

Gammawert Siehe Gammawert <http://de.wikipedia.org/wiki/Gamma-Wert> oder Gamm-
akorrektur <http://de.wikipedia.org/wiki/Gammakorrektur>

GIF GIF steht für Graphics Interchange Format und ist ein Dateiformat mit guter verlustfreier Kom-
primierung für Bilder mit geringer Farbtiefe (bis zu 256 verschiedene Farben pro Einzelbild). In-
zwischen gibt es ein neues Format namens Portable Network Graphics (PNG), welches technisch
in allen Belangen besser ist als GIF, abgesehen von Animationen und einigen kaum verwendeten
Eigenschaften.

GIF wurde 1987 von dem US-Onlinedienst CompuServe eingeführt. Es wurde vor allem wegen
seiner effizienten Kompression LZW populär. Die entstandenen Bilddateien benötigten deutlich
weniger Speicherplatz, als andere zu der Zeit übliche Grafikformate wie PCX oder MacPaint.
Selbst große Bilder konnten so in vernünftiger Zeit übertragen werden, auch mit langsamen Mo-
dems. Zudem ermöglichte die offene Lizenzpolitik von CompuServe jedem Programmierer, das
GIF-Format für eigene Anwendungen kostenlos zu implementieren, sofern dieser einen Hinweis
auf das Urheberrecht des Online-Dienstes anbrachte.

Bei GIF sind die Farbinformationen in einer Farbtabelle abgelegt. Diese kann bis zu 256 verschie-
dene Einträge enthalten, die frei aus 16,7 Millionen möglichen Farbwerten auswählbar sind. Als
das Bildformat vorgestellt wurde, war dies keine wesentliche Einschränkung, da nur wenige Leu-
te Hardware besaßen, die mehr Farben anzeigen konnte. Für typische Zeichnungen, Cartoons,
Schwarz-Weiß-Fotografien und ähnliches sind 256 Farben in der Regel auch heute noch völlig
ausreichend, bei komplexeren Bildern wie z. B. Farb-Fotos ist jedoch meist ein massiver Qua-
litätsverlust feststellbar, weshalb das Format dafür als ungeeignet gilt.

Ein Farbeintrag in der Palette kann als transparent definiert werden. Dadurch kann man den Ein-
druck erwecken, ein GIF-Bild hätte eine nicht rechteckige Form. Halbtransparenzen wie bei PNG
sind damit aber nicht möglich, ein Pixel kann entweder nur voll sichtbar oder komplett ”durch-
sichtigßein.

Die erste GIF-Version war die Version 87a. 1989 veröffentlichte CompuServe eine erweiterte Versi-
on, die 89a genannt wird. Diese ermöglicht u.a. das Speichern mehrerer Bilder in einer GIF-Datei,
was vor allem für einfache Animationen verwendet wird. Man kann die Version an den ersten
sechs Bytes einer GIF-Datei erkennen. Interpretiert man diese als ASCII-Zeichen, so steht dort
”GIF87a”bzw. ”GIF89a”. (Quelle: Wikipedia <http://de.wikipedia.org/wiki/GIF>)

GNU Das GNU-Projekt wurde von Richard Stallman mit dem Ziel gegründet, ein vollständig freies
Betriebssystem, das GNU System, zu entwickeln.

Bekannt ist es insbesondere durch die GNU General Public License (GPL) und GNU/Linux, einer
GNU-Variante mit Linux-Kernel.

Der Name GNU entstand aus der Namensgebung, die am MIT – dem Institut, an dem Stallman
zu dieser Zeit arbeitete – verbreitet war. Für Programme, die anderen Programmen ähneln, wur-
den rekursive Akronyme als Namen gewählt. Da das neue System auf dem verbreiteten Betriebs-
system UNIX aufbauen sollte, suchte Stallman einen solchen Namen und kam dabei auf GNU,
was für ”GNU is not Unix“ steht. Der Name soll, um Verwechslungen zu vermeiden, wie das
deutsche ’Gnu’ ausgesprochen werden, nicht wie im Englischen (also wie new). Die Entschei-
dung, GNU Unix-kompatibel zu machen, hatte mehrere Gründe. Zum einen war Stallman sicher,
dass die meisten Firmen ein grundlegend neues Betriebssystem ablehnen würden, wenn die Pro-
gramme, die sie benutzten, darauf nicht laufen würden. Andererseits ermöglichte die Architek-
tur von Unix eine schnelle, einfache und verteilte Entwicklung, da Unix aus vielen kleinen Pro-
grammen besteht, die größtenteils unabhängig von einander entwickelt werden können. Auch
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waren viele Bestandteile eines Unix-Systems frei für jeden erhältlich und konnten so direkt in
GNU integriert werden, beispielsweise das Textsatzsystem TeX oder das Fenstersystem X Win-
dow. Die fehlenden Teile wurden von Grund auf neu geschrieben. (Quelle: Wikipedia <http:
//de.wikipedia.org/wiki/GNU>)
Auch GIMP ist ein offizielles GNU Programm.

Graustufen Wie für das RGB Farbmodell angedeutet, können 24 Bit Bilder in GIMP bis zu 256 Graustu-
fen enthalten. Obwohl in GIMP Bilder im Modus Graustufen angelegt und in diesen umgewandelt
werden können ist dies im eigentlichen Sinn kein Farbmodell.

H

Hextriplet Ein Weg um das Farbspektrum im Computer zu kodieren. Die Raute ”#”wird benutzt um
zu kennzeichnen, dass die nachfolgende Zahl eine hexidezimale Codierung aufweist. Dabei wird
jeder Farbe in zwei hexadezimalen Zahlenwerten gespeichert. Dabei entsteht ein Tripel (3 Paare)
von Hexwerten die folgende Form haben: #rrggbb.

Hilfslinien Hilfslinien sind ein komfortabler Weg, um eine Auswahl oder eine Ebene zu positionieren.
Sobald die Hilfslinie erzeugt wurde, wird das Werkzeug ”Verschieben“ aktiviert, und der Maus-
zeiger nimmt die zugehörige Form an.
Um eine Hilfslinie zu erzeugen, klicken Sie einfach auf eines der Lineale im Bildfenster und ziehen
Sie die Hilfsline heraus, während Sie die Maustaste gedrückt halten. Die Hilfsline erscheint dann
als blaue, gestrichelte Linie.
Wie sich die Hilfslinie verhält, bestimmt die Eigenschaft Wirkt auf des automatisch aktivierten
Werkzeuges ”Verschieben“. Ist die Einstellung Ebene transformieren aktiviert, verwandelt sich
der Mauszeiger in das Symbol einer kleinen Hand, sobald er sich in der Nähe einer Hilfslinie
befindet. Die Hilfslinie verfärbt sich dann rot und wird aktiviert. Sie können die Hilfslinie dann
verschieben, oder zurückschieben in das Lineal auch löschen. Wird statt Ebene transformieren
die Eigenschaft Auswahl transformieren aktiviert, können Sie Hilfslinien zwar anlegen, aber dan-
nach nicht mehr verschieben.
Um die Positionierung zu erleichtern, können Sie die Hilfslinien durch einschalten der Eigenschaft
Ansicht → Magnetisches Gitter ”magnetisieren“.
Ausserdem können Sie unter Verwendung des Menüs Ansicht→ Hilfslinien anzeigen alle Hilfs-
linien gleichzeitig ein- und ausblenden. Diese Funktion ist so nützlich, dass Sie zusätzlich über
das Tastenkürzel Shift–Ctrl–T erreichbar ist.

Histogramm In der digitalen Bildverarbeitung versteht man unter einem Histogramm die statistische
Häufigkeit der Grauwerte bzw. der Farbwerte in einem Bild. Das Histogramm eines Bildes erlaubt
eine Aussage über die vorkommenden Grau- bzw. Farbwerte und über Kontrastumfang und Hel-
ligkeit des Bildes. In einem farbigen Bild kann entweder ein Histogramm über alle möglichen
Farben oder drei Histogramme über die einzelnen Farbkanäle erstellt werden; letzteres ist meist
sinnvoller, da die meisten Verfahren auf Grauwertbildern basieren und so die sofortige Weiterver-
arbeitung möglich ist. (Quelle: Wikipedia <http://de.wikipedia.org/wiki/Histogramm#
Histogramm in der Bildverarbeitung>)

Hochrechnung (Anpassende) Die Hochrechnung (engl. Supersampling) werden umliegende Pixel
zur Berechnung eines Farbverlaufs mit einbezogen. Das Resultat wird dabei verbessert, jedoch
wird für die Berechnung mehr Zeit benötigt.

HSV HSV bezeichnet ein Farbmodell, bestehend aus Komponenenten für Farbton (Hue), Sättigung (Sa-
turation) und Wert (Value).
Das RGB Farbmodell ist hervorragend für Computerbildschirme geeignet, aber es beschreibt nicht
was wir im täglichen Leben sehen: leuchtendes Grün, fahles Pink, schillerndes Rot usw. Das HSV
Modell berücksichtigt diese Eigenschaften. HSV und RGB sind jedoch nicht völlig unabhängig
voneinander. Sie können das im Farbwähler sehen: sobald Sie einen der Werte ändern, ändert sich
auch der andere. Die Mutigen unter Ihnen können einen Blick auf den Artikel <http://de.
wikipedia.org/wiki/HSV-Farbraum> bei Wikipedia werfen, der die Beziehung ausführlich
darstellt.
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• Leuchtkraft (Hue): Dies ist die Farbe selbst, also das Ergebnis einer Kombination der Primärfarben.
Alle Farbtöne (ausser den Graustufen) sind in einem Farbkreis dargestellt: Gelb, Blau und auch
violett, orange usw. Der Farbkreis reicht von 0° bis 360°.

• Sättigung (Saturation): Dieser Parameter beschreibt wie blass eine Farbe ist. Eine komplett
ungesättigte Farbe ist ein Grauton. Wird die Sättigung erhöht, entsteht ein Pastellton. Eine
komplett gesättigte Farbe ist rein. Der Wertebereich reicht von 0 bis 100.

• Wert (Value): Dieser Parameter beschreibt die Helligkeit. Er gibt die Lichtmenge an, die eine
Farbe ausstrahlt. Der Wertebereich reicht von 0 bis 100. Die Pixelwerte der drei Farbkanäle
im RGB Modell geben ebenfalls Helligkeiten an. Ihre Summe entspricht dem Wert im HSV
Modell.

I

Inkrementeller Malmodus Dieser Malmodus zeichnes jeden Pinselstrich direkt auf die aktive Ebene.
Wenn der inkrementelle Malmodus nicht aktiviert ist, wird auf einer Zeichenfläche gemalt, die
dann mit der aktiven Ebene zusammengemischt wird.

Die beiden Bilder wurden mit einem Pinsel erstellt, dessen ”Abstand“ auf 60 Pixel eingestellt war.
Im linken Bild war der Inkrementelle Malmodus ausgeschaltet. Das rechte Bild zeigt den Unterschied
durch den eingeschalteten Inkrementellen Malmodus.

Indizierte Farben Das Prinzip der indizierten Farben ist, jedem Pixel eine Farbnummer (8 Bit) zu ge-
ben, und dann in einer Tabell die zu dieser Nummer gehörige Farbe zu hinterlegen. Obwohl in
GIMP Bilder im Modus Indizierte Farben angelegt und in diesen umgewandelt werden können ist
dies im eigentlichen Sinn kein Farbmodell.

Weitere Informationen finden Sie im Abschnitt Farbtabelle.

Interpolation In der Bildverarbeitung verwendet man Interpolationsverfahren, um gerasterte Bilder zu
vergrößern (”digitaler Zoom”). Da diese Bilder aber nur eine begrenzte Bildauflösung haben, führt
die Wiederholung von Bildpunkten zu dem bekannten ”Treppchen-Effekt”. Das Phänomen ist
allgemein auch als Aliasing bekannt. Interpoliert man stattdessen die hinzugefügten Bildpunkte
aus den bekannten Nachbarpunkten (Antialiasing), so werden die Kanten glatter, was aber zu
Lasten der Bildschärfe geht. Die optische Auflösung des Bildes wird durch die Interpolation nicht
vergrößert. (Quelle: Wikipedia <http://de.wikipedia.org/wiki/Interpolation>)

GIMP bietet verschiedene Interpolationsverfahren, welche sich in Qualität und Geschwindigkeit
unterscheiden. Dabei gilt je besser die Qualität ist, umso länger dauert die Bearbeitung.

J

JPEG Das Dateiformat JPEG basiert auf der gleichnamigen Kompression. Die JPEG-Kompression ist
für natürliche (Raster-)Bilder entwickelt worden. Das sind Bilder, wie man sie in der Fotographie
oder bei computergenerierten Bilder (CGI) vorfindet. Ungeeignet ist JPEG für

• digitale Strichzeichnungen (z. B. Screenshots oder Vektorgraphiken), in denen es viele be-
nachbarte Bildpunkte mit exakt identischen Farbwerten, wenige Farben und harte Kanten
gibt.

• Schwarzweißbilder (nur Schwarz und Weiß, 1 bit pro Bildpunkt).

• gerasterte Bilder (Zeitungsdruck)
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Für diese Bilder sind Formate wie GIF, PNG oder JBIG weitaus besser geeignet.

Eine JPEG-Transformation ist im Allgemeinen nicht reversibel. Das Öffnen und anschließende
Speichern einer JPEG-Datei führt zu einer neuen verlustbehafteten Kompression. Ein nachträgliches
Heraufsetzen des Qualitätsfaktors vergrößert zwar den Speicherbedarf der Bilddatei, bringt aber
verlorene Bildinformation nicht mehr zurück. (Quelle: Wikipedia <http://de.wikipedia.
org/wiki/JPEG>)

K

Kanäle Jedes Bild kann in separaten Kanälen aufgeteilt werden. Für die Ausgabe werden alle sepe-
rierten Kanäle wieder zu einem Bild zusammengefügt. Ausgegeben werden können Bilder neben
den Monitor auch auf einem Drucker oder einem Plotter. Die Kanäle, die für den Monitor wichtig
sind, ergeben sich aus Rot, Grün und Blau. Andere Ausgabegeräte, zum Beispiel professionelle
Druckmaschienen, benutzen andere Kanäle um das Bild zusammenzufügen.

Nützlich erweisen sich Kanäle vor allem dann, wenn man Bildoperationen nur für eine bestimmte
Farbe durchführen lassen möchte. Als beliebtes Beispiel lässt sich hier, dass retuschieren an roten
Augen anführen. Gerade bei Anwendung von Filtern auf bestimmten Kanälen, lassen sich sehr
subtile Effekte erzielen. Dem Benutzer sei es überlassen, dies auszuprobieren.

L

L*a*b Der Lab-Farbraum (auch L*a*b-Farbraum) ist ein Anfang der 30er Jahre des 20. Jahrhunderts von
der Commission Internationale d‘Eclairage (CIE) entwickeltes Farbmodell. Es schließt alle Farben
ein, die das menschliche Auge wahrnehmen kann. Darin enthalten sind unter anderem die Farben
des RGB- und des CMYK-Farbraumes. In Lab wird eine Farbe durch die drei Werte L, a und b
angegeben. Hierbei steht das L für die Helligkeitskomponente (luminance) - entsprechend dem
Grauwert - und a und b repräsentieren den rot-grün- bzw. blau-gelb-Anteile der Farbe.

Im Gegensatz zum RGB oder CMYK ist Lab nicht von den unterschiedlichen Ein- und Ausgabe-
geräten abhängig. Deshalb benutzt man dieses Format als Austauschformat zwischen den Geräten.
Lab ist auch das interne Farbmodell von PostScript Level II.

(Quelle: Wikipedia <http://de.wikipedia.org/wiki/Lab-Farbraum>)

Laufende Ameisen Der Begriff bezeichnet die gestrichelte Linie, mit der eine Auswahl umrandet ist.
Die Begrenzungslinie ist animiert, so dass sie aussieht, wie kleine Ameisen, die hintereinander
herlaufen.

M

Ebenen Modi GIMP bietet 21 Blendenmodi für die Ebenen. Der Blendenmodus wird auf die Ebenen
angewendet, die unter der ausgewählten Ebene liegen. Gibt es nur eine Ebene, hat die Blende kei-
nen Effekt. So liegt es nahe, dass für die Blendenmodi mindestens 2 übereinanderliegende Ebenen
gebraucht werden. Die Beispielbilder zeigen die Auswirkungen bei Anwendung des jeweiligen
Modus. Das link Bild ist der normale Zustand, dass rechte gibt das Blendergebnis wieder.

Normal
Das ist der normale Blendenmodus der Ebene. Die oberste Ebene verdeckt alle unteren Ebe-
nen.
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Vernichtend Bei dem Vernichtend Blendenmodus werden die Pixel verstreut. Dies wird vor al-
lem sichtbar, bei Kanten des Bildes.

Das linke Bild gibt das Bild vergrössert, ohne Blende wieder. Rechts wurde der Blendenmo-
dus angewendet, wo deutlich zu sehen ist, wie die Pixel verstreut werden.

Multiplizieren
Dieser Blendenmodus multipliziert alle Farbwerte der oberen und unteren Ebene. Das Ergeb-
nis ist meist ein dunkleres Bild. Weiße Ebenen verändern den Hintergrund nicht, schwarze
hingegen ergeben ein komplett schwarzes Ergebnis.

Division
Der Blendenmodus Division ist eine Art invertierter Multiplikationsmodus. Anstatt die Farb-
werte der Pixel zu multiplizieren, werden diese dividiert. Das Ergebnis ist meist ein helleres
Bild.

Bildschirm
Der Bildschirm Modus ist das Gegenteil zum Multiplikationsmodus. Die Farbwerte beider
Ebenen, werden invertiert, dann multipliziert und das Ergebnis wieder invertiert. Das Ergeb-
nis ist meist ein helleres Bild. Aussnahmen bilden hierbei schwarze Ebenen, die den Hinter-
grund nicht verändern. Weiße Ebenen ergeben ein Weisses Bild.

Überlagern
Der Überlagern Modus ist eine Kombination aus Multiplikation und Screen Modus. Abhängig
ist dies von das Ausgangsfarbe.

Abwedeln
Bei dem Blendenmodus Abwedeln, werden die Farbwerte der zweiten Ebene vorerst inver-
tiert. Danach werden die Werte dividert. So ist dieser Blendenmodus ähnlich eines invertier-
ten Multiplikationsmodus.

Nachbelichten
Ähnlich dem Modus Abwedeln, wird der Blendenmodus Nachbelichten berechnet (die Farb-
werte der oberen Ebene werden invertiert). Der Unterschied hierbei ist, dass sich der Modus
ähnlich dem Bildschirm Modus verhält, anstatt der Multiplikation.
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Harte Kanten
Dieser Blendenmodus ist eine Kombination aus Bildschirm und Multiplikation. Abhängig
ist dies von dem Wert der Ergebnisfarbe.

Weiche Kanten
Dieser Blendenmodus hat bis auf seinem Namen nichts mit dem Harte Kanten Modus ge-
meinsam. Das Ergebnis dieses Blendenmodus ist ähnlich dem Überlagern Modus.

Grain Extract

Grain Merge

Unterschied
Bei diesem Blendenmodus werden die Farbwerte voneinander subtrahiert und ein Absolut-
wert gebildet. In Abhängigkeit von den Ausgangsebenen, wirkt das Ergebnis etwas abson-
derlich. Anwendung findet es vor allem zum invertieren von Bildelementen.

Addition
Ein einfacher Blendenmodus, der einfach beide Farbwerte miteinander addiert.

Subtraktion

Nur Abdunkeln
Beide Farbwerte werden bei diesem Blendenmodus miteinander verglichen und der kleinere
Werte wird benutzt. Komplett weisse Ebenen verändern nichts an dem Ergebnisbild, kom-
plett schwarze ergeben ein schwarzes Bild.

Nur Aufhellen
Im Unterschied zur Nur Abdunkeln wird bei diesem Blendenmodus der grössere Farbwert
bevorzugt. So verändern komplett schwarze Ebenen nicht das Bild, sondern nur komplett
weisse Ebenen. Diese färben das Ergebnisbild weiss.

Farbton
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Hier wird bei der Überblendung der Farbton des Blendenbildes benutzt, sowie Sättigung und
Lichtwerte des Ausgangsbildes.

Sättigung
Hier wird bei der Überblendung die Sättigung des Blendenbildes benutzt, sowie Farbton und
Lichtwerte des Ausgangsbildes.

Farbe
Hier wird bei der Überblendung der Farbton und die Sättigung des Blendenbildes benutzt,
sowie Lichtwerte des Ausgangsbildes.

Wert Hier wird bei der Überblendung der Farbton und Lichtwert des Blendenbildes benutzt, so-
wie Sättigung des Ausgangsbildes.

Maske Masken sind spezielle Elemente, die an eine Auswahl oder eine Ebene gekoppelt sind. Masken
bestimmen dabei die Transparenz der zugehörigen Auswahl oder Ebene.

Es gibt zwei verschiedene Maskentypen:

• Ebenenmasken: Jede Ebene kann eine eigene Maske haben. Die Ebenenmaske repräsentiert den
Alphakanal der Ebene und erlaubt die Verwaltung der Transparenz der Ebene. Sie können
Teile einer Ebene transparent machen, indem Sie eine Ebenenmakse verwenden. Auf die-
ser können Sie mit Transparenz malen. Malen mit Schwarz macht die Eben an dieser Stelle
durchscheinend, malen mit Weiß macht die Ebene an dieser Stelle sichtbar. Hierzu können Sie
beliebige Werkzeuge benutzen. Sie können mit Ebenenmasken Übergangseffekte, Volumen-
effekte und die Verschmelzung verschiedener Objekte eines anderen Bildes erreichen. Lesen
Sie auch den Abschnitt Ebenenmasken, um weitere Informationen zu erhalten.
Kanalmaske, auch bezeichnet als Auswahlmaske: Diese Maske repräsentier den Alphakanal ei-
nes Bildes. Durch das Malen mit Weiß können Sie die Maske entfernen und die Auswahl
vergrößern, bei Verwendung von Schwarz wird die Auswahl verkleinert. Dieses Vorgehen
erlaubt es sehr exakt eine Auswahl zu erstellen. Mehr noch, Kanalmasken erlauben es eine
Auswahl abzuspeichern. Sie können diese später über den Befehl ”Kanal zu Auswahl“ aus
dem Kanal Menü wieder laden. Kanalmasken sind so wichtig, dass GIMP einen speziellen
Typ davon zur Verfügung stellt, die Quick Maske. Beachten Sie auch den Abschnitt Aus-
wahlmasken, um weitere Informationen zu erhalten.

Moiré-Effekt Der Moiré-Effekt (franz. moirer = moirieren) macht sich bei der Überlagerung von Rastern
oder Linien durch die Entstehung neuer Linien bemerkbar. Zum Beispiel tritt er auf beim Scannen
von Bildern mit periodischen Strukturen (karierte Hemden, Rasterbilder), wenn das Bild digital
abgetastet wird, oder auch beim Siebdruck durch Überlagerung der Siebstruktur mit Strichmus-
tern im Bild. (Quelle: Wikipedia <http://de.wikipedia.org/wiki/Moire>)

P

Pfad Ein Pfad ist eine eindimensionale Kurve. Ihre Hauptanwendung finden Pfade in GIMP vor allem
um Auswahlen oder schwierige Formen zu Erstellen, die dann nachgezeichnet werden können.
Für weitere Informationen zu Pfaden können Sie die Einführung anschauen. Das Kapitel Pfad-
werkzeug erklärt wie Pfade erstellt werden.
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PDB In der Prozeduren Datenbank (kurz: PDB) sind alle Funktionen registriert die GIMP und die Er-
weiterungen zur Verfügung stellen. Entwickler können in der Datenbank nach nützliche Program-
mierinformationen über die bereitgestellten Funktionen nachschlagen.

PDF Das Portable Document Format wurde durch Adobe entwickelt, um Defizite von Postscript ab-
zustellen. Die Unterstützung von PDF (genauso wie Postscript) wird durch die freien Ghostscript
Bibliotheken erreicht.

Postscript Postscript ist eine sogenannte Seitenbeschreibungssprache udn wurde von Adobe vorwie-
gend für Drucker oder andere Ausgabegeräte entwickelt. So beschreibt Postscript das Aussehen
einer Grafik, anstatt die Selbige zu speichern. Um die Grafik wieder anschauen zu können muss
sie durch einen Postscript-Interpreter geladen werden. GIMP unterstützt Postscript nur indirekt
durch das frei verfügbare Ghostscript. Ghostscript interpretiert eine mit Postscript formatierte Da-
tei und wandelt es in ein Pixelformat um. Deshalb eignet sich GIMP schlecht um wiederum im
Postscript Format abzuspeichern.

Formate zur Beschreibung von Grafiken werden allgemein als Vektorformate bezeichnet. Zur Be-
schreibung werden geometrische Primitiven wie Linien, Kreise, Text und Pfade verwendet. Der
Vorteil bei dieser Vorgehensweise ist die Unabhängigkeit von der Auslösung der Grafik jedoch
lassen sich mit Vektorformate sehr schwierig kleinste Details beschreiben.

PNG PNG (Portable Network Graphics) sollte einst das GIF Format ablösen, um Patentschwierigkeiten
aus dem Wege zu gehen. Das Format selber unterstützt Indexierte, Graustufen und RGB Farben,
sowie einen optionalen Alphakanal. PNG benutzt ein Kompressionsverfahren ohne dabei Bildin-
formationen zu verlieren.

PSD PSD ist das hauseigene Dateiformat von Adobe Photoshop™, vergleichbar mit dem GIMP eige-
nen XCF. Es ist leider nicht immer möglich Photoshop Dateien lesen zu können und vor allem,
alle abgespeicherten Informationen auch in GIMP um zu setzen (z.B. Ebeneneffekte). Leider ist
der Zugang zu den Informationen für Entwickler, um einen guten Im- und Export des Dateifor-
mates zu ermöglichen, nur für ausgewählte Personen erreichbar. GIMP Entwickler gehören leider
nicht zum ausgewählten Personenkreis, so dass auch in Zukunft nicht mit einer Unterstützung
aktueller Photoshop Versionen zu rechnen ist.

R

Abbildung 10.246. Additives Farbmodell

RGB

RGB ist ein Akronym für Rot, Grün, Blau. Es bezeichnet ein Farbmodell, welches verwendet wird,
um Farben auf Computern und Fernsehgeräten darzustellen. Die Farben werden von den Geräten
ausgesendet und nicht wie bei Gemälden reflektiert. Die sich ergebende Farbe ist eine Kombi-
nation der Primärfarben Rot, Grün und Blau mit jeweils unterschiedlicher Helligkeit. Wenn Sie
ganz nah an einen Fernsehschirm herangehen, können Sie die einzelnen roten, grünen und blauen
Elemente in unterschiedlichen Helligkeiten leuchten sehen. Das Farbmodell RGB ist ein additives
Farbmodell.

GIMP verwendet 8 Bit pro Kanal für jede Primärfarbe. Daraus ergeben sich 256 verschiedene Werte
(Helligkeiten) für jede Primärfarbe, welche insgesamt zu 256x256x256 = 16,777,216 verschiedenen
Farben gemischt werden können.
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Es ist nicht offensichtlich warum Kombinationen der Primärfarben gelegentlich unerwartete Far-
ben ergeben. Warum entsteht zum Beispiel aus der Kombination 229R+205G+229B die Farbe Pink?
Das Ganze hängt vom menschlichen Auge und dem Gehirn ab. Es gibt in der Natur keine Far-
ben, sondern lediglich ein kontinuierliches Spektrum der Wellenlänge des Lichtes. In der Reti-
na <http://de.wikipedia.org/wiki/Netzhaut>, der Netzhaut des Auges, befinden sich
drei verschiedene Arten von Zapfen. Eine konstante Wellenlänge regt diese drei Arten von Zapfen
unterschiedlich an. Das Gehirn hat nach einigen Millionen Jahren Evolution gelernt, diese Unter-
schiede als Farben zu erkennen.

Es ist leicht einzusehen, dass kein Licht (0R+0G+0B) Dunkelheit, bzw. Schwarz ergibt, während
volles Licht (255R+255G+255B) weiss erzeugt. Eine gleiche Hellikeit aller Kanäle ergibt einen
Grauwert. Daraus ergibt sich, dass in GIMP lediglich 256 verschiedene Graustufen existieren.

Werden im RGB Modus zwei Primärfarben gemischt, ergibt dies eine Sekundärfarbe, also eine Farbe
des CMY Modells. Die Kombination von Rot und Grün ergibt Gelb (Yellow), Grün und Blau er-
geben Cyan, und Blau und Rot ergeben Magenta. Verwechseln Sie diese dabei bitte nicht mit den
sogenannten Komplementärfarben, welche die Farben sind, die sich im Farbkreis gegenüberstehen:

Das Mischen einer Primärfarbe mit seiner Komplementärfarbe ergibt Grau.

Es ist sehr wichtig zu verstehen, was passiert wenn Sie in GIMP mit Fargen hantieren. Die wich-
tigste Regel, welche Sie sich merken sollten ist, dass die Verminderung der Intensität einer Primärfarbe
automatisch eine Erhöhung der Intensität der Komplementärfarben bewirkt. Dies gilt natürlich
auch in umgekehrter Richtung. Warum ist das so? - Nun, wenn Sie den Wert für einen Kanal,
beispielsweise Grün, verringern, wird automatisch die relative Wichtigkeit der Rot und Blauan-
teile erhöht. Die Kombination dieser beiden Kanäle ergibt wiederum die Sekundärfarbe Magenta,
welche gleichzeitig die Komplementärfarbe zu Grün ist.

Der Farbwähler gibt Ihnen jederzeit Auskunft über den RGB Wert eines Pixels und den zugehörigen
HTML hextriplet Wert der Farbe.

S

Vereinigung abtasten Vereinigung abtasten ist eine nützlich wenn Sie mit mehr als einer Ebene ar-
beiten und Pixelinformationen der anderen Ebenen mit hinzuziehen wollen. Beispielsweise kann
die Farbe eines Pixels von einer aktuellen Ebene gemessen werden, oder unter Hinzunahme von
Vereinigung abtasten die gemischte Farbe aller darunter liegender Ebenen gemessen werden.

Supersampling Mit dieser Technik verwendet GIMP mehr Pixel zur Berechnung eines Farbübergangs,
zum Beispiel für eine Interpolation. Diese Technik führt zu sehr guten Ergebnissen, erfordert al-
lerdings mehr Rechenaufwand und damit eine längere Zeit zur Berechnung.

T

TGA Das TGA (Targa Image File) ist ein Dateiformat, welches eine Kompression von 8, 16, 24 und 32
Bits je Pixel unterstützt. Es wurde ursprünglich von der Firma Truevision entwickelt.
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TIFF Das Dateiformat TIFF (Tagged Image File Format) wurde vor allem für gescannte Rastergrafiken
für die Farbseparation entwickelt. Sechs verschiedene Kodierungsarten werden unterstützt, wobei
jede nochmals verschiedene Bildmodi unterstützen: Schwarz/Weiß, Graustufen und Echtfarben.
TIFF ist neben dem Postscript-Format eines der wichtigen Formate für die Druckvorstufe.

U

URL Als Uniform Resource Locator (URL, engl. ”einheitlicher Ortsangeber für Ressourcen“) bezeichnet
man eine Unterart von Uniform Resource Identifiern (URIs). URLs identifizieren eine Ressource
über ihren primären Zugriffsmechanismus (häufig http oder ftp) und den Ort (engl. location) der
Ressource in Computernetzwerken; der Name des URI-Schemas ist daher in der Regel vom hierfür
verwendeten Netzwerkprotokoll abgeleitet. Beispiele hierfür sind http oder ftp.

Da URLs die erste und häufigste Art von URIs darstellen, werden die Begriffe häufig synonym ver-
wendet. (Quelle: Wikipedia <http://de.wikipedia.org/wiki/Uniform Resource Locator>)

URI Ein Uniform Resource Identifier (URI) (engl. ëinheitlicher Bezeichner für Ressourcen”) ist eine Zei-
chenfolge, die zur Identifizierung einer abstrakten oder physikalischen Ressource dient. URIs wer-
den zur Bezeichnung von Ressourcen (wie Webseiten, sonstigen Dateien, Aufruf von Webservices,
aber auch z.B. E-Mail-Empfängern) im Internet und dort vor allem im WWW eingesetzt. (Quelle:
Wikipedia <http://de.wikipedia.org/wiki/Uniform Resource Identifier>

X

XCF XCF ist das GIMP eigene Dateiformat; entwickelt um alle GIMP eigenen Informationen zu spei-
chern.

Wenn GIMP ein Bild als XCF speichert, werden alle Informationen zum Bild abgespeichert: Pixel-
daten für jede Ebene, aktuelle Auswahlen, zusätzliche Kanäle, Pfade und vieles mehr. Die Infor-
mationen zum Rückgängig machen von Operationen werden jedoch nicht gespeichert.

Pixeldaten werden in unkomprimierter Form gespeichert: jedes Byte der Bildaten is gleich jedem
Byte der Datei. Somit können XCF Dateien, in Abhängigkeit der Bildgröße in Pixel, verwende-
tem Farbraum und verwendeten Ebenen, sehr groß werden. Beispielsweise ein 1000x1000 Pixel
grosses Bild im RGB Format mit drei Kanälen kann ein abgespeichertes XCF mit 100 Megabyte er-
geben. Um die Dateigrössen dennoch etwas zu verkleinen, is es möglich externe programme zum
Komprimieren der Daten zu verwenden. Hierfür kann GZIP oder BZIP2 benutzt werden, welche
schnell, effizient und frei verfügbar sind. Durch die Benutzung dieser Kompressionsprogramme
werden die Dateigrößen meist um den Faktor 10 verringert.

Die GIMP Entwickler haben sich viel Mühe gegeben, das Format in jeder (älteren) GIMP Version
lesbar zu halten. Jedoch steht einiges der neuen Funktionalität in älteren GIMP Versionen nicht
mehr zur Verfügung, wie z.B. Textebenen. Solche speziellen Informationen werden einfach als
normale Ebene importiert.

Y

YCbCr Das YCbCr-Farbmodell wurde für die PAL-Fernsehnorm als ein leicht vom YUV-Farbmodell
abweichendes Farbmodell entwickelt. Es wurde inzwischen zum CCIR-601-Standard für digitale
Bild- und Videoaufzeichnung. Es wird beispielsweise für JPEG-Bilder und MPEG-Videos verwen-
det, und damit auch auf DVDs, Video CDs und bei meisten anderen verbreiteten digitalen Video-
normen. Man beachte, dass ein Farbmodell noch kein Farbraum ist, denn es legt noch nicht fest,
welche Farben eigentlich mit ”Rot”, ”Grününd ”Blau”genau gemeint sind. Für einen Farbraum
bedarf es noch des Bezuges auf bestimmte absolute Farbwerte.

Es gibt Farbmodelle, die eine Farbe nicht durch die additiven Grundfarben Rot, Grün und Blau
(kurz RGB), sondern durch andere Eigenschaften ausdrücken. So zum Beispiel das Helligkeit-
Farbigkeit-Modell. Hier sind die Kriterien die Grundhelligkeit der Farbe (von Schwarz über Grau
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bis Weiß), die Farbe mit dem größten Anteil (Rot, Orange, Gelb, Grün, Blau, Violett, bzw. wei-
tere dazwischen liegende reine Farben) und die Sättigkeit der Farbe, (”knallig”gegenüber blass).
Dieses Farbmodell beruht auf der Fähigkeit des Auges, geringe Luminanzunterschiede (Hellig-
keitsunterschiede) besser zu erkennen als kleine Farbtonunterschiede, und diese wiederum besser
als kleine Farbsättigungsunterschiede. So ist ein grau auf schwarz geschriebener Text sehr gut
zu lesen, ein blau auf rot geschriebener, bei gleicher Grundhelligkeit der Farben, allerdings sehr
schlecht. Solche Farbmodelle nennt man Helligkeit-Farbigkeit-Modelle.

Das YCbCr-Modell ist ein leichte Abwandlung eines solchen Helligkeit-Farbigkeits-Modells. Es
wird ein RGB-Farbwert in eine Grundhelligkeit Y und zwei Komponenten Cb und Cr aufgeteilt,
wobei Cb ein Maß für die Abweichung von Grau in Richtung Blau ist bzw., wenn es kleiner als 0,5
ist, in Richtung Gelb. Cr ist die entsprechende Maßzahl für Differenz in Richtung Rot bzw. Türkis.
Diese Darstellung verwendet die Besonderheit des Auges, für grünes Licht besonders empfindlich
zu sein. Daher steckt die meiste Information über den Grünanteil in der Grundhelligkeit Y und
man braucht daneben nur noch die Abweichungen beim Rot- oder Blauanteil darzustellen. Die
Y-Werte werden dann in den meisten praktischen Anwendungen, etwa auf DVDs, doppelt so fein
aufgelöst wie die beiden Werte Cb und Cr. (Quelle: Wikipedia <http://de.wikipedia.org/
wiki/YCbCr-Farbmodell>)

YUV Das YUV-Farbmodell verwendet zur Darstellung der Farbinformation zwei Komponenten, die
Luma (Lichtstärke pro Fläche) und die Chrominanz oder Farbanteil (chroma), wobei die Chro-
minanz wiederum aus zwei Komponenten besteht. Die Entwicklung des YUV-Farbmodells geht
auf die Entwicklung des Farbfernsehens (PAL) zurück, wo nach Wegen gesucht wurde, zusätzlich
zum Schwarz/Weiß-Signal die Farbinformation zu übertragen, um eine Abwärtskompatibilität
mit alten Schwarz/Weiß-Fernsehgeräten zu erreichen ohne die zur Verfügung stehende Übertragungsbandbreite
erhöhen zu müssen. Aus dem YUV-Farbmodell der analogen Fernsehtechnik wurde das YCbCr-
Farbmodell entwickelt, das bei den meisten Arten der digitalen Bild- und Videokompression ein-
gesetzt wird. Fälschlicherweise wird in jenem Bereich auch oft vom YUV-Farbmodell gesprochen,
obwohl eigentlich das YCbCr-Modell benutzt wird. Dies sorgt oft für Verwirrung.

Zur Berechnung des Luma-Signals (auch Leuchtdichte-Signal) werden die zugrundeliegenden
RGB-Daten zunächst mit dem Gamma-Wert des Ausgabegerätes verrechnet, man erhält ein R’G’B’-
Signal. Die drei Einzelkomponenten werden mit unterschiedlicher Gewichtung addiert, um die
Helligkeitsinformation zu bilden, die als BAS-Signal auch bei alten Schwarz/Weiß-Fernsehgeräten
funktioniert.

Y=R+G+B

Die genaue Berechnung ist jedoch komplizierter, da einige Aspekte des Farbensehens des mensch-
lichen Auges berücksichtigt werden müssen. So wird Beispielsweise Grün heller wahrgenommen,
als Rot, und dieses heller als Blau. Weiterhin wird bei einigen Systemen zunächst eine Gammakor-
rektur der Grundfarben vorgenommen.

Die Crominanzsignale, auch Farbdifferenzsignale enthalten die Farbinformation. Sie entstehen aus
der Differenz Blau minus Luma bzw. Rot minus Luma.

U=B-Y

V=R-Y

Aus den drei erzeugten Komponenten Y, U und V können später wieder die einzelnen Farbanteile
der Grundfarben berechnet werden:

Y + U = Y + ( B - Y ) = Y - Y + B = B

Y + V = Y + ( R - Y ) = Y - Y + R = R

Y - B - R = ( R + G + B ) - B - R = G

Weiterhin ergibt sich durch den Aufbau der Netzhaut des menschlichen Auges, dass die Hel-
ligkeitsinformation in einer höheren Auflösung wahrgenommen wird als die Farbe, sodass viele
auf dem YUV-Farbmodell aufbauende Formate eine Komprimierung der Chrominanz vorneh-
men, um Bandbreite bei der Übertragung einsparen zu können. (Quelle: Wikipedia <http://
de.wikipedia.org/wiki/YUV>)
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Z

Zwischenablage Die Zwischenablage ist ein Bereich, in dem vorübergehend Daten gespeichert werden
können. Hauptzweck ist das Kopieren oder Verschieben von Daten zwischen Anwendungen oder
Dokumenten. GIMP verwendet unter verschiedenen Betriebssystemen einen leicht unterschiedli-
chen Ansatz für die Zwischenablage. Unter Linux/XFree wird die XFree Zwischenablage für Text
verwendet, und die GIMP interne Zwischenablage für Bilddaten.
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A. Die Geschichte von GIMP

A.1. Die Anfänge

Der Anfang der Geschichte von GIMP gestaltete sich nach Aussagen von Peter Mattis und Spencer
Kimball, den Vätern von GIMP, wie folgt:

Der Saga nach stieg GIMP aus der Asche eines scheußlichen, handgemachten cs164 (Compiler) Pro-
jektes. Die Umstände waren die Folgenden: Früher Morgen, die beiden Helden (Peter & Spencer) nie-
dergekämpft vom fehlenden Schlaf und der furchtbaren Anstrengung einen Compiler in LISP zu pro-
grammieren. Die Grenzen ihrer Geduld waren längst überschritten.

Doch dann geschah es. Das LISP Programm stürzte mit einem hässlichen ”Core Dump“ ab, als es nicht
die 17MB Speicher reservieren konnte, welche zur Erzeugung des Parsers für eine einfache Gramma-
tik in yacc notwendig gewesen wären. Ein Moment des Unglaubens ging vorbei, dann warfen sich die
Beiden einen angewiderten Blick zu und damit hatte sich das Projekt in Luft aufgelöst. Es reichte und
Peter & Spenzer mussten etwas ...IRGENDETWAS... sinnvolles programmieren. Etwas in der Program-
miersprache C. Etwas, dass nicht von eingebetteten Listen abhängig war, um eine Bitmap darzustellen.
Damit war GIMP geboren.

Wie ein Phönix aus der Asche, prächtiges neues Leben erwachte aus den Überresten von LISP und
yacc. Ideen wurden entwickelt, Entscheidungen getroffen und langsam nahm GIMP Gestalt an.

Ein Bildbearbeitungsprogramm war der Konsens. Ein Programm, das die Notwendigkeit kommer-
zielle Software unter ”Windoze“ oder ”Macintoy“ einzusetzen zumindest reduzierte. Ein Programm,
welches die in anderen Malprogrammen und Werkzeugen unter X vermissten Funktionen bereitstellen
würde. Ein Programm, das helfen sollte die lange Tradition hervorragender UNIX Anwendungen zu
pflegen.

Sechs Monate später wurde ein frühes Beta Stadium erreicht. Peter & Spencer wollten das Programm
jetzt veröffentlichen und begannen mit der Arbeit an Kompatibilitätsproblemen und Stabilität auf ver-
schiedenen Plattformen. Außerdem betrachteten sie das Programm als benutzbar und wollten, dass
andere interessierte Programmierer erste Erweiterungen und die Unterstützung für neue Dateiformate
entwickeln.

A.2. Die ersten Tage von GIMP

Die Version 0.54 Die Version 0.54 wurde im Februar 1996 freigegeben und hatte große Bedeutung
als erstes wirklich professionelles, freies Bildbearbeitungsprogramm. Es war das erste freie Pro-
gramm, welches mit den großen kommerziellen Bildbearbeitungsprogrammen konkurieren konn-
te.

Die Version 0.54 war einen Betaversion, aber sie war bereits so stabil, dass sie für die tägliche
Arbeit benutzt werden konnte. Allerdings bestand einer der großen Nachteile von 0.54 darin, dass
Motif als Basis für die Oberfläche benutzt wurde. Motif ist ein kommerzielles Produkt und musste
für Plattformen wie Linux gekauft werden, wenn man das schnellere dynamisch gelinkte GIMP
verwenden wollte. Viele Entwickler waren jedoch Studenten, die Linux verwendeten, aber sich
die Lizenz für Motif nicht leisten konnten.

Die Version 0.60 Die Version 0.60 wurde im Juli 1996 veröffentlicht und war durch Spencer und Peter
vier Monate weiterentwickelt worden. Die bedeutensten Fortschritte waren ein neues Toolkit na-
mens GTK (GIMP Toolkit) und gdk (GIMP Drawing Toolkit) mit denen die Abhängigkeit von Mo-
tif aufgehoben wurde. Für die Grafikkünstler war diese Version voll von neuen Funktionen wie
Ebenen, verbesserten Malwerkzeugen mit Subpixelgenauigkeit, einer verbesserten Sprühpistole
(Airbrush), Malmodi und vielen mehr.
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Die Version 0.60 war eine reine Entwicklerversion und nicht für die Allgemeinheit bestimmt. Sie
diente als Grundlage für die Versionen 0.99 und 1.0 zum Test von Funktionen die gelegentlich auch
wieder verworfen oder geändert wurden. Man könnte die Version 0.60 auch als Alphaversion der
Version 0.99 betrachten.

Die Version 0.99 Die Version 0.99 erblickte im Februar 1997, also geradeeinmal ein Jahr nach der al-
lerersten Version 0.54 das Licht der Welt. Zusammen mit anderen Entwicklern hatten Spencer &
Peter verschiedene Änderungen vorgenommen und sogar weitere neue Funktionen hinzugefügt.
Die bedeutendsten Neuerungen waren ein neues API (eine Programmierschnittstelle) and die PDB
(Prozedurendatenbank), welche es ermöglichten GIMP mittels einfacher Skripte zu erweitern. Mit
Skript-Fu konnten nun Abläufe automatisiert werden, die bis dahin manuel ausgeführt werden
mussten. GTK und gdk wurden ebenfalls überarbeitet und nun GTK+ genannt. Zusätzlich ver-
wendete die Version 0.99 eine neue, kachelbasierte Speicherverwaltung, mit welcher das Laden
von 100MB Bilddateien kein Problem mehr darstellte. Außerdem wurde mit dieser Version das
GIMP eigene Dateiformat .xcf eingeführt.

Die neue Programmierschnittstelle machte die Erstellung von Erweiterungen sehr einfach. Ver-
schiedene neue Erweiterungen fanden ihren Weg in GIMP, darunter einige sehr wichtige wie SA-
NE (SANE erlaubt es Bilder direkt in GIMP zu scannen).

Im Sommer 1997 erreichte GIMP die Version 0.99.10 und S & P sahen sich gezwungen ihre Un-
terstützung für das Projekt sehr einzuschränken, da Sie das Studium beendet und ihren ersten Job
angetreten hatten. Trotzdem setzten die anderen Entwickler unter der Leitung von Federico Mena
ihre Arbeit an GIMP fort.

Im September 1997 wurde das GTK+ aus dem GIMP Projekt herausgelöst und separat fortgeführt.
GTK+ wurde bereits zu dieser Zeit als hervorragendes Toolkit wahrgenommen und andere Ent-
wickler verwendeten es zur Entwicklung eigener Anwendungen.

Im Oktober 1997 wurden die Funktionen von GIMP festgeschrieben, das heißt es ganze Aufmerk-
samkeit der Entwickler lag auf der Beseitigung von Fehlern. Es wurden keine neuen Funktionen
zu den GIMP Bibliotheken und dem Programm selbst mehr hinzugefügt. GUM 0.5 wurde eben-
falls im frühen Oktober 1997 veröffentlicht. Die Entwicklungsarbeiten an GIMP wurden mit dem
Ziel fortgesetzt eine stabile Version 1.0 veröffentlichen zu können.

A.3. Der große Schritt die Welt zu ändern

Die Version 1.0 Die lang ersehnte Verison 1.0 von GIMP wurde am 5. Juni 1998 freigegeben. Zu diesem
Zeitpunkt wurde das Programm für stabil genug erachtet, um eine weltweite Ankündigung und
einen professionellen Einsatz zu rechtfertigen.

Die Version 1.2 Die GIMP Version 1.2.0 wurde am 25. Dezember 2000 freigegeben. Die Neuerungen
gegenüber der Version 1.0 halten sich in Grenzen, neben vielen Fehlerbereinigungen wurde vor
allem an der Benutzeroberfläche gearbeitet.

A.4. GIMP 2 - Schöne neue Welt

Die Version 2.0 Die Version 2.0.0 wurde am 24. März 2004 freigegeben. Um das Ausmaß der Neuerun-
gen in der Version 2.0 deutlich zu machen zunächst ein wenig Statistik: Der Programmcode von
GIMP besteht aus etwa 230.000 Zeilen C Code und fast jede dieser Zeilen wurde bei der Arbeit an
der neuen Version geändert! Aus der Sicht des Anwenders ist GIMP2 jedoch grundsätzlich sehr
ähnlich zur Version 1. Auch die Funktionen sind ähnlich genug, um den Anwender nicht völlig zu
verwirren. Als Teil der Restrukturierungsarbeiten wurde der Sourcecode gründlich aufgeräumt,
eine Investition, die auch wenn sie für den Anwender nicht direkt sichtbar ist, die Wartung und
Erweiterung von GIMP zukünftig deutlich erleichtern wird.
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Die Liste der neuen Funktionen und Möglichkeiten ist sehr lang, um Sie nicht unnötig zu langwei-
len ist sie auf die wesentlichen Neuerungen beschränkt.

Grundlegende Werkzeuge Die Basiswerkzeuge in GIMP 2 unterscheiden sich nicht wesentlich
von ihren Vorgängern in GIMP 1. Das Werkzeug ”Nach Farbe auswählen“ hat jetzt seinen
Weg in das Werkzeugfenster gefunden, war jedoch auch in GIMP 1 schon über das Menü
erreichbar. Das Transformationswerkzeug wurde in die spezialisierten Werkzeuge ”Drehen“,

”Skalieren“, ”Scheren“ und ”Perspektive“ aufgeteilt. Außerdem wurden die Werkzeuge ”Text“
und ”Pfad“ grundlegend überarbeitet. Die Farboperationen sind jetzt mit Ebenen assoziiert
und über das Menü Ebene → Farben erreichbar. Dies zählt jedoch fast schon in die Kate-
gorie Fehlerbehebung, denn zuvor waren diese Funktionen dem Menü Farben zugeordnet,
was jedoch unlogisch ist, da sie auf Ebenen wirken.
Die Benutzeroberfläche für die Werkzeuge wurde merklich überarbeitet. Der Dialog ”Werk-
zeugeinstellungen“ ändert jetzt seine Größe nicht mehr, wenn das Werkzeug gewechselt
wird, da dies von vielen Anwendern als störend empfunden wurde. In der Standardeinstel-
lung wird der Dialog jetzt unterhalb des Werkzeugfensters ständig eingeblendet, um schnell
zugreifbar zu sein.

Werkzeugeinstellungen Die Werkzeugeinstellungen habe jetzt für viele Werkzeuge neue Eigen-
schaften, welche in GIMP 1 nicht verfügbar waren. Ohne diese hier einzeln aufzulisten - sie
sind ein bemerkenswerter Fortschritt.
Alle Auswahlwerkzeuge verfügen mit der neuen Version über eine Schaltfläche unter deren
Verwendung Sie zwischen den Modi Ersetzen, Hinzufügen, Subtrahieren und Schnittmenge
wechseln können. In GIMP 1 konnte dies nur durch das zusätzliche Drücken verschiedener
Tasten erreicht werden.
Für die Transformationswerkzeuge können Sie nun mit einer Schaltfläche in den Werkzeu-
geigenschaften einstellen, ob das Werkzeug auf die Ebene, die Auswahl oder einen Pfad an-
gewendet werden soll. Auch dies stellt einen großen Fortschritt im Vergleich zu GIMP 1 dar.
Die Eigenschaften ”Ausblenden“ und ”Mit Verlauf füllen“ stehen nun in allen Malwerkzeu-
gen zur Verfügung. Genau betrachtet hat nun jedes Malwerkzeug seine eigenen Einstellun-
gen für Pinselform, Verlauf und Muster.

Benutzeroberfläche In diesem Bereich haben wohl die am deutlichsten sichtbaren Veränderungen
stattgefunden. Damit trägt die Entwicklung den Problemen Rechnung, die viele Anwender
mit GIMP 1 hatten. GIMP 2 verwendet das GTK2+ Toolkit, an Stelle von GTK+. Daraus er-
gibt sich für GIMP 2 die Möglichkeit Dialoge in Fenstern zusammenzufassen (zu docken)
und so eine der größten Schwächen von GIMP 1, nämlich die zur Unübersichtlichkeit nei-
gende große Anzahl von lose herumliegenden Dialogen, zu beseitigen. Mit GIMP 2 können
Sie die verschiedenen Paletten und Dialog von GIMP so anordnen, wie sie diese für Ihre
Arbeitsweise benötigen.
Das neue Bildfenster verfüg ebenfalls über einige interessante, neue Funktionen. So ist es
jetzt möglich den Umriss der Pinselspitze bei der Arbeit mit den Malwerkzeugen anzuzei-
gen. Ausserdem lässt sich dem Bildfenster eine Menüleiste hinzufügen und Sie können im
Vollbildmodus arbeiten, um die Größe Ihrer Arbeitsfläche zu maximieren.
Mit GIMP werden nicht nur mehrere Sets an Einstellungen für die Tastenkürzel geliefert. Soll-
ten Sie beispielsweise mit den Tastenkürzeln von Photoshop vertraut sein und lieber diese,
statt der GIMP eigenen verwenden wollen, so bennenen Sie einfach die Datei ps-menurc in
menurc um, und starten GIMP erneut.

Erstellung von Skripten Die Standardschnittstelle zur Erstellung von Skripten in GIMP 2 ist

”Python-fu“. Dies bedeutet, dass Python Skripte auf GIMP Funktionen zugreifen könne, oder
umgekehrt, GIMP Erweiterungen komplett in der Programmiersprache Python geschrieben
werden könnne. Damit wird das in GIMP 1 eingesetzte, LISP basierte Skript-Fu um eine leicht
zu lernende Schnittstelle ergänzt.
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GIMP-Perl ist nicht länger Bestandteil der Standardauslieferung von GIMP, kann aber nach
wie vor als separates Installationspaket eingebunden werden. GIMP-Perl ist jedoch, im Ge-
gensatz zu Python, nur auf Unix basierten Systemen verfügbar.

Das Werkzeug ”Text“ Die wohl größte Einschränkung des alten Textwerkezeuges in GIMP 1
war, dass einmal gezeichneter Text nicht mehr verändert werden konnte. Wenn irgendeine
Einstellung oder auch nur ein einzelner Buchstabe geändert werden sollte, so mußte bisher
die gesamte den Text beinhaltende Ebene gelöscht, und komplett neu angelegt werden. Diese
Einschränkungen wurden mit GIMP 2 beseitigt.

Das Pfadwerkzeug Das neue Pfadwerkzeug hat eine komplett neue Benutzeroberfläche. Der ers-
te große Unterschied, den Sie bei der Arbeit mit Pfaden bemerken werden ist, dass Pfade nicht
mehr geschlossen sein müssen. Die zweite Neuerung ist, dass das Werkzeug jetzt über drei
Modi (Design, Bearbeiten, Verschieben) verfügt.
Zwei weitere neue Funktionen, die mit Pfaden in Zusammenhang stehen sind das Laden von
SVG Dateien als Pfad und die Art wie Sie Pfade zeichnen können.

Weitere Neuerungen Außerdem wurden Verbesserungenn in folgenden Bereichen vorgenom-
men:

• Die Qualität des Anti-Aliasing wurde an verschiedenen Stellen (zum Beispiel im Text-
werkzeug) verbessert.

• Symbole und Menüs können über Themen geändert werden.
• Ein Bild kann als Vorlage gespeichert und für die Anlage neuer Bilder verwendet werden.
• Es wurden vier neue Modi zur Verknüpfung von Ebenen hinzugefügt: Hartes Licht, Wei-

ches Licht, Faser extrahieren sowie Faser mischen.
• Wenn es im Bild eine Auswahl gibt, so können Sie mit einem neuen Kommando das Bild

auf die Auswahl beschneiden.
• Neben der Möglichkeit der Hilfslinien können Sie jetzt auch ein Gitter über das Bild

legen, um präziser zu arbeiten.
• Die Benutzerfläche des Ebenendialoges wurde überarbeitet. Damit werden einige Funk-

tionen leichter zugänglich. Ausserdem sind wichtige, ebenenbezogene Funktionen jetzt
über ein Menü im Bildfenster zugänglich.

• Mit Hilfe der neuen Ansichtsfilter können Sie ein Bild, ohne es verändern zu müssen
unter verschiedenen Farbfiltern betrachten. Damit können beispielsweise verschiedene
Gammawerte simuliert werden.

• Der Dialog zur Farbauswahl verfügt über einen neuen CMYK Modus.
• Bildaten die in EXIF Tags enthalten sind, bleiben beim Lesen und Speichern von JPEG

Bildern erhalten.
• MNG Animationen werden unterstützt. Das MNG Dateiformat kann als eine Art ani-

miertes PNG betrachtet werden. Es hat all die Vorteile von PNG ( gegenüber GIF), als
da wären hohe Farbtiefe, 256 Transparenzstufen und fast das Wichtigste - es ist frei von
Patenten.

• Das GIMP Animationspaket kann jetzt önion-skinning”, außerdem wurde eine ”blues-
creen”Funktion hinzugefügt.

• Der Kanalmixer, zuvor als Erweiterung verfügbar, ist jetzt im Memü Filter→ Farben zu
finden.
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B. Rechtliches

Copyright (C) 2000,2001,2002 Free Software Foundation, Inc. 59 Temple Place, Suite 330, Bo-
ston, MA 02111-1307 USA Everyone is permitted to copy and distribute verbatim copies of
this license document, but changing it is not allowed.

B.1. PREAMBLE

The purpose of this License is to make a manual, textbook, or other functional and useful document
”freeı̈n the sense of freedom: to assure everyone the effective freedom to copy and redistribute it, with
or without modifying it, either commercially or noncommercially. Secondarily, this License preserves
for the author and publisher a way to get credit for their work, while not being considered responsible
for modifications made by others.

This License is a kind of ”copyleft”, which means that derivative works of the document must them-
selves be free in the same sense. It complements the GNU General Public License, which is a copyleft
license designed for free software.

We have designed this License in order to use it for manuals for free software, because free software
needs free documentation: a free program should come with manuals providing the same freedoms that
the software does. But this License is not limited to software manuals; it can be used for any textual
work, regardless of subject matter or whether it is published as a printed book. We recommend this
License principally for works whose purpose is instruction or reference.

B.2. APPLICABILITY AND DEFINITIONS

This License applies to any manual or other work, in any medium, that contains a notice placed by
the copyright holder saying it can be distributed under the terms of this License. Such a notice grants
a world-wide, royalty-free license, unlimited in duration, to use that work under the conditions stated
herein. The ”Document”, below, refers to any such manual or work. Any member of the public is a
licensee, and is addressed as ”you”. You accept the license if you copy, modify or distribute the work in
a way requiring permission under copyright law.

A ”Modified Versionöf the Document means any work containing the Document or a portion of it,
either copied verbatim, or with modifications and/or translated into another language.

A SSecondary Sectionı̈s a named appendix or a front-matter section of the Document that deals ex-
clusively with the relationship of the publishers or authors of the Document to the Document’s overall
subject (or to related matters) and contains nothing that could fall directly within that overall subject.
(Thus, if the Document is in part a textbook of mathematics, a Secondary Section may not explain any
mathematics.) The relationship could be a matter of historical connection with the subject or with related
matters, or of legal, commercial, philosophical, ethical or political position regarding them.

The Ïnvariant Sectionsäre certain Secondary Sections whose titles are designated, as being those of
Invariant Sections, in the notice that says that the Document is released under this License. If a section
does not fit the above definition of Secondary then it is not allowed to be designated as Invariant. The
Document may contain zero Invariant Sections. If the Document does not identify any Invariant Sections
then there are none.

The ”Cover Textsäre certain short passages of text that are listed, as Front-Cover Texts or Back-Cover
Texts, in the notice that says that the Document is released under this License. A Front-Cover Text may
be at most 5 words, and a Back-Cover Text may be at most 25 words.

A ”Transparent”copy of the Document means a machine-readable copy, represented in a format who-
se specification is available to the general public, that is suitable for revisingthe document straight-
forwardly with generic text editors or (for images composed of pixels) generic paint programs or (for
drawings) some widely available drawing editor, and that is suitable for input to text formatters or for
automatic translation to a variety of formats suitable for input to text formatters. A copy made in an
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otherwise Transparent file format whose markup, or absence of markup, has been arranged to thwart or
discourage subsequent modification by readers is not Transparent. An image format is not Transparent
if used for any substantial amount of text. A copy that is not ”Transparentı̈s called Öpaque”.

Examples of suitable formats for Transparent copies include plain ASCII without markup, Texin-
fo input format, LaTeX input format, SGML or XML using a publicly available DTD, and standard-
conforming simple HTML, PostScript or PDF designed for human modification. Examples of transpa-
rent image formats include PNG, XCF and JPG. Opaque formats include proprietary formats that can be
read and edited only by proprietary word processors, SGML or XML for which the DTD and/or proces-
sing tools are not generally available, and the machine-generated HTML, PostScript or PDF produced
by some word processors for output purposes only.

The ”Title Page”means, for a printed book, the title page itself, plus such following pages as are nee-
ded to hold, legibly, the material this License requires to appear in the title page. For works in formats
which do not have any title page as such, ”Title Page”means the text near the most prominent appea-
rance of the work’s title, preceding the beginning of the body of the text.

A section Ëntitled XYZ”means a named subunit of the Document whose title either is precisely XYZ or
contains XYZ in parentheses following text that translates XYZ in another language. (Here XYZ stands
for a specific section name mentioned below, such as Äcknowledgements”, ”Dedications”, Ëndorse-
ments”, or ”History”.) To ”Preserve the Titleöf such a section when you modify the Document means
that it remains a section Ëntitled XYZäccording to this definition.

The Document may include Warranty Disclaimers next to the notice which states that this License
applies to the Document. These Warranty Disclaimers are considered to be included by reference in this
License, but only as regards disclaiming warranties: any other implication that these Warranty Disclai-
mers may have is void and has no effect on the meaning of this License.

B.3. VERBATIM COPYING

You may copy and distribute the Document in any medium, either commercially or noncommercially,
provided that this License, the copyright notices, and the license notice saying this License applies to
the Document are reproduced in all copies, and that you add no other conditions whatsoever to those of
this License. You may not use technical measures to obstruct or control the reading or further copying
of the copies you make or distribute. However, you may accept compensation in exchange for copies. If
you distribute a large enough number of copies you must also follow the conditions in section3.

You may also lend copies, under the same conditions stated above, and you may publicly display
copies.

B.4. COPYING IN QUANTITY

If you publish printed copies (or copies in media that commonly have printed covers) of the Document,
numbering more than 100, and the Document’s license notice requires Cover Texts, you must enclose the
copies in covers that carry, clearly and legibly, all these Cover Texts: Front-Cover Texts on the front cover,
and Back-Cover Texts on the back cover. Both covers must also clearly and legibly identify you as the
publisher of these copies. The front cover must present the full title with all words of the title equally
prominent and visible. You may add other material on the covers in addition. Copying with changes
limited to the covers, as long as they preserve the title of the Document and satisfy these conditions, can
be treated as verbatim copying in other respects.

If the required texts for either cover are too voluminous to fit legibly, you should put the first ones
listed (as many as fit reasonably) on the actual cover, and continue the rest onto adjacent pages.

If you publish or distribute Opaque copies of the Document numbering more than 100, you must eit-
her include a machine-readable Transparent copy along with each Opaque copy, or state in or with each
Opaque copy a computer-network location from which the general network-using public has access
to download using public-standard network protocols a complete Transparent copy of the Document,
free of added material. If you use the latter option, you must take reasonably prudent steps, when you
begin distribution of Opaque copies in quantity, to ensure that this Transparent copy will remain thus
accessible at the stated location until at least one year after the last time you distribute an Opaque copy
(directly or through your agents or retailers) of that edition to the public.
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It is requested, but not required, that you contact the authors of the Document well before redistribu-
ting any large number of copies, to give them a chance to provide you with an updated version of the
Document.

B.5. MODIFICATIONS

You may copy and distribute a Modified Version of the Document under the conditions of sections 2 and
3 above, provided that you release the Modified Version under precisely this License, with the Modified
Version filling the role of the Document, thus licensing distribution and modification of the Modified
Version to whoever possesses a copy of it. In addition, you must do these things in the Modified Version:

A Use in the Title Page (and on the covers, if any) a title distinct from that of the Document, and from
those of previous versions (which should, if there were any, be listed in the History section of the
Document). You may use the same title as a previous version if the original publisher of that version
gives permission.

B List on the Title Page, as authors, one or more persons or entities responsible for authorship of the
modifications in the Modified Version, together with at least five of the principal authors of the Do-
cument (all of its principal authors, if it has fewer than five), unless they release you from this requi-
rement.

C State on the Title page the name of the publisher of the Modified Version, as the publisher.

D Preserve all the copyright notices of the Document.

E Add an appropriate copyright notice for your modifications adjacent to the other copyright notices.

F Include, immediately after the copyright notices, a license notice giving the public permission to use
the Modified Version under the terms of this License, in the form shown in the Addendum below.

G Preserve in that license notice the full lists of Invariant Sections and required Cover Texts given in the
Document’s license notice.

H Include an unaltered copy of this License.

I Preserve the section Entitled ”History”, Preserve its Title, and add to it an item stating at least the
title, year, new authors, and publisher of the Modified Version as given on the Title Page. If there is
no section Entitled ”Historyı̈n the Document, create one stating the title, year, authors, and publisher
of the Document as given on its Title Page, then add an item describing the Modified Version as stated
in the previous sentence.

J Preserve the network location, if any, given in the Document for public access to a Transparent copy
of the Document, and likewise the network locations given in the Document for previous versions it
was based on. These may be placed in the ”Historyßection. You may omit a network location for a
work that was published at least four years before the Document itself, or if the original publisher of
the version it refers to gives permission.

K For any section Entitled Äcknowledgementsör ”Dedications”, Preserve the Title of the section, and
preserve in the section all the substance and tone of each of the contributor acknowledgements
and/or dedications given therein.

L Preserve all the Invariant Sections of the Document, unaltered in their text and in their titles. Section
numbers or the equivalent are not considered part of the section titles.

M Delete any section Entitled Ëndorsements”. Such a section may not be included in the Modified Ver-
sion.

N Do not retitle any existing section to be Entitled Ëndorsementsör to conflict in title with any Invariant
Section.
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O Preserve any Warranty Disclaimers.

If the Modified Version includes new front-matter sections or appendices that qualify as Secondary
Sections and contain no material copied from the Document, you may at your option designate some
or all of these sections as invariant. To do this, add their titles to the list of Invariant Sections in the
Modified Version’s license notice. These titles must be distinct from any other section titles.

You may add a section Entitled Ëndorsements”, provided it contains nothing but endorsements of
your Modified Version by various parties–for example, statements of peer review or that the text has
been approved by an organization as the authoritative definition of a standard.

You may add a passage of up to five words as a Front-Cover Text, and a passage of up to 25 words
as a Back-Cover Text, to the end of the list of Cover Texts in the Modified Version. Only one passage of
Front-Cover Text and one of Back-Cover Text may be added by (or through arrangements made by) any
one entity. If the Document already includes a cover text for the same cover, previously added by you or
by arrangement made by the same entity you are acting on behalf of, you may not add another; but you
may replace the old one, on explicit permission from the previous publisher that added the old one.

The author(s) and publisher(s) of the Document do not by this License give permission to use their
names for publicity for orto assert or imply endorsement of any Modified Version.

B.6. COMBINING DOCUMENTS

You may combine the Document with other documents released under this License, under the terms
defined in section 4 above for modified versions, provided that you include in the combination all of the
Invariant Sections of all of the original documents, unmodified, and list them all as Invariant Sections of
your combined work in its license notice, and that you preserve all their Warranty Disclaimers.

The combined work need only contain one copy of this License, and multiple identical Invariant
Sections may be replaced with a single copy. If there are multiple Invariant Sections with the same
name but different contents, make the title of each such section unique by adding at the end of it, in
parentheses, the name of the original author or publisher of that section if known, or else a unique
number. Make the same adjustment to the section titles in the list of Invariant Sections in the license
notice of the combined work.

In the combination, you must combine any sections Entitled ”Historyı̈n the various original docu-
ments, forming one section Entitled ”History”; likewise combine any sections Entitled Äcknowledge-
ments”, and any sections Entitled ”Dedications”. You must delete all sections Entitled Ëndorsements”.

B.7. COLLECTIONS OF DOCUMENTS

You may make a collection consisting of the Document and other documents released under this License,
and replace the individual copies of this License in the various documents with a single copy that is
included in the collection, provided that you follow the rules of this License for verbatim copying of
each of the documents in allother respects.

You may extract a single document from such a collection, and distribute it individually under this
License, provided you insert a copy of this License into the extracted document, and follow this License
in all other respects regarding verbatim copying of that document.

B.8. AGGREGATION WITH INDEPENDENT WORKS

A compilation of the Document or its derivatives with other separate and independent documents or
works, in or on a volume of a storage or distribution medium, is called an äggregateı̈f the copyright
resulting from the compilation is not used to limit the legal rights of the compilation’s users beyond
what the individualworks permit. When the Document is included in an aggregate, this License does not
apply to the other works in the aggregate which are not themselves derivative works of the Document.

If the Cover Text requirement of section 3 is applicable to these copies of the Document, then if the
Document is less than one half of the entire aggregate, the Document’s Cover Texts may be placed on
covers that bracket the Document within the aggregate, or the electronic equivalent of covers if the
Document is in electronic form. Otherwise they must appear on printed covers that bracket the whole
aggregate.
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B.9. TRANSLATION

Translation is considered a kind of modification, so you may distribute translations of the Document
under the terms of section 4. Replacing Invariant Sections with translations requires special permission
from their copyright holders, but you may include translations of some or all Invariant Sections in ad-
dition to the original versions of these Invariant Sections. You may include a translation of this License,
and all the license notices in the Document, and any Warranty Disclaimers, provided that you also inclu-
de the original English version of this License and the original versions of those notices and disclaimers.
In case of a disagreement between the translation and the original version of this License or a notice or
disclaimer, the original version will prevail.

If a section in the Document is Entitled Äcknowledgements”, ”Dedications”, or ”History”, the requi-
rement (section 4) to Preserve its Title (section 1) will typically require changing the actual title.

B.10. TERMINATION

You may not copy, modify, sublicense, or distribute the Document except as expressly provided for
under this License. Any other attempt to copy, modify, sublicense or distribute the Document is void,
and will automatically terminate your rights under this License. However, parties who have received
copies, or rights, from you under this License will not have their licenses terminated so long as such
parties remain in full compliance.

B.11. FUTURE REVISIONS OF THIS LICENSE

The Free Software Foundation may publish new, revised versions of the GNU Free Documentation Li-
cense from time to time. Such new versions will be similar in spirit to the present version, but may differ
in detail to address new problems or concerns. See http://www.gnu.org/copyleft/.

Each version of the License is given a distinguishing version number. If the Document specifies that
a particular numbered version of this License ör any later versionäpplies to it, you have the option of
following the terms and conditions either of that specified version or of any later version that has been
published (not as a draft) by the Free Software Foundation. If the Document does not specify a version
number of this License, you may choose any version ever published (not as a draft) by the Free Software
Foundation.

B.12. ADDENDUM: How to use this License for your documents

To use this License in a document you have written, include a copy of the License in the document and
put the following copyrightand license notices just after the title page:

Copyright (c) YEAR YOUR NAME. Permission is granted to copy, distribute and/or mo-
dify this document under the terms of the GNU Free Documentation License, Version 1.2 or
any later version published by the Free Software Foundation; with no Invariant Sections, no
Front-Cover Texts, and no Back-Cover Texts. A copy of the license is included in the section
entitled ”GNU Free Documentation License”.

If you have Invariant Sections, Front-Cover Texts and Back-Cover Texts, replace the ”with...Texts.”line
with this:

with the Invariant Sections being LIST THEIR TITLES, with the Front-Cover Texts being
LIST, and with the Back-Cover Texts being LIST.

If you have Invariant Sections without Cover Texts, or some other combination of the three, merge
those two alternatives to suitthe situation.

If your document contains nontrivial examples of program code, we recommend releasing these ex-
amples in parallel under your choice of free software license, such as the GNU General Public License,
to permit their use in free software.
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C. Eeek! Hier fehlt die Hilfe

Leider ist für diese Funktion noch keine Hilfe geschrieben worden. Wenn du diese Lücke schliessen
möchtest, schau doch auf der Projektseite <http://docs.gimp.org> des Dokumentations Teams
vorbei. Desweiteren existiert eine Mailingliste <https://lists.xcf.berkeley.edu/mailman/
listinfo/gimp-docs/> auf der Du dich eintragen kannst. Generell ist die Projektseite von GIMP
<http://www.gimp.org> ein guter Anlaufpunkt.
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Streue RGB, 330
Supernova, 372

Tastenkürzel, 198
Temporärer Ordner, 211
Text, 150
Thema, 199
Tiefenkombination, 455
Tinte, 107
Tranparenz

Bilder mit Transparenz speichern, 67
Transformation, 258
Transparenz

aus Farbe, 282
Schwellwert, 283
Semi-Flatten, 282

Undo, 38, 174
Unscharf Maskieren, 350

Variationen, 322
Verbiegen, 375
Vergrössern / Verkleinern, 147
Verlauf, 338
Verschieben, 119, 387
Verschmieren, 116
Verwirbeln, 329
VG-HG anpassen, 305
Video, 391
Vollbild, 249
Vordergrundfarbe, 153
Voreinstellungen, 216
Vorschaubilder, 198

Warmes Glühen, 417
Web

Images for the Web, 66
Webbrowser, 201

Weichzeichnen, 112
Wellen, 394
Werhzeug

Transformationswerkzeug, 117
Werkzeug, 84

Abwedeln, 114
Auswahl nach Farbe, 86
Bleistift, 101
Drehen, 124
Einfärben, 135
Elliptische Auswahl, 81
Füllen (Fülleimer), 93
Farbabgleich, 133
Farbauftragende Malwerkzeuge, 99
Farbpipette, 145
Farbton-Sättigung, 134
Farbverlauf, 95
Helligkeit-Kontrast, 136
Klonen, 110
Kurven, 140
Maßband, 149
Magnetische Auswahl, 88
Malwerkzeug, 90
Nachbelichten, 114
Perspektive, 130
Pfade, 143
Pinsel, 102
Posterisieren, 142
Radieren, 104
Schärfen, 112
Scheren, 128
Schwellwert, 137
Skalieren, 126
Spiegeln, 131
Sprühpistole, 106
Text, 150
Tinte, 107
Vergrössern / Verkleinern, 147
Verschieben, 119
Verschmieren, 116
Weichzeichnen, 112
Werte, 138
Zoom, 147
Zuschneiden, 121

Werkzeugeinstellungen
Einstellungen, 201

Werkzeugfenster, 20, 75
>Farbübersicht, 153
Auswahl

Frei, 83
Zauberstab, 84

Einstellungen, 203
Menü, 215, 216, 219

Wert invertieren, 329
Wert propagieren, 392
Werte, 138
Werzeug

Rechteckige Auswahl, 79
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Index Index

Wiederherstellen, 232
Wiederholen, 174
Wind, 398

YCbCr, 318, 319, 473
YUV, 318, 319, 474

Zacken, 386
Zauberstab, 84
Zeigerbewegung, 204
Zeitungsdruck, 389
Zerlegen, 319
Zoom, 147, 203, 248
Zuletzt geöffnet, 227
Zusammensetzen, 318
Zuschneiden, 121, 263

automatisch, 264
Fanatisch, 264
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